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EKTRON, INC. SOFTWARE LICENSE AGREEMENT
** READ THIS BEFORE LOADING SOFTWARE**
YOUR RIGHT TO USE THE PRODUCT DELIVERED IS SUBJECT TO THE TERMS AND CONDITIONS SET OUT IN THIS
LICENSE AGREEMENT. USING THIS PRODUCT SIGNIFIES YOUR AGREEMENT TO THESE TERMS. IF YOU DO NOT
AGREE TO THIS SOFTWARE LICENSE AGREEMENT, DO NOT DOWNLOAD.
CUSTOMER should carefully read the following terms and conditions before using the software program(s) contained herein
(the “Software”). Downloading and/or using the Software or copying the Software onto CUSTOMER’S computer hard drive
indicates CUSTOMER’S acceptance of these terms and conditions. If CUSTOMER does not agree with the terms of this
agreement, CUSTOMER should not download.
Ektron, Inc. (“Ektron”) grants, and the CUSTOMER accepts, a nontransferable and nonexclusive License to use the Software on
the following terms and conditions:
1. Right to use: The Software is licensed for use only in delivered code form. Each copy of the Software is licensed for use only
on a single URL. Each license is valid for the number of seats listed below (the “Basic Package”). Any use of the Software
beyond the number of authorized seats contained in the Basic Package without paying additional license fees as provided
herein shall cause this license to terminate. Should CUSTOMER wish to add seats beyond the seats licensed in the Basic
Package, the CUSTOMER may add seats on a block basis at the then current price for additional seats (see product pages for
current price). The Basic Packages are as follows:
Ektron CMS400.NET — Licensed for ten seats (10 named users) per URL.
Ektron eWebEditPro — Licensed for ten seats (10 named users) per URL.
Ektron eWebEditPro+XML — Licensed for ten seats (10 named users) per URL.
For purposes of this section, the term “seat” shall mean an individual user provided access to the capabilities of the Software.
The CUSTOMER may not modify, alter, reverse engineer, disassemble, or decompile the Software. This software product is
licensed, not sold.
2. Duration: This License shall continue so long as CUSTOMER uses the Software in compliance with this License. Should
CUSTOMER breach any of its obligations hereunder, CUSTOMER agrees to return all copies of the Software and this License
upon notification and demand by Ektron.
3. Copyright: The Software (including any images, “applets,” photographs, animations, video, audio, music and text incorporated
into the Software) as well as any accompanying written materials (the “Documentation”) is owned by Ektron or its suppliers, is
protected by United States copyright laws and international treaties, and contains confidential information and trade secrets.
CUSTOMER agrees to protect the confidentiality of the Software and Documentation. CUSTOMER agrees that it will not provide
a copy of this Software or Documentation nor divulge any proprietary information of Ektron to any person, other than its
employees, without the prior consent of Ektron; CUSTOMER shall use its best efforts to see that any user of the Software
licensed hereunder complies with this license.
4. Limited Warranty: Ektron warrants solely that the medium upon which the Software is delivered will be free from defects in
material and workmanship under normal, proper and intended usage for a period of three (3) months from the date of receipt.
Ektron does not warrant the use of the Software will be uninterrupted or error free, nor that program errors will be corrected. This
limited warranty shall not apply to any error or failure resulting from (i) machine error, (ii) Customer's failure to follow operating
instructions, (iii) negligence or accident, or (iv) modifications to the Software by any person or entity other than Company. In the
event of a breach of warranty, Customer’s sole and exclusive remedy, is repair of all or any portion of the Software. If such
remedy fails of its essential purpose, Customer’s sole remedy and Ektron’s maximum liability shall be a refund of the paid
purchase price for the defective Products only. This limited warranty is only valid if Ektron receives written notice of breach of
warranty within thirty days after the warranty period expires.

5. Limitation of Warranties and Liability: THE SOFTWARE AND DOCUMENTATION ARE SOLD “AS IS” AND WITHOUT ANY
WARRANTIES AS TO THE PERFORMANCE, MERCHANTIBILITY, DESIGN, OR OPERATION OF THE SOFTWARE. NO
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED. EXCEPT AS DESCRIBED IN SECTION 4, ALL
WARRANTIES EXPRESS AND IMPLIED ARE HEREBY DISCLAIMED.
NEITHER COMPANY NOR ITS SUPPLIERS SHALL BE LIABLE FOR ANY LOSS OF PROFITS, LOSS OF BUSINESS OR
GOODWILL, LOSS OF DATA OR USE OF DATA, INTERRUPTION OF BUSINESS NOR FOR ANY OTHER INDIRECT,
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY KIND UNDER OR ARISING OUT OF, OR IN ANY
RELATED TO THIS AGREEMENT, HOWEVER, CAUSED, WHETHER FOR BREACH OF WARRANTY, BREACH OR
REPUDIATION OF CONTRACT, TORT, NEGLIGENCE, OR OTHERWISE, EVEN IF COMPANY OR ITS REPRESENTATIVES
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSS.
6. Additional Terms and Conditions apply
When using the CMS400 map control, Subject to the terms and conditions of the Map provider (Bing Maps for Enterprise or
Google maps)
Microsoft Virtual Earth - http://www.microsoft.com/virtualearth/product/terms.html
If you have any questions would like to find out more about a MWS/VE Agreement, please contact maplic@microsoft.com for
information.
Google Maps - http://code.google.com/apis/maps/terms.html
7. Miscellaneous: This License Agreement, the License granted hereunder, and the Software may not be assigned or in any way
transferred without the prior written consent of Ektron. This Agreement and its performance and all claims arising from the
relationship between the parties contemplated herein shall be governed by, construed and enforced in accordance with the laws
of the State of New Hampshire without regard to conflict of laws principles thereof. The parties agree that any action brought in
connection with this Agreement shall be maintained only in a court of competent subject matter jurisdiction located in the State
of New Hampshire or in any court to which appeal therefrom may be taken. The parties hereby consent to the exclusive
personal jurisdiction of such courts in the State of New Hampshire for all such purposes. The United Nations Convention on
Contracts for the International Sale of Goods is specifically excluded from governing this License. If any provision of this License
is to be held unenforceable, such holding will not affect the validity of the other provisions hereof. Failure of a party to enforce
any provision of this Agreement shall not constitute or be construed as a waiver of such provision or of the right to enforce such
provision. If you fail to comply with any term of this License, YOUR LICENSE IS AUTOMATICALLY TERMINATED. This License
represents the entire understanding between the parties with respect to its subject matter.
YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, THAT YOU UNDERSTAND THIS AGREEMENT, AND
UNDERSTAND THAT BY CONTINUING THE INSTALLATION OF THE SOFTWARE, BY LOADING OR RUNNING THE
SOFTWARE, OR BY PLACING OR COPYING THE SOFTWARE ONTO YOUR COMPUTER HARD DRIVE, YOU AGREE TO
BE BOUND BY THIS AGREEMENT’S TERMS AND CONDITIONS. YOU FURTHER AGREE THAT, EXCEPT FOR WRITTEN
SEPARATE AGREEMENTS BETWEEN EKTRON AND YOU, THIS AGREEMENT IS A COMPLETE AND EXCLUSIVE
STATEMENT OF THE RIGHTS AND LIABILITIES OF THE PARTIES.
Copyright 1999 - 2008 Ektron, Inc. All rights reserved.
LA10031, Revision 2.0
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Securing Ektron
CMS400.NET
Security Checklist
The following is a checklist of things an Administrator must do to
secure Ektron CMS400.NET.

Change the Admin and Builtin Users’ Passwords
Make sure you change the password for the Admin and Builtin
user. To change the Admin user’s password, navigate to .

Change Admin user password
Change the Admin user’s password in the Workarea by following
these steps.
1. In the Workarea, navigate to Settings > Users
2. Click the Admin user.
3. Click the Edit Users button.
4. In the Password and Confirm Password fields enter the new
password.
5. Click the Save button.

Change builtin user password
IMPORTANT!

If you changed the builtin user password during the site setup, you do not need to
change it again. See ”Editing Builtin” on page viii for additional information.

Change the builtin user’s password in the Workarea by following
these steps.
1. In the Workarea, navigate to Settings > Configurations >
Setup.
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2. Click the Edit button.
3. Find the Built In User field.
4. In the Password and Confirm Password fields enter the new
password.
5. Click the Update button.

Remove Sample Users and Sample Membership Users
Some sample users and sample membership users are included
with CMS400.NET for evaluation and demonstration purposes.
These users should be removed when they are no longer needed.
CMS users have access to the Workarea. They can be content
authors, administrators or even developers who need access to
information in the Workarea. These people count towards the
number of users in your license.
Membership users are typically people who only interact with your
Web site. Membership users are a category of users who have
limited privileges to Ektron CMS400.NET. Unlike regular CMS
users, they cannot use the Workarea and do not count towards the
number of users in your license.

Remove Sample Users and Sample
Membership Users
IMPORTANT!

Some users in this list might not appear in your User list. Also, you might have
sample users that appear in your users lists. This depends on which version of the
software you have installed.
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CMS400.NET Users

Membership Users

jedit

jmember

tbrown

member@example.com

jsmith

north

vs

supermember

See Also: ”Managing Users & User
Groups” on page 712

west
See Also: ”Membership Users and
Groups” on page 727

Removing CMS400.NET Users
To remove CMS400.NET users in the Workarea, follow these
steps.
1. In the Workarea, navigate to Settings > Users.
2. Click the check box next each user you want to remove.
3. Click the Delete button (

).

4. Click OK in the dialog box that appears.
The page refreshes and the users are removed.

Removing Membership Users
To remove Membership users in the Workarea, follow these steps.
1. In the Workarea, navigate to Modules > Community
Management > Memberships > Users.
2. Click the check box next each user you want to remove.
3. Click the Delete button (

).

4. Click OK in the dialog box that appears.
The page refreshes and the membership users are removed.
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Do Not Allow the Use of Group User Accounts
Do Not Allow the Use of Group User Accounts
A group account is an account that multiple people use to log in to
CMS400.NET using the same username and password. This is a
serious security issue as you lose the ability to accurately keep
track of who is doing what in your Web site’s environment. The use
of a group user account is a violation of Ektron CMS400.NET's
license agreement.

Additional Information
You do not need to make these changes if you are using the
CMS400.NET for demonstration or evaluation purposes. These
changes should be completed once the decision is made to
purchase the product and go live with your site.
IMPORTANT!

Ektron recommends creating your own Administrator user and deleting the Admin
user.

IMPORTANT!

Ektron recommends deleting any users from the CMS400.NET that are not
needed on the system.

The Everyone Group
By default, the root folder in Workarea provides the Everyone
Group with all permissions except Overwrite Library. Ektron Inc.
recommends reviewing the permission needs of the Everyone
Group when you add a folder. For information on Permissions, see
the Administrator Manual section “Managing User and
Permissions” > “Setting Permissions.”

Editing Builtin
IMPORTANT!

The “builtin” user does not appear in the Users list. This user appears on the
application setup screen.

To change the builtin account information, follow these steps.
1. In the Workarea, click Settings > Configuration > Setup.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

viii

Securing Ektron CMS400.NET

2. Click the Edit button (

).

3. Locate the Built In User field.
4. Edit the built in user information by changing the username and
password.
5. Click the Update button (
NOTE

).

If you cannot sign in to Ektron CMS400.NET because the builtin user
password was changed and you don’t know the new password, use the
BuiltinAccountReset.exe utility. This resets your Ektron CMS400.NET user \
password to Builtin \ Builtin. This utility is located in C:\Program
Files\Ektron\CMS400versionnumber\Utilities.

ServerControlWS.asmx
Best Practice
For improved security, Ektron recommends renaming or removing the
Web services file when you move it to your production server. After
installation, this file is named ServerControlWS.asmx and resides in the
webroot/siteroot/Workarea folder.

ServerControlWS.asmx is the Web service that lets the server controls talk to
Ektron CMS400.NET. The path is coded in the web.config file. This is how it
appears:
<!-- Web Service URL for Server Controls design time --> <add key="WSPath" value="http://
localhost/CMS400Developer/Workarea/ServerControlWS.asmx" />

You will need to edit this line if you change the location or name of the
ServerControlWS.asmx file.
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Introduction to Ektron CMS400.NET

Introduction to Ektron
CMS400.NET

Thank you for purchasing Ektron CMS400.NET, the best and most
affordable solution for Web content management. We welcome
you to use Ektron CMS400.NET to maintain, update, and modify
the contents of your Web site. All these efforts are easily achieved
while preserving the look and feel that you originally designed for
your site. With Ektron CMS400.NET, the tasks of maintaining your
site and updating content are passed on to subject experts. Based
on the page layouts and processes that you create, the highest
level of quality is preserved and maintained throughout the life
cycle of the site.
See Also:
•

”About Ektron CMS400.NET” on page 1

•

”Who Should Read This Documentation?” on page 2

•

”Online Learning Center” on page 2

•

”Sample Site Used in this Document” on page 2

•

”Types of Users” on page 2

•

”Management of Content” on page 3

•

”Conventions of the Documentation” on page 4

About Ektron CMS400.NET
Ektron CMS400.NET is a powerful, easy-to-use, and affordable

XML content management solution that empowers anyone to take
an active role in managing Web content and optimizing online
strategies. It streamlines site management, automates workflow
processes, and supports collaboration. Ektron CMS400.NET
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reduces costs, saves time and makes Web sites, extranets, and
intranets more effective – while generating rapid ROI.
Business users, like marketing or PR pros, can author, manage
and publish Web content, build and deploy Web forms, and collect
and leverage visitor info. Our browser-based editor supports the
industry’s best in-context editing environment – ensuring user
adoption and project success.
Ektron CMS400.NET also helps to move paper-based forms

processes to the Web. Our editor lets users create Web forms
such as expense reports, health records, and insurance forms,
deploy them to internal users, collect data, apply validation and
math functions, and run forms through workflow – all within a
browser.

Who Should Read This Documentation?
This document introduces all the concepts, features, and
instructions for using Ektron CMS400.NET as a Web administrator.
The Web administrator is the person who is responsible for
adjusting the setup of the Web site, and alters the site as
institutional changes require. New areas needing to be added to
the Web site, the changing of personnel and processes over time
may cause these adjustments.

Online Learning Center
Much of the information in this documentation is also presented in
a tutorial, animated format on Ektron’s Web site. To access
Ektron’s CMS400.NET Web Training, go to http://www.ektron.com/
cms400-web-cms.aspx?id=922.

Sample Site Used in this Document
This documentation uses the sample ASPX Web site installed with
Ektron CMS400.NET to explain and demonstrate functionality in a
Ektron CMS400.NET controlled Web site.

Types of Users
Ektron CMS400.NET lets you control the content of your Web site.
The tasks of creating and maintaining your Web site are allocated
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among different types of users. The types of Ektron CMS400.NET
users are:
User

Job

Developer

Builds templates

Administrator

Sets up the site, adds users and user groups,
sets permissions, and maintains the library

Content
Contributor

Maintains Web site by adding, modifying, and
publishing content.

You assign privileges to Ektron CMS400.NET users based on the
actions for which they are responsible. Each user may be assigned
any or all types of privileges. Users without administrative
permissions are known as content contributors.
This document describes features and actions available to a user
with administrative privileges. Information about Ektron
CMS400.NET’s editing and publishing features may be found in
the Ektron CMS400.NET User Documentation.

Management of Content
The Ektron CMS400.NET content manager uses database
technology to store, build, and retrieve Web page content. The
placement of the content on a Web page is determined by
templates, which you can build with external tools. Ektron extends
VisualStudio to support the template design process.
Templates can be thought of as mechanical layouts of your Web
pages. They incorporate powerful custom functions that Ektron
CMS400.NET uses to manage your content. Each content item is
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assigned a unique ID. Ektron CMS400.NET uses the ID to retrieve
content from the database.

If during the evolution of your site the need for a new template
arises, you simply create a new one, store it in a directory
accessible to Ektron CMS400.NET, and create new content that
uses the new template. You can even modify the layout of an
existing template, reincorporate it, and the content automatically
flows into and adjusts to the new layout.
For more information, see ”Creating/Updating Templates” on
page 70.

Conventions of the Documentation
This document‘s typographic styles and conventions are explained
below.
Convention

Explanation

Bold

Bold type indicates a menu selection, field or text that you must
select.

Courier New

Courier New font indicates code that you may enter.

Note:

Notes indicate special conditions or issues that the reader should be
aware of.
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Convention

Explanation

WARNING!
Italic

A warning indicates very important information that should be
followed. Inattention to a warning can produce undesirable results.
Italic text indicates either a title that is being cited or a special use of
a word that might be confused with common world terms.
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License Keys

Introduction
Ektron controls the use of CMS400.NET through a license key, a
unique code assigned to your domain when you purchase
CMS400.NET. Your license key is included in the email that Ektron
sends when you request or purchase CMS400.NET.

License Key Types
There are three levels of license keys available for use with Ektron
CMS400.NET. The features that are available in your specific
version of CMS400.NET depend on the license key you purchase.
The table below shows the major features at each level.

Features

Enterprise

List

Profession
al

eSync

Optional

Multi-site

Optional

eCommerce

Optional

Standard

Optional

Personalization

XLIFF Support

Document Management
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Features

Enterprise

List

Profession
al

Standard

Social Networking

URL Aliasing

All Other Ektron
CMS400.NET Features

License Key Format
A license key typically begins with a base URL (domain name,
computer network name, or IP address) followed by descriptor
tags, a question mark, a series of numbers, a hyphen and one or
two digits signifying release number. For example:
dev.mysite.com(exp-2008-10-25)(modifiers)(users10)?51510837796786063064924334416-XX

License keys cannot contain spaces or line breaks.

Inserting the License Key
If you download the executable (.exe) file, you are prompted to
enter a license key during installation. If you choose not to install
the license key during the installation, you can enter it by
navigating to Workarea > Settings > Setup and clicking the Edit
button. Once you are in edit mode, add the license key to the
License Key(s) text box.

Changing License Keys Upon Upgrade
If you upgrade to a new release of CMS400.NET and want to
replace the old license key with a new one, navigate to Workarea >
Settings > Setup and click the Edit button. Once you are in edit
mode, add the license key to the License Key(s) text box. On the
other hand, if you want to add new keys in addition to old keys,
create a comma delimited list of keys in the License Key(s) text
box.
Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13
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When cutting and pasting license keys, keep the full license key
intact without adding or deleting characters. License keys that are
changed in any way render CMS400.NET inoperable.

WebImageFX License Keys
If you are installing WebImageFX with CMS400.NET, a
WebImageFX license key is included in the email you receive
when you purchase CMS400.NET. A WebImageFX key resembles
a CMS400.NET key but includes the string wifx.
To add the key to CMS400.NET, navigate to Workarea > Settings
> Setup and clicking the Edit button. Once you are in edit mode,
add the license key to the Module Licenses text box.

License Key Check
When you login to a Web site that contains CMS400.NET, it
checks the license key(s) against the domain.
If the URL of a valid license key matches the URL of the site being
accessed, the Workarea appears.
If no valid license key is found for the URL of the site being
accessed, CMS400.NET is disabled and you must log in the with
Built-in account to change the License Key.

Invalid License Key Message
If you have a broken license key or a license key with an incorrect
base URL, an error message appears in the CMS400.NET Login
window. The message states, “Error: A license violation has
occurred and the application is presently locked. Please see your
administrator.”
If this message appears, you can login with the Builtin account and
reenter your license key. If the message continues to appear and
you are sure you have a valid key, contact Ektron Support.
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Using CMS400.NET without a License Key
For evaluation purposes, when you install CMS400.NET, you do
not need a license key. During the installation process, leave the
License Key field blank and click the next button on the License
screen. This allows you to use CMS400.NET as localhost.

Domains in which You Can Use the License Key
The license key is assigned to your base URL, which is typically
your domain name. For example, if your domain name is
www.mycompany.com, the license key follows this pattern:
www.mycompany.com(expdate)(Modifers)?1234567890.
Each domain name requires its own license key. For example, to
support the domain names, www.mycompany.com,
sales.mycompany.com and support.mycompany.com, you need three
license keys.

Register Domains, not IP Addresses
When you purchase a license key, be sure to register a domain
name, not an IP address. For example, register
www.mycompany.com, not 192.168.0.1.
Although CMS400.NET supports IP addresses, the domain that
you license becomes the required URL in the browser address. For
example, if you register 192.168.0.1, you would need to access
the site as http://192.168.0.1/somedirectory/myloginpage.aspx.
Since users would typically not identify a Web page by its IP
address, you should register the domain name instead.

More Information
Additional information about licenses is available at http://
www.ektron.com/products.aspx?id=1144.
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G e t t i n g Sta r t e d

Now that you have installed Ektron CMS400.NET, what’s next?
This chapter explains several resources supplied by Ektron to help
get your Ektron CMS400.NET Web site up and running.
This section has the following topics:
•

”Logging Into an Ektron CMS400.NET Web Site” on page 10

•

”Password Management” on page 15

•

”Accessing the Workarea” on page 17

•

”Workarea Navigation” on page 19

•

”Using the Web Site Interface” on page 20

Logging Into an Ektron CMS400.NET Web Site
See “Logging In and Out” in the Ektron CMS400.NET User Manual.
Note

If needed, you can adjust the width of the login screen. This may be necessary if
you use Active Directory and have long database names. Use the
ek_LoginScreenWidth element of the web.config file to adjust the width.

This section contains the following topics relating to logging in.
•

”Restricting Login Attempts” on page 10

•

”Changing Images Used for Logging In and Out” on page 13

•

”Resolving Problem with Login Screen” on page 14

Restricting Login Attempts
Ektron CMS400.NET has a login security feature that, by default,

locks out a user after five unsuccessful attempts to log in by a user
on one computer. This section explains the flexibility you have in
controlling this feature.
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You can control the following capabilities.
•

”Changing the Number of Unsuccessful Login Attempts” on
page 11

•

”Disabling the Login Attempts Feature” on page 13

•

”Unlocking a Locked Account” on page 12

•

”Preventing CMS Users from Signing On” on page 13

•

”Preventing All Users from Signing On” on page 13

You control login security feature by changing the value of the
ek_loginAttempts element in the web.config file. The following table
summarizes your options.
WARNING!

If you want your Ektron CMS400.NET eCommerce feature to comply with
Payment Application Data Security Standard (PA DSS) certification, the
ek_loginAttempts value must be between 1 and 6.

Value

Description

any number
between 1
and 254
0

Lock out all users

-1

Disable feature; unlock all locked users

-2

Lock out CMS users only; membership users can still
log in

Changing the Number of Unsuccessful Login Attempts
By default, if a user unsuccessfully tries to log in five times, the
following error message appears: The account is locked. Please
contact your administrator. Afterwards, even if the user enters
the correct password, he is locked out, and the error message
reappears.
NOTE

You can change the text of the error message in the resource file. To learn about
editing the resource file, see ”Procedure for Translating Workarea Strings” on
page 921
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To change the number of unsuccessful login attempts that occur
prior to lockout, edit the value of the ek_loginAttempts element in
the web.config file. (The web.config file is located in your site’s root
directory.) For example, to allow only three unsuccessful logins,
change the value to 3. You cannot enter a value greater than 254.

Unlocking a Locked Account
Once an account is locked out, the Account Locked field is
checked in the user settings.

To unlock the account, an administrator user (or a user assigned to
the user-admin role) accesses the Edit User screen and unchecks
the box. At this point, the user can attempt to sign in again.
NOTE

If you want to unlock all locked users at once, set the value of the
ek_loginAttempts element in the web.config file to -1. For more information
about the effects of this setting, see ”Disabling the Login Attempts Feature” on
page 13.

Manually Locking a User from Signon
You can use the Account Locked field (described above) to
manually lock a user out of Ektron CMS400.NET. To do so, go to
the Edit User screen, identify the user, and check the Account
Locked field.
Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13
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That user cannot sign in until either you reverse the above
procedure and uncheck the box, or you change the value of the
ek_loginAttempts element in the web.config file to -1.

Disabling the Login Attempts Feature
To disable the Login Attempts feature, set the value of the
ek_loginAttempts element in the web.config file to -1. If you do, any
user can try to log in as many times as he wants. The error
message never appears, and he is not prevented from entering a
password.
NOTE

Setting the value of the ek_loginAttempts element in the web.config file to -1
automatically unlocks all locked accounts.

Preventing CMS Users from Signing On
If you want to lock out all CMS users, set the ek_loginAttempts
element in the web.config file to -2. If you do, only membership
users can sign in.
NOTE

The builtin user cannot sign in if ek_loginAttempts is set to -2.

Preventing All Users from Signing On
If you want to lock out all users (including membership users), set
the ek_loginAttempts element in the web.config file to 0. If you do,
no one can sign in to Ektron CMS400.NET until you change the
value.
NOTE

The builtin user cannot sign in if ek_loginAttempts is set to 0.

Changing Images Used for Logging In and Out
You can change the images used for the login and logout buttons.
To do so, follow these steps.
1. Move the new images to the following folder: webroot\your
site’s root directory\Workarea\images\application.
2. Open the web.config file in your Web site’s root directory.
3. Change the images referenced in this section of the file:
<add key="ek_Image_1" value="btn_close.gif" />
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<add key="ek_Image_2" value="btn_login.gif" />
<add key="ek_Image_3" value="btn_login_big.gif" />

NOTE

You must update the images and web.config each time your system is updated.

Resolving Problem with Login Screen
You may find that in certain browsers, the login screen occupies
the entire browser window instead of just a small box (see
illustration below).

Browsers such as Netscape 8 and Firefox have a feature called
tabs. When the login window pops up, it appears as a new tab as
shown above.
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You can fix this problem by turning off tabs within the browser.

Password Management
This section contains the following topics relating to managing
passwords.

WARNING!

•

”Making Passwords Case Sensitive” on page 15

•

”Forcing Password Change Every 90 Days” on page 15

•

”Passwords Must Be Seven Characters Minimum, Include
Alpha and Numeric Characters” on page 16

•

”New Passwords Cannot Match the Last Four Passwords” on
page 16

•

”After 15 Minutes of Inactivity, User Must Log in Again” on
page 16

The last four topics require you to set the ek_ecom_ComplianceMode key in the
site’s Web.config file to true. If you do this, your site will need an SSL certificate.
You cannot access the Workarea until the certificate is installed or you turn
compliance off.
For more information, see the Ektron CMS400.NET PA DSS Security Guide.

Making Passwords Case Sensitive
By default, passwords are case insensitive. So for example, if the
password is TOKEN and the user enters token, the signon is
successful.
If you want to make passwords case sensitive, change the value of
the ek_passwordCaseSensitive element of the web.config file from
false to true. (The web.config file is located in your site’s root
directory.)
If you do, and the password is TOKEN and the user enters token,
the signon is unsuccessful. The user would have to enter TOKEN
to successfully sign on.

Forcing Password Change Every 90 Days
Ektron CMS400.NET has a password security feature that forces an

administrator or user with the Commerce Admin role to change his
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password at least every ninety days. This feature is only enabled
when the ek_ecom_ComplianceMode key in the site’s Web.config file is
set to true.
Once an administrator or user with the Commerce Admin role goes
eighty-five days without changing his password, a dialog box
appears at next log-in, asking them to change their password. If
they do not want to change their password at that time, they can
click the Skip button. They are allowed to do this for the next five
days. Once ninety days have passed, they must change their
password before they can log into Ektron CMS400.NET.

Passwords Must Be Seven Characters Minimum, Include
Alpha and Numeric Characters
Ektron CMS400.NET has a password security feature that forces an

administrator or user with the Commerce Admin role to use at least
seven characters in his password. Further, the password must
contain at least one alphabetic and one numeric character.
This feature is only enabled when the ek_ecom_ComplianceMode key in
the site’s Web.config file is set to true. See Also:

New Passwords Cannot Match the Last Four Passwords
Ektron CMS400.NET has a password security feature that forces an

administrator or user with the Commerce Admin role to have a
password that does not match any of his last four passwords. This
feature is only enabled when site’s Web.config file has the
ek_ecom_ComplianceMode key is set to true and the
ek_ecom_PasswordHistory key is set to at least four.
You can set ek_ecom_PasswordHistory to a number higher than four if
you want a higher level of security. If you set this key to less than
four and the ek_ecom_ComplianceMode key is set to true, Ektron
CMS400.NET enforces at least four.

After 15 Minutes of Inactivity, User Must Log in Again
Ektron CMS400.NET has a password security feature that

automatically logs an administrator or user with the Commerce
Admin role out of the application after 15 minutes of inactivity.
Activity is based on requests made to the server.
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This feature is enabled when the site’s Web.config file‘s
ek_ecom_ComplianceMode key is set to true. In addition, if you are using
IIS7, the line in red below needs to appear between the <modules>
tags in the Web.config file. This line is a part of the default install.
You should make sure it has not been removed.
<modules>
<add name="MyDigestAuthenticationModule"
type="Ektron.ASM.EkHttpDavHandler.Security.DigestAuthenticationModule,Ektron.ASM.EkHttpDavHan
dler" />
<add name="ScriptModule" type="System.Web.Handlers.ScriptModule, System.Web.Extensions,
Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35"
preCondition="integratedMode" />
<add name="EkUrlAliasModule" type="UrlAliasingModule" preCondition="integratedMode" />
</modules>

If you are using IIS 6, the line in red below needs to appear
between the <httpModules> tags in the Web.config file. This line is a
part of the default install. You should make sure it has not been
removed.
<httpModules>
<add name="DigestAuthenticationModule"
type="Ektron.ASM.EkHttpDavHandler.Security.DigestAuthenticationModule,Ektron.ASM.EkHttpDavHan
dler " />
<add name="ScriptModule" type="System.Web.Handlers.ScriptModule, System.Web.Extensions,
Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35"/>
<add name="EkUrlAliasModule" type="UrlAliasingModule" />
</httpModules>

Accessing the Workarea
Once logged into Ektron CMS400.NET, you can edit content by
navigating to the page or accessing the Workarea. From there, you
can perform all activities, such as configuring and viewing every
setting of Ektron CMS400.NET.
NOTE

To learn about editing content by navigating to its page, see ”Using the Web Site
Interface” on page 20.

To access the Workarea, follow these steps.
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1. Log in to your Web site, as described in ”Logging Into an
Ektron CMS400.NET Web Site” on page 10.
2. Click the Workarea button (
Workarea toolbar button (

) on a login page or a
).

The Workarea has a Windows Explorer-like interface.

When you first access your Workarea, your Smart Desktop is
displayed. The Smart Desktop contains useful information that
pertains to you.
NOTE

In the Application Setup screen, you can determine which screen appears when
you access the Workarea. See Also: ”Set smart desktop as the start location in
the Workarea” on page 27

For more information about the Smart Desktop, see the Ektron
CMS400.NET User Manual section “The Workarea and Smart
Desktop” > “Understanding the Smart Desktop.”

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

18

Getting Started

Workarea Navigation
The Ektron CMS400.NET administrator Workarea is divided into two
frames:

NOTE

•

the left frame displays the system’s folders

•

the right frame displays common reports (For more information,
see ”Content Reports” on page 147)

Each category in the right frame is followed by a number indicating how many
content items are in that status. Content to Expire lists how many content items
will expire within ten days. By going to the report (Smart Desktop > Reports >
Content To Expire) and changing the number of days, you can view a list of
content to expire in that amount of time.
The number next to Tasks indicates how many open tasks are assigned to, or
have been assigned by, you. Open tasks are those in one of the following states:
not started, active, awaiting data, on hold, pending, reopened.

To learn more about the Workarea, see the section of the Ektron
CMS400.NET User Manual titled “Understanding the Smart
Desktop.”
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Closing the Workarea
To close the Workarea, click the (
corner.

) button in the upper right

When you close the Workarea, you return to the Ektron
CMS400.NET view of your Web site but do not exit Ektron
CMS400.NET.

Using the Web Site Interface
As mentioned in the Ektron CMS400.NET User Manual section
“Introduction to Ektron CMS400.NET” > “Working with Content
from your Web Site”, users and administrators can perform actions
using either the Workarea or the Web site. The Web site has two
types of dropdown menus that appear after users sign in and
enable users to perform actions.
NOTE

The menus do not appear if you are in site preview mode. To learn about Site
Preview mode, see “Logging In and Out” > “Site Preview” in the Ektron
CMS400.NET User Manual.

Menu Type

Illustration

Content - the Silver Access
Point appears in upper left
corner of server control.
Click it to display menu.
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Menu Type

Illustration

For more information,
see

Server control - triangle
appears to right of content.
Click it to display menu.
Menu is available from
most server controls, such
as Content Block,
Collection, List Summary
and Metadata List. The
options depend on the
control and user’s folder
permissions.

Changing the Appearance of the Web Site Content Menu
You have three choices for determining the appearance of the Web
Site Content menu. To make your choice, edit the ek_UserMenuType
element of the siteroot/web.config file. By default, ek_UserMenuType is
set to 2.

Value set in

Description

Illustration

ek_UserMenuType

2 (default)

Dropdown Interface - No
borders; dropdown menu
appears when user clicks
the Silver Access Point in
top left corner of server
control
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Value set in

Description

Illustration

ek_UserMenuType

1

Classic Interface - Colored
borders and menus always
appear; menu options
appear as icons in the top
row
Note: If you use this
interface, the page layout is
not depicted accurately
because of the fixed
toolbars.

0

Hover Interface - Colored
border appears when user
hovers mouse over area;
menu appears when user
right clicks mouse inside
border.
This interface has two
display options: vertical
(shown on right) and
horizontal.
To change:
1.

Open the siteroot/
web.config file.

2.

Find
ek_MenuDisplayType.

3.

Change its value:

0 (zero) = horizontal
1 = vertical
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Modifying the Application Setup
Screen

In the setup section of the configuration folder, you can enter or
edit information for the Ektron CMS400.NET Web site including:
•

License keys

•

Default language

•

Maximum content and summary sizes

•

email notification

•

Physical library folders on file server

•

Builtin user information

•

Editor options

•

Work page size settings

You must complete this before any user can access your Ektron
CMS400.NET Web site.

NOTE

•

”Enabling WebImageFX” on page 28

•

”Enabling CMS to Create File System Folders” on page 29

•

”BuiltIn User” on page 30

•

”Editor Options” on page 31

Only members of the Administrator User Group can view and edit the Application
Setup screen.

Viewing Application Setup Information
To view Ektron CMS400.NET setup information, follow these
steps.
1. Access the Workarea. See Also: ”Accessing the Workarea” on
page 17
Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

23

Modifying the Application Setup Screen

2. Click Settings > Configurations > Setup.
3. The Application Setup screen is displayed.

Updating Setup Information
To update setup information, follow these steps.
1. Access the Application Setup screen, as described in ”Viewing
Application Setup Information” on page 23.
2. Click the Edit button (

).

3. The Application Setup screen appears. Update the fields as
needed. The following table explains the fields.

Field

Description

License Key(s)

Enter the license key sent to you from Ektron via email into this field.

Module Licenses

Enter the license key for WebImageFX that was sent to you via email.
See ”Enabling WebImageFX” on page 28 for more information.

Default Application
Language

Select a default language for Ektron CMS400.NET.
How a User’s Application Language Affects His Use of E k t r o n
CMS 40 0.N ET

This user’s language determines the screens and messages that
appear in E k t r o n C M S 4 0 0 . N E T .
How the System Default Language Relates to a User’s Language
Setting
In the user profile, you can set each user’s language. You can set any
user’s language to system default. Each user whose language is set
to system default uses the language assigned here.
Note: Do not confuse this default application language with the ek_
DefaultContentLanguage variable in web.config. For more information
on that variable, see ”The Default Language” on page 874.
Maximum Content Size

In characters, limit the size of each content item by specifying a
maximum size. If a user’s changes to content result in exceeding this
limit, the user is told to reduce the content before he can save it.
It cannot exceed 1,000,000 characters.
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Field

Description

Maximum Summary Size

In characters, limit the size of each summary by specifying a
maximum size. If a user’s changes to a summary result in exceeding
this limit, the user is told to reduce the summary before he can save it.
It cannot exceed 65,000 characters.

System email Address

Enter a valid email address. This address will appear in the From field
in the notification emails.

Enable Sending of System
Notification Email

Check the box to enable email notification for the entire CMS. Unchecking this box disables email notification, regardless of whether
individual users have their email enabled.

Asynchronous Processor
Location

If your site uses the Web Alerts feature, enter or update the location of
the asynchronous processor Web Services file. The default location
appears below. See Also: ”Setting Up the Message Queue and
Asynchronous Processor” on page 1019

This is a Staging Server

Check this box if you want your library links to refer to the staging
server domain, as opposed to the production server domain. This
would help you verify that the linked items exist on the staging server.
See Also: ”Setting up Staging Multi-sites” on page 1364

Publish in Other Format:
Enable Office documents to
be published in other format

Check the box to allow E k t r o n C M S 40 0. N E T to render Office
documents in PDF format. When a checked, PDF generation is
available for individual folders.
See Also: ”Should Office documents added to this folder be published
in other format?” on page 45

Library Folder Creation:
Enable CMS to create file
system folders for library
assets
Built - in User

Check the box if you want to create physical folders on your file
system server that match the Ektron CMS400.NET library folder tree.
See Also: ”Enabling CMS to Create File System Folders” on page 29

Edit the username and/or password for the built in user. By default, the
username and password combination is builtin/builtin.
Important! Ektron strongly urges you to change the default password
assigned to the builtin user. An opportunity to do this is presented
during installation.
See Also: ”BuiltIn User” on page 30

Editor Options

Toggle between displaying and not displaying font related buttons in
the editor. Also choose to remove styles and preserve MS Word styles
and classes. See Also: ”Editor Options” on page 31
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Field

Description

Accessibility/Section 508
Evaluation

”Validating Content For Compliance with Accessibility Standards” on
page 106

Work Page Size
The following fields change the
•

default editor screen size

•

whether button text appears in the title bar

•

default Web page after sign-in

•

default Workarea page

The default values are automatically applied to all new users, and to all existing users when you
upgrade.
Normally, you can modify these values for any user via the Edit User screen. But, you can force these
values on all users, removing the ability to personalize them.
Width

If desired, change the width of the screen in which E kt ro n
CMS 40 0.N ET appears. The width in pixels must be between 400 and
2400.
This field accommodates users who have larger monitors and/or
prefer a higher resolution, such as 1280 x 1024.
The default value for this setting is 790.

Height

If desired, you can change the height of the screen in which Ek tr on
CMS 40 0.N ET appears. The height in pixels must be between 300
and 1800.
This field accommodates users who have larger monitors and/or
prefer a higher resolution, such as 1280 x 1024.
The default value for this setting is 580.
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Field

Description

Display button text in the
title bar

Check this box if you want any button’s caption text to appear in the
screen title’s bar whenever a user moves the mouse over the button.
Note the word Update, describing the button, in the illustration below

If you do not check this box, the screen’s title remains in the title bar
when the user moves the mouse over the button, as illustrated below.

Landing Page after login

If you want one page in your Web site to appear after users sign in,
enter the URL to that page. You can click Select Page to browse to
the landing page. The last published version of the page appears. If
the page has never been published, nothing appears.
By default, the page from which the user logged in reappears.

Set smart desktop as the
start location in the
Workarea

If you want the Smart Desktop to appear as soon as users enter the
Workarea, click inside this check box.
See Also: ”Workarea Navigation” on page 19
By default, the user sees the Smart Desktop after sign in.
If you leave this check box blank, when you enter the Workarea, you
go to the folder of the content specified at the Landing Page after
login field.

Force preferences to all
users

To force these settings on all Ek tr on CMS4 00 .NET users, check this
box. If you do, users can see the values in the user profile screen but
not change them.
If you leave this box blank, users can personalize these values in their
User Profile.
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Field

Description

Enable Verify email?

Check this box if users should be notified whenever they subscribe to
an email notification list. See Also: ”What Happens if Verification email
is Used” on page 1047
Warning! When using the Checkout Server Control on an
eCommerce site, the Enable Verify Email setting must be
unchecked. Otherwise, new users will receive an error message when
they sign-up using this control. For information on the Checkout
Server Control, see the “eCommerce” > “Checkout Server Control”
section in the CMS400.NET Developer Reference Manual.

Enable PreApproval Group

Use this field to enable Automatic Task Creation. See Also:
”Automatic Creation of Tasks Associated with Content” on page 371

4. Make the necessary changes.
5. Click the Update button (

).

Enabling WebImageFX
When purchasing Ektron CMS400.NET, you had the option to
purchase Ektron WebImageFX as well. WebImageFX is an
imaging application that allows users to edit images online.
If you purchased WebImageFX when you purchased Ektron
CMS400.NET, you should have received an email with a license
key for WebImageFX as well.
To enable WebImageFX within Ektron CMS400.NET, from the
application setup page, insert the WebImageFX license key in the
Module License field.
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Enabling CMS to Create File System Folders
If this option is enabled, each time a new content/library folder is
created in Ektron CMS400.NET, a corresponding physical folder is
created on the file system. This helps organize library assets on
your file server.
The following illustration compares the library folder tree with the
file system’s folder structure.
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NOTE

If upgrading, the installation does not the create sample Web site’s folders on the
file server. These folders must be added manually. However, all folders created by
you are also created on the file server when enabled.

BuiltIn User
The builtin user is a user that is defined in the Ektron CMS400.NET
setup screen. Primarily, he’s an emergency user if you cannot log
in to Ektron CMS400.NET as the administrator.
NOTE

The builtin user can log in to Ektron CMS400.NET whether or not Active Directory
or LDAP is enabled.

Only use the builtin user to correct a bad or expired license key. It
is not designed for regular CMS operations. If you try to edit
content while signed on as this user, you see errors.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

30

Modifying the Application Setup Screen

IMPORTANT!

By default, the username and password combination for the builtin user is builtin/
builtin. For security reasons, Ektron recommends changing the username and
password upon installation.

Editing the BuiltIn User
To edit the builtin user’s information, follow these steps.
1. Accessing the Edit Application Setup Information screen, as
described in ”Updating Setup Information” on page 24.
2. Locate the Built In User field.
3. Edit the built in user information by changing the username and
password.
4. Click the Update button (
NOTE

).

If you cannot sign in to Ektron CMS400.NET because the builtin user
password was changed and you don’t know the new password, use the
BuiltinAccountReset.exe utility. This resets your Ektron CMS400.NET user \
password to Builtin \ Builtin. This utility is located in C:\Program
Files\Ektron\CMS400versionnumber\Utilities.

Editor Options
Style sheets greatly reduce the source code (and thereby the size
of) a content. For this reason, they are becoming more popular
than font-related tags for marking up content. The Editor Options
section lets you determine how the editor handles this issue.
The following table explains the editor options you may set.
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.
Editor Option

Description

Enable Font Buttons

This option displays the following font-related buttons on the
editor toolbar:
•

Font Face

•

Font Size

•

Font Color

•

Font Background Color

See Also: ”Enable Font Buttons” on page 32;”Font Manager” on
page 1071
Preserve MS-Word Styles

When content from MS Word is cut and pasted into the editor, the
editor, by default, removes some MS Word styles. Checking this
box prevents the editor from removing them.
Note: Ektron does not recommend enabling this feature.

Preserve MS-Word Classes

Similar to styles, when content from MS-Word is cut and pasted
into the editor, the editor, by default, removes some MS-Word
classes. Checking this box prevents the editor from removing
them.

Enable Font Buttons
Here is the editor with font related buttons enabled. To enable
these buttons, check the Enable Font Buttons checkbox in the
Settings > Configurations > Setup Screen.
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Disable Font Buttons
Here is the editor with the font buttons disabled. To disable these
buttons, uncheck the Enable Font Buttons checkbox in the
Settings > Configurations > Setup Screen.
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Managing Content

Ektron CMS400.NET’s User Manual provide extensive information

about how users create and work with content. This section
explains content topics that only administrators can manage.
So, you should familiarize yourself with the User Manual chapter
“Working with Folders and Content” before reading this.

Managing Content Folders

An administrator can control every aspect of the content and the
folders that hold them. The controls include setting permissions,
approvals, and adding, editing, publishing, and deleting content.
Below is the content folder.
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This chapter explains how to add, edit, publish, and delete content.
It includes the following information:
•

”Accessing the Content Folder” on page 35

•

”Folder Properties” on page 41

•

”Adding Subfolders” on page 48

•

”Deleting Folders” on page 50

•

”Community Folders” on page 50

•

”Purge History” on page 56

•

”Smart Forms” on page 57

•

”Breadcrumbs” on page 59

•

”Search Content Folder” on page 68

Accessing the Content Folder
To access a content folder, follow these steps.
1. Access the Workarea.
2. Click the Content folder in left side of the Workarea.
3. All content in the root content folder appears in the right frame.
In the left frame, the content folder expands to display its
subfolders.
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From this screen, you can perform administrative actions and
maintain content. Each folder displays the following information
about its content.

Field

Description

Title

The name given to the content by the creator.

Language

The content’s language. See Also: ”Working with MultiLanguage Content” on page 868

ID

The number Ektron CMS400.NET assigns to the
content. It is used to retrieve the content from the
database.

Status

The content’s status.
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Field

Description

Date
Modified

The most recent date that the content was added,
edited, or published.

Last Editor

The last user who accessed the content.

Additionally, each folder has the following menus.
•

”New Menu” on page 37

•

”View Menu” on page 38

•

”Delete Menu” on page 39

•

”Action Menu” on page 40

•

”Add Assets Button” on page 40

New Menu

Menu
Option

Creates the following new item
within selected folder

For more information, see

Folder

folder

”Search Content Folder” on page 68

Blog

Blog

“Blogs” in the E ktron CM S40 0. NET
User Manual

Discussion
Board

Discussion Board

”Discussion Boards” on page 465

Community
Folder

Community Folder

”Community Folders” on page 50

Catalog

eCommerce catalog folder

”Creating a Catalog Folder” on
page 1182

Note: This folder type only appears if
your license supports eCommerce.
HTML
Content

HTML content

”Adding Content” on page 79
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Menu
Option

Creates the following new item
within selected folder

For more information, see

HTML Form/
Survey

HTML Form, Poll, or Survey

”Managing HTML Forms” on page 292

Smart Form

Smart Form

”Smart Forms” on page 57

Office
Documents

Office Document

E ktron CM S40 0. NET User Manual

Managed
Files

Managed file, any supported type

Multimedia

Multimedia file, any supported type

”Managing Multimedia Assets” on
page 312

Collection

Collection

”Collections” on page 626

Menu

Menu

”Menu Feature” on page 704

Section “Using the Document
Management Functionality” > “Working
with Microsoft Office Documents”
E ktron CM S40 0. NET User Manual

Section “Using the Document
Management Functionality” > “Working
with Managed Files”

View Menu
The View Menu provides the following functions.

Menu Option

Function

All types

Displays all content types of selected
language.
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Menu Option

Function

For more information, see

• HTML content

Limits folder display to selected content
type. For example, choose View > Office
Documents, and see only Office
Documents in the folder -- other content
types are suppressed.

• ”Adding Content” on page 79

• HTML Form/Survey
• Office Documents
• Managed Files
• Multimedia

This is especially helpful if the folder has
a lot of items, and you are looking for
only one type of content.

• ”Managing HTML Forms” on
page 292
• E ktron CM S40 0. NET User Manual Section “Using the Document Management
Functionality” > “Working with
Microsoft Office Documents”
• E ktron CM S40 0. NET User Manual Section “Using the Document Management
Functionality” > “Working with
Managed Files”
• ”Managing Multimedia Assets” on
page 312

Language

Limits display within a folder to one
language.
The language setting also determines the
language of any new items you create in
the folder.

Menus

Lets user view and work with menus

Ektron CMS400.NET User Manual
section “Working with Menus” >
“Adding a New Menu” “Adding a
New Menu” > “Adding a Menu via
Content Folder”

Collections

Lets user view and work with Collection

”Collections” on page 626

Archived Content

Lets user view and work with Archived
content. That is, content that passed its
scheduled End Date and whose archive
option is either Archive and remove
from site or Archive and remain on
Site.

Ektron CMS400.NET User Manual
section “Scheduling Content to
Begin and End” > “Setting Archive
Options”

Folder Properties

Lets user view and edit a folder’s
properties. In the properties screens, you
can set permissions, approvals, etc.

”Folder Properties” on page 41

Delete Menu
This menu lets you perform the following functions.
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.
Menu option

Lets you

More Information

Delete this
folder

Delete current folder and all of its content

”Deleting Folders” on page 50

Delete content

Delete one, some, or all content items
within folder

Ektron CMS400.NET User Manual
section “Working with Folders and
Content” > “Deleting Content”

Action Menu
This menu lets you perform the following functions.
Menu option

Lets you

More Information

Export for
translation

Prepare content for translation by a
translation agency

”Using the Language Export Feature” on
page 882

Move/Copy
Content

Move or copy content to another folder.

”Moving or Copying Content” on page 84

Search

Search through content in the Workarea.

”Search Content Folder” on page 68

Add Assets Button
Click this button to enable a screen into which users can drag and
drop assets. For more information, see the Ektron CMS400.NET
User Manual Section ”Using the Document Management System”
> “Adding Documents Using Drag and Drop.”
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Folder Properties
The folder properties screen lets you set permissions and
approvals for a folder. You can also assign or modify the folder’s
metadata, Web Alerts, and Smart Forms.
NOTE

Only members of the Administrator User Group and those defined in the Manage
Members for Role: Folder User Admin screen can view, add, or edit folder
properties. (See Also: ”Defining Roles” on page 787) In addition, if a user is not a
member of the Administrators group, he must be given permission for individual
folders on the Folder Properties > View Permissions for Folder screen. (See Also:
”Setting Permissions” on page 768)

NOTE

If you are using an eCommerce catalog, see ”Product Types” on page 1156 for a
description of the Product Types screen.

Accessing the Folder Properties Screen
To access the folder properties screen, follow these steps.
1. Click View > Folder Properties.
2. The folder’s View Properties screen appears.
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If you want to change any properties, click the Edit button (
proceed to the edit screen.

) to

The table below describes the fields on the Folder Properties
screen.
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Fields on the Folder Properties Screen
Field

Description

Foldername

Edit the name of the content folder.
Note: You cannot change the root folder name.

Description

Edit the description of the content folder.
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Field

Description

Style Sheet filename for
this folder: (leave blank to
inherit)

Specify a style sheet that defines styles that may be applied to
content in this folder. The style sheet that you identify must reside in
the site root folder. Or, leave this field blank to inherit the parent
folder’s style sheet.
The style sheet populates the style dropdown list (see below) within
the editor.

Note: This style sheet affects content being edited. It does not
necessarily affect the content’s appearance on your Web site. To set
or edit the style sheet that determines your Web pages’ appearance,
open the page’s Web form and place a <link
rel=”stylesheet”... tag within its <HEAD> tags. If desired, you can
identify the same style sheet in both locations. To include userselectable styles, they must be generic classes.
Caption and Visible Properties
eWebEdit400 ignores the CSS custom properties caption and
visible. To address this problem for the Internet Explorer browser,
replace them with the custom CSS properties localeRef, caption
and visible.
For other browsers, use the custom CSS selectors localeRef and
unselectable (same as visible: false).

To achieve cross-browser compatibility, use both approaches.
Note: Non-IE browsers have no equivalent for caption.
Page Templates

Lets you specify one or more templates for content in this folder. This
folder’s content uses the specified template when appearing on your
Web site. See Also: ”Inheritance of Folder Templates” on page 75
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Field

Description

Inherit Parent Template
Configuration

Check this box to inherit the template from the parent content folder.

Taxonomy

•

Or, do not check this box and specify one or more templates below.
See Also: ”Inheritance of Folder Templates” on page 75
If you want this folder to inherit taxonomy configurations from
the parent folder, check Inherit Parent Taxonomy Configuration.

If you uncheck Inherit Parent Taxonomy Configuration, you can
then select taxonomies that can be applied to content in this folder.
•

If you want all content in this folder to be assigned at least one
taxonomy category, check Required at least one category
selection.

See Also: ”Inheriting Taxonomies from a Parent Folder” on
page 654; ”Taxonomy” on page 634
Flagging

Check this box if content in this folder inherits a flagging definition
from its parent folder. If you do not check the box, use the dropdown
list to apply a flagging definition to content in this folder.
See Also: ”Flagging” on page 964, ”Assigning a Flagging Definition
to a Folder” on page 967

Multi-site Domain

Lets you set up and manage several Web sites under one

Configuration

CMS. See Also: ”Multi-Site Support” on page 998.

Note: Only appears for
Site folders.
Should Office documents
added to this folder be
published in other format?

Publish Office documents as PDF

Note: This field only
appears if the Enable
Office documents to be
published in other
format property is
checked in the Settings >
Configuration > Setup
screen. See Also:
”Updating Setup
Information” on page 24

Note: This property is not inherited from a parent folder, nor is it
inherited by any subfolders below this folder.

Check this option if Office documents in this folder are published as
PDF files. See Also: ”PDF Generation” on page 319
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Tabs on the Folder Properties Screen
Tab

For more information, see

Metadata

”Assigning Metadata to a Folder” on page 141

Web Alerts

”Assigning Web Alert Information to Folders and Content”
on page 1038

Smart Forms

”Smart Forms” on page 57

Breadcrumb

”Breadcrumbs” on page 59

Product
Types (only
appears with
eCommerce
folder)

”Product Types” on page 1156

Folder Properties Toolbar
The Folder Properties screen contains these toolbar buttons.
Button

Name

Description

More Information

Edit Properties

Access the Edit Folder Properties
screen

”Editing Folder Properties”
on page 47

Permissions

Access the folder’s Permissions
Table

”Setting Permissions” on
page 768

Modify
Preapproval
Group

Set or update preapproval group
assigned to folder

”Automatic Creation of
Tasks Associated with
Content” on page 371

Approvals

Access the folder’s approvals table

”Setting Approval Chains”
on page 778

Purge History

Access the folder’s purge history
table

”Purge History” on page 56
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Button

Name

Description

More Information

Restore Web Alert
Inheritance

Assigns the folder’s Web Alert
properties to all content in folder

”Inheriting Content-Level
Web Alert Information from
Its Folder” on page 1045

Back

Go to previous screen

Editing Folder Properties
A content folder’s properties consist of
•

name

•

description

•

style sheet

•

template (See Also: ”Creating/Updating Templates” on
page 70)

•

Metadata (See ”Assigning Metadata to a Folder” on page 141)

•

Web Alerts (see ”Assigning Web Alert Information to Folders and
Content” on page 1038)

•

”Smart Forms” on page 57

•

”Breadcrumbs” on page 59

To edit any properties for a folder, follow these steps.
1. Access the View Properties screen for the folder you want to
edit, as described in ”Accessing the Folder Properties Screen”
on page 41.
2. Click the Edit button (

).

3. The folder’s Edit Properties screen appears.
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4. Make the necessary changes to the content folder’s properties.
See ”Fields on the Folder Properties Screen” on page 43.
5. Click the Update button (

).

Adding Subfolders
To further organize content on your Web site, create subfolders to
store related content. To add a sub folder, follow these steps.
1. Navigate to and click the folder within which you want to create
a subfolder (that is, the parent folder).
2. Each folder has a default language. By default, it is inherited
from its parent folder. To change a folder’s default language,
use the parent folder’s View > Language selection (shown
below).
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Effect of a Folder’s Default Language
By default, when a user adds content to a folder, the default
language is applied to the content unless the user explicitly
changes the language. So, you should select a default
language in which you expect the majority of folder’s content to
be created.
3. Click New > Folder.
4. The Add a Subfolder screen appears.
5. Complete the fields. See ”Fields on the Folder Properties
Screen” on page 43.
6. Click the Save button (

).

You can modify the subfolder’s properties, permissions, approval
chain, etc. For a list of options, see ”Folder Properties Toolbar” on
page 46.
If this is a Community Folder, see ”Community Folders” on
page 50.
If this is a Site Folder, see ”Multi-Site Support” on page 998.
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Deleting Folders
You can delete obsolete folders from the Ektron CMS400.NET
Web site.
NOTE
CAUTION!

The top-level folder, Root, cannot be deleted nor renamed.
Deleting a content folder permanently deletes the content and Quicklinks that
belong to the content folder, as well as its subfolders.

To delete a content folder, follow these steps.
1. In the Workarea, navigate to the content folder you want to
delete.
2. From the options across the top of the screen, click Delete >
This Folder.

3. A confirmation message is displayed.
4. Click OK.

Community Folders
Community folders resemble regular folders in most ways. The
only difference is that membership users can add and edit content
in these folders only. Community folders have a unique icon, which
looks like two houses (
).
Membership users add and edit Community folder content after
signing in to the Web site. They do not use the Workarea to add or
edit content.
NOTE

Authorized CMS users can also create and update Community folder content.
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Creating a Community Folder
1. In Workarea > Content, go to the folder in which you want to
create the community folder.
2. Select New > Community Folder.
3. Assign properties as you would any other folder. See ”Folder
Properties” on page 41
NOTE

The folder properties screen lets you require metadata for any content item.
However, membership users cannot enter metadata. Therefore, this requirement
is ignored when membership users edit community folder content. If an Ektron
CMS400.NET user tries to edit that content, he is required to enter a metadata
value.

Assigning Permissions for a Community Folder
Since Community folders are intended for membership users, this
section explains how to assign permissions for them. To assign
folder permissions for regular users, see ”Setting Permissions” on
page 768.
1. Navigate to the folder.
2. Click View > Folder Properties.
3. Click the View Permissions button (

).

4. If necessary, uncheck the Allow this object to inherit
permissions checkbox.
5. Click View Membership Users.
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6. Click the Add button (

).

7. Select the membership user or group to which you want to
assign permission for this folder.
8. Check the permission boxes as appropriate.

How a User Views and Edits Community Folder Content
When a user with Read-only or higher permission navigates to a
page whose content is in a community folder, he can view it. If he
has edit permission, a green border surrounds it.

IMPORTANT!

Membership users can edit only HTML content and assets. They cannot edit other
content types (HTML forms, Smart Forms, etc.).

When a membership user clicks the Edit button (
window displays the content within an editor.
Other membership buttons are View History (
( ).

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

), a new

) and Log out

52

Managing Content Folders

This editor has fewer capabilities than Ektron CMS400.NET’s editor.
However, a membership user can
•

add images and files via the library button ( ) if the
membership user has Add Images and Add Files permission.
See Also: ”Library Folders and Permissions” on page 177

•

add a wiki using the page link button ( ). See Also: Ektron
CMS400.NET User Manual section “Introduction to
eWebEditPro+XML” > “Using Ektron CMS400.NET’s Wiki
Feature”

•

Assign a taxonomy category to the content by clicking the
Category tab. See Also: ”Taxonomy” on page 634
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NOTE

The Category tab only appears if a Taxonomy is applied to the content’s folder.

•

replace the content summary with the first 40 words of the
content, using the Auto Generate New Summary check box.
See Also: ”Auto Generating Summaries” on page 80

When a membership user finishes editing, he clicks Publish. If the
content’s folder has an approval chain, the content’s status
changes to submitted, and the border color changes to yellow. If
there is no approval chain, the content is published immediately.

How a Membership User Adds Community Folder Content
You will need the assistance of your developer to enable this
feature. Instructions for doing so are in the developer sample site.
To download the developer sample site, go to http://
www.ektron.com/solutions/startersites/. After you install it, go to
siteroot/developer/ContentBlock/AddContentMembershipUser.aspx.
Or, from the developer home page (siteroot/developer/
default.aspx), go to Memberships > Membership Add Content.

How a Membership User Adds an Asset
First, your developer must create a template, then drop an Asset
Server Control onto it. While adding the Asset Server Control, the
developer specifies Add at the Upload Type property, and a
community folder to which the asset will be saved at the
DefaultFolderID property.
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When a membership user authorized to add content navigates to
the page with the server control, he sees an Asset control area like
the one that appears when CMS users add assets. He can then
drag and drop assets into Ektron CMS400.NET.

This is described in the Ektron CMS400.NET User Manual section
“Using the Document Management Functionality” >“Importing Files
via Drag and Drop.”
Additional information about administering assets is found in the
Ektron CMS400.NET User Manual section “Using the Document
Management System.”

How a Membership User Updates an Asset
Your developer adds the Asset Server Control, as described in
”How a Membership User Adds an Asset” on page 54. The only
difference is that the developer specifies Update at the Upload
Type property, and a community folder to which the asset will be
saved at the DefaultFolderID property.
Then, the developer specifies an asset ID number at the
DefaultAsset ID property. Using that control, the membership user
can update the identified asset only.
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Purge History
The Purge History option lets you delete historical versions of
content in a folder. When purging, your options are

NOTE

•

specify a date before which historical versions are purged

•

indicate whether the purge includes a folder’s subfolders

•

purge published as well as checked-in versions of content

Only Ektron CMS400.NET administrators and users identified on the Manage
Members for Role: Folder User Admin screen can purge history.

To purge the history for a content folder, follow these steps.
1. Access the View Folder Properties screen for the content folder
you want to purge the history for, as described in ”Accessing
the Folder Properties Screen” on page 41.
2. Click the Purge History button (

).

3. The Purge History screen appears.
4. Use the following table to customize the Purge History options.
Field

Description

Required?

Only purge historical
versions before

Specify a date to limit the number of historical versions to
purge. When specified, only historical versions with a
date before this date are purged.

Yes

Recursive Purge

Purges historical records for content in this folder’s
subfolders.

No
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Field

Description

Required?

Purge versions marked
as Published

Purges published versions of content as well as checkedin versions.

No

5. Click the Purge History button (

).

6. A confirmation message is displayed.
7. Click OK to continue.
8. Ektron CMS400.NET executes the purge and displays a
confirmation when complete.

Smart Forms
Use the Smart Forms screen to assign one or more XML
configurations to a folder. (To learn about how Smart Forms are
created, see ”Working with Smart Forms” on page 181.)
When creating new content in a folder, the New menu provides a
Smart Form option. This option displays a secondary menu, which
lists Smart Forms that you can use to create XML content. (See
graphic below.)
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This section explains how to determine the list of Smart Forms
available when creating content.

Inheritance and Smart Forms
A folder’s Smart Forms can be inherited from the parent folder, or
you can break inheritance and assign a unique group of Smart
Forms. Use the Inherit Parent Configuration checkbox to retain
or break inheritance.

Assigning Smart Forms to a Folder
If you break inheritance, you then select the Smart Forms that can
be assigned to content in the folder using the Smart Forms
dropdown list (shown below).

You can preview any Smart Form by clicking the Preview button
( ). To add any Smart Form, select it from the dropdown list and
click Add.
To remove a Smart Form, click Remove.
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Requiring Smart Forms
You can require a Smart Form to be the only type of content that
can be added within a folder. To enable this, click the Require
Smart Forms check box on the Smart Forms tab.

If you do, the user can only choose enabled Smart Forms when
viewing that folder’s New menu -- all other content types are
suppressed.

Breadcrumbs
WARNING!

The information described in this section is for use with the FolderBreadcrumb
server control, not the BreadCrumb server control. For additional information on
each server control, see The Developer Manual sections “Introduction to Ektron
CMS400.NET Server Controls” > “BreadCrumb Server Control” and
“Introduction to Ektron CMS400.NET Server Controls” > “FolderBreadcrumb
Server Control”.

Use the Breadcrumb tab to define a site map for the folder or to
inherit one from the parent folder. Breadcrumbs improve the way
site visitors can navigate around your site. Below is an example.
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The following topics explain Breadcrumbs in more detail.
•

”Inheritance and Breadcrumbs” on page 60

•

”Adding a Breadcrumb” on page 60

•

”Reordering Breadcrumb Items” on page 63

•

”Editing a Breadcrumb Item” on page 65

•

”Removing a Breadcrumb Item” on page 67

Inheritance and Breadcrumbs
A folder’s breadcrumbs can be inherited from the parent folder, or
you can break inheritance and assign a path of breadcrumbs. Use
the Inherit Parent Configuration checkbox to retain or break
inheritance.

Adding a Breadcrumb
The example below adds three breadcrumbs to the trail.
1. Navigate to the folder for which you want to add the
breadcrumbs.
2. On the View Contents of Folder screen, click View > Folder
Properties.
3. Click the Edit Properties button (

).

4. Click the Breadcrumb tab.
5. The Edit Breadcrumbs screen appears.
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6. In the Add New Item section of the screen, add the following
information.
•

Title - the name of the breadcrumb as you want it to appear in
the breadcrumb trail

•

URL Link - the URL path to the breadcrumb’s destination,
typically a Ektron CMS400.NET content item. For example,
default.aspx.
If you are not sure what the file’s name is, click the Binoculars
( ), and the library for quicklinks appears. Select the content
item to add to the breadcrumb.
You can also enter a URL, for example, www.example.com.

•

Description - add a description for the breadcrumb

7. Click the Add button (

).

8. The first item in the breadcrumb path appears.
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.

9. Repeat steps 6 and 7 for each item in the breadcrumb path.
10. The items in the breadcrumb now appear like this.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

62

Managing Content Folders

11. Click the Save button (

).

Reordering Breadcrumb Items
1. Navigate to the folder for which you want to reorder
breadcrumbs.
2. On the View Contents of Folder screen, click View > Folder
Properties.
3. Click the Edit Properties button (

).

4. Click the Breadcrumb tab.
5. The Edit Breadcrumbs screen appears.
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.

6. Click a breadcrumb item.
WARNING!

Do not click the red X. This deletes the breadcrumb item. See Also: ”Removing a
Breadcrumb Item” on page 67.
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7. Click the green Up and Down buttons (
around in the list.

) to move the item

8. Once the items are in the correct position, click the Save button
( ).

Editing a Breadcrumb Item
1. Navigate to the folder for which you want to edit breadcrumbs.
2. On the View Contents of Folder screen, click View > Folder
Properties.
3. Click the Edit Properties button (

).

4. Click the Breadcrumb tab.
5. The Edit Breadcrumbs screen appears.
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6. Click a breadcrumb item.
WARNING!

Do not click the red X. This deletes the breadcrumb item. See Also: ”Removing a
Breadcrumb Item” on page 67.
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7. In the Add New Item section, edit the information.
8. Click the Save button (
9. Click the Save button (

).
).

Removing a Breadcrumb Item
1. Navigate to the folder for which you want to remove a
breadcrumb.
2. On the View Contents of Folder screen, click View > Folder
Properties.
3. Click the Edit Properties button (

).

4. Click the Breadcrumb tab.
5. The Edit Breadcrumbs screen appears.
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.

6. Click the Red X (
remove.

) next to the breadcrumb item you want to

7. The breadcrumb item is deleted.
8. Click the Save button (

).

Search Content Folder
You can search a folder to locate content within your Web site. Use
this feature to find content when you know the text that needs to be
updated but are unsure of its folder or where it is on the Web site.
The search only looks through the current folder and its subfolders.
So if you want to search the entire site, begin with the root content
folder.
To learn more about searching through folders on Ektron
CMS400.NET, see “Searching the Workarea” in the Ektron
CMS400.NET User Manual.
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When you enter the Content folder in Ektron CMS400.NET as an
administrator, you can control every aspect of the content and
folders. Some controls include setting permissions, approvals, and
adding, editing, publishing, and deleting content. Below is an
example of the Content folder.

TIP!

The “Working with Folders and Content” chapter of the Ektron CMS400.NET
User Manual explains many details about how users interact with content. You
should familiarize yourself with that material before reading this chapter.

This chapter explains how to add, edit, publish, and delete content.
Permissions and Approvals are explained in later chapters.
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See Also:
•

”Creating/Updating Templates” on page 70

•

”Adding Content” on page 79

•

”Forming URLs For Ektron CMS400.NET Documents” on
page 82

•

”Viewing Content” on page 83

•

”Editing Content” on page 84

•

”Moving or Copying Content” on page 84

•

”Viewing and Restoring Historical Versions of Content” on
page 87

•

”Scheduling Content” on page 88

•

”Deleting Content” on page 88

•

”Content History” on page 88

•

”Content Permissions” on page 88

•

”Content Approvals” on page 88

•

”Content Workflow” on page 89

•

”Link Checking” on page 89

•

”Assigning Tasks to Content” on page 89

•

”Content Properties” on page 89

•

”Content Rating” on page 91

Creating/Updating Templates
During the setup of your Ektron CMS400.NET Web site, templates
are created for your Web pages. A template typically includes page
headers and footers as well as placeholders for content, forms,
summaries, calendars, collections, or other page elements.
A template included with Ektron’s sample site appears below.
Notice that the top of the screen contains headers that appear on
several pages. Other areas contain links to Ektron CMS400.NET
objects, such as menus and text. The developer can easily modify
the content inside these areas.
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NOTE

To learn more about creating templates, see the Ektron CMS400.NET
Developer’s Manual section “Introduction to Ektron CMS400.NET Server
Controls” > “Setting Up a Template.” Another good resource is the Ektron
technical article “Templating in CMS400.NET” (http://dev.ektron.com/
articles.aspx?id=6724).

Templates are more fully explained through the following topics.
•

”How Templates are Used” on page 72

•

”Declaring Templates” on page 72

•

”Inheritance of Folder Templates” on page 75

•

”Assigning Templates to Folders” on page 76

•

”Assigning Templates to Content” on page 77
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How Templates are Used
Except for your Web site’s home page, all pages on your site are
made accessible by hyperlinks. Hyperlinks can appear within
content. They are also used to link content items from list
summaries, menus, and collections.
The template is a key component of the hyperlink definition -- it
defines the template in which to display the content. As seen in the
example below, when the user selects Email, that content item (ID
87) will display within the contactinformation.aspx template.

Declaring Templates
After creating your templates, declare them within Ektron
CMS400.NET. To do this, go to the Active System Templates
screen, available from Settings > Configuration > Template
Configuration.
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From this screen, you can add new templates, or delete or update
existing ones.
NOTE

Only members of the Administrators group and users defined in the Manage
Members for Role: Template Configuration screen have permission to add, delete
or update templates. See Also: ”Defining Roles” on page 787

See Also:
•

”Creating/Updating Templates” on page 70

•

”Adding a New Template” on page 73

•

”Deleting a Template” on page 74

•

”Updating a Template” on page 74

Adding a New Template
To add a new template, click the Add button (
Template screen appears.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

). The Add a New

73

Managing HTML Content

Enter the path to the new template and click the Save button (

).

Deleting a Template
To delete a template, click Delete next to the template.
You can only delete a template if it is not assigned as any folder’s
default template. If you choose a template that is assigned as a
default, a screen tells you why you cannot delete it and lists the
folders for which it is the default.
If you delete a template that is not used as a default but is applied
to content, that content’s template is changed to its folder’s default
template.

Updating a Template
Use the update command to change all references from an old to
a new template. For example, your old template is named
MyTemplate.aspx. You can want to replace all references to it to
Updatetemplate.aspx.
To do this, follow these steps.
1. Click Update next to the template.
2. A new screen appears.
3. Enter Updatetemplate.aspx.
4. Click the Save button (

).
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Inheritance of Folder Templates
By default, all folders below the root folder inherit a template from
their parent. However, you can override the default and assign a
unique set of templates to any folder.
Before you can change a folder’s template assignment, you must
break inheritance from the parent folder. To do this, go to the Edit
Folder Properties screen and uncheck the box next to Inherit
Parent Template Configuration (illustrated below). See Also:
”Editing Folder Properties” on page 47

Each folder must have at least one template. Also, one template
must be chosen as the default.
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If the folder’s default template is changed, all existing template
assignments remain. However, any new content added or moved
into the folder will assume the new default template.

Assigning Templates to Folders
If you break template inheritance, all inherited templates are
initially assigned to the folder. You can then remove unwanted
templates or add new ones.
All available templates appear in the template dropdown list
(illustrated below). Select any that you want to be available from
the folder and click Add.

The list of available templates is managed through the ActIve
System Templates screen. See Also: ”Declaring Templates” on
page 72
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Adding a Template to a Folder
To add a new template, click the Add button (
Template screen appears.

). The Add a New

Enter the path to the new template and click the Save button (

).

Removing a Template from a Folder
•

If you try to delete a template that is the default for a folder, you
are notified that you must assign a new default to that folder
before you can delete it.

•

If you try to delete a template that is assigned to a content
block, you are notified via the following message If you wish to
continue and delete this template, the above content will
be set to their parent folder's default template. Do you wish
to continue?

Assigning Templates to Content
A folder’s default template is automatically applied to all content in
the folder. However, you can change a content item’s template to
any of those assigned to the folder.
This relationship is illustrated below.
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To change the template applied to a content item, edit that content,
and go to the Templates tab as shown above. Then, select a
template to apply to the content.
As explained in ”How Templates are Used” on page 72, the
template assigned to the content will be used whenever a hyperlink
is created to it.
See Also: ”Editing Content” on page 84

Adding Content
Ektron CMS400.NETallows for several types of content.
•

HTML - Most typical type of Web content. User creates/edits
this using WYSIWYG editor. Formatting is embedded as HTML
code, which the user doesn’t need to see. See Also: ”Adding
HTML Content” on page 80

•

HTML Form/Survey - Users can create and maintain HTML
forms to collect information and opinions from visitors to your
Web site. See Also: Ektron CMS400.NET User Manual section
“Working with HTML Forms”

•

Smart Forms - Content created using an XML configuration.
See Also: ”Adding XML Content” on page 81”Working with
Smart Forms” on page 181

•

Multimedia Files - Files that include audio, video, or both

•

Microsoft Office Documents - Content created in Microsoft
Office and stored in CMS400.NET via the Document
Management functionality

•

Managed Files - Content created with software external to the
CMS and stored in CMS400.NET via the Document
Management functionality. These files are typically .pdf, .gif,
.jpeg, .zip, and .txt files.
To learn about how Office documents and Managed files are
added see the Ektron CMS400.NET User Manual section
“Working with Folders and Content” > “Using the Document
Management System”

•

PageBuilder Page - a Web page on which you can drop
widgets, which are containers that can hold
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- Ektron CMS400.NET content and navigation tools, such as List
Summaries and Metadata
- generic Web widgets, such as a calculator or weather report
For more information see the Ektron CMS400.NET Pagebuilder
Quick Start Guide.

Adding HTML Content
See the Ektron CMS400.NET User Manual Section “Working with
Folders and Content” > “Adding Content”.

Auto Generating Summaries
Ektron CMS400.NET automatically generates a new content item’s

summary, if none exists. To do this, it checks the summary the first
time new content is published. If the summary is blank, Ektron
CMS400.NET copies the first 40 words of the content into the
summary.
After the content is published, a CMS user can update or delete
the summary. If it is deleted, the summary remains blank and is
never again automatically generated for that content.
You can disable this feature in Ektron CMS400.NET if desired. See
”Automatically Recreating a Catalog” on page 396.
Membership User Summary Editing

If a membership user edits content and wants to update the
summary, he can automatically copy the first 40 words of the
content into the summary. To do this, the membership user checks
the Auto Generate New Summary field on the membership
editing screen (shown below).
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There is no limit on the number of times a membership user can
automatically generate a new summary.

Adding XML Content
If one or more Smart Forms are assigned to a content folder, users
can create XML content within it. Any folder (other than the root
content folder) can have a unique group of Smart Forms or inherit
them from the parent folder. See Also: ”Working with Smart Forms”
on page 181
To add XML content, follow these steps.
1. In the Workarea, browse to a folder to which at least one Smart
Form is assigned.
2. Click New > Smart Form.
3. Select the Smart Form you will use for the content.
NOTE

When selecting the folder to create the content in, keep in mind the permissions
that are going to be set on it, and which users will have permissions for it.

NOTE

Depending on the Smart Form assigned to the content, the default XML may
appear differently.

4. The procedure for creating XML content is similar to that for
creating HTML content. Follow the steps described in ”Adding
HTML Content” on page 80.
The Smart Form formats the screen display. When that content is
published and a site visitor completes the screen, the user’s input
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is saved as XML. For more information, see ”Working with Smart
Forms” on page 181.

Forming URLs For Ektron CMS400.NET
Documents
Whenever content is created, Ektron CMS400.NET generates a
unique identifier of that content. See Also: Ektron CMS400.NET
User Manual > “Library Folder” > “Quicklinks and Forms”
The identifier for Ektron CMS400.NET content is made up of these
elements:

WARNING!

•

Site address

•

”The Template” on page 82

•

”The Content Variable” on page 83

•

”The Language Identifier” on page 83

Only use the language identifier if you are forcing or changing the language.

The Template
The template determines much of the page layout. By itself, the
template URL retrieves the empty template or the template with its
default document.
NOTE

You can set a default document for a template in the content function by inserting
an id number.

See Also: ”Creating/Updating Templates” on page 70

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

82

Managing HTML Content

The Content Variable
A question mark (?) separates the template URL from the content
variable. The content variable indicates which document or content
the server places in the template before displaying the page.
Below is a description of the URL format.
Content

Example

Description

http://www.example.com /
index.aspx?ID=1

ID selects a single document to display. Use this
variable for a single document template type. The
value corresponds to the content’s id value.

variable
ID=n

The above variable’s name is based on the templates included in
the Ektron CMS400.NET’s sample site. If your Web master
changed the variable names in your site’s template, use the name
of the corresponding variable in each template rather than the one
above.

The Language Identifier
This part of the URL identifies the language selected by a visitor to
your site. It only appears if your site supports multiple languages.
WARNING!

Only use the language identifier if you are forcing or changing the language.

To learn more, see ”Multi-Language Support” on page 868.

Viewing Content
See the Ektron CMS400.NET User Manual Section “Working with
Folders and Content” > “Viewing Content”.
NOTE

You can use the ek_PageSize setting in the web.config file to determine the
maximum number of items that can appear on a page before it “breaks.” When a
page breaks, additional entries appear on another screen, and the following text
appears near the bottom of the items list:
Page 1 of 2
[First Page] [Previous Page] [Next Page] [Last Page]

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

83

Managing HTML Content

Editing Content
See the Ektron CMS400.NET User Manual Section “Working with
Folders and Content” > “Editing Content”.

Moving or Copying Content
You can move content from any folder to any other folder. Or, you
can copy content from one folder to another. At the end of both
procedures, a copy of the content resides in the new folder. Moved
content retains the original ID number, while new content gets the
next available ID number.
When copying, you leave the content in its original folder, while
moving deletes the content from the original folder. Other than that
difference, the procedure for performing both actions is virtually
identical.

Who Can Move or Copy Content?
Only members of the Administrators user group or those assigned
in the Roles > Folder User Admins screen can move or copy
content. See Also: ”Defining Roles” on page 787 and ”Guidelines
for Using The Folder-User Admin Role” on page 790

Impact of Content Status on Moving and Copying
Your ability to move and copy content is affected by the content’s
status, as described in the table below.

Action

Content Status

Move

Approved, Checked in

Copy

Approved

What is Moved Or Copied?
When content is moved or copied, the following changes are
made.
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NOTE

•

The content inherits permissions and the approval chain from
the new folder.

•

The content’s Quicklink is moved or copied in the library to the
destination folder. However, the Quicklink remains the same
(that is, the default template doesn’t change). You can update
this by editing the Quicklink. This procedure in described in the
Ektron CMS400.NET User Manual section “Updating Default
Template for Multiple Quicklinks.”

If the Link Management setting in the web.config file is set to true, you do not
need to update the quicklink. Link Management automatically finds the correct
template based on the current content folder.

•

If the new folder already contains content with the same title,
Ektron CMS400.NET appends a number to the title to make it
unique. For example: ASP.NET Unleashed(2).

•

The new folder’s default template is assigned to the content

•

Library image paths inside the content remain the same

•

If the content has a Smart Form, it remains assigned even if the
Smart Form is not assigned to the new folder

Moving Or Copying One Content Item
To move or copy content to another folder, follow these steps.
1. Access the View Content screen for the content you want to
move or copy, as described in the Ektron CMS400.NET User
Manual section “Working with Folders and Content” > “Viewing
Content.”
2. Click the Move/Copy Content button (

).

3. The Move/Copy Content screen is displayed.
4. Select either Move or Copy.
5. If you choose Copy, and you want the content to be published
as soon as the copying is complete, check Publish Copied
Content.
If you want the content status in the new folder to be checked
in, uncheck the Publish Copied Content checkbox.
6. Enter the path to the destination folder. If you don’t know the
path, click Select Folder and navigate to the destination folder.
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7. Click the Move/Copy Content button (

).

8. A confirmation message is displayed.
9. Click OK to continue.
10. The content is moved or copied to the specified content folder.
The destination folder appears with the new content.

Moving Or Copying Several Content Items
To move or copy several content items in the same folder at once,
follow these steps.
1. Navigate to the folder that contains the content you want to
move or copy.
2. Click Action > Move/Copy Content.

3. The Move/Copy Contents of Folder screen is displayed.
4. Select either Move or Copy.
5. If you choose Copy, and you want the content to be published
as soon as the copying is complete, check Publish Copied
Content.
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If you want the content status in the new folder to be checked
in, uncheck the Publish Copied Content checkbox.
6. Enter the path to the destination folder. If you don’t know the
path, click Select Folder and navigate to the destination folder.
7. Check the boxes next to the content that you want to move or
copy.
NOTE

Check off the box in the header cell to select all or deselect all eligible content.

8. Choose the content folder to move or copy the selected
content from the drop down list.

9. Click the Move/Copy Content button (

).

10. A confirmation message is displayed.
11. Click OK.
12. The content is copied or moved to the destination folder.

Viewing and Restoring Historical Versions of
Content
Each time a new version of content is published or checked in, the
previous version is stored. Old versions of content may be
accessed, and if desired, restored to the Web site.
For more information, see “Viewing and Restoring Previous
Content” section of the Ektron CMS400.NET User Manual.
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Purging Historical Versions of Content
See ”Purge History” on page 56.

Scheduling Content
Scheduling content allows you to specify a future date and time
when content will be visible on the Web site. Similarly, you can
remove content from the Web site on a specified date and time.
For more information, see “Scheduling Content to Begin and End”
in the Ektron CMS400.NET User Manual.

Deleting Content
Seethe Ektron CMS400.NET User Manual Section “Working with
Folders and Content” > “Deleting Content”.

Content History
See the Ektron CMS400.NET User Manual section “Viewing and
Restoring Previous Content”.

Content Permissions
See ”Setting Permissions for Content” on page 776.

Content Approvals
See ”Setting Approval Chains” on page 778.
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Content Workflow
To learn about the process content must pass through to get
published to your Web site, see the Ektron CMS400.NET User
Manual section “Approving/Declining Content.”

Link Checking
The link checker button locates all content with a link to the
displayed content. This feature is useful if you decide to delete
content. You can use this to remove those links, which will not work
after the deletion.
To display all content that links to the selected content, follow these
steps.
1. Access the View Content screen for the content you want to
execute the link checker for, as described in ”Viewing Content”
on page 83.
2. Click the Check Links button (

).

3. A screen displays each content item with a link to the current
content.
4. Click the content title to access the View Content screen for the
selected content and perform the necessary actions on it.

Assigning Tasks to Content
See the Ektron CMS400.NET User Manual > “Managing Tasks” >
“Creating Tasks via Content”.

Content Properties
The Content Properties screen lets you determine if this content is
included in a search of your Web site, and which flagging definition
is applied to this content. See Also: ”Flagging” on page 964
If your site is using eCommerce, the screen also displays the
entry’s product type. See Also: ”Product Types” on page 1156
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The Content Searchable Check Box
If you uncheck this box, Ektron CMS400.NET excludes this
content when a Web site search is performed.
The Content Searchable box has no effect on
•

the ability to find this content from the Workarea Advanced
search

•

a content item’s appearance on a Suggested Results list

See Also:
•

”Suggested Results” on page 420

•

”Searching Your Web Site” on page 389

The View Content Properties screen
To view the Content Properties screen, follow these steps.
1. Access the View Content screen for the content whose
properties you want to view, as described in ”Viewing Content”
on page 83.
2. Click the Properties button (

).

3. The View Properties for the Content screen appears.

4. Check the Content Searchable box to include this content in a
search of your Web site.
5. Click the Update button (
NOTE

).

If you click the Properties button for content that is displayed on a Web page, the
View Content screen opens in the Workarea window.
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Content Rating
Ektron CMS400.NET provides a rating system, based on stars, so

site visitors can rate content on your Web site. A visitor can rate
content on a scale of one through five stars. The ratings are
collected from the Web page via the ContentReview server control.
Depending on the XSLT used with the ContentReview server
control, you can allow half star rating increments and let site
visitors submit comments (see illustration below).
NOTE

If a visitor is not logged in as a CMS or membership user, his browser must have
cookies enabled in order to submit a content rating.

In addition to consuming site visitors’ ratings and reviews and
displaying the information in the Workarea, the ContentReview
server control can be used to display reviews on your site. See
Also: ”Displaying Reviews on the Site” on page 94
Reviews can be moderated from the “Workarea” > “Smart
Desktop” or from the Content Rating screen associated with a
content item. See Also: ”Moderating Reviews” on page 95
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The content review feature is explained through the following
topics.
•

”Inserting the ContentReview Server Control” on page 92

•

”Limiting Visitors to One Review” on page 92

•

”Viewing the Content Rating Report” on page 92

Inserting the ContentReview Server Control
To allow site visitors to rate and review content on a Web page,
your developer inserts a server control. This procedure is
described in the Ektron CMS400.NET Developer Manual section
“ContentReview Server Control.”

Limiting Visitors to One Review
Ektron CMS400.NET assumes you want to limit a user to rating a

content item once. If a regular or membership user logs in before
rating a piece of content, Ektron CMS400.NET remembers the user
ID. For any other site visitor, Ektron CMS400.NET places a cookie
on his computer.
So, whenever a page with a ContentReview server control is
visited, Ektron CMS400.NET checks for the user ID or cookie. If
neither exists, it displays a rating scale. If the page has already
been rated by the user, the user can edit his existing rating and
review by clicking a star, editing the comments, and clicking the
submit button.

Viewing the Content Rating Report
All content rating and review data for a content item is maintained
and can be displayed in detail and summary format. To view this
data, follow these steps.
1. Sign in to Ektron CMS400.NET.
2. Do one of the following:
•

Navigate to the content item in the Workarea
- Go to Workarea > Content.
- Navigate to the folder that contains the content.
- Navigate to the content item.
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- Click the View Rating Reports toolbar button (
•

).

If the review is awaiting moderation, use the Content Review
section of the Smart Desktop.
- Go to the Workarea > Smart Desktop
- Click Content Reviews
- Select the content item

The Content Rating Report shows a summary of all ratings
submitted for the content.

If desired, you can select a range of dates and limit the display of
ratings data to those dates. Select start and end dates (using
calendar buttons at the top of the screen) and click Get Result.

Viewing Content Rating Details
To view details of the ratings data, click Get Result (see illustration
below).
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Displaying Reviews on the Site
Displaying reviews on your site allows visitors see how other
people in your site’s community feel about a product or content
article. It also helps build that community by empowering site
visitors and allowing them to have voice.
If your site displays reviews and a user does not see his review, it
is probably because moderation is enabled for the content reviews.
If a user’s review is pending or rejected, it is not displayed. A site or
membership user can determine the status of his review by logging
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into the site and navigating to the Web page that hosts the content
review. Next to the title of his review is Rejected or Pending. The
user can then submit another review if his review was rejected or
has been pending for too long.
The ContentReview server control’s DisplayXSLT property handles
the displays of site visitor reviews on the site. The server control
can display reviews for specific content or a specific user. For
additional information on the DisplayXSLT property, see the Ektron
CMS400.NET Developer Manual section “ContentReview Server
Control.

Moderating Reviews
Since reviews can be displayed on your Web site, Ektron
CMS400.NET lets you moderate reviews from the Content Ratings
screen in the Workarea. This capability is handled by the
ContentReview server control’s Moderate property. See the Ektron
CMS400.NET Developer Manual section “ContentReview Server
Control” > “ContentReview Server Control Properties” >
“Moderate.”
A site visitor can change his rating and review at any time, even if
its status is pending or rejected. When a visitor changes his rating
or review, the information is updated immediately in the Workarea,
and the review’s status changes to pending.
There are two ways to moderate reviews.
•

from the Smart Desktop > Content Reviews area. See Also:
”Moderating Reviews From the Smart Desktop” on page 95

•

from the Content Rating screen associated with a content item
See Also: ”Moderating Reviews From the Content Rating
Screen” on page 101

Moderating Reviews From the Smart Desktop

To moderate reviews from the Smart Desktop, follow these steps.
1. Sign in to Ektron CMS400.NET.
2. Click the Smart Desktop button.
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3. From the Smart Desktop, click the Content Reviews link.

4. The five latest reviews awaiting moderation appear. Note the
View all pending reviews link. Click it to see all pending
reviews. See Also: ”Viewing All Pending Reviews” on page 97

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

96

Managing HTML Content

5. Select an Approve or Decline radio button for each item in the
list.
6. Click the Update Reviews button.
Once the reviews are approved, they appear on the site.
NOTE

A ContentReview server control set to display reviews must be on the page for
reviews to be displayed. See the Ektron CMS400.NET Developer Manual section
“ContentReview Server Control” > “ContentReview Server Control Properties” >
“DisplayXSLT.”

Viewing All Pending Reviews

You can view all pending reviews by clicking the View all pending
reviews link in the Smart Desktop > Content Review screen.
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From that screen you can:
•

Approve or decline a review - select an Approve or Decline
radio button for each item on the list. Then, click the Submit
button(

•

).

Mark all reviews approved or all declined - click the Mark all
approved link to set all the radio buttons to Approve. Click the
Mark all declined link to set all the radio buttons to Decline.
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.

•

NOTE

Edit the rating, review or status of an individual review - click a
review’s title and the Edit screen appears. Change as needed.
Click the Save button ( ).

After editing a rating, click the Back Arrow to return to the content item’s Content
Rating screen.

•

Print a report of all pending content reviews - click the Print
button ( ) to create an HTML version of the pending content
review report that is ready for printing.

•

Email a pending content review report - click the Email button
( ) to email a pending content review report to Ektron
CMS400.NET users. Next, select the users to receive the
report. Then, click the Email button (
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•

Filter content reviews by folder - because reviews are
associated with content items in a folder, you can filter reviews
by folder. This makes it easier to moderate reviews if you are
responsible for content in a specific folder. Click the Folder
button ( ) and navigate to the folder by which the reviews will
be filtered. Then, click the Save button (

•

).

Filter reviews by language - from the Language dropdown box,
select the language by which the reviews are filtered.
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After you approve or decline reviews, click the Submit button (
Once reviews are approved, they appear on the site.

).

Moderating Reviews From the Content Rating Screen

To moderate content reviews from Content Ratings screen, follow
these steps:
1. Navigate to the Content Ratings screen for the content item
using one of the methods in ”Viewing the Content Rating
Report” on page 92.
2. Click the Get Results button.
3. A list of reviews appear for the content.
4. Click the Date link of the content to be moderated.
5. The View Rating screen appears.
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- To change information on this screen, click the Edit button
(
). From the Edit screen, you can change the rating,
review, and status. When finished, click the Save button
( ).
- To delete the review, click the Delete button (

).

Exporting Details to Excel
If Microsoft Excel is installed on your computer, you can export the
ratings detail to Excel for further manipulation of the data. To do so,
the Click Export to Excel button.

Purging Rating Data
You can remove content rating data to free up space in your
database. To do so, select the date range of the data you want to
purge using Start Date and End Date. Then click the Purge
button.
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Accessibility

By validating XHTML content and accessibility, you can ensure
your content is XHTML compliant and that individuals with
disabilities can navigate and understand your site.
This chapter is divided into two sections: ”Validating with
eWebEditPro+XML” on page 104 and ”Validating with
eWebEdit400” on page 113.
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eWebEditPro+XML can validate content against these types of
compliance.

NOTE

•

XHTML standards - see ”Validating Content for
Compliance with XHTML Standards” on page 110

•

Section 508 Validation - accessibility standards
established by agencies such as W3C Markup Validation
Service - see ”Validating Content For Compliance with
Accessibility Standards” on page 106

•

Smart Form Data - makes sure that data entered into a
smart form’s field is the correct type and format. This
selection only checks smart form fields if validation for the
field was turned on when it was added to the Smart Form.
Validation for each field type is explained in ”Data Designer
Field Types” on page 227.

An additional type of validation ensures that when a site visitor completes a
Web form, the information is formatted correctly. For example, a Social
Security number must have three numbers, a dash, two numbers, another
dash, and four numbers. This type of validation is explained in Ektron
CMS400.NET’s User Manual section “Introduction to eWebEdit400” >
“Working with HTML Forms” > “Form Validation.”

An editor can validate content while editing by clicking the
Validate button ( ). In addition, a validation check is
performed when a user tries to save, check in or (submit for)
publish content.
In addition, some dialogs add accessibility data to Ektron
CMS400.NET content. As an example, the Picture Properties is
used to add an image’s <alt> attribute.
The rest of this section provides details about validating
XHTML content through these topics.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

104

Validating with eWebEditPro+XML

•

”Dialogs that Allow Input of Accessibility Information” on
page 105

•

”Validating Content For Compliance with Accessibility
Standards” on page 106

•

”Validating Content for Compliance with XHTML Standards” on
page 110

Dialogs that Allow Input of Accessibility
Information
Several dialog boxes collect accessibility data. See example
below.
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When the cms_config.aspx’s suggestdefaultval property is set to true,
Ektron CMS400.NET tries to ensure that a value exists in required
accessibility fields of the following dialogs.

Dialog

Field

How filled if no value exists

Picture Properties

Title

Contents of File Selection field copied

Hyperlink

Title

Contents of Text field copied

Group Box

Caption

Contents of Descriptive Name field copied to
Caption field

Several Data Designer dialogs,
such as Plain Text Field, Image
Only field, Link Field, Select List
Field

Tooltip text

Contents of Descriptive Name field copied

Validating Content For Compliance with
Accessibility Standards
To have Ektron CMS400.NET check content for compliance with
accessibility standards, you enable accessibility in the Setup
screen and specify an XSLT or Web site to check against.

Enabling Accessibility Validation
In the Ektron CMS400.NET Workarea, accessibility options appear
on the Settings > Configuration > Setup screen under
Accessibility/Section 508 Evaluation (below Editor Options).
The options are explained below.
•

Do not validate - do not check content for compliance with
accessibility standards

•

Warn if fails - the user is warned but allowed to publish the
content

•

Enforce - the user must bring the content into compliance
before submitting it for publication or publishing it; however,
can save it or check it in after being warned.
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Defining the XSLT or Web Site
When a user tries to save content and Accessibility/Section 508
Evaluation is set to Warn if fails or Enforce, the content is
checked against an XSLT, a Web site designed to validate content,
or both.
If you enable both, the content is checked in this order.
1. XSLT
2. Web site
If the first check fails, the second check is not performed.

The XSLT File
Ektron CMS400.NET content can be checked against an XSLT that

enforces W3C’s WCAG Level 1 requirement. By default, this XSLT
is site root/Workarea/ewebeditpro/ektaccesseval.xslt. You can
modify this XSLT as needed.
If you want to use a different XSLT, place it in the Ektron
CMS400.NET root directory and refer to it in the site root
folder\Workarea\ewebeditpro\cms_config.aspx

file’s xslt

src

attribute,

as shown below.
<xslt enabled="true" src="[eWebEditProPath]/ektaccesseval.xslt" />

If you change the XSLT and validation fails, it should return a
description of the problem(s) as HTML. If validation succeeds, it
should return nothing.

Validating Against a Web Site
You can also validate XHTML content for accessibility against a
Web site. Two such sites are listed in site
root\Workarea\ewebeditpro\cms_config.aspx.
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•

hermish.com

•

webaim.org

You can use either listed site or any other site designed to check
for accessibility compliance. However, you can only use one.
NOTE

Changes to these web sites may adversely affect the ability to validate. Ektron
cannot control how validation Web sites operate. Your ability to change the
validation Web site is described below.

The Web sites are specified in these lines of cms_config.aspx. To
activate a site, set enabled to true.
<online enabled="false" type="string" contentname="myHTML" src="http://www.hermish.com/
check_this.cfm">
<online enabled="false" type="file" contentname="upload" src="http://wave.webaim.org/wave/
Output.jsp">

Enabling a Site Not Included in cms_config.aspx
By default, Ektron CMS400.NET only supports sites listed in
cms_config.aspx. If you want to validate content against another
Web site designed to do that, follow these guidelines.
•

Web sites that perform validation typically accept input in this
format.

<form action="http://www.example.com/validationaction.asp">
<textarea name="testcontent"></textarea>
<input type="submit" name="btnSubmit" value="Validate the
content"/>
</form>

To accommodate this format, define the cms_config.aspx’s <online>
element as follows.
<online enabled="true" type="string" contentname="testcontent"
src="http://www.example.com/ validationaction.asp"
keywordsearchresult="failure" keyword="invalid">
<data name=" btnSubmit"> Validate the content</data>
</online>

The following table describes <online>’s attributes.
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<Online> Attribute

Description

type

If the form accepts an HTML string as input, enter string.
If the form accepts a file name as input, enter file.

contentname

Enter the value of the name attribute of the textarea or input
element in the form.
For a form that accepts an HTML string, the textarea may
appear as:
<textarea name="testcontent"></textarea>

In this case, the value for contentname would be
testcontent.
For a form that accepts a file, the input element may appear
as:
<input type="file" name="testfile" />

In this case, the value for contentname would be testfile.
src

To obtain the URL of the Web page that validates HTML
content, go to the site and view the source. From there, you
should be able to obtain the form’s action attribute. Place
that into this attribute.

keywordsearchresult

Takes one of two values: failure or success.
•

If set to success and Ektron CMS400.NET finds the
keyword (set in the keyword attribute) in the validating
Web page’s response, the content is saved.

•

If set to success and Ektron CMS400.NET does not
find the keyword in the validating Web page’s
response, the Web site’s failure page appears. Typically, the page explains why the content failed validation.

•

If set to failure, and Ektron CMS400.NET finds
the keyword (set in the keyword attribute) in the validating Web page’s response, Web site’s failure page
appears. Typically, the page explains why the content
failed validation.

•

If set to failure, and Ektron CMS400.NET does
not find the keyword in the validating Web page’s
response, the content is saved.

If you do not define a keyword and keywordsearchresult,
the validating Web page’s response (or report) appears.
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<Online> Attribute

Description

keyword

Enter a text string that E ktron CM S40 0. NET searches for
in the source of the Web site’s response to the validation
check.
For example, if the site displays Congratulations when
validation passes, enter Congratulations in this attribute.
In this case, enter success as the keywordsearchresult.
As another example, if you know that a Web site displays
the images/icon_violation.gif image when validation
fails, enter that as the keyword. In this case, enter failure
as the keywordsearchresult.

data

Enter additional form fields to be posted to the Web site
during form submission.
•

The name attribute of the data tag specifies the name of
the form field.

•

The value between the data tags is the value of the
form field when submitted.

You may specify as many data tags as needed. For
example
<data name="btnSubmit">Validate the content</
data>

Validating Content for Compliance with XHTML
Standards
Ektron CMS400.NET content can be validated against the XHTML

1.0 schema, a Web site, or both. These are described in ”The
Schema” on page 110 and ”Validating Against a Web Site” on
page 111.
NOTE

This validation does not consider the value of the Workarea > Configuration
>Setup Screen’s Accessibility/Section 508 Evaluation fields.

Besides specifying a schema or Web site, you need to uncomment
the following line in site root/Workarea/ewebeditpro/ektfilter.xslt.
This XSLT removes non-W3C-compliant tags and attributes.
<xsl:include href="ektfilterxhtml10.xslt"/>

The Schema
eWebEditPro+XML provides two schemas from the W3C site.
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•

www.w3.org/2002/08/xhtml/xhtml1-strict.xsd

•

www.w3.org/2002/08/xhtml/xhtml1-transitional.xsd

The schemas are installed to the siteroot/workarea/ewebeditpro
directory. You identify which schema will be used in the following
lines of the siteroot/workarea/ewebeditpro/config.xml file.
<schema enabled="false" src="[eWebEditProPath]/xhtml1-strict.xsd"/>
<schema enabled="false" src="[eWebEditProPath]/xhtml1-transitional.xsd"/>

To specify a schema against which to validate content, set enabled
to true.
You can modify either .xsd file as needed. Or, you can use your
own .xsd file.

Using Your Own Schema
The schema tag’s src attribute can reference any URL. If you want to
place your own .xsd file in the siteroot/workarea/ewebeditpro
directory, use [eWebEditProPath]. To place the .xsd file in another
location, enter its path relative to the site root. For example, src=”/
siteroot/schemas/myschema.xsd”.

IMPORTANT!

If you are using a different .xsd file, you must add
elementFormDefault="qualified" to the schema as shown below.
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema"
elementFormDefault="qualified">

IMPORTANT!

Because of an error in XML parser 4 (see http://support.microsoft.com/
default.aspx?scid=kb;EN-US;q262585), Ektron has removed the namespace from
the schemas. If you design your own schema, do not use 'xml' to begin userdefined namespace prefixes.

Validating Against a Web Site
You can validate content against any Web site that enforces W3C’s
XHTML standards. One site listed in cms_config.aspx is
validator.w3.org. You can use that site or another designed to
check for XHTML compliance.
To activate that site, open the siteroot/workarea/ewebeditpro/
file, and set enabled to true, as shown in the code snippet
shown below.

config.xml
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<online enabled="true" type="string" contentname="fragment" src="http://validator.w3.org/
check"/>

If you want to use a different Web site, follow the directions in
”Enabling a Site Not Included in cms_config.aspx” on page 108.
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eWebEdit400 can check content for the following types of

compliance.
•

NOTE

Design - checks for the design standards such as proper
closing tags and unique field names.

There is nothing you need to do to enable this type of validation, nor can you
customize it.

•

XHTML standards - see ”Validating Content for Compliance
with XHTML Standards” on page 116.

NOTE

•

Section 508 Validation - accessibility standards
established by agencies such as W3C Markup Validation
Service - see ”Setting up and Customizing Accessibility
Validation” on page 114.

•

Smart Form Data - makes sure that data entered into a
smart form’s field is the correct type and format. This
selection only checks smart form fields if validation for the
field was turned on when it was added to the Smart Form.
Validation for each field type is explained in ”Data Designer
Field Types” on page 227.

An additional type of validation ensures that when a site visitor completes a
Web form, the information is formatted correctly. For example, a Social
Security number must have three numbers, a dash, two numbers, another
dash, and four numbers. This type of validation is explained in Ektron
CMS400.NET’s User Manual section “Introduction to eWebEdit400” >
“Working with HTML Forms” > “Form Validation.”

An editor can validate content while editing by clicking the
Validate button (

) (illustrated below).
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In addition, eWebEdit400 automatically validates content whenever
the user tries to save, check in or (submit for) publish content. See
Also: ”Step 1: Enable Accessibility” on page 114
When validation is checked, any errors appear on the screen. If the
content passes validation, a message states The content is valid.
The rest of this section provides details about validating XHTML
content through these topics.
•

”Setting up and Customizing Accessibility Validation” on
page 114

•

”Validating Content for Compliance with XHTML Standards” on
page 116

Setting up and Customizing Accessibility Validation
To have eWebEdit400 check content for compliance with
accessibility standards, follow these steps.
See Also:
•

”Step 1: Enable Accessibility” on page 114

•

”Step 2: Use Dialogs to Enter Accessibility Information” on
page 115

•

”Customizing Accessibility Checks” on page 116

Step 1: Enable Accessibility
In the Ektron CMS400.NET Workarea, accessibility options appear
on the Settings > Configuration > Setup screen under
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Accessibility/Section 508 Evaluation (below Editor Options).
The options are explained below.
•

Do not validate - do not check content for compliance with
accessibility standards

•

Warn if fails - the user is warned but allowed to publish the
content

•

Enforce - the user must bring the content into compliance
before submitting it for publication or publishing it; however,
can save it or check it in after being warned.

Step 2: Use Dialogs to Enter Accessibility Information
Several dialog boxes let the content editor enter accessibility
information. An example is below.

The table below lists dialog boxes in which accessibility information
can be entered.
Dialog

Field

How filled if no value exists

Image Properties

Image Alt Text:

Uses the image’s title

Table Wizard - Cell
Properties Tab

Abbreviation:

Not automatically filled when no value
exists

Categories:
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Dialog

Field

How filled if no value exists

Table Wizard - Accessibility
Tab

Caption:
Summary:

Not automatically filled when no value
exists

Hyperlink Manager

Tooltip:

Contents of Link Text field copied

(Includes Quicklinks)

Customizing Accessibility Checks
All standard accessibility checks are stored in the site root/
Workarea/Content Designer/ektaccesseval.xslt file. If you want to
customize which checks are applied, edit that file.
To change or disable the .xslt file that eWebEdit400 uses to
validate for accessibility, edit this line of site root/Workarea/
Content Designer/ValidateSpec.xml.
<validate>
<xslt id="ektaccesseval" name="Section 508 Validation" enabled="true" src="[srcPath]/
ektaccesseval.xslt"/>

Validating Content for Compliance with XHTML
Standards
Ektron CMS400.NET content can be validated against the XHTML

1.1 standard. To do so, you must define the Web sites that validate
schema files and schema namespaces.
Here are two sites that can validate content using the WC3 Markup
Validation Services.
•

schema files - http://www.w3.org/2002/08/xhtml/xhtml1transitional.xsd

•

schema namespaces - http://www.w3.org/1999/xhtml

Defining the XHTML Validation Schemas
To validate content against XHTML standards, follow these steps.
1. Using Visual Studio, open site

root/Workarea/edit.aspx.vb.

2. Find the section indicated below.
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3. Using Intellisense, enter SchemaFiles and SchemaNamespaces
properties to define the validating Web sites. They accept an
array of strings and go in pairs. Here are examples.
C#
ContentDesigner1.SchemaFiles = new string[] {"http://www.w3.org/2002/08/xhtml/xhtml1transitional.xsd"};
ContentDesigner1.SchemaNamespaces = new string[] { "http://www.w3.org/1999/xhtml" };

VB.Net
With m_ ContentDesigner1
.SchemaFiles = New String() {" http://www.w3.org/2002/08/xhtml/xhtml1-transitional.xsd"}
.SchemaNamespaces = New String() {"http://www.w3.org/1999/xhtml”}
End With
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Metadata is information about a content item, such as its title
and language. Ektron CMS400.NET provides extensive and
flexible support for metadata, which it uses in both standard
and innovative ways.
This section explains the types of metadata available, and
procedures for working with metadata through the following
subtopics.
•

”Types of Metadata” on page 118

•

”Working with Metadata Definitions” on page 128

Types of Metadata
The following kinds of metadata can be added to Ektron
CMS400.NET content.

Metadata type

Description

For more information,
see

Meta tag

Resides in the source code. Helps search engines
find a Web page.

”Meta Tags” on page 119

Note: You can use the SEO Control to identify how
search engines evaluate your Web pages’
metadata tags, and other search tools. See Also:
E k t r o n C M S 4 0 0 . N E T Developer Manual section
“Using the Search Engine Optimization (SEO)
Control.”
HTML tag

Information about the page to be used by a Web
browser. For example, <title> identifies the
content in the screen title, the favorites list, and
the browser’s history.
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Metadata type

Searchable

Description

For more information,
see

Metadata that can be found by E k t r o n

”Searching for Metadata”
on page 445

C M S 4 0 0 . N E T ’s search.

Related content

A related content item, collection, List Summary,
or library item that accompanies a content item on
a Web page.

”Related Content
Metadata” on page 123

Simple Dublin
Core

A set of fifteen standard fields that cover the most
useful information about content.

”Simple Dublin Core
Metadata” on page 126

Content tags

Keywords that can be assigned to content and
library items and allows for tag-based searching.

”Tags” on page 981

Best Practices

•

When anyone creates a new Metadata definition, it is
assigned the next available ID number. The ID numbers
determine the order in which metadata definitions are
arranged on the Folder Properties screen’s Metadata
tab.
So, by planning ahead, you can enter metadata
definitions in logical groupings, which will make it more
intuitive for the person assigning the metadata to pick
the correct ones.

•

Metadata can be used as a search criterion to find
content on your Web site. In order for this to work, the
metadata definition name cannot include a space. So, it
is a good idea to eliminate spaces from metadata
definition names.

Meta Tags
The META element is an extensible container for use in identifying
specialized document meta-information. Meta-information has two
main functions:
•

to provide a means to discover that a data set exists and how it
might be obtained or accessed
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•

to document the content, quality, and features of a data set,
indicating its fitness for use

(Above copied from www.w3.org/MarkUp/html-spec/html-spec_5.html.)

Example Meta Tags

Creating and Deploying Meta Tag Definitions
1. While creating a metadata definition, enter the metadata name
at the Name field. For example, Description and Keywords.
See Also: ”Adding a Metadata Definition” on page 129
2. Reply to the standard fields. See ”Metadata Definition Fields”
on page 131.
3. Respond to the additional fields for meta tags. See ”Meta Tag
Additional Fields” on page 132
4. Add the definition to all applicable folders. See ”Assigning
Metadata to a Folder” on page 141
5. Add the definition to applicable content within the folder. See
”Adding Metadata to Content” on page 144
6. Add a Metadata server control to every Web form (.aspx page)
on which the content will appear.
To learn how to do this, see the Ektron CMS400.NET
Developer Manual section “Introduction to Ektron CMS400.NET
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Server Controls” > “MetaData Server Control” and
“MetaDataList Server Control.”

Title Tag
The title should identify the contents of the document in a global
context. A browser may display the title of a document in a history
list or as a label for the window displaying the document.
(Above text copied from www.w3.org/MarkUp/html-spec/htmlspec_5.html.)

Creating and Deploying Title Tag Definitions
1. While creating a metadata definition, enter Title at the Name
field. See Also: ”Adding a Metadata Definition” on page 129
2. Reply to the standard fields. See ”Metadata Definition Fields”
on page 131.
3. Respond to the additional field for HTML tags. See ”HTML Tag
Additional Field” on page 131.
4. Add the definition to a folder. See ”Assigning Metadata to a
Folder” on page 141.
5. Add the definition to content within the folder. See ”Adding
Metadata to Content” on page 144.
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6. Add a metadata control to every Web form (.aspx page) on
which this content will appear.
To learn how to do this, see the Ektron CMS400.NET
Developer Manual section “Custom Functions (for your server
platform)” > “Metadata Function”, “MetaData Server Control”
and “MetaDataList Server Control.”

Creating and Deploying Search Tag Definitions
1. While creating a metadata definition, in the Name field, enter a
description of the kind of data to be searched. (See examples
circled above.) This title describes the search data on the
•Metadata tab of the Folder Properties screen
•Metadata tab of the View Content Screen
•Workarea search screen
NOTE

Searchable metadata field names should not include a space. If they do, the
search cannot find the metadata.

See Also: ”Adding a Metadata Definition” on page 129
2. Reply to the standard fields. See ”Metadata Definition Fields”
on page 131.
3. Respond to additional fields for Searchable Property
definitions. See ”Searchable Additional Fields” on page 133.
4. Add the definition to a folder. See ”Assigning Metadata to a
Folder” on page 141.
5. Add the definition to content within the folder. See ”Adding
Metadata to Content” on page 144.
6. The next time you visit the Workarea search screen, you will
see the new field.
7. If you want site visitors to use this field when searching your
Web site, ask your developer to set the ShowExtendedSearch
property of the Search Server Control to true. This value
enables the Web site search to find searchable metadata.
See Also: Ektron CMS400.NET Developer Manual >
“Introduction to Ektron CMS400.NET Server Controls” >
“Search Server Control” > “Search Server Control Properties” >
“ShowExtendedSearch”
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Related Content Metadata
You can associate the following types of content with a content
item.
•

a content item

•

a collection

•

a list summary

•

a menu

•

a user

•

one of the following types of library items
- image
- hyperlink
- file

Then, you can set up a Web page so that whenever the source
content item appears, the related information appears next to it.
For example, your Web site sells motorcycle helmets. On a page
that shows a particular helmet, the left column lists a collection of
motorcycle drivers who wear that helmet. Another example might
be that you want to show the profile of a user when a given content
item is displayed.

Related Content vs. MetadataList Server Control
This capability is similar to the MetadataList Server control. The
difference is that MetadataList shows a link to every content item
with a selected term in the keywords or title. Also, a MetadataList is
associated with a Web form (.aspx page), not a content item.
Related content lets you connect a content item with several types
of related content (see list above), and is associated with a content
item, not a web form. For example, you can display a library image
of the company logo on a page whenever content in a certain
folder appears. For content in a different folder, a different logo
could appear.
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Creating and Deploying Related Content Definitions
1. While creating a metadata definition, in the Name field, enter a
title for this kind of data. This title describes the metadata on
the
•Metadata tab of the Folder Properties screen
•Metadata tab of the View Content screen
See Also: ”Adding a Metadata Definition” on page 129
2. Reply to the standard fields. See ”Metadata Definition Fields”
on page 131.
The Type must end with the word Selector. Choices are
highlighted below.

For example, if you choose ListSummary Selector, a
specified List Summary will appear on the page along with its
associated content item.
Your choices are
•Collection Selector
•ListSummary Selector
•Content Selector
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•Image Selector (associates a library image with content)
•Hyperlink Selector (associates a library hyperlink with content)
•File Selector (associates a library file with content)
•Menu Selector
•User Selector
3. Add the metadata definition to all appropriate folders. See
”Assigning Metadata to a Folder” on page 141
4. For each content item with which you want to associate related
content, access its Metadata tab and identify the related
item(s).
WARNING!

If you are using Collection Selector type, only users with permission to work with
collections can select a collection. Also, if you are using Image, Hyperlink or File
Selector type, only users with permission at least read-only Library permissions
can select a library item. See Also: ”Setting Permissions” on page 768

For example, a collection of pages describes motorcycle
helmets. You want this collection to appear whenever a helmet
is being viewed.
To set this up, you would
- edit the helmet content item
- click its Metadata tab
- find the metadata definition for the collection
- click Change
- select the Helmet Collection

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

125

Metadata

5. Have your Web developer add code to each page on which the
related item appears. To learn how to do this, access the
developer sample page (http://localhost/cms400developer/
developer/default.aspx) and read the Metadata > Meta
Associations description.
NOTE

To download the developer sample site, go to http://www.ektron.com/
solutions/startersites/.

Simple Dublin Core Metadata
Simple Dublin Core is a set of fifteen standard names for metadata
fields designed to cover the most useful items of information on a
document. From the Dublin Core site FAQ: “Dublin Core metadata
provides card catalog-like definitions for defining the properties of
objects for Web-based resource discovery systems.” For more
information, refer to the Usage Guide: http://www.dublincore.org/
documents/usageguide/.
By using the Metadata Server Control, you automatically create
seven of the fifteen Dublin Core metadata fields. These fields are
automatically filled with the information from the equivalent Ektron
CMS400.NET property. Below is a list of the seven fields and their
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Ektron CMS400.NET equivalent. For more information on the
Metadata Server Control, see the Developer’s Manual section
“Introduction to Ektron CMS400.NET Server Controls” > “MetaData
Server Control”

Dublin Core Field Name

Ektron CMS400.NET Property

DC.title

Content block title

DC.description

Plain text version of a content summary

DC.contributor

Content block last editor name

DC.date

Content block last edit date

DC.format

“text/html”

DC.identifier

URL of current page (from ASP.NET
Server.Request object)

DC.language

CMS language cookie / current site
language, expressed as a .NET
System.Globalization Culture Name

Creating the Additional Eight Fields
To fully comply with the Simple Dublin Core metadata element set,
the administrator must create the remaining eight Dublin Core
fields as standard CMS400.NET Metadata definitions and apply
them to all CMS400.NET folders. Next, CMS users complete the
appropriate values for each content block.
WARNING!

When creating the Dublin Core metadata fields in the Metadata section of the
Workarea, you do not need to create the first seven fields in the table above. In
addition, the names of the fields you create must match the names below. For
example, in the name field, enter “DC.subject”. The DC identifies the metadata as
Dublin Core metadata.

The remaining eight Simple Dublin Core fields are described
below:
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NOTE

These descriptions are from the Dublin Core Metadata Initiative site. For a more
detailed description, visit http://www.dublincore.org.

•

DC.subject - The topic of the content of the resource.
Typically, a Subject is expressed as keywords, key phrases, or
classification codes that describe the topic of the resource.

•

DC.type - The nature or genre of the content of the resource.
Type includes terms describing general categories, functions,
genres, or aggregation levels for content.

•

DC.source - A reference to a resource from which the present
resource is derived. For example, DC.source=”Image from
page 54 of the 1922 edition of Romeo and Juliet”

•

DC.relation - A reference to a related resource.

•

DC.coverage - The extent or scope of the content of the
resource. Coverage typically includes spatial location (a place
name or geographic co-ordinates), temporal period (a period
label, date, or date range) or jurisdiction (such as a named
administrative entity). Examples: DC.coverage=”1995-1996”,
DC.coverage=”Boston, MA”, DC.coverage=”17th century” or
DC.coverage=”Upstate New York”.

•

DC.creator - An entity primarily responsible for making the
content of the resource.

•

DC.publisher - The entity responsible for making the resource
available.

•

DC.rights - Information about rights held in and over the
resource. Typically, a Rights element contains a rights
management statement for the resource, or reference a service
providing such information.

Working with Metadata Definitions
NOTE

Only members of the Administrator User Group and those defined in the Manage
Members for Role: Metadata-Admin screen can view, add, or edit metadata
definitions. See Also: ”Using the Roles Screens” on page 788

Procedures for creating, updating and deleting metadata
definitions are explained in the following sections.
•

”Adding a Metadata Definition” on page 129

•

”Viewing Metadata Definitions” on page 139
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•

”Editing a Metadata Definition” on page 139

•

”Deleting a Metadata Definition” on page 140

•

”Assigning Metadata to a Folder” on page 141

•

”Adding Metadata to Content” on page 144

Adding a Metadata Definition
Use the Add Metadata Properties screen to define metadata (such
as keywords and title). You can define as many instances of
metadata as you wish.
If your site supports multiple languages, you create metadata
definitions for each supported language.

To define one instance of metadata, follow these steps.
WARNING!

After creating a definition, you must assign it to all folders whose content should
use it. You assign a metadata definition to a folder in the folder’s properties. See
”Assigning Metadata to a Folder” on page 141.

1. From the Workarea’s left frame, click Settings >
Configuration > Metadata Definition.
2. The View Metadata Definitions screen appears.
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3. Select the language for the metadata you are about to define.
This metadata will only be available to content in this language.
4. Click the Add Metadata Definition button (

).

5. The Add Metadata Definition screen appears. Using the
following table, add the needed information.
After you create a metadata definition, you may see the following
error in the Windows Event Viewer Log.

To learn more about this problem and how to resolve it, see the
following Microsoft KB article: http://support.microsoft.com/kb/
310680.
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Metadata Definition Fields

Field

Description

Name

Enter a name to identify this metadata.
Note: Searchable metadata field names should not include a space. If they do,
the search cannot find the metadata.
Ek tron CM S40 0.NET reserves a list of names that you cannot use. If you

enter one of them, the following error message appears when you try to save
the definition.

Type

Editable

From the drop-down list, select whether this tag is
•

a searchable property - See Also: ”Searchable Additional Fields” on
page 133

•

an HTML tag (for example, <title>) - See Also: ”HTML Tag Additional
Field” on page 131 and ”Title Tag” on page 121

•

a Meta tag (<meta>) - See Also: ”Meta Tag Additional Fields” on
page 132 and ”Meta Tags” on page 119

•

Collection Selector, ListSummary Selector, Content Selector, Image
selector, Hyperlink Selector, File Selector - See Also: ”Related Content
Metadata” on page 123

Check this box if you want to allow users to edit the contents of the metadata
when creating or editing the metadata’s content.
Uncheck this box if you want uniform metadata text for each content item that
uses this metadata.

HTML Tag Additional Field
See Also: ”Title Tag” on page 121
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Field

Description

Default Text

Enter default content for the HTML tag. For example:
content="document management web content management content
management cms"

Meta Tag Additional Fields
NOTE

For background information about metadata, see http://www.w3.org/TR/REChtml40/struct/global.html#edef-META.

See Also: ”Meta Tags” on page 119
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Field

Description

Style

Select from the drop-down list to indicate whether you want the style to
be name or http-equiv.
For more information, see http://www.w3.org/TR/REC-html40/struct/
global.html#h-7.4.4.2

Remove Duplicates

Check this box to remove duplicate words or phrases from the metadata.

Case Sensitive

Check this box to remove duplicates only if the letters and case of each
letter match.

Separator

Enter a character to separate the metadata values. The default is a
semicolon (;).

Selectable Metadata

Check this box to force users to select from the options specified in the
Allow Selectable Text and Default Text fields.
If you do not check this box, users can create their own metadata.

Allow Multiple
Selections

Check this box to let users select multiple metadata values instead of
one. If multiple values are allowed, use the separator character to delimit
them.
If this box is not checked, all values appears in a drop-down list, and the
user selects the correct one.
This field is only active if the Selectable Metadata box is checked.

Allowed Selectable
Text

Enter standard metadata that can be selected by users. Separate each
option by the separator specified for the metadata definition.
This field is only active if the Selectable Metadata box is checked.

Default Text

Enter default content for the metadata tag.

Searchable Additional Fields
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Field

Description

Publicly Viewable

If you check the box, site visitors can find the metadata value when
searching your Web site. Otherwise, site visitors cannot find the metadata
value.
Note: Regardless of whether this is checked, this metadata value can be
found using the Workarea’s Search Content Folder screen. Only loggedin users can access the Workarea.
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Field

Description

Style

Select the style of the response field from these choices (available in a
dropdown list). You are specifying the kind of information that a user
adding searchable properties to content will enter to describe the data.
Later, anyone using the search can search on that information.
See Also: ”Assigning Metadata to a Folder” on page 141
•

Text - The user enters free text to describe the content.

•

Number - The user enters a number to describe the content.

•

Byte - 1 byte. 0 through 255 (unsigned)

•

Double - 8 bytes. -1.79769313486231570E+308 through 4.94065645841246544E-324 † for negative values;
4.94065645841246544E-324 through 1.79769313486231570E+308
† for positive values

•

Float - (single-precision floating-point) 4 bytes. -3.4028235E+38
through -1.401298E-45 † for negative values; 1.401298E-45 through
3.4028235E+38 † for positive values

•

Integer - 4 bytes. -2,147,483,648 through 2,147,483,647 (signed)

•

Long - 8 bytes. -9,223,372,036,854,775,808 through
9,223,372,036,854,775,807 (9.2...E+18 †) (signed)

•

Short - 2 bytes. -32,768 through 32,767 (signed)

•

Date - The user enters a date to describe the content.

•

Yes or No - The user answers yes or no to describe the content. For
example, if the content describes automobile parts, the user could
answer yes to include new and used parts or no to search for new
parts only.

•

Select from a list - The user picks a from a list to describe the content.

For an illustration of this style on the Edit Content screen/Searchable
Properties tab and the Web site search screen, see ”Select from a List”
on page 136.
•

Multiple selections - The user selects an item from a dropdown list.

For an illustration of this style on the Edit Content screen/Searchable
Properties tab and the Web site search screen, see ”Multiple Selections”
on page 136.
See Also: ”Converting the Style of a Metadata Definition” on page 137
Default

If desired, enter the most common response to this definition.
The default value is automatically applied to all existing content within
folders to which this definition is assigned.
While editing content that uses this definition, a user can accept the
default value or change it.
See Also: ”Effect of a Default Value on Required Metadata” on page 143
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Select from a List
NOTE

The following graphics depict searchable metadata when using the Site Search
server control. They do not appear when using the Web Search server control.

Appearance on Edit Content Screen > Metadata Tab

Appearance on Search Screen

Multiple Selections
Appearance on Edit Content Screen > Metadata Tab
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Appearance on Search Screen

Converting the Style of a Metadata Definition
This section explains how Ektron CMS400.NET handles changing
the style of a searchable property type of metadata. For example,
you create a definition to collect Part Number. Originally, the style
is text, but you later decide its style should be number.
When you change the style of searchable property type metadata,
Ektron CMS400.NET attempts to maintain any data stored in
content blocks that use the definition. For example, if the data style
was number and you change it to text, the number stored for that
metadata definition is converted to text and maintained in all
content that uses it.
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However, sometimes Ektron CMS400.NET cannot maintain the data
when you change the style. For example, if you change a
metadata definition style from number to date, Ektron CMS400.NET
cannot convert those styles. In this case, any data stored in
metadata definitions is lost.
The following table illustrates all conversion scenarios and how
Ektron CMS400.NET handles each one. It indicates whether data is
maintained after you convert from a data style in the left column to
a style to its right.

Text

Number

Date

Boolea
n

Single
Select

Multiple
Select

-

OK

OK

NO

NO

NO

Number

OK

-

NO

NO

NO

NO

Date

OK

NO

-

NO

NO

NO

Boolean

OK

NO

NO

-

NO

NO

Single Select

OK

NO

NO

NO

-

OK

Multiple
Select

OK

NO

NO

NO

NO

-

Text

Table legend
•

OK - Data is maintained

•

NO - Data is lost during conversion

When you change the style of a metadata definition, the screen
often gives you these choices:
•

Use existing data if possible, else default

•

Use default value
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Following these choices is a field that lets you define a default
value. If you want to simply replace any existing data, select Use
default value and enter the new value in the Default field.
If the data is convertible (according to the table above), and you
want to maintain existing data if possible, select Use existing data
if possible, else default. Then, enter a default value below. If the
existing data cannot be maintained, the default value replaces it.

Viewing Metadata Definitions
You may view any metadata definition. To do so, follow these
steps.
1. From the Workarea’s left frame, click Settings >
Configuration > Metadata Definition.
2. The View Metadata Definitions screen appears.
3. Select a language from the drop-down list.
4. Click the Metadata definition you want to view.
5. The View Metadata Definition screen appears. From here, you
can edit and delete this definition.
See Also: ”Metadata Definition Fields” on page 131

Editing a Metadata Definition
NOTE

You cannot edit the definition for the following Ektron standard metadata.
* MapLatitude
* MapLongitude
* MapAddress
* MapDate
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To edit a metadata definition, follow these steps.
1. Access the View Metadata Definition screen whose definition
you want to edit, as described in ”Viewing Metadata
Definitions” on page 139.
2. Click the Edit button (

).

3. The Edit Metadata Definition screen is displayed.
4. Make the necessary changes to the definition.
See Also: ”Metadata Definition Fields” on page 131
5. Click the Update button (

).

What Happens When a Metadata Definition is Edited?
If you create a metadata definition, assign it to a folder, then users
insert metadata information into their content, the collected
information takes on the characteristics of the metadata definition.
For example, if the metadata is title and its type is HTML tag, this
is how it appears in the Web page’s source code.
<title>CMS Developer</title>

If you later change its type to Meta, the following effects occur:
•

metadata to which the definition has already been assigned
maintains the previous style definition. For example, <title>CMS
Developer</title>.

•

when you create a new content item that uses the metadata
definition, its metadata takes on the new style. For example,
<meta name="title" content="CMS developer">.

Deleting a Metadata Definition
You can remove metadata definitions that are no longer used from
the Ektron CMS400.NET site. When you delete a definition, it is
removed from every content item that uses it.
To delete a definition, follow these steps.
1. Access the View Metadata Definition screen for the definition,
as described in ”Viewing Metadata Definitions” on page 139.
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2. Click the Delete button (

).

3. A confirmation message is displayed.
4. Click OK.
5. Another confirmation message is displayed.
6. Click OK.

Assigning Metadata to a Folder
After creating a metadata definition (see ”Adding a Metadata
Definition” on page 129), assign it to folders whose content will use
it.
On each folder’s properties screen, you determine which metadata
definitions can be used.The section of the folder properties screen
used to assign metadata appears below. Only metadata definitions
whose Assigned box is checked can be completed by users
working with content in the folder.

Then, while creating or updating content, the user can insert the
metadata information via the Metadata tab (illustrated below).
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Requiring Users to Enter Metadata
You can determine that a metadata value must be inserted before
content can be saved (see the Required checkboxes in the
illustration above). This occurs both when new content is added
and existing content is edited.
If you set a kind of metadata to be required, its label is red and
includes an asterisk (*) on the Metadata tab of the Edit Content
screen, as shown below.

If the user does not complete a required metadata field, a message
informs him that it must be completed before he can save the
content.
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Effect of a Default Value on Required Metadata
A default value can be defined when creating or editing a field
within a metadata definition. See Also: ”Adding a Metadata
Definition” on page 129
If a default value is defined for a required metadata field, the
default value is used when the user saves the content. In this case,
the user is not prompted to enter a value because the default value
is sufficient.

Inheritance of Metadata by Folder
Each folder can inherit metadata fields from its parent folder or
have a unique set of them. The information includes the kinds of
metadata that are assigned and which of those are required. For
example, you could assign the top folder (Content) all metadata
definitions, while you assign the Contacts folder (directly below it)
none.
On every folder’s Metadata tab, use the Break Inheritance check
box (illustrated below) to determine if metadata definitions are the
same as the parent folder or unique.

By default, Break Inheritance is not checked, which means that all
folders inherit metadata definitions from the root folder (Content).
When you check Break Inheritance, all inherited values appear by
default (that is, Assigned and Required boxes are either checked
or unchecked). You can then change the settings as desired.
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Adding Metadata to Content
When a user creates or updates content, he can define its
metadata within the assignments specified for its folder.
Default metadata values are applied without user intervention.
Instructions for adding metadata are found in the Adding or Editing
Data Metadata section of the Ektron CMS400.NET User Manual.
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Programmatically

Content can be created using a special function which lets
users add new content without logging in. To accomplish this,
your Web site developer places a form on your Web site which
lets users submit content without logging in. Here is a sample
Add Content form.
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Your Web site developer can customize this form to better suit your
needs. See the Ektron CMS400.NET Developer Manual for
additional information.
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The reports folder contains several reports to help you manage the
workflow of content through Ektron CMS400.NET. In most cases,
you choose a report that corresponds to the content’s status, then
view all content in that status. If appropriate, you can perform tasks
on selected content. For example, you can check in checked-out
content.
This chapter explains how to access the reports folder in your
Workarea, set criteria that determine the information on the
reports, and actions you can perform on them.
See Also:
•

”Accessing the Reports Folder” on page 147

•

”List of Standard Reports” on page 148

•

”Common Report Topics” on page 149

Accessing the Reports Folder
To access the Reports folder, follow these steps.
1. From the Ektron CMS400.NET Workarea, click the Smart
Desktop button in the top left corner (circled below).

2. Click the Reports folder.
3. A list of available reports appears.
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NOTE

The Approvals, Checked Out, and Content to Expire Reports are also available
from the Workarea.

The reports are described below.

List of Standard Reports
Report

Displays content in this
status

For more information, see

Approvals

Requiring your approval

”Approvals Reports” on page 157

Checked In Content

Checked in

”Checked In Report” on page 159

Checked Out Content

Checked out

”Checked Out Report” on page 160

New Content

New (that is, created and saved
but never published)

”New Content Report” on page 161
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Report

Displays content in this
status

For more information, see

Submitted Content

Submitted for publication

”Submitted Report” on page 161

Content Pending Start Date

Approved and pending a start date

”Content Pending Start Date Report”
on page 162

Refresh Reminder Report

End date has been reached

”Refresh Reminder Report” on
page 163

Expired Content

Expired date has been reached

”Expired Content Report” on page 164

Content to Expire

Will expire within specified number
of days

”Content to Expire Report” on
page 165

Site Update Activity
Content Report

Content created or updated in
selected folders and within a
selected date range

”Site Update Activity Report” on
page 166

Asynchronous Log File
Report

A log report of the Asynchronous
process

”Asynchronous Log File Reporting” on
page 1027”

Search Phrase Report

Frequency of search terms

”Search Phrase Report” on page 170

Preapproval Groups

User groups that have been
assigned to folders in order to
preapprove content

”Preapproval Groups Report” on
page 375

Bad Link Report

Invalid links to external URLs

”Bad Links Report” on page 172

Common Report Topics
The following topics apply to the reports.
•

”Information on the Reports” on page 150

•

”Report Toolbar Options” on page 150

•

”Selecting Content by Folder” on page 151

•

”Selecting Content by Type” on page 152

•

”Sorting and Filtering Content Reports” on page 152

•

”Performing an Action on Several Content Items” on page 153

•

”Viewing/Editing Content on the Report” on page 154
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•

”emailing Reports” on page 154

Information on the Reports
Each report displays the following information about its content.
Field

Description

Title

Title of content.

ID

Internal number assigned to content by E kt ro n
CMS400.NET.

Date Modified

If a Start Date was assigned to the content, it
appears here.

Last Editor

The user who last edited the content.

Path

Folder location of content.

Report Toolbar Options

Toolbar Button

Description

For more information, see

email this report to selected users

”emailing Reports” on page 154

Select a folder whose content appears on
the report. Content in other folders is
ignored.

”Selecting Content by Folder”
on page 151

Go to previous screen

Select the language of the content you
want to see on the report
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Toolbar Button

Description

For more information, see

Select the type of the content you want to
see on the report

Selecting Content by Folder
You can select a folder and only view the content in that folder that
satisfies the other report criteria. For example, the Checked in
Content Report can show only content whose status is checked in
and which resides in the Contacts folder.

Only content in the selected folder appears. The report does not
include content from subfolders of the selected folder.
To select content by a folder, follow these steps.
1. From the Smart Desktop, select a report.
2. Click the Select a Folder button (
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3. The top level folders appear.
4. If the folder you want is on the list, click the corresponding
checkbox.
If the folder you want is a subfolder, click the parent folder’s
name. A new screen appears, showing the selected folder’s
subfolders. Click the corresponding checkbox.
5. Click the Save button (

) to finalize your folder selection.

6. The screen displays all content items in the selected folder that
satisfy all report criteria.

Selecting Content by Type
After viewing any report, you can select a content type and only
view the content of that type that satisfies the other report criteria.
For example, the Checked in Content Report can show only Office
documents.
To select a content type, follow these steps.
1. From the Smart Desktop, select a report.
2. Use the file types pull-down to select a file type.
3. The screen refreshes and only displays files of that type.

Sorting and Filtering Content Reports
Upon viewing a report’s content, you have additional options for
filtering report data by user and content folder.
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The filtering options for each content report are identical. The
following section uses the Checked-In Content report as an
example.

Filter by User
To display only content that was checked in by a user, click the
name of the user in the report display. When you do, the report
redisplays, showing only content which that user checked in.

Filter by Content Folder
To display only content checked in to a selected folder, click the
folder on the report display. When you do, the report redisplays,
showing only content in that folder.
NOTE

You can also select a folder and view reports in that folder only. See Also:
”Selecting Content by Folder” on page 151

Performing an Action on Several Content Items
You can perform the following actions on several or all content
items in the Approvals, Checked in, and Checked out reports.

Report

Action you can perform

Approvals

Approve

Checked in

Submit for publication

Checked out

Check in

To select several reports, check the relevant checkboxes
(illustrated below). To select all reports, click Select All.
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Then, click the button at the top left to perform the action on the
selected content items.

Viewing/Editing Content on the Report
To view (and possibly edit) any content on a report, click it. It
appears on the View Content screen (illustrated below).

The View Content screen provides several toolbar options that you
can perform on the content.

emailing Reports
You can email any report. You might do this, for example, to notify
a user that several content items are checked out to him. All
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information in the report appears in the email. A sample appears
below.

You can click any content item on the report and proceed to that
page of your Web site.
To email any report, follow these steps.
1. Display the report you want to email.
2. Click the email button (

).

3. A list of all users and user groups in your Ektron CMS400.NET
appears.
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NOTE

Users appear fIrst in alphabetical order (by username), followed by user groups.
The icon for user groups has two heads (see below).

4. Click inside the checkbox of every user or group to receive a
copy of the report.

Searching for Report Recipients
If you cannot easily find a user, a search of all users and groups is
available. To use it, follow these steps.
1. Display the report that you want to email.
2. Click the email button (

).

3. A list of all users and user groups in your Ektron CMS400.NET
appears.
4. Click the Search for User button (

).

5. The following screen appears.

6. Enter whatever information you know about the users.
7. Click the Send email button.
8. All users that satisfy the search criteria appear on a new
screen.
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9. Click the checkbox of every user or group to receive the report.

Approvals Reports
Each content item awaiting your approval appears on this report.
Thus, you can quickly find all such content without searching
through every folder.
The View All Content Awaiting Approval screen displays the
following information about this content.
Field

Description

Title

Title of content.

Request Type

Request made for the content. Either Publish or
Delete.

Start Date

Start date, if any, assigned to the content.
Determines when content will go live on Web
site.

Date Modified

Date the content was most recently changed

Submitted By

User who submitted content for approval.

ID

The ID number if the content.

Language

The language of the content.

Path

Path to content folder where content resides.

Below is an example of the View All Content Awaiting Approval
screen.
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Approving/Declining Content
From the approvals report, you can approve or decline content that
was submitted to you. The steps below explain how to do so.

Approve/Decline One Content Item
1. Access your Approvals report in the Workarea (see ”Approvals
Reports” on page 157).
2. Click the content you want to approve or decline.
3. The View Content Awaiting Approval page is displayed.
4. Perform an action using the following table as a reference.

Button

Name

Description

Publish

Accept changes to content and publish it to site.
Note: If there is a subsequent approver in the content’s approval chain, this
button is replaced by a Submit button.
If you click Publish but the content item has an incomplete task assigned to
another user, the content cannot be published. Instead, the following error
message appears.

The user to whom the task is assigned must complete it before you can
publish the content.
Decline

Reject changes and keep current version of content live on Web site. You are
prompted to enter a comment that provides a reason for the decline. The
author who made the change is notified by email of the decline.
The content inserted by the last editor remains in the file. If you do not want it
to remain, choose the Edit option.

Edit

Check out content and make changes to it if desired.
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Button

Name

Description

View
Published/
Staged

Toggle between published and submitted versions of content. This can help
you compare differences.

Back

Go back to previous screen.

Approving Multiple Content Items
See ”Performing an Action on Several Content Items” on
page 153.
The selected content is either submitted to the next publisher,
published immediately, or deleted, depending on the content’s
approval chain.

Checked In Report
The Checked In Content report displays all the content currently in
a checked-in status.
The report displays the following information.

Column

Description

Title

Title of content.

ID

ID number assigned to content by Ektron CMS400.NET.

Last Editor

Last user to edit the content.

Date
Modified

Date and time content was last edited.
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Column

Description

Path

Folder location of content in Ektron CMS400.NET Web
site.

Submitting Multiple Content Items
After selecting content, use the submit toolbar option (
) to
submit it for approval or publication, depending on your position in
the approval chain.

Checked Out Report
The Checked Out Content report displays all content currently in a
checked out status.
The report displays the following information.

Column

Description

Title

Title of content.

ID

ID number assigned to content by Ektron CMS400.NET.

Last Editor

Last user to edit the content.

Date
Modified

Date and time content was last edited.

Path

Folder location of content in Ektron CMS400.NET Web
site.

After selecting content, check it in using the Checkin button (
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New Content Report
The New Content report displays content in a new state, that is, it
was created and saved but never published. The new content
report contains the following information.

Column

Description

Title

Title of content.

ID

ID number assigned to content by Ektron CMS400.NET.

Last Editor

Last user to edit the content.

Date
Modified

Date and time content was last edited.

Path

Folder location of content in Ektron CMS400.NET Web
site.

Submitted Report
The Submitted Content report displays all content in a submitted
state. The report contains the following information.

Column

Description

Title

Title of content.

ID

ID number assigned to content by Ektron CMS400.NET.

Last Editor

Last user to edit the content.

Date
Modified

Date and time content was last edited.

Path

Folder location of content in Ektron CMS400.NET Web
site.
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Viewing Position in Approval Chain
While viewing the Submitted Content report, you can view the
content’s position is its approval chain. You can use this
information to contact the individuals in the chain and ask them to
complete their approval. To do so, follow these steps.
1. From the Submitted Content Report, click the content’s title.
2. The View Content page is displayed.
3. Click the Properties tab.
4. The content’s position in the approval chain is indicated by red
text on the Approvals line.

Content Pending Start Date Report
The Pending Start Date Report displays all content that was
approved, but whose start dates haven’t occurred. Each content
item on the report contains the following information.

Column

Description

Title

Title of content.

ID

ID number assigned to content by Ektron CMS400.NET.

Last Editor

Last user to edit the content.

Start Date

Date and time content will go live on Web site.
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Column

Description

Path

Folder location of content in Ektron CMS400.NET Web
site.

Editing Content with a Pending Start Date
You may edit content on the Pending Start Date Content report. To
do so, follow these steps.
1. Click the content you want to view.
2. The View Content page is displayed.
3. Using the toolbar at the top of the page, perform any action
available.

Refresh Reminder Report
The Refresh Report displays all content whose end date has
passed and whose archive option is set to Refresh Report. This
content is still visible on the Web site. Its appearance on this report
indicates that it is due for review. See Also: The Ektron
CMS400.NET User Manual section “Scheduling Content to Begin
and End” >“Setting Archive Options.”
Each item on the report contains the following information.

Column

Description

Title

Title of content.

ID

ID number assigned to content by Ektron CMS400.NET.

Last Editor

Last user to edit the content.

Date
Modified

Date and time the content was last updated.

Path

Folder location of content in Ektron CMS400.NET Web
site.
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Removing Expired Content from Site
If you review content and decide it should no longer appear on
your site, follow these steps to remove it. The content will be visible
if you browse to it through the Workarea, but won’t appear to site
visitors.
1. From the Expired Content Report, click the content.
2. From the View Content screen, click the Edit button (

).

3. Click the Schedule tab.
4. Under Action on End Date:, click Archive and remove from
site (expire).

Expired Content Report
The Expired Content report displays all content whose end date
has passed. Such content is no longer visible on the Web site.
Each item on the list contains the following information.

Column

Description

Title

Title of content.

ID

ID number assigned to content by Ektron CMS400.NET.

Last Editor

Last user to edit the content.

End Date

Date and time the content expired.

Path

Folder location of content in Ektron CMS400.NET Web
site.

Editing Expired Content
You may edit any content on the Expired Content report. To do so,
follow these steps.
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1. Click the content you want to view.
2. The View Content page is displayed.
3. Using the toolbar at the top of the page, perform any action
available.

Content to Expire Report
The Content to Expire report lists all content whose end date will
occur between today and a number of days that you specify. For
example, if today is January 1 and you select 10 days, the report
lists all content whose end date is January 1 through January 10.
After viewing the report, you can click any content and proceed to
the View Content screen for it. From there, you can edit information
about it, including its end date if desired.
Each item on the list contains the following information.

Column

Description

Title

Title of content.

ID

ID number assigned to content by Ektron CMS400.NET.

Last Editor

Last user to edit the content.

End Date

Date and time the content expired.

Path

Folder location of content in Ektron CMS400.NET Web
site.
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Selecting the Report’s Date Range
To select the report’s date range, you have two options:
Option

Illustration

Enter a number in the Days field.
Then click the View Reports button
(

).

Select a number from the dropdown
list below the Days field

After selecting a number of days, click the view icon (
content that will expire within that time frame.

) to see all

Site Update Activity Report
The Site Activity Report provides a snapshot of the freshness of
the content on your Web site. Specifically, it lists how many content
items were published within a folder and date range you select,
broken down by folder.
A sample report appears below.
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Selecting Information to Appear on the Report
To choose which content items will appear on the report, follow
these steps.
1. By default, only content in the default language appears on the
report. To change the language, use the language pull-down
near the top of the screen.
2. Choose a Start Date by clicking the calendar icon (
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3. A calendar appears. You can move to another month or year by
clicking it. When you get to the desired month, click inside the
day. The selected date turns red (see below).

4. Click Done.
5. If desired, select an End Date using the same procedure.
NOTE

If you do not select an end date, the report uses today as the end date.

6. At the Select field, choose a folder. The Root folder is the
default selection.
NOTE

Only folders for which you have read-only or greater permission appear.

To change that selection, click the folder name. When you do,
the Select Folder screen appears.
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To select all folders on the screen, click the Select All
checkbox. Otherwise, select folders by clicking the
corresponding checkbox. There is also an option to Include
Sub-folders of the selected folders.
7. Choose the Report type, which determines the information you
will see on the report. Options are explained below.

Report
Type

Description

Executive
View

•

folder name

•

how many times
content in folder
was published

•

how many pages
were published

•

number of content items in folder

Example
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Report
Type

Description

Detail View

•

name of each
page that was
published

•

how many times it
was published

•

date it was last
published

•

users who published page

•

total numbers are
not provided

Combined
View

Example

information from
Executive and Detail
views

8. If you would like to exclude users or use groups from the
report, use the Exclude Users field. For example, you want to
see all updates other than those you have completed.
When you click Exclude Users, an alphabetical list of users
appears, followed by user groups. (User groups have a twoheaded icon (

)).

9. Click Get Result.

Search Phrase Report
This report displays all terms that were entered into the Search
Text Field within a selected range of dates. You can use it to
discover the kind of information site visitors are searching for.
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Selection Criteria
You can narrow down the search by selecting any combination of
these criteria.
•

language - the language of the search page (either Workarea
or Web site search). The user performing the search can
choose a language before inserting the search text. If he does
not explicitly choose a language, the search uses the default
one. This report can show results from all languages or any
one that you select.

•

a minimum number of occurrences of the word or phrase to
return. For example, you only want words or phrases entered
into the Search Text field at least 10 times during the last
month.

•

whether to include words or phrases entered into the Web site
search (the search page that site visitors use)

•

whether to include words or phrases entered into the Workarea
search (accessed from the View Contents of Folder screen,
this search page is used by authorized CMS users to find
content)
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•

date range

Display of Search Results
The search results show the number of times each word or phrase
that satisfies the selection criteria appears. They are arranged in
this order.
•

words or phrases with the most occurrences appear first

•

if several words or phrases have the same number of
occurrences, they are arranged alphabetically

Also, terms entered into the Web site search or the Basic
Workarea search are surrounded by parentheses (). Terms entered
into the Advanced Workarea search have no parentheses. The
Microsoft search engine uses this syntax to find content.

Bad Links Report
The Bad Links Report notifies you of any invalid links to external
URLs within your content. (An invalid link returns an error code to
your browser.)
NOTE

The report does not check quicklinks embedded in the content.

To accomplish this, the report scans the following types of content.
•

published HTML content

•

published XML content

•

HTML forms

•

XML Smart Forms

•

menus

•

active system templates

When the scan is complete, the report lists any item that includes
an invalid URL. From the list, you can click a button to access the
item, then update or remove the bad link.
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Running the Bad Links Report
To run the Bad Links Report, go to Smart Desktop > Reports.
When you select Bad Link Report, you immediately see its status,
either Done or Running.

To begin scanning for bad links, click the Check Links Now button
(
). When you do, existing data is replaced by new data being
collected as the report progresses.
While the report scans content, you are free to work in other areas
of Ektron CMS400.NET. You can even sign off Ektron CMS400.NET.
These actions have no effect on the report’s collection of data.
If you want to stop the Bad Links Report at any time, click the
Cancel button ( ).
After all content is scanned, the report’s status changes to Done. If
desired, you can print the report by clicking the print button (

).

You can also launch the broken link in a browser by moving the
cursor over it then clicking when the cursor turns into a hand.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

173

Content Reports

Fixing Errors
The report lists the following information about each item that
contains a bad link.
•

title

•

error description

•

Source, that is, item type (content, menu, etc.) followed in
parentheses by information about the item that has the error.
As examples
- if the error is in a content block, you see Content followed by
its id number and language locale id
- if the error is in a Smart form, you see Smart form followed
by its ID number
- If it’s a menu, you see Menu Item (11,0,1033). The three
parameters are menu ID, menu item ID, and language ID.
- An error in a template looks like this:

ASPX Template (therapies.aspx)
Invalid Link: http://localhost/websrc/WorkArea/therapies.aspx

- The beginning of the bad link’s source code. Use this to help
you find the bad link from Source View.
•

the anchor (<a>) tag to which the bad link is assigned

•

URL that could not be resolved (labeled Invalid Link)

To fix an error, click the edit button next to the title (highlighted
below). The item opens in edit mode, so you can fix the bad link.

The error report’s Source: field also indicates the text to which the
bad link is assigned. See content highlighted in the above graphic.
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Within the content, you select the indicated text, right click the
mouse, and select Hyperlink to access the hyperlink dialog. From
here, you can update or remove the bad link.

Running the Bad Links Report on a Schedule
You can set the Bad Links Report to run in the background at
predetermined times. If you do, you can view the report‘s latest
results at your convenience without having to wait while it
compiles.
To set up a schedule, follow these steps.
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1. Open the following configuration file:
C:\Program Files\Ektron\EktronWindowsservice30\Ektron.ASM.EktronServices.exe.config

2. Within that file, go to the following line:
<add name="RunJob" type="Ektron.ASM.EktronServices.RunCMSJobManager.JobService,
Ektron.ASM.EktronServices" AbsoluteTime="Weekly|5, 2:27:00 PM" Enabled="true" />

3. Use the absoluteTime property to set the Bad Links Report’s
start time and frequency. By default, the report is scheduled to
run every Thursday at 2:27 p.m. The following table lists ways
to indicate a schedule.

Frequency

How to indicate

Example

Hourly

Comma-separated list of
integers representing the
number of minutes, seconds
and ms between jobs

360,0,0 (every 360 minutes or 6 hours)

Daily

A time in hh:mm:ss AM/PM
format

11:30:00 PM (every day 11:30 pm)

Weekly

Weekly | followed by an

Weekly| 0 12:00:00 PM (every Sunday at noon)

n is an integer that corresponds
to a day of the week, followed
by time. Use the time format
described for the Daily
frequency.
Use zero (0) to indicate Sunday,
1 for Monday, etc., through 7 for
Saturday.
Monthly

Monthly | followed by an
integer that corresponds to a
day of the month, followed by
time. Use the time format
described for the Daily
frequency.

Monthly| 15 11:30:00 (the 15th of every month at 11:30
PM)

Use zero (0) to indicate Sunday,
1 for Monday, etc., through 6 for
Saturday.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

176

Managing Library Items

Managing Library Items

Before users can insert images and files into their content, they
must be uploaded to the server that contains Ektron CMS400.NET.
Each user, depending on their permissions, can upload images
and files through the library in their Workarea.
In the library, you determine the types of files that can be uploaded
and each user’s library permissions.

What’s In This Chapter?
This chapter assumes you are familiar with the Library Folder
chapter of the Ektron CMS400.NET User Manual. As a result, the
chapter only provides information that is unique to administrators.
The following topics are covered in this chapter:
•

”Library Folders and Permissions” on page 177

•

”Folder Properties” on page 178

•

”Performing Actions on Library Items” on page 180

•

”Library Load Balancing” on page 180

Library Folders and Permissions
Whenever a new content folder is created and permissions given
to it, a corresponding library folder is created. The new folder
inherits permissions from the content folder.
Items added to library folders are only accessible by users with
permission to the corresponding content folder. If items are added
to a library folders directly under the main library folder, all users
with at least library Read-Only permissions can use those library
items in their content.
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Conversely, if a library item is uploaded to a folder to which only
one person has permissions, that is the only user who can use that
library asset.

Folder Properties
The library folder properties contains library-related information,
including load balance settings, image and file types that are
allowed to be uploaded, as well as other settings.
The following buttons indicate actions you can perform on a library
folder.

Button

Description

For more information, see

Folder properties

”Accessing the Library Properties Screen” on
page 178

Search

Ektron CMS400.NET User Manual section
“Library Folder” > “Searching the Library”

Back to previous screen

Accessing the Library Properties Screen
As an administrator, you have permission to change the library
properties. To view the properties of the library folder, follow these
steps.
1. Access a library folder, as explained in ”Folder Properties” on
page 178.
2. Click the Properties button (

).

3. The Library Management window appears, displaying the
following settings.
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The Library Management Settings
Field

Description

Image Extensions

The types of image files that a content contributor can upload to the
library. You can add as many image file extensions as you want, or have
none. If no extensions appear, no one can upload image files to the
specified folder.

Image Upload Directory

Specifies where the uploaded images are saved on the Web server. By
default, the image upload directory is Web root/ek_sitepath/
uploadedimages. The ek_sitepath value is set in the Web.config file.

See Also: Ek tr on CMS 400 .NET Setup Manual section “Managing the
web.config File.”
Make Directory Relative
to this Web site

If you want to specify the image upload directory’s location as relative to
your Web site root, check this box. (Your Web site root’s location appears
to the right of Make Directory Relative to this Web site.)

File Extensions

Specify the types of non-image files that a content contributor can upload
to the library. You can add as many non-image file extensions as you
want, or have none. If no extensions appear, no one can upload nonimage files to the specified folder.

File Upload Directory

Specifies where the uploaded files are saved on the Web server. By
default, the file upload directory is Web root/ek_sitepath/
uploadedfiles. The ek_sitepath value is set in the Web.config file.

Note: You must create the directory in your Web root manually, before
adding it in CMS400.NET.

See Also: E k t r o n

C M S 4 0 0 . N E T Setup Manual section “Managing the

web.config File.”
Make Directory Relative
to this Web site

If you want to specify the file upload directory’s location as relative to your
Web site root, check this box. (Your Web site root’s location appears to
the right of Make Directory Relative to this Web site.)

Editing Library Properties
To edit library properties, follow these steps.
1. Go to the Library Properties screen, as explained in ”Accessing
the Library Properties Screen” on page 178.
2. Click the Edit button (

).
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Library properties are described in ”The Library Management
Settings” on page 179.

Performing Actions on Library Items
The library is made up of images, files, form Quicklinks, hyperlinks,
and regular Quicklinks that were added by Ektron CMS400.NET
users. The following table displays the actions that can be
performed for each library item type.
Action

Files

Images

Hyperlinks

Quicklinks

Form
Quicklinks

Add

Edit

View

Overwrite

Delete

Remove from
server
Check links

Update URL

Most actions can be performed by a user who is granted
permission to do so. See Also: ”Setting Permissions” on page 768

Library Load Balancing
See ”Load Balancing Library Images and Files” on page 1060
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WARNING!

Ektron CMS400.NET does not support the use of eWebEdit400 to create and
edit Smart Form configurations. You must use eWebEditPro+XML. However,
eWebEdit400 is the default editor for creating/editing content based on a Smart
Form.

Ektron CMS400.NET’s Smart Forms give you access to the power
of XML by separating Web content from presentation. In addition to
hiding the XML tags from users, Ektron CMS400.NET can serve
content to various presentation devices (PDAs, mobile phones,
etc.), saving users from the tedium of creating duplicate content.
Review and revision are drastically reduced because the accuracy
and format of your Web content are managed using XML schema
validation.
Using Smart Forms with Ektron CMS400.NET provides the
following benefits:
•

Strictly enforce content and page layout with Ektron's editor
(Ektron eWebEditPro+XML), XSLT, and WYSIWYG templates
for content contributors

•

Deliver content to multiple devices (e.g., PDAs, mobile phones,
etc.)

•

Easily share content across B2B transactions

•

Advanced XML authoring: Ektron's highly-acclaimed XML
editor—Ektron eWebEditPro+XML—lets developers hide XML
tags from content contributors and provides an easy-to-use
WYSIWYG editing interface

The following are examples of industries that can benefit from XML
Indexing.
Industry

Use XML indexing to find

Health Care

A cardiologist whose practice is located in
your city
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Industry

Use XML indexing to find

Human Resources

Sick time policy

Real Estate

A house with a zip code of 03031 priced
under $200,000

Hospitality

A hotel in Boston

Online Retail

Fleece gloves for men

Educational

A course in .NET programming

Smart Forms are used in Ektron CMS400.NET to define the
necessary files to display, save, and validate the content properly.
This section explains how to take advantage of Ektron
CMS400.NET’s Smart Forms.
See Also:
•

”Benefits of Using XML Data” on page 182

•

”Before You Manage Smart Forms” on page 183

•

”Adding a New Smart Form” on page 185

•

”Assigning Smart Forms” on page 191

•

”Viewing Smart Forms” on page 191

•

”Editing Smart Forms” on page 196

•

”Creating Smart Forms Based on Existing Configurations” on
page 199

•

”Viewing Data Designer XSLTs” on page 200

•

”Deleting Smart Form Configurations” on page 201

•

”XML Indexing” on page 203

Benefits of Using XML Data
This section explains why you should use XML as opposed to
HTML content for your Web site. Because of XML’s advantages,
Ektron recommends using XML content whenever possible. Below
are several reasons why XML is the preferred format for managing
content.
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•

Standardized format for capturing content
- You can create an XML Smart Form then require anyone
creating content in a folder to use the form. The result is
more uniform and consistent information.
- Within an XML Smart Form, you can require authors to
complete fields in a specified format. So, for example, if you
want the author to enter a date, XML can ensure that it’s
captured in a standard format. Several standard formats
are provided (email address, zip code), and you can create
your own.

•

Superior control over content display
- Authors contribute XML content but have virtually no control
over its format. The Web administrator determines the
format through an XSLT file. By customizing the XSLT, you
can exert maximum control over your Web site’s
appearance.
- Since one file controls several (even hundreds of) pages, you
can update just that file to efficiently change the look of all
pages whose content is based on the Smart Form.

•

Improved search capabilities
- Because XML data is captured in individual fields, you can
focus a search on relevant fields. For example, if your XML
content captures data about books, you can place an
author search on your Web site. Since that search only
looks through content in the Author field, it is much faster
and returns more reliable results than a search of HTML
content.

Before You Manage Smart Forms
You must define each Smart Form that will be used in your Web
site. Each form is assigned to a content folder or content item and
lets you specify how XML content appears in the editor, is
validated, and is displayed in an output device.
There are two ways to create a Smart Form.
•

Using external XML files

•

Using the WYSIWYG Data Designer

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

183

Working with Smart Forms

This section explains how to create and manage Smart Forms
using both methods.

The Smart Form Toolbar
During the process of creating and managing Smart Forms,
several toolbar buttons are available. The following table describes
the buttons and their actions.
Button

Name

Description

More Information

Add Smart
Form

Create a new Smart Form from
scratch or based on properties of an
existing one

”Adding a New Smart Form” on
page 185

Back

Return to previous screen

Delete

Delete a Smart Form

”Deleting Smart Form
Configurations” on page 201

Edit

Edit a Smart Form created with
external files

”Editing Smart Forms” on
page 196

Edit Data
Design

Edit a Smart Form created with the
Data Designer

”Editing Data Design Packages”
on page 196

Save

Save changes

Update

Save and update changes

View XSLT

Display the XSLT for a Smart Form

”Viewing Data Designer XSLTs”
on page 200

Accessing Smart Forms
NOTE

Only members of the Administrators group or those defined in Manage Members
for Role: Smart Forms Admin screen can create or edit Smart Forms. See Also:
”Defining Roles” on page 787

To access the Smart Form section of the Workarea, follow these
steps.
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1. In the Workarea, go to Settings > Configuration > Smart
Form Configuration.
2. The View Smart Forms screen is displayed.

From here, you can view, add, edit, and delete Smart Forms.

•

See Also: ”Working with Smart Forms” on page 181

Adding a New Smart Form
When adding a new Smart Form, you have two options. The
following sections explain both.

Note

•

”Adding a Smart Form Using the Data Designer” on page 185
(recommended)

•

”Adding a Smart Form Using External XML Files” on page 187
(for example, XSLTs, schemas, etc.)

To create a new Smart Form by copying and editing an existing one, see
”Creating Smart Forms Based on Existing Configurations” on page 199.

Adding a Smart Form Using the Data Designer
To add a Smart Form using the WYSIWYG Data Designer, follow
these steps.
1. In the Workarea, go to Settings > Configuration > Smart
Form Configuration.
2. Click the Add Smart Form button (

).

3. The Add Smart Form screen is displayed.
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4. Enter a Title for the Smart Form.
5. Click the Save button (

).

6. The Smart Form Data Designer screen appears.
NOTE

Ektron CMS400.NET checks to see if eWebEditPro+XML is installed on your
computer. If it is not, you are prompted to install it.

7. You may get the following error dialog.
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To learn about why the dialog is appearing and help decide
whether to click Yes or No, click the link More information
about Local Machine Lockdown. A Windows Help topic
appears and explains your options.
8. If desired, you may specify a style sheet for the Smart Form.
Use the field on the right above the editor.
To do so, either type the path and file name of the CSS file, or
select an Ektron CMS400.NET-registered style sheet from the
drop down list.
9. Design your XSLT in the Data Designer.
See ”Using the Data Designer with eWebEditPro +XML” on
page 209 for information about creating XSLTs using the Data
Designer.
10. Click the Update button (

).

You are ready to assign the Smart Form to a folder or content item.
See ”Assigning Smart Forms” on page 191 for more information.

Adding a Smart Form Using External XML Files
WARNING!

Release 7.5.2 and up of Ektron CMS400.NET supports two editors:
eWebEditPro+XML and eWebEdit400. If you want users to insert Smart Form
information using eWebEdit400, you cannot create or edit Smart Forms using
external files. You must create and edit them using Ektron CMS400.NET’s Data
Designer.

To add a Smart Form using external XML files, follow these steps.
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1. In the Workarea, go to Settings > Configuration > Smart
Form Configuration.
2. Click the Add Smart Form button (

).

3. The Add Smart Form screen is displayed.
4. Enter a Title for the Smart Form.
5. Click the Save button (

).

6. The Smart Form Data Designer screen is displayed.
7. Click the Back arrow (

) to exit.

8. The View Smart Form screen for the new Smart Form is
displayed.

9. Click the Edit button (

).

10. The Edit Smart Form screen is displayed.
11. Enter the necessary information using the following table as a
reference.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

188

Working with Smart Forms

Smart Form Fields
Section

Field

Description

Generic Information

Title

Name given to Smart Form.

ID (display only)

ID number assigned when configuration is
created.

Description

Detailed description given to configuration by
its creator or last editor.

Edit XSLT

XSLT applied to content while being edited.

Save XSLT

XSLT used to transform the XML when saved
to the database.

Advanced Configuration

XML file that contains display information,
schema validation, and other advanced XML
data.

XML Schema

The .xsd file used to validate the XML content

Target Namespace

The default namespace used for outgoing
XML

XSLT1

XSLT 1 applied to XML data when viewed on
a device

XSLT2

XSLT 2 applied to XML data when viewed on
a device

XSLT3

XSLT 3 applied to XML data when viewed on
a device

XSLT Packaged

XSLT package applied to XML data when
viewed on a device

Editor Information

Validation Information

DIsplay Information

NOTE

When a Smart Form is created using the Data Designer, a default display XSLT is
created which resembles the edit XSLT created in the editor. This default XSLT
can be applied to the XML content.
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12. Specify the default display XSLT for the configuration by
clicking the corresponding radio button.

13. Click the Save button (

).

XML File Verification
A verification button ( ) appears to the right of some fields on the
Add Smart Form screen. After you identify an XSLT or schema,
you can click this button to verify that the file:

NOTE

•

exists in the location specified

•

contains well-formed XML

The XML Verification feature does not validate the contents of the XML file.

The following table explains possible results when clicking the
verification button.
Display

Result

Description

Verified

The file passes all verification parameters

Not Verified

The file either:
•

Does not exist in the specified location

•

Does not contain well-formed XML

Review current settings. Ensure the file is
in the proper location, and that it contains
well-formed XML
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Assigning Smart Forms
After you create a Smart Form, you can assign it to a folder’s
Properties screen. (See Also: ”Smart Forms” on page 57) Content
in the folder can then use the configuration.
A Smart Form can be inherited from a parent folder, or you can
assign a different one.

Viewing Smart Forms
To view a Smart Form, follow these steps.
1. In the folder tree on the left side of the Workarea, go to
Settings > Configuration > Smart Form Configuration.
2. Click the form you want to view.

.

The View Smart Forms screen appears with a more detailed
description of the configuration.
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Smart Form Created with...
Data Designer

External Files

The View Smart Form screen has three tabs.
•

”Properties Tab” on page 193

•

”Display Information Tab” on page 196

•

”Preview Tab” on page 195

Each tab is explained below.
After viewing, you can perform the following actions on the Smart
Form.
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Button

Name

Description

More Information

Configure Full
Text Search

Edit search screen labels

”Editing Smart Forms” on
page 196

Edit

Edit a Smart Form

”Editing Smart Forms” on
page 196

Edit Data
Design

Open Data Designer

”Editing Data Design Packages”
on page 196

Add Smart
Form

Create a new Smart Form from
scratch or based on an existing one

”Adding a New Smart Form” on
page 185

View XSLT

Display a Smart Form’s XSLT

”Viewing Data Designer XSLTs”
on page 200

Delete

Delete a Smart Form

”Deleting Smart Form
Configurations” on page 201

Back

Return to previous screen

View online help

View online help

Properties Tab

Field

Description

Title

Name given to Smart Form.

ID

ID number assigned by Ektron CMS400.NET upon
creation of the configuration.

Description

Detailed description of configuration given by creator or
last editor.

If the Smart Form was created using external XML files (instead of
the Data Designer), the following information also appears:
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•

”Editor Information” on page 194

•

”Validation Information” on page 194

Editor Information
NOTE

This section only appears if you do not use the Data Designer to create your
Smart Form.

The editor information contains the file names of the XSLTs used
when editing and adding content in the editor.
Field

Description

Edit XSLT

XSLT applied to the content when being edited.
Note: If no edit XSLT is specified, the Edit Data
Design option is enabled in the toolbar.

Save XSLT

XSLT used to transform the XML created in the
editor when the Smart Form is saved to the
database.

Advanced
Configuration

XML file that contains display information, schema
validation, and other advanced XML data.

Validation Information
NOTE

This section only appears if you do not use the Data Designer to create your
Smart Form.

You can validate the content created and edited with Ektron
CMS400.NET with a schema if desired. The validation information
contains information about the schema.
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Field

Description

XML
Schema

Specify the .xsd file used to validate the XML content
that the Smart Form will be assigned to.

Target
Namespace

Specify the default namespace used for outgoing XML.

Preview Tab
The Preview tab displays the XSLT applied to the editor when
XML content is created. This is the XSLT that was created for the
Smart Form.
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Display Information Tab
The display information tab lists the XSLTs that are used when
displaying XML in the respective environment.

NOTE

Field

Description

XSLT1

Display XSLT 1

XSLT2

Display XSLT 2

XSLT3

Display XSLT 3

XSLT
Package

Display XSLT Package (created
using the Data Designer)

When a Smart Form is created using the Data Designer, a default display XSLT is
also created which looks similar to the edit XSLT created in the editor. This default
XSLT can be applied to the XML content.

The asterisk (*) denotes the default XSLT for the Smart Form.
The tab also displays the Smart Form’s xpaths.

Editing Smart Forms
After creating a Smart Form, you can modify it when files defined in
the configuration have changed.
Since there are two ways to create a Smart Form, there are two
ways to edit one.
•

”Editing Data Design Packages” on page 196

•

”Editing a Smart Form Created with External Files” on
page 198

Editing Data Design Packages
After you create a Smart Form, you can modify it.
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Before You Edit the Data Package!
Before editing a Smart Form data package, it is important to
understand the effects of the modifications. If an XML data
package is edited, all content to which the configuration is applied
is updated. Information that was originally created may be lost,
depending on the changes you make to the package.
To ensure that information is not lost, use the Create New Smart
Form Based on Existing Smart Form option on the view Smart
Form screen. See ”Creating Smart Forms Based on Existing
Configurations” on page 199 for more information.

Editing a Data Design Package
To edit a data design package, follow these steps.
1. In the Workarea, go to Settings > Configuration > Smart
Form Configuration.
2. Click the Smart Form configuration you want to edit.
3. The View Smart Form screen appears with a more detailed
description of the configuration.
4. Click the Data Design Mode button (
screen.
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5. The Edit Data Design Package screen displays the current
package.

6. Make the necessary changes to the Data Design package in
the editor. See ”Using the Data Designer with eWebEditPro
+XML” on page 209 for information about creating XSLTs
using the Data Designer.
7. Click the Update button (

).

Editing a Smart Form Created with External Files
WARNING!

Release 7.5.2 and up of Ektron CMS400.NET supports two editors:
eWebEditPro+XML and eWebEdit400. If you want users to insert Smart From
information using eWebEdit400, you cannot create or edit Smart Forms using
external files. You must create and edit them using Ektron CMS400.NET’s Data
Designer.

1. In the Workarea, go to Settings > Configuration > Smart
Form Configuration.
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2. Click the Smart Form configuration you want to edit.
3. The View Smart Form screen is displayed.
4. Click the Edit button (

).

5. The Edit Smart Form screen is displayed.
6. Edit the necessary fields to update the Smart Form. See
”Smart Form Fields” on page 189.
7. Click the Update button (

).

Now, all content and folders that use the Smart Form take their
properties from the updated configuration.
See Also: ”XML File Verification” on page 190

Creating Smart Forms Based on Existing
Configurations
Whenever major changes must be made to a Smart Form, Ektron
recommends making a copy of it and modifying the copy. In this
way, you do not affect the content controlled by the original
configuration.
To create a new Smart Form based on an existing one, follow
these steps.
1. In the Workarea, go to Settings > Configuration > Smart
Form Configuration.
2. Click the Smart Form configuration you want to view.
3. The View Smart Form screen appears with a more detailed
description of the configuration.
4. Click the Create New Smart Form button (

).

5. The Add Smart Form screen is displayed.
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6. Enter a Title for the new Smart Form.
7. Click the Add Smart Form button (

).

8. The View Smart Form screen for the new Smart Form is
displayed. From here, you can perform the necessary actions
on it.

Viewing Data Designer XSLTs
When a Smart Form is created using the Data Designer, an XSLT
is produced to assist you with creating your display XSLT. This
XSLT includes the structure for your XML documents.
If a display XSLT is not applied to a Smart Form, content is
displayed using the default XSLT displayed in the View XSLT
screen.
To view the XSLT for a Smart Form, follow these steps.
1. In the folder tree on the left side of the Workarea, go to
Settings > Configuration > Smart Form Configuration.
2. Click the Smart Form configuration whose XSLT you want to
view.

NOTE

The XSLT only appears if the Smart Form was created using the Data Designer.
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3. The View Smart Form screen appears with a more detailed
description of the configuration.
4. Click the View XSLT button (

).

5. The View XSLT screen is displayed.

You can use this information to create your display XSLT.

Deleting Smart Form Configurations
You can delete Smart Form configurations that are no longer
needed. To do so, follow these steps.
NOTE

If any Smart Form that uses this configuration has one or more indexed fields, you
must delete all content that uses the configuration before you can delete it. See
Also: ”Specifying Which XML Elements are Indexed” on page 205

1. In the Workarea, go to Settings > Configuration > Smart
Form Configuration.
2. Click the Smart Form configuration you want to delete.
3. The View Smart Form screen is displayed.
4. Click the Delete button (

).

5. A confirmation message is displayed.
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6. Click OK.
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XML Indexing

XML Indexing lets site visitors search XML information collected
via Smart Forms and view the results. The results appear as a list
of topic titles, optionally followed by the content summary.
The Data Designer lets you choose which XML fields to index. You
can also validate those fields to be numbers, dates, Boolean, or
string values. After you identify fields to be indexed, a search
dialog is created. Where appropriate, the dialog automatically
populates drop down lists from the indexed data.
NOTE

As the name implies, XML indexing is only available for information collected on
XML Smart Forms. It cannot find information in XHTML content.

See Also:
•

”User vs. Developer Selected Search Criteria” on page 203

•

”Types of Search Criteria” on page 204

•

”Setting up a User-Defined Search” on page 205

•

”Setting up a Developer-Defined Search” on page 205

•

”Specifying Which XML Elements are Indexed” on page 205

•

”Search Dialog Setup” on page 207

•

If you are upgrading from an earlier version of Ektron
CMS400.NET to 7.5, the Knowledge Base article “INFO: 7.5
Upgrade: Changes to 7.5 XML Index Search” lists upgrade
considerations.

User vs. Developer Selected Search Criteria
There are two ways that XML Indexing can make XML content
available to your site visitors.
•

Present a screen of search criteria. A site visitor uses the
screen to select the kind of information he is looking for. For
example, your site sells outdoor clothing, and a user searches
for wool hats under $20.00.
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•

Determine the search and display criteria programmatically
using a custom function. Your Web developer inserts a control
that specifies search and display criteria. For example, your
site sells books. A site visitor sees a navigation link Find
books under $5.00. When he clicks that link, the control
searches your XML content and returns all books whose price
is less than $5.00.

NOTE

The Ektron Windows Service manages the background processing that creates
XML indexes. See Also: ”Ektron Windows Service” on page 1051.

NOTE

Ektron CMS400.NET content has a Content Searchable check box, which is
checked by default. It must be checked if you want the Index Search to find Smart
Form content. See Also: ”The Content Searchable Field” on page 412

Types of Search Criteria
XML Indexing allows multi-dimensional searches on all types of
XML data.

Data Type

XML Index Search can

Plain text

Use an exact phrase, or any word or letter in a phrase

Numerical and date
information

Use expressions such as greater than, less than, or between two
values

List and choice fields

Display the field values and let the user select relevant ones.
Note: Choices field values can consist of single letter.

Image Only

Use the alt or src attribute value

Link

Use the text or href attribute value

For every search field, NoSelection is a value. If this is chosen,
the search disregards that field when compiling results. However,
the user must select a value (or range of values) in at least one
field to get results.
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WARNING!

Do not insert a calendar field into a Smart Form that allows multiple entries (using
the Allow more than One option on the dialog). If you do, you cannot search the
Smart Form using that field.

WARNING!

In order for Smart Form fields to searchable, they must be stored as elements not
attributes. See Also: ”Advanced Button” on page 280 If you are upgrading to
version 7.5, inspect your Smart Forms and change field properties as needed so
they are stored as elements not attributes.

Setting up a User-Defined Search
To create a user-defined search, follow these steps.

Step

For more information, see

1.

Select a Smart Form

”Accessing Smart Forms” on page 184

2.

Assign indexing to each field to be
searched

”Specifying Which XML Elements are Indexed” on
page 205

3.

Set up the search screen

”Search Dialog Setup” on page 207

4.

Have your Web developer set up a
page that displays a search control
and a results control

Ek tron CM S40 0.NET Developer’s Manual section
“Introduction to E k t r o n C M S 40 0. N E T Server Controls”

> “IndexSearch Server Control”

Setting up a Developer-Defined Search
To set up a developer-defined search, which defines both the
criteria and the results page, use the SearchParmXML property of
IndexSearch Server Control. For more Information, see the Ektron
CMS400.NET Developer’s manual section “Ektron CMS400.NET
Server Controls” > “List of Server Controls” > “IndexSearch Server
Control.”

Specifying Which XML Elements are Indexed
You can index the following types of fields:
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WARNING!

•

Checkbox

•

Plain Text

•

Choices

•

List

•

Calculated

•

Image Only

•

Link

•

Calendar

Do not insert a calendar field into a Smart Form that allows multiple entries (using
the Allow more than One option on the dialog). If you do, you cannot search the
Smart Form using that field.

To enable indexing for any field on an XML Smart Form
configuration, follow these steps.
1. In the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Smart Form Configuration.
2. Select a Smart Form configuration that you want to index. See
Also: ”Accessing Smart Forms” on page 184
3. Open its Data Design. See Also: ”Using the Data Designer with
eWebEditPro +XML” on page 209
4. Move the cursor to the first field you want to index.
5. Right mouse click the field.
6. Choose Field Properties.
7. A dialog box appears.

8. Check Indexed.
9. Repeat these steps for every field by which you want site
visitors to search the Smart Form.
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Validation
Validation ensures that the user completing an XML form enters
the right type of data. You can decide if the user’s input should be a
number, boolean, date, string, zip code, etc. If you do not specify
type attributes using validation data, the field is a string. See Also:
”Validation” on page 245
Validation is especially important when users search XML data,
because it helps the search find the correct information. For
example, if a field collects a zip code but you set its type to plain
text, a user completing the form can insert anything into the field. If
the user inserts the letter “o” instead of the number zero (0), the
field accepts that input but the search will not find that record. On
the other hand, if you set validation to zip code, the user can only
insert five or nine digits -- any other entry is rejected.

Search Dialog Setup
When you save a Data Design form, a dialog appears that lets you
view all and modify indexed fields (illustrated below).

The information on this screen is explained below.
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Screen
section

Description

Xpath

The xpath to each indexed field.

Label

The index field’s field name, as defined on its dialog.

Multiple

Check this box if you want to allow the user performing the search to select more than
one value. This checkbox only appears with List and Choice fields.
Note: To select more than one value on the search screen, the user holds down the
<Ctrl> key while selecting additional options.
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Introduction
eWebEditPro+XML’s Data Designer feature lets you design a

screen that collects information from users and stores it as XML
data. Creating the screen is simple and requires no knowledge of
XML.
NOTE

When using the Data Designer feature, the following browsers are supported:
Netscape 6.2 or later; Internet Explorer 5.5 or later.

For example, you may create the following screen.

This screen can store information entered by a user as the
following XML.
<address>
<street>123 Sesame St.</street>
<city>New York</city>
<state>NY</state>
</address>

Note that the street and city fields accept text, while the state field
accepts a pre-defined value (a state).
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This section explains how to use the Data Designer feature
through the following topics.
•

”Differences in eWebEditPro+XML” on page 210

•

”Design Mode vs. Data Entry Mode” on page 211

•

”Designing a Screen” on page 212

•

”Inserting a Field Type” on page 214

•

”Sample Screen Design” on page 218

•

”Data Designer Field Types” on page 227

Differences in eWebEditPro+XML
When you use the Data Designer, eWebEditPro+XML changes in
the following ways.
NOTE

The design toolbar and the design mode and Data Entry mode buttons appear
only if your site administrator has defined them in the configuration data.

•

two toolbars appear, illustrated below. The toolbar buttons let
you design the data entry screen. Each button represents a
different kind of field.

Both toolbars provide mostly the same buttons. The major
difference between them is how you use the button to add a
field to the screen. If you are using the horizontal toolbar, place
the cursor where you want field, and click the toolbar button.
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When using the drag and drop toolbar, drag a button to desired
screen location.
Note that a context-sensitive menu, available by right clicking
the mouse, is also available to perform the commands. You
can right click the mouse then select Insert Field to display a
context-sensitive menu of all commands. To edit the properties
of any field already on the screen, select the field, right click the
mouse, and select Field Properties.
•

two buttons appear on the regular (Edit) toolbar: Design mode
and Data Entry mode. (For more information, see ”Design
Mode vs. Data Entry Mode” on page 211.)

The Data Entry mode button lets you preview the screen being
created.
•

several toolbar buttons are grayed out -- they do not work with
Data Designer

Design Mode vs. Data Entry Mode
The Data Designer feature supplies two “modes,” which make it
easier for you to design screens:
•

Data Design mode - lets you insert and remove fields from the
data entry screen

•

Data Entry mode - simulates the screen’s appearance during
data entry

Two toolbar buttons let you switch between modes. The buttons
are located on the Edit toolbar.
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When you begin to create a data entry screen, you are in design
mode. To view the screen as the user will see it, click the Data
Entry button ( ). To switch back to Data Entry mode and modify
the screen, click the Data Designer button ( ).

Designing a Screen
To design a screen that captures XML data, you
1. Ask your system administrator to enable a version of
eWebEditPro+XML that includes the Data Designer. (The
administrator should refer to the Data Designer chapter of the
Developer’s Reference Guide.)
2. For each field on the screen, select a field type, and place it on
the screen. ”Inserting a Field Type” on page 214 explains the
kind of field that each button represents.
You can also use eWebEditPro+XML’s rich formatting
capabilities to design the screen. For example, you can format
text, and use tables, images and hyperlinks to guide the user
through the data entry process. Below is a sample screen
created with the Data Designer.
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If you are familiar with XML and want to manually edit the page,
use the View Source button ( ) to edit the page’s source code. If
the edited source XML is not well-formed, you are notified and
must remain in source view until you fix it.
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Inserting a Field Type
eWebEditPro+XML provides several options that let you insert or

edit fields in the editor. Each field type is described below.

Field type

Icon

Description

For more information, see

Group Box

Groups related fields, which can be
surrounded by a box and have a caption

”Group Box” on page 228

Tabular

Same as group box, but fields can be
presented in a table format

”Tabular Data” on page 232

Checkbox

User’s response is either checked or
unchecked

”Checkbox” on page 240

Plain Text

Free text field; user cannot format text

”Plain Text” on page 242

Rich Area

Free text field; user can format text using
the editor

”Rich Area” on page 246

Choices

Several choices appear on screen. User
checks appropriate boxes. All user
choices are inserted as values within
single XML tag.

”Choices” on page 248

List

Same as Choices except options appear
in a drop-down box

”Select List” on page 252

Calculated

Performs calculations using other fields
on the screen

”Calculated Field” on page 258

Calendar

Lets user insert a date by clicking a
calendar

”Calendar Field” on page 267

Image Only

Lets user insert an image

”Image Only Field” on page 274

File Link

Lets user insert a link to a file, such as a
PDF document

”File Link Field” on page 276
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Field type
Field
Properties

Icon

Description

For more information, see

Lets you change the properties of any
field. Select the field then click this
button.
Note: This option is also available on the
right click menu, but not available on the
drag and drop toolbar

Validate

Ensure the screen contains valid XML.
This button is available in both data entry
and data design modes.

Deleting a Field from the Screen
To remove a field from the screen, follow these steps.
1. Move the cursor to the field.
2. When the cursor changes to a four-headed arrow, click the
mouse.
3. Small boxes surround the field.

4. Click the cut icon (

) to remove the field.

Usually, the field label is not deleted when you delete a field. To
delete the label, use standard eWebEditPro+XML editing buttons.

Previewing the Screen
If you want to view how the screen will appear to the person who
will complete the screen, click the View Data Entry button ( ).
(See Also: ”Design Mode vs. Data Entry Mode” on page 211.)
If you want to see an internal representation of the Data Design,
click the Preview button ( ). Next to the Preview button is a dropdown list of internal formats in which you can view the data design.
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The formats are described below.

Format

Description

Example

Data as XML

The XML data document

<?xml version="1.0" ?>
- <root>
- <Information>
<LastName />
<FirstName />
<MiddleName />
<Gender>male</Gender>
<Address />
<city />
<state>MA</state>
<Zip />
<SSN />
<BDate />
<HomeTel />
<WorkTel />
<x-ray />
- <Dental_Insurance>
<Field1 />
<OtherInsurance>N/A</OtherInsurance>
<Account_Number>N/A</Account_Number>
</Dental_Insurance>
<medication />
<lastAppointment />
<clincal />
</Information>
</root>
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Format

Description

Example

Schema

Defines the structure, content,
and semantics of an XML
document

<?xml version="1.0" ?>
- <xs:schema elementFormDefault="qualified"
attributeFormDefault="unqualified"
xmlns:xs="http://www.w3.org/2001/XMLSchema">
- <xs:element name="root">
- <xs:complexType>
- <xs:sequence>
- <xs:element name="Information">
- <xs:complexType>
- <xs:sequence>
- <xs:element name="LastName">
- <xs:simpleType>
- <xs:restriction base="xs:string">
<xs:minLength xmlns:xs="http://www.w3.org/
2001/XMLSchema" value="1" />
</xs:restriction>
</xs:simpleType>
</xs:element>
- <xs:element name="FirstName">
- <xs:simpleType>
- <xs:restriction base="xs:string">. .. ..

Field List

A list of all fields and information
about them (as XML)

<fieldlist>
<field name="LastName" datatype="string"
basetype="text" xpath="/root/Information/
LastName" title="Last Name">Last Name</field>
<field name="FirstName" datatype="string"
basetype="text" xpath="/root/Information/
FirstName" title="First Name">First Name</
field>
<field name="MiddleName" datatype="string"
basetype="text" xpath="/root/Information/
MiddleName" title="Middle Name">Middle Name</
field>
<field name="Gender" datatype="choice"
basetype="text" xpath="/root/Information/
Gender" title="" datalist="IDAPK3KC">Gender</
field> . .. .. ..

Index

xpath information for any
indexed field on the screen

<?xml version="1.0" ?>
- <indexable>
<xpath type="string">/root/Information/SSN</
xpath>
<xpath type="string">/root/Information/
HomeTel</xpath>
<xpath>/root/Information/WorkTel</xpath>
</indexable>
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Format

Description

Example

XSLT

The Data Design document’s
presentation XSLT

<?xml version="1.0" ?>
- <xsl:stylesheet version="1.0"
xmlns:xsl="http://www.w3.org/1999/XSL/
Transform">
<xsl:output method="xml" version="1.0" omitxml-declaration="yes" indent="yes"
encoding="utf-8" />
<xsl:strip-space elements="*" />
<xsl:variable name="ektdesignns_fieldlist"
select="/*/ektdesignpackage_list/fieldlist" />
- <xsl:template match="/"
xml:space="preserve">
<p> </p>
- <fieldset id="Information"
title="Demographic Information">
<legend>Patient Information</legend>
- <div>
- <p>
<strong>Last Name</strong>
<xsl:text> </xsl:text>
<xsl:value-of select="/root/Information/
LastName" />
<strong>First Name</strong>
<xsl:text> </xsl:text>

<xsl:value-of select="/root/Information/
FirstName" /> .. .. ... ..

Sample Screen Design
This section provides a brief overview of designing a screen, so
that you can learn how the pieces fit together. Let’s assume you
want the screen to look like this.
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NOTE

The following example helps you understand how to create a simple data entry
screen. It does not explain how to save a screen so that a user can enter data into
it. When you are ready to create an screen, ask your system administrator to help
determine a method for saving it and making it available to users for data entry.

To create such a screen, follow these steps.
1. Sign on to eWebEditPro+XML in Data Designer mode. (Ask
your system administrator how to do this. The Developer’s
Reference Guide (version 4.0 and higher) provides details.)
2. Since you want to surround the data entry fields with a box and
a caption, drag the Group Box button (
) from the drag and
drop toolbar onto the screen. Then, complete the dialog as
shown below.
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NOTE

Later, each field on the dialog is documented. Since this section provides an
overview, it does not delve into those details.

At this point, the screen looks like this.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

220

Using the Data Designer with eWebEditPro +XML

3. Select Address then apply bold and the custom color shown
above. Now the screen looks like this.

4. The next field, street, should let the user enter text. So, drag
the plain text field icon (
) into the space below Address.
Then, complete the dialog as shown below.
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Now, the screen looks like this.
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Note that the Street field is not wide enough. To widen it, click
the field, move the cursor until you see a two-sided arrow, and
drag the arrow to the right.

5. The next field, City, should also let the user enter text. Assume
that you want City to appear in the line below Street. To make
room for City, move the cursor to the end of the Street field
and press <Enter> to create a new line. Next, drag the plain
text field icon (
) into the line below Street. Then, complete
the dialog as shown below.
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Now, the screen looks like this.
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6. The next field, State, should let the user choose from several
states. Assume that you want the state to appear to the right of
City. Move the cursor to the end of the City field and drag the
Select List Field field icon (
) into that space. Then,
complete the dialog as shown below.
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Now, the screen looks like this.
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The above example is very simple and does not use the Data
Designer’s more powerful and flexible features. To learn more
about Data Designer, read the rest of this chapter.

Data Designer Field Types
To help you use all of the Data Designer’s capabilities, this section
explains each field type you can insert. They are very flexible and
can accommodate all of your needs when designing a data entry
screen.
The Data Designer supports the following field types.
•

”Group Box” on page 228

•

”Tabular Data” on page 232

•

”Checkbox” on page 240

•

”Plain Text” on page 242

•

”Rich Area” on page 246

•

”Choices” on page 248

•

”Select List” on page 252

•

”Calculated Field” on page 258

•

”Calendar Field” on page 267

•

”Image Only Field” on page 274

•

”File Link Field” on page 276
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Group Box
A Group Box field lets you group related fields together on a
screen by surrounding them with a box and optionally placing a
caption above them.
After you insert a Group Box field, to insert other kinds of fields
within the box,
•

drag the fields into the box (if you are using the drag and drop
toolbar)

or
•

NOTE

place the cursor inside the box then select a field type button (if
you are using the horizontal toolbar)

The tabular data field type might better accommodate your needs. See ”Tabular
Data” on page 232.

Advantages of Grouping Fields
One advantage of grouping fields is that you can allow the user in
Data Entry mode to add another instance of a group.
For example, if a screen collects several fields of information about
each telephone call, the user could simply click the Insert Below
button to insert a new group of fields, ready to collect information
about the next call.

Another advantage of grouping fields is that you can suppress a
group of irrelevant fields. For example, if a screen includes two
groups of fields that collect information about hardcover and
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paperback books, and you are adding information about a
hardcover book, you can collapse the paperback book questions
because they are not relevant to your current task.
Use the eyeglass icon to expand or collapse the display of fields
within a group.
Expanded Group Field with glasses icon highlighted

Collapsed Group Field
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Dialog Box

Fields on the Group Box Dialog

Field

Description

Descriptive
Name

Enter the name of this field.
Note that you cannot enter spaces nor most special characters
(!@#$%^&*()+=<>,.:;'”{}[]\|`~) into this field.
Internally, the name is used as the field’s caption.

The Name Field’s Default Value
By default, the Data Designer assigns a name made up of Field
followed by the next available number. So, the first field’s default
name is Field1, the second field’s default name is Field2, etc. You
can change the default if you want.
Field Name

Enter the field’s element name. This defines the field in the XML.

Advanced

See ”Advanced Button” on page 280
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Field

Description

Use

See ”The Use Field” on page 283

Allow

See ”The Allow Field” on page 284

Appearance

Click Show border and caption if you want to surround the fields in
this group with a box. You can also create a caption to appear in the
top line of the box.
Click No border if you do not want to surround the fields in this
group with a box.

Caption

If desired, enter text to describe this group of fields on the data entry
screen. For example:

After you insert this field onto the screen, you can use
e We bE di t Pro + XML ’s formatting capabilities to modify its size, font,
color, and other attributes.
Note: The Caption field only appears on this dialog when you create
the Group Box field. If you later try to edit the field, the Caption field
is not on the dialog. However, you can edit Caption text within the
editor.

Using a Tag Other Than <Root>
By default, Ektron CMS400.NET surrounds your Data Design with
<root> tags. If you would like to replace the <Root> tags with
another element name, follow these steps.
1. After creating a new Data Design screen, insert a Group Box
as the first field.
2. In the Group Box Dialog’s Field Name field, enter the root text.
3. On the Group Box Dialog box, click the Advanced button.
4. In the Root tag section of that dialog, select Use this element
as the Root tag and press OK.
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5. Place all other screen elements within the Group Box field.

Tabular Data
The Tabular data button inserts a table into which you can place
other types of fields. It’s similar to a group box.
Tabular data’s main advantage over a group box is that it lets you
place fields in columns (see below).
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NOTE

”Group Box” on page 228 describes many features that also apply to tabular data.
Read that section to gain a full understanding of working with tabular data.

Creating a Table
First you insert the table. Then, you insert an appropriate type of
field into each column. As examples, in the table above, the
Description field type would be plain text, while the In Stock? field
type would be choices.
If you insert a field into a table and its caption appears to the left of
the data entry region (see below), move the caption to the column
header (see second illustration below).
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To access table commands (such as add row and add column),
place the cursor inside a table cell, right click the mouse, and
select Table.
IMPORTANT!

Only table cells into which you place a field are available to visitors of your Web
page.

Editing Tabular Data
To edit tabular data, hover the cursor over a table border line until
you see a four-headed arrow. Then, click the right mouse button
and select Field Properties.
NOTE

You cannot reduce the number of columns by editing the Tabular Data dialog’s
Columns field. To delete a column, place the cursor in the column and select
Delete Column from the table commands. The table commands are available in
the table drop-down menu, the table toolbar (which is hidden by default), or the
right-click context menu.

How Tabular Data Forms XML Structure
Tabular data creates three levels of XML tags:
•

inner level: each field in the table

•

middle level: each row in the table

•

outer level: the entire set of table data

To explain how this works, we’ll use the following contact list as an
example.

Name

Phone

Email

John Doe

555-1212

john.doe@example.com

Mary Smith

555-8765

msmith@example.net

How XML Tags are Assigned to Field Names
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When you insert a field into a table, a dialog helps you define the
field type. For example, when inserting a plain text field, the Plain
Text Field dialog appears. On that dialog, the value of the Phone
field defines the tags that enclose that field’s contents.

To continue our example, every contact is represented in XML as:
<Name>John Doe</Name>
<Phone>555-1212</Phone>
<Email>john.doe@example.com</Email>

and
<Name>Mary Smith</Name>
<Phone>555-8765</Phone>
<Email>msmith@example.net</Email>

How XML Tags are Assigned to Table Rows
Each row of the table collects information for one contact. On the
Tabular Data Box dialog, the Row Name field defines the XML tag
that groups information for each contact. For example, the Row
Name field value is Contact.
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<Contact>
<Name>John Doe</Name>
<Phone>555-1212</Phone>
<Email>john.doe@example.com</Email>
</Contact>
<Contact>
<Name>Mary Smith</Name>
<Phone>555-8765</Phone>
<Email>msmith@example.net</Email>
</Contact>

How XML Tags are Assigned to the Entire Table
When you create a table, the name you give it (in the Name field of
the Tabular Data Box dialog) defines the XML tag that groups all
contacts on the table. In this example, the name is AddressBook.
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<AddressBook>
<Contact>
<Name>John Doe</Name>
<Phone>555-1212</Phone>
<Email>john.doe@example.com</Email>
</Contact>
<Contact>
<Name>Mary Smith</Name>
<Phone>555-8765</Phone>
<Email>msmith@example.net</Email>
</Contact>
</AddressBook>
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Dialog Box
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Fields on the Tabular Data Dialog

Field

Description

Descriptive Name

Enter the name of this table.
Note that you cannot enter spaces nor most special characters
(!@#$%^&*()+=<>,.:;'”{}[]\|`~) into this field.

The Name Field’s Default Value
By default, the Data Designer assigns a name made up of Field followed by
the next available number. So, the first field’s default name is Field1, the
second field’s default name is Field2, etc. You can change the default if you
want.
Field Name

Enter the table’s element name. This will define the table in the XML. See
Also: ”How Tabular Data Forms XML Structure” on page 234

Tool Tip Text

Enter the text that appears when a user hovers the cursor over the table’s
column headers.

Advanced

See ”Advanced Button” on page 280

Use

See ”The Use Field” on page 283

Allow

See ”The Allow Field” on page 284
Note: If you check More than one here, you are allowing the user to insert an
entirely new table, not an additional table row.

Rows
Row display name

Enter the text that appears when a user hovers the cursor over the table’s
cells. Use this field to describe the kind of information to be inserted into the
table’s cells.

Row name

Enter the name of the XML tag used to collect data for each entry in the table.
See Also: ”How Tabular Data Forms XML Structure” on page 234
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Field

Description

Minimum number

If desired, enter the minimum number of rows for this table.
If you enter a number and the data entry user tries to save the screen without
inserting at least the minimum number of rows, he is informed that Element
content is incomplete according to the DTD/Schema.
By default, the user is allowed to cancel or save the screen anyway. However,
the system administrator determines whether or not the user can save an
invalid document.

Maximum number

If desired, enter the maximum number of rows for this table. If you don’t want
to assign a maximum number, check the Unlimited check box.
Result of Assigning a Maximum
When this table appears on a data entry screen, and a user adds the
maximum number of rows, the Insert Above and Insert Below options are
grayed out on the menu (see example below).

Columns

Enter the number of columns to appear in the table.
See Also: ”Editing Tabular Data” on page 234

Caption

If desired, enter text to describe this table on the data entry screen. The
caption appears centered above the table.
After you insert this field onto the screen, you can use eWebEdi tPr o+ XML ’s
formatting capabilities to modify the caption’s size, font, color, and other
attributes.

Checkbox
A Checkbox field is only one character wide and accepts one of
two possible values: checked or unchecked. For example
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Dialog Box

Fields on the Checkbox Dialog

Field

Description

Descriptive Name

Enter text to guide the user’s response to this field. To continue the above
example, the caption would be Check if you are over 65.
After you insert this field onto the screen, the Descriptive Name appears
to the right of the checkbox. You can use eWeb Ed it Pr o+X ML ’s
formatting capabilities to modify its size, font, color, and other attributes.
Note: The Descriptive Name field only appears on this dialog when you
create the Check Box field. If you later try to edit the field, it is not on the
dialog. However, you can edit the Descriptive Name text within the editor.

Indexed

Check if you want to index this field. See Also: ”XML Indexing” on
page 203
The Indexed field may not appear, depending on how your administrator
set up your system.

Field Name

Enter the field’s element name. This will define the field in the XML.

Advanced

See ”Advanced Button” on page 280
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Field

Description

Tool Tip Text

Enter text that appears when a user hovers the cursor over this field
(circled in red below).

Default value

If you want this field to be checked when the screen first appears, click
True.
Otherwise, click False.

Plain Text
Use a plain text field when you want the user to enter an
unformatted, free text response.
NOTE

If a plain text field tries to perform a numerical calculation with a value that is blank
or contains letters, NaN appears in the field. (NaN stands for “not a number.”) If a
plain text field tries to divide by zero, Infinity appears.

NOTE

If a plain text field collects a URL, add on-screen instructions to prefix it with
http:\\. If the user does not, the URL address is not stored properly.

Plain Text Field vs. Rich Area Field
The following capabilities are available with a plain text field but not
a rich area field.
•

You can adjust the field’s width by dragging it. See ”Resizing a
Plain Text Field” on page 245.

•

The text can be read-only or hidden

The following capability is available with a rich area field but not a
plain text field.
•

In Data Entry mode, the user can change the text’s format,
size, style, etc. along with adding hyperlinks, using
eWebEditPro+XML’s formatting capabilities.
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•

You can enter custom tags.

Dialog Box

Fields on the Plain Text Dialog

Field
Descriptive Name

Description
Enter the name of this field.
Note that you cannot enter spaces nor most special characters
(!@#$%^&*()+=<>,.:;'"{}[]\|`~) into this field.
See Also: ”The Name Field’s Default Value” on page 230
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Field

Description

Indexed

Check if you want to index this field. For more information, see ”XML
Indexing” on page 203.
The Indexed field may not appear, depending on how your administrator
set up your system.

Field Name

Enter the field’s element name. This defines the field in the XML.

Advanced

See ”Advanced Button” on page 280

Tool Tip Text

Enter the text that appears when a user hovers the cursor over this field.

Default Value

If you want to set a default value for this field, enter that value here. The
default value appears in Data Entry mode, where the user can accept,
change, or delete it.
For example, if this field collects a city, and most users enter New York,
enter New York as the value.

Use

See ”The Use Field” on page 283

Allow

See ”The Allow Field” on page 284

Options

Invisible - Check here to make this field hidden in Data Entry mode.
This option lets you store unseen information in each XML document. An
example might be putting a version number for the data design so that
XML documents can be upgraded to newer versions using an XSL
transform.
Allow multiple lines - Check here to let this text box expand to
accommodate the user’s input.
If you do not check this box, a single line input box appears on the data
entry screen to accept user input.
Note: A field can be either invisible or cannot be changed -- it cannot be
both.
Cannot be changed - Check here to make this field read-only. That is,
the user cannot insert data into it in Data Entry mode.
You might use this option to provide instructions for completing the
screen.
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Field

Description

Validation

Select the kind of validation to apply to this field. Your choices are:
•

No validation - the user’s response is not checked

•

Cannot be blank - the user must enter a response

•

Non-negative whole number or blank - the user must enter a positive whole number or no response

•

Non-negative whole number (required) - the user must enter a
positive whole number

•

Decimal number or blank - must be a decimal number (for example, 12.345 or 12) or blank . A leading minus sign "-" is allowed. The
decimal point must be a period (.), even in locales that normally use
a comma (,).

Note: Decimal numbers include whole numbers because the decimal
point is implied. That is, 12 is 12.0000.
•

Decimal number required - must be a decimal number (it cannot be
blank) of none, one, or two decimal places.

A leading minus sign "-" is allowed. The decimal point must be period (.),
even in locales that normally use a comma (,).
•

Percent: (0-100) required - the user must enter a whole number
from 0 to 100

•

Zip code (US only) - the user’s response must consist of 5 (nnnnn)
or 9 digits separated by a dash after the fifth (nnnnn-nnnn)

•

Social Security number (US only) - the user’s response must consist of nine digits in this pattern: nnn-nn-nnnn

•

Custom - You can create custom validation.

For more information, see ”Custom Validation” on page 286.
If you assign to this field any value other than No validation, the field is
initially surrounded by red dashes in Data Entry mode. If the user’s
response does not meet the validation criterion, the field remains
surrounded by red dashes. The system administrator determines whether
or not the user can save an invalid document.
Data Style

See ”The Data Style Field” on page 285

Resizing a Plain Text Field
If you insert a plain text field and its width is too small or too large,
you can easily resize it. To do so, follow these steps.
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1. Place the cursor over the field and click. The cursor changes to
a four-headed arrow, and small boxes surround the field.
2. Move the cursor to the far right of the field. (See illustration
below). The cursor turns into a two-headed arrow.

3. Drag the arrow to adjust the width.

Rich Area
Use a rich area field to let a user enter a free text response that
can be formatted using the editor buttons.
See Also: ”Plain

NOTE

Text Field vs. Rich Area Field” on page 242

If a rich area field collects a URL, add on-screen instructions to prefix it with
http:\\. If the user does not, the URL address is not stored properly.

Adjusting the Width of a Rich Area Field
Note that, unlike a plain text field, the width of a rich area field
cannot be adjusted. It occupies the entire screen width. If a user
enters more text than fits on one line, the rich area field
automatically adds more lines. To limit the width of a rich area field,
place it in a table cell. In this case, the field is as wide as the cell.
If you want to insert default text into a rich area field, insert it after
you place the field in the editor.
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Dialog Box

Fields on the Rich Area Dialog

Field
Descriptive Name

Description
Enter the name of the field.
Note that you cannot enter spaces nor most special characters
(!@#$%^&*()+=<>,.:;'"{}[]\|`~) into this field.
See Also: ”The Name Field’s Default Value” on page 230

Indexed

Check if you want to index this field. For more information, see ”XML
Indexing” on page 203
The Indexed field may or may not appear, depending on how your
administrator set up your system.

Field Name

Enter the field’s element name. This defines the field in the XML.

Advanced

See ”Advanced Button” on page 280

Use

See ”The Use Field” on page 283

Allow

See ”The Allow Field” on page 284
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Field

Description

Cannot be blank

If you want to require the user completing this field to enter a response,
click inside this check box.

Choices
Use the Choices field when you want to give the data entry user
several options. For example, you create a Choices field named
Interests that lists these options.
•

music

•

art

•

sports

The data entry user could check the first two and leave the third
blank.

Choices Field vs. Select List Field
The following capabilities are available with a Choices field but not
a Select List field.
•

You can limit a user’s choice to one item or allow more than
one

•

All items appear on the screen, arranged horizontally or
vertically

•

If one item is set as the default in the Smart Form
Configuration, it is initially checked. The data entry user can
change the selection as needed.

The following capabilities are available with a Select List field but
not a Choices field.
•

The user can only select one item.

•

Only the default item appears on the screen. To the right of the
field, a down arrow appears (circled in red below). The user
clicks the arrow to display all items and select one.
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Dialog Box
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Fields on the Choices Dialog

Field
Descriptive Name

Description
Enter the name of the field.
Note that you cannot enter spaces nor most special characters
(!@#$%^&*()+=<>,.:;'"{}[]\|`~) into this field.
See Also: ”The Name Field’s Default Value” on page 230

Indexed

Check if you want to index this field. For more information, see ”XML
Indexing” on page 203
The Indexed field may or may not appear, depending on how your
administrator set up your system.

Field Name

Enter the field’s element name. This defines the field in the XML.

Advanced

See ”Advanced Button” on page 280

Tool Tip Text

Enter the text that appears when a user hovers the cursor over this choice list.

List

Using a Standard List
If you want to use one of Ektron CMS400.NET’s standard lists, click the
black down arrow next to the field to see a list of options.

If you choose a standard list, it appears in the lower half of the screen. You
cannot change its values.
Creating a Custom List from Scratch
To create your own set of list options, accept the default value, Custom.
Then, enter the values using the Item field.
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Field

Description

Allow selection

Click More than one to let the data entry user select more than one item on
the data entry screen. Otherwise, click Only one.
For example, if you click More than one, and the choices are: music, art,
sports, the user could select all three choices.
If you click Only one, the user can only select one.
A selection is required - Check this box if the user must select at least one
list item.

Appearance

Click Vertical List to arrange the choices vertically. The user selects items by
clicking the radio button.

Click Horizontal List to arrange the choices horizontally.

Click List Box to arrange the choices vertically in a box. The user selects
items by clicking inside the box.
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Field

Description

Item List

This section of the screen displays the items that you enter in the Value and
Text fields.
Buttons near the bottom of the screen let you remove and rearrange items
from this list.

Place a check in the box of any item to be checked by default on the data
entry screen. If you do, the user can accept the default or uncheck the item by
clicking in the checkbox. Note that if Only One is selected under Allow
selection (above), only one item can be selected.
Value

Enter the value that is collected when the data entry user selects this item.
For example, if Interests appears in the Name field, and you want music to be
collected when the data entry user selects this item and saves the page, enter
music here.

No longer
available

See ”No longer available” on page 255

Basic

Check this box if you want this item’s XML tag to be the same as its name on
the screen.
If you want the XML tag to be different from the screen name, uncheck this
box. When you do, a new field appears, Value. Enter the XML tag into this
field.

Data Style

See ”The Data Style Field” on page 285

Select List
A Select List field is similar to a Choices field. The biggest
differences are
•

all responses appear in a drop-down box instead of appearing
separately

•

the user can only select one response. If you want to allow the
user to select more than one response, use a choice list
instead. See Also: ”Choices” on page 248

To see the choices, click the down arrow on the right side of the
box (circled below).
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See Also: ”Choices

Field vs. Select List Field” on page 248

For example:

Dialog Box
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Fields on the Select List Field Dialog

Field
Name

Description
Enter the name of the field.
Note that you cannot enter spaces nor most special characters
(!@#$%^&*()+=<>,.:;'"{}[]\|`~) into this field.
See Also: ”The Name Field’s Default Value” on page 230

Indexed

Check if you want to index this field. For more information, see ”XML
Indexing” on page 203.
The Indexed field may not appear, depending on how your administrator has
set up your system.

Field Name

Enter the field’s element name. This defines the field in the XML.

Advanced

See ”Advanced Button” on page 280

Tool Tip Text

Enter the text that appears when a user hovers the cursor over this list.

List

Using a Standard List
If you want to use one of Ektron CMS400.NET’s standard lists, click the
black down arrow next to this field to see your choices.

If you choose a standard list, it appears in the lower half of the screen. You
cannot change its values.
See Also: ”Creating Your Own Predefined List” on page 256 and ”Creating a
Dynamically Populated Choice List” on page 257
Creating a Custom List from Scratch
To create your own set of list options, accept the default value, Custom.
Then, enter the values using the Item field.
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Field

Description

Item List

This section of the screen displays the items that you enter in the Value and
Text fields.
Buttons let you remove items from this list as well as rearrange them.
Place a check in the box of any item to be checked by default on the data
entry screen. If you do, the user can accept the default or uncheck the item by
clicking in the checkbox.

Value

Enter the value that is collected when the data entry user selects this item.
For example, if Interests appears in the Name field, and you want music to be
collected when the data entry user selects this item and saves the page, enter
music here.

Text

Enter text to describe this item on the data entry screen.
After you insert this field onto the screen, you can use eWebEdi tPr o+ XML ’s
formatting capabilities to modify its size, font, color, and other attributes.

No longer
available

Use this field to indicate that an item can no longer be selected by a user in
data entry mode. For example, you have a list of team members. If one
member leaves, check No longer available rather than removing the
member.
If checked, the item only appears in data entry mode if a document contained
the item when the check is applied.
This field lets you render a value obsolete without invalidating an existing XML
document.
Exception! -- If multiple selections are allowed in a Choices Field and the
item is selected in design mode, it appears in data entry mode but is disabled
(grayed-out). This lets you force an item's value into the XML document.

Basic

Check this box if you want this item’s XML tag to be the same as its name on
the screen.
If you want the XML tag to be different from the screen name, uncheck this
box. When you do, a new field appears, Value. Enter the XML tag into this
field.

First item is not a
valid selection.
For example,
"(Select)"

Check here if the first item on the list is not a valid value but instead text that
prompts the user to respond to the field. An example of such text for a list of
states is Select a state.
If you check this box and the user selects the first value on the list (most likely
by default), an error message appears when he tries to save the screen.
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Field

Description

Caption

Enter text to guide the user’s selection. For example, if the user needs to
select an area of interest, the caption could be Choose your interests.
Note: The Caption field only appears on this dialog when you create the
Select List field. If you later try to edit the field, the Caption field is not on the
dialog. However, you can edit the Caption text within the editor.

Data Style

See ”The Data Style Field” on page 285

Creating Your Own Predefined List
An administrator can create a predefined list of options to appear
when a user is inserting a Select List field.
Advantage of Creating Custom List in Configuration File
Although a user can create a custom list of choices via the Item
List area of the Select List Field dialog, that list is only available in
that field of that screen. If the user wants to insert the same list in
another section of the screen or a different screen, he must reenter all options.
However, if you create a list according to the steps below, your
custom list is stored in the configuration file (along with the
standard choice lists, such as Countries). As a result, any user
connected to your server can insert the list into any Select List
field on any screen.
Creating the List
To insert a custom list of choices, follow these steps.
1. Open the eWebEditPro+XML configuration file. If you are
working with eWebEditPro+XML, this is webroot/ewebeditpro5/
config.xml.
If you are working with CMS400, this is webroot/Workarea/
ewebeditpro/cms_config.aspx.
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2. Insert the name of your list into the following section of the
configuration file. In the sample below, the custom list is
MyNewList.

<selections name="datalists">
<listchoice data="MyNewList">My New List</listchoice>
<listchoice data="languages" localeRef="sLanguages" />
<listchoice data="countries" localeRef="sCountries" />
<listchoice data="USPS-US" localeRef="sUSState" />
<listchoice data="USPS-CA" localeRef="sCaPrvnc" />
<listchoice data="ageRange" localeRef="sAgeRng" />
<listchoice data="numRange" localeRef="sNumRng" />
<listchoice data="years" localeRef="sYrs" />
</selections>

3. Find the <dataentry> element of the configuration file.
4. Insert the new list within that element. Below is an example of
such a list.
<datalist name="MyNewList">
<schema datatype="string" />
<item default= "true" value= "Green" />
<item value= "Red" />
<item value= "Blue" />
</datalist>

Note that
•

the <datalist> element contains the list

•

its name must match the listchoice
Step 2

•

you can specify a data type. Values are string,
nonNegativeInteger, date, decimal.

•

as shown in the third line above, you can specify a default
value

data

value you entered in

Creating a Dynamically Populated Choice List
You specify the elements of the custom options list described
above in the configuration data. You can also create a dynamicallypopulated list from any XML source. The source can be on your
server or on a remote Web site. Follow these steps to add a
dynamic data list to the Select List field.
1. Follow steps 1 through 3 in ”Creating the List” on page 256.
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2. Insert a new datalist item according to this pattern.
<datalist name="MyNewList" src="{url to xml data source}" select="{xpath to data item
element}" captionxpath="{relative xpath to data item's display text}" valuexpath="{relative
xpath to data item's value}">

WARNING!

The datalist name must match the listchoice data attribute.'

For example
<datalist name="USPS-CA" src="[eWebEditProPath]/uspsca.xsd" select="/xsd:schema/
xsd:simpleType/xsd:restriction/xsd:enumeration" captionxpath="xsd:annotation/
xsd:documentation" valuexpath="@value" namespaces="xmlns:xsd='http://www.w3.org/2001/
XMLSchema'" validation="select-req">

In this example, the data list is stored in the uspsca.xsd file,
located within the ewebeditpro folder. However, it could be in any
XML data source.

Calculated Field
Use a calculated field to perform a calculation based on values in
other fields. For example, if your screen collects mortgage
information, you could create one field to collect the mortgage and
interest payment and another to collect taxes and insurance. The
calculated field could sum those two numbers and display the
monthly payment.
You can validate a calculated field. For example, you can require a
positive number between 100 and 1,000.
Calculated fields are display only -- users cannot edit them.
IMPORTANT!

If a field will be referenced in a calculation, use the validation feature to require a
value for that field. This forces the user to enter a number to be used in the
calculation.
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Dialog Box

Fields on the Calculated Field Dialog

Field

Description

Descriptive
Name

Enter the name of the field.
Note that you cannot enter spaces nor most special characters
(!@#$%^&*()+=<>,.:;'"{}[]\|`~) into this field.
See Also: ”The Name Field’s Default Value” on page 230

Indexed

Check if you want to index this field. For more information, see ”XML
Indexing” on page 203.
The Indexed field may or may not appear, depending on how your
administrator has set up your system.
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Field

Description

Field Name

Enter the field’s element name. This defines the field in the XML.

Advanced

See ”Advanced Button” on page 280

Tool Tip Text

Enter the text that appears when a user hovers the cursor over this field.

Formula

Enter the calculation that this field will perform. See Also: ”Using the Formula
Field” on page 261

Select Field

Click this button to select a field to reference in the calculation. For more
information, see ”Using the Formula Field” on page 261.

Examples

Click the down arrow to the right of this field to see examples of calculations
you can perform. When you select an example, it is copied into the Formula
field.
Note: Your system administrator can customize the examples. Instructions are
provided in “The <cmddsgcalc> Command” in the Data Designer chapter of
the Developer Reference Guide.
See Also: ”Explanation of Examples” on page 263

Validation

Select the kind of validation to apply to this field. Your choices are:
•

No validation - the user’s response is not checked

•

Non-negative number (required) - the result of the calculation must be
a positive number

If you assign to this field any value other than No validation, the field is
surrounded by red dashes in Data Entry mode. If the user’s response does
not meet the validation criteria, the field remains surrounded by red dashes.
Your system administrator determines if a user can save a screen with invalid
data.
Error
message

If you select Non-negative number above, insert text that appears on the
screen if the user’s response does not meet this criterion.

Custom
Validation

See ”Custom Validation” on page 286

Data Style

See ”The Data Style Field” on page 285
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Using the Formula Field
You can copy a sample calculation into the Formula field by
clicking the Examples field and selecting an operation from the
drop down list. For example, if you click Examples Add two
numbers {X}+{Y}, {X}+{Y} appears in this field.

Next, replace the variables with fields on the screen. Be sure to
select the curly brackets ({}) as well as the letter between them.
Then, when the user enters data into those fields, the calculation is
performed using the current field values.
If a calculated field tries to perform a numerical calculation with a
value that is blank or contains letters, NaN appears in the field. (NaN
stands for “not a number.”)
If a calculated field tries to divide by zero, Infinity appears.
WARNING!

If the user does not replace all variables with a field or a number, when the
content is validated, validation will fail.

To do this, follow these steps.
1. Select the first variable to replace. To continue the example,
select {X}.
2. Click the Select Field button. A screen appears listing
appropriate fields on the Data Design screen.
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3. Select a field to replace {X}. When you do, the field name
replaces {X} in the Formula field.
WARNING!

If a variable appears more than once in a formula (for example, {X} * number(
{X} &lt;= {Y} ) + {Y} * number( {X} &gt; {Y}), you only need to replace
the first occurrence - eWebEditPro+XML replaces subsequent occurrences for
you.

4. Continue replacing all variables in the formula.
Notes
•

If an XML document contains several occurrences of a field
that is referenced in a formula, the value is derived as follows:
- When using the XPath functions sum() and count(), all values
with the field name are considered. For example, a
document includes three books whose prices are $10, $20
and $30. In this case, sum’s value is $60.
- When using all other functions, the first value is used. For
example, a document includes three books whose prices
are $10, $20 and $30. If a calculation formula refers to
<price>, its value is $10.

•

You can replace a variable with a number instead of a field. For
example, replace {X} * {Y} with ../price * 1.15.

•

The expression can be complex, such as (round(Field1
+ (1 div Field2)) - 2.
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•

You can use a string expression that creates a text message.
For example, to calculate a full name from its parts: concat(
title, ' ', givenname, ' ', familyname), which could produce
“Dr. Jonathan Smythe”.

Referencing Other Calculated Fields
A calculated field can only reference other calculated fields that
appear before it in a document. For example, a document collects
a series of numbers.
•

One calculated field counts the number of numbers.

•

Another totals their values.

•

A third computes the average by dividing the total by the count.

In this example, you must place the third field below or to the right
of the first two fields. Calculated fields that are defined later in a
document do not appear in the Select Field or Group dialog.

Explanation of Examples
The following table explains the standard examples that appear in
the Examples drop-down list of the Calculated Field dialog. Note
that your system administrator can customize the list, so it may not
match what is below.

Example Field Text

Example Field Formula

Description

Add two numbers

{X} + {Y}

Add the value in the first field (X) to
the value in the second field (Y).

Subtract two numbers

{X} - {Y}

Subtract the value in the second field
(Y) from the value in the first field (X).

Multiply two numbers

{X} * {Y}

Multiply the value in the first field (X)
by the value in the second field (Y).

Divide two numbers

format-number( {X} div {Y}
,'0.###')

Divide the value in the first field (X) by
the value in the second field (Y).
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Example Field Text

Example Field Formula

Description

Format as a percentage

format-number({X} div {Y}
,'#0%')

Determine what percentage one
number (X) is of another (Y).
For example, if {X}=10 and {Y}=100,
the result of the calculation is 10%.

Absolute value of a number

{X} * (number({X} &gt; 0)*2-1)

The number regardless of the sign
(negative or positive).

Minimum of two numbers

{X} * number( {X} &lt;= {Y} ) +
{Y} * number( {X} &gt; {Y})

The smaller of two field values.

Maximum of two numbers

{X} * number( {X} &gt;= {Y} ) +
{Y} * number( {X} &lt; {Y})

The larger of two field values.

Zero if subtraction is negative

({X} - {Y}) * number(({X} - {Y})
&gt; 0)

Subtract one number (Y) from
another (X). If the difference is less
than zero, insert zero.

Multiply by another number if
checkbox is checked

{X} * ( {Y} * number( {Z}
='true') + number( {Z}
!='true'))

X is a numeric field.
Y is another numeric field to multiply
by X if a checkbox is checked.
Z is the checkbox.
For example, {X}=2 and {Y}=3
•

if the checkbox is checked, the
result is 2 * 3, which is 6

•

If the checkbox is not checked,
the result is 2

Round a decimal number

round({X})

Rounds the number to the nearest
integer. For example, round(3.14).
The result is 3.

Round up a decimal number

ceiling({X})

Returns the smallest integer that is
greater than the number. For
example, ceiling(3.14). The result
is 4.
For negative numbers:
ceiling(-3.14) = -3
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Example Field Text

Example Field Formula

Description

Round down a decimal number

floor({X})

Returns the largest integer that is not
greater than the number argument. .
For example, floor(3.14). The
result is 3.
For negative numbers:
floor(-3.14) = -4

Format decimal number 0.00

format-number( {X} ,'0.00')

Rounds a value either up or down to
the hundredth place. As examples,
100 becomes 100.00, and
3.14159265 becomes 3.14.

Total numeric values from
multiple fields

sum( {X}[text()] | {Y}[text()] |
{Z}[text()] ))

Add the values in all referenced
fields.
Only elements that contain a value
are summed. Empty elements are
excluded.

Total a list of numeric values

sum( {X}[text()] )

Total all values in a single repeating
field. Here’s an example.
Plain Text Field properties
Name: Miles
Allow: more than one
Validation: non-negative whole
number
XML Data
<root>
<Miles>89</Miles>
<Miles>12</Miles>
<Miles>23</Miles>
<Miles>19</Miles>
</root>

sum(Miles) equals
89+12+23+19=143
Only elements that contain a value
are summed. Empty elements are
excluded.
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Example Field Text

Example Field Formula

Description

Average a list of numeric values

format-number(sum( {X}[text()] )
div count( {X} ),'0.###')

Calculate the average of all values in
a single repeating field.
To continue the example from the
Total a list of numeric values field
(above):
Plain Text Field properties
Name: Miles
Allow: more than one
Validation: non-negative whole
number
XML Data
<root>
<Miles>89</Miles>
<Miles>12</Miles>
<Miles>23</Miles>
<Miles>19</Miles>
</root>

Average=89+12+23+19=143
divided by the number of values (4)=
35.75
Only elements that contain a value
are summed. Empty elements are
excluded.
Count the number of values in a
list

count( {X} )

Calculate the number of values in a
single repeating field.
To continue the example from the
Total a list of numeric values field
(above):
Plain Text Field properties
Name: Miles
Allow: more than one
Validation: non-negative whole
number
XML Data
<root>
<Miles>89</Miles>
<Miles>12</Miles>
<Miles>23</Miles>
<Miles>19</Miles>
</root>

Count = 4
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Example Field Text

Example Field Formula

Description

Lowercase text

translate( {X}
,'ABCDEFGHIJKLMNOPQRST
UVWXYZ','abcdefghijklmnopqrs
tuvwxyz')

Replace all uppercase characters
with the lowercase version of that
character

Uppercase text

translate( {X}
,'abcdefghijklmnopqrstuvwxyz','
ABCDEFGHIJKLMNOPQRSTU
VWXYZ')

Replace all lowercase characters with
the uppercase version of that
character

Remove extra spaces

normalize-space( {X} )

Remove extra space characters from
content\

Concatenate text

concat( {X} , ', ' , {Y} )

Link text strings together into a single
string. For example, concat('The','
','XML') yields The XML.

Size of a text string

string-length( {X} )

Count the number of characters in a
selected field’s value. For example, if
the referenced field’s value is Hello,
string-length = 5.

Calendar Field
Insert a calendar field when you want the end user to enter a date.
The user must click a date from an interactive calendar.
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Because users cannot enter digits, a standard date format is
ensured.
The date is stored as a standard XML date (in the format yyyy-mmdd), and localized to the computer of the user viewing it.

Dialog Box
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Fields on the Calendar Field Dialog

Field

Description

Descriptive
Name

Enter the name of the field.
Note that you cannot enter spaces nor most special characters
(!@#$%^&*()+=<>,.:;'"{}[]\|`~) into this field.
See Also: ”The Name Field’s Default Value” on page 230

Indexed

Check if you want to index this field. For more information, see ”XML
Indexing” on page 203
The Indexed field may or may not appear, depending on how your
administrator has set up your system.

Field Name

Enter the field’s element name. This defines the field in the XML.

Advanced

See ”Advanced Button” on page 280

Tool Tip Text

Enter the text that appears when a user hovers the cursor over this
field.

Default
value

If you want this screen to have a default date when the user first
sees it, click the calendar icon to the right and select a date. The
user can change the date in Data Entry mode.
Note: If you enter a default date, you cannot later remove it. You can
change it. If necessary, you can delete the field and enter a new one.

Use

See ”The Use Field” on page 283

Allow

See ”The Allow Field” on page 284
Warning! Do not insert a calendar field into a Smart Form that allows
multiple entries (using the Allow more than One option on the
dialog). If you do, you cannot search the Smart Form using that field.
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Field

Description

Validation

If you want to require the user using the calendar to enter a
response, click the down arrow to the right of this response field and
select Cannot be blank.

Error
Message

If you select Cannot be blank above, insert text that appears on the
screen if the user’s response does not meet this criterion.

Data Style

See ”The Data Style Field” on page 285

Custom
Validation

See ”Custom Validation with a Calendar Field” on page 270

Data Style

See ”The Data Style Field” on page 285

Custom Validation with a Calendar Field
The Calendar Field dialog features a Custom Validation button
(illustrated below).

When you click the button, the Custom Validation screen appears.
The screen can ensure the user’s input is greater or less than the
date you are inserting on the Data Design screen.
You can compose an error message that appears if the user’s
response fails to meet the criteria. Your system administrator
determines if a user can save the invalid data.
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When the Custom Validation button is clicked, the Custom
Validation dialog appears.

•

The Data Type field shows Date.

•

The Condition field displays the validation logic.

•

The Examples drop-down list shows validation expressions
that you can apply to the field.

•

Any Error Message displays in Data Entry mode when the
user inserts an invalid value.

When the Select Field button is clicked, the Select a Field or
Group dialog appears.
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This dialog displays fields that can be inserted into the Condition
field. Not all field types are listed. You must choose calendar type
field (note the calendar to the left of these fields.)

Example of Creating Custom Validation
As an example of custom validation, assume that a field collects
the date when a patient’s health insurance policy expires. You want
to make sure the date is later than today. To accomplish this, follow
these steps.
1. Create a calendar field that prompts for today’s date.
2. Create another calendar field that prompts for a patient’s health
insurance policy expiration date.
3. While creating the second field, in the Validation section, click
Custom Validation.
4. The Custom validation screen appears.
5. Click the down arrow to the right of the Examples field to see
sample logic.
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6. Click Date After (. >={X}). This option lets you specify that the
user’s response must be later than a specified date.
7. In the Condition field, select {X} and click the Select Field
button.
8. The Select Field or Group screen appears.
9. Select the field that prompts for today’s date, which you
created in Step 1.
10. That field replaces {X} in the Condition field.
11. Move the cursor to the Error Message field and compose an
error message. For example: Must be after today.
12. Your screen should look like this.

13. Press OK and return to the Plain Text field dialog.
14. Press OK to save that dialog and test the validation on the date
field. To do this, switch to Data Entry mode and enter a date
earlier than today to verify that validation works as expected.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

273

Using the Data Designer with eWebEditPro +XML

Image Only Field
Use an Image Only field to place an icon on the screen, which the
user in Data Entry mode can click to insert an image into the Web
content. You can insert a default image if desired.
To let the user insert any file, such as a Microsoft Word document,
use a File Link field. See Also: ”File Link Field” on page 276

Using an Image Only Field in Data Entry Mode
In Data Entry mode, the image’s caption appears, followed by a
default image (if you specify one) and this icon: .
NOTE

The user can only insert a file whose extension is defined within the <validext>
element of the configdataentry.xml file. Your system administrator can help you do
this.
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Dialog Box

Fields on the Image Only Dialog

Field

Description

Descriptive
Name

Enter the name of the field.
Note that you cannot enter spaces nor most special characters
(!@#$%^&*()+=<>,.:;'"{}[]\|`~) into this field.
See Also: ”The Name Field’s Default Value” on page 230

Indexed

Check if you want to index this field. For more information, see ”XML
Indexing” on page 203.
The Indexed field may or may not appear, depending on how your
administrator has set up your system.

Field Name

Enter the field’s element name. This defines the field in the XML.
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Field

Description

Advanced

See ”Advanced Button” on page 280

Tool Tip Text

Enter the text that appears when a user hovers the cursor over this
field.

Use

See ”The Use Field” on page 283

Allow

See ”The Allow Field” on page 284

Default
Image
Location

If desired, you can insert a default image, which might be the most
common image or simply a reminder that an image needs to be
inserted.
To help find the image, click the From File button and navigate to
image file.
You can only insert an image file whose extension appears between
the <validext> tags in the configdatadesign.xml file. For example:
<validext>gif,jpg,png,jpeg,jpe,doc,txt
</validext>

Cannot be
blank

If you want to require the user completing this field to enter a
response, click inside this check box.

Description

Enter the image’s alt text. The Alt text appears when the user hovers
the cursor over the image on the screen

File Link Field
Use a File Link field to place an icon on the screen which the user
in Data Entry mode can use to link to any file, such as a Microsoft
Word document or a .gif image file. (You can also use an Image
Only field to let the user insert an image. See Also: ”Image Only
Field” on page 274)

Using a File Link Field in Data Entry Mode
In Data Entry mode, the file link field’s caption appears, followed by
this icon:
. When the user clicks the icon, this screen prompts
the user to specify a file, a description, and a Target Frame.
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NOTE

The user can only insert a file whose extension is defined within the <validext>
element of the configdataentry.xml file. Your system administrator can help you
do this.
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Dialog Box

Fields on the File Link Field Dialog

Field

Description

Descriptive
Name

Enter the name of the field.
Note that you cannot enter spaces nor most special
characters (!@#$%^&*()+=<>,.:;'"{}[]\|`~) into this field.
See Also: ”The Name Field’s Default Value” on
page 230
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Field

Description

Indexed

Check if you want to index this field. For more
information, see ”XML Indexing” on page 203
The indexed field may or may not appear, depending on
how your administrator has set up your system.

Field Name

Enter the field’s element name. This defines the field in
the XML.

Advanced

See ”Advanced Button” on page 280

Tool Tip Text

Enter the text that appears when a user hovers the
cursor over this field.

Use

See ”The Use Field” on page 283

Allow

See ”The Allow Field” on page 284

Default
Location

If desired, you can insert a default link, which can be the
most common link or simply an example.
To help find the link, click the Select button and navigate
to a file. You can only insert a file whose extension
appears between the <validext> element of the
configdatadesign.xml file. For example:
<validext>gif,jpg,png,jpeg,jpe,pdf,doc
</validext>

Cannot be
blank

If you want to require the user completing this field to
enter a response, click this check box.

Description

If desired, enter text that the user can click to access the
linked file.

Target
Frame

•

New Window(_blank) - In a new browser window,
on top of the current browser.

•

Same Window(_self) - In the same position within
the browser window. The new window replaces the
current one.

•

Parent Window(_parent) - If your page contains
frames, in the frame that contains the frame with
the hyperlink.

•

Browser Window(_top) - If your page contains
frames, in the full display area, replacing the
frames.
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Field

Description

Data Style

See ”The Data Style Field” on page 285

Fields that Appear on Several Dialogs
Advanced Button
The Advanced button opens a dialog that lets you control the XML
that the field produces.

The dialog lets you generate XML microformats made up of
standard XHTML tags and attributes that contain a specific
structure and values. The types are described below.
WARNING!

In order for Smart Form fields to searchable, they must be stored as elements not
attributes. See Also: ”Advanced Button” on page 280 If you are upgrading to
version 7.5, inspect your Smart Forms and change field properties as needed so
they are stored as elements not attributes.
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Type

This field defines

Example

Element

A unique tag. The user’s response to the field
becomes its value.

<Lastname>Rogers</Lastname>

Attribute

An attribute of the containing field. The containing
field is typically a Group Box.

<PtInformation Lastname="Rogers">
</PtInformation>

If you insert an Attribute field type, the Field
Name field on the dialog box is grayed out. The
field name and type can only be edited on the
Advanced Field properties screen.
Content

The content of the containing field, typically a
Group Box.

<PtInformation>Rogers</
PtInformation>

Note that, in this case, field name is not used. As a
result, the Field Name field is is grayed out.
Since most fields define their own content, this
option is typically used to define a value to a
Group Box that contains other fields defined as
attributes.
IMPORTANT! Only one Content type field is valid
within a containing field.
If you insert an Content field type, the Field Name
field on the dialog box is grayed out. The field
name and type can only be edited on the
Advanced Field properties screen.
Value

Whether the value is an element or plain text.

(Only
appears if
field type is
Image Only
or File Link)

Value is an element renders the field as
•
•

<a href=”url” title=”text”
target=”frame”>text</a> for a file link
<img src=”url” alt=”text” /> for an

image
Value is plain text renders the field as just the url.

Sample Microformat
For example, the microformat of an event looks like this.
<span class="event">
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<a class= "url"href="https://www.lisa.org/events/2006nyc/package_registration.html?from=fn1206
">LISA Global Strategies Summit</a>
</span>

The Data Entry view looks like this.

The Data Design view looks like this.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

282

Using the Data Designer with eWebEditPro +XML

Additional Notes about Advanced Field Properties
•

If the element is a group box or table, its type must be Element
because it surrounds other elements.

•

If the element is a Rich Area field, its type must be Element or
Content.

•

If the element is a link to an external file (either image or link
filed), the Advanced Field Properties dialog has an additional
field, Value. For more information, see ”Value” on page 281.

The Use Field
Click May not be removed if this field must be included on the
screen. Otherwise, click May be removed.
If you check May be removed, when this field appears on a data
entry screen, an icon ( ) appears to the left of the field.
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If the user clicks the icon, a dropdown menu provides an option to
remove the field, as shown below.

If the user removes the field, add field display name replaces
the field on the data entry screen to indicate that the field was
removed and can be added if necessary.
For example, if the field’s display name is street address, and the
user removes the field,
field.
NOTE

appears in place of the

The menu icon ( ) can also indicate that the user can add instances of a field
(see the Allow field, below). So, if a field is required, the icon could appear but
omit a Remove option.

The Allow Field
Check more than one if you want to let the user entering data add
instances of this field. Otherwise, check only one.
WARNING!

Do not insert a calendar field into a Smart Form that allows multiple entries (using
the Allow more than One option on the dialog). If you do, you cannot search the
Smart Form using that field.

For example, if a screen is collecting names and addresses and
you want to let the user enter several of them, check more than
one.
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If you check more than one, when this field appears in Data Entry
mode,

appears to the left of the field, as shown below.

If the user entering data clicks , a menu appears (shown above),
which lets the user add instances of the field to the screen.
NOTE

The menu icon ( ) can also indicate that the user can remove a field (see the
Use field, above). So, even if a field allows only one instance, the icon could
appear but the menu would only display Remove.

The Data Style Field
Click the Data Style button to apply formatting to the field that
accepts user input. When you do, the following dialog appears.

Use the dialog to assign the following formatting attributes to a
user response field.
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NOTE

•

Font style and size

•

Bold and italic

•

Text alignment (especially helpful for formatting dollar amounts
in a plain text field)

•

Underline or strikethrough

•

Font color and/or background color

The configuration data controls a command's appearance on the toolbar and on
the Data Style dialog. For example, if <button command="cmdfontname" /> is
removed from configdatadesign.xml, it disappears from the toolbar and the Data
Style dialog.

Below is an example of a response field whose font, size,
alignment, background, and foreground colors were modified via
this dialog.

Custom Validation
The Plain Text and Calculation field dialogs feature a validation
section (illustrated below).

Adding Standard Validation Options
By default, the Data Designer provides several standard validation
options. You can see them by clicking the down arrow to the right
of the Validation dropdown.
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If you will frequently use a validation format that does not appear
on the list, the following Ektron KB article provides instructions for
creating additional validation options.
http://dev.ektron.com/kb_article.aspx?id=7420

Creating Custom Validation Criteria
If the standard validation options do not provide the flexibility you
need, use the custom validation feature to ensure the following
about the user’s input.
•

The data type - the default types are
- text
- URL
- whole number
- decimal number
- floating point number (Floating point includes scientific
notation, so is appropriate for scientific numbers. Decimals
usually suffice for business numbers.)

NOTE

Your system administrator may customize the choices.

•

The field value has one of the following relationships with
another field, a number, or an expression - the default
expressions are
- between two values (either another field or a number that you
specify)
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- less than
- equal to
- not equal to
- maximum length (usually for text responses)
NOTE

Your system administrator may customize the choices.

If the user’s response fails to meet the criteria, you can compose
an error message that appears when that happens. Your system
administrator determines if a user can save the invalid data.
When the Custom Validation button is clicked, the Custom
Validation dialog appears.

•

The Data Type field is the value’s basic type, for example, text
number or URL.

•

The Condition field displays the validation logic.

•

The Examples drop-down list shows validation expressions
that the data design creator can apply to the field.

•

Any Error Message displays in Data Entry mode when the
user inserts an invalid value.
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When the Select Field button is clicked, the Select a Field or
Group dialog appears.

This dialog displays fields that can be inserted into the Condition
field. Some field types, like the RichArea field, are not listed. See
Also: ”Referencing Other Calculated Fields” on page 263

Example of Creating Custom Validation
As an example of custom validation, assume that a field collects
telephone numbers, and you want to make sure the user enters 10
digits. To accomplish this, follow these steps.
1. Click the Plain Text Field dialog and complete the screen.
2. In the validation section, click Custom Validation. The Custom
validation screen appears.
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3. In the Data Type field, select Whole Number from the drop
down list. This ensures that the user can only enter digits.

4. Click the down arrow to the right of the Examples field to see
sample logic.

5. Click Maximum text length... . This option lets you specify the
length of the user’s response.
6. string-length(.) <= {X} appears in the Condition field.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

290

Using the Data Designer with eWebEditPro +XML

7. Since you want the user’s input to equal 10, remove the less
than sign (<) from the calculation. Now it looks like this: stringlength(.) = {X}.

8. Replace the {X} with 10. Now, it looks like this: stringlength(.) = 10.

9. Move the cursor to the Error Message field and compose a
relevant error message. For example: must be 10 digits.
10. Your screen should look like this.

11. Press OK and return to the Plain Text field dialog.
12. Press OK to save that dialog and test the validation on the
phone number field. To do this, switch to Data Entry mode and
enter more or fewer than 10 digits, as well as non-digit
characters to verify that validation works as expected.
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Ektron CMS400.NET’s HTML Forms feature lets users create
and maintain HTML forms to collect information from visitors to
your Web site.

This section only describes the following technical topics
relating to forms. For more information about using HTML
forms, see the Ektron CMS400.NET User Manual.
•

”Form Permissions” on page 292

•

”Forms Must Use Template with FormBlock Server Control”
on page 293

•

”Preparing the Server to Send email” on page 294

•

”Implementing a Form on a Web Page” on page 295

•

”Sending Data as XML” on page 296

•

”Redirecting Submitted Form Data” on page 303

Form Permissions
Folder Permissions
By default, form permissions are inherited from a form’s folder.
To customize permissions for any folder that contains forms,
access the corresponding folder under Content and assign
permission as described in ”Setting Permissions for a Content
Folder” on page 772.

Administrator Permissions
Similar to content, users in the administrator user group have
full control over form features. You must be a member of the
administrator group to:
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•

Add a form

•

Edit a form

•

Delete a form

•

Assign content to a form

You may also perform all actions on a form’s content.

User Permissions
Users who are not members of the administrator user group can
add, edit, delete, and restore form content if granted these
permissions for the content folder or item.

Forms Must Use Template with FormBlock Server
Control
HTML forms can only be created in a folder whose template uses a
FormBlock or Poll server control. In the Intranet sample site
supplied with Ektron CMS400.NET, the Contact Information folder
uses such a template, contactinformation.aspx (illustrated below).
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You can modify this template as needed or create your own form
template and assign it to any folder via its Folder Properties
screen.
Since, by default, folders inherit properties from their parent folder,
any new folders created under a parent folder use the correct
template. Of course, you can break inheritance and assign a
custom template for any folder.

Preparing the Server to Send email
Since email generated by forms is created on and sent from the
server that hosts Ektron CMS400.NET, the server must be enabled
to handle those responsibilities. To configure your Web server to
send email, refer to Configuring email Notifications in the Ektron
CMS400.NET Setup Manual.
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Implementing a Form on a Web Page
After you create a form, the next step is to implement it on a Web
Page. To do that, follow these steps.
NOTE

The use of server controls or functions to manage templates is documented in the
Ektron CMS400.NET Developer’s Manual.

1. Open the Web form template on which you want the Form
content to appear. (This example uses support.aspx.)
2. Place the FormBlock or Poll server control in the body of the
template. Below is an example of what the form might look like.
IMPORTANT!

Ektron recommends using the Poll server control when displaying a form that is
being used as a Poll or a Survey. For more information, see the Ektron
CMS400.NET Developer Manual section “Poll Server Control.”

3. Save and close the new Web form.
4. To test your form, navigate to your Web site then to the new
page.
5. Complete the form.
6. Click the Submit Form button.
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7. The screen is refreshed and displays the post back message
that you created.

Sending Data as XML
While creating a form that generates email, you can specify that
the email be sent as XML data or plain text.
XML has the following advantages over plain text.
•

Because XML data is structured, you can easily parse the
content to store and retrieve important information.

•

If you download the form data to an Excel spreadsheet, the
XML tags become the spreadsheet’s column headers. See
Also: Ektron CMS400.NET User Manual Section “Working with
HTML Forms” >”Viewing Form Reports” > “Exporting Form
Reports”.

This section contrasts XML and plain text email using the form
displayed below as the example. Here is an example of a form
before it is submitted.
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The following table displays the resulting email, depending on the
method used.
Form
sent as

Generated email

Plain
Text
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Form
sent as

Generated email

XML

XML email Structure
A form’s XML structure consists of two groups of XML tags:
•

Form and mail elements

•

Data elements

The following image illustrates the sections of XML email structure.
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The following explains the sections of the XML email.

Root Tag
The XML email is wrapped in <cmsMail> root tags.

Form and Mail Tags
The form and mail tags display information about the form that was
generated from the form information.
This illustration compares the information defined for the form with
the information in the XML email.
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The following table explains each XML tag in the form and mail
sections of the email.
XML Tag

Description

<FormTitle>

Title given to the form that was submitted.

<FormDescription>

Description given to the form that was
submitted.

<date>

Date and time the form was submitted.

<MailTo>

To email address(es) defined in the form.

<MailFrom>

From email address(es) defined in the form.

<MailCc>

CC address(es) defined in the form.
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XML Tag

Description

<MailSubject>

Subject for the generated email defined in the
form.

<MailPreamble>

Preamble for the generated email defined in
the form.

Data Tags
The XML email’s data tags wrap the information entered by the
form’s submitter. Each form element in the content becomes an
XML tag.
The following image illustrates how a form is edited in the editor,
displayed on a Web page, and then converted to XML for the
email.
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As shown in the graphic, the content is comprised of four form
elements that are converted to XML tags:
•

Name

•

Email

•

PhoneNumber

•

Problem
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Redirecting Submitted Form Data
This section explains how to redirect submitted form data to an
action page. Because the data is redirected via server transfer, you
can easily customize the handling of a multi-page form.
Users can select this option when creating or editing a form
response, as illustrated below.

Instructions for how a user chooses a hyperlink to an action page
are in the Ektron CMS400.NET User Manual section “Working with
HTML Forms” > “Creating a New Form” > “Redirecting to an Action
Page and Forwarding Form Data”.
WARNING!

NOTE

If your form will redirect the user to an action page, it must be implemented using
a FormBlock server control. You cannot use a Poll server control when redirecting
to an action page.
If a form’s specifications indicate that its data is saved to a database, the data is
saved before being forwarded to an action page.

The following section explains how an administrator sets up a
hyperlink to the action page in preparation for a user’s selection.
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Setting Up the Action Page
1. Create the action page. It must
- load and use the form variables
- have an .aspx extension
- reside in the same web application as your Web site
IMPORTANT!

If your site is using URL Aliasing, the action page’s header must include the
following: EnableEventValidation="false" EnableViewStateMac="false"

2. Place the action page in your Web site’s root folder.
3. Set up a library hyperlink to the .aspx page. Here’s how to do
that:
- In Ektron CMS400.NET, go to the Library.
- Select Hyperlinks from the file type dropdown.
- Click the Add button (

).

- In the URL Link field, enter the path relative to the Web root
to the .aspx file you created in Steps 1 and 2. For example:
http://localhost/siteroot/ServerVariables.aspx

- Give the hyperlink a title and save it.
4. Inform your users of the hyperlink. They will select it when
selecting the form response.
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This section explains the administration of the Document
Management functionality in Ektron CMS400.NET. It includes the
following sections:
•

”Document Management Configuration” on page 305

•

”Checking Document Management Permissions” on page 309

•

”Managing Multimedia Assets” on page 312

•

”PDF Generation” on page 319

•

”Adding Assets Automatically” on page 323

•

”Merging Indexing Service Catalogs” on page 330

•

”Troubleshooting” on page 337

Document Management Configuration
This section explains configuring the Document Management
feature. By changing these settings, you can:
•

update Document Management server settings

•

change which file types are allowed on the Document
Management server

•

set the View Type

There are two ways you can configure a Document Management
server:
•

the Asset Server Setup screen in the Workarea. See Also:
”Updating Asset Configuration Settings” on page 306

•

the AssetManagement.Config file. See Also: ”The
AssetManagement.Config File” on page 307

In either case, you are editing the AssetManagement.Config file.
While the Workarea screen provides a simple way to update this
information, some tags can only be updated in the
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AssetManagement.Config file. The table in ”The
AssetManagement.Config File” on page 307 indicates which tags
can be edited in the Workarea.

Updating Asset Configuration Settings
You can update some AssetManagement.Config tags from the
Ektron CMS400.NET Workarea. To do that, follow these steps.
NOTE

Only members of the Administrator User Group can view, add, or edit the Asset
Server Setup.

1. In the Workarea, go to Settings > Configuration > Asset
Server Setup.
2. The Asset Management Configuration screen appears.

3. Click the Edit button (

) for the tag you want to edit.

4. The Value field for that tag changes to a text box.
5. Change the information in the text box.
6. Click the Save button (

).

For more information on each tag, see ”The
AssetManagement.Config File” on page 307.
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The AssetManagement.Config File
The following table describes the AssetManagement.Config file’s
tags.
Element

Description

CatalogLocation=

The folder location of the Asset Catalog. This location is used
when setting up the index service. For example:
“C:\assetcatalog\”.

CatalogName=

The name of the Asset Catalog. This name is used when
setting up the index service.

DomainName=

Can be Domain Name, IP Address or Machine Name. An
example is: localhost. This is the address a Web client system
uses to open managed documents through HTTP.

FileTypes=

Files types that users are allowed to upload to Document
Management. For more information, see ”FileTypes” on
page 327. The default file types installed are
*.doc,*.xls,*.ppt,*.pdf,*.gif,*.jpg,*.jpeg,*.txt,*.log,*.vsd,*.dot,*.zi
p,*.swf,*.wma,*.wav,*.avi, *.mp3, *.rm, *.wmv, *.ra, *.mov,
*.odt, *.odf, *.odp, *.odg, *.ods, *.odb

LoadBalanced=

Enables Load Balancing for assets. Set to “1” to enable. See
Also: ”Load Balancing Assets” on page 1062

Password=

The password for the user created during the install. This
password is encrypted during the install. If you are changing
the user and need to encrypt a new password, use the
dms400encryptpassword.exe encryption tool located in

Editable
within
Workarea?

C:\Program
Files\Ektron\CMS400versionnumber\Utilities\DMS.

ServerName=

The name of the server that hosts E ktron CM S40 0. NET .

StorageLocation=

The folder location where published assets are stored. For
example: “C:\assetslibrary”.

UserName=

The user created during the install.
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Element

Description

WebShareDir=

The folder where temporary data files that are waiting to be
checked in, saved, or published are stored. For example:
”dmdata”.

Editable
within
Workarea?

Allowing File Types
Administrators control which file types are allowed in the
Document Management functionality by editing the
AssetManagement.config file. Reasons for limiting the file types
include:
•

Security - For example, you do not want users to load .exe files
to your Document Management server

•

Ease of Management - For example, you want your Document
Management server to store .doc files only

The <FileTypes> tag in the AssetManagement.config file contain the
file types users can upload. The default file types are:
*.doc,*.xls,*.ppt,*.pdf,*.gif,*.jpg,*.jpeg,*.txt,*.log,*.vsd,*.dot,
*.zip,*.swf,*.wma,*.wav,*.avi, *.mp3, *.rm, *.wmv, *.ra, *.mov,
*.odt, *.odf, *.odp, *.odg, *.ods, *.png,*.docx,*.xlsx,*.pptx,
*.vsdx, *.htm, *.html *.js,*.wmf,*.css,*.xml.

Adding or Removing a File Type
To add or remove a file type from the list, follow these steps.
1. Edit the Workarea > Settings > Configuration > Asset
Server Setup > Update Asset Configuration Settings
screen.
Or
1. Open the AssetManagement.config file. The default location is
(webroot)/(site root).
2. Find the FileTypes=”” element. All file types must appear
between the quotes. For example, FileTypes=”*.doc,*.xls”.
NOTE

Use a comma to separate file types. Also, file types must be formatted as
wildcard.extension. For example, adding an .mp3 file type to the list after *.zip
looks like this: *.zip,*.mp3
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3. Add or remove any file type.
4. Save and close the AssetManagement.config file.

Checking Document Management Permissions
If you are having any problems with permissions, use this section
to verify that your user and folder settings are assigned properly.
See Also:
•

”User Permissions” on page 309

•

”Folders Used by Document Management” on page 311

User Permissions
When the Document Management functionality is installed,
permissions are granted to several users for the following folders:
•

webroot\site root\AssetManagement\dmdata

•

webroot\site root\Assets

•

root\assetlibrary

The assigned permissions vary depending on your server’s
operating system.
The following table lists users and their permissions. Scan down
the column of your server’s operating system to determine which
users and permissions should be enabled for the folders listed
above.
You can use this information to help troubleshoot potential
permission problems.
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User

Needs these
permissions

IIS_WPG User

See ”Advanced
Permissions” on
page 310

IUSR_

See ”Advanced
Permissions” on
page 310

(The IUSR_ account is required
only if Impersonate is set to
True in web.config, and its
username and password
attributes are not specified. If
impersonate is set to false
(default setting), the IUSR_
account may be harmlessly
removed from the folders listed.)
IUSR_Group

See ”Advanced
Permissions” on
page 310

ASP.NET User

See ”Advanced
Permissions” on
page 310

User Defined (The User Defined
user account is required only if
Impersonate is set to True in
web.config, and its username
and password attributes are
specified.)

See ”Advanced
Permissions” on
page 310

Window
s 2000
Pro or
XP Pro

Window
s 2003
Server

Windows
2003
Enterprise
Edition

Advanced Permissions
The following are extended permissions for use with the Document
Management functionality.
•

Traverse Folder / Execute File

•

List Folder / Read Data
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•

Read Attributes

•

Read Extended Attributes

•

Create Files / Write Data

•

Create Folders / Append Data

•

Write Attributes

•

Write Extended Attributes

•

Delete Subfolder and Files

•

Read Permissions

Folders Used by Document Management

Folder

Set by

Description

assetLibrary

User

Defined by user during installation. The path to this
folder can be viewed and changed in the Workarea
under Settings > Configuration > Asset Server Setup
> Storage Location. See Also: ”The assetLibrary
Folder” on page 311

dmdata

Ektron
CMS400.NET

Defined during Ek tr on CMS 400 .NET installation.
Located in the AssetManagement folder. Has settings
for both the File System and IIS.

assets

Ektron
CMS400.NET

Defined during Ek tr on CMS 400 .NET installation.
Located in site root folder.

The assetLibrary Folder
The Asset Library folder contains file assets uploaded to and
managed by DMS. You can view and update the path to this folder
in the Workarea under Settings > Configuration >Asset Server
Setup > Storage Location.
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Managing Multimedia Assets
Multimedia files contain audio, video, or both. File types include
.wav, .mpeg., .swf, .avi, and .wma.
Because of their unique characteristics, these files warrant special
treatment within Ektron CMS400.NET. This section explains how
multimedia files are handled through the following subtopics.
•

”Supported Multimedia Players” on page 312

•

”Multimedia File Types” on page 313

•

”Working with Multimedia Files in Ektron CMS400.NET” on
page 314

Supported Multimedia Players
Ektron CMS400.NET supports the following media players.

•

WindowsMedia®

•

Quicktime®

•

Realplayer®

•

Flash®

This means that Ektron CMS400.NET only supports multimedia files
that run on one of these players. If you import a multimedia file that
cannot play on any supported player, it is treated like any other
asset but cannot be played within Ektron CMS400.NET.

Downloading Media Players
If a Ektron CMS400.NET user within the Workarea, or a site visitor,
tries to play a file and no supporting media player exists on the
user’s computer, the user is prompted to download and install the
player.
If the file uses the Quicktime or Flash media player, the web.config
file contains information that prompts the user to immediately
download and install the player.
If the file uses the Realplayer or WindowsMedia media player, the
user must go to the host Web site and download them.
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Multimedia File Types
Every multimedia file type has a corresponding MIME type. For
example, an mp3 file's MIME Type is audio/mpeg.
All supported MIME types are defined within the mediasettings
element of the web.config file. That section of the web.config file is
reproduced below.
<add
<add
<add
<add
<add
<add
<add
<add
<add
<add
<add
<add
<add
<add

key="application/x-shockwave-flash" value="Flash" />
key="audio/x-wav" value="WindowsMedia, Quicktime, Realplayer" />
key="audio/x-wav-default" value="WindowsMedia" />
key="audio/x-pn-realaudio" value="WindowsMedia, Quicktime, Realplayer" />
key="video/x-avi" value="WindowsMedia, Quicktime, Realplayer" />
key="video/x-avi-default" value="Quicktime" />
key="video/x-msvideo" value="WindowsMedia, Quicktime"/>
key="video/x-msvideo-default" value="WindowsMedia"/>
key="audio/x-ms-wma" value="WindowsMedia"/>
key="audio/mpeg" value="WindowsMedia,Quicktime"/>
key="video/x-realvideo" value="Realplayer"/>
key="video/x-ms-wmv" value="WindowsMedia"/>
key="audio/x-realaudio" value="Realplayer"/>
key="video/quicktime" value="Quicktime"/>

NOTE

A good reference of file and corresponding MIME types is http://
www.w3schools.com/media/media_mimeref.asp.

To determine if a multimedia file type is supported, go to the Web
site listed above to find its MIME type. Then, go to the web.config
file section show above to see if the MIME type exists and, if so,
the supported media players.

Adding Players for a MIME Type
You can add to the list of supported media players for any MIME
Type. To do so, open the web.config file, find the MIME type, and
add the player name within the value element.
Here is an example: <add

key="audio/mpeg" value="WindowsMedia"/>

As shown, WindowsMedia is the only supported player for mp3 files. If
you know that other players can run mp3 files, insert additional
media players after WindowsMedia. To get the exact name of the
player, review the value elements in web.config file section shown
above.
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Adding MIME Types
If you want Ektron CMS400.NET to support additional MIME
Types, add them within the <mediaSettings> element using the
following syntax:
<add key="MIME type/subtype" value="supported media player(s)"/>

For example
<add key="video/x-ms-asf" value="WindowsMedia"/>

You must also add the file type to the list of supported file types in
the assetmanagement.config file. See Also: ”Allowing File Types”
on page 308

Adding a MIME Type’s Default Player
To identify a player as the default for a MIME type, use the
following syntax within web.config.
<add key="MIME Type/subtype" value="default player"/>

For example
<add key="video/x-msvideo-default" value="WindowsMedia"/>

Working with Multimedia Files in Ektron CMS400.NET
Importing Multimedia Files into Ektron CMS400.NET
You import multimedia files into Ektron CMS400.NET the same way
you import other assets. Seethe Ektron CMS400.NET User Manual
chapter “Using the Document Management Functionality,” sections
“Working with Managed Files” and “Importing Files via Drag and
Drop.“
Once imported into Ektron CMS400.NET, a document proceeds
through the same workflow as any other type of content. See Also:
”Setting Approval Chains” on page 778
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Changing Supported Media Players
After a multimedia file is imported into Ektron CMS400.NET, you
can view supported media players’ properties on the Content tab
of the Edit Content screen. All players defined for the file’s MIME
type are checked. You can uncheck any media players that you do
not want to operate a particular file.

If a default media player is defined for a MIME type in web.config,
you cannot uncheck its checkbox. In the above graphic,
WindowsMedia is the default player.
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Changing File Properties
After a multimedia file is imported into Ektron CMS400.NET, you
can edit its properties on the Content tab of the Edit Content
screen.

If the file is supported by several players, first check the player
whose properties you want to modify, then edit its properties.
The Width and Height fields determine the size (in pixels) of the
media player when it appears in the Workarea and on your Web
site. The remaining properties are determined by the media player
(QuickTime in the example above).

Inserting a Multimedia File into Content
To insert a multimedia file into content, follow these steps.
1. Either create a new HTML content item or edit an existing one.
2. Within the content, type text or insert an image that you want
site visitors to click to launch the multimedia file. For example:
Click here to begin playing.
3. Select the image or text you inserted in Step 2.
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4. Apply a quicklink to the multimedia file to the selection. This
procedure is described in the Ektron CMS400.NET User Manual
section “Library Folder” > “Quicklinks and Forms.”

Replacing Multimedia Files
If you want to replace a multimedia file but maintain all CMS
information about that file (for example, its properties, summary,
metadata, etc.), follow these steps.
1. Browse to the folder that contains the multimedia content item.
2. Double click the item.
3. The bottom of the Edit screen has a gray rectangle with the text
Drag files into this window and drop to add.

4. Open Windows Explorer and navigate to the folder that
contains the updated multimedia file.
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5. Drag and drop the file into the lower section of the Edit Content
screen.
6. Save, Check In, or Approve the content.
Note that after you complete the replacement, you can play and
restore older versions of the file through the content’s history. For
more information, see the Ektron CMS400.NET User Manual
chapter “Viewing and Restoring Previous Content.”

Viewing and Listening to Multimedia Files
Users in the Workarea and visitors to your Web site play interact
with multimedia files in the same way.
When either type of user visits a page that hosts a multimedia file,
Ektron CMS400.NET tries to match media players on the user’s
computer with those defined in the web.config file for the file’s
MIME type. Ektron CMS400.NET then displays a list of choices for
every supported media player for the file. The user selects the
preferred one.

Modifying Style Properties of the Multimedia Player
You can change the multimedia player’s style properties by
modifying the EKTTabs.css style sheet. This file is installed to site
folder/Workarea/csslib.
For example, you can change the color of the text that selects a
player to red by changing the property highlighted below.
.EktTabActive
{
padding: 2px 2px 2px 2px;
top:10px;
text-decoration:none;
position: relative;
background-color:white;
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border: solid thin navy;
color:Red;
font-weight:bolder;

}

Here is the result.

PDF Generation
PDF (Portable Document Format) is a file type designed for
distributing compact, platform-independent documents. Each
document is self-contained, packing text, graphics, and fonts into a
single file.
You can automatically convert Office documents stored in Ektron
CMS400.NET to the PDF format. As a result, when a site visitor
accesses a page containing such a document, he sees the PDF
version. Since most computers have a PDF reader, the visitor
needs no additional software to view the file.
IMPORTANT!

Upon installing Ektron CMS400.NET, the Ektron Windows service begins
communicating with Ektron’s external PDF-generation server. To terminate this
communication, disable PDF generation. See ”Disabling PDF Generation” on
page 1053. Alternatively, you can generate PDFs locally. See ”Local PDF
Generation” on page 321.

Why use PDF?
•

Files easily cross multiple platforms, including Microsoft, Apple,
Linux, and Unix.
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NOTE

•

Documents keep their formatting and appear the same on a
computer screen or when printing.

•

File size is typically smaller, which means less bandwidth
usage.

•

Converted Office documents can be viewed by anyone with a
PDF viewer.

•

Site visitors do not need a different viewer for each file type.

Ektron CMS400.NET also supports saving MS Office documents in .html
format, which is also formatted for a browser.

The following sections explain creating PDFs with the Document
Management feature:
•

”PDF Conversion Process” on page 320

•

”Local PDF Generation” on page 321

•

”Enabling or Disabling PDF Generation” on page 322

•

”Designating a Folder to Generate PDFs Automatically” on
page 322

PDF Conversion Process
The PDF conversion of an Office document starts when it is
published. At that point, a copy of the file is sent to an Ektron
server for PDF generation. After the server generates the PDF, it is
returned to your Document Management server.
The PDF file doesn’t appear in the CMS400.NET Workarea -- only
the originally-published Office document appears. Ektron
CMS400.NET stores the PDF file in a secure location. Subsequent
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editing is done in the original Office document. Each time it’s
published, a new PDF is generated.

Once the Office document is added to a Web page, the Web page
shows the PDF version. This means site visitors only need a PDF
viewer to view any Office document on your site.
The Ektron Windows Service runs the Office-to-PDF conversion
process. See Also: ”Ektron Windows Service” on page 1051

Local PDF Generation
If you purchase software from a PDF generation software vendor,
you can create PDF documents on a local network instead of
sending them an Ektron server. Reasons for generating a PDF
locally include:
•

Speed: Office documents can be converted more quickly

•

Security: Office documents never leave the local network

•

Quality: You can configure the output quality
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The following sections explain setting up local PDF generation.

Modifying the PdfGenerator Information in AssetManagement.config
When setting up local PDF generation, use the PdfGenerator
parameter in the AssetManagement.Config file to provide the
location of the local PDF generator. To modify the file, follow these
steps.
1. Open the AssetManagement.Config file, located in your site root
folder.
2. Change the location of the PDF generator.
For example:
PdfGenerator=”http://aspnet20.ektron.com/PdfManager/PdfGeneratorService.asmx”

might become
PdfGenerator=”http://localhost/PdfManager/PdfGeneratorService.asmx”

3. Save and Close the file.

Enabling or Disabling PDF Generation
Administrators decide if this feature is enabled and to which folders
it applies. After enabling this feature, administrators can change
any folder’s properties to allow PDF generation.
Follow these steps to enable or disable this feature.
1. In the CMS Workarea, go to Settings > Configuration >
Setup.
2. Click the Edit button (

).

3. Click the Enable Office Documents to be Published in other
Format checkbox.
4. Click the Save button (

).

Designating a Folder to Generate PDFs Automatically
By setting a folder’s properties to allow PDF generation, all Office
documents published in that folder have a PDF created for them.
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For an introduction to PDF generation, see ”PDF Generation” on
page 319.
The steps below explain how to change the folder property for PDF
generation.
NOTE

Existing subfolders do not inherit PDF generation. Each subfolder needs to be set
individually. However, a new subfolder inherits the PDF generation setting from its
parent folder. Administrators can change the setting while creating a new
subfolder.

1. In the Workarea, click the Content folder button.
2. Click the folder for which you want to enable PDF generation.
3. Click View > Folder Properties.
4. Click the Edit Properties button (

).

5. Click the Publish Office Documents as PDF radio button.
6. Click Save (

).

Adding Assets Automatically
The Auto Add Asset feature automatically transfers assets placed
in a specified folder into Ektron CMS400.NET.
It’s a very helpful feature if, for example, several users work with
assets, you want to manage them with Ektron CMS400.NET, but the
users creating or updating the assets have neither Ektron
CMS400.NET licenses nor the client software installed. These users
simply place the assets in a folder, and the Auto Add Asset feature
moves them to Ektron CMS400.NET.
The Auto Add Asset feature is very flexible. While setting it up, you
can determine the following aspects of how it works.
•

whether it uploads a single asset, multiple assets, a folder, or a
folder and its subfolders

•

the location of the uploaded assets

•

if subfolders are included, do you want to mirror that structure
within Ektron CMS400.NET?

•

file types that can be uploaded
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•

how frequently the specified assets or folders are checked for
new content

The rest of this section explains the Auto Add Asset feature
through the following topics.
•

”Installing the Auto Add Asset Feature” on page 324

•

”Updating the Configuration File” on page 325

•

”Start the Auto Add Asset Service” on page 329

•

”Testing the Auto Add Asset Feature” on page 329

Installing the Auto Add Asset Feature
Follow these steps to install the Auto Add Asset Feature.
1. Verify that Ektron CMS400.NET is running basic authentication
in IIS. For information on how to do this, see
- IIS 6 - http://www.microsoft.com/technet/prodtechnol/
WindowsServer2003/Library/IIS/abbca505-6f63-4267aac1-1ea89d861eb4.mspx?mfr=true.
- IIS 7 - http://technet.microsoft.com/en-us/library/
cc772009.aspx
2. Create the following directories in the file system of the
computer that will transfer the assets to Ektron CMS400.NET.
•

Input - place assets in this directory before uploading them to
Ektron CMS400.NET

•

Backup - assets are moved to this directory after they are
uploaded to Ektron CMS400.NET

•

Error - assets are moved to this directory if there was a
problem moving them to the input folder

3. To each computer that will run the Auto Add Asset Feature,
copy the C:\Program
Files\Ektron\CMS400versionnumber\Utilities\AssetWorkerSetup.msi

file and run it.
This program creates a new folder, C:\Program
Files\Ektron\AssetWorkerSetup.

4. Test that the Web Services are working. To do that, browse to
the following page:
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http://localhost/cms400min/workarea/webservices/
assetservice.asmx
NOTE

Replace localhost with your server name and CMS400min with your site name.

The page displays two Web services: AddAsset and
MakeFolderIfNoExists.

Updating the Configuration File
After installing the Auto Add Asset feature, you can modify the
configuration file, which lets you customize the feature to fit your
particular needs.
The file’s name and folder path is C:\Program
Files\Ektron\AssetWorkerSetup\maindata.config.

The following table

describes its elements.

Element

Description

DmsUserName

The user created during the install.

DmsPassword

The password for the user created during the install. This password is
encrypted during the install. If you are changing the user and need to encrypt
a new password, use the dms400encryptpassword.exe encryption tool
located in C:\Program
Files\Ektron\CMS400versionnumber\Utilities\DMS.

DmsUserDomain

The domain for the user created during the install.

DmsServer

The name of the server on which DMS is running.

CmsUserName

By default, E kt ro n CMS 40 0.N ET inserts the user name vs. This is a special
user that lets you work in Visual Studio.net while signing into CMS as an
administrator.
Note: "Securing Ektron CMS400.NET," on page v advises you to remove the
VS user. If you do, you must create a new user, assign him to the
Administrators groups, and enter his username and password in these fields.
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Element

Description

CmsPassword

By default, E ktron CM S40 0. NET inserts the password of the VS user. If you
change the VS user’s password, or change the CMS UserName, enter the
new password here.
Note: "Securing Ektron CMS400.NET," on page v advises you to remove the
VS user. If you do, you must create a new user, assign him to the
Administrators groups, and enter his username and password in these fields.

CmsUserDomain

Enter the Domain Name, IP Address or Machine Name. An example is
localhost.

A Web client system uses this address to open managed documents through
HTTP.
Protocol

Enter the protocol used to transfer the assets: http or hhtps.

CmsSite

Enter the path to your Web site root. For example, one of E k t r o n
C M S 4 0 0 . N E T ’s sample site’s root is http://localhost/CMS400min.

DmsSite

Enter the path to your Asset Management folder. For example, one sample
site‘s Asset Management folder is http://localhost/CMS400min/
AssetManagement.

ConfigType

Enter the type of file upload you want. Choices are:
•

file

•

multifile

•

folder

•

autofile

•

autofolder

•

autofoldercreate

•

multifolder

•

automultifolder

•

automultifoldercreate

These choices are explained in ”File Upload Types” on page 327.
Folder:
•

Input

•

Backup

•

Error

Enter paths to the folders you created in Step 2 of ”Installing the Auto Add
Asset Feature” on page 324. An example is below.
<Input>C:\Test\Input</Input>
<Backup>C:\Test\Backup</Backup>
<Error>C:\Test\Error</Error>

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

326

Managing Assets

Element

Description

MultiFolder

If your choice at the ConfigType element is listed below, use this element to
specify the folders.
•

multifolder

•

automultifolder

•

automultifoldercreate

Separate each folder with the pipe character (|). Here is an example.
C:\AutoAddAsset\InputPhotos|C:\AutoAddAsset\InputWorddocs|C:\Aut
oAddAsset\InputPDFs

CreateFolder
FileTypes

Enter all file types that can be added using the Auto Add Asset feature.
To identify a file type, enter an asterisk(*), a period (.) and the file’s extension.
Separate each file type with a comma. Here is the sample list that appears by
default:
*.doc,*.xls,*.ppt,*.pdf,*.gif,*.jpg,*.jpeg,*.txt,*.log,*.vsd,*.d
ot,*.zip

Note: The FileTypes field in the Assetmanagement.config file determines
which files can be used within Ek tr on CMS 400 .NET . You should not enter
file types here that are not listed in AssetManagement.config. See Also:
”Allowing File Types” on page 308

File Upload Types
There are nine methods for uploading files from the input folder
into Ektron CMS400.NET. The following table explains the options
and how each works.

File Upload
Type

What is
uploaded

If folder, are
subfolders also
scanned for
assets?

Are new files
uploaded
automaticall
y?

CMS folder
structure set up
to match your
file system?

File

One file

na

no

no

Multifile

Multiple individual
files separated by
a pipe

na

no

no
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File Upload
Type

What is
uploaded

If folder, are
subfolders also
scanned for
assets?

Are new files
uploaded
automaticall
y?

CMS folder
structure set up
to match your
file system?

Folder

One folder

no

no

no

Autofile

One folder

no

yes

no

Multifolder

All specified
folders

yes

yes

no

Note: Specify the
folders at the
Multifolder
element. See
”MultiFolder” on
page 327
Autofolder

All files in
specified folder

yes

yes

no

Autofoldercreate

All files in
specified folder

yes

yes

yes

Automultifolder

All files all
specified folders

yes

yes

no

yes

yes

Yes

Note: Specify the
folders at the
Multifolder
element. See
”MultiFolder” on
page 327
Automultifoldercre
ate

All files all
specified folders
Note: Specify the
folders at the
Multifolder
element. See
”MultiFolder” on
page 327
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Start the Auto Add Asset Service
The Auto Add Asset feature uses a Windows Service to transfer
assets to Ektron CMS400.NET. You must begin the service
manually every time you start Windows. Follow these steps to start
the Auto Add Asset Service.
1. Go to Windows Control Panel > Administrative Tools >
Computer Management.
2. Click Services and Applications > Services.
3. Click the start button (circled below) to start the Automatic
Asset Adder service.

Testing the Auto Add Asset Feature
After completing the above steps, you should verify that the Auto
Add Asset feature is working. To do this, follow these steps.
1. Place files of the appropriate type into the specified input
folder.
2. Open C:\Program
Files\Ektron\AssetWorkerSetup\AssetWorker.exe.config

with a text

editor such as Notepad.
3. Change the value of the PollInterval element to 10000. Save
and close the file.
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4. The input folders will be checked for files every 10 seconds.
They should appear within the Ektron CMS400.NET shortly.

Merging Indexing Service Catalogs
This section explains how to merge two Windows Indexing Service
catalogs. You need to do this if your server has more than the
maximum allowed number of 26 catalogs.
NOTE

The maximum number of catalogs is determined by Microsoft’s Windows Indexing
Service.

See Also:
•

”Windows Indexing Service Catalogs” on page 330

•

”Conditions for Merging Catalogs” on page 332

•

”Procedure for Merging Catalogs” on page 332

Windows Indexing Service Catalogs
IMPORTANT!

When you install more than three Web sites to a server, the catalogs for additional
sites are automatically merged with one of the three existing Web site’s catalogs.
An existing Web site’s catalogs are chosen for merging based on the site with the
least amount of directories to index. When a Web site’s catalogs are merged with
another, the information for each site is kept separate.

Each Ektron CMS400.NET site has three catalogs. In addition, your
server may have catalogs for other applications that use the
Windows Indexing service. Below is an example of what your
Indexing Service catalogs might look like.
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Note that the first six catalogs support two Ektron CMS400.NET web
sites: Cms.example2.com and CMS400Developer. Each site has
three catalogs:
•

Content

•

Private (assets)

•

Publish (assets)

Each catalog has a Directories folder, which lists the directories of
the content being indexed.

Why Merge Catalogs?
The merge reduces the number of catalogs on your server, yet still
indexes each site’s content for the search. After you merge the
catalogs, each site’s search is still limited to content on that site --
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the search does not find content from other sites even though
several sites now reside in one catalog.
When merging catalogs, you copy the directory of the “merge from”
catalog to the Directories folder of the “merge to” catalog. Then,
you delete the “merge from” catalog.

Conditions for Merging Catalogs
•

You can only merge Ektron CMS400.NET catalogs if the Web
sites use the same major point release. For example, you can
merge catalogs from two sites with Release 7.0.4, or a 7.5.0
site with a 7.5.1 site. But you cannot merge a 7.0.4 site with a
7.5 site, because catalog properties change between releases.

•

Each Ektron CMS400.NET site has three catalogs.
- publish
- private
- content
You must merge the same catalog type between sites. So, for
example, you cannot merge a publish with a private catalog.

Procedure for Merging Catalogs
As an administrator, you can merge different Web sites’ catalogs
by using Ektron's MergeCatalog.exe command line utility or by
performing the merger manually. For information on
•

Ektron’s MergeCatalog.exe command line utility - see ”Using
the MergeCatalog.exe Utility” on page 332

•

performing the catalog merger manually - see ”Manually
Merging Catalogs” on page 333

Using the MergeCatalog.exe Utility
There are two ways to use this utility. The first allows you to merge
all of your Web sites’ catalogs until you have only three catalog
sets. For example, if you have five Web sites, you can merge their
catalogs down to the equivalent of three sites. To merge your
catalog sets down to three, run the MergeCatalog.exe file located
in the following folder.
C:\Program Files\Ektron\CMS400v7x\Utilities\MergeCatalog.exe
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The second way allows you to merge catalogs from one specified
Web site to another. For example, you want to merge the catalogs
from your CMS400Developer site to your eIntranet site. See Also:
”Merging Catalogs from One Web Site to Another” on page 333
Merging Catalogs from One Web Site to Another

To use Ektron’s MergeCatalog.exe utility, follow these steps:
1. Open a command prompt.
2. Change the directory to
C:\Program Files\Ektron\CMS400v7x\Utilities.

3. Run the MergeCatalog.exe utility.
Usage: MergeCatalog

“<fromCMS400dir>” “<toCMS400dir>”

Below is an example of using the MergeCatalog.exe command
line utility to merge the CMS400Developer Web site’s catalogs
with the eIntranet site’s catalogs.
MergeCatalog "I:\inetpub\wwwroot\CMS400Developer"
"I:\inetpub\wwwroot\eIntranet"

Once the merge is complete, the following message appears in the
command box.
“Switching shared catalogs for site at <fromCMS400dir> into site at
<toCMS400dir>
Restarting Ektron Windows Service
Catalogs Merged”

Manually Merging Catalogs
Follow these steps for all three catalogs on each site: Content,
Private and Publish.
Part 1: Copy the “From” Catalog Path to a New Directory in the “To” Catalog

In this part, you create a new directory in the “to” catalog. Point the
new directory to the “from” catalog folder. Then, delete the “from”
catalog.
1. Open Computer Management > Services and Applications
> Indexing Service.
2. Select the first catalog that you want to merge from (that is, the
catalog you will delete after merging).
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3. Click its Directories folder.
4. The directory appears in the right pane.
5. Double click it. The Add Directory dialog appears.

6. Press <Ctrl> + <C> to copy the Path field.
7. In the left panel, select the corresponding “to” catalog, the one
into which you will merge the “from” catalog.
WARNING!

Make sure the catalog types match: content > content, publish > publish, private >
private.

8. Right click the mouse and select New > Directory. The Add
Directory dialog appears.
Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

334

Managing Assets

9. In the Path field, paste the path you copied in Step 7 and press
OK.
10. Repeat these steps for the other two catalogs on the site that
you are merging.
11. Click Indexing Service then stop the Indexing service.
12. Delete the three “from” catalogs.
13. Click Indexing Service then restart the Indexing Service. This
action begins indexing the files in the new directory.
Part 2: Update .Config Files with the New Catalog Location

In this part, you open Windows Explorer and navigate to “from”
Web site, that is, the site whose catalog you deleted above. There,
you point its web.config and assetmanagement.config files to the
new catalog.
1. Open Computer Management > Services and Applications
> Indexing Service.
2. Find the catalogs that you have merged into.
3. Resize the window so that it occupies the left half of the screen.
4. Open Windows Explorer.
5. Navigate to the Web site whose catalog you deleted in ”Part 1:
Copy the “From” Catalog Path to a New Directory in the “To”
Catalog” on page 333.
6. In the site root folder, open the web.config file.
7. Resize the window so that it occupies the right half of the
screen.
You should see the Computer Management screen on the left,
and the web.config file on the right.
8. In web.config, find the element <webSearch
defaultProvider="MSIndexDialectServer">.
NOTE

Don’t confuse the MSIndexDialectServer tag with MSIndexServer. You only
need to change MSIndexDialectServer.

9. Shortly after that are catalogName and privateCatalogName.
10. Replace the value of catalogName with the name of the publish
catalog, visible in the Computer Management screen. For
example:
catalogName="CMS400Developer11282007130734Publish"
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11. Replace the value of privatecatalogName with the name of the
private catalog. For example:
catalogName="CMS400Developer11282007130734Private"

12. Save the web.config file.
13. In the site root folder, open the AssetManagement.config file.
14. Resize the window so that it occupies the right half of the
screen.
You should see the Computer Management screen on the left,
and the AssetManagement.config file on the right.
15. In AssetManagement.config, find the element CatalogName.
16. Replace the value of CatalogName with the name of the content
catalog, visible in the Computer Management screen. For
example:
catalogName="CMS400Developer11282007130734Content"

17. Replace the value of CatalogLoc with the path to the newlymerged catalog. To get the path:
- open Windows Explorer.
- navigate to the folder to which the catalog is being copied. For
example, C:\Program Files\
Ektron\Catalogs\CMS400Developer11282007130734\Content

- right click the folder and select Properties.
- copy the Location field.

- Select the assetmanagement.config file’s CatalogLoc tag.
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- replace the path with the copied one. For example.
catalogName=”C:\Program Files\ Ektron\Catalogs\CMS400Developer11282007130734\Content”

18. Copy the “to” catalog name and path entered in steps 16 and
17 to the other catalogs and locations: PublishCatalogName,
PublishCatalogLoc, PrivateCatalogName, and PrivateCatalogLoc.
19. Save the AssetManagement.config file.
20. Stop and restart the Ektron Windows Service.
TIP!

If you still have the Computer Management screen open, you can quickly navigate
to Services and Applications > Services > Ektron Windows Services 2.0.

Troubleshooting
This section explains how to fix problems that may occur with
Ektron CMS400.NET assets.

Symptom

See this section

Error message: Install Indexing Service

”Setting Up the Indexing Service” on page 338

A search of asset files finds no assets on
your Web site

”Turning on the Asset Indexing Service” on page 352
or
”Merging Indexing Service Catalogs” on page 330

You cannot drag and drop assets into

”Removing Front Page Server Extensions” on page 358

Ek tr on CMS 400 .NET

When a user drags a document, the file
opens in the browser instead of
generating an “Uploading” notification

Ektron KB Article: http://dev.ektron.com/
kb_article.aspx?id=14204

The server running E kt r o n
C MS4 00. NE T is running slowly; much of
its resources are being used even though
the computer is idle

”Disabling the System Indexing Service” on page 346

Error message after trying to upload
documents: Failed with error 2147217911

”Removing aspnet_isapi.dll from the List of Wildcard
Application Maps” on page 349
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Symptom

See this section

Error message: Windows Server 2003 no
longer ships MSDAIPP.DLL, thus
connecting to an FPSE server through
Webfolders, is no longer possible.

”Using Microsoft Windows Server 2003 as a Client (Web
Folders Setup)” on page 353

While trying to drag and drop an asset,
an error message appears: The target
directory already exists.

Check the impersonate element of the web.config file. If
it is set to true, make sure the anonymous access
account has at least write access to the dmdata and
assets directories.

When you try to publish DMS documents,

Make sure your production server is not running
Windows XP. You cannot use XP as a production server
for DMS.

Ek tr on CMS 400 .NET sometimes does

not allow them to update.
After recently moving the ASM database
to a new SQL server that has never
hosted an ASM database, the following
error appears while adding a DMS asset:

”ERRMSG: AssetManagement error: Failed to save
asset” on page 356

AssetManagement error: Failed to save
asset. Internal Message: RAISERROR
could not locate entry for error
2000000002 in sysmessages. at
Ektron.ASM.Documents.Asset.Create(en
AssetStatus state) at ... ....

Setting Up the Indexing Service
If you see the following error during installation, you need to set up
the indexing service manually.

The following steps explain how to do that.
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Step
1.

Screen

Click Start > Control Panel
> Administrative Tools >
Computer Management.

The Computer Management
screen appears.

2.

Click the plus sign (+) next
to Services and
Applications.

3.

Click Indexing Service.
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Step
4.

Screen

Click the stop button to halt
the indexing service if it is
running.

Note: If the Index service is
running, the start button
grayed out.

is

5.

Right click Indexing
Service, then click New >
Catalog.

6.

At the Add Catalog Screen:

•

In the Name field, add the
catalog name.

•

In the Location field, identify the folder that will store
the asset catalog.

Note: By default, during
installation, E k tro n
C MS 4 00 .NE T names the
catalog Asset and associates it
with the location
c:\assetcatalog. The installer
can change the default location.
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Step
7.

Screen

Click OK.

The Computer Management
screen shows your new
Indexing Service.

8.

Right click the Asset
catalog, then click New >
Directory.

This is the directory the service
indexes.
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Step
9.

Screen

In the Path text box, add
the folder of the secure
storage location. Make sure
the Include in Index radio
button is marked Yes.

Note: By default, during
installation, E k tro n
C MS 4 00 .NE T uses
c:\(Domain Name, IP
Address or Machine
Name)\assetlibrary.

10. Click OK. Then, click the
plus sign (+) next to Asset
to view the Directories
folder.
In the Directories folder, the new
directory is displayed.
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Step

Screen

11. Right click Assets, then
click Properties.

12. On the Tracking tab,
uncheck all boxes and
choose None for WWW
Server.
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Step

Screen

13. On the Generation tab,
uncheck Inherit above
settings from Service.
Then click OK.
The Index files with unknown
extensions and Generate
abstracts check boxes can be
checked or empty. It is your
choice.

14. Right click Indexing
Service, then click All
Tasks > Tune
Performance.
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Step

Screen

15. Click the Customize radio
button.

16. Click the Customize
button.
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Step

Screen

17. Change Indexing to
Instant.

18. Click OK and OK again to close both dialog boxes.
19. Click the Start button to
start the service again.

Disabling the System Indexing Service
Symptom
The server running Ektron CMS400.NET is running slowly; much of
its resources are being used even when the computer is idle.
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Cause
The Microsoft Windows Indexing service is turned on during
installation. This service indexes every file on the server, and the
resources required to carry out that task slow down other activities.
NOTE

Ektron recommends turning off all indexing services other than the DMS Asset
indexing service.

Resolution
Follow these steps to disable the Windows indexing service. This
change does not affect DMS’s ability to find files because it uses a
different indexing service.

Step
1.

Screen

Click Start > Control Panel
> Administrative Tools >
Computer Management.

The Computer Management
screen appears.
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Step
2.

Click the plus sign (+) next
to Services and
Applications.

3.

Click Indexing Service.

4.

Click the Stop button to
stop the indexing service.

Screen
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Removing aspnet_isapi.dll from the List of Wildcard
Application Maps
Symptom
When you try to upload an asset, you get the error message
“Failed to upload documents.”

Cause
Remove the aspnet_isapi.dll from the list of Wildcard Application
Maps.

Resolution
1. Open IIS.
2. Go to your Ektron CMS400.NET Web site.
3. Underneath the Web site, click Asset Management > dmdata.
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4. Right click dmdata and choose Properties.
5. Click the Virtual Directory tab.
6. Click the Configuration button.
7. Look in the Wildcard Application Maps area. If
aspnet_isapi.dll appears, remove it.
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8. Click OK.
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Turning on the Asset Indexing Service

Step
1.

Screen

Click Start > Control Panel
> Administrative Tools >
Computer Management.

The Computer Management
screen appears.

2.

Click the plus sign (+) next
to Services and
Applications.

3.

Click Indexing Service.
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Step
4.

Screen

Click the Start button to
start the indexing service.

Using Microsoft Windows Server 2003 as a Client (Web
Folders Setup)
Symptom
You receive the following error message:
•

Windows Server 2003 no longer ships MSDAIPP.DLL, thus
connecting to an FPSE server through Webfolders, is no longer
possible.

Resolution
Per MS Licensing, you can obtain webfldrs.msi from any downlevel OS, or any Office product that shipped before Windows2003
(not Office 2003) and install the WebFolders client. Doing so will
keep you compliant with licensing.
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Installing WebFolders from Office 2003 is only allowed if you have
an Office 2003 license for each Windows2003 server you plan to
install WebFolders on.

Web Folders Setup for Microsoft Windows Server 2003
NOTE

You only need to run the Web Folders Setup if there is a problem during the
install. The E k t r o n C M S 4 0 0 . N E T install performs the setup when needed.

The MSDAIPP.DLL is no longer shipped with Microsoft Windows
Server 2003, making communication with Web folders impossible.
To correct this, Ektron CMS400.NET setup runs the Web folder
setup when it detects Microsoft Windows Server 2003.
The following steps explains installing Web Folders. You will need
to obtain a copy of the webfldrs.msi file.

Step

Setup Screen

1.

Double click the webfldrs.msi file.

2.

The Web Folders install
screen appears. Click Next
to continue.
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Step
3.

The Web Folders Identity
dialog box appears.

•

Add your Name.

•

Add your Organization.

•

Click Next.

4.

The Web Folders Product
ID dialog box appears.

Setup Screen

This dialog box displays the
your product ID number.
•

Click Next.

5.

The Web Folders Selection
Choice dialog box appears.

•

Complete - installs all components.

•

Custom - you choose the
components to install.

•

Typical - installs the most
frequently used components.

After making a selection, click
Next.
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Step

Setup Screen

6.

The Verify Ready All dialog
box appears. Click Install
Now.

7.

The Action dialog box
appears. The Setup is
installing Web folders.

8.

The We Are Done dialog box appears. Click OK.

ERRMSG: AssetManagement error: Failed to save asset
Symptom
After recently moving the ASM database to a new SQL server that
has never hosted an ASM database, the following error appears
while adding a DMS asset.
AssetManagement error: Failed to save asset. Internal Message: RAISERROR could not locate entry
for error 2000000002 in sysmessages. at Ektron.ASM.Documents.Asset.Create(enAssetStatus state)
at Ektron.ASM.Documents.AbstractAssetManagement.Create(AssetMetaData assetMetaData,
enAssetStatus state) at Ektron.ASM.PluginManager.PluginHandler.Create(AssetMetaData
assetMetaData, enAssetStatus state) at
AssetManagement.AssetManagementService.Create(AssetMetaData assetMetaData, enAssetStatus
state) at Mojave.AssetManagementProxy.Create(AssetMetaData assetMetaData, enAssetStatus state)
at Ektron.Cms.DataIO.EkContentRW.AddContentv2_0(Collection ContObj) at
Ektron.Cms.EkException.ThrowException(Exception ex) at
Ektron.Cms.DataIO.EkContentRW.AddContentv2_0(Collection ContObj) at
Ektron.Cms.Content.EkContent.AddNewContentv2_0(Collection ContObj)
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Cause
During the creation of the ASM database, a total of 7 messages
are written to the sysmessages table in SQL Server’s master
database. Each installation of SQL Server has its own master
database and, in a typical move from one location to another,
changes to the master database are not brought over.
If the ASM database was moved, and these messages are not in
the sysmessages table in the new location's master table, the
above error appears instead of a standard error message.

Resolution
Run this set of SQL scripts against your database. They add
appropriate messages to the sysmessages table in the master
database.
/
*********************************************************************************************
***/
sp_addmessage 2000000001, 10, N'Error in %s: Error %d inserting into %s. %s', US_ENGLISH,
FALSE, REPLACE
go
/
*********************************************************************************************
***/
sp_addmessage 2000000002, 10, N'Error in %s: Insert into %s returned %d rows. %s', US_ENGLISH,
FALSE, REPLACE
go
/
*********************************************************************************************
***/
sp_addmessage 2000000003, 10, N'Error in %s: Failed creating record because primary key already
exists. %s', US_ENGLISH, FALSE, REPLACE
go
/
*********************************************************************************************
***/
sp_addmessage 2000000004, 10, N'Error in %s: Error %d updating into %s. %s', US_ENGLISH, FALSE,
REPLACE
go

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

357

Managing Assets
/
*********************************************************************************************
***/
sp_addmessage 2000000005, 10, N'Error in %s: Update into %s returned %d rows. %s', US_ENGLISH,
FALSE, REPLACE
go
/
*********************************************************************************************
***/
sp_addmessage 2000000007, 10, N'Error in %s: Error %d deleting into %s. %s', US_ENGLISH, FALSE,
REPLACE
go
/
*********************************************************************************************
***/
sp_addmessage 2000000008, 10, N'Error in %s: Delete into %s returned %d rows. %s', US_ENGLISH,
FALSE, REPLACE
go

This snippet utilizes the sp_addmessage stored procedure from
the master database, which adds the appropriate messages to the
correct table.
NOTE

Although it is possible to recode these as an INSERT statement that can run
directly against the sysmessages table, that procedure is not recommended.

Removing Front Page Server Extensions
Follow these steps to remove FrontPage Server Extensions from
the Web root. When you do, the extensions are also removed from
all folders below that.
1. Click the Windows Start button.
2. Click Control Panel > Administrative Tools > Computer
Management.
3. Open Services and Applications > Internet Information
Services > Web Sites > Default Web Site.
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4. Right click the mouse and select All Tasks > Remove Server
Extensions.
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Managing Ta sks

NOTE

Much of the Task functionality is documented in the Ektron CMS400.NET
Users Manual section “Managing Tasks”. As an administrator, you should
familiarize yourself with this information.

Tasks are typically assigned to content to help you monitor and
manage changes to your Web site. Within Ektron CMS400.NET,
users can assign tasks to themselves and other users. Tasks may
include updating content, publishing content, updating an image
and reordering a collection.
There are two kinds of tasks:
•

Tasks not assigned to content

•

Tasks assigned to content

A standard Ektron CMS400.NET user only sees tasks that are
either assigned to or by himself. However, an administrator can
view all tasks regardless of who they are assigned to or by.
This chapter explains how to access, manage, and assign tasks
via the following topics:
•

”The Tasks Folder” on page 361

•

”Task Permissions” on page 361

•

”Task Categories and Types” on page 362

•

”Automatic Creation of Tasks Associated with Content” on
page 371

•

”Task States” on page 379

•

”Task View Options” on page 382

•

”Email Notification” on page 385

•

”Archiving a Task” on page 386

•

”Deleting a Task” on page 387

•

”Purging a Task” on page 388
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The Tasks Folder
The tasks folder in the Smart Desktop contains all tasks in the Web
site.

Task Permissions
Assign task-related permissions on the screens indicated below.

Permission

Where assigned

Create task

Manage Members for Role: Task-Create

Redirect task (that is,
assign to another user)

Manage Members for Role: Task-Redirect

Delete task

Manage Members for Role: Task-Delete
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For more information about the screens listed above, see ”Using
the Roles Screens” on page 788.

Task Categories and Types
Tasks can be assigned a Task Category, then a Task Type. This
gives users an additional way to filter their tasks.
Task Categories and Task Types have a hierarchical relationship:
the Task Category is the parent, and the Task Type is the child. So,
several types can be assigned to each category.
Some examples of Task Categories might be Engineering, Sales,
Documentation, or Web Design. Examples of Task Types might be
Edit Content, Update Documents, or Contact Customer.
NOTE

Only members of the Administrator User Group or users assigned the following
roles can view, add, or edit task categories and types: Task-Create, Task-delete,
Task-Redirect. See Also: ”Defining Roles” on page 787

You can create Task Categories and Task Types from these
locations.
•

When adding a task. See Also: Ektron CMS400.NET User
Manual section “Managing Tasks” > “Creating a Task via the
Task Folder” When editing a task.

•

When working in the View Categorization screen.

View Categorization Screen
The View Categorization screen allows administrators to work with
Task Categories and Task Types. From this screen you can create,
edit, and delete them.
To access the View Categorization Screen, access the Workarea
> Settings > Configuration > Task Types.
The following screen appears.
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Viewing Task Categories
Note

The View Categorization screen has a system-defined category (Form
Submission Task) that can only be used with forms. You can change its name but
cannot delete it. For more information, seethe Forms chapter of the Ektron
CMS400.NET User Manual.

While in the View Categorization screen, you can collapse and
expand Task Categories. To collapse a Task Category, click the
( ) button next to the Task Category name. To expand one, click
the ( ) button next to the Task Category name.
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The following example shows the View Categorization screen with
one Task Category minimized.

Creating Task Categories and Task Types
From the View Categorization screen, you can create Task
Categories and Task Types by clicking the Add Task button (
When you do, the following screen appears.
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From this screen, you can perform these tasks.
•

”Adding a New Task Category and Task Type” on page 365

•

”Adding a New Task Type to an Existing Task Category” on
page 366

•

”Editing Task Category” on page 367

•

”Editing a Task Type” on page 368

•

”Task Type Availability” on page 369

Adding a New Task Category and Task Type
To add new Task Category and Task Type, follow these steps.
1. Click the Add Task Type button (

).

2. The Add Task Type Screen appears.
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3. Click the Add Task Type to New Task Category radio button
or in the text box.
4. Enter a name in the New Task Category field.

5. Add a Task Type name in the Task Type field.
6. Enter a Task Type Description.
7. Choose a Task Type Availability. See Also: ”Task Type
Availability” on page 369
8. Click Save (

).

9. Your new Task Categories and Task Types appear on the View
Categorization screen.

Adding a New Task Type to an Existing Task Category
To add a new Task Type to an existing Task Category, follow these
steps.
1. Click the Add Task Type button (

)

2. The Add Task Type Screen appears.
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3. Click the Add Task Type to New Task Category radio button
or click the drop down box.
4. Choose a category from the drop down box.
5. Add a Task Type name in the Task Type field.
6. Enter a Task Type Description.
7. Choose a Task Type Availability. See Also: ”Task Type
Availability” on page 369
8. Click Save (

).

9. Your new Task Categories and Task Types appear on the View
Categorization screen.

Editing Task Category
You can edit a Task Category names. To edit a Task Category, click
the Task Category link.

A text box screen appears next to the category name. Use the text
box to change the name.
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You can either save (

) the changes, or cancel (

) the edit.

Editing a Task Type
From the View Categorization screen, you can edit a Task Type.
This allows you to change the Task Type name, Task Type
description, and Task Type availability.
To edit a Task Type, follow these steps.
1. On the View Categorization screen, click a Task Type.
2. The Edit Task Type screen appears.

From this screen you can edit the following:
•

Task Type

•

Task Type Description
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•

Task Type Availability. See Also: ”Task Type Availability” on
page 369

3. Edit the information.
4. Click Save (

).

5. The Task Type information is changed.

Task Type Availability
Task Types can be hidden from users by clicking the Not Available
check box in the Add Task Type and Edit Task Type screens. By
making a Task Type not available, you can suppress without
deleting it.
When you make a Task Type not available, you see the following
warning.

After you make a Task Type not available, the assigned tasks’ Type
and Category are changed to Not Specified.

Deleting Task Categories and Task Types
You can delete Task Types by Task Category or individually.
To delete a Task Type, click the check box next to the Task Type,
then click the Delete ( ) button.
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When you delete a Task Type, the following appears.

To delete all Task Types, check the Delete all check box.
The following example shows which check boxes on the screen
are associated with All Task Types, Task Categories, and individual
Task Types.
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Automatic Creation of Tasks Associated with
Content
In addition to the manual assignment of tasks, they can be
automatically generated whenever content, an asset, or a form is
created. You would enable and use the Automatic Task Creation
feature if you want to set up a preapproval process, which requires
one or more users to review and approve content before it enters
the regular approval process. (The regular approval process is
described in ”Setting Approval Chains” on page 778.)
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The most common scenario illustrated below.

In this example, an automatically-generated task assigns the
content to a preapproval group. When any member of that group
reviews his tasks, he inspects the corresponding content and
assigns it to an editor. After the editor reviews and possibly edits
the content and submits it for approval, it enters the normal
approval process.
This section explains the automatic task creation process through
the following subtopics:
•

”Enabling Automatic Task Creation” on page 372

•

”Assigning a Preapproval Group to a Folder” on page 373

•

”How Automatic Task Creation Works” on page 375

Enabling Automatic Task Creation
The Settings > Configuration > Application Setup screen’s Enable
PreApproval Group field controls Ektron CMS400.NET’s Automatic
Task feature. Check this box to turn Automatic Tasks on.
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Next, you create user groups and assign them to folders whose
content must complete the preapproval process before it enters
the regular approval process. See ”Managing User Groups” on
page 723 and ”Assigning a Preapproval Group to a Folder” on
page 373.

Assigning a Preapproval Group to a Folder
The ability to select or update a folder’s preapproval group is
determined by the advanced permission Modify Preapproval.
Only users with this permission can see the Modify Preapproval
button ( ) when viewing the Folder Properties screen. See Also:
”Standard & Advanced Permissions” on page 770
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If you have permission to modify a folder’s preapproval group, go
to the Folder Properties screen and click the Modify Preapproval
button ( ) to access the PreApproval Group field. (The field
only appears if you have enabled the Preapproval Feature. See
”Enabling Automatic Task Creation” on page 372.)
If you assign a user group, an automatic task can be assigned to
that group whenever content in that folder is created or updated.

If you select Inherit, this folder gets its preapproval group from the
parent folder. If you select None, you disable the preapproval
feature for the folder.
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Preapproval Groups Report
The Preapproval Groups Report lists all preapproval groups
assigned to folders within Ektron CMS400.NET. To access it, go to
Smart Desktop > Reports > Preapproval Groups. See Also:
Ektron CMS400.NET User Manual > “The Workarea and Smart
Desktop” > “Understanding the Smart Desktop.”

How Automatic Task Creation Works
When a user submits a content item for approval, Ektron
CMS400.NET checks to see if an open task exists for it. (An open
task is one whose state is Not Started, Active, Awaiting Data, on
Hold, or Pending.) If none exists and a preapproval group is
assigned to its folder, a task is created and associated with the
content.
At this point, all members of the folder's preapproval group see the
task on their Smart Desktop.
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A task has the following information.
.
Field

Value

Title

A string formulated by joining the
•

content title

•

content ID number

•

underscore

•

Task

For example, Private Content2_Task
Assigned to

The preapproval group

Assigned by

The user who submitted the content
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Field

Value

Content

The content being submitted for approval

Priority

Normal

State

Not Started

Due date

none

Start date

none

Created by

User who submitted content

Description

none

Next, the task can be reviewed by any member of the preapproval
group. The member then has two choices.

NOTE

•

review the content and submit it for publishing. This action
completes the preapproval process and submits the content
into the regular approval chain.

•

assign the task to another user, such as an editor. (The user to
whom the task is being assigned must have permission to edit
the content.) The editor reviews the content, updates it as
needed, and submits it into the regular approval chain.

The user submitting the content does not need permission to create tasks. Also,
the user assigned to the task should not change its state using the task system.
Instead, he should review and approve content using the regular content workflow
mechanism. That mechanism automatically changes the task’s state.

The tables below explain the sequence of changes to content and
its associated task. All changes are logged into the task’s history.
See Also: Ektron CMS400.NET User Manual > “Managing Tasks” >
“Viewing a Task’s History”
Also, email is automatically generated for automatic tasks as it is
for manually-created tasks. See Also: ”Email Notification” on
page 385
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Sequence of Task/Content Statuses (Author Lacks Permission to
Approve Content)

Event

Content Status

Task Status

Content is created and checked
in

Checked In

No auto task assigned

Content is submitted for
approval

Waiting for completion of
associated tasks

Not Started

Content is assigned by a
member or preapproval group to
an editor

Waiting for completion of
associated tasks

Not Started

Editor updates content then
checks it in

Checked In

Active

Content is submitted for
approval; it enters any approval
chain set for the folder

Submitted for Approval

Pending

Approver denies request

Checked In

Reopened

Approver approves content

Approved

Complete

Note: The above action creates
the automatic task for the
content.

Note: Since the task requires an
approval, it appears in the task
list of the current approver.
When the content is approved,
the task is moved to the next
approver's task list.
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Sequence of Task/Content Statuses (Author Can Approve Content)

Event

Content Status

Task Status

Content is created then checked
in

Checked In

No auto task assigned

Content is edited then checked
in

Checked In

Active

Content is submitted for
approval

Waiting for completion of
associated tasks

Not Started

Approved

Complete

Note: Although an author can
approve content, he must click
publish twice: once to change
content status to Awaiting
Completion of Associated Task,
and a second time to change it
to Approved.
Content is published

Task States
During the life of a task assigned to content, it normally progresses
through a series of states. The state helps track a task’s progress
from creation to completion and even removal from the database.
When reviewing the history of a task, the state can be used to
review which actions changed the task’s state by whom and when.

User-Assigned versus System-Assigned States
Some states can only be assigned by users while others are only
assigned when an event occurs to the associated content. For
example, when content is first submitted for approval, the
associated task’s state changes to Not Started.
IMPORTANT!

The administrator user can always change a task’s state to any other state.

The following graphic illustrates the sequence of user and system
actions that change a task’s state.
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Progression of Task States

State

Description

Assigned
by

Not Started

Assigned when task is created.

User

Active

The task’s content is checked out.

System

Awaiting
Data

The task is started but the assigned-to user is awaiting
data from an external source. You can use comments
to indicate the data being waited for.

User

On Hold

Task cannot be worked on at this time.

User
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State

Pending

Description

Assigned
by

The content is submitted for approval.

System

A task remains pending while its content is in the
approval process. When the last person in the
approval chain approves the content, the task’s state
changes to Completed.
If any approver declines the content, the task’s state
changes to Reopened.
If an editor edits the content and then checks it back
in, the task’s state changes to Reopened.
Reopened

Content is declined by an approver in the approval
process. Also, if someone edits content whose task
state is pending, the tasks’s state changes to
Reopened.

System

Completed

The last user in the approval chain approves the
content and it is being published.

System

Archived

After a task is completed, administrators can assign
this state. It no longer appears on open task lists but is
kept for reviews and reports.

User

Only the administrator can view Archived tasks.
See Also: ”Archiving a Task” on page 386
Deleted

When an archived task is no longer needed for
reporting or reviewing, administrators can assign this
state. While in this state, the task remains in the
database. See Also: ”Deleting a Task” on page 387
When you purge the task, it and all of its transactions
are removed from the database. See Also: ”Purging a
Task” on page 388

User (user
with delete
permission
can delete;
only admin
and user with
Task-Delete
role can
purge)

Restrictions on the Task Flow Process
•

Only users with archive and delete permissions can set a task’s
status to archived or deleted. This can be done at any stage of
the task flow process.

•

Notes can be entered for the task at any time.
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•

An administrator can assign a task to any state at any time.

Task View Options
Beneath the main task module folder, 14 view screens display all
tasks filtered by specified categories. The categories appear in
”The Tasks Folder” on page 361.
After viewing tasks in any category, most screens let you perform
an action on the tasks (the actions are included in the table below).
For example, you can redirect your tasks to another user. To select
all tasks on a screen, click the check box in the header row
(illustrated below).

Folder

Displays these tasks

Action you can perform
from view screen

Tasks

Open tasks assigned to yourself, and
open tasks you have assigned to other
users.

•

Create a new task

•

Delete a task

•

View a task

•

Sort tasks by column

•

Edit a task

•

Sort tasks by column

All Open Tasks

All open tasks (that is, tasks in one of
these states) for all users
•
•
•
•
•

not started
active
awaiting data
on hold
reopened

•

pending

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

382

Managing Tasks

Folder

Displays these tasks

Action you can perform
from view screen

Assigned To Me

All open tasks assigned to you

•

Assign tasks to a different
user

•

View a task

•

Sort tasks by column

•

Assign tasks to a different
user

•

View a task

•

Sort tasks by column

•

View a task

•

Sort tasks by column

•

Select any user and view
all tasks assigned to that
user.

Assigned By Me

Created by Me

Assigned to User

All open tasks you assigned to yourself or
others

All open tasks you created

All open tasks assigned to a user you
select

To do so, select new user from
Assign to User drop down list
and click Get Tasks.

Not Started

Active

Awaiting Data

On Hold

•

View a task

•

Sort tasks by column

All whose state is Not Started

•

Change to any other state

See Also: ”Task States” on page 379

•

View a task

•

Sort tasks by column

•

Change to any other state

•

View a task

•

Sort tasks by column

•

Change to any other state

•

View a task

•

Sort tasks by column

•

Change to any other state

•

View a task

•

Sort tasks by column

All whose state is Active

All whose state is Awaiting Data

All whose state is On Hold

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

383

Managing Tasks

Folder

Displays these tasks

Action you can perform
from view screen

Pending

All whose state is Pending

•

Change to any other state

•

View a task

•

Sort tasks by column

•

Change to any other state

•

View a task

•

Sort tasks by column

•

Change to any other state

•

View a task

•

Sort tasks by column

•

Change to any other state

•

View a task

•

Sort tasks by column

•

Change to any other state

•

Purge tasks

•

View a task

•

Sort tasks by column

Reopened

All whose state is Reopened

Completed

All whose state is Completed

Archived

All whose state is Archived

Deleted

All whose state is Deleted

Determining Which Tasks a User Can View
To provide security, Ektron CMS400.NET restricts which users can
use the task views. These restrictions are listed on the following
table.

View
option

All Open *
Assigned by
Me

Administrator
group member

User or
group to
whom task
assigned

User who
assigned
task

User who
created
task

All users

X
X

X
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View
option

Administrator
group member

User or
group to
whom task
assigned

User who
assigned
task

X

Created by
Me *

Not Started

All users

X

Assigned to
Me *

Assigned to
User

User who
created
task

X

X

all tasks in
specified state

X

X

X

only tasks
assigned to
user in
specified
state

Active

|

|

Awaiting
data

|

|

On hold

|

|

Pending

|

|

Reopened

|

|

Completed

|

V

Archived

|

Deleted

V
* - user can only view open tasks, that is, not started, active, awaiting data, on
hold, pending, or reopened

Email Notification
email notification is sent on these occasions.
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IMPORTANT!

For email notifications to be sent, the following items must be true:
- Users have email enabled in their user profile.
- Users have a valid email address in their user profile.
- CMS400.NET is set up and configured to send emails.

•

A task is assigned to a user.

•

A task is redirected to a user.

•

A task is submitted for content approval. Sent to the first user in
the approval chain.

•

The approval process moves on to the next approver.

•

The content is declined at an approval stage. This is sent to the
assigned user.

•

The content is published. This goes to the creator, assigned
user, and the approvers.

See Also: “Configuring E-Mail for Tasks and Content Notifications”
in the Ektron CMS400.NET Setup Manual

Archiving a Task
After a task is completed, you may want to change its state to
Archived. Archiving moves selected tasks from the Completed
tasks list to the archived list. This change cleans up the completed
tasks list and makes it and easier to use.
Archived tasks are typically kept for a predetermined time period,
at which point an administrator deletes them (depending on your
organization’s policies).
To archive a task, follow these steps.
1. From the Smart Desktop, open the Tasks folder.
2. Click the view option corresponding to the state of tasks you
want to archive. Typically, you would archive completed tasks.
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3. A list of Completed tasks appears. Select tasks one at a time,
or click the check box on the top left corner to select all.

4. Next to the Change to State field, click the down arrow to
display the drop down list and select Archived.
5. Click the Set button.

Deleting a Task
You can easily delete tasks no longer needed on the Web site.
Although an administrator can change a task’s state to deleted at
any time, you typically do so after it is completed or archived,
depending on your organization’s policies.
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Note that a deleted task remains in the system until you purge it. It
is only visible on the View Deleted Tasks option. See Also:
”Deleted” on page 381.
Tasks can be deleted either one at a time, or several at once.
To delete tasks, follow these steps.
1. From the Smart Desktop, click the Tasks folder.
2. Click the view option corresponding to the state of tasks you
want to delete. Typically, you would delete archived tasks.
3. Select tasks one at a time, or click the check box on the top left
corner to select all.
4. Next to the Change to State field, click the down arrow to
display the drop down list and select Deleted.
5. Click the Set button.

Purging a Task
If you want to remove deleted tasks from the system, you purge
them. Upon purging, a task and its history are removed from the
database.
To purge one or more tasks, follow these steps.
1. From the Smart Desktop, click the Tasks folder.
2. Click the Deleted view option.
3. Select tasks one at a time, or click the check box on the top left
corner to select all.

4. Click the Purge button.
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NOTE

This chapter describes the operation of the Web Search server control, which was
introduced by the 7.0 Release. To learn about the operation of the Search server
control (the search available prior to 7.0), see http://www.ektron.com/manuals/
cms400/v61/useradmin/search.62.1.html.

NOTE

This chapter only describes searching HTML content. To learn about searching
XML Smart Form content, see ”XML Indexing” on page 203.

Ektron CMS400.NET provides two kinds of searches:

•

the Web site search helps site visitors find published content
on your Web site.
Your Web developer determines where to place the Web site
search. The Ektron CMS400.NET sample site provides a link to
it from every page. When a site visitor clicks the link, he sees
the search screen.

For more information, see ”Web Site Search” on page 391.
•

the Workarea search helps anyone signed into Ektron
CMS400.NET to find content. To access the Workarea search,
go to the folder whose content you want to search and click
Action > Search. The following screen appears.
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The left tab lets you access the default version of the Web site
search, while the right tab lets you search content by properties
(title, comments, creation date, status, etc.).
To learn more about the Workarea search, see the Ektron
CMS400.NET User Manual section “Searching the Workarea.”
The Web site search is more fully explained through the following
topics.

NOTE

•

”Web Site Search” on page 391

•

”The Catalog and Index Files” on page 391

•

”Basic versus Advanced Web Site Search” on page 406

•

”Display of Search Results” on page 412

•

”Synonym Sets and Suggested Results” on page 416

•

”Using the Integrated Search” on page 434

•

”Setting up a Multiple Site Search Using Virtual Directories” on
page 441

•

”Searching for Metadata” on page 445

•

”Installing the Visio IFilter” on page 445

•

”Query Language” on page 446

•

”Search Troubleshooting” on page 458

For information about inserting the Web Search server control into an Ektron
CMS400.NET Web template, see the Ektron CMS400.NET Developer Manual.
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Web Site Search
Ektron CMS400.NET’s Web site search provides extremely fast

results without impacting the load on your database. To
accomplish these goals, Ektron CMS400.NET stores a separate
copy of all published content in local index files (also known as a
catalog). The Microsoft Windows Indexing service constantly
indexes the catalog so that search results are returned with
lightning speed.
NOTE

Actually, two catalogs are created: one for public content, and another for private
content.

Another advantage of the indexing service is its robust query
language. Site visitors can use it to find Web site content by
combining a rich collection of search criteria, including
•

boolean and proximity operators

•

wildcards

•

free text queries

•

vector space queries

•

property value queries

These are explained in ”Query Language” on page 446.
A third benefit of this architecture is scalability. If the amount of
content or number of hits begins to affect performance, you can
move the catalog to a separate server to handle the increased
workload.

The Catalog and Index Files
NOTE

Be sure that your Web server is running Indexing Service 3.0. Earlier versions of
the service do not work properly.

The Microsoft Windows Indexing Service uses catalogs to index
Ektron CMS400.NET content. The catalogs read copies of content
that are saved to the local file system whenever they are
published.
This section explains the following topics about working with the
Indexing Service and catalogs.
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•

”Local Index Files” on page 392

•

”The Catalogs” on page 393

•

”Recreating a Catalog” on page 395

•

”Restarting the Indexing Service” on page 402

Local Index Files
A separate copy of all published content is maintained in local
index files (whose extension is .txt), which are stored in the
siteroot/assets folder. Within that folder is a reproduction of the
CMS folder structure. However, it uses the folder ID number, not
name, to represent folders. The following graphic illustrates this
structure.

Notice that each content item is saved as a .txt file for indexing.
The file name is derived from the content item’s
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•

ID number

•

underscore (_)

•

language ID

•

file extension (content items have an .html extension)

•

.txt file extension

The Catalogs
Ektron CMS400.NET stores a copy of all published content in two

catalogs that can be queried. Their default names are below.
•

siteroot uniqueID Publish

•

siteroot uniqueID Private

As indicated, the second catalog stores private assets. See Also:
”Private Content” on page 744
To access these catalogs within the indexing service, go to
Computer Management > Services and Applications >
Indexing Service.
Within the file system, these catalogs reside in the c:\program
Files\Ektron\Catalogs\siteroot unique identifier folder. For
example, C:\Program Files\Ektron\Catalogs\CMS400Min312007131255.
View a catalog’s properties to see the fields you can use in
queries. See Also: ”Property Value Queries” on page 451
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Changing a Catalog’s Name
To change a catalog’s name, open the siteroot/web.config file with
an editor such as Notepad. Then, update the catalogName element
for the published catalog name, and the privateCatalogName
element for the private catalog name.
<webSearch defaultProvider="MSIndexDialectServer">
<providers>
<add name="MSIndexDialectServer"
type="Ektron.Cms.WebSearch.SearchProviders.MSIndexDialectProvider, Ektron.Cms.WebSearch"
catalogName="localhostPublished" privateCatalogName="localhostPrivate" pageSize="10"
description="MS Index Server Dialect2 Provider"/>
<add name="MSIndexServer"
type="Ektron.Cms.WebSearch.SearchProviders.MSIndexProvider, Ektron.Cms.WebSearch"
catalogName="localhostPublished" privateCatalogName="localhostPrivate" pageSize="10"
description="MS Index Server SQL Provider"/>
</providers>
</webSearch>
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Recreating a Catalog
If a catalog is accidentally deleted or becomes corrupted, follow
these steps to recreate one. There are two ways to do this.
•

”Manually Recreating a Catalog” on page 395

•

”Automatically Recreating a Catalog” on page 396

Manually Recreating a Catalog
Part 1: Create a New Catalog and Copy Metaconfig.doc File to it

1. Open the C:\Program

Files\Ektron\Catalogs

folder.

2. Create a folder for the new catalog.
3. From the Computer Management screen, select Services and
Applications > Indexing Service.
4. If the indexing service is running, right click Indexing Service
and click Stop.
5. Right click the mouse and select New > Catalog.
6. Assign the catalog a name. At the Location field, browse to the
folder you created in Step 2.
7. Navigate to the C:\Program
Files\Ektron\CMS400releasenumber\Utilities

directory and find

the metaconfig.doc file.
8. If you are creating a public catalog, copy that file to the site
root/Assets folder.
If you are creating a private catalog, copy metaconfig.doc to
the site root/PrivateAssets folder.
9. From the Computer Management screen, click the new catalog
you created in step 5. Underneath it, a Directories folder
appears.
10. Select the Directories folder and click New > Directory.
11. The Add Directory Screen appears. If you are creating a public
catalog, browse to the site root/Assets folder. If you are
creating a private catalog, browse to the site root/PrivateAssets
folder.
12. Right click Indexing Service and click Start.
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13. From the Computer Management screen, view the new
indexing service. Make sure a number appears in new
catalog’s Total Docs column, and the Docs to Index number
is zero (0) before proceeding.
Part 2: Update Metaconfig.reg

1. Navigate to the C:\Program
Files\Ektron\CMS400releasenumber\Utilities

directory

2. Open the metaconfig.reg file with an editor like Notepad.
3. Update the first line of that file with the location of the new
catalog relative to the C:\Program Files\Ektron\Catalogs folder.
For example, if the new folder within the catalog folder is
named mytest, the first line of the metaconfig.reg file looks like
this.
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\ContentIndex\Catalogs\mytest\Properties]

4. Save the file.
5. Double click the file. This action updates your Windows
Registry with the new information.
6. Stop and restart Windows Indexing Service. Both commands
are available from the menu that appears when you hover over
the Indexing Service and right click the mouse.
7. View the new Indexing Service to verify that all properties exist
as in the original service.
Part 3: Update web.config

Follow the directions in ”Changing a Catalog’s Name” on page 394
to update the catalogs that are updated as content is updated.

Automatically Recreating a Catalog
If you don’t want to perform the manual steps listed above, Ektron
CMS400.NET provides a utility that automatically creates a new
catalog. You would typically use this if a catalog were corrupted or
accidentally deleted.
IMPORTANT!

Before running the Search Data Configuration utility, if your server has Visio
documents, install the Visio IFilter. See ”Installing the Visio IFilter” on page 445.
Also, if your server has Office 2007 documents, install the Microsoft Office
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SharePoint Server 2007 IFilters. See http://technet2.microsoft.com/Office/en-us/
library/c6c029bd-64ea-4617-b2da-c269f13599e21033.mspx?mfr=true.

WARNING!

Make sure all Ektron CMS400.NET users are signed off before you begin this
utility. If they are not, the utility logs them off.

To launch the utility, follow this path from the Windows Start button:
Start > Programs > Ektron > CMS400 version > Utilities >
SearchConfigUI
Alternatively, click the following file: C:\Program
Files\Ektron\CMS400vversionnumber\Utilities\SOFTWARE\SearchConfig\s
earchconfigUI.exe
When you do, the following screen appears.
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To create a new published asset catalog, follow these steps.
1. In the Published Catalog field, enter the name of a new
catalog. Or, leave the current catalog name, and the utility will
overwrite the catalog.
2. Do the same to create a new or replace the Private Catalog.
3. Check the Create New Catalogs box.
4. If you want to automatically generate a summary for all content
in the new catalog, click the Automatically generate
summary for content checkbox. See Also: ”Auto Generating
Summaries” on page 80
5. Click the Advanced tab.
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6. Check each type of content that you want to index for the
search.

7. By default, new catalogs are created in the web site root/
catalogs folder. If you want to create these in another folder,
use the Specify directory for catalogs field to enter or browse
to that folder.
8. Press Start.
9. Ektron CMS400.NET creates a new catalog and index files for
your content.
After you run this utility, the old catalog remains but no new content
is written to it. All subsequent changes are written to the new
catalog.
See Also: ”SearchConfigUI.exe crashes while building search
indexes and catalogs” on page 460

The SearchConfig Log
All activity generated by the Search Data Configuration screen is
tracked by a log. You can view the log top obtain a history of these
changes.
The log is located in the C:\Program
Files\Ektron\CMS400vversionnumber\Utilities\SOFTWARE\SearchConfig
folder. Its name is date time.LOG. The log is also available on the
Search Data Configuration Screen’s Log output tab.

Search Data Configuration Screens
Use these screens to perform the following actions.
•

make all Ektron CMS400.NET content searchable (do this if you
recently switched to a new database)

•

make any of the following kinds of content searchable (do this if
the search cannot find this content)
- HTML
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- assets
- XML Smart Forms
- users and groups
- forums
•

reindex the catalogs

•

create a new catalog and index it (do this if a catalog was
corrupted or accidentally deleted)

The following table explains the fields on the screens.
See Also: ”The SearchConfig Log” on page 399

The Configuration Tab

Field

Description

Web Site

Select the Ek tr on CMS 400 .NET site that you want to work with

Connection String

Review the connection string to your E ktron CM S40 0.NET database.
Update if needed.

Assets Path

Review the path to your site’s Assets folder. Update if needed.

Private Assets Path

Review the path to your site’s Private Assets folder. Update if needed.

Re-index existing catalogs

Check this box if you want to reindex the existing catalogs.

Create New Catalogs

Check this box if you want to create a new catalog.

Published Catalog

Review the name of your published catalog. Update if needed. See Also:
”The Catalogs” on page 393

Private Catalog

Review the name of your private catalog. Update if needed. See Also:
”The Catalogs” on page 393

Automatically Generate
Summary for Content

If you want to automatically generate a summary for all content in the new
catalog, click this checkbox. See Also: ”Auto Generating Summaries” on
page 80

Status

After you click the Start button, this area indicates the status of the new
catalog creation.
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The Advanced Tab

Field

Description

Index the following for
Search

Check each type of content that the search can find.

•

Html Content

•

Users and Groups

•

Documents

•

Forums

•

XML Content

Specify directory for
catalogs

Use this field to change the location of the published and private
catalogs, if desired. By default, they reside in the your web site/catalogs
directory.
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The Log Output Tab
All activity generated by the Search Data Configuration screen is
tracked by a log. The Log Output Tab displays a history of these
changes.

A permanent copy of the log is saved in the C:\Program
Files\Ektron\CMS400vversionnumber\Utilities\SOFTWARE\SearchConfig

folder. Its name is date time.LOG.

Restarting the Indexing Service
Use the Indexing Service screen to restart Windows’ Indexing
Service. You can also use the screen to rescan the catalogs.
To access the Indexing Service screen, go to Workarea >
Settings > Configuration > Indexing Service.
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From this screen, you can
•

”Restart the Indexing Service” on page 403

•

”Run a Full Scan of a Catalog” on page 404

•

”Run an Incremental Scan of a Catalog” on page 405

Restart the Indexing Service
Sometimes, when resolving issues with your search, you must stop
and restart the indexing service. To restart it via the Indexing
Service screen, click the Restart Service button.

To restart the indexing service for a particular catalog only, click
Restart to the right of the catalog name.
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Alternatively, you can stop and restart the Indexing service from
the Computer Management screen, as shown below.

Run a Full Scan of a Catalog
Sometimes, when resolving issues with your search, you need to
run a full scan of a catalog. To do this, access the Settings >
Configuration > Indexing Service screen. Then, click Rebuild
next to the affected catalog.
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The following text explains the full scan. (Copied from Microsoft
Management Console help)
A full scan takes a complete inventory of all documents in the
cataloged folders and adds them to the list of documents to be
indexed. The Indexing Service does a full scan of disk drives
attached to your computer (except for removable devices) in the
following situations:
•

When it is run for the first time after installation

•

When a folder is added to the catalog

•

As part of recovery if a serious error occurs

Run an Incremental Scan of a Catalog
Sometimes, when resolving issues with your search, you need to
run an incremental scan of a catalog. To do this, access the
Settings > Configuration > Indexing Service screen. Then, click
Update next to the affected catalog.

The following text explains the incremental scan. (Copied from
Microsoft Management Console help)
Microsoft Windows Indexing Service cannot track changes to
documents when it is shut down. When Indexing Service restarts, it
does an incremental scan to detect all documents that were
modified while it was inactive so it can update its index.
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An incremental scan may also be performed if Indexing Service
loses change notifications. This can happen if the update rate of
documents is very high and the buffer used to get change
notifications from Windows XP overflows.

Basic versus Advanced Web Site Search
When your developer places a Web Search server control on any
page, and a site visitor browses to it, he sees the following.

This section now divides into two sections:
•

Basic Search (shown above)

•

Advanced Search (access this by clicking the Advanced
Search tab)

This section also explains the following search-related topics.
•

”The Content Searchable Field” on page 412

•

”Display of Search Results” on page 412

•

”Synonym Sets and Suggested Results” on page 416

•

”Using the Integrated Search” on page 434

•

”Setting up a Multiple Site Search Using Virtual Directories” on
page 441

•

”Searching for Metadata” on page 445

•

”Installing the Visio IFilter” on page 445
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See Also: ”The Advanced Search” on page 409

The Basic Search
NOTE

You can also create a folder with content outside of Ektron CMS400.NET that is
searched. For more information, see ”Using the Integrated Search” on page 434.

The Basic Search finds content that satisfies these criteria.
•

published

•

active (archived content is ignored)

•

its Searchable check box is checked (see ”The Content
Searchable Field” on page 412)

•

public. However, private content is available to those with
permission to view it, such as membership users after logging
in. See Also: ”Private Content” on page 744.

•

resides in the CMS folder specified in the Web search server
control, or in one of that folder’s subfolders if the control’s
recursive property is set to true

•

is not a non-image file added to the library. Images are
searchable, while other files added to the library are not. So, to
make files searchable, add them as assets, not library files.

•

matches selected language, if site is multilingual

•

satisfies text and/or query entered in the search box (no value
returns nothing) See Also: ”Query Language” on page 446
- The text inserted in the search field can appear in the content
or metadata (See Also: ”Searching for Metadata” on
page 445)

•

satisfies content type criterion selected on screen, if chosen
(see below)
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NOTE

The search does not find documents inside compressed files, such as *.zip, *.cab,
etc.

Search Results by Content Type

Search Screen
Option

Finds submitted text in these content types

Site

Content from all options below (except Tags) plus Forums

HTML

•

HTML

•

Smart Form (XML)

Note: Finds XML field values but not field labels. This has
not changed since prior releases.

Documents

•

HTML Form

•

Blog entries (not comments)

•

MS Office document (includes PowerPoint, Excel)

Note: The search finds text within Visio documents if the
Visio IFilter has been installed. See ”Installing the Visio
IFilter” on page 445.
•

PDF file

•

.txt file
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Search Screen
Option

Finds submitted text in these content types

Images added as
assets and through the
library

.gif, .jpeg, etc.

Multi Media

Flash, .mp3, etc.

Tags

Tags applied to content and library items. See Also: ”Tags”
on page 981

NOTE

The search cannot find calendar events.

Searching Multiple Terms
If a site visitor enters several terms, the search only returns pages
that include all terms. This is known as an ‘and’ relationship. For
example, if the user enters cancer and cure in the Search box,
only content that includes both terms (and satisfies the other
criteria) appears.
Ektron uses an ‘and’ relationship because we believe it’s what a
site visitor expects. Consider a simple Google search – the more
you enter into the Google Search text box, the fewer results you
get, since your phrase is more precise.
The advanced search screen, on the other hand, lets the site
visitor determine if he wants an and, or, not, or exact phrase
relationship. See Also: ”The Advanced Search” on page 409

The Advanced Search
The Advanced Search uses nearly all the same search criteria as
the Basic Search. (See ”The Basic Search” on page 407). The
differences are additional options and filters (explained below) and
the fact that you cannot use queries.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

409

Searching Your Web Site

Advanced Search Options

Search Option

Finds these pages

with all of the words

Web page must include all submitted terms; their
position on the page does not matter.
You cannot enter queries into this field.

with the exact phrase

Web page must include the exact phrase. For example,
if you enter Ektron healthcare, a page with the term
Ektron provides healthcare is not found because it is
not an exact match.

at least one of the words

Web page can include any one of the submitted terms
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Search Option

Finds these pages

without the word

Web page does not contain the submitted word.
Only use this option if you also reply to one of the three
fields above.

Advanced Result Filters
Below the Advanced Search Options is a list of additional fields
you can use to refine the search. These are titled Advanced
Result Filters.

Result
Filter

Prompts site visitor to enter

Author

Enter firstname<space>last name.
Can abbreviate by entering part of either name surrounded by
asterisks (*). For example, *Jo* finds any author whose first or last
name contains those letters.

Created
Before

All content created before date entered by user.

Created
After

All content created after date entered by user.

Modified
Before

All content updated before date entered by user.

Modified
After

All content updated after date entered by user.

File Size

Enter file size in kilobytes. You can use greater and less than
operators (>, <) to find content greater or less than a value. For
example, > 10000.

Date format is YYYY/MM/DD.

Date format is YYYY/MM/DD.

Date format is YYYY/MM/DD.

Date format is YYYY/MM/DD.

To add a filter, click Add Filter. To remove a filter, click Remove to
the right of the filter.
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The Content Searchable Field
Each content item includes a Content Searchable field. The
search only considers content whose field is checked. See
illustration below.

By default, this field is checked when content is created.
IMPORTANT!

Despite the value of this checkbox, if an Ektron CMS400.NET user places this
content item in a Suggested Results list, it will appear in the Suggested Results
area of the Search Results screen. See Also: ”Suggested Results” on page 420.
Also, this content can still be found by the Advanced Workarea search.

Display of Search Results
Below is an example of the Web Site Search and Search
Published results screen. Your developer can customize it using
the Web Search server control.
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Below the search box is an optional Filter by Category link. If your
developer enables the link in the WebSearch server control, a site
visitor can click it to see a folder structure of taxonomy categories.
He can then select categories of interest. When he does, only
content that includes the search term and which is assigned to the
selected categories appears. For more information, see the Ektron
CMS400.NET Developer Manual section “Web Search Server
Control” > “Filtering Search Results by Category.”
The actual results begin with the title and last edited date.
Following them is either
•

an abstract of the content, which is automatically generated by
the Windows Indexing Service, or

•

the content summary (The Ektron CMS400.NET User Manual
section “Adding a Content Summary)

Your developer makes this decision in the WebSearch server
control.
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Following the abstract or summary is additional information, such
as content ID number, size, last author, number of occurrences of
the search term, and rank. Your developer determines which
criterion is used to order the results.
TECHNICAL NOTE

The Adobe IFilter, which is used to generate the abstract, is only supported in Tier
1 languages (English, French, German, and Japanese). If your Web site uses
other languages, the abstract may not be legible. In such a case, your developer
should suppress the abstract from the search results. This procedure is
documented in the Ektron CMS400.NET Developer Manual section “Web
Search Server Control” > “Determining the Display of Search Results.”

When you click the title of any content item, it appears. The search
term is highlighted (see example below) if the following web.config
property is set to true: <add key="ek_termHighlight" value ="true"/>.
To remove the highlighting, set ek_termHighlight to false.

See Also:
•

”Adjusting the Length of the Search Result Abstract” on
page 415

•

”Search Result Ranking” on page 415
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Adjusting the Length of the Search Result Abstract
To adjust the length of the abstract, update the Indexing Service’s
Properties window > Generation tab > Maximum Size field (see
below).

The abstract’s text is taken from the content. (It ignores text in
tables.) If the content text has fewer characters than the Maximum
Size, Ektron CMS400.NET tries to complete the abstract by
retrieving the title, summary, metadata, comments, and additional
information stored in the content item’s tabs.

Search Result Ranking
Each content item found by a catalog search is given a numerical
rank between 0 and 1000. Search results can be sorted by rank.
Criteria used to calculate rank include the
•

number of occurrences of the search term
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•

proximity of search term to beginning of file

•

proximity of search term to other occurrences of the term

•

whether the term is in the title

Customizing the Postback Message
By default, if a search term yields no results, the following
message appears on the screen.

If you want to customize this message, follow these steps.
1. In your site root folder, find the workarea/resources folder.
2. Open the resource file that corresponds to your site’s
language. For example, if your site is in American English,
open EkResource.en-US.resources.
NOTE

If your site supports multiple languages, follow these steps for each
corresponding resource file. See Also: ”Procedure for Translating Workarea
Strings” on page 921

3. Within the resource file, find the key lbl

search no results.

4. The default text (shown above) follows this key. Modify the text
as needed.
5. Save the file.

Synonym Sets and Suggested Results
This section describes two search enhancements that can be used
independently but are more powerful when used together.
•

”Synonym Sets” on page 417
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•

”Suggested Results” on page 420

Synonym Sets
You can create sets of synonyms to work with the search. If a site
visitor enters any term in a synonym set into the Search box,
Ektron CMS400.NET’s search looks for that term plus all other
terms in the set.
For example
Synonym Set: Tuition
Terms: tuition, bill, payment, pay, fee, charge, price, amount, cost,
money, balance
If a site visitor inserts bill into the search field, Ektron CMS400.NET
uses bill or tuition or payment or pay or fee or charge, etc. to
gather search results.
The Synonym Set feature will typically produce more “hits.” So,
while the user does no more work, his chances of finding the right
information on your Web site are greatly increased.
If a term exists in more than one Synonym Set, the search
encompasses all terms in all sets.
The following sections explain how to work with Synonym Sets in
more detail.

TECHNICAL NOTE

•

”Synonym Set Best Practices” on page 418

•

”Creating a Synonym Set” on page 418

•

”Editing a Synonym Set” on page 419

•

”Deleting a Synonym Set” on page 420

The Web Search server control has a SearchSynonyms property. This must be set
to true for a Synonym Set’s terms to be included in the search logic.
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Synonym Set Best Practices
•

Synonyms are searched across all HTML content and
documents indexed by Ektron CMS400.NET (for example, Word
documents).

•

Ektron CMS400.NET’s search does not include plurals or verb

forms. So, if you think a site visitor might enter either ticket or
tickets, enter both into the Synonym Set. Same with bill,
billing, etc.
•

A search term can consist of several words as long as the term
is entered the same way in the Synonym Set. For example,
love seat is part of a Synonym Set that includes sofa.
As long as both love and seat are in a content item, the search
finds it even if the words are separated. But, entering a single
term, like love, will not find that Synonym Set.
So, if you think people may search using loveseat or love
seat, enter both terms into the Synonym Set.

•

The metadata search does not use or support Synonyms Sets.

Creating a Synonym Set
Follow these steps to create a Synonym Set.
1. From the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Search > Synonyms.
2. From the language dropdown, select a language for the
Synonym Set. (The search is language-specific. When a site
visitor begins using your site, he selects a language. Only
synonyms sets in that language are considered.)
3. Click the Add button (

).

4. The following screen appears.
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5. Enter a name for the set. Ektron CMS400.NET users will use
this name to identify the Synonym Set.
6. Enter all terms that make up the set. Separate each with a
semicolon (;). You cannot enter a comma (,) or a parenthesis
character (() into the Terms field.
7. After entering all terms, click the Check for Duplicates button.
Ektron CMS400.NET compares terms in this set against the
other Synonym Sets in this language. If the same term is found
in another set, you are notified.
It is not necessarily a problem for a term to exist in more than
one Synonym Set. So, review each Synonym Set that contains
the duplicate and decide what to do.
8. Click Save (

).

Editing a Synonym Set
Follow these steps to edit a Synonym Set.
1. From the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Search > Synonyms.
2. From the language dropdown, select the Synonym Set’s
language.
3. Click the Synonym Set that you want to edit.
4. Click the Edit button (

).

5. The Edit Synonym Set screen appears.
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6. Add or remove terms. Be sure to separate each term with a
semicolon (;).
7. Click the Check for Duplicates button. Ektron CMS400.NET
compares terms in this set against the other Synonym Sets in
this language. If the same term is found in another set, you are
notified.
8. Click Save (

).

Deleting a Synonym Set
NOTE

Deleting a Synonym Set also deletes any Suggested Results associated with the
Synonym Set. The user is warned about this when deleting.

Follow these steps to delete a Synonym Set.
1. From the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Search > Synonyms.
2. From the language dropdown, select the Synonym Set’s
language.
3. Click the Synonym Set that you want to delete.
4. Click the Delete button (

).

5. You are asked to confirm your action.
6. The Synonym Set is deleted.
7. Perform an IIS reset on your server. This utility clears the
cache, so that the synonym set is no longer available to Ektron
CMS400.NET.
See Also: http://technet.microsoft.com/en-us/library/
cc781553(WS.10).aspx

Suggested Results
For any term or Synonym Set, you can create a list of Suggested
Result links. That is, links that appear in a special area of the
Search Results page whenever someone searches for a selected
term. These links can jump to your Web site or an external Web
site.
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The Suggested Results feature is explained through the following
topics.

TECHNICAL NOTE

•

”Using Suggested Results to Direct Site Visitors” on page 422

•

”Determining the Display of Suggested Results” on page 425

•

”Creating a Set of Suggested Results” on page 426

•

”Editing a Suggested Result Set” on page 430

•

”Deleting a Suggested Results Set” on page 434

The Web Search server control has a ShowSuggestedResults property. This must
be set to true for suggested results to appear on the page that hosts that control.
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Using Suggested Results to Direct Site Visitors
Use this feature to direct site visitors to pages that do not appear at
the top of natural search results. For example, you manage a
university’s Web site. When a site visitor wants to know where to
mail a tuition payment, he enters bill into the search field and gets
these results.
Faculty member Bill McDermott
The Student Bill of Rights
How a Bill Becomes Law
Frustrated, many people call the business office to get information
that exists on the Web site but is difficult to find.
Using Ektron CMS400.NET, you can combine a Synonym Set with
Suggested Results to direct site visitors to the correct Web pages.
To continue this example, you could create
•

a Synonym Set (named tuition) that includes all terms people
might enter when searching for the tuition page on your Web
site. See Also: ”Synonym Sets” on page 417

•

a Suggested Results list in which you assign the “Tuition &
Fees” Web page to the Tuition Synonym Set

These sets are illustrated below.
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After you set up the Synonym Set and Suggested Results, here is
a typical sequence of events.
1. A site visitor enters a phrase on your site's Search page.

2. The phrase matches a term in a Synonym Set that has
Suggested Results.
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3. Suggested Result hyperlinks assigned to the set appear in a
special area of the results page. They appear in the order you
defined when setting up links.

4. The search term’s normal results can also appear. Your
developer determines their location on the results page.

Using Suggested Results to Enhance Business Opportunities
You can also use Suggested Results to direct site visitors to
business partners' Web sites. One example is a stop smoking
clinic near your hospital that has been successful with your
patients. When someone visits your Web site and searches for
smoking, you can set the clinic to be the top Suggested Result.
As another example, your organization creates widgets but does
not implement or customize them. Over time, several agencies
develop experience at deploying and customizing your widgets.
Therefore, you want to promote these supporting businesses on
your site. To do so, create a Synonym Set (for example: deploy,
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install, implement, customize, modify, adapt) and assign the Web
sites of approved agencies to the Suggested Results list. Then,
when a site visitor searches for the word implement or customize,
he gets links to those agencies’ Web sites.
Suggested Results can also be used to advertise products, as
used in the sponsored results section of popular search engines
like Google® search and Yahoo!® .

Determining the Display of Suggested Results
Suggested Results can appear on any page that contains a
Websearch server control. They can appear wherever you want: at
the top of the search results page, in the right column, etc. You can
also choose if and where to display the search term's regular
results.
In the Web Search server control, your Web developer determines
where search results appear, using either a style sheet or an XSLT.
For more information, see the Ektron CMS400.NET Developer
Manual section “Web Search Server Control.”
NOTE

The WebSearch server control has a ResultsPageSize property. If your
developer sets it to less than the number of suggested results applied to a term or
synonym set, the ResultsPageSize property’s number of results appears. For
example, if you assign five links to a Suggested Result set but a developer sets
ResultsPageSize to three, only the first three results appear.

What Happens when a Term Appears in More than One Synonym Set
If more than one Synonym Set contains the same word, and each
set has suggested search results, the results appear in
chronological order by Synonym Set creation date. Here is an
example.

Synonym Set

Terms

Creation Date

Milk production

Cow; Milk; Dairy

January 1, 2007

Animals

Horse; Sheep; Cow

April 16, 2007
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When a site visitor searches for Cow, the Milk production set’s
links appear above Animals links because it was created first.

Creating a Set of Suggested Results
Follow these steps to create a set of Suggested Results. You
cannot enter more than 10 links into any Suggested Results set.
1. From the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Search > Suggested Results.
2. From the language dropdown, select a language for the
Suggested Results. (The search is language-specific. When a
site visitor begins using your site, he selects a language. Only
Suggested Results in that language are considered.)
3. Click the Add button (

).

4. The following screen appears.

5. Use the following table to complete the fields.

Field

Description

Type

To apply this Suggested Results set to a single term, proceed to the next field,
Term.
To apply this set to a Synonym Set, change this value to Synonym Set. (If
you do, the next field’s name changes to Synonym Set.)
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Field

Description

Term/
Synonym
Set

If the above value is Single Term, enter a search phrase that will trigger the
Suggested Results you will create below.
Note: You cannot enter a comma(,) or a parenthesis character (() into the
Terms field.
If the above value is Synonym Set, select from the dropdown the Synonym
Set that will trigger the Suggested Results you will create below. That is, if a
user enter a search phrase that matches any term in the Synonym Set, the
Suggested Results appear.

Suggested
Results

Place the cursor in this field. When you click, a menu appears (see illustration
below).

6. Click Add.
7. The following screen appears. Here, you add the URL, text,
and summary for each Suggested Result.
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8. Use the following table to complete the fields.

Field

Description

Link

To create a link to
•

content on your Web site, click the Browse to CMS content button.
Then, navigate to the folder that contains the content you want to link
to. Select the content and click Save.

•

an external Web site, enter its full address, starting with http://.
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Field

Description

Title

If you created a link to
•

content on your Web site, its title is retrieved and displayed here. You
may edit it as needed.

•

an external Web site, enter the text of the link that will
appear on the Suggested Results display.

Site visitors use this text to select the linked Web page. The title is circled
in the example below.

Summary

If you created a link to
•

content on your Web site, its summary appears here. You may edit it
as needed. The summary cannot exceed 320 characters (including
HTML tags).

•

an external Web Site, nothing appears. Enter up to 320 characters
(including HTML tags) to further describe this link on the search
results page.

The summary is circled in the example below.
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9. Click Save (

).

10. The Add Suggested Results screen reappears. You can add
more links, edit existing ones, etc. When done, click Save ( ).

Editing a Suggested Result Set
The following sections explain how to perform the following edits
on a Suggested Result Set.
•

”Adding a Link to a Suggested Result Set” on page 430

•

”Editing a Link in a Suggested Result Set” on page 431

•

”Removing a Link from a Suggested Result Set” on page 432

•

”Rearranging the Sequence of Links in a Suggested Results
Set” on page 433

•

”Deleting a Suggested Results Set” on page 434

Adding a Link to a Suggested Result Set
1. From the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Search > Suggested Results.
2. From the language dropdown, select a language for the
Suggested Results. (The search is language-specific. When a
site visitor begins using your site, he selects a language. Only
Suggested Results in that language are considered.)
3. Select the Suggested Results set to which you want to add a
link.
4. Click the Edit button (

).

5. Place the cursor over the first result in the Suggested Results
area of the screen.
6. Click once and a menu appears.
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7. Click Add.
8. The Add New Suggested Results screen appears.
9. See ”Use the following table to complete the fields.” on
page 428.
10. Click Save (

).

11. Click Save (

) again.

Editing a Link in a Suggested Result Set
1. From the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Search > Suggested Results.
2. From the language dropdown, select a language for the
Suggested Results. (The search is language-specific. When a
site visitor begins using your site, he selects a language. Only
Suggested Results in that language are considered.)
3. Select the Suggested Results set that you want to edit.
4. Click the Edit button (

).

5. Place the cursor in the Suggested Results area of the screen.
6. Place the cursor on the result that you want to edit.
7. Click once and a menu appears.
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8. Click Edit.
9. See ”Use the following table to complete the fields.” on
page 428.
10. Click Save (

).

11. Click Save (

) again.

Removing a Link from a Suggested Result Set
1. From the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Search > Suggested Results.
2. From the language dropdown, select a language for the
Suggested Results.
3. Select the Suggested Results set from which you want to
remove a link.
4. Click the Edit button (

).

5. Place the cursor in the Suggested Results area of the screen.
6. Place the cursor over the result that you want to delete.
7. Click once and a menu appears.
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8. Click Delete.
9. A confirmation message appears. Click OK.
10. Click Save (

).

Rearranging the Sequence of Links in a Suggested Results Set
Use this procedure to move Suggested Results up or down within
a list.
1. From the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Search > Suggested Results.
2. From the language dropdown, select a language for the
Suggested Results.
3. Select the Suggested Results set from which you want to
remove a link.
4. Click the Edit button (

).

5. Place the cursor in the Suggested Results area of the screen.
6. Place the cursor over the result that you want to move up or
down.
7. Click once and a menu appears.
8. Click Move Up or Move Down.
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9. Click Save (

).

Deleting a Suggested Results Set
1. From the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Search > Suggested Results.
2. From the language dropdown, select a language for the
Suggested Results.
3. Select the Suggested Results set from which you want to
remove a link.
4. Click the Delete button (

).

5. Click OK to the confirmation message.

Using the Integrated Search
You can expand the Web search to any Web-accessible files on
your server, even if they are not part of Ektron CMS400.NET. This
feature is called Integrated Web Search.
NOTE

The Integrated Search only works with a Web Search server control that is placed
on a Web page. It does not work with the Workarea search or any other search
server control.

Use an Integrated Search if your site’s search should include nonEktron CMS400.NET files which, nevertheless, need to be
searchable by site visitors. For example, a folder of personnel
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policy documents should be searchable on your intranet but you do
not want to add them to Ektron CMS400.NET.
As another example, you have a Web site of static HTML pages,
and are now deploying Ektron CMS400.NET for certain parts of the
site, such as job listings or a discussion forum. You can create a
page with an Integrated Search that encompasses your entire site.
The following topics explain the Integrated Search in more detail.
•

”Integrated Search Overview” on page 435

•

”Setting up a Virtual Directory” on page 435

•

”Setting up an Integrated Search” on page 436

•

”Searching for non-Ektron CMS400.NET Content” on page 440

•

”Integrated Search Content in Search Results” on page 441

Integrated Search Overview
To set up an Integrated Search, create one or more Windows
folders underneath the site root folder. Place files to be searched
within them or their subfolders.
Alternatively, Integrated Search can find content in any Webaccessible folder on the server’s file system. In this case, create
one or more virtual directories that point to the site root folder.
Then, identify the Integrated Search folder and, if desired, file
types to include or exclude when searching. The procedure for
doing this is explained in ”Setting up a Virtual Directory” on
page 435.

Setting up a Virtual Directory
The Integrated Search’s starting folders can reside anywhere on
your server’s file system. If you want a folder to reside somewhere
other than under the site root folder, follow these steps to set up a
virtual directory. A virtual directory resides in the site root folder, but
contains no content -- instead, it points to a Web-accessible folder
anywhere in the file system.
IMPORTANT!

Although a virtual directory is not on the same server as your site, it must be on
the same domain as your site’s server.
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Since creating a virtual folder is a Windows procedure, the
procedure is explained in http://www.microsoft.com/technet/
prodtechnol/WindowsServer2003/Library/IIS/5adfcce1-030d-45b8997c-bdbfa08ea459.mspx?mfr=true.
On the Access Permissions screen that appears during the setup,
only check Read (see below).

Setting up an Integrated Search
There are three parts to setting up an Integrated Search.
•

”Creating an Integrated Search Folder Structure” on page 437

•

”Assign the Integrated Search folder to the WebSearch Server
Control” on page 437

•

”Identifying Integrated Search Folder Information in the
Workarea” on page 437

After setting up an Integrated Search, you might want to do these
things:
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•

”Viewing All Integrated Search Folders” on page 439

•

”Viewing an Integrated Search Folder” on page 440

•

”Editing an Integrated Search Folder” on page 440

Creating an Integrated Search Folder Structure
1. In the site root folder, create one or more folders for non-Ektron
CMS400.NET files to be searched. You can create child folders
in as many levels as needed underneath these folders.
Alternatively, create a virtual folder that points to any folder in
your file system. See Also: ”Setting up a Virtual Directory” on
page 435
2. Place all files to be searched in the parent or child folders.

Assign the Integrated Search folder to the WebSearch Server Control
To find Integrated Search content, users must access a Web page
that contains a WebSearch server control. Further, you must
assign to that control’s CustomSearch property the names of all
top-level Integrated Search folders (see illustration below). Any
child folders under the top-level folders are included in the search.

Identifying Integrated Search Folder Information in the Workarea
Follow this procedure for every folder that contains Integrated
Search content.
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1. In the CMS Workarea, go to Settings > Configuration >
Integrated Search Folders.
2. Click the Add button (

).

3. The Add Integrated Search Folder screen appears.

4. Complete the fields as described in the table below.
To include all files in the folder (except those that would
typically not be searched, such as .exe and .dll files), do not
modify the Include Extensions and Exclude Extensions
fields.

Field

Description

Site Directory

Enter the name of the parent folder (or virtual folder) that contains the
searchable, non-Ek tron CMS4 00. NE T content. This folder must reside in the
site root folder. If you are using a virtual folder, enter its name, not the folder
that contains the content.
See Also: ”Creating an Integrated Search Folder Structure” on page 437

Recursive

Check this box if you want the search to include all child folders under the
folder in the Site Directory field.
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Field

Description

Exclude Directories

If you want to exclude files in any directory underneath the directory listed in
the Site Directory field, enter the names of the directories to exclude. You do
not need to enter the path to the directory -- only the name.
If you enter more than one directory, use a comma to separate them.
By default, E k t r o n C M S 4 0 0 . N E T places several directories that a search
would typically ignore. Edit as needed.

Exclude Extensions

If you want the search to ignore certain file types, enter those extensions in
this format: *.filetype. For example *.xml. If you enter more than one,
separate them with a comma (,).
By default, E k t r o n C M S 4 0 0 . N E T inserts several file types that a search
would typically ignore. Edit as needed.
Important! - If you enter any value into the Include Extensions field, this field
is ignored.

Include Extensions

If you want the search to include only certain file types, enter those extensions
in this format: *.filetype. For example *.xml. If you enter more than one,
separate them with a comma (,).
Important! - If you enter any value into this field, the Exclude Extensions
field is ignored.

Domain/User Name,
Password and Confirm
Password

IMPORTANT!

If the parent folder is a virtual folder that points to another server, enter the
domain\user name and password needed to access that server.
The parent folder is identified at the Site Directory field.

Ektron’s Windows service runs hourly to index these files. So, you will not see
search results for at least an hour after you set up this feature.

Viewing All Integrated Search Folders
To view all integrated search folders, go to Settings >
Configuration > Integrated Search Folders. The screen displays
every folder that will be included in the Integrated Search. See
Also: ”Using the Integrated Search” on page 434
Click any folder to edit its properties or delete it.
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If you want to create a new Integrated Search folder, click the Add
button ( ). See Also: ”Creating an Integrated Search Folder
Structure” on page 437

Viewing an Integrated Search Folder
This screen displays all information about one Integrated Search
folder. See Also: ”Using the Integrated Search” on page 434
To see documentation for any field on the screen, go to ”Complete
the fields as described in the table below.” on page 438.
To edit information assigned to this Integrated Search folder, click
the Edit button (

).

To delete this Integrated Search, click the Delete button (

).

Editing an Integrated Search Folder
To edit an integrated search folder, select if from the View
Integrated Search Folders screen. Then, click the Edit button (

).

Edit the fields as needed. To see documentation for any field, go to
”Complete the fields as described in the table below.” on page 438.

Searching for non-Ektron CMS400.NET Content
You can search for all non-Ektron CMS400.NET content by file title.
For example, you can find the file Ektron.gif by inserting Ektron
into the search field.
You can search text files (.doc, .pdf, .txt, etc.) by either file name or
text within them.
Finally, you can use the following syntax to find files by extension:
For example, to find all .gif files, use
#filename *.gif. Be sure to click the Images button.
#filename *.extension.
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NOTE

Because Ektron CMS400.NET stores all content in .txt files, you cannot use this
syntax to find files with a .txt extension.

Integrated Search Content in Search Results
To distinguish Integrated Search content from regular content, the
ID number of IS content begins with 1,000,000,000. Also, the last
author name is Non_Cms_User. See illustration below.

Setting up a Multiple Site Search Using Virtual
Directories
Use the following procedure if you want to set up two sites but use
a single database. The steps below allow you to search from either
site to find the same content.
In this example, the first site contains the database, while the
second site uses virtual directories to point to content in the first
site.
1. Set up the first site and create a database for it in the normal
manner.
2. Set up the second site, but when you are prompted to set up
the database, click No.
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3. The following message appears. Press OK.

4. In the first site, open the web.config file.
5. Copy the database connection information for your database,
as indicated below.
<connectionStrings>
<!--FOR SQLSERVER-->
<add name="Ektron.DbConnection" providerName="System.Data.SqlClient"
connectionString="server=(local);database=CMS400Min;Integrated Security=TRUE;user=;pwd=;" />

NOTE

Your information may be different from the sample above.

In the second site, open the web.config file. Then, overwrite the
database information with the text you copied in Step 5.
6. Copy the catalog information from the first site to the second.
To do this, open the first site’s web.config file, and copy the
contents of the <providers> element (illustrated below).
<providers>
<add name="MSIndexServer"
type="Ektron.Cms.WebSearch.SearchProviders.MSIndexProvider,
Ektron.Cms.WebSearch" catalogName="CMS400Min3152007121250Publish"
privateCatalogName="CMS400Min3152007121250Private" pageSize="10"
description="MS Index Server Provider"/>
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<add name="MSIndexDialectServer"
type="Ektron.Cms.WebSearch.SearchProviders.MSIndexDialectProvider,
Ektron.Cms.WebSearch" catalogName="CMS400Min3152007121250Publish"
privateCatalogName="CMS400Min3152007121250Private" pageSize="10"
description="MS Index Server Dialect2 Provider"/>
</providers>

NOTE

The catalog names are examples. You catalog names may be different.

7. In the second site, open the web.config file. Then, overwrite the
<providers> information with the text you copied in Step 7.
8. Open the folder that contains the first site. Copy the
AssetManagement.config file.
9. Open the folder that contains the second site. Overwrite the
AssetManagement.config file in that folder with the file you
copied in Step 9.
10. Set up the virtual directories. To do that, follow these steps.
- In IIS, open the second Web site you created in Steps 2 and 3
- Delete the Assets folder
- Create a new virtual directory named Assets
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- When prompted to specify a path to the new Assets folder,
navigate to the first site’s Assets folder
- When you finish setting up the virtual folder to Assets
directory, set up virtual directories in the same manner for
the following directories: PrivateAssets, uploaded files, and
uploaded images. Remember to delete the folder in the
second site before creating the virtual directory.
- Make sure that none of the folders is set up as an application.
To do that, open IIS, right click each folder and select
properties. On the Directory tab, the Application name
field should be grayed out, as shown below.
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:

Searching for Metadata
NOTE

You can use the SEO Control to identify how search engines evaluate your Web
pages’ metadata tags, and other search tools. See Also: Ektron CMS400.NET
Developer Manual section “Using the Search Engine Optimization (SEO)
Control.”

•

Searchable type metadata values are returned like regular
content. See Also: ”Types of Metadata” on page 118

•

It can take up to 30 minutes for newly-added metadata to be
available to the search.

•

Searchable metadata field names must not include a space. If
they do, the search cannot find the metadata.

•

To find content with searchable metadata whose style is yes or
no, enter true or false.

Installing the Visio IFilter
The search finds text within Visio documents if the Visio IFilter has
been installed to the Ektron CMS400.NET server. Use the following
links to download the Visio IFilter.
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Visio
Version

Link

2003

http://www.microsoft.com/downloads/details.aspx?FamilyID=dcee9e09-448b4386-b901-efea29cac808&DisplayLang=en

2002

http://www.microsoft.com/technet/prodtechnol/Visio/visio2002/deploy/
ifilter.mspx

Query Language
NOTE

Following text collected from Microsoft Web site. © 2006 by Microsoft Corporation. All rights
reserved.

To search for any word or phrase on a Web site, enter the word or
phrase into the Search field and click the button to begin the
search.

This section covers the following topics.
•

”Rules for Formulating Queries” on page 447

•

”Boolean and Proximity Operators” on page 448 - increase
accuracy of searches by inserting Boolean and proximity
operators

•

”Localized Symbols and Keywords” on page 449 - explains
which keywords are supported in foreign languages

•

”Wildcards” on page 450 - find pages with words similar to your
search term

•

”Free-Text Queries” on page 450 - create a query based on a
phrase’s meaning as opposed to exact wording

•

”Vector Space Queries” on page 451 - find pages that match a
list of words and phrases
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•

”Property Value Queries” on page 451 - query a file’s
properties

•

”Query Examples” on page 457 - examples of various queries

Rules for Formulating Queries
When a search is executed, it returns a list of Web pages that
contain the word or phrase that a user entered, regardless of
where it appears in text.
Follow these rules when formulating queries.
•

Multiple words are treated as individual search terms. So, the
term calendar server returns pages that have both words.
To find pages that have calendar and server in that exact order,
use quotes. “calendar server” returns pages that include both
terms in that exact order with no intervening words.

•

Queries are case-insensitive. You can type a query in upper or
lower case.

•

The search ignores words in the noise files. Ektron
CMS400.NET’s noise files screen from the search every single
letter of the alphabet as well as many common words, such as
about, after, all, and also. Avoid entering such words into the
Search Text field, because the search ignores them.
The list of noise words (noise.enu) is installed to your siteroot/
and Windows/System 32 folders. You can open a noise
file with a simple word processor program, such as Notepad, to
view the noise words. You can also edit the files. For example,
you can remove words that users should be able to search on.
Workarea

To make a word in the noise files searchable, remove it from
both files then restart both catalogs. See Also: ”Run a Full
Scan of a Catalog” on page 404
Exceptions:
- In the Ektron CMS400.NET Workarea, the Advanced Search
disregards the noise file.
- You cannot make the indexing service operators (and, or,
but) searchable.
•

Words in the noise file are treated as placeholders in phrase
and proximity queries. For example, if you search for “Word for
Windows”, the results could return “Word for Windows” and
“Word and Windows”, because “for” is in the exception list.
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•

Punctuation marks, such as period (.) and comma (,), are
ignored by a search.

•

To use special characters, such as &, |, ^, #, @, $, (, ), in a
query, enclose the query in quotation marks (“).

•

To search for a word or phrase containing quotation marks,
surround the entire phrase with quotation marks and double
the quotation marks around the word to be surrounded with
quotes. For example, “World-Wide Web or ““Web””” searches
for World-Wide Web or “Web”.

•

Use Boolean operators (AND, OR) and the proximity operator
(NEAR) to specify additional search criteria. See Also:
”Boolean and Proximity Operators” on page 448

•

Use the wildcard character (*) to find words with a given prefix.
For example, the query esc* finds Web pages with “ESC,”
“escape,” and so on. See Also: ”Wildcards” on page 450

•

You can specify free-text queries without regard to query
syntax. See Also: ”Free-Text Queries” on page 450

•

Vector space queries can be specified. See Also: ”Vector
Space Queries” on page 451

•

You can search on ActiveX™ (OLE) and file attribute property
values. See Also: ”Property Value Queries” on page 451

Boolean and Proximity Operators
Use boolean and proximity operators to create a more precise
query.

To Search for

Example

Results

Both terms on a
page

healthcare insurance

Pages with words “healthcare” and
“insurance”

Either term on a
page

kidney or renal

Pages with “kidney ” or “renal”

—Or—
kidney | renal#

All pages that
match a property
value

@CMSsize > 1000

Pages greater than 1000 kilobytes
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To Search for

Example

Results

Both terms on a
page, close
together

treatment near immunoglobulin

Pages with the word “treatment” near the
word “immunoglobulin” See Also: ”The
NEAR operator is like the AND operator
because it finds pages that include both
search words.” on page 449

—Or—
treatment ~ immunoglobulin

Tips
•

To nest expressions within a query, add parentheses.
Expressions within parentheses are evaluated before the rest
of the query.

•

Use double quotes (“) to ignore a Boolean or NEAR operator
keyword. For example, “Abbott and Costello” finds pages with
the entire phrase, not pages that match the Boolean
expression. In addition to being an operator, the word “and” is a
noise word in English.

•

The NEAR operator is like the AND operator because it finds
pages that include both search words.
However, the rank assigned by NEAR depends on the
proximity of the search words. A page with the searched-for
words closer together has a higher rank than a page where
they are farther apart. If the search words are more than 50
words apart, the page is assigned a rank of zero.

NOTE

The NEAR operator can be applied only to words or phrases.

•

The AND operator has a higher precedence than OR. For
example, the first three queries are equal, but the fourth is not:
- a AND b OR c
- c OR a AND b
- c OR (a AND b)
- (c OR a) AND b

Localized Symbols and Keywords
The symbols (&, |, !, ~) and the English keywords AND, OR, and
NEAR work the same in all languages supported by Ektron
CMS400.NET. Localized keywords are also available when the
browser locale is set to one of the following languages.
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Language

Keywords

German

UND, ODER, NICHT, NAH

French

ET, OU, SANS, PRES

Spanish

Y, O, NO, CERCA

Dutch

EN, OF, NIET, NABIJ

Swedish

OCH, ELLER, INTE, NÄRA

Italian

E, O, NO, VICINO

Wildcards
Wildcard operators find pages that contain words similar to a given
word.

To Search For

Example

Results

Words with the
same beginning
letters

pharm*

Pages with words that have the prefix pharm, such as
pharmaceutical, pharmacist, and pharmacology.

Words based on
any form of a verb

fly**

Pages with any form of a verb. For example, if you enter fly,
the search returns pages that contain flying, flown, flies,
and flew.

Free-Text Queries
A free-text query finds pages that match the meaning, not the
exact wording, of submitted words and phrases. Begin free-text
queries with $contents.
You cannot use boolean, proximity, or wildcard operators in a freetext query.
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To Search For

Example

Results

Files that match
free-text

$contents how do I
print in Microsoft
Excel?

Pages that mention printing and Microsoft Excel

Vector Space Queries
The search supports vector space queries, which return pages that
include a list of words and phrases. Each page is ranked according
to how well it matches the query.

To Search for

Example

Results

Pages that contain
specific words

light, bulb

Files with words that best match the search words

Pages that contain
weighted prefixes,
words, and
phrases

invent*, light[50],
bulb[10], “light
bulb”[400]

Files that contain words prefixed by “invent,” the words
“light,” “bulb,” and the phrase “light bulb” (the terms are
weighted)

Tips
•

Separate terms in a vector query with commas (,)

•

You can weight terms in vector queries by using the [weight]
syntax (see example above)

•

Pages found by vector queries do not necessarily match all
words submitted in the query

•

Vector queries work best when results are sorted by rank

Property Value Queries
Use a property value query to find files whose property values
match a given criteria. Properties you can query include file
information (like file name and size), and ActiveX properties,
including the document summary stored in files created by
ActiveX-aware applications.
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There are two types of property queries.
•

Relational property queries - consist of an “at” character (@),
a property name, a relational operator, and a property value.
For example, to find all files larger than one million kilobytes,
use @CMSsize > 1000000. See Also: ”Relational Operators” on
page 453

•

Regular expression property queries - consist of a number
sign (#), a property name, and a regular expression for the
property value. For example, to find all .avi files, use #filename
*.avi. See Also: ”Regular Expressions” on page 455
Regular expressions do not match the contents (#contents) and
all (#all) properties.
In regular expression property queries, you can only use
properties that are retrievable at query time. Properties that are
not retrievable include HTML META properties not stored in the
property cache.

Property Names
Property names are preceded by the “at” sign (@) for relational
queries, and the pound sign (#) for regular expression queries.
If no property name is specified, @contents is assumed.
Properties available for all files are listed below.

Property Name

Description

All

Matches words, phrases, and any property

Contents

Words and phrases in the file
Note: The contents property does not support relational
operators. If a relational operator is specified, no results
are found. For example, @contents Ektron finds
documents containing Ektron, but @contents=Ektron
finds none.

Filename

Name of the file
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Property Name

Description

CMSsize

File size

Write

Date file was created or last modified (whichever is
later)

You can also use ActiveX property values in queries. You can
search for files created by most ActiveX-aware applications by
querying for the following properties.

Property Name

Description

DocTitle

Title of the document

DocSubject

Subject of the document

DocAuthor

The document’s author

DocKeywords

Keywords for the document

DocComments

Comments about the document

Relational Operators
Use relational operators to create relational property queries.

To Search for

Example

Results

Property values in
relation to a fixed
value

@CMSsize < 100

Files whose size matches the query

@CMSsize <= 100
@CMSsize = 100
@CMSsize != 100
@CMSsize >= 100
@CMSsize > 100
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To Search for

Example

Results

Property values
with all of a set of
bits on

@attrib ^a 0x820

Compressed files with the archive bit on

Property values
with some of a set
of bits on

@attrib ^s 0x20

Files with the archive bit on

Property Values

To Search for

Example

Results

A specific value

@DocAuthor = “Bill
Bailey”

Files authored by Bill Bailey

Values beginning
with a prefix

#DocAuthor George*

Files whose author property begins with George

Files of any
extension

#filename *.gif

Files with a .gif extension

Files modified
after a certain date

@write > 2006/02/14

Vectors matching
a vector

@vectorprop = { 10,
15, 20 }

ActiveX documents with a vectorprop value of { 10, 15, 20 }

Vectors where
each value
matches a
criterion

@vectorprop >^a 15

ActiveX documents with a vectorprop value in which all
values in the vector are greater than 15

Note: Because E ktron CM S40 0. NET stores all content in
.txt files, you cannot use this syntax to find files with a .txt
extension.
Files modified after February 14, 2006

Note: You cannot use
the equal operator (=)
with @ write. Only
greater than (>) and
less than (<) operators
work.
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To Search for

Example

Results

Vectors where at
least one value
matches a
criterion

@vectorprop =^s 15

ActiveX documents with a vectorprop value in which at least
one value is 15

Tips for Using Property Queries
•

Use the pound (#) character before the property name when
using a regular expression in a property value.
Use the “at” (@) character otherwise. The equal (=) relational
operator is assumed for regular-expression queries.

•

File name (#filename) is the only property that efficiently
supports regular expressions with wildcards to the left of text.

•

Dates use the format yyyy/mm/dd.
You can omit the first two characters of the year. If you do, 29
or less is interpreted as the year 2000, and 30 or greater is
interpreted as the year 1900. All dates are in Greenwich Mean
Time (GMT).

•

Currency values use the format x.y, where x is the whole value
amount and y is the fractional amount. There is no assumption
about units.

•

Boolean values are (t) or (true) for TRUE and (f) or (false) for
FALSE.

•

Vectors (VT_VECTOR) are expressed as an opening brace ({),
a comma-separated list of values, and a closing brace (}).

•

Single-value expressions that are compared against vectors
are expressed as a relational operator, then a (^a) for all of or a
(^s) for some of. See Also: ”Relational Operators” on page 453

•

Numeric values can be expressed in decimal or hexadecimal
(preceded by 0x).

Regular Expressions
Regular expressions in property queries are defined as follows.
•

Any character except asterisk (*), period (.), question mark (?),
and vertical bar (|) defaults to matching itself.
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•

A regular expression can be enclosed in matching quotes (“). It
must be enclosed in quotes if it contains a space ( ) or closing
parenthesis ()).

•

The characters *, ., and ? behave as in Windows. They match
any number of characters, match (.) or end of string, and match
any one character, respectively.

•

The character | is an escape character. After |, the following
characters have special meaning:
- ( opens a group. Must be followed by a matching ).
- ) closes a group. Must be preceded by a matching (.
- [ opens a character class. Must be followed by a matching
(un-escaped) ].
- { opens a counted match. Must be followed by a matching }.
- } closes a counted match. Must be preceded by a matching {.
- , separates OR clauses.
- * matches zero or more occurrences of the preceding
expression.
- ? matches zero or one occurrences of the preceding
expression.
- + matches one or more occurrences of the preceding
expression.
Anything else, including |, matches itself.

•

Between square brackets ([]), the following characters have
special meaning.
- ^ matches everything but following classes. Must be the first
character.
- ] matches ]. May only be preceded by ^. Otherwise, it closes
the class.
- - range operator. Preceded and followed by normal
characters.
Anything else matches itself (or begins or ends a range at
itself).

•

Between curly braces ({}), the following syntax applies.
- |{m|} matches exactly m occurrences of the preceding
expression. (0 < m < 256).
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- |{m,|} matches at least m occurrences of the preceding
expression. (1 < m < 256).
- |{m,n|} matches between m and n occurrences of the
preceding expression, inclusive. (0 < m < 256, 0 < n < 256).
•

To match *, ., and ?, enclose them in brackets (for example,
|[*]sample matches “*sample”).

Query Examples

Example

Results

@CMSsize > 10000

Pages larger than 10 MB

@write > 2003/05/12

Pages modified after the date

Note: You cannot use the equal
operator (=) with @ write. Only
greater than (>) and less than (<)
operators work.
pear tree

Pages with the phrase “pear tree”

“pear tree”

Same as above

@contents pear tree

Same as above

Ektron and @CMSsize > 10000

Pages with the word “Ektron” that are larger than 10
thousand kilobytes

“Ektron and @CMSsize > 10000"

Pages with the phrase specified (not the same as
above)

#filename *.avi

Video files (the # prefix is used because the query
contains a regular expression)

@attrib ^s 32

Pages with the archive attribute bit on

@docauthor = “John Stanton”

Pages with the given author

$contents why is the sky blue?

Pages that match the query
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Search Troubleshooting
Problem

Solutions

You publish content
but cannot find it using
the search

1.

Wait 5 or 10 minutes (depends on the load on the server).

2.

Make sure the Microsoft indexing service is running (Computer
Management > Services and Applications > Indexing Service). Verify
that the Run button is grayed out. If the service is not running, start it.

3.

Query the catalog using the new content’s ID. See ”Querying the Catalog
for the Content” on page 461.

4.

Make sure the Ektron Windows service is running (Computer
Management > Services and Applications > Services > Ektron
Windows Services 2.0). Verify that the Run button is grayed out.

If the service is not running, start it. If you do, it may take a while for the
service to prepare the content for indexing.
(Continued below)
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Problem

Solutions

You publish content
but cannot find it using
the search (continued)

1.

Make sure the siteroot/Assets folder’s Advanced Attributes screen’s
For fast searching, allow Indexing Service to index this folder checkbox is checked. To access this screen, click the Advanced button on the
siteroot/Assets folder properties screen.

2.

Check the priority of the database table. See ”Checking the Priority of the
Database Table” on page 463

Indexing service uses
too much memory or
resources.
Or, too many instances
of cidaemon.exe are
running.

Check the number of catalogs being serviced. To do so, follow these steps.
1.

Go to Computer Management > Services and Applications > Indexing Service.

2.

You should see three E k t r o n C M S 4 0 0 . N E T catalogs (Public, Private,
and Content), plus System and Web. Ek tr on CMS 400 .NET does not
use the system and Web catalogs, so unless your server uses them for
another purpose, delete them.

3.

Delete any other unused catalogs.

4.

Restart the Microsoft Indexing Service.

The catalog size is
growing too quickly, or
is really huge

The indexing service generates an abstract for each content item. See ”Query
Language” on page 446. By default, the abstract length is 320 characters.

Catalog is mistakenly
deleted or corrupted

Recreate it. See ”Recreating a Catalog” on page 395

To reduce the catalog size, reduce the abstract length. See ”Adjusting the
Length of the Search Result Abstract” on page 415
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Problem

Solutions

The Inheritable
Settings checkboxes
are not checked

Make sure the Inheritable Settings checkboxes on the Generation tab of the
Properties dialog are checked.

Verify that Windows
can find files on your
server

1.

Go to Computer Management > Services and Applications > Indexing Service.

2.

Select the first of the three E ktron CM S40 0. NET catalogs (Public,
Private, and Content).

3.

Right click the mouse and select Properties.

4.

Click the Generation tab.

5.

Make sure the two checkboxes are checked (illustrated below).

6.

Repeat for the other two catalogs.

1.

Open Windows Explorer.

2.

Right click your C drive and select Search.

3.

In the All or part of the file name field, enter *.*.

4.

The search should find all files on your computer.

If it does not, ask your system or network administrator to help you determine
why your Windows search is not working. For example, he should verify that
you have permission to search for files.
SearchConfigUI.exe
crashes while building
search indexes and
catalogs

1.

Make sure the metaconfig.doc file exists in the siteroot/
uploadedfiles directory.

If it does not, ask Ektron Technical Support to send you a new file.
2.

If anyone uploaded Visio documents to your server, make sure the iFilter
is installed. See ”Installing the Visio IFilter” on page 445.
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Problem

Solutions

MS Indexing Service
cannot find files in the

1.

Open Windows Explorer.

2.

Navigate to the siteroot/assets folder.

3.

Select the folder and right click the mouse.

4.

Select Properties.

5.

Click the Advanced button.

6.

Check the box next to For faster searching, allow Indexing Service to
index this folder.

7.

Press OK.

siteroot/assets

folder.

Get error message.
An unhandled
exception has
occurred: The type
initializer for
Ektron.CMS.
WebSearch.Manager
threw an exception.0

During installation, the user might have canceled the database setup. Check
the following.
1.

Check the site root folder for the following folders. If they do not exist, create them.
•PrivateAssets
•Assets
•UploadedFiles
•UploadedImages

2.

Make sure MetaConfig.doc exists in the [sitepath]\UploadedFiles
folder. If it does not, ask Ektron Technical Support for a copy of that file
from the same Ek tron CM S40 0.NET version.

3.

Make sure noise.enu file exists in the [sitepath] folder. If it does not,
look in the [sitepath]\workarea folder. If noise.enu is there, copy it to
the [sitepath] folder. If you cannot find noise.enu, ask Ektron Technical
Support for a copy of that file from the same Ek tr on CMS 400 .NET
version.

4.

Check the following registry key:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\ContentI
ndexCommon. For that key, make sure DefaultColumnFile has the value
C:\WINDOWS\system32\FriendlyNamesDefinitionFile.txt.

If the entry does not exist, create it and set the value as listed above.

Querying the Catalog for the Content
To query the catalog for a content item, follow these steps
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1. Go to Computer Management > Services and Applications
> Indexing Service > sitenamePublishedAsset > Query the
Catalog.

2. Choose Advanced Query.
3. Use the syntax @contentID64=IDnumber. For example, if the
content ID is 30, enter @contentID64=30.
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4. The content should appear as shown above.

Checking the Priority of the Database Table
To check how your database is processing the documents, follow
these steps.
1. Launch a database management tool, such as SQL Server
Management Studio.
2. Find the Ektron CMS400.NET database.
3. Open Tables > dbo.perform.action.
4. A list of content blocks being processed appears.
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5. Make sure the action_priority for each item is less than -8. If
that is the case, the database will process the record.
If the priority is -8 and the action status is inAction, there is a
problem with the service that processes the document. To
resolve the problem, you can
- go to Computer Management > System Tools > Error Log
to find any errors and fix them
- reset the action_priority value to zero (0) and the action
status to PerformAction
- contact Ektron Support
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Discussion Boards

The Discussion Board feature provides an opportunity for topic
discussions on your Web site. A site or membership user creates a
topic and posts a starter question. Site visitors can then reply.
An example of a Discussion Board is below. As you can see, the
first screen has general topics, the second screen’s topics are
more specific, and a third screen displays posts to the forum.

As an administrator, you can determine the following Discussion
Board features.
•

The subjects being discussed
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•

A starter post, which initiates a discussion

•

If users must sign in before posting to the forum

•

If a post appears as soon as someone submits it, or must be
approved first
- If a post requires approval, you can edit or delete it before it
appears

Whether or not posts must be approved, anyone with permission to
the board can perform the following tasks on a post from the
Workarea
•

edit

•

delete

•

reply

This section explains Discussion Boards through the following
topics.
•

”Hierarchy of Discussion Board Elements” on page 466

•

”Implementing Discussion Boards” on page 470

•

”Sending Notifications When a New Forum Topic or Post is
Created” on page 514

•

”Inserting Discussion Board Server Controls” on page 517

•

”Using Discussion Boards on Your Web Site” on page 518

Hierarchy of Discussion Board Elements
A Discussion Board consists of a five-level hierarchy, illustrated
below. Before creating a Discussion Board, it is important to
understand the elements of the hierarchy.
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Ektron CMS400.NET supports an unlimited number of Discussion

Boards. Each board must follow the hierarchy. Below is the
hierarchy with sample data, to explain how each element is used.
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Within the Workarea, Discussion Boards appear as top-level
folders in the folder structure. Forums appears under them. Both
folders use the people icon ( ) to distinguish them from content
and blog folders.
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If you click a Discussion Board, you see its Subjects and Forums
on the right side of the Workarea, as shown below.

If you click a Discussion Forum, you see its topics. If you click a
topic, you see its posts, as shown below.
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Implementing Discussion Boards
To implement a Discussion Board into your Web site, place a
Forum server control on a Web page. Then, select a Discussion
Board.
All Subjects and Forums within that board appear on the Web
page. You cannot selectively suppress Subjects or Forums. Keep
this in mind when determining the contents of a Discussion Board.
This is more fully explained through the following topics.
•

”Working with Discussion Boards and Subjects” on page 471

•

”Ranking Forum Users” on page 485

•

”Working with Forums” on page 482

•

”Working with Topics” on page 490

•

”Working with Posts” on page 499

•

”Changing Page Size for Discussion Boards” on page 478

•

”Replacing Words in a Post” on page 505

•

”Restricting an IP Address” on page 511
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•

”Setting Up Post Reporting” on page 513

Working with Discussion Boards and Subjects
This section contains the following topics.
•

”Creating a Discussion Board” on page 471

•

”Viewing a Discussion Board” on page 477

•

”Editing a Discussion Board” on page 477

•

”Deleting a Discussion Board” on page 477

•

”Changing Page Size for Discussion Boards” on page 478

•

”Editing Subject Name and Sort Order” on page 478

•

”Creating a New Subject” on page 479

•

”Terms & Conditions” on page 479

Creating a Discussion Board
To create a Discussion Board, follow these steps.
1. From the Workarea’s Content tab, navigate to the folder in
which you want to place the Discussion Board.
2. Click New > Discussion Board.
3. The Add a Discussion Board to folder screen appears.
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.

Complete the screen using the following table.
NOTE

Some items in this table only appear when editing an existing Discussion Board’s
properties.

Discussion Board Properties

Field

Description

When
Available

Board Name

Enter the name of the Discussion Board. This text describes the
board within the Workarea and on your Web site.

Enter or edit

Board Title

Enter the title of the board.

Enter or edit
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Field

Description

When
Available

Accepted
HTML

A comma-delimited list of HTML tags allowed in the editor. When left
blank, all tags are available.

Enter or edit

The default list is:
br,hr,b,i,u,a,div,ol,ul,li,blockquote,img,span,p,em,
strong,font,pre,h1,h2,h3,h4,h5,h6,address,embed

Site visitors posting to the forum can apply these HTML tags to
content when their Forum editor is eWebEdit400, as set in the user
profile.
Note: You must add the embed tag if you want users to be able to
insert WMV files into their posts. See Also: ”Adding Video to a Post”
on page 525.
Accepted
Extensions

A comma delimited list of file extensions that can be uploaded. You
can enter the extension with or without the period (.). Use a comma
to separate each extension.

Edit only

The default list is: bmp,conf,doc,gif,jpe,jpeg,jpeg,png
The list appears at the bottom of the editor screen to notify the
person entering a post which file types he can attach.

Max File Size

The maximum size of a file, in bytes, that a user can upload. The
default is 200000 bytes (.19 megabytes).
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Field

Description

When
Available

Topics: Require
Authentication

Effect of this Field on the Web Site

Enter or edit

Check this box if a site visitor must sign in before he can post to the
Discussion Board. If the user cannot access a login screen, he
cannot post.
If this box is unchecked, site visitors can post without signing in.
Effect of this Field within the Workarea
If this field is checked, only users with Add Topic or Edit Topic
permissions for the Discussion Board can create or reply to posts.

Lock

Check this box if you want to prevent all posting to this Discussion
Board. You can do this temporarily or permanently.

Edit only

If a Board is locked, only Administrator user group members can
post to it, or edit or delete posts. Those users can post from the Web
site or the Workarea.
You can alternatively lock any Forum underneath this Board via the
Forum properties screen.
CSS Theme

Choose a style sheet to determine the appearance of the Discussion
Board on your Web site. Select any theme available in the CSS
Theme dropdown. The default is site root/Workarea/
threadeddisc/themes/standard.css.

Enter or edit

Alternatively, enter a path below the site root folder to your custom
CSS file in the path box.
Note: If you edit a CSS file, Ektron recommends saving it under a
new name. This prevents your changes from being overwritten
during an upgrade.
For additional information on creating custom themes, see the
Developer Manual section “Discussion Board Server Controls” >
“Forum Server Control” > “Using a Custom Theme.”
Page Template

Lets you specify a template for the Forum. If you do not specify a
template, the search results do not link properly to the Forum. See
Also: ”Creating/Updating Templates” on page 70

Enter or edit

To preview what the Forum looks like within the selected template,
click the preview icon to the right (

).
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Field

Description

When
Available

Taxonomy:
Required
category
selection

If you want all topics in this Discussion Board to be assigned a
taxonomy category, check Required category selection. If you do,
a signed-in user is prompted to select a taxonomy category when
creating a topic.

Edit only

This checkbox has no effect when creating new topics within the
Ektron CMS400.NET Workarea.
See Also: ”Taxonomy” on page 634
Taxonomy: All
taxonomies
appear

Select a taxonomy whose categories will be assigned to Forum
topics. The Taxonomies are created in the Taxonomy Module. The
Discussion Board’s taxonomy display represents another way to
organize the Forum’s posts.
See Also: ”Taxonomy” on page 634
Effect of Assigning Taxonomy Categories to a Topic
When a Discussion Board server control is placed on a Web page,
its display includes a small taxonomy icon (circled below).

When a site visitor clicks this icon, he sees all taxonomy categories.
When he selects a category, he sees its subcategories followed by
all Forum posts assigned to that category.
Below is an example of how a Discussion Board’s posts might be
organized by taxonomy category.

See Also: ”Using the Taxonomy Search” on page 678
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Field

Description

When
Available

Subjects Tab

Enter as many Subjects as you wish. Each Subject contains one or
more Discussion Forums.

Enter or edit

You must create at least one Subject for each Discussion Board.
To learn how Subjects fit into the Discussion Board hierarchy, see
”Hierarchy of Discussion Board Elements” on page 466.
Note: You can also add a Subject by selecting a Discussion Board
then selecting New > Subjects.
Subject Sort Order
Subjects are the highest level of the hierarchy that appears on your
Web site. In the sample Forum below, Latest Discoveries and
Patient Care are Subjects.

Subjects appear in alphabetical order unless you use the Sort Order
field. The Sort Order field accepts a number and uses it to arrange
the Subjects of a Discussion Board on the Web site. The lowest
numbers appear near the top of the page.
To access the Sort Order field, follow these steps.

Terms &
Conditions Tab

1.

Save the Discussion Board.

2.

Click the Discussion Board in the Workarea.

3.

Click View > Properties.

4.

Click the Subjects tab.

5.

Modify the number in the Sort Order field as needed.

Add the Terms & Conditions for using the Discussion Board. By
entering text in this text box and saving, you activate the Terms and
Conditions feature. See Also: ”Terms & Conditions” on page 479
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Viewing a Discussion Board
To view a Discussion Board, select it from the Folders display.
When viewing the Board, you see all of its Forums. You can click
any Forum to see details about it.
See Also: ”Implementing Discussion Boards” on page 470;
”Discussion Boards” on page 465

Editing a Discussion Board
When editing a Discussion Board, you can change information
entered when it was created plus additional fields only available
when editing. See the When Available column of the ”Discussion
Board Properties” on page 472.
To edit a Discussion Board, follow these steps.
1. Click the Workarea’s Content tab.
2. Form the folder structure in the left frame, click the Discussion
Board.
3. Click View > Properties.
4. Click the Edit button (

).

5. Update the screen as needed. Fields are described in
”Discussion Board Properties” on page 472.
6. Click Save (

).

Deleting a Discussion Board
You can delete any Discussion Board. When you do, its Subjects,
Forums, and posts are also deleted. Once deleted, they cannot be
retrieved.
1. Click the Workarea’s Content tab.
2. From the folder structure in the left frame, click the Discussion
Board.
3. Click Delete > This folder.
4. A message appears asking you to confirm.
5. Press OK If you are sure.
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Changing Page Size for Discussion Boards
You can change the number of Topics or Posts shown on a page
by changing the ek_PageSize value in the Web.config file.

See Also: The ek_PageSize property description in the Ektron
CMS400.NET Setup Manual section “Managing the web.config
File” > “Settings in the web.config File” > “Miscellaneous Settings.”

Editing Subject Name and Sort Order
You can change any Subject’s name or sort order. To do so, follow
these steps.
1. Click the Workarea’s Content tab.
2. From the folder structure in the left frame, click the Discussion
Board that contains the Subjects.
3. Click View > Properties.
4. Click the Subjects tab.
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5. Click the Subject that you want to edit.
6. The current Subject name and sort order appear on a new
screen. Edit as needed. See Also: ”Subject Sort Order” on
page 476.
7. Click Save (

).

Creating a New Subject
Use this procedure when you want to add a new Subject to a
Discussion Board.
NOTE

For more information about how Subjects fit into the Discussion Board hierarchy,
see ”Hierarchy of Discussion Board Elements” on page 466.

1. Click the Workarea’s Content tab.
2. From the folder structure in the left frame, click the Discussion
Board to which you want to add a Subject.
3. Click New > Subject.
4. Enter a Subject name and sort order. See Also: ”Subject Sort
Order” on page 476
5. Click Save (

).

Terms & Conditions
Adding Terms & Conditions to a discussion board allows you to
convey to a user the expectations when using the discussion
board. Once Terms & Conditions are added, users can only post to
the Forum after agreeing to the Terms.
Once any text is entered into the Terms & Conditions editor and
saved, anyone posting to the site sees the following screen the first
time he tries to post or reply to a Forum. The circled text is an
example of your entry in the Terms & Conditions editor. The rest of
the text, checkbox, and button are provided by Ektron
CMS400.NET.
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When new Membership users are added, you can have them
accept the Terms & Conditions during registration. This is
explained in the “Membership Server Control” section of Developer
manual.
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Adding Terms and Conditions to a Discussion Board
1. Click the Workarea’s Content tab.
2. From the folder structure in the left frame, click the Discussion
Board to which you want to add terms and conditions.
3. Click View > Properties.
4. Click the Edit button (

).

5. Click the Terms & Conditions tab.
6. Add the terms and conditions text to editor.
7. Click the Save (

) button.
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Working with Forums
A Forum is a particular thread within a Discussion Board. To learn
about how Forums fit into the Discussion Board hierarchy, see
”Hierarchy of Discussion Board Elements” on page 466.
For each Forum, you define the following:
•

name and Description

•

whether posts to it must be approved before appearing on your
Web site

•

if it’s accepting new postings

•

its sort order, which determines its sequence on the Web page
within its Subject

•

its Subject

This section contains the following topics.
•

”Creating a Forum” on page 482

•

”Editing a Forum” on page 484

•

”Deleting a Forum” on page 485

•

”Ranking Forum Users” on page 485

Creating a Forum
You can only create a Forum after a Discussion Board and at least
one Subject have been created.
1. In the Workarea, click the Content tab.
2. Select a Discussion Board.
3. Click New > Discussion Forum.
4. The Add a Discussion Forum to Board screen appears.
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Complete the screen using the following table.

Field
Name

Description
Enter the name of the discussion Forum.
The name identifies the Forum in the left side of the Workarea. The
Forum’s name appears next to a people icon (
distinguishes it from content and blog folders.

). This icon

It also appears on the Web site (see example below).

Description

Enter a more detailed description of the Forum.
The description appears on the Web site, as illustrated above.
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Field

Description

Moderate Comments

Checking this box causes
•

comments to require approval before appearing on the Web site
See Also: ”Approving a Topic” on page 498

•

a post to be reported to all moderators of the Forum. See Also:
”Reporting a Post” on page 524 and ”Setting Up Post Reporting”
on page 513

Only users who are granted Moderate permission can approve
comments, thereby allowing them to be published on the site.
The Smart Desktop has a Forum Topics and Posts category. This
tells you how many posts currently require your approval before they
appear on the site.
Lock Forum

Check this box if you want to prevent all posting to this Forum. You
can do this temporarily or permanently.
If a Forum is locked, only members of the Administrators user group
can post to it, or edit or delete posts. Those users can post from the
Web site or the Workarea.
A Discussion Board can also be locked. If a board is locked, a
message on this screen indicates that. In that case, no posting is
allowed to this Forum regardless of this setting.

Sort Order

Enter a number if you want to arrange the sequence of Forums
within the Subject.
If you do not, Forums appear in alphabetical order within a Subject.

Subject

Enter the Subject within which this Forum will appear on the Web
site. To learn more about the relationship of Subjects to Forums, see
”Hierarchy of Discussion Board Elements” on page 466.

5. Click Save (

).

Editing a Forum
Follow these steps if you want to change any information about a
Forum.
1. Click the Workarea’s Content tab.
2. From the folder structure in the left frame, click the Discussion
Board that contains the Forum.
3. Click the Forum.
4. Click the View Properties button (
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5. Click the Edit button (

).

6. Update the screen as needed. The fields are described in
”Complete the screen using the following table.” on page 483.
7. Click Save (

).

Deleting a Forum
You can delete any Forum. When you do, its topics and posts are
also deleted. Once deleted, they cannot be retrieved.
To delete a Forum, follow these steps.
1. In the Workarea, click the Content tab.
2. Select the Discussion Board that contains the Forum.
3. Click the Forum.
4. Click the Delete Forum button (

).

5. A message appears asking you to confirm.
6. Press OK if you are sure.

Ranking Forum Users
The User Ranking feature lets you recognize users for their Forum
contributions. You can create a ranking system that determines the
number of posts a user must submit to move up to the next level.
Here’s an example.

Rank

Number of posts

Newbie

0-9

Intermediate

10 - 19

Expert

20 and up

This is known as a ladder system, because users move to the next
level after a designated number of posts.
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This system lets Forum users build credibility. You can assign each
rank an image, which appears below the user’s name on any post
(see illustration below).

The rank also appears on a user’s forum profile. See Also:
”Suppressing User Information from the Forum Profile Display” on
page 526

Ranks Independent of the Ladder System
You can also create ranks that are independent of the ladder
system. Such a rank bears no relationship to the number of posts a
user has made. For example, after a Forum user acquires Ektron
Developer Certification, he is assigned the Ektron Developer rank.
Users can be moved from a non-ladder rank to the ladder system
and vice versa. Whether or not a user is in a ladder system, Ektron
CMS400.NET keeps a tally of posts. So, if the user is moved into a
ladder system at any time, he is placed into the correct rank.

Adding a User Rank
To add a user rank, follow these steps.
NOTE

You can also access the User Ranks screen from Workarea > Settings >
Configuration > Discussion Board > User Ranks. If you have more than one
Forum, this screen lets you pick the Discussion Board to which a rank is assigned.

1. In the Workarea, click the Content tab.
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2. Select a Discussion Board.
3. Click New > User Ranks.
4. The User Ranks screen appears.

5. Complete the screen using the following table.

Field

Description

Name

The name of the rank. For example, Newbie, Expert, Developer, or
Associate.

Rank Image

Click the upload link to browse and select an image to upload. Once
uploaded the path where the image is stored appears in the text box.
Images are optional.
If you assign an image, it appears below the user’s name on any
post.

Ladder System

Check this box if this rank is part of a ladder system. That is, a rank
based on the number of posts a user has submitted to this
Discussion Forum. If you uncheck Ladder System, both Starting
Rank and Number of Posts become inactive, since those fields set
up and manage the ladder system.
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Field

Description

Starting Rank

If you are using a ladder system, use this check box to designate this
rank the Starting Rank. A user is assigned to this rank when he
submits the first post.
A Discussion Forum can only have one Starting Rank. Also, If this is
the Starting Rank, you cannot enter a number of posts.

Number of Posts

Enter the number of posts it takes to reach this rank. If the Starting
Rank check box is checked, the number is 1 and cannot be
changed.

Applies To

If you accessed this screen from Workarea > Settings >
Configuration > Discussion Board > User Ranks, use this field to
select the Discussion Forum to which this rank applies.

6. Click the Save button (

).

Deleting a User Rank
1. In the Workarea, click the Content tab.
2. Select a Discussion Board.
3. Click View > User Ranks.
4. Select the rank you want to delete.
5. Click the delete (

) button.

6. Press OK to the confirmation message.

Changing a User’s Rank
In order to change a user’s current rank, you must know it. As
mentioned above, a user’s rank appears below the user name on
any post he has made.
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You can only move a user into and out of a ladder system. You
cannot change his rank within a ladder system -- that is determined
by the number of posts.
To change a user’s rank, follow these steps.
1. In the Ektron CMS400.NET Workarea, go to Content and
navigate to the forum to which the user has posted.
2. Click View > User Ranks.
3. Select the rank that you want to move the user out of.
4. The User Ranks screen appears. The lower half shows all
users assigned that rank.

5. Click the user that you want to move out of the rank.
6. The screen display all ranks. The current one is selected.
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7. Click next to the desired rank.
8. Click the Save (

) button.

Working with Topics
Topics are specific issues to be discussed in a Forum. For
example, in a medical research Forum, a topic might be New
Cancer Treatments. Topics can only be started within the
Workarea.
Before creating a topic, you must create a Forum into which to
place it. To learn more about how Topics fit into the Discussion
Board hierarchy, see ”Hierarchy of Discussion Board Elements” on
page 466.
This section contains the following topics:
•

”Adding a Topic to a Forum” on page 491

•

”Setting and Changing the Topic Priority” on page 493

•

”Locking a Topic” on page 494

•

”Viewing a Topic” on page 495

•

”Editing a Topic’s Title” on page 497

•

”Approving a Topic” on page 498

•

”Deleting a Topic” on page 498
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Adding a Topic to a Forum
When a new Topic is created, the first post is created from the
message of the Topic.
To create a Topic, follow these steps.
NOTE

If the user adding the Topic is not a Forum moderator, that user does not see the
Topic in the workarea until it is approved. See Also: ”Approving a Topic” on
page 498.

1. In the Workarea, click the Content tab.
2. Select a Discussion Board, then a Forum from the folder
structure.
3. Click the New Topic button (

).

4. The Post New Topic screen appears.

5. Complete the screen using the following table.
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Field

Description

Subject

Enter a short description of the topic. The Topic Subject appears on the Forum
page, as shown below.

Priority

Set the priority level for the topic. This determines where the topic appears in
the topic list on the site. The default setting is Normal. See Also: ”Setting and
Changing the Topic Priority” on page 493

Lock

Check this box if you want to prevent posting of replies to this Topic. You can
do this temporarily or permanently.
If a Topic is locked, only Administrator user group members can post to it, or
edit or delete posts. Those users can post from the Web site or the Workarea.

Message

Enter the topic text. This text appears on a new Web page after a Web site
visitor clicks a Topic’s Subject line.
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6. Click Save (

).

Setting and Changing the Topic Priority
You can set a topic’s priority when creating it. Within a Forum,
topics are sorted by priority.
Anyone with Moderate permission can change a topic’s priority. To
do so, edit a Forum’s properties and click the View Properties
button ( ).

Priority Levels
There are three priority levels:
•

Announcement

•

Sticky

•

Normal

•

Announcement - topic always appears at the top of the list. If a
list has more than one announcement, they are sorted by date
with most recent on the top.
The Announcement icon (
the title.

•

) indicates its priority to the left of

Sticky - topic appears near the top of the list, just below the
announcements. If a list has more than one sticky topic, they
are sorted by date with most recent on the top.
The Sticky icon (

) indicates its priority to the left of the title.
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•

Normal - Topics with this priority follow Announcements and
Sticky topics. The Normal icon ( ) next to the topic indicates
its priority.

Locking a Topic
Locking a Forum Topic prevents users from posting a reply to the
Topic. For example, you might create an announcement, but don’t
want people replying to it. Or, you might feel as though a topic has
had enough discussion and want to stop further replies.
If a Topic is locked, only Administrator user group members can
post to it, or edit or delete posts. Those users can post from the
Web site or the Workarea.
To lock a Topic, follow these steps.
1. In the Workarea, click the Content tab.
2. Select a Discussion Board, then a Forum from the folder
structure.
3. Click a topic.
4. Click the Properties button (

).

5. Click the Lock Topic check box.
NOTE

To unlock a topic, remove the check mark from the Lock Topic check box.
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6. Click Save (

).

Viewing a Topic
NOTE

To learn about viewing a topic from your Web site, see ”Using Discussion Boards
on Your Web Site” on page 518.

To view a topic from the Workarea, follow these steps.
1. In the Workarea, click the Content tab.
2. Select a Discussion Board, then select a Forum from the folder
structure.
3. The Forum’s topics appear in the right frame. Click the one that
you want to view.
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The View Topic screen displays each post within the topic. If a post
is surrounded by a yellow border (illustrated below), it must be
approved before it can appear on the Web site. Only users with
Moderate permission can approve a post.

NOTE

A red flag (circled below) to the left of a post on the Content of Forum screen also
indicates that posts require a moderator’s approval.

The following options may appear across the top of the screen,
depending on your permissions.
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Button

Description

For more information, see

Delete topic and all of its posts

”Deleting a Topic” on page 498

View and edit the topic’s title and priority

”Editing a Topic’s Title” on page 497

Return to previous screen

Under each post is a set of options that you may be able to perform
on any post, depending on your permissions and the status of the
post.
If an option is underlined, you have authority to perform it. If not,
you cannot. For example, if a post’s status is approved, the
approve option is not underlined because it is already approved.
See Also:
•

”Approving a Post in the Workarea” on page 500

•

”Adding a Reply to a Post” on page 499

•

”Editing a Post” on page 501

•

”Deleting a Post” on page 502

Editing a Topic’s Title
The only part of topic you can edit is its title.
1. In the Workarea, click the Content tab.
2. Select a Discussion Board, then select a Forum from the folder
structure.
3. The Forum’s topics appear in the right frame. Click the one that
you want to edit.
4. Click the View Properties button (

).

5. The Edit Topic screen appears. Modify the title as needed.
6. Click Save (

).
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Approving a Topic
A topic needs approval when a user without moderate permissions
for the Forum adds a Topic.
Moderate permissions are set on a forum’s properties screen, at
the Moderate Comments check box. If that box is checked, only
CMS users assigned to the Discussion Board's Permissions
screen's Moderate column can approve.
To approve a Topic, follow these steps.
1. In the Workarea, click the Content tab.
2. Select a Discussion Board, then select a Forum from the folder
structure.
3. The Forum’s topics appear in the right frame. Click the one that
you want to approve.
4. The View Topic screen appears.
5. Click the Approve Topic button (

).

6. The Topic is approved.

Deleting a Topic
You can delete any Topic. When you do, its posts are also deleted.
Once deleted, they cannot be retrieved.
1. In the Workarea, click the Content tab.
2. Select a Discussion Board, then select a Forum from the folder
structure.
3. The Forum’s topics appear in the right frame. Click the one that
you want to delete.
4. The View Topic screen appears.
5. Click the Delete Topic button (

).

6. A confirmation message appears.
7. Click OK if you are sure you want to delete it.
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Working with Posts
When a new Topic is created, the first post is created from the
message of the Topic. Essentially, all posts to the Topic are replies
to the first.
This section contains the following topics, which explain working
with posts.
•

”Adding a Reply to a Post” on page 499

•

”Approving a Post in the Workarea” on page 500

•

”Editing a Post” on page 501

•

”Deleting a Post” on page 502

•

”Attaching Images and Files to a Post” on page 502

•

”Searching a Forum’s Posts” on page 504

•

”Moving a Topic and Its Posts to Another Forum” on page 505

•

”Replacing Words in a Post” on page 505

•

”Creating and Editing Emoticons” on page 508

Adding a Reply to a Post
NOTE

You can also reply to a post from the Web site. See ”Posting a Reply” on
page 520.

1. In the Workarea, click the Content tab
2. Select a Discussion Board, then select a Forum from the folder
structure.
3. The Forum’s topics appear in the right frame. Click the one that
has the post that you want to reply to.
4. The next screen, View Topic, displays all posts to the selected
topic.
5. Find the post that you want to reply to by reading its text
(illustrated below).
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6. Click reply.
7. Enter a Title for the post.
8. In the Description field, enter the text of your post.

Approving a Post in the Workarea
When defining a Forum, you can check the Moderate Comments
field. If you do, posts to the Forum must be approved before they
appear on the Web site. Only users who are assigned the
Moderate permission are allowed to approve a post.
You can approve a post from the Workarea or the Forum on the
site. See also ”Approving a Post” on page 523.
To approve a post in the Workarea, follow these steps.
1. In the Workarea, click the Content tab.
2. Select a Discussion Board, then a Forum from the folder
structure.
3. The Forum’s topics appear in the right frame. Click the one that
has the post that you want to reply to. (Unapproved posts have
a red flag in the left column, as illustrated below.)
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4. The next screen, View Topic, displays all posts to the selected
topic.
5. Find the post you want to reply to. Unapproved posts have a
yellow border (Illustrated below).

6. Click approve under the post icon.

Editing a Post
You can edit the text of a post but you cannot edit its title.
NOTE

You can also edit a post from the Web site. See ”Using Discussion Boards on
Your Web Site” on page 518.

1. In the Workarea, click the Content tab.
2. Select a Discussion Board, then a Forum from the folder
structure.
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3. The Forum’s topics appear in the right frame. Click the one that
has the post that you want to edit.
4. The next screen, View Topic, displays all posts to the selected
topic.
5. Find the post that you want to edit.
6. Click edit under the post icon.
7. The Edit Reply screen appears. Within the editor, update the
text as needed.
8. Click Save (

).

Deleting a Post
1. In the Workarea, click the Content tab.
2. Select a Discussion Board, then a Forum from the folder
structure.
3. The Forum’s topics appear in the right frame. Click the one that
has the post you want to delete.
4. The next screen, View Topic, displays all posts to the selected
topic.
5. Find the post that you want to delete.
6. Click delete under the post icon.

Attaching Images and Files to a Post
When creating a topic or post, you can add an attachment. In the
Attached Files field, A list of the files of files that will be attached
appears, In addition, a list of valid file extensions appear. The list of
valid file extensions and maximum size of the file upload are
defined at the Discussion Board level. See ”Accepted Extensions”
on page 473 and ”Max File Size” on page 473.

Attaching a File
To add an attachment to a topic or post, follow these steps.
1. Click the Attachments button below the editor.
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2. The Attachments window appears.

3. Click the Browse... button to find the file.
4. Browse to the location of the file and select it.
5. Click Open.
6. Click the Attach button to attach the file to the post.
7. The file appears in the list of Current File Attachments.
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8. Click the Close button.

Viewing an Attached File
To view an attached file, click its name in the post.

Removing an Attached File
To remove a file from the list of attachments, follow these steps.
1. Click the Attachments button below the editor.
2. Highlight the attached item.
3. Click the Remove button.
4. Click the Close button.

Searching a Forum’s Posts
The Forum server control includes a search feature that lets site
visitors search through all posts on your site. Any user can access
the search from the Forum screen (see below).
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When a site visitor clicks Search, he can search the current Forum
(the default value), select a different Forum, or search all Forums.

Moving a Topic and Its Posts to Another Forum
If you want to move a topic and its associated posts in one forum to
another, follow these steps.
Prerequisite: The forum to which you want to move the topic and
posts must exist. See ”Creating a Forum” on page 482.
1. Access a page on your Web site that has a login button.
2. Sign in as a member of the Administrators group or as a
Moderator of the board.
3. Navigate to a page with Discussion Board.
4. Select a forum from the Discussion Board.
5. Navigate to a topic page.
6. Click the Move to... dropdown list. (It appears in the right
corner above the posts.)

7. Select the topic to which you want to move.
8. Confirm that you want to move all posts.

Replacing Words in a Post
You can configure Ektron CMS400.NET to replace unwanted
words in a post. This feature is useful for changing words that are
obscene, indecent, or should not appear on your site. In addition,
Replace Words can fix commonly misspelled words. For example,
the can replace teh. See Also: ”Adding a Replacement Word” on
page 507
The Replace Words feature works with exact matches but does not
append words. For example, if you replace car with auto, the
sentence I bought the car from the cartel becomes I bought the
auto from the cartel. Note that cartel did not change to autotel even
though the word car appears in cartel.
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This feature is more fully explained through the following topics.
•

”Using Regular Expressions” on page 506

•

”Adding a Replacement Word” on page 507

•

”Viewing Existing Replacement Words” on page 508

•

”Editing a Replacement Word” on page 508

•

”Deleting a Replacement Word” on page 508

Using Regular Expressions
If you would like the Replace Words feature to modify words that
contain a word you do not want used, you can use Regular
Expressions. A Regular Expression, often referred to as regex, is a
pattern of metacharaters placed around a word that describes a
string. Used for string manipulation, regex allows you to detail a
succinct description of a group of words without having to detail
each word in the group.

Regular Expression

Description

.

Matches any character, similar to a wildcard. For example, .ar matches any
three letter word ending in ar, such as car, bar, tar or far.

|

Acts as an or operator. For example, steak|stake would find steak or stake.

[]

Matches one character that is between the brackets. For example, [rst]
matches r, s or t. [d-g] matches d, e, f, or g. Another example, [bc]ar matches
bar and car. If you need to match a dash (-), use it a the beginning or end of
the group. For example, [xyz-] or [-xyz].

[^ ]

Matches one character that is not in the group. For example, [^rst] matches
any character other than r, s or t. Another example, [^bc]ar does not match bar
or car, but does match words, such as tar or far.

^

Matches the beginning of any line. For example, ^[bc]ar matches bar or car,
but only at the beginning of a line.

$

Matches the end of any line. For example, ^[bc]ar matches bar or car, but only
when it appears at the end of a line.
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Regular Expression

Description

()

Marks a sub expression. For example, alt(a|e)r finds altar or alter.

*

When an expression is followed by *, it matches zero or more versions of the
expression. For example, [rst]* finds (blank), r, s, t, rs, sr, rt, tr, st, ts, rst, rts,
srt, str, trs and tsr.

+

When an expression is followed by +, it matches one or more versions of the
expression. This differs from * because it does not match (blank). It must
match at least one character. For example, r+ matches r, rr, rrr and so on.

{x,y}

Must match at least x times and not more than y times. For example, s{2,4}
matches ss, sss and sss. You can also use {x} to specify an exact match. For
example, s{3} matches sss. You can use {x,} to specify that the match is at
least x amount of times. For example, s{4} matches ssss, sssss, ssssss and
so on.

?

Must match the preceding character zero or one times. For example,
Boa?rder matches boarder and border.

Adding a Replacement Word
To add a replacement word to a Forum, follow these steps.
NOTE

In addition to using Replace Words for a specific Forum, you can access the
Replace Word feature from the Workarea > Settings > Configuration > Discussion
Board > Replace Words. If you have more than one Forum, this allows you select
to which Discussion Boards the Replace Words feature is applied.

1. In the Workarea, click the Content tab.
2. Select a Forum from the folder structure.
3. Click New > Replace Word.
4. The Replace Word screen appears.
5. Add the word to be replaced in the Old Word textbox.
6. Add the replace word in the New Word textbox.
7. Select the language for the Replace Word.
8. Click the Save button (

).
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Viewing Existing Replacement Words
To view a list of existing words that are replaced, follow these
steps.
1. In the Workarea, click the Content tab.
2. Select a Forum from the folder structure.
3. Click View > Replace Words.
4. A list of word to be replaced appears.

Editing a Replacement Word
1. In the Workarea, click the Content tab
2. Select a Forum from the folder structure.
3. Click View > Replace Words.
4. Click either the Old Word or the New Word to edit.
5. Click the Edit button (

).

6. Change the Old Word, New Word or Language.
7. Click the Save button (

).

Deleting a Replacement Word
1. In the Workarea, click the Content tab.
2. Select a Forum from the folder structure.
3. Click View > Replace Words.
4. Click either the Old Word or the New Word to delete.
5. Click the Delete button (

).

6. A dialog box asks if you are sure you want to delete.
7. Click OK.

Creating and Editing Emoticons
An emoticon is an icon used to express emotion in a Forum post.
For example,

.
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There are two ways to insert an emoticon.
•

A Forum participant clicks the emoticon toolbar button
.
Next, a small window appears with available emoticons (shown
below). The user clicks one to insert it.

•

A Forum participant enters a few characters that resemble the
image. For example, to insert

, the user enters O:\).

While working in a post, the user only sees the text. But when
the post is saved, Ektron CMS400.NET converts the text to the
corresponding emoticon. In all subsequent work with the post,
users see only the emoticon.
”Viewing Emoticons” on page 509 explains how to find the list of
available emoticons and the characters used to insert each one.
You can view and modify or delete a standard set of emoticons.
You can also create your own.

Inserting Emoticon Images
Place emoticon images in the following folder:
webroot\Workarea\threadeddisc\emoticons. Administrators reference
these files when editing or creating new emoticons.

Viewing Emoticons
A standard set of emoticons is supplied with Ektron CMS400.NET.
After viewing them, you can add new ones as well as delete or
modify standard ones.
To see Ektron CMS400.NET’s emoticons, follow these steps.
1. Within the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Discussion Boards > Emoticons.
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2. A list of emoticon images and text appears.

Editing Emoticons
To edit an emoticon, follow these steps.
1. Within the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Discussion Boards > Emoticons.
2. Click the emoticon text or image that you want to edit.
3. Click the Edit button (

).

4. Use the following table to guide you through the screen’s fields.
Fields on the Emoticons Properties Screen

Field

Description

Emoticon
Text

Enter or update the characters a Forum participant would enter to insert this
emoticon.

Emoticon
Image

Enter the name of the image file that will appear after a user enters the above
Emoticon text and saves the post. Administrators place emoticon images in
the siteroot\Workarea\threadeddisc\emoticons folder.

Regex

See ”Using Regular Expressions” on page 506

Language

Select the emoticon’s language from the dropdown list. If a Forum is
language-specific, only emoticons assigned to that language or all languages
are available.
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Deleting Emoticons
To delete an emoticon, follow these steps.
1. Within the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Discussion Boards > Emoticons.
2. Click the emoticon that you want to delete.
3. Click the Delete button (

).

4. Reply to the confirmation message.

Creating Emoticons
To create an emoticon, follow these steps.
1. Within the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Discussion Boards > Emoticons.
2. Click the Add button (

).

3. Respond to the fields on the screen. See ”Editing Emoticons”
on page 510.
4. Click Save (

).

Restricting an IP Address
If you are not using authentication for the Forums and want to
block a site visitor from posting to the Forum, you can use the
Restricted IP feature to block site visitors from posting to the
Forum.
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Adding an IP Address the Restricted List
NOTE

In addition to using Restricted IPs for a specific Forum, you can access the
Restricted IP feature from the Workarea > Settings > Configuration > Discussion
Board > Restricted IPs. If you have more than one Forum, this allows you select
to which Discussion Boards the Restricted IPs are applied.

To add an IP address to the restricted list, follow these steps.
1. In the Workarea, click the Content tab.
2. Select a Forum from the folder structure.
3. Click New > Restricted IP.
4. Enter the IP Address to be blocked.
5. Click the Save button (

).

6. A list of restricted IP addresses appear.

Editing a Restricted IP Address
1. In the Workarea, click the Content tab.
2. Select a Forum from the folder structure.
3. Click View > Restricted IPs.
4. A list of restricted IP addresses appears.
5. Click the IP address to be edited.
6. Click the Edit button (

).

7. Edit the IP address in the Block IP text box.
8. Click the Save button (

).

Deleting a Restricted IP Address
1. In the Workarea, click the Content tab.
2. Select a Forum from the folder structure.
3. Click View > Restricted IPs.
4. A list of Restricted IP addresses appears.
5. Click the IP address to be deleted.
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6. Click the Delete button (

).

7. A dialog asks if you are sure you want to delete the restricted
IP address.
8. Click OK to continue.
9. A list of the remaining restricted IP addresses appear.
See Also: ”Discussion Boards” on page 465

Setting Up Post Reporting
When you set up the Forum Post Reporting feature, it adds a
Report button to the bottom of each post. The button lets site
visitors report posts to Forum moderators. For example, users can
report posts that are offensive or spam posts.

When a user clicks the Report button, an email notification is sent
to moderators. A moderator can then view the post and decide
whether to edit, delete or leave the post. See Also: ”Reporting a
Post” on page 524
To set up a Forum for Post Reporting, follow these steps.
IMPORTANT!

Your Ektron CMS400.NET Web server must be set up to send emails. See the
Setup Manual section “Configuring E-Mail Notifications for Tasks and Content
Workflow.”

1. In the Workarea, click the Content tab.
2. Select a Discussion Board from the folder structure.
3. Click View > Permissions.
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4. Make sure Forum moderators have Moderate permission.
5. Click the Back button (

).

6. Select a Forum.
7. Click the Properties button (

).

8. Make sure the Moderate Comments box is checked. If it is
not, click the Edit button (
Comments box.
9. Click the Save button (

) and check the Moderate
).

Sending Notifications When a New Forum Topic or
Post is Created
The Discussion Board’s Email Notification feature enables Ektron
CMS400.NET to generate email for a list of registered users
whenever a new forum topic or post is created.
For example, anyone may register to be notified whenever a new
forum topic or post is created. As soon as the new forum topic or
post is created on the discussion board, registered users receive
an email announcement with a link to the new topic or post. The
recipient clicks the link and immediately accesses the page.
As a result, a self-selected group of users can be instantly notified
when user’s post information to your discussion board relating to
their interests. Once the messages are set up, you don’t need to
do anything -- everything happens in the background.
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Sample Discussion Board Email Notification

See Also: ”Creating the Email Message” on page 515

Creating the Email Message
You can create an email message to be sent when a new post is
added to the discussion board or when a new topic is added. A
simple editor lets you apply some XHTML formatting the message.

Including Variables in the Default Message
The messages can include variables that retrieve information
about the new post or topic and display it in the message text. The
variables are surrounded by at signs (@). For example:
@appPosterDisplayName@ has created a thread you have subscribed to.

In the email, this text might read:
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Alan Administrator has created a thread you have subscribed to.

You can use the following variables in the body of an email
notifications.

Variable

Displays this information in the email

@appTopicTitle@

The title of the topic.

@appTopicId@

The integer ID of the topic.

@appRecipientDisplayName@

The display name of the person receiving the email.

@appRecipientId@

The recipient’s integer ID.

@appRecipientFirstName@

The first name of the person receiving the email.

@appRecipientLastName@

The last name of the person receiving the email.

@appRecipientEmail@

The email address of the person receiving the email.

@appHostUrl@

The host site’s URL.

@appForumUrl@

The forum’s URL.

@appPostMessage@

The text of the message that was posted to the
discussion board.

@appPosterId@

The integer ID of the person who created the post.

@appPosterDisplayName@

The display name of the person who created the post.

@appPosterProfileUrl@

The profile URL for the person who created the post.

@appPostUrl@

The URL of the post on the Web site.

To create a message, follow these steps.
1. In the Workarea, go to Settings > Configuration >
Discussion Boards > Messages.
2. Click the Add button (

).

3. Enter a title that describes the message.
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4. At the Type field, select either NewForumTopic or
ForumPost.
5. Select whether to make the email message a Default message.
6. In the editor, enter the message text. Use the variables listed in
the table above to retrieve information about the about the new
post or topic and display it in the message.
7. Click the Save button (

).

Inserting Discussion Board Server Controls
Ektron CMS400.NET provides two server controls for use with the

Discussion Boards. The Forum server control displays the
discussion board. The Active Topics server control displays a list of
active or recent topics.

Inserting the Forum Server Control
After creating at least one hierarchy of Discussion Board elements,
place a Forum server control on a Web page. That procedure is
described in the Ektron CMS400.NET Developer’s Manual section
“Introduction to Ektron CMS400.NET Server Controls” >
“Discussion Board Server Controls” > “Forum Server Control.”
If you want require authentication by site visitors, the web page
that hosts the Forum should also contain

NOTE

•

a Membership server control (or a link to page that has one).
This lets site visitors/membership users register for Discussion
Boards.

•

a Login server control that lets the site visitor/membership user
log in

Ektron recommends adding text below the Login server control to remind the site
visitor to enter his email address at the User field. For example, “At the User field,
enter your email address.”

Inserting the ActiveTopics Server Control
Displays the most active or recent topics. You can place this server
control anywhere on your site. For example, on your home page,
display the last ten topics added to the board.
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To learn about the ActiveTopics Server Control, see the Ektron
CMS400.NET Developer’s Manual section “Introduction to Ektron
CMS400.NET Server Controls” > “Discussion Board Server
Controls” > “ActiveTopics Server Control.”

Using Discussion Boards on Your Web Site
This section explains what can be done when using a Discussion
Board on your site.
•

”Approving a Topic” on page 518

•

”Sorting Topics” on page 519

•

”Deleting a Topic” on page 498

•

”Posting a Reply” on page 520

•

”Editing a Post” on page 522

•

”Quoting a Post” on page 521

•

”Approving a Post” on page 523

•

”Deleting a Post” on page 524

•

”Reporting a Post” on page 524

•

”Adding Video to a Post” on page 525

•

”Moving a Topic and Its Posts to Another Forum” on page 505

•

”Suppressing User Information from the Forum Profile Display”
on page 526

•

”Outputting a Forum as an RSS Feed” on page 529

•

”Subscribing to a Discussion Board” on page 530

•

”Sending a Private Message” on page 531

•

”Using the Control Panel” on page 532

Approving a Topic
A Topic needs to be approved when a user who does not have
moderate permission for the Forum adds a Topic. When you view
topics on the site, any that need approval are highlighted with a
different color background.
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From this screen, you can click the Approve link next to the topic’s
title. You could also click the Topic’s title to view it and click the
Approve button (
) on that screen.

Sorting Topics
Topics can be sorted by the columns of a Forum. To sort a Forum:
1. Go to the Web page that hosts the Discussion Board.
2. Click the Forum of interest.
3. Click any of the column titles to sort by alpha or numerical
order.
On the first click, items are sorted first by any numeric (1-10)
values, then by alpha values (A to Z). Clicking a column title a
second time sorts the items in reverse.
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When the page is first viewed, the list is sorted by Last Post.

Deleting a Topic
Topics on the site can be deleted from a Forum by the users who
created them or by users with the Moderate permission. This
includes Membership users.
WARNING!

When you delete a topic, any replies or posts associated with the topic are also
deleted.

To delete a topic:
1. Go to the Web page that hosts the Discussion Board.
2. Click the Forum of interest.
3. Click the topic you wish to delete.
4. Click Delete Topic.
5. A dialog appears asking you to confirm the deletion.
6. Click OK.
The topic and all associated posts and replies are deleted.

Posting a Reply
1. Go to the Web page that hosts the Discussion Board.
2. Click the Forum of interest.
3. Click Add Reply.
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NOTE

If a topic is moderated, a message appears stating that your reply is pending
moderator approval.

There are two editors that site visitors can use when replying:
•

eWebEditPro (scaled-down version)

•

eWebEdit400

For users who sign in before posting, this decision is made for the
user at the Forum Editor field on the Edit User screen.
If users does not sign in, eWebEdit400 is the editor.
If a site visitor is using an Apple Macintosh computer,
eWebEdit400 is the editor regardless of the Forum Editor field
value on the Edit User screen.

Quoting a Post
Quoting a post’s comments means that your reply begins with the
original post’s comments. You can then add your comments and
even edit the quoted post, so that you can include only the portion
on which you are commenting.

To quote a post, follow these steps.
1. Go to the Web page that hosts the Discussion Board.
2. Click the Forum of interest.
3. Click a Topic.
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4. Find the post you want to quote.
5. Click the Quote button.

6. The editor appears with the quoted information at the top of the
text area.
.

7. Add your comments below the quote.
8. Click Post.

Editing a Post
1. Go to the Web page that hosts the Discussion Board.
2. Click the Forum of interest.
3. Find the topic you want to edit.
4. Click Edit.
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Approving a Post
When defining a Forum, you can check the Moderate Comments
field. If you do, posts to the Forum must be approved before they
appear on the Web site. Only users who are assigned the
Moderate permission are allowed to approve a post.
You can approve a post from the Workarea or the Forum on the
site. See also ”Approving a Post in the Workarea” on page 500.
To approve a post from the Forum, follow these steps.
1. Log into the site.
2. Navigate to the Forum.
3. Click the Moderate button (

).

4. The Forum’s Control Panel appears.

5. Click the topic.
6. The topic appears. Posts requiring approval have an Approve
button (
).
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7. Click the Approve button (

).

8. A screen appears stating that the post has been approved.
9. The post now appears on your Web site.

Deleting a Post
1. Go to the Web page that hosts the Discussion Board.
2. Click the Forum of interest.
3. Find the topic you want to delete.
4. Click Delete.

Reporting a Post
You can allow site visitors to inappropriate report posts, such as
spam or offensive posts.
When a site visitor clicks the Report Post button (located at the
bottom of the post), an email notification is sent to all Forum
moderators. Any moderator can review the post and decide to edit,
delete, or leave it alone. See Also: ”Setting Up Post Reporting” on
page 513
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Adding Video to a Post
A user can add video to a post by clicking the Add Video button
(
) in a Forum post using eWebEdit400. The following
prerequisites must be in place for a user to perform this action:
•

the embed tag must be added to the Accepted HTML property
in the Workarea Forum’s properties. See Also: ”Accepted
HTML” on page 473.

•

a user must be using eWebEdit400 See Also: ”Introduction to
Ektron CMS400.NET Editors” on page 490

•

the video must be in the .wmv format

•

the video must reside in a hosted location. For example,
http://www.example.com/myvideos/fridaylunch.wmv

Once you click the Add Video button (
), enter the path to the
video in the dialog box and click OK. A place holder is then added
to the post.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

525

Discussion Boards

Suppressing User Information from the Forum Profile Display
Anyone browsing to a Discussion Forum can view information
about its contributors by clicking the user name, as shown below.
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However, if the Forum server control’s HideUserProfile property is
true, non-administrator users cannot see the profile, even if the
Private Profile setting is set to Public. For more information, see
”How Users Suppress Profile Information” on page 528 and ”How
Administrators Suppress Profile Information” on page 529.
Administrators can see the profile, regardless of how the
property is set.

HideUserProfile

What Information is Contained in the Profile?
The profile contains the following information about a user:
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•

First Name - the first name of the user

•

Last Name - the last name of the user

•

Email - the email address of the user

•

Joined - the date the user joined

•

Last Visit - the date the user last visited the site

•

Number of Posts - the amount of posts a user has contributed

•

Post History - a list of posts the user has contributed

How Users Suppress Profile Information
Users can determine if their profile is viewable via the Private
Profile drop down box on the Membership Registration screen
(shown below) and the Edit Profile screen. If Private Profile is set
to Private, profile information is suppressed. If it is set to
Colleagues, only a user’s colleagues can see his profile. When set
to public, everyone can see a user’s profile information.
NOTE

If the Forum server control’s HideUserProfile property is set to true, nonadministrator Forum visitors cannot see a user profile, even if the Private Profile
drop down box is set to Public.
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NOTE

The Membership Registration screen appears wherever your developer inserts
the Membership Server Control. For more information, see the Ektron
CMS400.NET Developers Manual section “Membership Server Control.”

How Administrators Suppress Profile Information
If you want to suppress the display of user names as an
administrator, follow these steps.
NOTE

If the Forum server control’s HideUserProfile property is set to true, nonadministrator Forum visitors cannot see the profile, even if the Private Profile
check box is unchecked.

1. If the user is a regular user, go to Settings > Users and select
the user whose information you want to suppress.
If the user is a membership user, go to Modules > Community
Management > Memberships > Users and select the user
whose information you want to suppress.
2. In the User Properties area of the screen, check the Private
Profile checkbox.

Outputting a Forum as an RSS Feed
You can output a Forum as an RSS feed by clicking the RSS feed
button ( ). Each level of the Forum has an RSS feed button. This
allows you to output a specific topic as an RSS feed.
This following is an example of the output.
<?xml version="1.0" encoding="UTF-8" ?>
- <rss version="2.0">
<!-- Generated by Ektron CMS400.NET -->
- <channel>
<title>Ektron Medical Center Forum</title>
<link>http://test/webform.aspx</link>
<description>Ektron Medical</description>
- <item>
<title>Research</title>
<link>http://test/webform.aspx?g=topics&f=108</link>
- <description>
<![CDATA[ Latest medical research ]]>
</description>
<pubDate>Wed, 11 Oct 2006 17:50:04 GMT</pubDate>
</item>
</channel>
</rss>
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Subscribing to a Discussion Board
After logging in, discussion board users can subscribe to Forum
posts and replies by clicking the Subscribe button (
)
(highlighted below).

The button appears at each Discussion Board level, so that a user
can subscribe to Forums and topics of interest. After clicking the
button, the following screen appears.

The user selects a notification type, listed below.
•

All Posts - notifies you when any post or reply is added

•

Replies to Me - notifies you when someone replies to your
post
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Next, he clicks the Add Subscription button. A page notifies him
that his subscription was added.

Reviewing Subscriptions
To review your Forum subscriptions, go to the Control Panel and
click Notifications in the lower left corner. A screen indicates each
Discussion Board level to which you have subscribed, as
illustrated below.

Deleting a Subscription
To delete any subscription, check the corresponding check box
and click the Delete button (highlighted above).

Sending a Private Message
Logged in users can send a private message to the person who
created a post or reply. Only the sender and receiver can view
private messages. This requires both users to be either a
CMS400.NET user or a Membership user.
To send a private message, follow these steps.
1. Navigate to a post.
2. Click the User’s name.
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3. When the User Profile appears, click the Message button.

4. The Message screen appears.
NOTE

The To: field is filled automatically. Users cannot add additional members.

5. Enter a Subject.
6. Enter a Message.
7. Click the Post button.
8. Users are notified that a message was sent.

Using the Control Panel
The Control Panel allows logged in users to view your profile, read,
reply to and delete private messages. It also allows users with
moderate permissions to moderate the Forum. The Control Panel
button is located at the Forum level.
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Clicking the Control Panel button opens control panel.

The Inbox view appears by default. From this view, users can read
a message by clicking on it. Once a message is read, its icon
changes from unread ( ) to read ( ).
In addition, users can view information about the person who sent
the message by clicking their name. Users can also delete the
message by clicking the corresponding check box then the delete
button. To switch to a different view, click its link.
The user can also check his subscriptions. See ”Reviewing
Subscriptions” on page 531.
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Viewing and Replying to Messages
From the Inbox or Sent Items in the Control Panel, users can view
a message by clicking on it. On the View Message screen, users
can see who sent the message, to whom the message was
directed, when it was sent, the subject and the contents of the
message.

Users can reply to a message by clicking the reply button ( ).
Once clicked, the editor opens in the control panel, and a user can
reply.
IMPORTANT!

When replying to a private message, users add their response to the existing
message. Only one message is created.
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Once a user adds a reply to the private message, he clicks the
Post button. He is then informed that the message was sent.

Deleting a Private Message
To delete a private message, follow these steps.
1. Click the Control Panel button on the front page of the
Discussion Board.
.

2. Click the check box next to the message.
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3. Click the Delete Selected button.
4. A confirmation box asks if you want to delete all selected
messages. Click OK.
5. The message is deleted.

Viewing a User Profile From the Control Panel
To view a profile from the Control Panel, click the Profile link in the
Control Panel. ”What Information is Contained in the Profile?” on
page 527
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Once the Profile link is clicked, the user’s profile page appears.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

537

Discussion Boards

Moderating From the Control Panel
Users who have permission to moderate a Forum can do so from
from the Control Panel by clicking the Moderate link.

Once Moderate is clicked, the user sees a list of items that need
approval.
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Clicking an item opens the post. From this screen, you can edit,
approve, or delete the post. See Also: ”Approving a Post” on
page 523.
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The Calendars feature allows you to create event calendars for
your Web site. Once created, users may add calendar events
that are posted to the calendar for visitors to see.
NOTE

The User Manual section “Working with Calendars“ explains calendar
concepts and procedures that end users need to know. This section does not
repeat that information. So, you should be familiar with that information
before reading this.
Also, the Ektron CMS400.NET Developer’s Manual provides instructions on
using the Calendar server control/custom function.

This chapter explains Ektron CMS400.NET calendars through
the following topics.
•

”Calendar Toolbar Buttons” on page 540

•

”Accessing the Workarea Using Calendars” on page 542

•

”Calendar Permissions” on page 542

•

”Adding a New Calendar” on page 543

•

”Editing a Calendar” on page 548

•

”Deleting a Calendar” on page 549

•

”Calendar Event Types” on page 549

•

”Displaying Calendars on Web Pages” on page 552

•

”Creating a Foreign Language Calendar” on page 552

Calendar Toolbar Buttons
Within the Calendars feature, several buttons (described
below) help you perform actions.
Button

Name

Lets you

More Information

Add
Calendar

Access Add Calendar screen

”Adding a New Calendar”
on page 543
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Button

Name

Lets you

More Information

Save

Save calendar or calendar event

Show
Calendar

Display calendar in Workarea

“Viewing a Calendar” in
the E k t r o n
C M S 4 0 0 . N E T User
Manual chapter “Working
with Calendars

Manage
Event
Types

Add, edit, and delete Event Types to and
from a calendar

”Calendar Event Types”
on page 549

Add
Calendar
Event

Access Add Calendar Event screen in
the Workarea

“Adding a Calendar
Event” in the E k tro n
C M S 4 0 0 . N E T User
Manual chapter “Working
with Calendars”

Edit

Edit calendar or event name

”Editing a Calendar” on
page 548; ”Editing the
Event Type Name” on
page 551

Delete

Delete calendar or calendar event

”Deleting a Calendar” on
page 549

Delete all
recurring
events

Delete all events in a recurring series

“Deleting All Events in a
Recurring Series” in the
E ktron CM S40 0. NET

User Manual chapter
“Working with Calendars”
Add
Calendar
Event

Access the Add Calendar Event screen
from calendar on Web page
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Button

Name

Lets you

More Information

View Date

View calendar events for selected day

“Viewing a Calendar
Event” in the E k tro n
C M S 4 0 0 . N E T User
Manual chapter “Working
with Calendars”

Add Library

Select a library Quicklink for an event.

Hyperlink field
description in the E k t r o n
C M S 4 0 0 . N E T User
Manual chapter “Working
with Calendars”

Accessing the Workarea Using Calendars
To access the Workarea after viewing a calendar, you cannot right
click the mouse then choose Workarea from the context-sensitive
menu as you can with content. Instead, after logging in, click either
the Add Events or View Events icon (circled below) to access the
Workarea.

Calendar Permissions
Calendar permissions are derived from the content folder assigned
to the calendar. This section explains the permissions you can set
for a calendar.

Administrator Permissions
Members of the following groups have full control over all calendar
features (as they do for content). Only these users can add, edit, or
delete a calendar.
•

administrator user group
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•

users and user groups defined on the Manage Members for
Role: Calendar-Admin screen. (For more information, see
”Defining Roles” on page 787.)

Administrators may also add, edit, and delete calendar events.

User Permissions
Users who are not in one of the groups listed in ”Administrator
Permissions” on page 542 cannot add, edit, or delete calendars.
Non-administrator users can add, edit, or delete calendar events if
they have add, edit, and delete permissions for the calendar’s
content folder. See Also: ”Setting Permissions for a Content
Folder” on page 772

Membership User Permissions
Membership users cannot add, edit, or delete calendar events.

Adding a New Calendar
To add a new calendar, follow these steps.
See Also: ”Calendar Permissions” on page 542
1. From the Ektron CMS400.NET Workarea, click Modules >
Calendar.
2. Click the Add Calendar button (

).

3. The Add or Edit Calendars screen appears. The following table
explains each field on the screen.

Section

Description

Title

Enter a calendar title, which identifies the calendar in the
Workarea.
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Section

Description

Description

Enter a calendar description, which appears on the
Calendar Modules screen to help identify the calendar.

Location Label

Specify the label text for the location field. The location
appears with the detail of a calendar event.

Start Time Label

Specify a label for the start time. A calendar event can
display the start time.

End Time Label

Specify a label for the end time. A calendar event can
display the end time.

Display Weekends

Place a check in this box if you want the calendar to display
Saturdays and Sundays along with weekdays.
To display weekdays only, remove the check. See Also:
”Display Weekends” on page 547

Forward Only

To have the calendar display only events from the date
when someone views the calendar forward (but no past
events), place a check in the box next to
Show only events that fall after the viewing day
However, a logged-in user can view past calendar events.

Event Type Label

One section of the Add Calendar Events screen displays
available event types and lets the user assign them to the
event.

By default, this text is Event Type:. To change the default
text, edit this field.
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Section

Description

Event Types Available

If you want to allow users to assign event types to events
on this calendar, check this box.

Event Types Required

If you want to require users to assign event types when
adding events, check this box.
This checkbox can only be checked if Event Types
Available is checked.

Instructions

If you allow users to filter a calendar view by event type,
text appears at the bottom of the screen that explains how
to use the selection box. By default, this text is Select
Event Type To View.

If you want to change this text, edit this field.
Show All label

If you allow users to filter a calendar view by event type, the
list of event types appears at the bottom of the screen. On
top of the list is text indicating that all event types will
appear on the calendar. By default, this text is Show All.

If you want to change this text, edit this field.
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Section

Description

Long Description

This field can allow the user to enter additional information
about a calendar event.

Your choices are:
•

No Long Description - no additional description is
allowed

•

Text Only - while adding an event, a user can enter
text into a Long Description box. No formatting is
allowed within this text.

This text appears in the Event View screen and in the XML
Packet. Because the text is not formatted, the XSL creator
is responsible for its display.
•

Content Folder

Rich Text Description - works the same as the Text
Only option (see above) except the user can format
text using Ektron’s eWebEditPro editor.

Specify the calendar’s content folder.
To understand how folder assignment affects calendar use,
see ”Calendar Permissions” on page 542.
By default, the root (0) folder is selected. To assign a
different folder, click change. If you do, a new screen
appears. Navigate to and select the folder of your choice.

4. Click the Save button (

).
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Display Weekends
To display seven day weeks (for example, Sunday to Saturday), as
opposed to five day weeks (Monday to Friday), check this box.
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Do Not Display Weekends

Editing a Calendar
All calendar information, with the exception of the ID, can be edited
at any time. To edit a calendar, follow these steps.
1. From the Ektron CMS400.NET Workarea, click Modules >
Calendar.
2. Click the calendar you want to edit.
3. Click the Edit button (

).

4. The Add or Edit Calendar screen is displayed.
5. Make the necessary changes to the calendar, using the table in
”Adding a New Calendar” on page 543 as a reference.
6. Click the Save button (

).
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Deleting a Calendar
You can delete calendars that are no longer needed.
NOTE

Deleting a calendar deletes all events assigned to it.

To delete a calendar, follow these steps.
1. From the Ektron CMS400.NET Workarea, click Modules >
Calendar.
2. Click the calendar you want to delete.
3. Click the Delete button (

).

4. A confirmation message is displayed.
5. Click OK.

Calendar Event Types
Any calendar event can have one or more Event Types assigned
to it. An event type might be a meeting, product demonstration, or
deadline. When a user views a calendar, he can change the
display to view only events that are relevant to him.
This section explains how to manage calendar Event Types
through the following subtopics.
•

”Enabling Event Types” on page 549

•

”Viewing Event Types” on page 550

•

”Adding Event Types” on page 550

•

”Editing the Event Type Name” on page 551

•

”Deleting Event Types” on page 551

•

”Assigning an Event Type to an Event” on page 552

Enabling Event Types
To enable event types, edit the calendar and check off the Event
Types Available box. If desired, you can also check the Event
Types Required box. This forces the user to specify an event type
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when adding a calendar event. See Also: ”Adding a New Calendar”
on page 543
Once event types are enabled, the Manage Event Types button
(

) appears on the toolbar.

Viewing Event Types
To view available Event Types, follow these steps.
1. From the Ektron CMS400.NET Workarea, click Modules >
Calendar.
2. Access the View Calendar screen for the calendar whose
event types you want to view.
3. Click Event Types button (
NOTE

).

If the Event Types button does not appear in the toolbar, you must make Event
Types available. See ”Enabling Event Types” on page 549 for more information.

4. The View Event Types for [Calendar Name] screen is displayed
with a list of Event Types.
From this screen, you can add, edit, and delete Event Types.

Adding Event Types
1. Access the Event Types screen, as described in ”Viewing
Event Types” on page 550.
2. Click the Add button (

).

3. The Add or Edit an Event Type screen is displayed.
4. Type an Event Type name in the displayed field.
5. Click the Save button (

).

After you add an Event Type to a calendar, it can be assigned to a
calendar event by users. See ”Assigning an Event Type to an
Event” on page 552 for more information.
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Editing the Event Type Name
To edit the name of an event type, follow these steps.
1. Access the View Event Types for [Calendar Name] for the
calendar with the Event Type you want to edit, as described in
”Viewing Event Types” on page 550.
2. Click the Event Types button (

).

3. The View Event Types for [Calendar Name] window opens,
listing all Event Types.
4. Click the Edit button (

).

5. The Edit an Event Type screen appears.
6. Click the radio button next to the Event Type you want to edit.
7. Click the Edit button (

).

8. The Add or Edit an Event Type screen is displayed. Update the
Event Type name.
9. Click the Save button (

).

Deleting Event Types
To delete an event type from a calendar, follow these steps.
1. Access the View Event Types for [Calendar Name] for the
calendar with the Event Type you want to delete, as described
in ”Viewing Event Types” on page 550.
2. Click the Event Types button (

).

3. The View Event Types for [Calendar Name] window opens,
listing all Event Types.
4. Click the Remove button (

).

5. The Delete Event Types screen displays available Event
Types.
6. Check the box next to each Event Type you want to delete.
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NOTE

Click either Select All or Clear All to check off all or none of the Event Types.

7. Click the Delete button (

) to delete the Event Type.

8. A confirmation message is displayed.
9. Click OK.

Assigning an Event Type to an Event
After Event Types are available, users can assign them to calendar
events. This is described in the Ektron CMS400.NET User Manual
chapter “Working with Calendars.”
After users assign Event Types to a calendar event, visitors can
filter the calendar view by them.

Displaying Calendars on Web Pages
After a calendar is created, it can easily be inserted onto a Web
page. For information about inserting calendars into your Web site,
refer to the Ektron CMS400.NET Developers Reference Manual.

Creating a Foreign Language Calendar
As part of the comprehensive multi-language features of Ektron
CMS400.NET, calendars can be created in any supported
language.
Exception

Microsoft’s .NET platform supports most languages. If a language is not
supported by .NET (for example, Welsh), an English calendar appears instead.

Once you enter the calendar and event information in the foreign
language, the calendar display (that is, day and month names)
automatically appears in that language. Also, regional conventions
for first-last days of the week, and date and time formats are
maintained. As an example, see the French calendar below.
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Notice that the days and months are translated, and that the week
begins on Monday instead of Sunday (as in American English).
And in the daily detail (below), note that date and time format
follows French conventions.
WARNING!

In order to see foreign characters and accents, the client PC must have support
enabled for that language in Windows. For more information, see http://
www.microsoft.com/globaldev/handson/user/xpintlsupp.mspx.
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See Also: ”Using an Existing Calendar ID or Creating a New One”
on page 554

Using an Existing Calendar ID or Creating a New One
When you create a calendar in a foreign language, you can either
use an existing calendar ID or create a new one.

Type

Use when...

For more information, see

Foreign language
version of existing
calendar ID

You want one Web page that
displays a calendar in the language
selected by the site visitor

”Creating a Multilingual Calendar
Using the Same ID” on page 556

New calendar ID

The foreign calendar will be placed
on its own Web page; there is no
equivalent calendar in the default
language

”Creating a Multilingual Calendar
Using a New ID” on page 557
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For example, the following is the English-language version of the
sample calendar provided with the intranet. The URL of the
following calendar is
http://localhost/CMS400EXAMPLE/intranet/
calendar.aspx?menu_id=15&calendar_id=3&TitleLabel=Company%20Calendar&LangType=1033

If you create a French version of that calendar, and a user
navigates to the same page but views it in French, he sees the
French version of the calendar (below). Note that they are
separate calendars with separate event listings -- they only share
the ID number.
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The URL of the following calendar is
http://localhost/CMS400EXAMPLE/intranet/
calendar.aspx?menu_id=15&calendar_id=3&TitleLabel=Company%20Calendar&LangType=1036

Creating a Multilingual Calendar Using the Same ID
To create a multilingual calendar using the same ID number but a
different language, follow these steps.
1. Within the Workarea, select Modules > Calendars.
2. Select the calendar for which you want to create a version in
another language.
3. When the View Calendar Screen appears, pull down the Add
In box and select the new language.
Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

556

Calendars

4. Complete the calendar information, as explained in ”Adding a
New Calendar” on page 543.

Creating a Multilingual Calendar Using a New ID
To create a multilingual calendar using a unique ID number, follow
these steps.
1. Within the Workarea, select Modules > Calendars.
2. From the Calendar Modules screen, click to open the View In
dropdown box.

3. Select the language for the calendar.
4. The Calendar Modules screen reappears, showing only
calendars in the selected language (if any exist).
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Complete the calendar information, as explained in ”Adding a New
Calendar” on page 543.
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Search engine optimization (SEO) plays a key role in every Web
marketing strategy. Ektron CMS400.NET’s URL aliasing makes it
easy to create descriptive, meaningful and SEO-friendly URL
aliases consistently, maximizing your Web site’s placement in
search results.

For a video introduction to Ektron CMS400.NET’s Aliasing feature, go to:
http://media.ektron.com/flash/urlaliasing/480x360/ektronaliasing/ektronaliasing.html

There are four important aspects of URL Aliasing.
•

Automatic Aliasing - Normally-generated URLs are barely
human readable, let alone search engine-friendly. With search
engines using the text in a URL to define where a page shows
up on a search return, it has never been more important to
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have descriptive URLs. While you can manually create aliases
that will do the job, CMS400.NET gives you the tools you need
to generate them automatically, with consistent structure.
These human-readable URLs are predicable and scalable,
following consistent patterns that can apply to all of your sites.
The use of words and phrases that actually define the page
itself increases these aliases’ search engine rankings. By
following a pattern, they are scalable, and that pattern can be
used across your sites as they grow.
Sites that are currently built migrate easily to CMS400.NET,
adopting the new aliasing scheme. No longer do you have to
make changes to the web.config, and aliasing can keep old
links valid. Once the URL aliasing function is configured and
enabled, all content inherits the new aliasing structure.
URL aliases generated by CMS400.NET don’t require an
extension of how the page is built; search engines find “real”
words. Web site performance affects search engine returns as
well, and Ektron’s URL aliasing takes this into account: these
aliases are cached, improving performance.
•

Taxonomy-Based Alias - URL aliases can be auto-created by
Ektron CMS400.NET based on the taxonomy of your Web site. It
uses the levels of the taxonomy plus the title of the page itself
to produce an alias. Search engines will find those words,
increasing the page’s relevancy in any search for them. And
because it is based on the taxonomy (which lets content be
established in one-to-many relationships), multiple aliases can
be created that will have relevancy to multiple search criteria.

•

Folder-Based Alias - Ektron CMS400.NET can also automate
the creation of folder-based URL aliases. Similar to taxonomybased aliases, deriving an alias from the folder structure
produces one that is relevant to the content’s actual location.
With descriptive folder names and good organization, this
produces SEO-friendly addresses comprised of folder structure
plus title of page.

•

Manual & RegEx Based Alias - For some pages with content
that follows a pattern, Regex aliasing may be the answer. It
looks for a pattern in the current URL, and then replaces it with
a different pattern to create a relevant alias. For example, a
blog site may be best served by Regex aliases that rely on
entry date.
Manual aliasing is also available in Ektron CMS400.NET. By
enabling it, you can define the pages very specifically,
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including adding metadata to further improve SEO for that
page.

Effects of Aliasing Content
Once your content is aliased, a site visitor can enter either the
original URL or the alias into the browser to view the page. Also, if
someone selects a content link on your Web page, the alias
frequently replaces the original URL in the browser.
Also, when an Ektron CMS400.NET user is editing content and
inserts a quicklink whose content has several aliases, a screen
appears, and he must select one of the aliases. (If only one alias is
assigned to the content, it is applied to the quicklink.)
This chapter explains how to alias Ektron CMS400.NET content
through the following topics.
•

”Benefits of Aliasing” on page 561

•

”Types of URL Aliasing” on page 562

•

”Features Not Supported by Aliasing” on page 564

•

”Aliasing and Relative Links” on page 566

•

”Configuring URL Aliasing” on page 566

•

”Manually Clearing the Cache” on page 577

•

”Automatic URL Aliasing” on page 580

•

”Manual Aliasing” on page 589

•

”Using RegEx Expressions” on page 600

•

”Site Aliasing” on page 605

•

”Upgrading from Previous Releases” on page 609

•

”Assigning an Alias to Multi-Language Content” on page 609

•

”Using Classic ASP with Windows 2008 Server 64 Bit” on
page 610

Benefits of Aliasing
Here are some examples of why you’d want to alias Ektron
CMS400.NET pages.
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NOTE

•

To provide shorter, more user-friendly URLs, which map to
longer paths. For example, www.ektron.com/training/ may be
preferable for marketing materials.

•

If you have a PHP site, you can alias all php pages and use the
same query string names to pass needed information to the
new .aspx pages.

Any query strings appended to an aliased page pass to the .aspx page and may
be used if necessary.

•

If you have a static Web site (for example, all HTML pages)
that is indexed in a search engine, you can alias your site and
retain complete content management without affecting your
search engine ranking.

•

Some search engines work better without the URL parameters
that make up an Ektron CMS400.NET Web page name. URL
Aliasing creates page names that search engines might more
easily recognize.

Types of URL Aliasing
There are three types of URL aliasing, described below.
•

Automatic Aliasing - can automatically change the page
name format of a group of content blocks. You determine the
group by selecting a taxonomy or a top-level Ektron
CMS400.NET folder.
For example, you might choose a folder and alias its content
using the content title followed by slash (/). So, while the
original URL might be www.example.com/Human_resources/Postings/
hr.aspx?id=8745, the aliased one might be www.example.com/jobs/.
For more information, see ”Automatic URL Aliasing” on
page 580.

•

Manual Aliasing - You can manually alias any content block
using whatever unique name you wish. For example, you can
alias your technical support page as www.example.com/help.htm,
even though its real name is www.example.com/help.aspx?id=27.
You can assign several manual aliases to content then decide
which one is the primary. For more information, see ”Manual
Aliasing” on page 589.
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If both alias types are provided for a content item, a user can enter
any alias into the browser address field to access that content. If
someone hovers the cursor over (or clicks) a link to aliased
content, the primary manual alias appears.
•

Site Aliasing - If your site supports the multi-site feature (see
”Multi-Site Support” on page 998), you can enter aliases for
any site. For example, your company‘s name just changed
from Bionics to NewGen. You could use the site aliasing
feature to resolve the URL www.bionics.com to www.newgen.com.
For more information, see ”Site Aliasing” on page 605.
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Example of an Alias in the Browser

Features Not Supported by Aliasing
Aliasing is not supported in the following areas of Ektron
CMS400.NET.
•

search results

•

images
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•

content in root folder * (cannot be automatically aliased,
although you can alias it manually and by taxonomy)

•

forums (discussion boards) * (links within forum posts can be
aliased)

•

forms/polls/surveys *- the form is aliased but the postback
screen is not (for a workaround, see http://weblogs.asp.net/
scottgu/archive/2007/02/26/tip-trick-url-rewriting-with-aspnet.aspx > “Handling ASP.NET PostBacks with URL
Rewriting”)

•

a link to an HTML form

•

content links within the directory server control

•

If a template is assigned to a taxonomy (see below), the
template takes precedence over an alias for content found by a
directory server control

* - looking to support in future release

•

eCommerce - items in a Shopping Cart control use an alias
unless you assign an .aspx page in the control’s TemplateProduct
property. If you assign a page there, that page is used in the
product’s URL, not the alias.
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•

If you enable .asp as an extension, the alias does not appear
when a site visitor hovers the cursor over an asset. Instead, the
actual file name appears. See Also: ”Extension” on page 570
If a site visitor hovers the cursor over HTML content, the alias
does appear.

•

The alias does not appear when a site visitor viewing an RSS
page hovers the cursor over an asset. Instead, the actual file
name appears.

•

You cannot create an alias based on a taxonomy whose name
includes assets or privateassets.

Aliasing and Relative Links
After you enable Aliasing, any relative links embedded in your Web
pages that are not preceded by a slash (/) may demonstrate
symptoms such as:
•

Runtime error notifications

•

Broken images (you see a red X where the image should be)

•

Missing text styling

The following Ektron CMS400.NET Knowledge Base article
analyzes this problem and presents solutions: http://
dev.ektron.com/kb_article.aspx?id=19254.

Configuring URL Aliasing
Before you can set up aliases, you must enable the features using
the URL Aliasing Configuration screen (shown below).
See Also:
•

”Manually Clearing the Cache” on page 577

•

”Setting Default Documents” on page 578
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WARNING!

If you performed a database sync and the site being synched uses URL aliasing,
you must go to its URL Aliasing Configuration screen and click the Refresh button
(

) to update its aliasing information.

To edit the Aliasing Configuration screen, go to Ektron
CMS400.NET Workarea > Settings > Configuration > URL
Aliasing > Settings. Then, click the Edit button (
NOTE

).

After changing the configuration screen, if your Ektron CMS400.NET supports
multi-site configurations, you must log into each site, navigate to the URL Aliasing
Configuration screen, and click the Refresh button (

).

Use the following table to complete the screen.

Field

Description

Manual
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Field

Description

Enabled

Check this box to enable manual aliasing. See Also: ”Manual Aliasing” on
page 589

Caching

Check this box to improve your server’s performance. It minimizes the
number of database hits by placing all manual aliasing information in your
server’s memory.
Note: A developer might want to uncheck this box while developing a site,
to make sure that everything is coming out of the database.

Cache Size

If you checked the Manual Caching box, enter the maximum number of
manual aliases that your server will cache. By default, this is set to 1000.
An alias is cached whenever anyone uses it. It remains in the cache for
the number of seconds set in the Cache Duration field.
If more than this number of aliases needs to be added to the cache,
Ek tron CM S40 0.NET makes room for new ones by removing aliases
that have been in the cache for the longest time.
If you increase the number, it is possible that your performance will
improve. But at some point, the size of the cache may degrade your
server’s performance. See Also: ”Manually Clearing the Cache” on
page 577

Cache Duration
(Seconds)

Enter the number of seconds for which any alias is retained in the
server’s cache. After this number of seconds has passed, the alias is
flushed from the cache. See Also: ”Manually Clearing the Cache” on
page 577
Note: If your E k t r o n C M S 4 0 0 . N E T supports multi-site configurations,
this setting only affects the site to which you are logged on. To set a
cache duration for other sites, sign in to each site’s Workarea > Settings
> Url Aliasing > Settings, then set its cache duration values.

Automatic
Enabled

Check this box to enable automatic aliasing. See Also: ”Automatic URL
Aliasing” on page 580

Caching

Check this box to improve your server’s performance. It minimizes the
number of database hits by placing the most frequently used automatic
aliases in your server’s memory.
You set the number of cached automatic aliases at the Automatic Alias
Cache Size field.
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Field

Description

Cache Size

If you checked the Automatic Caching box, enter the maximum number
of automatic aliases that your server will cache. By default, this is set to
1000.
An alias is cached whenever anyone uses it. It remains in the cache for
the number of seconds set in the Cache Duration field.
If more than this number of aliases needs to be added to the cache,
Ek tron CM S40 0.NET makes room for new ones by removing aliases
that have been in the cache for the longest time.
If you increase the number, it is possible that your performance will
improve. But at some point, the size of the cache may degrade your
server’s performance. See Also: ”Manually Clearing the Cache” on
page 577

Cache Duration
(Seconds)

Enter the number of seconds for which any alias is retained in the
server’s cache. After this number of seconds has passed, the alias is
flushed from the cache. See Also: ”Manually Clearing the Cache” on
page 577

RegEx
Enabled

Check this box to enable the RegEx feature. See Also: ”Using RegEx
Expressions” on page 600

Caching

Check this box to improve your server’s performance. It minimizes the
number of database hits by placing the most frequently used RegEx
aliases in your server’s memory.
You set the number of cached aliases at the RegEx Cache Size field.

Cache Size

If you checked the RegEx Caching box, enter the maximum number of
RegEx aliases that your server will cache. By default, this is set to 1000.
An alias is cached whenever anyone uses it. It remains in the cache for
the number of seconds set in the Cache Duration field.
If more than this number of aliases needs to be added to the cache,
Ek tron CM S40 0.NET makes room for new ones by removing aliases
that have been in the cache for the longest time.
If you increase the number, it is possible that your performance will
improve. But at some point, the size of the cache may degrade your
server’s performance. See Also: ”Manually Clearing the Cache” on
page 577

Cache Duration
(Seconds)

Enter the number of seconds for which any alias is retained in the
server’s cache. After this number of seconds has passed, the alias is
flushed from the cache. See Also: ”Manually Clearing the Cache” on
page 577
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Field

Description

Extension

Enter file extensions of pages for which aliases can be created. Begin
each extension with a period (.), and separate them with a comma (,).
By default, E k t r o n C M S 4 0 0 . N E T supplies the following extensions.
•

.aspx

•

/ (the slash is actually the lack of an extension at the end of a page’s
name)

If you are editing this screen and delete an extension, all aliases that use
it are immediately disabled.
Where Extensions Appear
The values in this field appear as dropdowns in the Add a New Manual
Alias and Add a New Automatic Alias screens.

See Also: ”Restrictions on Extensions” on page 572
Override Template

A template and an alias can have the same name, for example,
www.example.com/dynamic.aspx. If this happens, and a site visitor types
such an address into the browser, this check box determines if the
template page or the alias appears.
If this box is checked, the alias appears instead of the template.
Note: The template must be defined within the Workarea Settings >
Template Configuration screen.
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Field

Description

Disable Language
Awareness

Use this check box to determine what happens under the following
conditions:
1.

A site visitor browses to content using an alias.

2.

The site visitor changes the site language.

If this box is checked - If the content exists in the new language, it
appears. If not the content appears in the original language.
If this box is unchecked - Site visitor sees a 404 error.
Examples if box is checked and a site visitor browses to content using an
alias.
•

Content ID 33 exists in both English and Spanish. Site visitor views
this content in English then switches the site language to Spanish.
The Spanish version of content ID 33 appears.

•

(Assume English is the default language). Content ID does not exist
in German. Site visitor views this content in English then switches
the site language to German. The English content appears.
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Field

Description

Query String Action

Use this field to set up a rule to handle an alias’s query string parameters.
You can set one rule for your entire site (via this field), and separate ones
that override the system-wide rule for specific manual aliases (using the
Manual Aliased Page Name Maintenance screen).
Four options are available.
•

None - If an aliased URL has a query string, it is ignored. Any query
string on the target URL is used.

•

Resolve matched parameters within alias - E kt r o n
C M S 4 0 0 . N E T tries to resolve matching parameters (it is case sensitive). If a match is found, the alias’s query string parameter takes
precedence. Example:

alias’s query string parameter:
http://www.example.com/Contact.aspx?id=84
Target: http://www.example.com/aboutus.aspx?id=35&UserId=10
Result: http://www.example.com/aboutus.aspx?id=84&UserId=10

(id=35 is replaced by id=84 since it matched the query string parameter.
UserId=10 was not affected because it did not match the alias query
string parameter.)
•

Replace all parameters within alias - E ktron CM S40 0.NET
replaces all of a target’s query parameters with the alias’ s query
parameter. Example:

alias’s query string parameter:
http://www.ektron.com/Contact.aspx?id=84
Target: http://www.ektron.com/aboutus.aspx?id=35&Userid=1
Result: http://www.ektron.com/aboutus.aspx?id=84

(The target parameters id=35&Userid=1 are replaced by the alias
parameter id=84)
•

Append parameters to alias - E k t r o n C M S 4 0 0 . N E T appends the
alias’s parameters to the target URL. Example:

Alias: http://www.ektron.com/Contact.aspx?id=84&lang=1033
Target: http://www.ektron.com/aboutus.aspx?id=35&Userid=1
Result: http://www.ektron.com/aboutus.aspx?id=35&Userid=1 &
id=84&lang=1033

(The parameter from the alias is appended to the target)

Restrictions on Extensions
NOTE

The following restrictions only apply if your server runs IIS7.

This section explains how IIS7 handles Web page extensions other
than .aspx. There are two scenarios.
•

Some of your site’s pages have non-.aspx extensions. So, IIS7
needs to handle requests for those pages. See ”Your Site Has
non-aspx Pages” on page 573.
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•

You site previously had non-.aspx pages but no longer does.
You want to set up aliases for these pages, so site visitors’
bookmarks will still work. See ”You Want to Set up Aliases for
non-aspx Pages” on page 575.

Your Site Has non-aspx Pages

If any of your site’s pages have extensions other than .aspx (for
example, .asp, .php, .cfm), follow these steps to move them above
ek* in the Handler Mappings list. (Extensions below ek* are
handled by aliasing.)
1. Open IIS7.
2. Right click your Web site.
3. Click Handler Mappings.
4. Click View Ordered List.
5. Move non-aspx extensions used on your site above ek*. For
example, if your site uses .asp pages, move ASPclassic
above ek*. See below.
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Once you do this, you cannot use these extensions as part of an
alias. So, do not enter them into the Extension field of the URL
Aliasing Configuration screen.
You Want to Set up Aliases for non-aspx Pages

If you want to use extensions other than .aspx for aliasing Web
pages, follow these steps.
1. Open IIS7.
2. Right click your Web site.
3. Click Handler Mappings.
4. Click View Ordered List.
5. On the Handler Mappings screen, move non-aspx extensions
that you want to alias below ek*. For example, if your site uses
.asp pages, move ASPclassic below ek*.
6. Enter the extensions in the Extension field of the URL Aliasing
Configuration screen. See Also: ”Configuring URL Aliasing” on
page 566

Activating Custom Extensions
By default, E k t r o n

C M S 40 0. N E T

supplies the following extensions.

•

.aspx

•

/ (the slash is actually the lack of an extension at the end of a
page’s name)

If you want to enable other extensions, follow these steps.
1. Go to the Ektron CMS400.NET Workarea > Settings >
Configuration > URL Aliasing > Settings screen.
2. Enter the new extension into the Extension field and click
Save (

). See Also: ”Extension” on page 570

3. If Wildcard Mapping in IIS is turned on, you are done.
If Wildcard Mapping in IIS is turned off, you must enter the new
extension into IIS. To do this, go to the Windows Start button >
Administrative Tools > IIS manager.
4. Open the Web Sites folder, right click your Web site then
choose Properties.
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5. Click the Home Directory tab.
6. Click the Configuration button.
7. Scroll down to and double click the .aspx extension.

8. Copy the path to aspnet_isapi.dll. (The path is found in the
Executable field.)

9. On the Application Configuration window, click Add.
10. The Add/Edit Application Extension Mapping screen appears.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

576

URL Aliasing

11. In the Executable field, paste the path to aspnet_isapi.dll
(which you copied in Step 8).
12. In the Extension field, enter the extension that you are
activating. See example below.

13. Uncheck the Verify that file exists checkbox.
14. Click OK.

Manually Clearing the Cache
Each aliasing type (Automatic, Manual, and RegEx) has Cache
Size and Cache Duration fields, which let you determine
conditions that automatically clear each cache. However, you can
manually clear a cache at any time. To do so, follow these steps.
WARNING!

If your Ektron CMS400.NET supports multi-site configurations, you must sign in to
each site’s Workarea, then manually clear its cache.

1. Click the appropriate Settings > URL Aliasing screen. For
example, to clear the Manual Aliasing cache, click Settings >
URL Aliasing > Manual.
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2. Click the Clear Cache button (

).

Setting Default Documents
The concept of default document is explained in the following
Microsoft KB article: http://www.microsoft.com/technet/
prodtechnol/WindowsServer2003/Library/IIS/dc6eb1b4-90284308-9935-52b64edfad36.mspx. Essentially, it lets you establish a
default document for client requests to a Web site that do not
specify a document name. For example, www.example.com/jobs. If the
default document is default.aspx, this URL resolves to
www.example.com/jobs/default.aspx.
When using Ektron CMS400.NET Release 7.6 or higher, you
identify one or more default documents in the siteroot/web.config
file’s ek_DefaultPage element (shown below).
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NOTE

The ek_DefaultPage element determines your Web site’s default document
whether or not you are using URL Aliasing.

So when a site visitor enters an address that includes your domain
but no page name, Ektron CMS400.NET refers to ek_DefaultPage’s
values. In the above example, the first page is default.aspx. If
found, that page displays. If not, it looks for the second page listed,
etc.
If none of the pages is found or a page is not specified in
what happens next depends on the IIS version that
your server is running.
ek_DefaultPage,

IIS version

Result if pages listed in ek_DefaultPage are not
found

6

•

if ek_DefaultPage is blank in web.config, default documents
listed in IIS6 are used.

•

if ek_DefaultPage has one or more pages but none of them
exists on the server, a Page not Found (404) message appears.

7

Page not found message appears in browser.
Because E k t r o n C M S 4 0 0 . N E T assumes responsibility for letting
you define the default document, default documents specified in IIS
7 are ignored.
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Automatic URL Aliasing
Automatic aliasing lets you assign an alias to several content items
at once. You identify content by either taxonomy or folder. Then,
select additional elements of the alias pattern and save all
information as a configuration.
You can create one automatic aliasing configuration for each folder
or taxonomy. Since a single content block can be assigned to
several taxonomies, it can have many automatic aliases.
When an automatic alias configuration is activated, an alias is
assigned to all content in the taxonomy or folder (and its
subfolders). From then on, that content can be identified by its
automatic alias. In addition, any content added to the folder/
taxonomy in the future will be assigned that alias as long as the
configuration is active.
Automatic Aliasing is further described through the following
topics.
•

”Permissions for Working with Aliasing” on page 580

•

”Enabling/Disabling Automatic URL Aliasing” on page 581

•

”Setting up Automatic Aliasing” on page 582

•

”Viewing and Editing Automatic Alias Configuration” on
page 587

•

”Inactivating an Automatic Aliasing Configuration” on page 588

•

”Deleting an Automatic Aliasing Configuration” on page 588

Permissions for Working with Aliasing
Members of the Administrators group or those assigned to the
Alias-Admin Role have full permissions to work with aliasing. They
can do things like
•

Turn aliasing on and off

•

View all manual aliases

•

Activate or deactivate manual aliases

•

Change the primary alias

•

Create automatic aliases
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•

Create RegEx aliases

To give a user a limited ability to work with aliasing, you can assign
them the Alias-Edit role. These users can only
•

view and assign a manual alias to content

•

view secondary aliases assigned to content

See Also: ”Using the Roles Screens” on page 788

Enabling/Disabling Automatic URL Aliasing
To enable automatic aliasing, follow this path: Settings >
Configuration > URL Aliasing > Settings. The screen indicates if
automatic aliasing is currently on or off.

To change its state, click the Edit button (
box, and click the Save button ( ).
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Setting up Automatic Aliasing
After enabling automatic URL aliasing, you can create a
configuration, which lets you
•

identify the content source (that is, a taxonomy or a folder)

•

choose elements of the aliasing pattern

•

preview sample original and aliased URLs

To create an automatic alias configuration, follow these steps.
1. Open the Settings > Configuration > URL Aliasing >
Automatic screen.
2. If you are creating an alias based on Taxonomy, select its
language from the language dropdown.

If you creating an alias based on folder, go to Step 3.
NOTE

On the Auto Aliased Page Name Maintenance screen, a folder-based alias’ Lang
column shows a United Nations flag ( ). This indicates that folders are
language-neutral.

3. Click the plus sign (
(shown below).

) to access the Add a New Alias screen
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4. Use the following table to complete the screen.
Field

Description

Active

Check this box to apply this configuration to content. If you do, the aliases are
applied when you save the screen.
If you uncheck this box, automatic aliases set up via this configuration are
deleted from the associated content.

Source Type

Automatic aliases are based on either a taxonomy or a folder. Choose one.
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Field

Description

Alias Root

Navigate to and choose a taxonomy or folder to which you want to assign an
automatic alias.
If you choose a taxonomy, the automatic alias is applied to all content
assigned to it and all of its child nodes. See Also: ”Taxonomy” on page 634
Furthermore, if your Ektron CMS400.NET supports multi-site configurations,
the automatic alias will apply to content in all sites. This is because taxonomy
is site independent.
Note: If the language selector was set to All on the Auto Aliased Page Name
Maintenance screen, and you chose Taxonomy as the Source Type, No
Taxonomy appears here. This indicates that you must return to the Auto
Aliased Page Name Maintenance screen and select a language before you
can select a taxonomy as the Alias Root.
If you choose folder, the automatic alias applies to all content in that folder
and its subfolders. See Also: ”Managing Content Folders” on page 34
The taxonomy or folder is part of the automatic alias pattern. See Also: ”The
Automatic Alias Pattern” on page 586

Alias Format

Use this field to help construct the automatic alias pattern. Choose one of the
following items to identify the content within the alias.
ContentTitle - Example: Sample Content Block
ContentID - Example: 30
ContentIDandLanguage - Example: 30/1033
See Also: ”The Automatic Alias Pattern” on page 586

Extension

Use this field to help construct the automatic alias pattern. Choose an
extension from the list to identify the end of the aliased URL.
Extensions are defined in the Extension field of the URL Aliasing
Configuration screen.
See Also: ”The Automatic Alias Pattern” on page 586; ”Configuring URL
Aliasing” on page 566
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Field

Description

Replacement
Character

Enter the character that replaces prohibited characters in content titles when
they appear within an automatic alias. Examples of prohibited characters are
a space and question mark (?).
So, for example, if the content title is About Us, and you enter an underscore
(-) here, the aliased version of the title is About_Us.
You cannot enter one of the following as the replacement character: [ , \ / < >
(Space) : | ? ' ] # * & %
Note: If you're using IIS7 (Microsoft Vista or Server 2008), and specify a plus
sign (+), you get this error: HTTP Error 404.11 Not Found The request
filtering module is configured to deny a request that contains a
double escape sequence. For a solution, see http://support.microsoft.com/

kb/942076/en-us.
Customize Alias Path

By default, the automatic alias pattern displays all folders or taxonomy levels
from the top to the level you select. (See Also: ”The Automatic Alias Pattern”
on page 586)
You can use this field to control which folders/taxonomy levels appear in the
pattern.
For example, your Alias Root is based on the following folder path: /
CMS400Demo/About Us/Careers. Using this field, you can choose any of the
following to indicate the folder or taxonomy path in the automatic alias pattern.

Preview Alias

This area of the screen displays
•

a sample Original URL

•

an aliased example of that URL, based on the information entered on the
screen

To see any content item’s fully aliased URL, navigate to it and click its Alias
tab.

Uniqueness Requirement for Automatic Alias Configuration
A configuration must have a unique combination of Source Type,
Alias Root, Alias Format, and Extension. For example
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•

Source Type = taxonomy

•

Alias Root = the taxonomy named Products

•

Alias Format = Content title

•

Extension

You cannot create a configuration whose values match an existing
one.

The Automatic Alias Pattern
The Automatic Alias pattern combines the following elements in
this order. Each element is separated by a slash (/).
1. site root
2. folder or taxonomy path (Spaces are replaced by the
Replacement Character specified on the Add/Edit Alias
screen).
NOTE

Either a taxonomy or a folder is selected when creating an automatic aliasing
configuration.

By default, a taxonomy path has all taxonomy nodes from the
top to the level at which content is assigned. Here is an
example: www.example.com/Medical_Conditions/Kidney_Disease/.
By default, a folder path has all folders from the top-level to the
folder that contains the content. Here is an example:
www.example.com/CMS400Developer/CMS400Demo/About_Us/
Company_Profile/Board_of_Directors.aspx.

NOTE

You can use the Customize Alias Path field to determine which path components
appear in the pattern. See Also: ”Customize Alias Path” on page 585

3. content name source (Spaces are replaced by the
Replacement Character specified on the Add/Edit Alias
screen)
4. extension
Examples:
Folder-based automatic alias
www.example.com/CMS400Demo/About_Us/Company_Profile/Awards_and_Honors/
www.example.com/CMS400Demo/About_Us/Company_Profile/12548/
www.example.com/CMS400Demo/About_Us/Company_Profile/12584/1033
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Taxonomy-based automatic alias
www.example.com/cms400/MapCategory/Restaurant/Chinese/You_You_Japanese_Bistro/

NOTE

Ektron CMS400.NET lets users create content with the same title in different
folders. If an automatic alias based on a taxonomy is created, and the same
taxonomy node is applied to two content items with the same title, both items will
have the same automatic alias. To avoid this problem, do not allow users to
assign the same name to more than one content item.

Viewing and Editing Automatic Alias Configuration
To view and edit an automatic alias configuration, go to the
Settings > Configuration > URL Aliasing > Automatic screen.
TIP!

Use the screen’s language selector to find taxonomy-based configurations of a
selected language.

From the Auto Aliased Page Name Maintenance screen, click the
alias configuration that you want to view.

To edit an automatic alias, view it then click the Edit button ( ).
To learn about the screen’s fields, see ”Use the following table to
complete the screen.” on page 583.

Viewing an Automatic Alias
To view the automatic alias assigned to a specific content item,
navigate to and view the content. Then, click the Alias tab (shown
below). A primary manual alias appears near the top, followed by
all automatic aliases.
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Inactivating an Automatic Aliasing Configuration
Follow these steps if you want to temporarily inactivate an
automatic alias configuration. When you do, automatic aliases
created by that configuration are removed from all content to which
they are applied. The configuration is saved, so if you later want to
reactive it, simply undo these steps.
1. Open the Settings > Configuration > URL Aliasing >
Automatic screen.
2. Click the alias that you want to inactivate.
3. Click the Edit button (

).

4. Uncheck the Active checkbox.
5. Click the Save button (

).

Deleting an Automatic Aliasing Configuration
Follow these steps if you want to delete an Automatic Aliasing
Configuration. When you do, automatic aliases are removed from
all content to which they are applied.
1. Open the Settings > Configuration > URL Aliasing >
Automatic screen.
2. Click the delete button (

).

3. Check each configuration that you want to delete.
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4. Click the delete button (

).

5. You are asked if you are sure.
6. Click OK.

Manual Aliasing
When using manual aliasing, you choose a page name. Next, you
specify the content to appear whenever anyone enters the URL
using that name into a browser address field. For example, you
can alias www.example.com/cms/index.aspx as www.example.com/cms/
Launch.html. From then on, the content can be identified either by
its original URL or its alias.
You can assign any number manual of aliases to a content block.
NOTE

You cannot manually alias the root of your Web site (for example,
www.example.com). You can, however, alias everything below that.

This section explains manual aliasing through the following topics.
•

”Manual Aliasing and Multi-Site” on page 589

•

”Enabling/Disabling Manual Aliasing” on page 590

•

”Assigning a Manual URL Alias to Content” on page 590
- ”Adding a Manual Alias via the Page Name Maintenance
Screen” on page 591
- ”Adding a Manual Alias via the Alias Tab” on page 596

•

”Editing a Manual URL Alias” on page 597

•

”Removing a Manual Alias” on page 598

Manual Aliasing and Multi-Site
If your Ektron CMS400.NET deployment uses multi-site, the
following restrictions apply to manual aliasing.
•

Any manual alias applied to the root site cannot be applied to
any of the additional sites

•

Any manual alias applied to an additional site cannot be
applied to the root site
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However, the same manual alias can be applied to any number of
additional sites.

Enabling/Disabling Manual Aliasing
To activate manual aliasing, follow this path to the URL Aliasing
Configuration screen: Settings > Configuration > URL Aliasing >
Settings.

The screen indicates if manual aliasing is currently on or off. To
change its state, click the Edit button (
box, and click the Save button.

), check or uncheck the

Assigning a Manual URL Alias to Content
Two screens let you manually alias content.

Screen/tab

Who is authorized to
use

Can create/update
these manual aliases

For more information,
see

Page Name
Maintenance

members of Administrators
group

an unlimited number of
primary and secondary

”Adding a Manual Alias via
the Page Name
Maintenance Screen” on
page 591

Alias tab of
View Content
screen (see
image below)

•

members of Administrators group

”Adding a Manual Alias via
the Alias Tab” on page 596

•

users assigned AliasEdit role

primary (Alias tab displays
but does not let users
change secondary aliases)
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Adding a Manual Alias via the Page Name Maintenance Screen
Prerequisites
•

Manual aliasing is enabled. See Also: ”Enabling/Disabling
Manual Aliasing” on page 590

•

You are a member of the Administrators group

To add a manual alias via the Page Name Maintenance screen,
follow these steps.
1. Go to Workarea > Settings > Configuration > URL Aliasing
> Manual.
2. The Manual Aliased Page Name Maintenance screen appears.

The following table explains the buttons on the screen.

Button

Description

For more information, see

Add manual alias

”If creating new alias” on page 594
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Button

Description

For more information, see

Delete manual alias

”Removing a Manual Alias via the Manual Aliased Page
Name Maintenance Screen” on page 600

Manually clear cache

”Manually Clearing the Cache” on page 577

The following table explains the fields on the screen.

Field

Description

Primary

If you assign more than one manual alias to content, this field designates the
primary one. If you only assign one, it is the primary by default.
The primary alias appears in the browser when a user hovers the cursor over a link
to associated content, such as within a List Summary or a Collection. It also
appears in the browser address field after the content is selected. See ”Example of
an Alias in the Browser” on page 564.
If a user views a content block’s Alias tab, he can only see and edit the primary
manual alias. See Also: ”Adding a Manual Alias via the Alias Tab” on page 596

Active

Indicates if this alias is active.

Lang

The alias’s language flag.

Alias

The alias (that is, the page name) that site visitors can enter as part of the URL
into a browser to see the associated content.

Original Link

The content template and variable being aliased.

Content ID

The ID number of the content assigned to the alias.

3. To edit an existing manual alias, use the language selector
dropdown (see image below) to choose the language of the
aliases you want to work with.
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If you are creating a new alias, click the Add Alias button (
and skip to Step 8.

)

4. If your Ektron CMS400.NET version supports multi-site
configurations, use the Site dropdown to choose the site.
5. Click the alias you want to edit.
NOTE

If there are many aliases, use the search to help find one. You can filter aliases by
alias name, Content ID, etc.

6. The View Alias screen appears. Click the Edit button (

).

7. The Add/Edit Manual Alias screen appears.
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8. If editing existing alias
If this is not the primary alias, you can check or uncheck the
Active checkbox. Only active aliases can be entered into the
browser address field to display the assigned content.
If this is the primary alias, you cannot uncheck it. If you want to
inactivate a primary alias, first assign another alias to be the
primary for this content block. Then, return to this screen and
make this alias inactive. Alternatively, you can delete a primary
alias.
If creating new alias
Check the Active checkbox if you want this alias to be active.
9. Check the Primary box if you want this to be the primary alias.
See Also: ”Primary” on page 592
If another alias is the primary when you check this box, the
other alias is no longer the primary.
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10. In the Alias field, enter the alias name. It cannot include the
following characters: (comma), (space), \, <, >, “, :, |. Also, it
must be unique within this site and language.
To the right of Alias Name is a pull-down of valid extensions.
Select one to apply to this alias. Extensions are defined on the
URL Aliasing Configuration screen. See Also: ”Extension” on
page 570
11. Click Select a Content Block to choose content. The
QuickLink Select window appears.
NOTE

Only content in the language chosen on the Page Name Maintenance screen
appears.

12. Navigate through the folder structure and click the content to
which you are assigning the alias.
TIP!

A folder’s content appears below its subfolder list. You may have to scroll down to
see the content.

13. The Title, Link and Quick Link fields fill in, using information
from the selected content.
If the content has more than one quicklink assigned to it, select
the one to which you are assigning the alias.
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14. To learn about the QueryString Action field, go to ”Query String
Action” on page 572.
15. Enter the Additional Variables. These are used as query
string parameters that can track how visitors arrived at the
aliased page. You might use these for marketing campaigns, to
analyze the source of an aliased page’s visitors.
For example, the Additional Variables field has
?gclid=CO7gs_L0_ZICFRkTIgodBgV9CQ. Your Web site's analytics
software can track the source of the query through the variable.
TECHNICAL NOTE

Within the page load event that returns the query string parameters, use the
Request.RawURL() property instead of request.querystring.

16. Click the Save button (

).

Adding a Manual Alias via the Alias Tab
Once manual aliasing is enabled, every content block includes an
Alias tab. You can use that tab to view and update the content’s
primary alias.
NOTE

If you insert/update an alias via the Alias tab, it only goes live after the content is
published.

See Also: ”Manual Aliasing” on page 589
Prerequisites
•

Manual aliasing is enabled. See Also: ”Enabling/Disabling
Manual Aliasing” on page 590

•

You are a member of the Administrators group or assigned to
the Alias-edit Role. If neither, you do not see the Alias tab.

To add a manual URL alias via the Alias tab, follow these steps.
1. In the Workarea, select Content.
2. Navigate to and click the content you want to work with.
3. Click the Edit button (

).The Edit Content screen appears.
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4. Click the Alias tab.
5. In the Primary Alias Name field, enter the name of the primary
alias.
The name cannot include the following characters: (comma),
(space), \, <, >, “, :, |. Also, it must be unique within this site and
language.
6. To the right of Primary Alias Name is a pull-down of valid
extensions. Select one to apply to this manual alias.
The extensions are set up in the URL Aliasing Configuration
screen’s Extension field. See Also: ”Extension” on page 570
7. Save and publish the content.

Editing a Manual URL Alias
You can edit any manual alias via the Edit Alias screen. This lets
you change all fields completed when the alias was created: name,
assigned content, etc.
NOTE

You can also edit a content block’s primary alias name via the Alias tab on the
content screen. See ”Adding a Manual Alias via the Alias Tab” on page 596.

To edit a manual URL alias, follow these steps.
1. Go to Workarea > Settings > Configuration > URL Aliasing
> Manual.
2. On Manual Aliased Page Name Maintenance screen, click the
alias you want to edit.
3. The View Alias screen appears. Click the Edit button (
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4. The Edit Alias screen appears.

5. Make any changes. To learn about the fields, see ”If editing
existing alias” on page 594.
If this is the only alias assigned to the content, you cannot
uncheck Primary or Active.
If other aliases are assigned to the content, and you want to
make one of them the primary, edit that alias and check the
Primary checkbox. You cannot uncheck Primary from this
screen.
Also, only secondary aliases can be inactivated by unchecking
the Active checkbox.
6. Click the Save button (

).

Removing a Manual Alias
Just as there are two ways to add a manual alias, there are two
ways to remove one.
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•

”Removing a Manual Alias via the Content Alias Tab” on
page 599

•

”Removing a Manual Alias via the Manual Aliased Page Name
Maintenance Screen” on page 600

Removing a Manual Alias via the Content Alias Tab
Using a content block’s Alias tab, you can delete a primary manual
alias only if no secondary aliases exist. If secondary aliases exist
and you want to delete or replace the primary alias, you must use
the Manual Aliased Page Name Maintenance screen. See Also:
”Removing a Manual Alias via the Manual Aliased Page Name
Maintenance Screen” on page 600
You can neither see nor delete secondary manual aliases from the
Alias tab.
Note

If you delete an alias via the Alias tab, the change only goes live after the content
is published.

To remove the primary manual alias by editing the associated
content block, follow these steps.
1. Browse to the content block associated with the alias.
2. Click Edit.
3. Click the Alias tab.
4. Delete or replace the value in the Primary Alias Name field.

5. Click Save, Check in, or Publish.
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Removing a Manual Alias via the Manual Aliased Page Name
Maintenance Screen
Using the Page Name Maintenance Screen, you can delete the
primary and any secondary manual aliases.
IMPORTANT!

If you want to delete a primary manual alias while secondary aliases exist, you
must first designate one of the secondary aliases as the primary. You can only
delete the primary alias if no secondary aliases exist.

To remove a manual alias via the Page Name Maintenance
Screen, follow these steps.
1. Go to Workarea > Settings > Configuration > URL Aliasing
> Manual.
2. On Manual Aliased Page Name Maintenance screen, click the
Remove button ( ).
3. Check the box next to all aliases you want to remove.
4. Click the Delete button (

).

5. Click OK to confirm.

Using RegEx Expressions
RegEx expressions allow site visitors to enter a human-readable
URL into the browser address field and transform that entry into
the query string component of an Ektron CMS400.NET page. The
benefit is that the site visitor can “guess” other pages based on an
easily recognizable pattern.
For example, a RegEx expression aliases
as blogs/2006/03/41.
From that, a site visitor can infer that he can enter blogs/2006/03/40
to see the previous post, enter blogs/2006/03 to see all March 2006
posts, etc.
blogs.aspx?blogmonth=3&blogyear=2006&blogid=41

This section provides a description of the screen’s fields, then a
step-by-step explanation of how to create and validate a RegEx
expression.
See Also:
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•

”Add a Regular Expression Screen” on page 601

•

”Instructions for Creating a RegEx Expression” on page 603

Add a Regular Expression Screen
To access the Regular Expression screen, follow these steps.
1. In the Ektron CMS400.NET Workarea, go to Settings >
Configuration > URL Aliasing > RegEx.
2. Click the Add button (

).

3. The Add a Regular Expression screen appears.

4. Use the following table to complete the screen.
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Field

Description

Active

Check this box to activate the expression. If the
expression is active, site visitors can enter an aliased
URL to access a page on your site.

For more information, see

For example, they can enter www.example/com/
blogs/2006/03/41 to access a blog page even though
the actual URL is www.example/com/blogs/
blogs.aspx?blogmonth=3&blogyear=2006&blogid=4
1

Expression
Name

Assign an easily recognizable name to this regular
expression. It appears on the RegEx Aliased Page
Name Maintenance screen to help users identify it.

Expression

Enter a RegEx expression that will replace the
variables (for example, $1, $2, etc.) in the Expression
map.

•

”Instructions for Creating a
RegEx Expression” on
page 603

If you want to insert a question mark into the
Expression, you must precede it with a backslash (\).

•

http://regexlib.com/

Enter a map of original URL elements. The map lets
you replace query string parameters with variables,
such as $1, $2, etc. As a result, a site visitor can
identify any page that uses this pattern by changing the
variable values.

”Instructions for Creating a
RegEx Expression” on
page 603

Expression
Map

You can click Expression Library to view examples of
RegEx expression maps. To copy any map that
resembles your page pattern, click it. You can then
modify is as necessary.
Example
URL

Displays an example of Web page that follows this
pattern.
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Field

Description

Priority

Assign a priority to this expression from the following
choices.
•

high

•

medium

•

low

•

none

For more information, see

Assign high to expressions that will be used most
frequently.
This field helps the aliasing feature respond quickly
when site visitors enter expressions into the browser
address field. This is because aliasing first tries to
match a site visitor’s entry with high priority
expressions, then medium, then low.
Requested
URL

Enter a user-friendly pattern that site visitors can insert
to access pages on your site. This pattern replaces the
query string component of a URL.

”Instructions for Creating a
RegEx Expression” on
page 603

For example, blogs/2006/03/41.
Transform
button

After completing all fields on the screen except
Resulting URL, use this button to check the validity of
the Expression, Expression Map and Requested
URL fields.

Resulting
URL

Values appear in this field after you click the
Transform button. It uses the Expression and
Expression Map field values to translate a Requested
URL (one a site visitor will enter) into a Resulting URL
(the page’s actual query string parameter).

Instructions for Creating a RegEx Expression
Use the following steps as a guide to creating a Regex expression.
1. Find a site page (such as a blog) whose query string
parameters allow users to guess similar pages using a pattern.
For example
http://ecmintranet/blogs.aspx?blogmonth=3&blogyear=2006

2. In the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Url Aliasing > RegEx.
3. Click the Add a Regular Expression button (
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4. Give your expression a name.
5. Click Expression Library.
6. Find and click an Expression Map similar to the page you found
in Step 1. To continue our example, choose
PageName.aspx?year=$1 & month=$2

7. The Expression and Example URL field values fill in, using
information from the Expression Map.
8. As needed, adjust the values in the Expression map or the
RegEx expression to match your page name. For example,
change PageName to blogs, and delete Default.aspx
See Also: http://regexlib.com/
9. To continue the example, change the Expression Map field so
that it looks like this.

10. Click the Transform button to verify that the resulting URL
matches the original page pattern. If it does not, check all
steps, especially the Expression field.
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Site Aliasing
If your site supports the multi-site feature (see ”Multi-Site Support”
on page 998), you can enter aliases for any site. For example, your
company’s name just changed from Bionics to NewGen. You can
use the site aliasing feature to resolve the url www.bionics.com to
www.newgen.com.
NOTE

If your Ektron CMS400.NET supports multi-site configurations, an automatic alias
assigned to a taxonomy will apply to content in all sites. This is because taxonomy
is site independent.

IMPORTANT!

If the site being aliased resides in a folder under your server’s Web root folder (for
example, ser4325/min), you must add the subfolder to the alias. So, to continue
the above example, you could not enter http://www. myalias.com as an
alias for that site. Instead, you would enter http://www.myalias.com/min/.

See Also:
•

”Creating Site Aliases” on page 605

•

”Editing a Site Alias” on page 608

•

”Deleting a Site Alias” on page 608

Creating Site Aliases
Enabling site aliasing has two steps.
•

”Setting up a Site Alias in the Ektron CMS400.NET Workarea”
on page 605

•

Add each site alias as an IIS host. To learn how do this for your
server, please consult IIS help.

Setting up a Site Alias in the Ektron CMS400.NET Workarea
To set up site aliases, follow these steps.
NOTE

You cannot assign a site alias to the site root folder.
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1. Open the site folder for which you want to create aliases. (Site
folders have a globe icon, like this:
).
2. Click View > Folder Properties.
3. Click the Edit button (

).

4. Click the Site Alias tab.

5. Enter the alias into the Alias Name field.
NOTE

The alias cannot end with a slash (/).

From now on, if a site visitor enters the alias into a browser
address field, he is redirected to the site URL (set on the folder
properties tab’s Production Domain field).
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Editing a Site Alias
Follow these steps to edit a site alias.
1. Open the site folder for which you want to create aliases. (Site
folders have a globe icon, like this:
).
2. Click View > Folder Properties.
3. Click the Edit button (

).

4. Click the Site Alias tab.
5. From the Alias list, click the alias that you want to edit. When
you do, it is highlighted in yellow and appears in the Alias
Name field.
6. Change the alias text.
7. Click the Save button directly below the Alias Name field.

8. Click the screen’s Save button (

).

Deleting a Site Alias
Follow these steps to delete a site alias.
1. Open the site folder for which you want to create aliases. (Site
folders have a globe icon, like this:
).
2. Click View > Folder Properties.
3. Click the Edit button (

).

4. Click the Site Alias tab.
5. From the Alias list, click the alias that you want to delete. When
you do, it is highlighted in yellow and appears in the Alias
Name field.
Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

608

URL Aliasing

6. Click the delete icon (

).

7. The alias is deleted.

Upgrading from Previous Releases
See the following Ektron CMS400.NET Knowledge Base article to
learn about 7.6 URL Aliasing upgrade issues: http://
dev.ektron.com/kb_article.aspx?id=21358

Assigning an Alias to Multi-Language Content
If Ektron CMS400.NET has several foreign-language versions of
content that share an ID, you can alias only one of them and check
the URL Aliasing Configuration screen’s Disable Language
Awareness checkbox. Then, when a site visitor selects a
language in which to view your site and enters the alias, Ektron
CMS400.NET displays the aliased content in the selected language.
If you prefer, you can assign a different alias to each language
version of content. To do this, select the content, language, go to
the Alias tab, and assign a language-specific alias. For example,
your English Careers page’s alias is careers, while your Spanish
alias is carreras, and your German alias is Karrieren.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

609

URL Aliasing

Also, alias names must only be unique within a language. So, for
example, you cannot have two aliases named Ektron within U.S.
English content. But, you can create two aliases named Ektron if
one is applied to U.S. English content, and the other applies to
Spanish content.

Using Classic ASP with Windows 2008 Server 64
Bit
If you want to use aliasing on a 64-bit server running Windows
2008, follow these steps.
1. Install classic ASP onto the server. It is not installed by default.
See Also: http://technet.microsoft.com/en-us/library/
cc753918.aspx
2. Open your site

root/web.config

file.

3. Go to the <handlers> section.
4. Find this tag:
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<add name="ek*" path="*" verb="GET,HEAD,POST"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory" modules="ManagedPipelineHandler"
scriptProcessor="" resourceType="Unspecified" requireAccess="Script" preCondition="" />

5. Add the following ASP handler above the ek handler shown
above.
<add name="ASPClassic" path="*.asp" verb="GET,HEAD,POST" modules="IsapiModule"
scriptProcessor="%windir%\system32\inetsrv\asp.dll" resourceType="File" />
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Business Rules

Business Rules allow you to define conditions for Web pages on
your site. You choose an action based on whether the conditions
are true or false when a site visitor browses your site. For example:
•

Condition - a site visitor visits your site for the first time

•

Action - add a cookie to the site visitor’s system and pop up a
welcome message

With Business Rules, you do not write code to set conditions and
initiate actions. You simply complete the information requested in
the Business Rules wizard, have your developer add a Business
Rules server control to your Web form, and assign the server
control the Business Rules Ruleset.
NOTE

For Information on the Business Rules server control, see the Developer Manual
Section “Introduction to Server Controls” > “Business Rules Server Control”.

Business Rules start out with a Ruleset that is assigned an ID.
Each Ruleset is made up of one or more rules. Rules are made up
of conditions and actions. There are several predefined conditions
and actions for rules in CMS400.NET.
Conditions include:
•

Cookie Parameter = value

•

Form Parameter = value

•

QueryString Parameter = value

•

Server Variable = value

•

Custom Parameter = value

Actions include:
•

Displaying a calendar

•

Displaying a message

•

Opening a URL in a new window
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•

Popping up a message

•

Redirecting to a new URL

•

Setting a cookie value

•

Displaying a content block.

Once a rule is defined, you can add it to multiple Rulesets. This is
useful if you have several groups of rules that use a common rule.
Business Rules are more fully explained through the following
topics.
•

”Selecting a Rule” on page 613

•

”Creating a New Business Rule Ruleset” on page 614

•

”Working with Rulesets” on page 615

•

”Permission to Work with Business Rules” on page 625

Selecting a Rule
There are two ways to select a rule. The first, check boxes, allows
you to select a rule by clicking the check box. This method is used
when turning a rule on or off in the Ruleset. Checked, the rule is
active. Unchecked the rule is inactive.

The second, highlighting a rule, is used to when you want to work
with the rule. For example, you want to add or remove a rule from a
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Ruleset. To highlight a rule, click its title. Once a rule is highlighted,
it is ready for an action, such as Remove or Edit.

Creating a New Business Rule Ruleset
NOTE

Only members of the Administrators group or those defined in Manage Members
for Role: Rule Editor screen can create or edit Business Rules and Rulesets. See
Also: ”Defining Roles” on page 787

You create Business Rules Rulesets from the Business Ruleset
screen in the Workarea.

The Business Ruleset screen contains these columns:
•

ID - the numerical ID assigned to the Ruleset.

•

Name - a unique name you give to the Ruleset to help you
understand what the Ruleset does.

To add a new Ruleset, follow these steps:
1. In the Workarea, click Modules > Business Rules.
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2. Click the Add New Ruleset button (

).

3. The Add New Ruleset screen appears.

4. In the Name: text box, add a name for the rule.
5. Click the Save button (

).

6. The View Ruleset screen appears.
At this point, you can continue on to ”Add a New Rule to a Ruleset”
on page 618 or ”Add an Existing Rule to a Ruleset” on page 622 to
add a rule or click the Back button (
later.

) and return to add a rule

Working with Rulesets
After creating a Ruleset, you typically add rules to it via the View
Ruleset screen.

The View Ruleset screen is the launch pad for working with
existing Rulesets. From this screen you can:
•

”Edit a Ruleset” on page 616

•

”Remove a Rule From a Ruleset” on page 617
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•

”Change the Order of Rules in the Ruleset” on page 617

•

”Delete a Ruleset” on page 618

•

”Add a New Rule to a Ruleset” on page 618

•

”Add an Existing Rule to a Ruleset” on page 622

•

”Edit a Rule in a Ruleset” on page 624

•

”Viewing a Rule in a Ruleset” on page 624

Edit a Ruleset
You can initiate editing a Ruleset from two different locations, the
Web page or the Workarea. To edit a Ruleset from the Web page,
navigate to a Business Rule on a Web page while logged in. Then,
right click the Business Rule icon and click Edit.

If editing from the Workarea, click Modules > Business Rules and
then click the Ruleset to edit. Next, click Action > Edit Ruleset.
The Edit Ruleset screen appears.
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Remove a Rule From a Ruleset
Follow these steps to remove a rule from the Ruleset.
1. Navigate to the Edit Ruleset screen, as explained in ”Edit a
Ruleset” on page 616.
2. Highlight the rule you want to remove.
WARNING!

The check box associated with the rule must be empty for you to remove the rule.
If the check box is not empty, the rule will look as though it has been removed

3. Click the Remove Rule button (

).

4. A pop up appears letting you know that the rule will be removed
from this Ruleset only.

5. Click OK.
6. The rule is removed from the Edit Ruleset screen.
7. Click the Save button (

).

Change the Order of Rules in the Ruleset
The order of rules in a Ruleset affects how rules are applied when
a site visitor views a page. For example, you want to display a
welcome message before a content item. To accomplish this, move
the rule for the welcome message above the rule for a content
item.
Follow these steps to change the order of the rules in a Ruleset.
1. Navigate to the Edit Ruleset screen, as explained in ”Edit a
Ruleset” on page 616.
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2. Highlight the rule you want to reorder.
3. Click the Move Up or Move Down buttons (
the rule up or down the list.
4. Click the Save button (

)(

) to move

).

Delete a Ruleset
When you delete a Ruleset, it is removed from the system
permanently. However, rules included in a Ruleset are not deleted.
This is because a rule can be used in multiple Rulesets.
Follow these steps to delete a Ruleset.
1. Navigate to the Edit Ruleset screen, as explained in ”Edit a
Ruleset” on page 616.
2. Click the Delete Ruleset button (

).

3. A dialog asks you to confirm the deletion.

4. Click OK.

Add a New Rule to a Ruleset
Adding a new rule is easy with Ektron CMS400.NET. Just click the
Add button on the View Ruleset screen. The Rules Wizard
launches and helps you define a rule.
Follow these steps to add a new rule to your Ruleset.
1. If you arrived here from the ”Creating a New Business Rule
Ruleset” on page 614 section, continue to the next step.
Otherwise, navigate to the Business Rules screen in the
Workarea by clicking Modules > Business Rules. Next, click
the Business Rule for which you want to create a new rule.
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2. Click New > Add New.
3. The Rules Wizard launches.

4. Step 1 prompts you to create conditions for the rule and decide
whether a site visitor needs to match Any or All conditions.
Clicking the param and value links opens a dialog to enter
information.

Place a check next to any condition you want to use. Use the
table below to help you fill out the param and value fields.
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Conditions Table
Condition

Description

Example

The Cookie param
equals value

Use a cookie for this condition.

Does the site visitor's system have an
Ektron cookie?

param - enter Name in this field.
value - enter the name of the cookie in
this field.

The Form param
equals value

Use a form elements field name and
match the value entered into the element.
param - enter a form’s element Field
Name from a form.
value - enter the value you want the form
element to match.

Usage:
The Cookie param “Name” equals
value “Ektron”
A form has a Choices Field element
with the Field Name “Favorite_Food”
and choices of Pizza, Steak and
Chicken. When a site visitor chooses
Pizza and clicks submit, your rule
launches a Pizza company’s Web
site.
Usage:
The Form param “Favorite_Food”
equals value “Pizza”

The QueryString
param equals value

The Server Variable
param equals value

Use the QueryString for this condition
param - the name of the QueryString. For
example, ID.

Is content with the ID of 18 being
displayed?
Usage:

value - the value associated with the
parameter. For example, 18.

The QueryString param “ID” equals
value “18”

Use server variables from the site visitor.

Is the site visitor’s browser using
SSL?

param - enter the name of a server
variable. For example, HTTPS.
value - the value associated with the
parameter. For example, On.

Usage:
The Server Variable param “HTTPS”
equals value “On”

A list of server variables and their descriptions can be found at http://msdn.microsoft.com/library/
default.asp?url=/library/en-us/iissdk/html/21b3be8f-d4ed-4059-8e21-6cba2c253006.asp.
The Custom param
equals value

Use custom parameters from the user.
User parameters are defined in the
codebehind of a web page.
param - enter the name of a custom
parameter. For example, AcctBlnc

Is the user's account balance $1000?
Usage:
The Custom param “AcctBlnc” equals
value “1000”

value - the value associated with the
parameter. For example, 1000
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5. Click Next.
Step 2 of the Wizard prompts you select an action to take if
conditions are true. Check the boxes for the actions to take. Click
the blue links to add the appropriate information.

Conditions Table
Action

Description

Display Calendar ID

Enter a CMS400.NET Calendar ID.

Display a Message

Enter a message to be displayed.

Open URL

Enter a URL. This opens a new window with the URL.

Popup A Message

Enter a message that appears in a popup dialog box.

Redirect to a URL

Enter a URL to redirect a the site visitor’s browser.

Set Cookie to Value

Creates a cookie on the site visitor’s system. Enter
Name for Cookie and the name of the cookie for Value.
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Action

Description

Display Content Block ID

Enter a CMS400.NET content block’s ID.

6. Click Next.
7. Step 3 of the Wizard lets you select actions to take when
conditions are false. This works the same as Step 2 of the
Rules Wizard. For descriptions of the actions, see ”Conditions
Table” on page 620.
8. Click Next.
9. Step 4 of the Wizard asks you to enter a name for the rule in
the text box.
10. Click Done.
11. The View Ruleset screen appears. Your rule appears in the
Ruleset box.

Add an Existing Rule to a Ruleset
Because rules are not tied to a Ruleset once they are created, you
can add a rule to more than one Ruleset. To add an existing rule to
a Ruleset, follow these steps:
1. If you arrived here from the ”Creating a New Business Rule
Ruleset” on page 614 section, continue to the next step.
Otherwise:
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Navigate to the Business Rules screen in the Workarea by
clicking Modules > Business Rules. Next, click the name of
the Business Rule for which you want to add an existing rule.
2. Click New > Add Existing.
3. The Add an Existing Rule screen appears.

4. Check the rules to add to the Ruleset.
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5. Click the Save button (

).

Edit a Rule in a Ruleset
Following these steps to edit a rule in a Ruleset.
1. In the Workarea, navigate to Modules > Business Rules.
2. Select the Ruleset that contains the rule to be changed.
3. Highlight the rule to be changed.

4. Click Action > Edit Rule.
5. The Rules Wizard appears with the rule loaded. Edit as
necessary. The Rules Wizard is explained in ”Add a New Rule
to a Ruleset” on page 618.

Viewing a Rule in a Ruleset
To help you understand the contents of a rule, a (View) link
appears next to each rule in a Ruleset. Click this link to launch a
view window for the rule. This window displays settings for each
Rules Wizard step applied to a rule.
NOTE

The steps are not editable from this window. To edit rules in a Ruleset, see ”Edit a
Rule in a Ruleset” on page 624.
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To navigate through the steps, use the Previous and Next Step
buttons (

). To close the window, click the Close button (

).

Permission to Work with Business Rules
Only members of the Administrators user group and those defined
in the Manage Members for Role: Add Role Member Business
Rule Editor screen can work with Business Rules. See Also:
”Defining Roles” on page 787
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Collections

Ektron CMS400.NET’s Collection feature lets users create a list
of content that can be placed on a Web page to offer readers
links to them. In the following illustration, the circled content is
an example of a collection on a Web page.

Collections can also be used to display listings such as job
postings, press releases, and Knowledge Base articles. The
following graphic illustrates the use of a collection on the
landing page of Ektron’s Knowledge Base.
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This section only describes managing permissions to use the
Collections feature. For more information about the Collections
feature, see the Ektron CMS400.NET User Manual section “Working
with Collections.” See Also:
•

”Collection Permissions” on page 627

•

”Setting up Approval for Collections” on page 630

Collection Permissions
Any of the following users have permission to create or edit a
collection.
•

a member of the Administrators group

•

a user who has been assigned the Collection and Menu Admin
role. See Also: ”Defining Roles” on page 787

•

a user who has been granted collection permission for the
collection’s folder. Permission is granted on the folder
Permission screen (see graphic below). See Also: ”Setting
Permissions” on page 768
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How a Folder is Assigned to a Collection
If you create a collection by going to the Workarea’s Modules tab,
it is assigned to the root folder.

If you create a collection by going to a folder then selecting New >
Collection, it is assigned to that folder.
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A collection’s folder appears on the Modules > Collections >
Collection Report screen, in the Path column. No value there
indicates root folder.
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Setting up Approval for Collections
If desired, you can set up an approval system for any collection. As
with a content approval chain, you specify users who must approve
changes to a collection before it can be published.
Any collection approver can either approve or decline the modified
collection. And, if a user who is not an approver tries to delete a
collection, that action also requires approval.
See Also:
•

”Differences Between Content and Collection Approval
Systems” on page 630

•

”Creating a Collection that Requires Approval” on page 630

•

”Which Users Can Approve Collections” on page 631

•

”What Happens When an non-Approver Submits Changes to a
Collection” on page 631

•

”How Approvals Affect Deleting a Collection” on page 632

Differences Between Content and Collection Approval
Systems
•

While content can have a chain of approvers, a collection has a
list of approvers. Any collection approver can publish or decline
changes. There is no concept of a “chain” of approvers.

•

While content approval is folder-specific, collection approval is
not. Once set up, collection approval affects the collection to
which it was assigned, regardless of its folder.

Creating a Collection that Requires Approval
Only administrators or users to whom the folder-admin role has
been assigned see the Approval is Required checkbox on the
Add and Edit Collection screens. See Also: ”Defining Roles” on
page 787
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When the collection is created, its status is set to checked out. This
allows you to add items to it. When ready, you can publish it.

Which Users Can Approve Collections
If you require a collection to be approved, only the following users
have permission to create or edit a collection and can approve a
change to a collection.
•

a member of the Administrators group

•

users to whom the Collection Approver role has been assigned
and who have permission to work with the collection

•

users to whom the Folder User Admin role has been assigned
and who have permission to work with the collection

See Also: ”Defining Roles” on page 787

What Happens When an non-Approver Submits Changes to a
Collection
A user who has permission to edit collections but not approve
changes sees the following buttons.
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After making the change, the user clicks the submit button ( ).
This action triggers an email notification to all approval users for
the collection. It also changes the collection’s status to checked
out. No other users can edit it in this status.
Next, one of the approval users must open the Edit Collection
screen and click the Publish or Decline button. If he clicks Publish
(

), the new version of the collection is published to your Web

site. If Decline ( ), the user who submitted the changes is
notified by email but no changes are made to your Web site.
If the user who made the changes realizes he made a mistake, he
can go to the screen and click the Undo Checkout button at any
time before the approval. In this case, his submitted changes are
deleted, and the collection reverts to its original state.
In fact, any user with permission to edit a collection can perform
the undo function until the content is approved.

How Approvals Affect Deleting a Collection
To delete a collection, a user who has permission to work with
collections but not approve changes clicks the Delete button ( )
from the View Collection screen. This action changes the
collection’s status to Marked for Deletion (M) and triggers an email
notification to all approval users for the collection. One of the
approval users must open the Edit Collection screen and click the
Delete or Decline button.
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If the approval user clicks Delete (

), the collection is removed

from your Web site. If the approval user clicks Decline ( ), the
user who submitted the deletion is notified by email but no
changes are made to your Web site.
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Ta xon omy

Large amounts of content can be an organizational nightmare, and
it takes a far reaching categorization model to allow content to be
efficiently repurposed, searched for, and organized on a site.
Ektron’s taxonomy, a one-to-many relationship model, follows
natural and organic methods all the way down to the content level,
enabling an intuitive organization scheme that reflects how people
think.
Click the following link to see a video introduction to taxonomy in
Ektron CMS400.NET: http://www.ektron.com/learningcenter/
taxonomy/taxonomy.html.
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Ektron’s taxonomy is a content-level categorization system that
uses one-to-many relationships to create a scalable organization
of content. Content is categorized in the database by how it relates
to multiple categories, allowing it to be accessed in multiple ways
for multiple purposes. The hierarchy of the content is arranged
from the general to the specific, and there may be multiple “routes”
that define the content at the end of the hierarchy.
This type of categorization lets you create a navigation structure
(independent of the folder structure) that matches the way different
site visitors want to find what they are looking for.
For example, Arnold Schwarzenegger can be thought of as an
actor, Mr. Olympia or as a California governor. Taxonomy creates a
one-to-many relationship with any content about Schwarzenegger
and auto-generates navigation which can support all of the
approaches to accessing any content about him. Site visitors can
find the content whichever way that they think about it.
Ektron’s taxonomy system plays key roles in more than just
organizing content. CMS400.NET’s URL Aliasing is able to autogenerate human readable and SEO-friendly addresses based on
the taxonomic structure of the page. Because it is using the various
ways that people relate to the content to determine the alias,
search engines will find it based on multiple terms as well.
A taxonomy directory control can automatically create the
navigation on your Web site. Once the content is tagged, it
automatically shows up in the correct section of the site. The
author doesn’t need to know where the content is going to show
up, the taxonomy tagging will determine that. If you are managing
large amounts of information, this use of taxonomy is especially
powerful.
Taxonomy can also improve search functionality, and Ektron’s
integrated search takes full advantage of it.

Introduction to Creating a Taxonomy
When working with content, you can place a listing of those
categories (a taxonomy) on a Web page. When that page displays,
the taxonomy’s categories appear, followed by all published items
in the taxonomy.
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To help site visitors find your Web site’s content via a taxonomy,
your developer places a Directory server control on a Web page. It
looks something like this.

There is no limit to the number of category levels you can assign to
a taxonomy.
Also, a taxonomy can provide a link to all content in a folder, so the
display is based on folder structure. Alternatively, you can assign
content items from various folders to a taxonomy.
To illustrate the benefits of a content-based taxonomy, assume
your Web site is for a college. Several items relating to the
graduate school are organized under major departments:
Admissions, Academics, Faculty, Library, etc. You can create a
Graduate School taxonomy, use it to categorize all content relevant
to graduate students (regardless of their department), and display
them on a graduate students page.
The following sections explain Taxonomies in more detail.

• ”Creating a Taxonomy” on page 637
• ”Assigning a Taxonomy/Category to Content or Users” on
page 649
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• ”Additional Taxonomy/Category Tasks” on page 662
• ”Displaying a Content Item Taxonomy Search on your Web
Site” on page 678

• ”Multi-Language Support for Taxonomies” on page 679
• ”Using Taxonomies with Social Networking” on page 686

Creating a Taxonomy
Follow these steps to create and deploy a taxonomy.
1. ”Planning the Taxonomy” on page 637
2. ”Creating a Taxonomy” on page 638
3. ”Applying a Template to a Taxonomy or Category” on page 643
4. ”Assigning a Taxonomy Configuration” on page 646
5. ”Assigning a Taxonomy/Category to Content or Users” on
page 649
6. ”Assigning a Folder to a Taxonomy/Category” on page 659
7. ”Insert the Directory Server Control on a Web Page” on
page 662

Planning the Taxonomy
It helps to design a taxonomy on paper before creating it in Ektron
CMS400.NET. This can let you determine relationships among the
kinds of information before you try to implement the taxonomy.
As an example, here is a hierarchy of some content in the Ektron
CMS400.NET sample site. The top level item is the taxonomy. All
levels below it are categories.
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Next, review the site content and decide which content items and
folders to assign to which taxonomy categories. Some categories
may map directly to a folders. Other categories may use content
from several folders.
Once you determine how content and folders will be assigned to
taxonomy categories, sign on to Ektron CMS400.NET and set up
those relationships.

Creating a Taxonomy
NOTE

Only administrators or users to whom the Taxonomy-Administrator role has been
assigned see the Modules > Taxonomy option. See Also: ”Defining Roles” on
page 787

1. From the Workarea, go to Modules > Taxonomy.
2. Use the language selector pull-down to choose a language for
the taxonomy (see below).
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See Also: ”Creating a Taxonomy in a Multi-Language
Environment” on page 680
3. Click the Add Category button (

).

4. The Add Taxonomy or Category screen appears.
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5. Use the following table to complete the screen.

Field

Description

Category Title

Give the taxonomy a title. The title identifies the
taxonomy wherever it appears.

Category
Description

If desired, enter a more complete description of
the taxonomy. It appears only on the Edit
Taxonomy screen.
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Field

Description

Taxonomy Image

If desired, you can assign an image to this
taxonomy. For example, in the eCommerce
feature, you could display this taxonomy image to
indicate the type of products that make up the
taxonomy.

For more information, see

To display the taxonomy image, use Ektron
CMS400.NET’s API. A sample of how to do this is
provided in the following file: site root/
developer/taxonomy/taxonomy_image.aspx.
To see the sample on a Web page, go to the
Developer sample page > Taxonomy >
Taxonomy Image. To download the developer
sample site, go to http://www.ektron.com/
solutions/startersites/.
Template

If desired, select a template to apply to the
taxonomy or category.

Inherit (only
appears when
creating a
category
underneath a
taxonomy)

Check this box if you want this category to inherit
its template from the parent category or taxonomy.
If not, assign a template using the Template field
(above).

Category Link

Use this field to direct a Web site visitor who clicks
this taxonomy/category to any page on your Web
site. For example, when someone is using your
site’s company directory and clicks Human
Resources > Benefits, he is directed to that area of
your Web site.

”Applying a Template to a
Taxonomy or Category” on
page 643

Without a Category Link, if a site visitor clicks a
taxonomy category, the results appear on the
same page.
Enter a path to a destination page relative to your
site root folder. For example, aboutus.aspx.
When a site visitor clicks this taxonomy/category,
he is directed to http://your URL/Site root
folder/aboutus.aspx.
You could also direct the user to a content ID, such
as aboutus.aspx?id=62.
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Field

Description

For more information, see

Display?

Check this box if you want this taxonomy/category
and its subcategories to appear when this
taxonomy appears on your Web site.
Use this field to block certain categories from
appearing as part of this taxonomy. For example,
you have not finished creating content for the
category, so you don’t want it to appear yet.
If you uncheck this box, this node and its child
nodes are indicated by a gray background (see
image below).

The gray background also appears when users
work with this taxonomy/category on the Edit
Content screen’s Category tab.
This setting does not prevent you from assigning
taxonomies/categories in the E kt ro n
C M S 4 0 0 . N E T Workarea.
Configuration

Select a configuration with which to associate the
taxonomy.

•
•
•

”Assigning a Taxonomy
Configuration” on page 646

Content
User
Group

Notes:
* By default, a new taxonomy’s configuration is
content.
* This field only appears for a taxonomy. It does
not appear for categories, which are below the
taxonomy.

6. Click the Save button (

).

7. The View All Taxonomies screen reappears, and you can see
the new taxonomy.
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8. Next, assign items and/or folders to the taxonomy. To do that,
click it from the View All Taxonomies screen.
9. Hover the cursor over the taxonomy. A menu appears.

See Also: ”Numbers on the View Categories Screen” on page 648
10. If you want to assign content, folders, etc. to this taxonomy,
click Assign Item(s) or Assign Folder(s). These procedures
are more fully explained in ”Assigning a Taxonomy/Category to
Content or Users” on page 649 and ”Remove Content from a
Taxonomy/Category” on page 670.
NOTE

You can also assign a Taxonomy to content using the Edit Content in Folder
screen’s Category tab. See Also: ”Assigning a Taxonomy/Category to Content or
Users” on page 649

11. If you want to add categories and subcategories underneath
the top level taxonomy, click Add. See Also: ”Add a Category
to a Taxonomy/Category” on page 669

Applying a Template to a Taxonomy or Category
Taxonomy categories are designed to help site visitors find
content. To provide a taxonomy-based search, your developer
places a Directory server control on a Web page.
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By default, when a user clicks a hyperlink on such a Web page, it
uses the template assigned to the linked content (as illustrated
below). See Also: ”Creating/Updating Templates” on page 70

If you want to display the linked content using a different template,
follow these steps.
1. When creating or editing a taxonomy or category, select the
appropriate template at the Template pull-down field.
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NOTE

Any category below the root level can inherit its parent’s taxonomy template. Use
the Inherit checkbox to do this.

You may need a developer’s help with the rest of these steps.
2. In Visual Studio.Net, open the .aspx page that contains the
directory server control.
3. Look at the server control’s MarkupLanguage property.
4. If the property is blank, open the following file: site
workarea/template/taxonomy/taxonomy.ekml.

root/

If the property displays an .ekml file, open that file. Its path may
be listed in the property. If the .ekml file’s path is blank, it is
workarea/template/taxonomy/.
5. Find the following line:
[$HyperLink]<br/>[$Teaser]

6. Replace it with the following:
<a href="[$TemplateQuickLink]">[$Title]</a><br/>[$Teaser]

7. Save the .ekml file.
The content selected from this Directory server control will now use
the template assigned to the taxonomy/category.
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Assigning a Taxonomy Configuration
There are three taxonomy configurations (that is, types). Each
taxonomy is one of these types.

Configuration

Result

Content

Associate this taxonomy with content. When this configuration is selected

•
•

you can assign content to the taxonomy/category
the taxonomy category appears on every folder’s properties screen
(shown below)

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

646

Taxonomy

Configuration

Result

User

Associate this taxonomy with CMS or membership users. You select users
for this taxonomy on the Assign Items to Taxonomy screen.

After users are assigned to a taxonomy, they can be found via the
CommunitySearch server control’s Advanced tab. From the Advanced tab,
select Category from the Users dropdown, and a User Categories selector
appears (shown below).

See Also: ”Using Taxonomies with Social Networking” on page 686

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

647

Taxonomy

Configuration

Result

Group

This taxonomy‘s categories can be assigned to community groups from the
Category tab of the Edit Community Group screen. See example below.

If you do not check this box, users can only view taxonomy/category
assignments on the Category tab.
Whether or not this box is checked, you can assign taxonomy categories to
community groups via the View All Categories of Taxonomy screen.
See Also:

•
•

”Viewing a Taxonomy” on page 663;

•

”Using Taxonomies with Social Networking” on page 686

”Assigning a Taxonomy or Category to Community Group via the Edit
Community Group Screen” on page 661

Numbers on the View Categories Screen
On the View All Categories of Taxonomy screen, the number to the
right of any taxonomy/category is a cumulative total of all items
assigned to it and its subcategories. In the example below, the
three subcategories have a total of 13 items (2 + 1 + 10).
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Since the number to the right of the parent category equals the
number assigned to all subcategories, you know that no items are
assigned to the parent category.
Also, the number includes individual items plus all items in any
assigned folders. So, for example, if one content item and one
folder are assigned to a category, and the folder has five items, the
category’s number is six.

Assigning a Taxonomy/Category to Content or
Users
There are three ways to assign a taxonomy or category to content
or users.
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To assign a
a taxonomy
category to

Available methods

Prerequisites

For more information,
see

Content

from the Edit Content
in Folder screen

•

Must be authorized to edit
the folder’s content

•

”Content Editor-Based
Taxonomy Assignment” on
page 650

You can only select from
taxonomies assigned to the
content’s folder

Note:
Regardless of
the method
you use to
assign a
taxonomy to
content, the
result is the
same.
Users

from the Modules >
Taxonomy screen

Must be member of
administrators group or
Taxonomy administrator

”Administrator-Based
Taxonomy Assignment” on
page 655

from a community
group

Taxonomy’s Configuration >
Group check box is checked

”Assigning a Taxonomy or
Category to Community
Group via the Edit
Community Group Screen”
on page 661

Content Editor-Based Taxonomy Assignment
Ektron CMS400.NET lets content editors assign a taxonomy

category to content. They do this by navigating to a content block,
clicking its Category tab, opening a taxonomy, and checking the
correct level.
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However, all taxonomies may not be available to every content
item. Use a folder property's Taxonomy area to control which
taxonomies can be assigned to a content in that folder.
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For example, a folder’s content consists of restaurants, and you
want to restrict users to the Restaurant taxonomy -- users cannot
assign other categories to that folder’s content.
The following topics explain how administrators set up a folder’s
taxonomy properties, and how a user assigns taxonomy categories
to content in that folder.

• ”Assigning Taxonomies to a Folder” on page 653
• ”Inheriting Taxonomies from a Parent Folder” on page 654
• ”Requiring Content to Have at Least One Category Assigned”
on page 654

• ”Assigning a Taxonomy or Category to Content via the Edit
Content Screen” on page 654
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• ”How a Folder’s Taxonomy Properties are Affected by MultiLanguage Support” on page 683

Assigning Taxonomies to a Folder
To make a taxonomy available to a folder, follow these steps.
1. Navigate to the folder.
2. Choose View > Folder Properties.
3. In the Taxonomy section of the screen (shown below),
uncheck the Inherit Parent Taxonomy Configuration
checkbox. See Also: ”Inheriting Taxonomies from a Parent
Folder” on page 654
4. Check taxonomies that should be available to this folder.
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5. From now on, users editing content in this folder can assign
categories from the selected taxonomies.

Inheriting Taxonomies from a Parent Folder
Unlike some folder properties, Taxonomy settings are not inherited
from a parent folder by default. But you can cause them to be
inherited if that is appropriate.
If you are not working on the root folder and the appropriate set of
Taxonomies is applied to a folder’s parent folder, go to the folder’s
properties screen and check the Inherit Parent Taxonomy
Configuration checkbox.

Requiring Content to Have at Least One Category Assigned
In the folder properties, you can require all content to be assigned
at least one taxonomy category. If you do, when content in that
folder is saved, Ektron CMS400.NET checks for at least one
taxonomy category. If none is found, the user is notified that he
must assign a taxonomy category before he can save the content.
To set a folder-level requirement for all content to be assigned a
taxonomy category, follow these steps.
1. Navigate to the folder.
2. Choose View > Folder Properties.
3. In the Taxonomy section, check the Require at Least One
Category Selection checkbox.

Assigning a Taxonomy or Category to Content via the Edit Content
Screen
1. Navigate to a content item.
2. Hover the cursor over the adjacent triangle and click.
3. Click View from the dropdown menu.
4. From the View Content screen, click the Edit button (

).

5. Click the Category tab.
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6. Check the taxonomies or categories to apply.
7. Save the content.

Administrator-Based Taxonomy Assignment
Assigning Content to a Taxonomy/Category
Members of the administrators group or taxonomy administrators
can assign taxonomy categories to content via the View All
Categories of Taxonomy screen. See Also: ”Defining Roles” on
page 787

1. From the Workarea, go to Modules > Taxonomy.
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2. Select a language whose taxonomies you want to work with
(see image below). You can choose All.

See Also: ”Assigning Content to a Multi-Language Taxonomy” on
page 682
3. Select a taxonomy.
4. The taxonomy appears on the View All Categories of
Taxonomy screen.
5. Select the category to which you want to assign content.
6. Click Assign Item(s).

7. Choose the object type of the item to associate.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

656

Taxonomy

8. If you selected Content as the object type, you can narrow
down the type of content you wish to see via the Type pulldown.

• All types - both archived and active content
• Content - active content only
• Archived Content - only content that has been archived and
set to remain on site See Also: Ektron CMS400.NET User
Manual section “Scheduling Content to Begin and End” >
“Setting Archive Options”
9. Navigate to the folder that contains the content you want to
assign to the taxonomy or category.
or
Search for the user or community group to assign to the
taxonomy or category.
NOTE

Folder content appears below the folder list (see below). Also, only content in the
selected language appears.
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10. Check the box to the left of content, user or community group
you want to assign. You can assign all types of content, even
blogs.
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Assigning a Folder to a Taxonomy/Category
NOTE

If you assign a folder, the internal relationship is between the folder’s content and
a taxonomy category. The folder is merely a convenience for creating this
relationship. There is no data connection between a folder and a taxonomy
category.

You can assign a folder to a taxonomy, thereby displaying
published content in the folder when the page is viewed. As
content is added to or removed from the folder, the taxonomy on
the Web page changes dynamically.
For example, you have a “Top News Stories” folder, in which old
news items are frequently replaced by newer ones. The taxonomy
only shows the latest news items. The updating of the content is
handled by the taxonomy automatically.
NOTE

Only administrators or users to whom the Taxonomy-Administrator role has been
assigned see the Modules > Taxonomy option. See Also: ”Defining Roles” on
page 787

To assign a folder to a taxonomy category, follow these steps.
1. From the Workarea, go to Modules > Taxonomy.
2. Select the language of the taxonomy that you want to work
with.
See Also: ”Assigning Folders to a Multi-Language Taxonomy” on
page 685
3. Select the taxonomy from the View All Taxonomies Screen.
4. Select the taxonomy or category under which you want to
assign a folder.
5. Click Assign Folder(s).
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6. Navigate to the folder you want to assign to the taxonomy or
category.
7. Check the box to the left of all folders you want to assign.

IMPORTANT!

Only checked folders are assigned to the taxonomy/category. Checking a parent
folder has no effect on its child folders.
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Assigning a Taxonomy or Category to Community Group via
the Edit Community Group Screen
Prerequisite
You can perform this procedure only if a taxonomy’s
Configuration > Group check box is checked.

If it is not checked, you can view the taxonomy categories
assigned to a Community Group on the Edit Community Group
Screen. And, you can assign Community Groups to a Taxonomy
via the View all Categories of Taxonomy screen.
1. In the Workarea, navigate to Modules > Community
Management > Community Groups > Groups.
2. Select a community group.
3. Select the Category tab.
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4. Check the taxonomies or categories to apply.
5. Click the Save button.

Insert the Directory Server Control on a Web Page
See the Ektron CMS400.NET Developer Manual chapter
“Introduction to Ektron CMS400.NET Server Controls” > “Directory
Server Control.”
See Also: ”Displaying a Content Item Taxonomy Search on your
Web Site” on page 678

Additional Taxonomy/Category Tasks
The following sections explain additional tasks you can perform
when working with a Taxonomy or its categories.

• ”Viewing All Taxonomies” on page 663
• ”Viewing a Taxonomy” on page 663
• ”Edit a Taxonomy/Category’s Fields” on page 667
• ”Delete a Taxonomy/Category” on page 668
• ”Add a Category to a Taxonomy/Category” on page 669
• ”Remove Content from a Taxonomy/Category” on page 670
• ”Remove Folder from a Taxonomy/Category” on page 672
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• ”Change Order of Categories Assigned to a Taxonomy/
Category” on page 673

• ”Change Order of Content Assigned to a Taxonomy/Category”
on page 674

• ”Importing and Exporting a Taxonomy” on page 675

Viewing All Taxonomies
The View All Taxonomies screen displays all taxonomies currently
in Ektron CMS400.NET. The language pull down lets you filter the
list by a language.
To work with any taxonomy, select it. When you do, it appears
within the View All Categories of Taxonomy screen.
You can also use the View All Taxonomies screen to perform these
tasks.

Button

Task

For more information, see

Add new taxonomy

”Creating a Taxonomy” on page 638

Delete one or more taxonomies

”Deleting a Taxonomy from the View All
Taxonomies Screen” on page 668

Import a taxonomy

”Importing and Exporting a Taxonomy” on
page 675

Export for Translation

”Using the Language Export Feature” on page 882

Viewing a Taxonomy
The View All Categories of Taxonomy screen exposes all
categories in a selected taxonomy.
Use this screen to perform tasks on a taxonomy or one of its
categories, such as adding new categories, assigning content to a
category, and changing the order of items.
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NOTE

On the View All Categories of Taxonomy screen, a dashed box indicates the
selected Taxonomy/category (see below).

To access the View All Categories of Taxonomy screen, follow
these steps.
1. From the Ektron CMS400.NET Workarea, go to Modules >
Taxonomy > View All Taxonomies.
2. Use the language pull-down to select the language of the
taxonomy you want to work with.

3. Click a taxonomy.
Tasks you can perform from this screen are listed below.
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Task

How to initiate

Edit a taxonomy’s fields (title,
description, template, etc.)

Click Edit toolbar button (

For more information, see
”Use the following table to complete
the screen.” on page 640

)

or

Delete a taxonomy

Export a taxonomy

1.

Place cursor over the taxonomy/category.

2.

Click Edit Properties from
the popup menu.

Click Delete toolbar button (

Click Export Taxonomy toolbar
button (

Add a taxonomy category

View a taxonomy category

Change the order of items in a
taxonomy/category

Delete a category

Assign content items to a
category

)

)

1.

Select the taxonomy/category under which the new
category should appear.

2.

Click Add from the popup
menu.

1.

Place the cursor over the
taxonomy/category.

2.

Click View/Edit Items from
the popup menu.

1.

Place the cursor over the
taxonomy/category.

2.

Click Reorder from the
popup menu.

1.

Place the cursor over the
taxonomy/category.

2.

Click Delete from the
popup menu.

1.

Place the cursor over the
taxonomy/category.

2.

Click Assign Item(s) from
the popup menu.
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All Taxonomies Screen” on
page 668
”Exporting a Taxonomy” on
page 676
”Administrator-Based Taxonomy
Assignment” on page 655

”Change Order of Categories
Assigned to a Taxonomy/Category”
on page 673

”Deleting a Taxonomy from the View
All Taxonomies Screen” on
page 668

”Assigning a Taxonomy/Category to
Content or Users” on page 649
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Task

How to initiate

For more information, see

Assign folders to a category

1.

Place the cursor over the
taxonomy/category.

”Assigning a Folder to a Taxonomy/
Category” on page 659

2.

Click Assign Folder(s)
from the popup menu.

Viewing a Taxonomy or Category
To view any taxonomy or category, move the cursor over it then
select View/Edit Items from the popup menu.

The View screen displays the taxonomy/category’s information
(title, description, image, template, etc.). The bottom of the screen
shows assigned content items, folders, users, or community
groups, depending on how the View dropdown is set.
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From here, you can perform these tasks.

Task

Directions

Edit taxonomy/category fields (title, description,
image, etc.)

See ”Edit a Taxonomy/Category’s Fields” on page 667.

Remove items (content, folders, users or
community groups) from the taxonomy/category

See ”Deleting a Category from the View All Categories of
Taxonomy Screen” on page 668

Edit a Taxonomy/Category’s Fields
To edit a Taxonomy’s fields, follow these steps.
NOTE

Only administrators or users to whom the Taxonomy-Administrator role has been
assigned see the Modules > Taxonomy option. See Also: ”Defining Roles” on
page 787

1. From the Workarea, go to Modules > Taxonomy.
2. Click the taxonomy from the View All Taxonomies Screen.
3. Click the Edit button ( ) or hover the cursor over the
taxonomy and select Edit Properties from the popup menu.

4. For a description of these fields, see ”Use the following table to
complete the screen.” on page 640
See Also: “Applying a Template to a Taxonomy or Category” on
page 643
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Delete a Taxonomy/Category
There are two ways to delete a taxonomy or category.

• ”Deleting a Taxonomy from the View All Taxonomies Screen”
on page 668

• ”Deleting a Category from the View All Categories of
Taxonomy Screen” on page 668
After you delete a taxonomy, it can no longer be assigned to
content and folders. Further, existing links to content (via the
Category tab) are deleted. And, if the taxonomy was assigned to a
folder (via the Folder Properties screen), it is no longer assigned.
See Also: ”Deleting a Taxonomy in a Multi-Language Environment”
on page 681

Deleting a Taxonomy from the View All Taxonomies Screen
NOTE

Only administrators or users to whom the Taxonomy-Administrator role has been
assigned see the Modules > Taxonomy option. See Also: ”Defining Roles” on
page 787

1. From the Workarea, go to Modules > Taxonomy.
2. From the View All Taxonomies Screen, check the box to the left
taxonomy you want to delete.
3. Click the delete button (
NOTE

).

The delete button does not appear if the language selector is set to All.

Deleting a Category from the View All Categories of Taxonomy Screen
1. From the Workarea, go to Modules > Taxonomy.
2. Select the taxonomy from the View All Taxonomies Screen.
3. Hover the cursor over the taxonomy or category and select
Delete from the popup menu.
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4. A confirmation message appears. Click OK.

Add a Category to a Taxonomy/Category
Follow these steps to add a category to a taxonomy, or to add a
subcategory to a category.
NOTE

Only administrators or users to whom the Taxonomy-Administrator role has been
assigned see the Modules > Taxonomy option. See Also: ”Defining Roles” on
page 787

1. From the Workarea, go to Modules > Taxonomy.
2. Select a taxonomy from the View All Taxonomies Screen.
3. Select the taxonomy or category under which you want to
create a new category.
4. Click Add from the popup menu.
5. The Add Category screen appears.
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6. Complete the fields for the new category. See Also: ”Use the
following table to complete the screen.” on page 640
7. Click the Save button (

).

Remove Content from a Taxonomy/Category
NOTE

Only administrators or users to whom the Taxonomy-Administrator role has been
assigned see the Modules > Taxonomy option. See Also: ”Defining Roles” on
page 787

See Also: ”Removing Content from a Multi-Language Taxonomy”
on page 683
1. From the Workarea, go to Modules > Taxonomy.
2. Select a taxonomy from the View All Taxonomies Screen.
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3. Select the taxonomy or category that has content that you want
to edit.
4. Click View/Edit Items from the popup menu.
5. The View Taxonomy screen appears.
6. From the View dropdown, select Content.

7. Check the box to the left of content you want to remove.
TIP!

To remove all content, check the box in the title bar.
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8. Click the delete button (

).

Remove Folder from a Taxonomy/Category
NOTE

Only administrators or users to whom the Taxonomy-Administrator role has been
assigned see the Modules > Taxonomy option. See Also: ”Defining Roles” on
page 787

• ”Background Information” on page 672
• ”Steps for Removing a Folder” on page 672
• ”Removing Folders from a Multi-Language Taxonomy” on
page 685

Background Information
If you assign a folder to a taxonomy category, the internal
relationship is between the folder’s content and a taxonomy
category. A folder is merely a convenience for creating this
relationship. There is no data connection between a folder and a
taxonomy category.
Therefore, if you delete a folder from a taxonomy category, all
content in that folder remains assigned to it. To remove the folder’s
content from the category, see ”Remove Content from a
Taxonomy/Category” on page 670.
However, after deleting a folder, the connection between the folder
and taxonomy category is broken. So, content subsequently added
to the folder is not assigned to the taxonomy.

Steps for Removing a Folder
1. From the Workarea, go to Modules > Taxonomy.
2. Select a taxonomy from the View All Taxonomies Screen.
3. Select the taxonomy or category that has folder that you want
to delete.
4. Click View from the popup menu.
5. The View Taxonomy screen appears.
6. From the View dropdown, select Folder(s).
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7. Check the box to the left of folders you want to remove.
TIP!

To remove all folders, check the box in the title bar.

8. Click the delete button (

).

Change Order of Categories Assigned to a Taxonomy/
Category
NOTE

Only administrators or users to whom the Taxonomy-Administrator role has been
assigned see the Modules > Taxonomy option. See Also: ”Defining Roles” on
page 787

You can reorder (that is, change the sequence of) the categories
below a taxonomy or one of its categories. Reordered
subcategories appear only within the Ektron CMS400.NET
Workarea.
To reorder the categories assigned to a taxonomy or category,
follow these steps.
See Also: ”Reordering Categories in a Multi-Language Taxonomy”
on page 686
1. From the Workarea, go to Modules > Taxonomy.
2. Select the taxonomy from the View All Taxonomies Screen.
3. Select the taxonomy or category that has content that you want
to reorder.
4. Click Reorder from the popup menu.
5. Set the reorder pull-down list to Category.
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6. Select an item that you want to move up or down.
7. Click the up or down arrow to move the item in that direction.
8. Continue steps 6 and 7 until all content is in the desired order.
9. If there are several language versions of this taxonomy, you
can automatically reorder all versions. To do that, check Apply
ordering for all languages.
10. Click the Save button (

).

Change Order of Content Assigned to a Taxonomy/Category
You can reorder (that is, change the sequence of) content within a
category. Reordered content appears within the Ektron
CMS400.NET Workarea and can appear on your Web site of the
Directory server control’s ItemSortOrder property is set to
taxonomy_item_display_order.
See Also: ”Reordering Content in a Multi-Language Taxonomy” on
page 686
To reorder the content assigned to a category, follow these steps.
NOTE

Only administrators or users to whom the Taxonomy-Administrator role has been
assigned see the Modules > Taxonomy option. See Also: ”Defining Roles” on
page 787

1. From the Workarea, go to Modules > Taxonomy.
2. Select the taxonomy from the View All Taxonomies Screen.
3. Select the taxonomy or category that has content that you want
to reorder.
4. Click Reorder from the popup menu.
5. Set the reorder pull-down list to items.
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6. All items assigned to the category appear.

7. Select a content block that you want to move up or down.
8. Click the up or down arrow to move the item in that direction.
9. Continue steps 7 and 8 until all content is in the desired order.
10. Click the Save button (

).

Importing and Exporting a Taxonomy
You can export any taxonomy as an xml file. Then, you can reuse it
or send it to someone else, who would import it in order to bring a
copy of it onto their computer.
You can use the Export/Import feature like a “save as” feature. For
example, you want to create a taxonomy that is similar to an
existing one but has some differences. The easiest way to do this
is to export an existing one, import it under a new name, and edit it.
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Below is an example of part of a taxonomy saved as an XML
document.
<?xml version="1.0" ?>
- <TaxonomyData xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:xsd="http://
www.w3.org/2001/XMLSchema">
<TaxonomyName>MapCategory</TaxonomyName>
<TaxonomyDescription>map</TaxonomyDescription>
- <Taxonomy>
- <TaxonomyData>
<TaxonomyName>Sports</TaxonomyName>
<TaxonomyDescription>sports</TaxonomyDescription>
</TaxonomyData>
- <TaxonomyData>
<TaxonomyName>Banks</TaxonomyName>
<TaxonomyDescription>Banks</TaxonomyDescription>
</TaxonomyData>
- <TaxonomyData>
<TaxonomyName>Pharmacies</TaxonomyName>
<TaxonomyDescription>Pharmacies</TaxonomyDescription>
</TaxonomyData>
- <TaxonomyData>
<TaxonomyName>Travel</TaxonomyName>
<TaxonomyDescription>Travel</TaxonomyDescription>
</TaxonomyData>
- <TaxonomyData>
<TaxonomyName>Restaurant</TaxonomyName>
<TaxonomyDescription>Restaurant</TaxonomyDescription>
- <Taxonomy>
- <TaxonomyData>
<TaxonomyName>American</TaxonomyName>
<TaxonomyDescription>American</TaxonomyDescription>
</TaxonomyData>
- <TaxonomyData>
<TaxonomyName>Indian</TaxonomyName>
<TaxonomyDescription>Indian</TaxonomyDescription>
</TaxonomyData>

Exporting a Taxonomy
Exporting a taxonomy means saving it as an .xml file on your
computer or network drive. To export a taxonomy, follow these
steps.
1. From the Workarea, go to Modules > Taxonomy.
2. Select the language of the taxonomy that you want to export.
3. All taxonomies in that language appear.
4. Click a taxonomy that you want to export.
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5. Click the Export Taxonomy button (

).

6. You are prompted to select a folder into which to save it.

Importing a Taxonomy
1. From the Workarea, go to Modules > Taxonomy.
2. Click the Import Taxonomy button (

).

3. The Import Taxonomy screen appears.

4. In the Title field, enter a name for your new taxonomy.
5. Click the Browse button.
6. Navigate to the taxonomy file you want to import.
7. The path appears in the File field.
NOTE

Alternatively, you can enter or paste the xml into the XML box.

8. Determine the taxonomy’s configuration. See ”Configuration”
on page 642
9. Click the Save button (
NOTE

).

If you assign a name that is already given to a taxonomy, Ektron CMS400.NET
appends a number to the title, beginning with 1.
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Displaying a Content Item Taxonomy Search on
your Web Site
When your Web developer places a Directory server control on a
Web page, he can use the Enable Search property to include a
Search box with the taxonomy display (circled below).

The box helps site visitors find content by returning only items that
include a search phrase and are assigned to a selected category.
When placing a Directory server control, your Web developer
defines a Taxonomy ID number. The ID determines the top level of
the taxonomy that appears below the Search box, to the right of
Breadcrumb. Below that are categories that exist directly below
the Taxonomy ID.

Using the Taxonomy Search
To use the search, a site visitor enters a search term and clicks the
Directory radio button (above the Search box). The screen may
return links in two areas below Breadcrumb.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

678

Taxonomy

• Category - all categories below the selected level with content
that includes the search term. Click a category to see a list of
content that includes the search term in that taxonomy/
category level or one of its subcategories.

• Articles - content within the currently selected taxonomy/
category level that includes the search term
As illustrated below, within the Editor category, one category
(eWebEditPro) includes content with the word library. And, one
content block (The best Microsoft Word content processing)
includes library.

Multi-Language Support for Taxonomies
This section explains of how Taxonomy is supported in a multilanguage environment. It consists of the following topics.

• ”Creating a Taxonomy in a Multi-Language Environment” on
page 680

• ”Deleting a Taxonomy in a Multi-Language Environment” on
page 681

• ”Enabling/Disabling a Language in a Multi-Language
Environment” on page 681
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• ”Taxonomy Properties in a Multi-Language Environment” on
page 682

• ”Assigning Content to a Multi-Language Taxonomy” on
page 682

• ”Removing Content from a Multi-Language Taxonomy” on
page 683

• ”How a Folder’s Taxonomy Properties are Affected by MultiLanguage Support” on page 683

• ”Assigning Folders to a Multi-Language Taxonomy” on
page 685

• ”Removing Folders from a Multi-Language Taxonomy” on
page 685

• ”Reordering Content in a Multi-Language Taxonomy” on
page 686

• ”Reordering Categories in a Multi-Language Taxonomy” on
page 686

Creating a Taxonomy in a Multi-Language Environment
When you create a new taxonomy, you select a language. At that
point, a version of that taxonomy is also created for each enabled
language.
For example, you create a taxonomy in English, and French and
Spanish are also enabled (in the Settings > Language Settings
screen). Ektron CMS400.NET now has versions of that taxonomy in
English, French, and Spanish. The ID of each taxonomy is the
same, but the language ID is different. You do not need to use all
language versions.
The three versions now linked and cannot be unlinked. So, for
example if you assign a category to the English taxonomy, that
category is also assigned to the French and Spanish versions. Of
course, since the text is English, it will probably have to be
translated. See Also: ”Using the Language Export Feature” on
page 882

Upgrading and Multi-Language Taxonomy Support
As of version 7.6.5, any new taxonomies are synchronized. That is,
if you create a taxonomy in English, one is created with the same
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taxonomy ID but a different language ID in all other enabled
languages. And, if you add categories to one language taxonomy,
those categories are automatically added to the other language
versions of that taxonomy.
Previously, CMS400.NET allowed multiple language versions of a
taxonomy, but changes to one language did not affect the
language-related versions. If your Ektron CMS400.NET has such
versions, the 7.6.5 upgrade does not synchronize your taxonomy.
Furthermore, no additional versions of that taxonomy will be
created in other enabled languages. Ektron assumes that, since
taxonomies in those languages already exist, you want to keep
them as they are. So, for example, assume you created a
taxonomy in a previous version of Ektron CMS400.NET in English
and Spanish. The upgrade does not synchronize them.

Enabling Taxonomy Synchronization for Taxonomies that Existed Prior
to 7.6.5 Upgrade
Suppose that, after the 7.6.5 upgrade, you want to transform an
unsynchronized taxonomy to a synchronized multi-language
taxonomy, so that changes to one are automatically reflected in the
others. To accomplish this, upgrade to 7.6.5 and delete the
Spanish version. At that point, a version of that taxonomy will be
created for every enabled language and synchronized with the
English version. You now have the option of translating category
names manually or exporting the taxonomy, translating it and then
importing back in. See Also: ”Using the Language Export Feature”
on page 882

Deleting a Taxonomy in a Multi-Language Environment
If you delete a taxonomy, all related language versions are also
deleted.

Enabling/Disabling a Language in a Multi-Language
Environment
If you enable a new Workarea language, a version of every
taxonomy created in version 7.6.5 and above is automatically
created in that language.
If you disable a language, all of its taxonomies are deleted.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

681

Taxonomy

See Also: ”Determining Which Languages are Available” on
page 872

Taxonomy Properties in a Multi-Language Environment
Initially, all related-language versions of a taxonomy take their
properties from the original language version. For example, if you
create a taxonomy in English and French is also enabled, the
French Taxonomy description is the same as the English one, as
are the taxonomy image, taxonomy template, value of Display?
checkbox, etc.
However, after the initial creation of the multiple-language
versions, changes to taxonomy properties affect the current
language only -- they do not affect the related-language versions.
Exception - When you edit the taxonomy Display? property, you
are prompted to apply the change to all languages or the current
language only. See Also: ”Display?” on page 642

Assigning Content to a Multi-Language Taxonomy
As explained in ”Multi-Language Support” on page 868, Ektron
CMS400.NET supports multiple language versions of content, as
shown below.

As you can see, Content ID=30 exists in English, Spanish and
German.
When applying content to a taxonomy category, you can only apply
content whose language matches the taxonomy language. If that
content exists in other languages, the related-language version is
also applied to the related-language taxonomy.
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So, to continue the above example, assume there is a taxonomy in
English and you apply content item ID=30, Sample Content Block
to one of its categories. If that taxonomy exists in German, the
content block titled Ektron CMS400.NET Server Kontrollen (also
ID=30) is applied to the corresponding category in the related
German taxonomy.
If there is no corresponding German content, nothing is applied to
the German taxonomy category.

Removing Content from a Multi-Language Taxonomy
If you remove content from a taxonomy in any language, it is
removed from all language-related taxonomies.

How a Folder’s Taxonomy Properties are Affected by MultiLanguage Support
If there are several language-related versions of a taxonomy and
you select one of them then edit a folder’s taxonomy properties,
content in the related language inherits the taxonomy folder
properties.
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For example, assume I select English, then edit a folder’s
taxonomy properties and apply taxonomy categories. See Also:
”Assigning Taxonomies to a Folder” on page 653
If I later edit French content in that folder, the corresponding
French taxonomy’s categories are available to be assigned via the
Category tab.
Further, the value of the At least one category is Required check
box is also inherited. This means that if a category must be applied
to English content, it is also required for French content.
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Assigning Folders to a Multi-Language Taxonomy
When you assign a folder to a taxonomy category, you indicate
that all folder content is assigned to that node. Ektron CMS400.NET
folders are language-neutral, so the folder is also applied to the
corresponding taxonomy category in every language. However,
only folder content that matches the taxonomy’s language is
assigned to the taxonomy category.
So, for example, a folder has three content blocks.

Language

Content in folder in this language

English

•
•
•

100

•

100

German

101
102

If you apply that folder to a taxonomy, the English version of the
taxonomy has three content blocks assigned, but the German
version only gets one content block (ID 100).
If content is later added to the folder, new English content is
assigned to the English taxonomy, and new German content is
assigned to the German taxonomy.
TIP!

If you apply a folder to a taxonomy, numbers on the View Taxonomy screen
indicate how many content items are applied to it. Unless you have the same
number of content items in each language, this number is different for every
language.

Removing Folders from a Multi-Language Taxonomy
As explained in ”Background Information” on page 672, if you
remove a folder from its assignment to a taxonomy category, the
content in that folder is still applied. So, you must also remove all
of its content, as described in ”Removing Content from a MultiLanguage Taxonomy” on page 683.
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Reordering Content in a Multi-Language Taxonomy
If you reorder the content assigned to a taxonomy category, there
is no change to corresponding categories in other languages. This
is because there is no guarantee that content that exists in one
language exists in the other languages.

Reordering Categories in a Multi-Language Taxonomy
If you reorder categories assigned to a Taxonomy/Category, you
have the option of applying the changes to all language-related
categories (see below).

Using Taxonomies with Social Networking
If you have a community or social networking Web site, you can
assign users and community groups to a taxonomy. This allows
site visitors to search for users and groups by category.
To enable a taxonomy-based search of users and community
groups, a developer uses the following server controls on your site.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

686

Taxonomy

• CommunityGroupBrowser control - lets a site visitor browse
a taxonomy category for community groups

• CommunitySearch control - lets a site visitor search for users
and community groups based on selected criteria
See Also: The Developer Manual section “Introduction to Server
Controls” > “Community Platform Server Controls” >
“CommunityGroupBrowser Server Control” and
“CommunitySearch Server Control.”
NOTE

To see a comparison of taxonomy with other list options available with Ektron
CMS400.NET, see the User Manual section “Web Site Navigation Aids” >
“Working with Collections” > “Comparison of Collections, Menus, Taxonomy, and
the List Summary Features.”
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Personalization is fast becoming an integral part of Web sites like
iGoogle and Facebook, and organizations see personalization as a
way to make their sites stickier and more engaging.
The following video introduces Personalization : http://
www.ektron.com/personalization/

Ektron CMS400.NET provides tools to let membership users

personalize their experience on your site, bringing relevant
information to their fingertips. By letting users add widgets,
applications, and feeds to a Web site, CMS400.NET provides a
framework on which to easily build true, personalized portals.
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Make Your Site, Their Site with CMS400.NET
When membership users can choose and organize content on
their digital dashboard, your site becomes their site. Everyone has
different needs and preferences, and CMS400.NET’s portal
functionality lets you create a more interactive, engaging
experience by giving power to the user.

How Personalization Works
On an Ektron CMS400.NET Web site, personalized areas can have
multiple tabs, letting users organize content by subject – think of
tabbed browsing. Users can easily add new tabs, switch between
them, and define each one as public or private. For example, a tab
that displays personal financial information can be private, so only
that user can see it. Each tab can have multiple columns, to further
customize the view.
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Ektron CMS400.NET widgets can be dragged and dropped into

each tab. These widgets can range from RSS feeds to applets to
Ektron server controls. They make it possible for a site visitor to
access all information from one location, rather than using many
mouse clicks to log into separate Web sites or applications.

Developers can give users access to any pre-built Ektron
CMS400.NET widgets, and even build their own widgets that talk to
third-party systems to customize the way site visitors are engaged.
See Also: “Creating Your Own Widgets” and “Standard Widgets” in
the Ektron PageBuilder Quick Start Guide.

Empower your Intranet ...
Building personalization into your intranet empowers employees
with customization that fits their work and personal life. Widgets
can range from photos, local weather, and updated news to a
personal work calendar, a sales timeline and tracker, or a feed to a
discussion board about a new product release.
Managers can use widgets to enhance their access to their team’s
information. A human resources department can update job
postings on a weekly basis via a widget rather than navigating to
the company’s careers site.
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… and Public Facing Web Sites
Personalization revolutionizes the way visitors interact with sites,
and Ektron CMS400.NET provides the tools to make that happen.
See what some organizations can do with personalization.
•

Healthcare portals have regular site visitors who desire the
same information each time they visit. Enable visitors to
receive allergy, fitness, nutrition, and appointment information
whenever they log in – your site visitors may even save recipes
to their nutrition tab.

•

Clothing store customers are fashion-minded individuals who
like to view the latest styles on these Web sites. Let them view
the department they always go to first with the click of a button.
Clothing widgets can show what’s available in their size. This
personalization will increase site traffic and sales.

•

Banking sites can allow users to access personal account
widgets, and separate it from their business financial
information. Calculator widgets can keep them on the site as
they make financial decisions.

•

Schools personalize their Web site for each student and
parent. Personalized portals let students have widgets such as
school e-mail, personalized school calendars (with their
homework, project due dates and social events), feeds linked
directly to their grades, a school library search tool, and more
to keep them connected and informed.

Personalization enables membership users to access information
they want with the click of a button. No longer do they have to
navigate all over a Web site (or sites) to find content. Ektron
CMS400.NET’s personalization functionality lets organizations
create iGoogle-like interfaces integrated within content
management, so that they can serve their customers and members
in a more powerful and personal way, building user adoption and
increasing site traffic.
The following topics explain personalization in more detail.
•

”Personalization versus Pagebuilder Pages” on page 692

•

”Sample Personalization Pages” on page 693

•

”Creating an Individual Personalization Page” on page 693
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•

”How a Membership User Interacts with an Individual
Personalization Page” on page 698

•

”Creating a Community Group Personalization Page” on
page 701

•

”How a User Interacts with a Community Group
Personalization Page” on page 703

Personalization versus Pagebuilder Pages
Personalization lets a membership user or community group
member customize a single page on your site for their own use. A
Pagebuilder page, on the other hand, lets an Ektron CMS400.NET
user create pages that make up your Web site.
Both page types use widgets. Widgets are described in the
PageBuilder Quick Start Guide.

Individual versus Group Personalization Pages
An individual personalization page is used by a membership or an
Ektron CMS400.NET user to personalize a page on your Web site.
A page consists of tabs, and each tab can contain several widgets.

If a tab is private, only that user can view and edit it. If the tab is
public, anyone can view it but only the signed-in user can create
and edit the content.
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A group personalization page is used by group members to set up
a portal page that addresses that group’s unique needs. Any group
member can view and create or edit the page’s content.
If a tab on a group page is private, only group members can view
and create or edit it. If the tab is public, anyone can view it but only
the group members can create and edit the content.

Sample Personalization Pages
You can find examples of personalization pages in these Ektron
sample sites. You can copy and edit the samples as needed to
build your personalization pages.
To download sample sites, go to http://www.ektron.com/solutions/
startersites/.

Individual Personalization Pages
•

Technology site > Login > My Profile > Dashboard

•

Intranet Site > Login > My Profile > Dashboard

•

Developer Sample site > Personalization

Group Personalization Pages
•

Technology site > Login > Community > Community Groups >
select group, such as Ektron Tech Web Design > Dashboard

•

Intranet Site > Login > Groups > select group > Dashboard

Creating an Individual Personalization Page
Follow these steps to create a personalization page from scratch.
After you create the page, place a link to it on your site. Then, any
authenticated membership user can use the page to create his
own personal portal.
This section consists of the following subtopics.
•

”Widget Spaces” on page 694

•

”Steps for Creating a Personalization Page” on page 694
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•

”Verify that the User is Authenticated” on page 697

Widget Spaces
A widget space is a mechanism that lets you determine which
widgets individual users or a community group can drop onto a
personalization page.
For example, one group of users should only be allowed to drop
weather and news feed widgets onto their personalization page. In
this case, you would
•

Create a widget space.

•

Select only weather and news feed widgets.

•

Sign on to Visual Studio to create the .aspx page.

•

Drop a Personalization user control onto the page.

•

In the control’s widgetspaceID property, identify the widget space
you created in bullet 1.

Steps for Creating a Personalization Page
1. Go to Ektron CMS400.NET Workarea > Settings >
Configuration > Personalization > Widgets. Widgets are
described in the PageBuilder Quick Start Guide.
2. Click the Sync button (

make sure all widgets are available.

3. Go to Settings > Configuration > Personalization > Widget
Space.
4. Click the add button (

).

5. Enter a Title.
6. Only check the Group Space checkbox if this widget space will
be used for a community group personalization page.
7. Select widgets that authorized users will be able to drop onto a
page.
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As you select a widget, its background color changes.
These widgets appear in the personalization screen’s widget
tray (shown below) when a membership user is personalizing a
page.

8. Click the Save button (

).
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NOTE

Remember your widget space’s ID number. You need it when setting up the
Personalization user control.

9. Open Visual Studio.
10. Create a new Web Form.
11. Switch to design view.
12. From the Toolbox, drag and drop an Ajax Extensions > Script
Manager control.

If you do not see a Script Manager control, install the Microsoft
AJAX Library 3.5. To do this, go to http://www.asp.net/ajax/
downloads/.
13. In the Visual Studio folder browser, open the workarea/
personalization/ folder.
14. Drag and drop a Personalization user control
(personalization.ascx).
15. Set the control’s widgetspaceid property (circled below) to the ID
number of the widget space you added in Step 6.
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16. Save the Web Form.

Verify that the User is Authenticated
Your page should redirect the user to the personalization page, or
use an ASP.NET panel to verify that user is authenticated.
NOTE

The asp.net panels are implemented in eintranet and ektrontech site.

Here is sample code you can use.
Aspx.cs
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// To check if user is logged in or not
Ektron.Cms.CommonApi IsUserLoggedIn = new Ektron.Cms.CommonApi();
if (IsUserLoggedIn.IsLoggedIn)
{
Response.Redirect(“dashboard.aspx”);
Or
pnlDashboard.Visible= true;
}
Else
{
pnlDashboard.Visible=false;
}

Aspx
<asp:Panel ID="pnlDashboard" runat="server" Visible="False">
<asp:ScriptManager ID="ScriptManager1" runat="server" EnablePartialRendering="true"></
asp:ScriptManager>
<ucEktron:Personalization ID="widgetSpace" WidgetSpaceID="1" DynamicForeignIDParameter="id"
runat="server" />
</asp:Panel>

How a Membership User Interacts with an
Individual Personalization Page
To access a personalization page, a membership user logs in then
clicks My profile > Dashboard. Initially, the dashboard looks like
this.

Inserting a Tab and Column
The user must first add a tab by clicking the down arrow circled
above and choosing Add Tab.
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Public vs. Private Tab
When creating a tab, the user must decide if it is public or private.

Any logged-in user can see a user’s public tab by visiting his profile
and clicking Dashboard.
A private tab is only visible to the user who created it.

Adding Columns
Next, the user must add at least one column. To do this, he clicks
the down arrow circled below and chooses Add Column.
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Here is an example of a tab with three columns.

Adding Widgets
To add a widget, the user clicks the other down arrow (circled
below), then drags and drops the desired widgets.

The selection of widgets was determined when the widget space
was created. See Also: ”Creating an Individual Personalization
Page” on page 693.
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Creating a Community Group Personalization Page
A community group personalization page is similar to an individual
page. It lets group members customize a page’s content by
dropping widgets. For an introduction to these concepts, see
•

”Personalizing a Web Page” on page 688

•

”Individual versus Group Personalization Pages” on page 692

•

”Sample Personalization Pages” on page 693

•

”Creating an Individual Personalization Page” on page 693

•

”How a Membership User Interacts with an Individual
Personalization Page” on page 698.

Setting up a Community Group Personalization Page
To create a Community Group personalization page, follow the
instructions in ”Creating an Individual Personalization Page” on
page 693, with the following differences
•

When creating a Widget space, check the Group Space
checkbox.

•

When a developer creates an .aspx page and drops a
personalization control, the selected Widget space must be
one whose Group Space box is checked.
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•

A private tab is visible only to group members.
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How a User Interacts with a Community Group Personalization
Page
To access a Community Group personalization page, a
membership or Ektron CMS400.NET user group member logs in
then navigates to the group’s personalization page. See Also:
”Group Personalization Pages” on page 693
Initially, a group personalization page looks like this.

Community group members work with a personalization page in
the same way they work with individual personalization pages. See
”Inserting a Tab and Column” on page 698 and ”Adding Widgets”
on page 700.
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Ektron CMS400.NET’s Menu feature lets users create and maintain

a dropdown menu navigation system for your Web site. Like
Collections, the Menu feature gives you the flexibility to display
links to content, library assets, external hyperlink and submenus.
This section only describes managing permissions to use the
Menus Feature, suggestions for implementing it, and how folder
associations work.For more information about using the Menus
feature, see the Ektron CMS400.NET User Manual section “Working
with Menus.”
See Also:
•

”Permission to Use the Menus Feature” on page 704

•

”Implementation of the Menus Feature” on page 706

•

Ektron CMS400.NET User Manual > 'Web Site Navigation Aids”

> “Working with Menus”

Permission to Use the Menus Feature
There are two ways to create a menu. Each has its own permission
model.
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Menu Creation
Method
Via the Workarea’s
Modules tab

Via the View Contents
of Folder screen’s New
> Menu option

Illustration

How to set permissions

The user must be one of the following.
•

a member of the Administrators user
group

•

assigned the Collection and Menu
Admin role. See Also: ”Defining
Roles” on page 787

•

granted permissions to Collections
for the root folder. This is advanced
permission. See Also: ”Setting Permissions through the Permissions
Table” on page 768

See ”Permissions for Menus Created
from the View Contents of Folder
Screen” on page 705

Permissions for Menus Created from the View Contents of
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Folder Screen
Only users with permission to use the Collections feature
(illustrated below) for a folder can work with menus. If user does
not have permission to Collections, the Menu option does not
appear on the New menu.

Also, if a user has permission to Collections but Read Only
permission for content and the library, he cannot add content from
a navigation link.

Implementation of the Menus Feature
In order for a menu to appear on your Web site, your Web
developer must modify a page template to display it. This
procedure is described in the Ektron CMS400.NET Developer
Manual sections “Ektron CMS400.NET Server Controls” > “List of
Server Controls” > “Menu Server Control”, “Smart Menu Server
Control”, and “DhtmlMenu Server Control.”
See Also:
•

”Assigning Folders or Templates to a Menu” on page 707

•

”Effect of Assigning a Folder to a Menu” on page 708

•

”Effect of Assigning a Template to a Menu” on page 710
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Assigning Folders or Templates to a Menu
The Advanced Settings on the Edit Menu screen has Folder
Associations and Template Associations sections (see image
below). Any folders or templates currently assigned to the menu
appear. You can use this section of the screen to add new
templates/folders or remove existing ones.

For more information, see
•

”Effect of Assigning a Folder to a Menu” on page 708
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•

”Effect of Assigning a Template to a Menu” on page 710

Effect of Assigning a Folder to a Menu
If
•

you assign a folder to a menu
and

•

a user navigates to any content item that resides in the folder
and

•

a Smart Menu whose EnableSmartOpen property is true appears
on the screen

the Smart Menu automatically displays the items on the associated
submenu.
NOTE

Navigation to the content item can consist of clicking a quicklink, a menu option, a
list summary item, the result of a search, etc.

In effect, you are instructing Ektron CMS400.NET to expose a menu
whenever a content item that resides in one or more selected
folders appears on the screen. As a result, a user who begins
looking for a specific content item sees similar items on the screen.
As an example, assume your Web site sells books, and your
folders are organized by genre. One of your folders is “Teen
Fiction.” You create a submenu that contains the top five sellers in
“Teen Fiction.” You then associate the Teen Fiction folder with that
submenu.
If a site visitor uses the site search to find any book in that
category, and proceeds to a page describing the book, the Smart
Menu in the page’s left column displays the five top Teen Fiction
titles.

Using the Select Folder Screen
The Select Folder screen lets you assign new folders to the menu,
reorder the folders, and delete folders from the menu association.
These tasks are described below.
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When you click Change below Folder Associations on the Edit
menu screen, the Select Folder screen appears (see image
below).

The following table describes tasks you can perform on this
screen.

Task

Instructions

Add folder to list

1.

In the top of the screen, navigate to the folder you want to
add.

2.

Click the Add button (

1.

Click check box to the left of the folder.

2.

Click the Delete button (

1.

Click check box to the left of Folder.

2.

Click the Delete button (

Remove folder from list

Remove all folders from list
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Task

Instructions

Move a folder up or down on the list

1.

Click check box to the left of the folder.

2.

Click the up or down arrow buttons (

Note: The sequence in which folders
appear has no impact on how they are
used. It merely affects the appearance of
the folders on the Select Folders screen.
Save changes and return to Edit Menu
screen

Click the Save button (

Exit screen; do not save changes

Click the Exit button (

).

).

).

Effect of Assigning a Template to a Menu
If
•

you assign a template to a menu
and

•

a user navigates to any content item that uses the template
and

•

a Smart Menu whose EnableSmartOpen property is true appears
on the screen

the Smart Menu automatically displays the items on the associated
submenu.
NOTE

Navigation to the content item can consist of clicking a quicklink, a menu option, a
list summary item, the result of a search, etc.

In effect, you are instructing Ektron CMS400.NET to expose a menu
whenever a content item that uses one or more selected templates
appears on the screen. As a result, a user who begins looking for a
specific content item sees similar items on the screen.
As an example, assume your Web site sells books, and your
templates are organized by genre. One of your templates is “Teen
Fiction.” You create a submenu that contains the top five sellers in
“Teen Fiction.” You then associate the Teen Fiction template with
that submenu.
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If a site visitor uses the Web site search to find any book in that
category, and proceeds to a page describing the book, the Smart
Menu in the page’s left column displays the five top Teen Fiction
titles.

Assigning a Template to a Menu
To add a new template, follow these steps.
1. Move to the Template Associations area of the Edit menu
screen.
2. In the box on the right, enter the template that you are
assigning to this menu. It can be a CMS template, or any file
that you wish.
3. Click Add.
To later change or remove the template, select it then click
Change or Remove.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

711

Managing Users and Permissions

Managing Users and
Permissions

Managing Users & User Groups

Users are people who administer the Web site, create content, or
publish content. Without users, the Web site would be blank. In
Ektron CMS400.NET, you can add, edit, and delete users to and
from the application through the Settings folder in the Workarea.
Every Ektron CMS400.NET user belongs to a User Group. User
groups are used when creating permissions and an approval chain
for content folders. User groups can be departments in your
company (Human Resources, Sales, Engineering) or indicate a
user’s role (Publishers, Administrators, Editors, etc.).
IMPORTANT!

If your system uses the Active Directory Integration Feature, proceed to ”Active
Directory Feature” on page 796 to learn about user management functions. This
chapter only applies to systems that do not use Active Directory Integration.

IMPORTANT!

If your system uses LDAP Authentication, proceed to ”LDAP Authentication” on
page 850. Some functionality in this chapter does apply to LDAP. The LDAP
chapter explains which information is applied.

This section explains the most common actions that you will
perform on users and user groups. These actions include:

• ”Accessing the Users and User Groups Folders” on page 713
• ”Creating a New User” on page 714
• ”Viewing a User” on page 720
• ”Editing a User” on page 720
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• ”Deleting a User” on page 722
• ”Assigning Users To User Groups” on page 723
NOTE

Only members of the Administrators User Group and those defined in the Manage
Members for Role: User Admin screen can view, add, or edit users and user
groups.

Accessing the Users and User Groups Folders
All user and user group information is accessible from the
Workarea.

Accessing the User Folder
To access the user folder in Ektron CMS400.NET, follow these
steps.
1. Access the Workarea > Settings > Users.
2. All Ektron CMS400.NET users appear.
From this screen, you can add, edit, and delete users. These
procedures are explained in the next sections.

Accessing the User Group Folder
To access the user group folder in Ektron CMS400.NET, follow
these steps.
1. Access the Workarea > Settings > User Groups.
2. All user groups appear.
From this screen, you can add, edit, and delete user groups. These
procedures are explained in the next sections.

Managing Users
IMPORTANT!

If you are using Active Directory to Manage users, see ”Associating User
Information in AD with Ektron CMS400.NET” on page 810.

The following topics explain how to manage users.
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• ”Creating a New User” on page 714
• ”Viewing a User” on page 720
• ”Editing a User” on page 720
• ”Deleting a User” on page 722
• ”Removing Users from User Groups” on page 722

Creating a New User
IMPORTANT!

If you are using Active Directory to add a new user, see ”Manually Adding AD
User Information to Ektron CMS400.NET” on page 812. If you are using LDAP,
see ”Adding User Information from an LDAP Server to Ektron CMS400.NET” on
page 856.

Before you can assign a user to a user group, you must add the
user to the system. To create a new user, follow these steps.
1. Access the User folder, as described in ”Accessing the User
Folder” on page 713.
2. Click the Add User button (

).

3. The Add a New User to the System screen appears.
4. Enter the following information about the user.

Field

Description

Username

Insert a username for the user you want to create.

Organization

These fields are only available when using LDAP Authentication. See Also:
”Adding User Information from an LDAP Server to Ektron CMS400.NET” on
page 856.

Organizational Unit
Domain
First Name

Enter the first name of the user.

Last Name

Enter the last name of the user.
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Field

Description

Display Name

The name that is used to identify a user on the Web site. This can be
different from their Username, which is the name you use to log into the
Ektron CMS400.NET Web site.
Important: This name needs to be unique inside CMS400.NET and it
cannot be blank.

Password

Enter a password for the user.
Note: Passwords can be either case-sensitive or case-insensitive. For more
information, see ”Making Passwords Case Sensitive” on page 15.

Confirm Password

Confirm the password by typing it again.

User Language

Select the language in which the user will view Ektron CMS400.NET
screens and messages. The language also determines the default value
whenever a drop-down list of languages appears within E k tro n
CMS400.NET.
The dropdown list of choices at this field is derived from the Language
Settings screen, available from the Settings> Configuration folder.
Do not confuse the system language with the user’s ability to create and edit
foreign editions of content. This field does not prevent a user from working
with multiple language content.
See Also: ”Multi-Language Support” on page 868
Note: If the selected language is not English, French or German, it is only
supported after you download the Ek tr on CMS 40 0.NET Language
Support Program from Ektron and translate the Web site.

Email Address

Enter the email address of the user. Notification email is sent to this address
unless the Disable E-mail Notification field is checked. Also, this address
identifies the user sending Instant email. See Also: ”Sending Instant Email”
in the E ktron CM S40 0. NET User Manual.
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Field

Description

Content and Forum
Editor

Determines which editor will be used when this user

•

replies to a Discussion Board. See Also: ”Using Discussion Boards on
Your Web Site” on page 518

•

edits content from the Ektron CMS400.NET Workarea or after signing
into your Web site if the user is operating a Windows computer and the
system administrator has set UserPreferred as the value of the
web.config file’s ek_EditControlWin key. See Also: ”Setting the Editor
for Ektron CMS400.NET Users” in the E k t r o n C M S 4 0 0 . N E T User
Manual.

Your choices are eWebEditPro and eWebEdit400. See Also:”Introduction
to Ektron CMS400.NET Editors” in the E k t r o n C M S 4 0 0. NE T User Manual.
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Field

Description

Avatar

An image or icon to represent you in the Forum.
Type in a web path to image. For example: http://www.example.com/
smileyface.gif

By default, the maximum file size of an avatar is limited to 200 kilobytes and
the height and width of the avatar will be reduced 125 pixels preserving the
aspect ratio.
To change the file size limit, edit this file:
C:\inetpub\<wwwroot>\<YourSite>\Workarea\Upload.aspx.vb

In this file, change the line shown below to the size file you wish to allow. For
example, to allow 500kb files, change 200 to 500.
If (numFileSize > 200) Then

Remember, this number is in kilobytes.
To change the default height and width of the avatar, edit this file:
C:\intetpub\wwwroot\<YourSite>\App_Code\VBCode\Utilities.vb

In this file, change the following lines to the size you wish to allow. For
example, to make avatars have a height and width of 166 pixels, change
125 to 166 in both these lines.
Dim Width As Integer = 125
Dim Height As Integer = 125

Address

Enter the address used to find this user’s location when a search based on
location is being performed.

Latitude

The latitude used to find this user’s location when someone performs a
search based on location.
Google maps provides a service that takes the address of user and returns
its latitude and longitude.
Note: You don’t need to use Google’s automatic retrieval of latitude and
longitude. Instead, you can enter the values manually.
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Field

Description

Longitude

The longitude used to find your location when a user is performing a search
based on location.
Google maps provides a service that takes the address of content and
returns its latitude and longitude.
Note: You don’t need to use Google’s automatic retrieval of latitude and
longitude. Instead, you can enter the values manually.

Forum Signature

Adds a signature to this user’s posts in the forum. The user does not see the
signature in the editor. It is added after he clicks the Post button.

Tags

Select from a predefined list of Tags that describe yourself. Or, create a new
tag by clicking the Click To Add A New Tag link. Placing a check mark in
the check box next to a tag activates it for your profile.

Disable Receiving of
System Notification
Email

Select to disable the email notifications for the user. If you do, the user will
not receive the automatic email notification described in ”Automatic eMail
Notification” on page 1066. However, this field has no effect on the user’s
ability to receive instant email.

Any custom user
properties

See ”Custom User Properties” on page 748

Width

If desired, change the width of the screen in which Ek tr on CMS 400 .NET
appears for this user. The width in pixels must be between 400 and 2400.
This field accommodates users who have larger monitors and/or prefer a
smaller resolution, such as 1280 x 1024.

Height

If desired, you can change the height of the screen in which E kt r o n
C M S 4 0 0 . N E T appears for this user. The height in pixels must be between
300 and 1800.
This field accommodates users who have larger monitors and/or prefer a
smaller resolution, such as 1280 x 1024.
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Field

Description

Display button text in
the title bar

Check this box if you want any button’s caption text to appear in the screen
title’s bar whenever a user moves the mouse over the button. Note the word
Update, describing the button, in the illustration below.

If you do not check this box, the screen’s title remains in the title bar when
the user moves the mouse over the button, as illustrated below.

Landing Page after login

If you want one page in your Web site to appear after this user signs in,
enter that page’s URL. You might select a page that leads to a group of
pages that you maintain.
If you don’t know the URL, navigate to the page, go to the browser address
bar and select the text following the directory in which E k t r o n
C M S 4 0 0 . N E T resides. For example, if the browser address bar says
http://www.example.com/customers.aspx?id=945, enter
customers.aspx?id=945.

Set smart desktop as
the start location in the
Workarea

If you want the Smart Desktop to appear as soon as this user enters the
Workarea, click inside this check box.

See Also: ”Understanding the Smart Desktop” on page 19
If you leave this check box blank, when this user enters the Workarea, he
goes to the folder of the content specified at the Landing Page after login
field.

NOTE

If email notification is turned off in the setup page, you are notified when editing,
adding, or viewing a user.

5. Click the Save button (

).

6. The View Users in Group Everyone screen appears with the
new user included in the table.
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NOTE

When you add a new user, he is automatically placed in the Everyone user group.
To assign users to other groups, see ”Assigning Users To User Groups” on
page 723.

7. Continue this process until you add all users of your Web site,
or are allowed to depending on your license.
NOTE

Contact Ektron Sales for pricing of adding more users to your license.

Viewing a User
After adding a user, you can view that information. While viewing a
user, you can edit or delete the user.
To view a user, follow these steps.
1. Access the user folder as described in ”Accessing the User
Folder” on page 713.
2. Click the Username of the user you want to view.
3. The View User Information screen is displayed.
To learn about the fields, see ”Enter the following information
about the user.” on page 714 and ”The following fields are only
available when editing a user.” on page 721
From the View User screen, you can edit or delete users. These
actions are described in the next sections.

Editing a User
IMPORTANT!

If you are using Active Directory to edit a user, see ”Editing User Information in
Ektron CMS400.NET” on page 813.

When editing a user, you can change the username, first name,
last name, password, user language, and email address. Also,
while editing, you can change three fields that were not available
when the user was created.

• Account Locked
• Work Page Size
• Landing Page after login
To edit a user, follow these steps.
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1. Access the view user screen of the user you want to edit as
described in ”Viewing a User” on page 720.
2. Click the Username of the user you want to edit.
3. The View User Information screen is displayed.
4. Click the Edit button (

).

5. The Edit User screen is displayed. To learn about most fields,
see ”Enter the following information about the user.” on
page 714.
The following fields are only available when editing a user.
.
Field

Description

Account Locked

See ”Restricting Login Attempts” on page 10

Content and Forum
Editor

See ”Content and Forum Editor” on page 716

Forum Signature

Adds a signature to your posts in the forum. You do not see the signature
in the editor. It is added after you click the Post button.

Work Page Size

See ”Work Page Size” on page 26

Landing Page after
login

See ”Landing Page after login” on page 27

6. Make the necessary changes to the user information.
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7. Click the Update button (

).

Deleting a User
IMPORTANT!

If you are using Active Directory to delete a user, see ”Deleting Users” on
page 813.

When you need to remove a user from the application, you can
easily do it from the User’s Folder in the Workarea.
WARNING!

Once a user is deleted from the database, he is deleted permanently. The process
cannot be undone.

To delete a user, follow these steps.
1. Access the view user screen for the user you want to delete, as
described in ”Viewing a User” on page 720.
2. Click the Username of the user you want to delete.
3. The View User Information screen is displayed.
4. Click the Delete button (

).

5. A confirmation message is displayed.
6. Click OK.

Removing Users from User Groups
IMPORTANT!

NOTE

If you are using Active Directory to remove a user from a group, see ”Removing
Users from a Group” on page 809.
Removing a user from a user group does not delete the user from Ektron
CMS400.NET. Also, you cannot remove users from the Everyone user group.

To remove a user from a user group, follow these steps.
1. Access the User Groups folder, as described in ”Accessing the
User Group Folder” on page 713.
2. Click the User Group that includes the user you want to
remove.
3. Members of the selected group appear.
4. Click the user to remove.
5. The View User Information screen is displayed.
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6. Click the Delete button (

) to delete the user from the group.

7. A confirmation message is displayed.
8. Click OK.

Managing User Groups
The following topics explain how to manage User Groups.

• ”Creating a New User Group” on page 723
• ”Assigning Users To User Groups” on page 723
• ”Viewing the Users in a User Group” on page 725
• ”Editing a User Group” on page 725
• ”Deleting a User Group” on page 726
• ”Removing Users from User Groups” on page 722

Creating a New User Group
To create a new User Group in Ektron CMS400.NET, follow these
steps.
1. Access the User Groups folder in the administrator Workarea,
as described in ”Accessing the User Group Folder” on
page 713.
2. Click the Add User Group button (

).

3. The Add a New User Group to the System screen is displayed.
4. Enter a name and brief description of the user group you want
to create.
5. Click the Save button (

).

Assigning Users To User Groups
To add a user to a user group, follow these steps.
1. Access the Workarea > Settings > User Groups.
2. Click the user group to which you want to add a user.
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3. The View Users in Group screen appears with all current group
members.
NOTE

When you create a new user group, no user is initially assigned to it.

Note that you can select any number of users by checking the
box to the left of their name. To select all users, check the box
in the column header row.
You can also sort the display by Username, Lastname or
Firstname.

And, you can enter characters into the Search field and find
only users that match them. For example, you could enter bill,
click the Search button, and see only users with those
characters in their name.
4. Click the Add User button (

).

5. Users who do not belong to the group appear.
6. Click the user you want to add.
7. A confirmation message is displayed.
8. Click OK.
9. The selected user is now a member of the selected group.
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10. Continue this process until you add all users into User Groups.

Viewing the Users in a User Group
To view a list of users who are members of a user group, follow
these steps.
1. Access the User Group folder in the administrator Workarea,
as described in ”Accessing the User Group Folder” on
page 713.
2. Click the user group whose members you want to view.
3. The View Users in Group screen appears with a list of users
who are members of the group.
From this screen, you can edit or delete user groups, as well as
add and remove users to and from the user group.
You can also send an email to any group member by clicking the
checkbox next to the email icon on the same line as the user’s
name.

After selecting all users to receive email, click the email toolbar
button (
email.

). A new screen appears that lets you compose the

Editing a User Group
When editing a User Group, you can only change its name.
NOTE

You cannot edit the default Administrators and Everyone user groups.

To edit a user group, follow these steps.
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1. Access the View Users in Group screen for the user group you
want to edit, as described in ”Viewing the Users in a User
Group” on page 725.
2. Click the User Group you want to edit.
3. The View Users In Group screen is displayed.
4. Click the Edit button (

).

5. The Edit User Group screen is displayed.
6. Make the necessary changes.
7. Click the Update button (

).

Deleting a User Group
When you do not need a User Group anymore, you can delete it
from the system.
NOTE

You cannot delete the Administrator and Everyone groups.

To delete a user group, follow these steps.
1. Access the View Users in Group screen for the user group you
want to delete, as described in ”Viewing the Users in a User
Group” on page 725.
2. Click the User Group you want to delete.
3. The View Users In Group screen is displayed.
4. Click the Delete button (

).

5. A confirmation message is displayed.
6. Click OK.
7. The User Group is deleted from the Ektron CMS400.NET Web
site.

Removing Users from User Groups
See ”Removing Users from User Groups” on page 722.
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Membership users are a category of users who have limited
privileges to Ektron CMS400.NET. Unlike regular CMS users, they
cannot use the Workarea. When a membership user logs in, he
can view, add and edit content from the Web site (as permitted) -all other functionality is disabled.
Membership users can also be granted permission to view private
content. This is helpful if your organization has partners who need
access to Web pages that should not be visible to the general
public.
When you have a Social Network or Community Web site,
membership users can create an online area for themselves.
You can use Membership groups to group similar membership
users.

Privileges of Membership Users
•

They can create, edit, and view content after log in. See Also:
”Community Folders” on page 50

•

They can be granted permission to view private content. See
Also: ”Membership User/User Group Example” on page 728
and ”Private Content” on page 744

•

They can self-subscribe to receive Web Alerts. See Also: ”Web
Alert Feature” on page 1013

•

If your site is a Community Web site, they become members of
the community and can use the following features provided by
Ektron’s Community Platform. See Also: ”Community
Management” on page 940, the user manual section “My
Workspace”, and the Developer Manual section “Community
Platform Server Controls.”
- Share their Document Workspace and Photo Gallery with
other site visitors
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- Join a Community Group
- Mark content the member likes and allow site visitors to see
the list of these Favorites
- Mark other members or site users as Colleagues.
- Keep a Journal about themselves.
- Add and read comments left on a Message Board
- Send and receive Messages with other registered users.
•

If a Discussion Board requires sign in, they can view and post
to them. See Also: ”Discussion Boards” on page 465

•

If a blog requires authentication, they can post blog comments.
See Also: “Working with Folders and Content” > “Blogs” in the
Ektron CMS400.NET User Manual

•

If a poll or survey is set up to track participating users,
membership users’ names appear on the Form reports.

Membership User/User Group Example
A typical membership scenario is a Partners section of your Web
site that contains private content for partners only. Set up a
membership user group to include users from your partner’s
organization. The group is given add and edit permissions to the
Partners section. As a result, any partner can log into Ektron
CMS400.NET and view, add, or edit the private content.

This topic is more fully explained through the following subtopics.
•

”Accessing the Membership Module Folder” on page 729

•

”Working with Membership Users” on page 729

•

”Membership User Groups” on page 738

•

”Assigning Permissions for Memberships” on page 742

•

”Troubleshooting Problems with Membership Users and
Groups” on page 743

.
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Accessing the Membership Module Folder
Use the Membership Module folder to enter and edit membership
users and user groups. To access the folder, follow these steps.
1. Navigate to Workarea > Modules > Community
Management.
2. Click the Memberships folder to view its subfolders.
Folder Name

More Information

Users

”Working with Membership Users” on page 729

Users not
Verified

”What Happens if Verification email is Used” on
page 1047

User Groups

”Membership User Groups” on page 738

Messages

”What Happens if Verification email is Used” on
page 1047

Working with Membership Users
The following sections explain all actions that may be performed
on membership users via the following topics.
•

”Adding Membership Users” on page 730

•

”Adding Membership Users to a Membership User Group” on
page 733

•

”Setting Permissions on Private Content for Membership
Users” on page 733

•

”Viewing Membership User Information” on page 733

•

”Editing Membership Users” on page 735

•

”Deleting Membership Users” on page 738

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

729

Membership Users and Groups

Adding Membership Users
NOTE

If you are using the Web Alert feature, any site visitor can sign up to be a
membership user. That represents another way to add membership users. For
more information, see ”How Users Sign up for Subscriptions” on page 1045.

To add a new membership user, follow these steps.
1. Form the Workarea, click Modules > Community
Management > Memberships > Users.
2. Click the Add Membership User button (

).

3. The Add Membership User screen is displayed.
4. Complete the form using the following table as a reference.
Field

Description

Username

Enter a unique username for the membership user.

First Name

Enter the first name of the user.

Last Name

Enter the last name of the user.

Display Name

The name that is used to identify a Membership user on the Web site. This can be
different from their Username, which is the name you use to log into the Ektron
CMS400.NET Web site.
Important: This name needs to be unique inside CMS400.NET and it cannot be
blank.

Password

Enter a password for the user.

Confirm Pwd

Re-type the password to confirm it is correct.
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Field

Description

User Language

Select the language in which the user will view Ektron CMS400.NET screens and
messages. The language also determines the default value whenever a dropdown list of languages appears within E ktron CM S40 0. NET .
The dropdown list of choices at this field is derived from the Language Settings
screen, available from the Settings> Configuration folder.
Do not confuse the system language with the user’s ability to create and edit
foreign editions of content. This field does not prevent a user from working with
multiple language content.
See Also: ”Multi-Language Support” on page 868
Note: If the selected language is not English, French or German, it is only
supported after you download the Ek tr on CMS 400 .NET Language Support
Program from Ektron and translate the Web site.

Email Address

Enter an email address for the user.

Forum Editor

Determines which editor will be used when this user replies to a Discussion Board.
See Also: ”Using Discussion Boards on Your Web Site” on page 518
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Field

Description

Avatar

An image or icon to represent the user in the Forum.
Type in a web path to image. For example: http://www.example.com/
smileyface.gif

Changing Maximum File Size
By default, an avatar’s maximum size is 200 kilobytes. The height and width of the
avatar is reduced 125 pixels preserving the aspect ratio.
To change the file size maximum, edit this file:
C:\inetpub\<wwwroot>\<YourSite>\Workarea\Upload.aspx.vb

In this file, change the line shown below to the desired size:
If (numFileSize > 200) Then

For example, to allow 500kb files, change 200 to 500.
Remember, this number is in kilobytes.
Changing Default Height and Width
To change the default height and width of the avatar, edit this file:
C:\intetpub\wwwroot\<YourSite>\App_Code\VBCode\Utilities.vb

In this file, change the following lines.
Dim Width As Integer = 125
Dim Height As Integer = 125

For example, to set avatars to a height and width of 166 pixels, change 125 to 166
in both lines.
Address

The address used to find your location when a user is performing a search based
on location.

Latitude

The latitude used to find your location when a user is performing a search based
on location.
Google maps provides a service that takes the address of user and returns its
latitude and longitude.
Note: You don’t need to use Google’s automatic retrieval of latitude and longitude.
Instead, you can enter the values manually.
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Field

Description

Longitude

The longitude used to find your location when a user is performing a search based
on location.
Google maps provides a service that takes the address of content and returns its
latitude and longitude.
Note: You don’t need to use Google’s automatic retrieval of latitude and longitude.
Instead, you can enter the values manually.

Forum
Signature

Adds a signature to your posts in the forum.
You do not see the signature in the editor. It is added after you click the Post
button.

Tags

Select from a predefined list of Tags that describe yourself. Or, create a new tag by
clicking the Click To Add A New Tag link. Placing a check mark in the check box
next to a tag activates it for your profile. See Also: ”Tags” on page 981

5. Click the Save button (

).

Adding Membership Users to a Membership User Group
See ”Adding Membership Users to a Membership User Group” on
page 740.

Setting Permissions on Private Content for Membership Users
See ”Assigning Permissions for Memberships” on page 742.

Viewing Membership User Information
To view membership user information, follow these steps.
1. Access the membership users folder, as described in
”Accessing the Membership Module Folder” on page 729.
NOTE

The ek_PageSize setting in the web.config file determines the maximum number
of users that can appear on a page before it “breaks.” When a page breaks,
additional entries appear on another screen, and the following text appears near
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the bottom of the list:
Page 1 of 2
[First Page] [Previous Page] [Next Page] [Last Page]

The View Users in Group All_Members screen lets you add
new users, as well as sort and search for existing users. See
”Sorting Membership Users” on page 734 and ”Searching for
Membership Users” on page 734.
2. Click the user you want to view.
3. The View Membership User Information screen is displayed.
From this screen, you can edit or delete membership users.

Sorting Membership Users
You can arrange users on the View Users in Group All_Members
screen by clicking the following column headers:
•

Username

•

Last Name

•

First Name

By default, users are arranged alphabetically by Username,
starting with the beginning of the alphabet. To switch that
arrangement so that users whose username is last when sorted
alphabetically, click the column header. To revert to the original
arrangement, click the header again.
You can also sort the list by last name or first name. Like
username, clicking the column header reverses the arrangement.

Searching for Membership Users
You can use the Search field (circled below) to display only users
who meet your criteria. This would be especially helpful to filter out
a large number of membership users.
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Use the Search field to enter unique characters to find members
you seek. For example, to find all members whose username
includes @example.com, enter that into the Search field and click
the Search button. Only users with those characters in that exact
sequence in their username, first name, or last name appear on
the screen.
You can also search by First and Last name fields. Click the down
arrow to the left of the Search button to select a field to search.

The sequence of search characters must match your entry in the
Search field. For example, if you are searching by last name and
enter MI, anyone whose name is Smith appears. But, if you enter
IM, users with the last name of Smith do not appear.
Also, the search is case-insensitive, so MI produces the same
results as mi.

Editing Membership Users
To edit a membership user, follow these steps.
1. Access the View Membership User screen of the membership
user you want to edit, as described in ”Viewing Membership
User Information” on page 733.
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2. Click the Edit button (

).

3. The Edit Membership User Information screen is displayed.
4. Use the following table to assist with editing the membership
user’s information.

Field

Description

Username

Enter a unique username for the membership user.

First Name

Enter the first name of the user.

Last Name

Enter the last name of the user.

Display Name

The name used to identify a Membership user on the Web site. This can
be different from their Username, which is the name they use to log in to
the Ektron CMS400.NET Web site.
Important: This name needs to be unique inside CMS400.NET and it
cannot be blank.

Password

Enter a password for the user.

Confirm Pwd

Re-type the password to confirm it is correct.

User Language

Select the language in which the user will view Ektron CMS400.NET
screens and messages. The language also determines the default
value whenever a drop-down list of languages appears within E k t r o n
CMS400.NET.
This field’s list of choices is derived from the Settings > Configuration
> Language Settings screen.
Do not confuse the system language with the user’s ability to create and
edit foreign editions of content. This field does not prevent a user from
working with multiple language content.
See Also: ”Multi-Language Support” on page 868
Note: If the selected language is not English, French or German, it is
only supported after you download the E ktron CM S40 0. NET
Language Support Program from Ektron and translate the Web site.

Email Address

Enter an email address for the user.
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Field

Description

Forum Editor

Determines which editor will be used when this user replies to a
Discussion Board.
See Also: ”Using Discussion Boards on Your Web Site” on page 518

Avatar

An image or icon to represent the user in the Forum.
Type in a web path to image. For example: http://www.example.com/
smileyface.gif

By default, the maximum file size of an avatar is limited to 200 kilobytes
and the height and width of the avatar will be reduced 125 pixels
preserving the aspect ratio.
To change the file size limit, edit this file:
C:\inetpub\<wwwroot>\<YourSite>\Workarea\Upload.aspx.vb

In this file, change the line shown below to the size file you wish to
allow. For example, to allow 500kb files, change 200 to 500.
If (numFileSize > 200) Then

Remember, this number is in kilobytes.
To change the default height and width of the avatar, edit this file:
C:\intetpub\wwwroot\<YourSite>\App_Code\VBCode\Utilities.vb

In this file, change the following lines to the size you wish to allow. For
example, to make avatars have a height and width of 166 pixels,
change 125 to 166 in both these lines.
Dim Width As Integer = 125
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Field

Description

Forum
Signature

Adds a signature to the membership user’s posts in the forum. You do
not see the signature in the editor. It only appears after you click the
Post button.

5. Click the Update button (

).

Deleting Membership Users
To delete a membership user, follow these steps.
1. Access the View Membership User screen of the membership
user you want to edit, as described in ”Viewing Membership
User Information” on page 733.
2. Click the Delete button (

).

3. A confirmation message is displayed.
4. Click OK.

Membership User Groups
IMPORTANT!

Membership User Groups and Community Groups are two different concepts.
Community Groups allow users with similar interest to join together in a social
networking environment. See ”Community Groups” on page 942. Membership
User Groups are explained below.

Membership user groups organize similar membership users,
reducing the effort required to assign identical permissions to many
users. You can assign them permission to any folder by going to
Folder Properties > View Permissions for Folder > View
MemberShip users.
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The following sections explain membership user group
management.
•

”Adding Membership User Groups” on page 739

•

”Viewing Users in a Membership User Group” on page 740

•

”Adding Membership Users to a Membership User Group” on
page 740

•

”Setting Permissions on Private Content for Membership User
Groups” on page 740

•

”Editing Membership User Group Name” on page 740

•

”Deleting User from Membership User Group” on page 741

•

”Deleting Membership User Groups” on page 741

Adding Membership User Groups
To create a new membership user group, follow these steps.
1. Access the membership user group folder, as described in
”Accessing the Membership Module Folder” on page 729.
2. Click the Add Membership User Group button (

).

3. The Add a New User Group screen is displayed.
4. Enter a unique name for the group.
5. Click the Save button (

).

See Also: ”Membership User Groups” on page 738
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Viewing Users in a Membership User Group
To view the information about a membership user group, follow
these steps.
1. Access the membership user group folder, as described in
”Accessing the Membership Module Folder” on page 729.
2. Click the membership user group you want to view.
3. The View Users In Group screen is displayed.
See Also: ”Membership User Groups” on page 738

Adding Membership Users to a Membership User Group
To add a membership user to a membership user group, follow
these steps.
NOTE

Only membership users can be added to membership user groups.

1. Access the View Membership User Group screen for the
membership user group to which you want to add a
membership user, as described in ”Viewing Users in a
Membership User Group” on page 740.
2. Click the Add Membership User button (

).

3. The Add User to Group screen is displayed.
NOTE

Only membership users who do not belong to the group appear.

4. Click the user you want to add.
5. A confirmation message is displayed.
6. Click OK.
See Also: ”Membership User Groups” on page 738

Setting Permissions on Private Content for Membership User
Groups
See ”Assigning Permissions for Memberships” on page 742

Editing Membership User Group Name
To edit a membership user group name, follow these steps.
NOTE

The membership user group, All_members, cannot be edited.
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1. Access the View Membership User Group screen for the
membership group you want to edit, as described in ”Viewing
Users in a Membership User Group” on page 740.
2. Click the Edit button (

).

3. The Edit User Group screen is displayed.
4. Change the membership group name.
5. Click the Update button (

).

See Also: ”Membership User Groups” on page 738

Deleting User from Membership User Group
To remove a user from a membership user group, follow these
steps.
1. Access the View Membership User Group screen for the
membership user group that contains the membership user
you want to delete, as described in ”Viewing Users in a
Membership User Group” on page 740.
2. Click the name of the membership user you want to remove.
3. The View User Information screen is displayed.
4. Click the Delete button (

).

5. A confirmation message is displayed.
6. Click OK.

Deleting Membership User Groups
To delete a membership user group, follow these steps.
1. Access the View Membership User Group screen for the
membership user group you want to delete, as described in
”Viewing Users in a Membership User Group” on page 740.
2. Click the Delete button (

).

3. A confirmation message is displayed.
4. Click OK.
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Assigning Permissions for Memberships
After you create membership users and groups, you can assign
them permissions to content folders. To do so, follow these steps.
1. Access the permissions table for the content or folder to which
you want to assign membership permissions.
For

See

Content folders

”Setting Permissions for a Content Folder” on
page 772

Content

”Setting Permissions for Content” on page 776

2. If necessary, break the inheritance for the content or folder.
See Also: ”Inheritance” on page 770
3. If desired, set the folder or item to Private. See Also: ”Private
Content” on page 744
4. Click View MemberShip Users on the right side of the
permissions table.

5. The membership users/user groups added to the permissions
table are displayed.
6. Click the Add button (

).

7. The Add Permissions screen is displayed.
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8. Click a username or user group name to add to the
permissions table.
9. The Add Permissions Options screen is displayed.
10. Check appropriate permissions for the membership user or
group.
11. Click the Save button (

).

Troubleshooting Problems with Membership Users
and Groups
Symptom

Problem

Solution

Error
message:

Response Buffer exceeded its
limit

Increase limit. To do so, follow these steps.

Response
object
error 'ASP
0251 :
80004005'
Response
Buffer
Limit
Exceeded

1.

Stop IIS.

2.

Locate the file
%WinDir%\System32\Inetsrv\Metabase.xml

3.

Modify the AspBufferingLimit value.

4.

Restart IIS.

The default value is 4194304, which is about 4 MB.
Suggest changing it to 20MB (20971520) and see if
that helps.
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Private content is only available to CMS users or membership
users with at least Read-Only permissions for its folder. Those
users must log in to work with the private content. Unauthorized
site visitors cannot see it.
NOTE

All members of the Administrators group have access to private content, even if
they are not granted permission on the View Permission for Folder screen.

You can designate a folder to be private. In that case, all content in
it and its subfolders is private (if they inherit permissions).
Alternatively, you can designate specific content items as private.
To demonstrate private content, the following table shows how a
user’s status affects the display of content in three scenarios.

Scenario

Private Content Web Page

Site visitor

Logged in user
with read-only
permission
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Scenario

Private Content Web Page

Logged-in user
with edit
permissions

Note: You can determine the appearance of the menu shown above. See ”Changing
the Appearance of the Web Site Content Menu” on page 21.

Making a Folder Private
NOTE

You can only set content to private when inheritance is broken. See Also:
”Inheritance” on page 770.

To make a folder private, follow these steps.
1. In the Workarea, navigate to the folder that you want to make
private.
2. Click View > Folder Properties.
3. Click the View Permissions button (

).

4. If necessary, uncheck the box that says Allow this object to
inherit permissions. (Inheritance must be disabled before you
can make the content private.)
5. Check the box that says The content in this folder is private
and can only be viewed by authorized users and members.
6. A confirmation message is displayed.
7. Click OK.
All content in the folder is now private. As new content is added, it
is automatically set to private.
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Making Content Private
To make any content private, follow these steps. See Also:
”Making Assets Private” on page 746
1. In the Workarea, navigate to the folder that contains the
content you want to make private.
2. Click the content item you want to make private.
3. Click the View Permissions button (

).

4. If necessary, uncheck the box that says Allow this object to
inherit permissions. (Inheritance must be disabled before you
can make the content private.)
5. Check the box that says This content is private and is NOT
viewable on the public Web site.
6. A confirmation message is displayed.
7. Click OK.
The content is now private.

Making Assets Private
If assets are set to private, they are handled like other private
content with one important exception: Unless you follow the
procedure described below, anyone can access an asset by typing
the URL of the asset into the browser’s address field.
If a user attempts to access the asset in any other way (such as,
linking to it from a Web page), the regular methods of making
content private work. See ”Making a Folder Private” on page 745
and ”Making Content Private” on page 746.
To make assets private even if someone types their URL into the
browser’s address field, follow these steps.
NOTE

If site users receive a 404 Page Not Found Error when trying to view private
assets, make sure you have completed all step below.

1. Open your Web site’s web.config file, located in the site root
folder.
2. Make sure the following line is uncommented.
<remove verb="GET,HEAD,POST" path="*"/>
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3. Comment out the eight lines indicated below.
<httpHandlers>
<remove verb="GET,HEAD,POST" path="*"/>
<add
verb="HEAD,OPTIONS,PROPFIND,PUT,LOCK,UNLOCK,MOVE,COPY,GETLIB,PROPPATCH,MKCOL,DELETE,(GETSOURCE),(HEA
DSOURCE),(POSTSOURCE)" path="*" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<!--<add verb="GET,POST" path="*.doc" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.docx" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.xls" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.xlsx" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.ppt" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.pptx" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.vsd" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.vsdx" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>-->

Eight add

verb

statements in the middle are commented out.

4. Make sure the following line is uncommented.
<add verb="GET,HEAD,POST" path="*" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>

5. Save web.config.
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Custom User Properties

Custom User Properties allow you to create custom fields. These
custom fields appear on the User Properties and Membership User
Properties screens, and on the Membership server control. They
are used to define information about a user beyond the standard
Ektron CMS400.NET user properties, such as Username, First
Name, Password and email Address.
Examples of Custom User Properties might be:
•

employee ID

•

phone number

•

phone extension

•

instant message screen name

•

position

•

start date

•

department

•

birthday

•

the IP address of the user’s machine

Your ability to create and manage custom user properties is
explained through the following topics.

NOTE

•

”The View Custom Properties Screen” on page 749

•

”Adding a Custom User Property” on page 750

•

”Editing a Custom User Property” on page 759

•

”Deleting a Custom User Property” on page 760

•

”Setting the Custom User Properties Order” on page 761

•

”Using Custom User Properties for Non-English Languages” on
page 763

Only members of the Administrator User Group can work with Custom User
Properties.
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The View Custom Properties Screen
Use the View Custom Properties screen to create custom
properties for users and membership users. From the View
Custom Properties screen, you can:
•

add a new custom property. See ”Adding a Custom User
Property” on page 750

•

edit a custom property. See ”Editing a Custom User Property”
on page 759

•

reorder the way custom properties appear on the users and
membership users screen. See ”Setting the Custom User
Properties Order” on page 761

•

work with custom properties in different languages. See ”Using
Custom User Properties for Non-English Languages” on
page 763

Below is an example of the View Custom Properties screen.

The table below describes the View Custom Properties screen.

Buttons, Dropdown
Boxes or Fields

Description

For More Information

Add button (

Add custom user properties.

”Adding a Custom User
Property” on page 750

Change the order in which the custom
properties appear on the Users or
Membership User Properties screen.

”Setting the Custom User
Properties Order” on
page 761

Reorder button (

)

)
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Buttons, Dropdown
Boxes or Fields

Description

For More Information

Language Selection
Dropdown List

Allows you to view custom user properties by
language.

”Viewing Custom User
Properties By Language”
on page 766

Displays the title of a custom user property.
When viewing by language, the title changes
to the title used in a specific language if it has
been defined. Click a Title to edit the
property.

”Editing a Custom User
Property” on page 759

(
Title Field

)

Note: The title and label are the same field.
On some screens, Title is used; on others
Label is used.
Type Field

Shows the Type that was chosen for a
custom user property.

”Type” on page 752

Adding a Custom User Property
After you add a custom user property, it appears on all User and
Membership User Information screens, under the User Properties
header. When new users and membership users are added,
custom user properties appear during the creation process.
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Follow these steps to add a custom user property.
1. In the Workarea, click Settings > Configuration > User
Properties > User Properties.
2. Choose the standard language used in your Ektron
CMS400.NET Workarea.
3. Click the Add Property button (

).

4. The Add Custom Property screen appears.
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5. Complete the screen according to the table below.

The Custom User Properties Fields
The following table describes the custom user properties fields
Field

Description

Label

Title of the property you are adding. For example, Employee ID.

More Information

Note: The Title and Label are the same field. On some screens the
word Title is used, on others the word Label is used.
Type

The property’s data type. Once a type is selected and saved, you
cannot change it. You must delete the custom property and reenter it.

”The Type Field” on
page 753

Input Type

Choose how a user is able to enter a response to the property.

”The Input Type
Field” on page 754

Validation

Ensures the right type of data is entered in a text box or text area.

”Validation” on
page 755

Min Value

If desired, enter the minimum value you want to allow. The Min
Value only appears when the following Validations are used:
Numeric Only, Date Only and U.S. Zip Code.
The following is an example of a Date Only Min Value: 01/01/1900.
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Field

Description

More Information

Max Value

If desired, enter the maximum value you want to allow. The Max
Value only appears when the following Validations are used:
Numeric Only, Date Only and U.S. Zip Code.
The following is an example of a Date Only Max Value: 01/01/
1987.

Message

A message that appears when information entered in a user
property violates the validation criteria.
For example, if the validation is U.S. Zip Code, you might use the
following message: Please enter a valid zip code

6. Click the Save button (

).

7. The new property appears on the View Custom Properties
screen.

The Type Field
The following table describes the types available in the Type field.
Types

Description

Input Types
Available

Validations
Available

String

Accepts all alpha, numeric, and symbol
characters

•

Text Box

All validations

•

Text Area

•

Hidden

See Also:
”Validation” on
page 755

Boolean

Accepts a true or false response

•

Check Box

None

Numeric

Accepts numbers only

•

Text Box

•

No Validation

•

Cannot be blank

•

Numeric Only

•

U.S. Zip Code

•

Dollar Amount
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Types

Description

Input Types
Available

Validations
Available

Date

Only a date can be entered.

•

•

No Validation

•

Cannot be blank

•

Date Only

SelectList

Select a response from a list of choices.

Text Box

NA

NA

See Also: ”SelectList Field” on page 757
Multi
SelectList

Select any number of responses from a list
of choices. See Also: ”MultiSelectList
Field” on page 758

NA

NA

Category

A system-defined type that appears when
the first subscription is created. One entry
covers all subscriptions.

NA

NA

See Also: ”Defining Subscriptions” on
page 1035.

The Input Type Field
The following table describes possible responses to the Input
Type field.
Input Type

Description

An Option When
Used With

Text Box

Creates a standard text box. Below is an example of a text
box.

•

String

•

Numeric

•

Date

•

String

Text Area

Creates a multi-lined area for entering text. Typically used
when more than one line of text needs to be added. Below is
an example.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

754

Custom User Properties

Input Type

Description

An Option When
Used With

Hidden

Hides the input field. This can be used by an administrator to
add additional values at postback time. This requires a
developer to add client-side JavaScript.

•

String

•

Boolean

Note: If you change a String field’s Input Type from Text
Box or Text Area to Hidden, then sign in as a member of
the Administrators group, the field and its value still appear
on the user’s profile.
Check Box

Creates a checkbox. Used when the field requires a boolean
(true / false) response. Below is an example of a check box.

= True

= False

Validation
The following table describes the validations available in the
Validation field.
Validation

Description

An Option When
Used With

No Validation

The entry is not checked.

•

String

•

Numeric

•

Date

•

String

•

Numeric

•

Date

•

String

•

Numeric

Cannot be blank

Numeric Only

A response must be entered.

The response must be a number.

Text Only

The response must be characters.

•

String

Date Only

The response must be entered in the following format: mm/
dd/yyyy.

•

String

•

Date
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Validation

Description

An Option When
Used With

Email Only

The response must be entered as an Email address. For
example, username@domain.domainextention.

•

String

Credit Card Only

The response must be entered as a credit card number. For
example, nnnn nnnn nnnn nnnn

•

String

Social Security
Only

The response must consist of nine digits in this pattern: nnnnn-nnnn.

•

String

U.S. State Code

A two letter state code. For example: NH = New Hampshire.

•

String.

U.S. Zip Code

The response must consist of 5 (nnnnn) or 9 digits separated
by a dash after the fifth (nnnnn-nnnn).

•

String

•

Numeric

Note: If you use the Numeric Type, you cannot have a dash
or space when using a nine digit Zip Code
Valid US Phone
Number

The response must consist of a 10 digits in this pattern: nnnnnn-nnnn.

•

String

Canadian Postal
Code

The response must consist of 6 (xnx nxn) alpha or numeric
characters with a space after the first three characters.

•

String

Time HH:MM or
HH:MM:SS or
HH:MM:SS.mm

Time is entered in one of the following three formats.

•

String

HH:MM - Hours and Minutes 09:30
HH:MM:SS - Hours, Minutes and Seconds 09:30:45
HH:MM:SS.mm - Hours, Minutes, Seconds and milliseconds
09:30:45.002

IP Address

The response must be in the form of an IP address.

•

String

Dollar Amount

This validation works differently depending on the Type used.
If used with the String Type, you can have a dollar sign ($)
along with the money amount in the text field.

•

String

•

Numeric

•

String

When used with the Numeric Type, you are not allowed to
have a dollar sign ($) in the text field. The following are
examples of each type with validation:
String - $3.00
Numeric - 3.00
Canadian Social
Insurance Number

The response must consist of nine digits in this pattern (nnn
nnn nnn).
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SelectList Field
Use a SelectList field to present the user completing the User
Information or Membership User Properties screen with a list of
choices. See example below.

When you create a custom user property and specify its type to be
Select List, the screen changes as shown below.

Completing a SelectList Field Entry
To add an item to the list, enter its text in the Text field, then click
the Add button. Added items then appear in the larger box on the
left.
You can then
•

remove any item from the list by clicking it. It appears in the
Text field. Click Remove.
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•

change the text of any list item by clicking it. It appears in the
Text field. Make changes then click Change.

•

change the sequence of list items by selecting an item then
clicking the up or down arrow to move the item

Using the First List Item to Prompt a Response
You can use the first list item to prompt the user to make a
selection instead of being a valid response. For example, the first
list item may say Select from a list of choices. To do this, check
the First item is not a valid selection for example, “[Select]”
check box.
If you do, the field has an asterisk (*) next to it (indicating it is
required) on the User Information and Membership User
Properties screens. The user completing the screen must choose
any selection other than the first item. If he tries to file the screen
without choosing a different item, the following error message
appears:
Please fill in all required fields (*)

MultiSelectList Field
Use a MultiSelectList field to present the user completing the
User Information or Membership User Properties screen with a list
of choices. The user can choose as many responses as
appropriate. See example below.

Selected items are indicated by a blue background.
When you create a custom user property and specify its type to be
MultiSelect List, the screen changes as shown below.
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For information about completing the screen, see ”Completing a
SelectList Field Entry” on page 757.

Editing a Custom User Property
When you click a custom user property’s title, you are brought to
the Edit Custom Property Screen. From this screen, you can edit
and delete a custom property or create a version of the custom
property in a non-English language.
When you edit a custom user property, the changes are applied to
all users and membership users. These changes are also applied
to any other language versions of the custom properties that exist.
To learn how to:
•

edit a custom user property. See ”Editing a Custom User
Property” on page 760.

•

delete a custom property. See ”Deleting a Custom User
Property” on page 760.

•

create a custom property for a non-English language. See
”Create a Custom User Property for a Non-English Language”
on page 763.
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Editing a Custom User Property
When editing a custom user property, the changes are available to
users and membership users when the save button is clicked.
Follow these steps to edit a custom user property.
1. In the Workarea, click Settings > Configuration > User
Properties > User Properties.
2. Click the Title of the Custom User Property you want to edit.
3. Choose the field you want to change. You can edit the following
fields:
•

Label

•

Input Type

•

Validation

•

Min Value

•

Max Value

•

Message
For descriptions of these fields, see ”The Custom User
Properties Fields” on page 752.

NOTE

WARNING!

You cannot edit the Type field. If you need to change the type, you must delete
the custom user property and create a new one.
If you delete a custom user property, it is removed from all users and membership
users. Any information that has been collected about users and membership
users for that property will be lost. In addition, any language versions of the
custom user property are deleted.

4. Click the Save button (

).

5. When you click a user or membership user, you see your
changes.

Deleting a Custom User Property
If you delete a custom user property, it is removed from all users
and membership users. Any information that has been collected
about users and membership users for that property will be lost. In
addition, any language versions of the custom user property are
deleted.
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Follow these steps to delete a custom user property.
1. In the Workarea, click Settings > Configuration > User
Properties > User Properties.
2. Click the Title of the custom user property you want to delete.
3. Click the Delete button (

).

A dialog box appears asking if you are sure you would like to
delete the item.

4. Click OK.
5. The View Custom Properties screen appears, and the property
is no longer available.

Setting the Custom User Properties Order
From the View Custom Properties screen, you can set the order in
which the properties appear on the User and Membership Users
Properties screen. To set the custom user properties order,
complete these steps.
1. In the Workarea, click Settings > Configuration > User
Properties > User Properties.
2. Click the Reorder button (

).

3. The Reorder Custom Properties screen appears.
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4. Click a property.
5. Click the Up or Down arrows (
down the list.
6. Click the Save button (

) to move the property up or

).

7. On the View Custom Properties screen, you now see the
properties in the new order. If you go to the User or
Membership User Properties screen, the order of the
properties there now reflects the changes.
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Using Custom User Properties for Non-English
Languages
Like content, custom user properties have a language attribute.
This is useful if you have users or membership users that only use
a specific language. It can also be used if you want a custom user
property to appear in the language in which the user is signed in.
Unless a language other than English is defined for a custom user
property, the property defaults to the English version. For example,
if you have two properties called Birthday and Phone Number in
English and you can translate the French version of Birthday to
Anniversaire, when you view the properties in French, you see the
English version of Phone Number and the French version of
Birthday.

Create a Custom User Property for a Non-English Language
When creating a custom user property, it must be created in
English then translated to the desired language. This is done by
editing the property, changing languages, filling out the Translate
Custom Property Label screen and saving the property.
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IMPORTANT!

All custom user properties in languages other than English are tied to the English
version of the property. If you delete the English version of the property, all other
language versions of the properties are deleted also. However, you can remove a
non-English language version of the custom properties without deleting the
English version. See ”Removing a Non-English Custom User Property Title” on
page 764

The following steps illustrate how to translate the Title/Label of a
property into French.
1. In the Workarea, click Settings > Configuration > User
Properties > User Properties.
2. Choose a custom property to be defined in another language.
3. Choose a language from the language select dropdown box.

4. The Translate Custom Property Label screen appears.
5. Enter a Label for the property in the language you have
chosen. For example, if you are creating a French version of a
Birthday custom user property, you would enter Anniversaire in
the label text field. For information on the Label property, see
”Label” on page 752
6. Click the Save button (

).

Removing a Non-English Custom User Property Title
Removing a non-English version of a custom user property title
does not remove the english version of the property. When you
remove the non-English version of a property, you are basically
removing the label for that specific language in the custom
property.
1. In the Workarea, click Settings > Configuration > User
Properties > User Properties.
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2. Choose the language in which the custom user property
appears from the Language Dropdown Box.

3. Click the Title you want to delete.

4. The Translate Custom Property Label screen appears.
5. Click the Delete button (

).

6. A dialog box appears asking if you would like to remove the
translated custom property title.

7. Click OK.
8. The English version of the Edit Custom Property screen
appears.
9. Click the Back button (

).
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WARNING!

Do not click the delete button on the Edit Custom Property screen. This action
deletes the English version of the custom user property. If you click the delete
button, you lose all information collected by the property and all language
versions of the property.

Viewing Custom User Properties By Language
From the View Custom Properties screen, you can view the
custom users properties by languages. When viewing by
languages, it is important to remember that if there is only an
English version of the property, the English version appears in all
the languages.
All custom user properties, in languages other than English, are
tied to the English version of the property. If you delete the English
version of the property, all other language versions of the
properties are deleted.
To view the custom user properties by language, follow these
steps.
1. In the Workarea, click Settings > Configuration > User
Properties > User Properties.
2. Choose the language in which to view the properties from the
language dropdown box.

3. The View Custom Languages screen for that language
appears.
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NOTE

In the example below, some properties have not been translated, so the English
versions appear instead.
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Permissions determine which actions users and members of user
groups can perform on content, library items, and content folders.
For example, you allow your Webmaster to perform the most
advanced actions, such as adding folders, editing folder properties,
and deleting folders. At the same time, you restrict content
contributors to viewing, editing, and adding new content.
You can set permissions for a content folder or content item. When
you assign permissions to a content folder, it affects all of its
subfolders unless you break inheritance for a subfolder.
Permissions are explained through the following topics:
•

”Who Is Authorized to Set Permissions” on page 768

•

”Setting Permissions through the Permissions Table” on
page 768

•

”Inheritance” on page 770

•

”Standard & Advanced Permissions” on page 770

•

”Setting Permissions for a Content Folder” on page 772

•

”Setting Permissions for Content” on page 776

Who Is Authorized to Set Permissions
Only Ektron CMS400.NET administrators and users identified on
the Manage Members for Role: Folder User Admin screen can set
permissions. See Also: ”Using the Roles Screens” on page 788

Setting Permissions through the Permissions Table
IMPORTANT!

All members of the Administrators group are automatically granted all permissions
to all Ektron CMS400.NET folders. Although these users do not appear when you
view a folder’s permission settings, they have full permissions.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

768

Setting Permissions

You manage the following permissions through the Permission
Table (illustrated below).

NOTE

•

Content management: view, add, edit, delete, restore

•

Library File Management: view, add images, add other types of
files, add hyperlinks, overwrite files

•

Folder management: add, edit, delete, traverse

•

Work with Collections and Menus

You can use the Roles screens to assign additional permissions that are not
defined in the Permission Table, such as the ability to create tasks. See Also:
”Defining Roles” on page 787

The Permission Table appears when you click the Permission
button (

) from a folder’s or content item’s Properties window.

Best Practice
If you need to assign multiple users the same permission, Ektron
recommends placing them in a user group and assigning the group to the
Permission Table. If you assign too many users in the Permission Table,
your system's response time may degrade.
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Inheritance
By default, all content folders and items inherit permissions from
their parent folder. You have two options for modifying
permissions.
•

Modify the permissions of the parent folder - see ”Setting
Permissions for a Content Folder” on page 772

•

Break inheritance and add permissions to a folder

Breaking Inheritance
To break inheritance from a parent folder, follow these steps.
1. Access the Permissions Table for a content folder or content in
your Workarea, as described in ”Accessing the Permissions
Table” on page 772.
2. Remove the check mark from the box that says Allow this
object to inherit permissions.
3. A confirmation message appears.
4. Click OK.

Restoring Inheritance
To restore inheritance for a content folder or content, follow these
steps.
1. Access the Permissions Table as described in ”Accessing the
Permissions Table” on page 772.
2. Place a check in the box that says Allow this object to inherit
permissions.
3. A confirmation message appears.
4. Click OK.

Standard & Advanced Permissions
There are two categories of permissions. You assign permissions
in each category from a different screen.
•

Standard Permissions - basic functions
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•

Advanced Permissions - administrator level functions

The following table explains the permissions in Ektron
CMS400.NET.
Category

Permission

Allows user/user group to perform this action on
content in selected folder

Standard

Read Only

View content

Edit

Edit content

Add

Add content

Delete

Delete content

Restore

Restore old versions of content

Library Read Only

View items in the corresponding library folder
See Also: ”Managing Library Items” on page 177

Add Images

Upload images to the corresponding library folder

Add Files

Upload files to the corresponding library folder

Add Hyperlinks

Add hyperlinks to the corresponding library folder

Overwrite Library

Overwrite images and files to the corresponding library folder
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Category

Permission

Allows user/user group to perform this action on
content in selected folder

Advanced

Collections

Manage collections See Also: ”Collections” on page 626

Add Folders

Add sub folders See Also: ”Search Content Folder” on page 68

Edit Folders

Edit folder properties See Also: ”Folder Properties” on page 41

Delete Folders

Delete the current folder or its subfolders

Traverse Folders

Access folders under the root folder. By default, the Everyone
user group has permission to view all subfolders.
If you disable or modify the Everyone user group, and you want
to grant users/groups permission to a folder other than the root
folder, you must also assign Traverse permission. If you do not,
the user cannot access the folder. In that case, the user cannot
perform any other granted permissions.

Modify Preapproval

Set or update a folder’s preapproval group. See Also:
”Automatic Creation of Tasks Associated with Content” on
page 371

Setting Permissions for a Content Folder
You can set permissions for any content folder and language from
the Folder Properties screen. Here is the Permissions button on
the Folder Properties screen.

Accessing the Permissions Table
To access the Permissions Table, follow these steps.
1. Select a content folder from the left frame of the Workarea.
2. Click View.
3. From the language dropdown, select the language whose
folder properties you want to update.
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4. Click View > Folder Properties. The Folder Properties screen
appears.
5. Click the Permissions button (

).

6. The Permissions Table appears.
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The Permissions Table displays each user’s abilities to perform
actions on content within the selected folder. Since all permissions
cannot fit on one screen, you can click View Advanced
Permissions to see the other group.
After viewing the permissions, you can change them. Below is a list
of actions you can perform from this screen.

Actions You Can Perform from the Permissions Table
The following table summarizes actions you can perform from the
Permission Table screen.

Action

How to perform it

For more information, see

View advanced
permissions

Click View Advanced
Permissions

”Standard & Advanced Permissions” on
page 770

Add user or group to
permission table

Click

”Adding a User or User Group to the
Permissions Table” on page 775

Remove user or group
from permission table

Click

”Deleting Users or User Groups from the
Permissions Table” on page 776

View membership
users

Click View MemberShip users

”Community Folders” on page 50

Have this folder inherit
permissions from
parent folder

Check box next to Allow this
object to inherit permissions

”Inheritance” on page 770

Make content in this
folder private

Check box next to The content
in this folder is private and
can only be viewed by
authorized users and
members

”Private Content” on page 744

Note: If Allow this object to
inherit permissions is
checked, you cannot check this
box. In that case, this folder is
inheriting this setting from its
parent folder.
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Adding a User or User Group to the Permissions Table
To add a user or user group to the Permissions Table, follow these
steps.
NOTE

Before adding users or groups, you must break inheritance. See ”Inheritance” on
page 770.

NOTE

If a user and the user group to which that user belongs are both given permission
to a folder, the user has all permissions to which he/she is assigned as well as
permissions assigned to the user group.

NOTE

You can only assign Read Only permission to a Membership user or user group.
See Also: ”Membership Users and Groups” on page 727

1. Access the Permissions Table for the content folder or content,
as described in ”Accessing the Permissions Table” on
page 772.
2. Click the Add button (

).

3. The Add Permissions screen appears. Only users and groups
not assigned to the Permissions Table appear.
4. Click a user or group to add to the Permissions Table.
5. The Add Permissions screen appears.
6. Check the standard and advanced permissions for the user or
group. Refer to ”Standard & Advanced Permissions” on
page 770 for a description of permission options.
NOTE

Check Enable All to assign all standard permissions. If you do, you still must
assign advanced permissions by hand.

7. Click the Save button (

).

Editing User or User Group Permissions
To add or remove permissions for a user or group, editing the user
or group in the Permissions Table. To do so, follow these steps.
1. Access the Permissions Table for the content folder or content,
as described in ”Accessing the Permissions Table” on
page 772.
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2. Click the user or group for which you want to edit permissions.
3. The Edit Permissions screen appears.
4. To assign any permission, check the box. To remove any
permission, uncheck the box.
NOTE

Remember to toggle between standard and advanced permissions.

5. Click the Update button (

).

Deleting Users or User Groups from the Permissions Table
To remove permissions from a user or user group, use the Delete
button on the View Permissions window. To do so, follow these
steps.
1. Access the Permissions Table for the content folder or content,
as described in ”Accessing the Permissions Table” on
page 772.
2. Click the Delete button (

).

3. The Remove Permissions screen appears.
4. Click the user or group to remove from the Permissions Table.
5. A confirmation message appears.
6. Click the OK button.
NOTE

When you delete the permissions of a user or user group, that change is
propagated to all subfolders and content. Also, if the user or group was part of an
approval chain, they are removed from it.

See Also: ”Setting Permissions” on page 768

Setting Permissions for Content
You can assign permissions to a single content item, overriding the
default permissions inherited from the folder. To do so, follow these
steps.
1. Access the content by navigating to its folder, selecting a
language, and clicking on it.
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2. Click the View Permissions button (

).

3. Uncheck the box next to Allow this object to inherit
permissions.
4. A confirmation message appears. Press OK.
5. You can perform any action on the content that you can
perform on a folder. These options are described in ”Actions
You Can Perform from the Permissions Table” on page 774.
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What is an Approval Chain?
An approval chain is a series of users or user groups who must
approve content before it can be published on your Web site.
When the last person in the chain approves content, it goes live.
Also, if a user deletes content, before it can be removed from
Ektron CMS400.NET, it must pass through the approval chain
before it is deleted.
An approval chain can include any number of users or user groups.
However, to be eligible, a user or user group must have
permissions to the content folder or content item. See Also:
”Setting Permissions” on page 768
NOTE

If you assign a user group to an approval chain, only one member of the group
needs to approve the content, not all members.
Also, if a user appears in an approval chain twice (both as a user and part of a
user group), the approval chain skips the second approval because the user has
already approved the content.

You can set up an approval chain for a content folder or a content
item as well as a language. See Also: ”Multi-Language Approval
Chains” on page 895
Finally, the Approval Method determines if content must be
approved by all users in the chain, or only users higher up the
chain than the one making the edits.
This chapter explains how to manage approval chains through the
following subtopics.
•

”Examples of Approval Chains” on page 779

•

”Inheritance and the Approval Chain” on page 779

•

”Creating an Approval Chain for a Content Folder” on page 780

•

”Editing an Approval Chain For Content” on page 784

•

”The Approval Method” on page 784
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NOTE

Only Ektron CMS400.NET administrators and users identified on the Manage
Members for Role: Folder User Admin screen can modify the approval chain.

Examples of Approval Chains
An approval chain lets you control how and when your Web site is
updated. For example, if your Webmaster needs to approve every
new content item or update of an existing item, he would be last
user in every approval chain and exert total control over the site.
Alternatively, you could set up a less centralized organization,
where each department head controls his section. To
accommodate this, set up an approval chain for each department,
and assign the department head as the last person in the chain.
On the opposite extreme, you can delete the approval chain for a
content item or folder. In this case, every item in that folder is
published as soon as a user submits it for publication.

Inheritance and the Approval Chain
An approval chain’s inheritance is determined by the
corresponding permission table. So, if a folder’s permission table
inherits settings from its parent folder, that folder’s approval chain
also inherits. To learn about enabling and disabling permission
table inheritance, see ”Inheritance” on page 770.
The Approval Chain screen only displays its inheritance status; it
does not let you set it.
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Creating an Approval Chain for a Content Folder
Before you can create or edit an approval chain, you must access
the View screen.

Viewing a Folder’s Approval Chain
To view a folder’s approval chain, follow these steps.
1. Select a folder from the left frame of the Workarea.
2. Click View > Language.
3. Select the language of the approval chain you want to view.
4. Click View > Folder Properties.
5. Click the Approvals button (

).

6. The approval chain appears in the lower section of the screen.

This screen shows the following information about the approval
chain.
•

its language

•

every user and user group in the approval chain

•

the approval order

•

the approval method (See also: ”Changing the Approval
Method” on page 785)

•

toolbar buttons for modifying the approval chain and method
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Actions You can Perform from the Approvals Screen
From this screen, you can perform these actions.
Action

Button

See this section for details

Add approvers

”Adding Approvers” on page 781

Remove approvers

”Deleting Approvers” on page 783

Change the order of users in the
approval chain

”Editing the Approval Order” on page 782

Change the approval method

”Changing the Approval Method” on page 785

Change the language of the
approval chain

Content
Language

”Multi-Language Approval Chains” on page 895

Adding Approvers
To add a user or user group to the approval chain, follow these
steps.
1. Access the approval table, as described in ”Viewing a Folder’s
Approval Chain” on page 780.
2. Select the language of the approval chain. The chain only
applies to content in this language.
3. Click the Add button (

).

4. The Add Approvals screen appears.
NOTE

Only users and user groups with permissions to the folder appear. See ”Adding a
User or User Group to the Permissions Table” on page 775 for more information.

Best Practice
Ektron suggests assigning user groups to the approval chain, as opposed
to individual users. In this way, if someone is out of the office for a day,
another group member can approve the content.
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5. Click the user or user group to add to the approval chain.
6. A confirmation message appears.
7. Click OK.

NOTE

If you assign a user group to an approval chain, any member of the group can
approve the content, not all members.

Editing the Approval Order
After you assign approvers to a folder, you may want to adjust the
approval order. Place the user or group with final review at the end
of the approval chain (that is, the highest number).
For example, if you have a content contributor whose edits must be
approved by a department head, and the Webmaster has final
review of all content, the approval order would look like this.
User or Group Name

Approval Order

Content contributor

1

Department Head

2

Webmaster

3

To edit the approval order, follow these steps.
1. Access the approval table as described in ”Viewing a Folder’s
Approval Chain” on page 780.
2. Select the language.
3. Click the Reorder button (

).

4. The Edit Approval Order screen appears.
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5. Click the user or group whose approval order you want to
change.

6. Click the Up (
) or Down (
group to the desired order.
7. Click the Save button (

) arrow to move the user or

).

Deleting Approvers
NOTE

If a user in an approval chain is deleted from the permissions table, he or she is
automatically deleted from the approval chain.

To delete a user or user group from an approval chain, follow these
steps.
1. Access the approval table as described in ”Viewing a Folder’s
Approval Chain” on page 780.
2. Select the language.
3. Click the Remove button (

).

4. The Remove Approval screen appears.
5. Click the user or group that you want to remove from the
approval chain.
6. A confirmation message appears.
7. Click OK.
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Editing an Approval Chain For Content
At times, you may need to change the approval chain for a specific
content item. Use the Approvals button ( ) on the View Content
screen to change a content item’s approval chain.

Viewing an Approval Chain for Content
To view the approval chain for content, follow these steps.
1. Navigate to the folder that contains the content.
2. Click the content.
3. Click the View Approvals button (

).

4. Uncheck the checkbox next to Allow this object to inherit
permissions.
5. Return to the View Content screen.
6. Click the Approvals button (

).

7. The content’s approvals table appears.

After viewing the content’s approval chain, you can perform the
same actions on it as you can perform on a folder. This list of
actions is available from ”Actions You can Perform from the
Approvals Screen” on page 781.

The Approval Method
The Approval Method determines if content must be approved by
all users in the chain, or only users higher up in the chain than the
user making the edits. The approval method only affects the
approval process if the person submitting content for publishing is
a member of the approval chain.
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Two approval methods are available.

Approval Method

Description

Force All Approvers

All users in approval chain must approve the content,
beginning with the first

Do Not Force All Approvers

Approvers after the user submitting content in the
approval chain must approve the content

For example, assume the approval chain is set as below.
User or Group Name

Approval Order

Content contributor

1

Department Head

2

Webmaster

3

If the Approval Method is Force All Approvers, and the
Department Head submits content, the content must be approved
by the content contributor, then the department head, and the
Webmaster before it is published.
If the Approval Method is Do Not Force All Approvers, and the
Department Head submits content, the content must only be
approved the Webmaster before it is published.

Changing the Approval Method
By default, the approval method is set to Do Not Force All
Approvers. To change the approval method for a content folder or
item, follow these steps.
1. Access the approval table, as described in ”Viewing a Folder’s
Approval Chain” on page 780.
2. Click the Edit button (

).

3. The Edit Approval Method screen appears.
4. Select an approval method by clicking the radio button.
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5. Click the Save button (

).
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Ektron CMS400.NET contains an Administrators User Group. Any

user who is a member of that group automatically has full
administrator privileges. See Also: ”Guidelines for Using The
Folder-User Admin Role” on page 790
The Roles feature lets you assign limited or specific administrator
privileges to users who should not have full administrator
privileges. For example, you can let certain users create, redirect,
or remove tasks but deny them other privileges normally granted to
administrators.

Best Practice
When creating new user groups to use with roles, assign names as a
mnemonic aid for the role, especially for folder-specific rules. For
example, the Marketing Folder Admins user group could be used for all
role members who can administer the marketing folder.

NOTE

The Permissions Table lets you control which users can manage a folder’s
properties, its content, library items, and create or edit collections. (See Also:
”Setting Permissions” on page 768) So, together, the Roles feature and the
Permission Table give you the ability to assign administrative privileges to users
who are not members of the Administrators group.

This section explains the use of Roles through the following topics.
•

”Using the Roles Screens” on page 788

•

”Guidelines for Using The Folder-User Admin Role” on
page 790

•

”Using the Roles Screens” on page 788

•

”List of Administrator Privileges” on page 793
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Using the Roles Screens
Use the Roles screens to assign limited administrator privileges.
To access the Roles screens, go to the Ektron CMS400.NET
Workarea and select Settings > Roles.
NOTE

In the screens listed below, you can select users or groups. However, you can
never select the Administrators group, because that group already has all
permissions.

The following table describes the Roles screens.

Screen

Lets you give a user or user group the
ability to

Alias-Admin

This user has all the permissions that a
member of the administrators group has, such
as the ability to

Alias-Edit

•

Turn aliasing on and off

•

View all manual aliases

•

Activate or deactivate manual aliases

•

Change the primary alias

•

Create automatic aliases

•

Create RegEx aliases

•

View and assign a manual alias to content

•

View secondary aliases

For more information, see

”Permissions for Working with Aliasing”
on page 580

Calendar- Admin

Create, edit and delete calendars

”Calendar Permissions” on page 542

Collection and
Menu Admin

Create, edit and delete Collections and
Menus via the Modules tab.

”Collection Permissions” on page 627;
”Menu Feature” on page 704

Note: To manage permissions for creating
collections and menus via the folder’s New >
Collection or New> Menu option, use folder
permissions. See Also: ”Setting Permissions”
on page 768
Collection
Approver

If approval is required for a collection,
approve changes to it, including the deletion
of a collection.

”Setting up Approval for Collections” on
page 630
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Screen

Lets you give a user or user group the
ability to

For more information, see

Commerce
Admin

Access the eCommerce Module’s screens in
the Ek tr on CMS 400 .NET Workarea.

”eCommerce” on page 1078

Community
Group Admin

Create, edit and delete and manage all
Community Groups.

”Community Groups” on page 942 and
the Developer Manual section >
“Introduction to Server Controls” >
“Community Platform Server Controls”

Community
Group Create

Create and manage Community Groups. A
user with this role can only manage
community groups he has created.

”Community Groups” on page 942 and
the Developer Manual section >
“Introduction to Server Controls” >
“Community Platform Server Controls”

Metadata-Admin

View, create and edit metadata definitions

”Metadata” on page 118

Business Rule
Editor

Create or edit Business Rules and Rulesets

”Business Rules” on page 612

Smart Forms
Admin

Create or edit Smart Forms

”Working with Smart Forms” on page 181

Synchronization
Admin

Access the Workarea > Settings >
Configuration > Synchronization screen,
which lets the user set up an run an eSync.

”Using eSync” on page 1295

Task Create

Create tasks

”Task Permissions” on page 361

Task Delete

Delete tasks

”Task Permissions” on page 361

Task Redirect

Redirect tasks

”Task Permissions” on page 361

Taxonomy
Administrator

Create and manage taxonomies

”Taxonomy” on page 634

Template
Configuration

View, create, update, and delete system
templates

”Creating/Updating Templates” on
page 70

User-Admin

Create, view, edit, and delete users and user
groups

”Managing Users & User Groups” on
page 712

XLIFF-Admin

Use the Language Xport feature, which
copies content into XLIFF files that can be
submitted to a translation agency.

”Using the Language Export Feature” on
page 882

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

789

Defining Roles

Screen

Lets you give a user or user group the
ability to

For more information, see

Taxonomy
Administrator

View, create, update, and delete taxonomies
and their categories

”Taxonomy” on page 634

Message Board
Admin

A user with this role can approve pending
comments or delete existing comments on a
message board.

”Content Rating” on page 91 and the
Developer Manual section “Introduction
to Server Controls” > “Community
Platform Server Controls” >
“MessageBoard Server Control”

Message board comments for users and
community groups are administered on the
Web site. Message Board comments for
content can be administered on the Web site
or from the Content Report screen in the
Workarea.
Synchronization
Admin

Folder-User
Admin

Perform all synchronization activities:
•

manage sync configurations and profiles

•

run a sync

•

perform content and folder-level sync

View and edit folder properties. These users
can update properties, permissions, the
approval chain, metadata, Web alerts, purge
history, etc.

”Using eSync” on page 1295

”Folder Properties” on page 41

For example, create a user group and give it
permission to manage the top-level marketing
folder. Members of the group can do
everything to that folder and its subfolders,
but lack authority over other folders.
See Also: ”Guidelines for Using The FolderUser Admin Role” on page 790
Custom
Permissions

Would be used by a developer when
extending E ktron CM S40 0. NET ’s standard
features.

”Guidelines for Using a Custom Role” on
page 791

Guidelines for Using The Folder-User Admin Role
When setting up users and groups for administrative access over
folders, keep these in mind.
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•

After being identified on the Manage Members for Role: Folder
User Admin screen, users or groups must also be given at
least Read-Only permission for individual folders on the Folder
Properties > View Permissions for Folder screen. See Also:
”Setting Permissions” on page 768

•

You must use the same identity on the Manage Members for
Role: Folder User Admin and Folder properties screens. So, if
a user group is listed for the role, use the same group when
assigning folder permissions, not simply a group member.
Conversely, if individual users are listed on the role screen,
they must be specified in the folder permission.

•

Ektron strongly recommends adding only user groups to the
Folder User Admin role, not individual users.
If you set up an individual user as a role member, he could
accidentally receive administrative rights to other folders.

Guidelines for Using a Custom Role
NOTE

The developer sample page installed with the sample site (http://site root/
cms400developer/developer/default.aspx) demonstrates how to use custom
roles. From the home page, click Roles > Custom Roles.
To download the developer sample site, go to http://www.ektron.com/
solutions/startersites/.

The custom permissions role lets your Web developer create a site
page, and then restrict access to that page’s content (or areas with
a page) to users assigned to a custom role.
Items you could show and hide could be as simple as a content
block. But they could be more complicated, such as displaying
buttons and fields for one user group, and something completely
different for another.
Custom roles have no effect inside the workarea.

Examples of Custom Roles
•

Most of your site visitors belong to different political parties,
while some are not registered with any party. By checking the
user’s ID against custom roles, you could present registered
voters with selections for their party’s primary, and prevent
unregistered voters from participating.
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•

Your CMS site visitors fall into two categories: suppliers and
buyers. You could check the current user against a custom role
and show buyers one set of data and suppliers a different set.

•

On your eCommerce site, registered students see a list of
coupons that are not displayed for anyone else. Or, only
registered adults can order age-controlled items, such as
tobacco or alcohol.

•

Control your pages’ background colors, images, and skins
based on custom roles. For example, mothers get familyoriented background images while teenagers get rock images
and related styling.

Steps for Setting up a Custom Role
To set up a custom role, follow these steps.
1. Set up user groups and add to them users who will have some
level of access to the custom page. See Also: ”Creating a New
User Group” on page 723
To continue the above example, create one group of auditors
(who will have read-only access), and another group of
administrators (who will have edit access).
2. Create an Ektron CMS400.NET folder to hold the content that
will appear on the custom page. Use the folder’s permission
table to assign users and groups appropriate access to the
folder’s content. See Also: ”Setting Permissions” on page 768
3. Set up a Custom role. To do this, go to Workarea > Settings >
Roles > Custom Permissions.
4. Create a new role.
5. From the Manage Custom Roles screen, click the role you
created.
6. From the user type selector, click the type of users you want to
add to the role.
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7. Click the Add button (

).

8. Check the box next to the users or groups that you want to add
to the role.
9. Your Web developer creates the custom page. See Also:
”Information about Custom Roles for your Developer” on
page 793
10. You create content to appear on the custom page. Place the
content in the folder you created in Step 2.

Information about Custom Roles for your Developer
The API provides two methods that determine if the current user is
logged in, and if he is a member of the Administrators group. The
methods let you test customizable roles with conditions outside the
standard Is-Logged-In / Is-Admin tests.
API methods are listed below.

Method

Returns

GetRolePermissionSystem(RoleName As
String, nUserId As Long)

a Boolean value indicating if the user belongs to the
system-wide custom role

GetRolePermissionFolder(RoleName As
String, nFolderId As Long, nUserId As
Long)

a Boolean value indicating if the user belongs to the
custom role for the given folder. The procedure for
assigning a user to a custom role is ”Guidelines for
Using a Custom Role” on page 791

Usage is demonstrated in the Developer sample file site
root\CMS400Developer\Developer\Roles\CustomRoles.aspx.vb.

List of Administrator Privileges
Administrator privileges include access to most screens that
appear when you select Settings > Configuration from the lower
left panel of the Workarea (illustrated below).
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Administrators can also
•

edit folder properties (including Web alerts, metadata,
permissions, and the approval chain)

•

manage aliasing features, such as turn aliasing on or off,
activate and deactivate manual aliases, and create automatic
aliases

•

manually alias content

•

add, edit, or delete a calendar
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•

add, edit, or delete a business rule

•

create, view, edit, and delete metadata definitions

•

create, view, edit, and delete taxonomies

•

create, redirect, and delete tasks

•

require a collection to go through an approval process

•

export content for translation to another language using XLIFF

•

run an eSync

•

access the eCommerce Module
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The Active Directory feature allows you to retrieve user and user
group information from the Microsoft Windows Active Directory
(AD) into Ektron CMS400.NET. As a result, you can administer
user information from one place only, and users need to remember
only one password/username combination to sign on to the
network and Ektron CMS400.NET.
To learn more about Active Directory, see http://
www.microsoft.com/windowsserver2003/technologies/directory/
activedirectory/default.mspx.
This feature is described through the following top-level topics.
•

”Setup Guidelines” on page 797

•

”Implementing Active Directory Integration” on page 800

•

”Active Directory Integration” on page 800

•

”User Authentication Only Mode” on page 833

•

”Logging into a System that Uses AD Integration” on page 837
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WARNING!

Ektron strongly recommends configuring a secure socket layer (SSL), especially if
you are using Active Directory Integration. SSL encrypts passwords that are
otherwise sent as clear text to the Ektron CMS400.NET server. See SSL Support
in the Ektron CMS400.NET Setup Manual for more information.

The two ways to set up Active Directory are contrasted in the table
below. Below the table are instructions for each setup option.

Method

When to Use

How setup is done

Advanced
Domains

•

You are using a firewall

Ek tron CM S40 0.NET Workarea. For setup

•

The E k t r o n C M S 4 0 0 . N E T server
need not be part of an Active Directory domain

instructions, see ”Setting Up Active Directory
via the Advanced Domains Method” on
page 797.

•

You are connecting to multiple Active
Directory domains, even ones that
do not see each other

Legacy

You are using auto discovery and Active
Directory single signon.

The domain connects to the AD domain within
the web.config.
For setup instructions, see ”Setting Up Active
Directory via the Legacy Method” on
page 798

Setting Up Active Directory via the Advanced
Domains Method
1. Make sure each AD user to be used in Ektron CMS400.NET is
defined correctly in the Active Directory. Remember that, when
you enable AD integration, logon name and domain are copied
from AD to Ektron CMS400.NET.
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2. If you have multiple domains in your Active Directory Forest,
decide if you want Ektron CMS400.NET to reference all
domains or if you want to choose a specific one. (You will use
this when completing the Domain field of the Active Directory
Setup Screen.)
3. Set the following elements in the Web.config.
- Set the ek_ADEnabled element to true. It should look like this:
<add key="ek_ADEnabled" value="true"/>

- Set the ekADAdvanced element to true. It should look like this:
<add key="ekADAdvanced" value="true"/>

- Set the ek_AUTH_Protocol element to LDAP. It should look like
this:
<add key="ek_AUTH_Protocol" value="LDAP"/>

4. Set up your domains on the Edit Domains screen. See ”The
Edit Domains Screen” on page 815.
5. Configure the AD setup page. See ”The Active Directory Setup
Screen” on page 818.
6. Assign AD groups to Ektron CMS400.NET user groups. See
”Copying User Groups from AD to Ektron CMS400.NET” on
page 804.

Setting Up Active Directory via the Legacy Method
1. Make sure each AD user to be used in Ektron CMS400.NET is
defined correctly in the Active Directory. Remember that, when
you enable AD integration, logon name and domain are copied
from AD to Ektron CMS400.NET.
2. If you have multiple domains in your Active Directory Forest,
decide if you want Ektron CMS400.NET to reference all
domains or if you want to choose a specific one. (You will use
this when completing the Domain field of the Active Directory
Setup Screen.)
3. Set the following elements in the Web.config.
- For the authentication element, change the value of the
impersonate attribute to false. It should look like this:
<identity impersonate="false" userName="" password=""/>

- Set the ek_ADEnabled element to true. It should look like this:
<add key="ek_ADEnabled" value="true"/>
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- Make sure the ekADAdvanced element is set to false. (This is the
default value.)
- Set the ek_AUTH_Protocol element to GC. It should look like this:
<add key="ek_AUTH_Protocol" value="GC"/>

- declare a domain account through ek_adusername and
ek_adpassword. It should look like this:
<add key="ek_ADUsername" value="[username]@domain" />
<add key="ek_ADPassword" value="YourPasswordHere" />

NOTE

Before entering the password, encrypt it using Ektron’s password encryption
utility. To access that utility, go to the Windows Start menu > All Programs >
Ektron > current release > Utilities > Encrypt Email Password.

4. Configure the AD setup page. See ”The Active Directory Setup
Screen” on page 818.
5. Assign AD groups to Ektron CMS400.NET user groups. See
”Copying User Groups from AD to Ektron CMS400.NET” on
page 804.
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Integration

The Active Directory feature has two implementation modes,
described in the following table. Choose the mode that best meets
your needs.
.
Mode

Information Shared
between AD and
CMS

How to Implement

For more
information, see

user
authentication
only

•

user logon name

•

domain

•

password

On the Active Directory Setup
screen, check Enable Active
Directory authentication.

”User Authentication
Only Mode” on
page 833

active
directory
integration

•

user logon name

•

domain

•

password

”Active Directory
Integration” on
page 800

•

user’s first and
last name

On the Active Directory Setup
screen, check Enable Active
Directory authentication and
Enable Active Directory
integration.

•

email address

•

user groups

•

user’s group
memberships

You may also want to check
Enable automatic addition of
user from AD and Enable
automatic addition of user to
groups.

Active Directory Integration
This section covers the following topics:
•

”How Information is Transferred from AD to Ektron
CMS400.NET” on page 801

•

”Which Information is Transferred from AD to Ektron
CMS400.NET” on page 801
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•

”Copying User Group Information from AD to Ektron
CMS400.NET” on page 804

•

”Associating User Information in AD with Ektron CMS400.NET”
on page 810

•

”The Screens of the Active Directory Feature in Active
Directory Integration Mode” on page 814

•

”Disabling AD Integration” on page 832

How Information is Transferred from AD to Ektron
CMS400.NET
Ektron CMS400.NET does not write to the AD – it only reads from
it. This results in the following changes to how user information is
handled within Ektron CMS400.NET.
•

Once you enable AD integration, all changes to user and user
group information must be made in the AD -- the Ektron
CMS400.NET Edit User and User Group screens change to
primarily view screens.

•

When adding a new user or user group to Ektron
CMS400.NET, you can only select users and groups in the AD.
If the user or user group does not exist in the AD, create them
there first, and then import the user or group into Ektron
CMS400.NET.

Which Information is Transferred from AD to Ektron
CMS400.NET
Ektron CMS400.NET accesses the following AD user information.
•

Authentication (password, user logon name, and domain) for
signing in to Ektron CMS400.NET.
The password is not stored in Ektron CMS400.NET – the
application only refers to the password during sign in.

•

Field in AD

User information, listed in the following table

AD attribute

Corresponding field in Ektron
CMS400.NET
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User logon name (preWindows 2000)

sAMAccountName

Domain and Username

Last Name

sn

Lastname

First Name

givenName

Firstname

Email

mail

email Address

Note: Users can share a name in different
domains. For example, juser/example.com
and juser/example.net. Otherwise, user
names must be unique.

•

user group information, listed in the following table.

Field in AD

AD attribute

Corresponding field in Ektron
CMS400.NET

Group Name (pre-Windows
2000)

cn

Domain and User group name
Note: User groups can share a name in
different domains. For example, editors/
example.com and editors/example.net.
Otherwise, user group names must be
unique.

The following diagram illustrates the components of the Active
Directory feature.
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Copying User Group Information from AD to Ektron
CMS400.NET
This section explains how a user’s group membership is copied
from the AD to the Ektron CMS400.NET system when integration
is first enabled, and then on an ongoing basis. Once assigned to a
group, the user automatically receives all Ektron CMS400.NET
privileges and workflow responsibilities associated with it.
NOTE

The Active Directory has two kinds of user groups: security and distribution.
Ektron CMS400.NET does not distinguish between them – as long as a user is a
member of either kind of group, group information is imported to Ektron
CMS400.NET.

This section explains the following topics.
•

”Copying User Groups from AD to Ektron CMS400.NET” on
page 804

•

”Associating a User’s AD Group Information with Ektron
CMS400.NET” on page 805

•

”Mapping the Administrator Group” on page 807

•

”User Belongs to AD Group that Does Not Exist in Ektron
CMS400.NET” on page 808

•

”User Belongs to Ektron CMS400.NET Group that Does Not
Exist in AD” on page 808

•

”Removing Users from a Group” on page 809

•

”Adding User Groups” on page 809

•

”Adding a User to a Group” on page 809

•

”Replacing a User Group” on page 809

•

”Deleting a User Group” on page 809

Copying User Groups from AD to Ektron CMS400.NET
Before using the AD integration feature, copy all AD groups you
will use in your Web site into Ektron CMS400.NET. To do that,
follow these steps.
1. From the left side of the Workarea, click Settings > User
Groups.
2. Click the Add Groups button (
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3. The Search Active Directory for Groups screen appears.

4. From the Domain drop-down list, select the domain from which
you want to add a user group.
NOTE

The Active Directory Setup screen can restrict AD integration to one domain. If it
does, you can only search within that domain.

5. Enter as much information as you know into the Active
Directory Group field.
6. Click the Search button.
7. A new screen displays all groups that satisfy the search
criteria.
8. Click the check box under the Add column to add the user
group to Ektron CMS400.NET.
9. Click the Save button (

).

Associating a User’s AD Group Information with Ektron CMS400.NET
When Integration is First Enabled

Ektron CMS400.NET User Database Already Exists
If Auto Add User To Group is checked (on the Active Directory Setup
screen), a user’s group membership is first copied from the AD to
Ektron CMS400.NET when a user logs in or is added. At this time,
any AD group memberships overwrite Ektron CMS400.NET group
memberships except the Everyone group, to which all users
belong.
NOTE

The Everyone group, unlike other Ektron CMS400.NET groups, is not associated
with an AD group. It is an all-encompassing group with no special permissions.
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If a user belongs to an AD user group that does not exist in Ektron
CMS400.NET, nothing happens because the feature assumes that
all AD groups are not meaningful in Ektron CMS400.NET.
If a user belongs to an Ektron CMS400.NET user group that does
not exist in AD, the discrepancy is flagged on the Active Directory
Setup and Active Directory Status screens. From these screens,
you can copy the AD group information into Ektron CMS400.NET.
See Also: ”Associating User Group Membership with Active
Directory User Group Membership” on page 825 and ”Associating
Groups with Active Directory Groups” on page 825
To learn how membership is updated from then on, see ”After
Integration is Enabled” on page 806.
Ektron CMS400.NET is Being Installed, so No User Groups Exist

Follow the procedure described in ”Copying User Groups from AD
to Ektron CMS400.NET” on page 804 to copy AD user groups to
Ektron CMS400.NET. As users in those groups are added to
Ektron CMS400.NET, their group membership is copied from AD
to Ektron CMS400.NET.

After Integration is Enabled

A user’s group membership is updated in Ektron CMS400.NET
when all of the following are true:
•

The Enable automatic addition of user to groups field is
checked on the Active Directory Setup screen

•

A user is added to Ektron CMS400.NET or his group
membership changes in the Active Directory

•

The user logs in or someone clicks on the Refresh button (
on the user’s View User Information screen

)

On the other hand, if Enable automatic addition of user to
groups field is unchecked, you can add the user to groups and
remove him from groups independently of his AD group
memberships.
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Mapping the Administrator Group
On the Ektron CMS400.NET Active Directory Setup screen, you
can identify an AD user group that maps to the Ektron
CMS400.NET Administrator group.
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Administrators have access to all functions documented in this
documentation. (Unlike other Ektron CMS400.NET user groups,
whose names are copied from the AD, the Administrator and
Everyone group names cannot be changed.)
For example, if the AD has a user group named CMSAdmin whose
members should have the privileges of Ektron CMS400.NET
administrators, assign that group to Administrators on the Active
Directory Setup screen. If such a group does not exist in AD yet,
you should create it and then assign it on the Active Directory
Setup screen.
Note that only one AD group can be mapped to the Ektron
CMS400.NET Administrator group -- you cannot have an AD
administrator group within each AD domain.
See Also: ”The Active Directory Setup Screen” on page 818

User Belongs to AD Group that Does Not Exist in Ektron CMS400.NET
If user is assigned to an AD user group that does not exist in
Ektron CMS400.NET, nothing happens. The AD integration feature
assumes that an Ektron CMS400.NET administrator only
maintains user groups that are meaningful to Ektron
CMS400.NET, and not all AD groups may be meaningful to Ektron
CMS400.NET.
NOTE

If a user belongs to a user group that is given Membership permissions, but also
to a group that has CMS permissions, the user will only receive Membership
permissions if logged into Ektron CMS400.NET.

User Belongs to Ektron CMS400.NET Group that Does Not Exist in AD
If a user was a member of a user group in Ektron CMS400.NET
before integration was enabled, but does not belong to that group
in the AD, this discrepancy is flagged on the Active Directory Setup
and Active Directory Status screens.
If the user should belong to the AD group, add the group
membership within the AD. Then, refresh the user on these
screens to copy AD group information into Ektron CMS400.NET.
See Also: ”Associating Groups with Active Directory Groups” on
page 825
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Removing Users from a Group
If you delete a user from an AD group, the user is automatically
removed from the associated Ektron CMS400.NET group the next
time the user’s information is updated (as explained in ”Copying
User Group Information from AD to Ektron CMS400.NET” on
page 804).

Adding User Groups
Once AD integration is enabled, you can only add new user groups
in the AD. In Ektron CMS400.NET, use the Search Active Directory
for Groups screen to copy an AD user group to Ektron
CMS400.NET. You can only add groups that do not already exist
in Ektron CMS400.NET. This procedure is described in ”Copying
User Groups from AD to Ektron CMS400.NET” on page 804.

Adding a User to a Group
You cannot add a user to a user group within Ektron CMS400.NET
-- you must do so in the Active Directory.

Replacing a User Group
If you realize that you have associated the wrong AD user group
with an Ektron CMS400.NET user group, you can replace the user
group. Follow these steps to do so.
1. From the left side of the Workarea, click User Groups.
2. Click the user group that you want to replace.
3. Click the Associate Ektron CMS400.NET Group with Different
AD Group button (

).

4. Select a group to replace the group you selected in Step 2.
5. Click the Save button (

) to finalize the change.

Deleting a User Group
Deleting a User Group in AD

If you delete a user group in AD and users are assigned to the
group within Ektron CMS400.NET, the group is not automatically
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deleted in Ektron CMS400.NET. However, any Ektron
CMS400.NET users who were members of the group are no longer
members the next time their Ektron CMS400.NET information is
updated. The discrepancy is flagged on the Active Directory Setup
and Active Directory Status screens.

Deleting a User Group in Ektron CMS400.NET

If you delete a user group in Ektron CMS400.NET and users are
assigned to that group within AD, nothing happens. This is
because the AD Integration Feature assumes that, in Ektron
CMS400.NET, the administrator only sets up user groups that are
meaningful to Ektron CMS400.NET, and some AD groups are not
meaningful to Ektron CMS400.NET.

Associating User Information in AD with Ektron CMS400.NET
A key component of the Active Directory Integration feature is to
maintain consistent information between the AD and Ektron
CMS400.NET. This section explains the transfer of user
information between AD and Ektron CMS400.NET when
integration is first enabled and on an ongoing basis.
This section covers the following topics.
•

”Automatically Copying AD User Information When Integration
is First Enabled” on page 811

•

”Automatically Copying AD User Information after Integration is
Enabled” on page 812

•

”Manually Adding AD User Information to Ektron
CMS400.NET” on page 812

•

”Editing User Information in Ektron CMS400.NET” on page 813

•

”Deleting Users” on page 813

•

”Replacing a User” on page 814
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Automatically Copying AD User Information When Integration is First
Enabled
Ektron CMS400.NET Database Already Implemented

If Enable automatic addition of user from AD is checked on the Active
Directory Setup screen, user information is copied from the AD to
Ektron CMS400.NET when that user logs in or is added to Ektron
CMS400.NET.
See Also: ”The Active Directory Setup Screen” on page 818
The first time the user information is copied, the AD information
overwrites all Ektron CMS400.NET information. To learn how
information is updated from then on, see ”Copying User Group
Information from AD to Ektron CMS400.NET” on page 804.
If two or more AD users have the same Ektron CMS400.NET user
logon name but different domains (for example, JDoe in
Eng.Example.com and JDoe in Mkt.Example.com) and that
username (JDoe) also exists in Ektron CMS400.NET, the Active
Directory Setup and Active Directory Status screens indicate this
discrepancy by the following message:
CMS users need to be associated with Active Directory users.
Click the message to proceed to the Associate Ektron
CMS400.NET Users to Active Directory Users screen and
associate an AD user with the Ektron CMS400.NET user.
See Also: ”Associating Ektron CMS400.NET Users with Active
Directory Users” on page 823
Ektron CMS400.NET is Being Installed, so No User Database Exists

Go to the Search Active Directory for Users Screen and select AD
users that will use Ektron CMS400.NET. When you add a user, the
user information is copied from the AD to Ektron CMS400.NET.
See Also: ”The Search Active Directory for Users Screen” on
page 829
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NOTE

You can only select AD users that do not already exist in Ektron CMS400.NET.
Also, the Active Directory Setup screen can restrict AD integration to one domain.
If it does, you can only search for users within that domain.

Automatically Copying AD User Information after Integration is Enabled
User information is copied from the AD to Ektron CMS400.NET
when either of these events occurs:
•

the user logs in

•

someone clicks the Refresh button (
User Information screen

) on the user’s View

See Also: ”The View User Information Screen” on page 827
If a user’s last name, first name, email field, or group membership
changed in the AD, those changes are copied to Ektron
CMS400.NET. However, if a user’s logon name changed in the
AD, that change is not copied to Ektron CMS400.NET because
Ektron CMS400.NET uses that field to identify the user. Instead,
that discrepancy is flagged on the Active Directory Setup and
Active Directory Status screens. You should proceed to the
Associate Ektron CMS400.NET Users to Active Directory Users
screen, where you can update the AD user associated with the
Ektron CMS400.NET user.
See Also: ”Associating Ektron CMS400.NET Users with Active
Directory Users” on page 823

Manually Adding AD User Information to Ektron CMS400.NET
Before using the AD integration feature, add all AD users that will
use your Web site to Ektron CMS400.NET. This can be done
automatically, as explained ”Automatically Copying AD User
Information When Integration is First Enabled” on page 811.
If you want to manually add an AD user to Ektron CMS400.NET,
follow these steps.
1. From the left side of the Workarea, click Users.
2. Click the Add Users button (

).
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3. The Search Active Directory for Users screen appears.

4. From the Domain pull-down list, select the domain from which
you want to add a user.
5. Enter as much information as you know into the other fields.
6. Click the Search button.
7. A new screen displays all users that satisfy the search criteria.
8. Click the check box under the Add column to add users to
Ektron CMS400.NET.
9. Click the Save button (

).

Editing User Information in Ektron CMS400.NET
Because Ektron CMS400.NET does not write to the AD, you can
only change the User Language and Disable email Notifications
fields within the Ektron CMS400.NET Edit User screen. You must
edit all other user fields from the AD.

Deleting Users
If a user is deleted in AD, Ektron CMS400.NET does not
automatically delete the user. However, the user’s login fails
because he cannot be authenticated.
The user remains in Ektron CMS400.NET, and the discrepancy is
flagged on the Active Directory Setup and Active Directory Status
screens. You should delete the user from Ektron CMS400.NET
using the Delete User function.
See Also: ”Deleting a User” on page 722
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NOTE

If you mistakenly delete all users with administrative privileges, you can still sign
in using the builtin user’s username and password. For more information, see
”BuiltIn User” on page 30.

Replacing a User
If you associate the wrong AD user with a Ektron CMS400.NET
user, you can replace the user. If you do, all Ektron CMS400.NET
privileges and workflow responsibilities assigned to the old user
transfer to the new one.
Follow these steps to associate a Ektron CMS400.NET user with a
new AD user.
1. From the left side of the Workarea, click Users.
2. Click the user you want to replace.
3. Click the Associate CMS User with Different AD User button
(

).

4. Select a user to replace the user you selected in Step 2.
5. Click the Save button (

).

When you complete this procedure, the first user is deleted from
Ektron CMS400.NET.

The Screens of the Active Directory Feature in Active
Directory Integration Mode
The Active Directory feature uses the following screens:
•

”The Edit Domains Screen” on page 815

•

”The Active Directory Setup Screen” on page 818

•

”The Active Directory Status Screen” on page 822

•

”The View Users Screen” on page 826

•

”The View User Groups Screen” on page 829

This section explains how to use each screen.
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The Edit Domains Screen
Use this screen to identify each network domain you will use with
Ektron CMS400.NET’s Active Directory feature. You would use this
when you want to define domains, as opposed to using auto
discovery to find them.
This feature is described through the following subtopics.
•

”Enabling the Edit Domains Screen” on page 815

•

”Accessing the Edit Domains Screen” on page 815

•

”Fields of the Edit Domains Screen” on page 816

•

”How Domains are Used” on page 817

Enabling the Edit Domains Screen

To have the Edit Domains screen appear, set the following
web.config file values as shown below.

web.config value

Setting

ek_ADEnabled

True

ek_ADAdvancedConfig

True

ek_ADUsername

blank (username entered in Edit Domains screen)

ek_ADPassword

blank (username entered in Edit Domains screen)

ek_AUTH_Protocol

LDAP

Accessing the Edit Domains Screen

After you modify web.config as described above, access the Edit
Domains screen by going to Workarea > Settings >
Configuration > Active Directory > Domains.
Below is a sample of the screen.
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The screen lets you add new domains, modify existing ones, or
delete obsolete ones.
Fields of the Edit Domains Screen

When defining a domain, enter the following information.

Field

Description

Domain

Enter the domain’s DNS. Contact your server administrator for this
information. For example, corp.example.com.

DNS
NetBIOS

If your NetBios is the same as your domain name, leave the checkbox
box checked. Otherwise, uncheck the box and enter your NetBIOS
setting. Contact your server administrator for this information.

Username

Enter the name of the user with permission to sign on to the domain
server. The name is in the format username@domainDNS. For example,
jsmith@corp.example.com.
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Field

Description

Password

Enter the password of the user identified above.

Domain
Controller IP

Enter the IP address or DNS name of your domain controller.
Note: If using Active Directory across a firewall, the IP address should be
that of the firewall. On the firewall, traffic on port 389 (LDAP) should be
allowed.

How Domains are Used

Domains defined on this screen are referenced when defining the
user group that maps to the hard coded Ektron CMS400.NET
administrator group. See Also: ”The Screens of the Active
Directory Feature in Active Directory Integration Mode” on
page 814
While defining the user group, first select a domain. Ektron
CMS400.NET creates a selection list of Active Directory user groups
in that domain. In this way, you must choose a user group within
the selected domain.
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The Active Directory Setup Screen
The Active Directory Setup screen (illustrated below) lets you
enable and disable the Active Directory feature, as well as
determine other aspects of AD management, such as whether
users and groups are automatically updated. To access the screen,
click Settings > Configuration > Active Directory > Setup from
the left panel of the Workarea.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

818

Implementing Active Directory Integration

The following table describes the fields on the screen.
See Also: ”Messages Near the Top of the Active Directory Setup
Screen” on page 821
Field

Description

For more information, see

Active Directory Installed
Disable Active
Directory and
LDAP
Authentication

Disables the use of Active Directory and LDAP
Authentication.

”Disabling AD Integration” on
page 832

Enable LDAP
Authentication

If enabled, you need to fill out the following five
fields. These fields are explained in the LDAP
Authentication chapter.

”Enabling LDAP” on page 852

LDAP Server

Explained in LDAP Authentication chapter.

”Enabling LDAP” on page 852

Port

Explained in LDAP Authentication chapter.

”Enabling LDAP” on page 852

Organization

Explained in LDAP Authentication chapter.

”Enabling LDAP” on page 852

Domain

Explained in LDAP Authentication chapter.

”Enabling LDAP” on page 852

Organizational
Unit

Explained in LDAP Authentication chapter.

”Enabling LDAP” on page 852

Active Directory
Authentication

If enabled, user authentication is functional, and
you can enable the following three fields.

”User Authentication Only
Mode” on page 833
For information on LDAP, see
”LDAP Authentication” on
page 850

Active Directory
Integration

If enabled, the Active Directory feature is
functional.

”Active Directory Integration”
on page 800

Note: Can only be enabled if Active Directory
Authentication is enabled.
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Field

Description

For more information, see

Auto Add User

If enabled, user information is copied from the AD
to Ektron CMS400.NET when that user logs in or
when the user is added to Ektron CMS400.NET.

”Associating User Information
in AD with Ektron
CMS400.NET” on page 810

Note: Can only be enabled if Active Directory
Integration is enabled.
Auto Add User
To Group

If enabled, a user’s group membership is first
copied from the AD when a user logs in or is
added.
Note: Can only be enabled if Active Directory
Integration is enabled.

”The Screens of the Active
Directory Feature in Active
Directory Integration Mode” on
page 814

User Property Mapping
FirstName

Enter the Active Directory Property that maps to
the user’s first name in Ektron CMS400.NET. By
default, this is set to givenName, but you can
change it to any AD property.

MSDN Library (http://
msdn.microsoft.com/library/
default.asp)> Active Directory,
ADSI and Directory Services >
Directory Services > Active
Directory > Active Directory
Reference > Active Directory
User Interface Mappings.

LastName

Enter the Active Directory Property that maps to
the user’s last name in Ektron CMS400.NET. By
default, this is set to sn, but you can change it to
any AD property.

same reference as FirstName
(above)

EmailAddr1

Enter the Active Directory Property that maps to
the user’s last name in Ektron CMS400.NET. By
default, this is set to mail, but you can change it to
any AD property.

same reference as FirstName
(above)

Ektron CMS400.NET Administrator Group Mapping
AD Group
Name @ AD
Domain

Enter the Active Directory user group and domain
name that maps to the hard coded Ektron
CMS400.NET administrator group. If you do not
have an AD user group that includes all Ektron
CMS400.NET administrators, you should create
one and enter its name and domain here.
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Field

Description

For more information, see

Domain

If you want to restrict the search of new users and
groups to one AD domain, select that domain.
If you do, the Search Active Directory for Users
and Search Active Directory for Groups screens
let you search in the selected domain only.
Also, if any Ektron CMS400.NET user or group
names include a domain (for example,
admin@saturn.example.com) that is excluded by
your selection, those users/groups are flagged on
the Active Directory Setup and Active Directory
Status screens because the names now include
an invalid domain.

Messages Near the Top of the Active Directory Setup Screen

Message

Explanation

Active Directory Authentication is Enabled and
Requires More Configuration.

Some Ektron CMS400.NET users are not associated
with AD users. Also, if you are using full active
directory integration mode, user groups and/or user
group relationships may not be associated.
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Message

Explanation

Active Directory Authentication is disabled, but
needs further configuration

Some Ektron CMS400.NET users and/or groups are
no longer unique.
This happens because, in the AD, users and groups
can share a logon name as long as their domains are
different.
But, when AD authentication is disabled, two Ektron
CMS400.NET users or groups can no longer share a
name -- each must be unique.

If you see either message, click it. You proceed to the Active
Directory Status screen, which helps you resolve the
discrepancies.
See Also: ”The Active Directory Status Screen” on page 822

The Active Directory Status Screen
Use the Active Directory Status screen to resolve the following
discrepancies between Ektron CMS400.NET and AD.
•

an Ektron CMS400.NET user needs to be associated with an
AD user

•

an Ektron CMS400.NET user group needs to be associated
with an AD user group

•

an Ektron CMS400.NET user’s group membership need to be
associated with the same AD user’s group membership

To access the screen, click Configuration > Active Directory >
Status from the left panel of the Workarea.
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.

There are several reasons why such discrepancies may occur. To
learn more about why
•

an Ektron CMS400.NET user is not associated with an AD
user, read ”Associating User Information in AD with Ektron
CMS400.NET” on page 810.

•

an Ektron CMS400.NET user’s group membership is not
associated with the user’s AD group membership, read
”Associating a User’s AD Group Information with Ektron
CMS400.NET” on page 805

•

an Ektron CMS400.NET group is not associated with an AD
group, read ”The Screens of the Active Directory Feature in
Active Directory Integration Mode” on page 814

If you click any link on the Active Directory Status screen, a new
screen appears that allows you to resolve the discrepancy. For
information on how to use these screens, see the following topics.
•

”Associating Ektron CMS400.NET Users with Active Directory
Users” on page 823

•

”Associating User Group Membership with Active Directory
User Group Membership” on page 825

•

”Associating Groups with Active Directory Groups” on
page 825

Associating Ektron CMS400.NET Users with Active Directory Users

If you click CMS users need to be associated with Active
Directory users on the Active Directory Status screen, the
Associate Ektron CMS400.NET Users with Active Directory Users
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screen appears (illustrated below). Use this screen to associate
Ektron CMS400.NET users with AD users.

If a user with the same username exists in the AD, that name and
domain appear by default in the AD Username and AD Domain
fields. If the user exists in the more than one AD domain (as
illustrated in the first example above), select a domain from the
pull-down list.
If there is no default and you know the AD user name to associate
with an Ektron CMS400.NET user, enter that in the AD Username
and AD Domain fields. If you do not know the AD username, click
Search to find the user in the AD.
If you decide to change the username in AD to match the Ektron
CMS400.NET username, make the change in the AD. Then, click
the Refresh button ( ) to update Ektron CMS400.NET and
resolve the discrepancy.
Finally, if a user should not exist in Ektron CMS400.NET, click the
box under the Delete column to delete the user from Ektron
CMS400.NET.
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After you make all necessary changes, click the Save button (

).

Associating User Group Membership with Active Directory User Group Membership

If you click CMS relationships need to be associated with
Active Directory relationships on the Active Directory Status
screen, the Associate Ektron CMS400.NET Relationships with
Active Directory Relationships screen appears (illustrated below).
Use this screen to coordinate Ektron CMS400.NET user group
membership with AD user group membership.
The screen displays a user’s group membership that exists in
Ektron CMS400.NET, but does not exist in the AD.

See Also: ”Associating a User’s AD Group Information with Ektron
CMS400.NET” on page 805
After viewing the discrepancy on the screen, you have two
choices:
•

To associate the user with the same user group in AD, go to the
AD and assign the user to the group. Then, return to this
screen and click the Refresh button ( ) to update the user
group information in Ektron CMS400.NET.

•

To remove the user’s group membership in Ektron
CMS400.NET, check the box under the Delete column and
click the Save button (

).

Associating Groups with Active Directory Groups

If you click CMS groups need to be associated with Active
Directory groups on the Active Directory Status screen, the
Associate Ektron CMS400.NET User Groups with Active Directory
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Groups screen appears (illustrated below). Use this screen to
associate Ektron CMS400.NET groups with AD groups.

If a group with the same groupname exists in the AD, that name
appears by default in the AD Group Name field. If the group exists
in the more than one domain within the AD, select a domain from
the pull-down list.
If there is no default and you know the AD group name to
associate with an Ektron CMS400.NET group, enter that in the AD
Group Name and AD Domain fields. If you do not know the AD
groupname, click Search to find the group in the AD.
Finally, if this group should not exist in the Ektron CMS400.NET
database, click the box under the Delete column to delete the
group from Ektron CMS400.NET.
After you make all necessary changes, click the Save button (
to save them.

)

The View Users Screen
The View Users screen (illustrated below) lists all users in the
Ektron CMS400.NET database. To access the screen, click Users
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from the left panel of the Workarea. To view more information for a
user, click that user to move to the View User Information screen.

The View Users screen also provides a toolbar button ( ) that
lets you add AD users to the Ektron CMS400.NET database.
When you click it, the Search Active Directory for Users Screen
appears.
The View User Information Screen

The View User Information Screen displays the user’s
•

username and domain
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•

first and last name

•

language

•

email address and whether the user receives email
notifications

•

user groups

If you are using user authentication mode, username and domain
can only be edited in the AD. You can edit all other fields on this
screen.
If you are using full AD Integration mode, you can only edit
language and whether the user receives email notifications. You
must edit the other fields in the AD.
The screen also displays the following buttons.
Button

Description
Edit information on screen

Delete user

See Also: ”Deleting Users” on page 813
Retrieve latest information from AD into Ektron
CMS400.NET

See Also: ”Copying User Group Information from AD
to Ektron CMS400.NET” on page 804
Note: This toolbar button does not appear if you are
using user authentication mode.
Replace user

See Also: ”Replacing a User” on page 814
Return to previous screen
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The Search Active Directory for Users Screen

Use this screen to add AD users to Ektron CMS400.NET. To
access the screen, click Users from the left panel of the Workarea,
then click the Add button (

).

Enter as much search criteria as you know to reduce the number of
users that the search yields. For example, if you know that the
user’s last name is Jackson and the user is in the planets domain,
enter those criteria and you will get fewer hits.
When the Active Directory Users screen appears, click the box
next to users that you want to create in Ektron CMS400.NET.
Then, click the Save button ( ) to copy their information into
Ektron CMS400.NET.

The View User Groups Screen
The View User Groups Screen displays all AD user groups that
have been copied into Ektron CMS400.NET. (See ”Copying User
Groups from AD to Ektron CMS400.NET” on page 804).
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To access the screen, click User Groups from the left panel of the
Workarea.

To view more information for a group, click that group to move to
the View Users in Group screen.
The View User Groups screen also provides a toolbar button ( )
that lets you add AD groups to the Ektron CMS400.NET database.
When you click it, the Search Active Directory for Groups screen
appears.
View Users in Group Screen

The View Users in Group Screen displays, for each user in the
group
•

username and domain

•

first and last name

•

language
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The screen also displays the following buttons.
Button

Description
Replace group

See Also: ”Replacing a User Group” on page 809
Return to previous screen

The Search Active Directory for Groups Screen

Use this screen to add AD groups to Ektron CMS400.NET. Enter
as much search criteria as you know to reduce the number of
groups that the search yields.
NOTE

You can only select AD groups that do not already exist in Ektron CMS400.NET.
Also, the Active Directory Setup screen can restrict AD integration to one domain.
If it does, you can only search for groups within that domain.

For example, if you know that a group begins with S and is in the
planets domain, enter those criteria and you will get fewer hits.
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After you click Search, a new screen appears listing all AD groups
that satisfy the search criteria. Click the box next to groups that you
want to create in Ektron CMS400.NET. Then, click the Save button
( ) to copy their information.

Disabling AD Integration
If you decide to disable AD authentication or integration, edit the
Active Directory Setup screen and uncheck the box next to Enable
Active Directory Authentication or Enable Active Directory
Integration.
See Also: ”The Active Directory Setup Screen” on page 818
If you do this, and any users or groups share the same name within
different domains, the following message appears on the screen.
Active Directory Authentication is disabled, but needs further
configuration
For example, two users are named JJackson@example.net and
JJackson@example.com. When AD was enabled, the domain
names made the two users unique. However, when you disable
integration, the domain names are dropped, so the user names are
now identical. You need to make the users unique.
If you click the message (above) on the Active Directory Setup
screen, you move to the Active Directory Status screen. The
following messages may appear.
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Click the message to proceed to the Make Ektron CMS400.NET
Users Unique screen (illustrated below).

This screen lists all users whose user names are not unique and
suggests a new, unique Ektron CMS400.NET username. The new
name consists of the user name, underscore, at sign (@),
underscore, the domain name. So, for example,
JJackson@example.net would appear as
JJackson_@_example.net.
The same is true for user groups. For example, if you had two
groups name Account Operators, one in the example.com domain
and another in the saturn.example.com domain, the Make Ektron
CMS400.NET Groups Unique screen would look like this.

Ektron recommends that you accept the suggested new names.
Click the Save (

) button to do so.

One advantage of using the new name format is that, if you later
decide to re-enable AD integration, the software can automatically
associate the AD and Ektron CMS400.NET users or groups.

User Authentication Only Mode
In user authentication mode, the sharing between AD and Ektron
CMS400.NET is limited to user logon name, domain, and password.
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The following topics explain how to work with user authentication
mode.
•

”How Information is Transferred from Active Directory to Ektron
CMS400.NET” on page 834

•

”Which Information is Transferred from Active Directory to
CMS400.NET” on page 834

•

”User Groups” on page 835

•

”Adding User Information from AD to Ektron CMS400.NET” on
page 835

•

”Editing User Information in Ektron CMS400.NET” on page 835

•

”Deleting Users” on page 836

•

”Replacing a User” on page 836

•

”The Screens of the Active Directory Feature in User
Authentication Mode” on page 836

•

”Disabling AD Authentication” on page 836

How Information is Transferred from Active Directory to
Ektron CMS400.NET
Ektron CMS400.NET does not write to the AD – it only reads from
it. This results in the following changes to how the username,
domain, and password are handled within Ektron CMS400.NET.
•

Changes to user logon name, domain and password must be
made in the AD — you cannot update these fields in the Ektron
CMS400.NET Edit User screens.

•

When adding a new user to Ektron CMS400.NET, you can only
select AD users. If the user does not exist in the AD, create the
user there, and then import the user into Ektron CMS400.NET.

Which Information is Transferred from Active Directory to
CMS400.NET
CMS refers to the following AD sign-in authentication information
during sign-in: password, user logon name, and domain. Note that
the password is not stored in CMS — CMS only refers to the
password during sign-in.
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User Groups
User authentication mode has no effect on user groups. To learn
more about user groups, see ”Managing User Groups” on
page 723.

Adding User Information from AD to Ektron CMS400.NET
See ”Manually Adding AD User Information to Ektron
CMS400.NET” on page 812

Changing the User Login Name in AD
If a user’s logon name changes in the AD, it no longer matches the
Ektron CMS400.NET logon name. This discrepancy is flagged on
the Active Directory Setup and Active Directory Status screens.
You should proceed to the Associate Ektron CMS400.NET Users
to Active Directory Users screen, where you can update the user
information.
Alternatively, you could
1. Go to the View User Information screen.
2. Select the user whose AD name changed.
3. Click the Associate the Ektron CMS400.NET user with
Different AD user toolbar button (

).

4. Select the AD user and domain.
See Also: ”Associating Ektron CMS400.NET Users with Active
Directory Users” on page 823

Editing User Information in Ektron CMS400.NET
Ektron CMS400.NET does not write to the AD. This means that
you can only change the Username and Domain fields from the
AD.
You can change the First Name, Last Name, email Address,
User Language and Disable email Notifications fields on the
Ektron CMS400.NET Edit User screen.
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Deleting Users
See ”Deleting Users” on page 813

Replacing a User
See ”Replacing a User” on page 814
IMPORTANT!

If you replace a user in user authentication-only mode, the user’s first name, last
name, and email address are not overwritten with information in the active
directory.

The Screens of the Active Directory Feature in User
Authentication Mode
Since the scope of user authentication mode is limited, only some
fields on the AD screens are used. For example, on the Active
Directory setup screen, the only relevant fields are authentication
and domain.
See Also: ”The Active Directory Setup Screen” on page 818
Also, on the Active Directory Status Screen, only one discrepancy
message may appear:
CMS user needs to be associated with an AD user
See Also: ”Associating Ektron CMS400.NET Users with Active
Directory Users” on page 823
The View Users Screen works the same for both modes.
See Also: ”The View User Information Screen” on page 827

Disabling AD Authentication
See ”Disabling AD Integration” on page 832
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Logging into a System that Uses
AD Integration

Because usernames and passwords are stored in the AD by
domain, the AD sign on procedure requires you to select a domain
name. So, if AD integration is enabled, the sign on screen includes
a drop-down list that prompts the user to select a domain.

NOTE

Your organization determines AD domain names.

For more information about logging in, see ”Logging Into an Ektron
CMS400.NET Web Site” on page 10.
This feature is explained through the following topics.
•

”Single Sign On” on page 837

•

”Setting up Single Sign On” on page 838

Single Sign On
You can implement a Single Sign On feature that lets a user
bypass the Login screen. The feature retrieves the user’s Windows
login information from the server to authenticate access to Ektron
CMS400.NET.
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How Single Sign on Works
The feature uses a variable called User.Identity.Name. This holds
the user's account\domain in Active Directory, and has the format
[domain]\[username]. For example, EKTRON1\skearney. This variable is
set when a user authenticates against a Windows server.
When a user clicks the login server control, if the variable is
passed and Active Directory is enabled, the server control opens
the autologin.aspx page. Next, the opening window refreshes just
like a normal login, except the user is not prompted to enter a
username, password, and domain.
However, if the user‘s computer is not on a domain, not on the
same domain as Ektron CMS400.NET, or does not include the
Ektron CMS400.NET server as a trusted site, the following login
screen appears.

If Active Directory is not enabled, the normal login.aspx page
appears.

Setting up Single Sign On
The Single Sign On login process uses the autologin.aspx file (in
the workarea/SSO directory) . Once set up, user authentication is
enabled from any domain that this server can reach. For example,
if Ektron CMS400.NET is located in a third level domain, users from
third, second, and first level domains can authenticate.
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•

”Setting up Single Sign On Using IIS6” on page 839

•

”Setting up Single Sign On Using IIS7” on page 843

After completing these procedures, enable Active Directory within
Ektron CMS400.NET (if it isn’t already enabled). See Also: ”Setup
Guidelines” on page 797
Ektron recommends turning on the auto add options (user and
group).

Setting up Single Sign On Using IIS6
Setting up Single Sign On with IIS 6 involves these procedures.
•

”Modifying Web.config for Single Sign On” on page 839

•

”Adjusting Security Settings for the Site Root Folder” on
page 839

•

”Adjusting Security Settings for autologin.aspx” on page 841

•

”Adjusting the Login Server Control” on page 843

Modifying Web.config for Single Sign On
1. Open your site root folder.
2. Open the web.config file.
3. Find the ek_AUTH_protocol element.
4. Change its value to GC. It should look like this:
<add key="ek_AUTH_Protocol" value="GC" />

5. Find the authentication element.
6. Change the value of the impersonate attribute to true. It should
look like this:
<authentication mode="Windows" />
<identity impersonate="true" userName="" password=""/>

Adjusting Security Settings for the Site Root Folder
1. Go to Windows Control Panel > Administrative Tools >
Internet Information Services.
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2. Within IIS, go to Web Sites and select your Ektron
CMS400.NET site.
3. Right click your Ektron CMS400.NET site folder and select
Properties.

4. Click the File/Directory Security tab then the top Edit button.
5. Uncheck everything except Anonymous Access. The
Account used for anonymous access should specify a
domain account, preferably the root of the Active Directory
tree.
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Adjusting Security Settings for autologin.aspx
1. Go to Windows Control Panel > Administrative Tools >
Internet Information Services.
2. Within IIS, go to Web Sites > your Web site’s root folder >
Workarea > SSO > autologin.aspx.
3. Right click autologin.aspx and select Properties.
4. Click the File security tab and the top Edit button.
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5. Under Authenticated Access, uncheck all except Integrated
Windows Authentication.
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As a result, autologin.aspx will pass credentials from the
logged-in user's desktop.

Adjusting the Login Server Control
In Visual Studio.NET, open the Login server control and set the
AutoLogin property to True. (Server Controls are explained in the
Ektron CMS400.NET Developer’s Manual.)

Setting up Single Sign On Using IIS7
•

”Modifying Web.config for Single Sign On” on page 839

•

”Adjusting Security Settings for the Site Root Folder” on
page 839

•

”Adjusting Security Settings for autologin.aspx” on page 841

•

”Adjusting the Login Server Control” on page 843

After completing these procedures, enable Active Directory within
Ektron CMS400.NET (if it isn’t already enabled). See Also: ”Setup
Guidelines” on page 797
Ektron recommends turning on the auto add options (user and
group).
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Modifying Web.config for Single Sign On
1. Open your site root folder.
2. Open the web.config file.
3. Find the ek_AUTH_protocol element.
4. Change its value to GC. It should look like this:
<add key="ek_AUTH_Protocol" value="GC" />

5. Find the authentication element.
6. Change the value of the impersonate attribute to true. It should
look like this:
<authentication mode="Windows" />
<identity impersonate="true" userName="" password=""/>

7. Comment out the following lines.
<!-- <httpModules>
<add name="DigestAuthenticationModule"
type="Ektron.ASM.EkHttpDavHandler.Security.DigestAuthenticationModule,Ektron.ASM.EkHttpDavHan
dler " />
<add name="ScriptModule" type="System.Web.Handlers.ScriptModule, System.Web.Extensions,
Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35" />
</httpModules>
-->

Adjusting Security Settings for the Site Root Folder
1. Go to Windows Control Panel > Administrative Tools >
Internet Information Services.
2. Within IIS, go to Sites and select your Ektron CMS400.NET site.
3. From the right panel, select Authentication.
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4. On the Authentication screen, enable Anonymous
Authentication.
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5. Select Anonymous Authentication and click Edit.

6. Set the credentials to a specific user with a domain account,
preferably the root of the Active Directory tree.
Click Set to select the user.

7. Enter the username and password. Confirm the password.
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Adjusting Security Settings for autologin.aspx
1. Go to Windows > Control Panel > Administrative Tools >
Internet Information Services.
2. Within IIS, go to Web Sites > your Web site’s root folder >
Workarea > SSO > autologin.aspx.
3. From the right panel, enable Windows Authentication.
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As a result, autologin.aspx will pass credentials from the logged-in
user's desktop.

Adjusting the Login Server Control
In Visual Studio.NET, open the Login server control and set the
AutoLogin property to True. (Server Controls are explained in the
Ektron CMS400.NET Developer’s Manual.)
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LDAP Authentication

LDAP is short for Lightweight Directory Access Protocol. It is a set
of protocols that enable corporate directory entries to be arranged
in a hierarchical structure which reflects geographic and
organizational boundaries.
Ektron CMS400.NET’s LDAP feature lets you retrieve user Login
information from an LDAP server to Ektron CMS400.NET. As a
result, you can administer user information from one place, and
users only need to remember one password/username
combination to sign on to the network and Ektron CMS400.NET.
The hierarchical structure of LDAP authentication can look a few
different ways. For example, if you had the following LDAP
structure, the domain would typically span multiple countries.
NOTE

Here is a list of the abbreviations: CN = Common Name, OU = Organizational
Unit, O = Organization, DN = Distinguished Name.

CN=Pitchers Name, OU=Pitchers, O=Baseball Team, C=US,
DN=example.com
By changing the order of C and DN, the hierarchy indicates that the
domain example.com is located in the US.
CN=Pitchers Name, OU=Pitchers, O=Baseball Team,
DN=example.com, C=US.
In some instances, it may be necessary to have an Organization
appear below an Organizational Unit. This might happen if you
have your Organization Unit has it own Organizations.
Below is a visual example of an LDAP hierarchical structure.
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This chapter covers the following topics:
•

”Using LDAP with Ektron CMS400.NET” on page 851

•

”LDAP Screen Descriptions” on page 863

•

”Disabling LDAP Authentication” on page 867

Using LDAP with Ektron CMS400.NET
NOTE

Active Directory and LDAP are not the same. While they can perform some
similar functions, LDAP when used with Ektron CMS400.NET only verifies user
login information and creates the user in the everyone group. Active Directory can
can be used to verify user login information only or it can become completely
integrated with Ektron CMS400.NET. To learn more about using Active Directory
with Ektron CMS400.NET, see ”Active Directory Feature” on page 796

The following sections explain how to use LDAP with Ektron
CMS400.NET.
•

”Enabling LDAP” on page 852
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•

”Adding an Organizational Unit During Setup” on page 855

•

”Adding User Information from an LDAP Server to Ektron
CMS400.NET” on page 856

•

”Editing User Information in Ektron CMS400.NET” on page 862

•

”Deleting Users” on page 863

Enabling LDAP
You enable LDAP through the Active Directory Setup screen. To
enable the LDAP functionality in Ektron CMS400.NET, follow these
steps.See Also: ”The Active Directory Setup Screen” on page 863
IMPORTANT!

Before enabling LDAP in Ektron CMS400.NET, make sure your LDAP server is
set up and ready for use. Be sure to include an Ektron CMS400.NET
administrator account for yourself. Once you enable LDAP, the only account
available to access Ektron CMS400.NET without LDAP authentication is the
BuiltIn account. For more information on the BuiltIn account, see ”BuiltIn User” on
page 30.

1. In the webroot\siteroot\web.config file, change the following line:
<add key="ek_AUTH_Protocol" value="None"/>

becomes
<add key="ek_AUTH_Protocol" value="LDAP"/>

2. Save and close the Web.config file.
3. In the Workarea, navigate to the Settings > Configuration >
Active Directory > Setup screen.
4. Click the Edit button (

).

5. On the Active Directory Setup screen, choose Enable LDAP
Authentication.
6. Fill in the following fields.
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Field

Description

For more
information, see

Type

Choose the type of LDAP authentication you are
using.

”Using Active Directory
for LDAP” on page 854

Note: Depending on your choices, the fields below
may be required or disallowed.
The following choices are available:
•

Active Directory (LDAP) - Domain allowed, Organization is not.

•

Novell eDirectory/NDS - Organization allowed,
Domain is not.

•

Sun Iplanet/JSDS - Domain allowed, Organization
is not.

•

Other - Allows both Domain and Organization

LDAP Server

The IP Address or name of the LDAP server

Port

The LDAP server port that Ektron CMS400.NET
communicates with.
If you are unsure, consult the documentation provided
with your Directory Service (such as, Novell, iPlanet,
Microsoft, or Red Hat).

Organization

The name of your company or organization. For
example, Ektron, Inc.
This field can be blank if you enter a domain in the
Domain field.

Domain

The name of the domain you are using. For example,
www.ektron.com. This should be the same name you
used when you received your license key.
This field can be blank if you enter an organization in
the Organization field.

Path

The next levels below your Organization or Domain.
These can include multiple levels of Organizational
Units. For example, Content Editors, Marketing, East
Coast.
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Field

Description

For more
information, see

Add

Enter your the path you would like access to in the text
field and click the Add link.

”Adding an
Organizational Unit
During Setup” on
page 855

When adding Organizational Units, the paths are
comma separated and run from specific to general.
For example, ou=Amherst,ou=New Hampshire,o=US
Do not add individual Common Names here. Only add
Organizational Units that contain the people who
should have access to Ektron CMS400.NET.
Important: You can have additional Organizations
below your Organization Units as long as the path on
your LDAP server is the same.
Delete

To add a single individual
from a different
Organizational Unit, see
”Adding User Information
from an LDAP Server to
Ektron CMS400.NET” on
page 856

Choose any Organizational Unit from the multiselection box and click the Delete link.

7. Click the Save button (

).

Using Active Directory for LDAP
In the webroot\siteroot\Web.Config file, add the Username and
Password for ek_ADUsername and ek_ADPassword. For example:
<add key="ek_ADUsername" value="mwright@ektron.com" />
<add key="ek_ADPassword" value="mypasswordisthis" />

When using LDAP to connect to Active Directory, use the following
settings in the Workarea.
NOTE

LDAP using AD is NOT the same as AD integration. LDAP integration
(independent of server type) does not support groups, only user authentication.

Field

Needed Information

Type

Active Directory (LDAP)

LDAP Server

[IP Address of the AD domain controller]
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Field

Needed Information

Port

389

Organization

[leave this blank]

Domain

[dns name of the AD domain]
For example: intra.ektron.com

Organizational Unit

[any OUs that you want to draw users from]
For example: Support,Users,Ektron Corporate also
Engineering,Users,Ektron Corporate

Adding an Organizational Unit During Setup
Things to consider when adding Organizational Units are:
•

Should everyone in the OU have access to Ektron
CMS400.NET?
Once LDAP is enabled, users are added to the everyone group
upon login. While everyone in the OU has access to Ektron
CMS400.NET, every user does not necessarily have
permission to edit content. To control permissions, set up user
groups, adding each user to a group, and assigning
permissions to the group. For more information on user groups,
see ”Managing Users & User Groups” on page 712. For more
information on assigning permissions, see ”Setting
Permissions” on page 768.

•

Do users in other Organizational Units need access?
Sometimes, managers or editors are in a different OU. They
need to be added manually, or you need to add their OU.

When adding an Organizational Unit, several entries might cover
the same hierarchical path. For example, you might have:
•

ou=Pitchers,ou=Players,o=Team

•

ou=Players,o=Team

•

o=Team

This allows you to authenticate users listed in Pitchers, Players,
and Team.
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Adding User Information from an LDAP Server to Ektron
CMS400.NET
Users at each level are automatically available for adding to Ektron
CMS400.NET. You do not have to be at the OU or CN level to add
a user. If a user is at the DC or OU level, they are available.
There are three ways to add LDAP user information to Ektron
CMS400.NET.
•

NOTE

Have the user log in after LDAP is enabled. As a result, the
user appears in the Users list and is added to the Everyone
group.

After a user logs in, some fields on the Add User screen can be filled in manually,
such as first and last name. For a description of these fields, see ”Fill out the fields
according to the table below.” on page 859.

•

Search an LDAP server for LDAP users using the LDAP
Search feature. See Also: ”Searching an LDAP Server for
Users” on page 856

•

Add the user’s LDAP information manually. See Also: ”Steps to
Manually Add an LDAP User” on page 858.

•

A combination of browsing for the user, then manually
completing the remaining fields. See Also: ”Using the Browse
Feature to Add an LDAP User” on page 860

Searching an LDAP Server for Users
The following steps explain how to search for a user on an LDAP
server an add them to the CMS400.NET.
1. Enable LDAP by following the instructions in ”Enabling LDAP”
on page 852.
2. From the left side of the Workarea, click Users.
3. Click the Add Users button (

).
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4. The Add a New User to the System screen appears.

5. Click the Browse LDAP button (

).

6. The Search LDAP Users screen appears.

7. Enter search criterion for any of the categories to search.
•

Username - the username of the user on the LDAP server.

•

Firstname - the first name of the user on the LDAP server.

•

Lastname - the last name of the user on the LDAP server

•

Path - select a path from the drop down list. The paths that are
available are the same paths that are enabled when
configuring the CMS400.NET for use with your LDAP server. If
you select a path and enter no other information, you get back
all of the users in that path.

8. Click the Search button.
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9. The search returns any users that match the criteria entered.

10. Click the check box next to the user to be added.

11. Click the Save button (

)

12. The user is now added to Ektron CMS400.NET and added to
the Everyone group. To learn about how to assign this user to
a specific group, see ”Assigning Users To User Groups” on
page 723.

Steps to Manually Add an LDAP User
The following steps explain how to add an LDAP user manually.
1. Enable LDAP by following the instructions in ”Enabling LDAP”
on page 852.
2. From the left side of the Workarea, click Users.
3. Click the Add Users button (

).
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4. The Add a New User to the System screen appears.

5. Fill out the fields according to the table below.
Field

Description

Username

The username of the person logging in, as found on the LDAP
server.

Path

The path on the LDAP server to the user. For example:
ou=Amherst,ou=New Hampshire,o=US,dc=local

First Name

The first name of the user.

Last Name

The last name of the user.

Display Name

The name of the user that is displayed in the Forums when using
Discussion Boards feature. See Also: ”Discussion Boards” on
page 465
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Field

Description

User Language

Select the language in which the user will view Ektron CMS400.NET
screens and messages. The language also determines the default
value whenever a drop-down list of languages appears within Ektron
CMS400.NET.
The dropdown list of choices at this field is derived from the
Language Settings screen, available from the Settings >
Configuration folder.
Do not confuse the system language with the user’s ability to create
and edit foreign editions of content. This field does not prevent a
user from working with multiple language content.
See Also: ”Multi-Language Support” on page 868
Note: If the selected language is not English, French or German, it is
only supported after you download the Ektron CMS400.NET
Language Support Program from Ektron and translate the Web site.

E-Mail Address

Enter the email address of the user.

Forum Editor

If you are using Discussion Boards feature, specify which editor this
user uses when editing in the Forums. Choose from eWebEditPro or
the eWebEdit400 Editor. For information on Discussion Boards, see
”Discussion Boards” on page 465

Disable Email

Select to disable email notifications for this user. If you do, the user
will not receive the automatic email notification described in
”Automatic eMail Notification” on page 1066. However, this field has
no effect on the user’s ability to receive instant email.

Notification

6. Click Save (

) to add LDAP users to Ektron CMS400.NET.

7. The View Users in Group Everyone screen appears, displaying
the new user and the other Ektron CMS400.NET users. To
learn about how to assign this user to a specific group, see
”Assigning Users To User Groups” on page 723.

Using the Browse Feature to Add an LDAP User
The Browse LDAP feature provides a more friendly and intuitive
way to find the username, domain/organization and organizational
unit(s).
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IMPORTANT

The default server IP/DNS name and port are taken from the settings specified in
the Configuration > Setup page. These settings must be specified before
connecting to the LDAP server. See Also: ”Enabling LDAP” on page 852

IMPORTANT

An Organizational Unit that can see the user to be added must be specified in the
Configuration > Setup page before using the browse feature. See Also:
”Enabling LDAP” on page 852

1. Enable LDAP by following the instructions in ”Enabling LDAP”
on page 852.
2. From the left side of the Workarea, click Users.
3. Click the Add Users button (

).

4. The Add a New User to the System screen appears.

5. Click the Browse LDAP button (
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6. The LDAP Explorer appears.

7. Navigate the LDAP server’s folders by clicking on the folder
images. Each folder represents an Organizational Unit (OU).
When you choose an OU level, its users appear.
NOTE

In the LDAP Explorer, the Path and Org/Domain fields update dynamically as you
navigate through the LDAP tree.

8. Select a user.
9. The user is now added to Ektron CMS400.NET and added to
the Everyone group. To learn about how to assign this user to
a specific group, see ”Assigning Users To User Groups” on
page 723.

Editing User Information in Ektron CMS400.NET
It is important to note that Ektron CMS400.NET does not write to the
LDAP server. So, while you can change any fields when editing a
user in Ektron CMS400.NET, you also need to make these
changes in the LDAP server.

Steps to Edit an LDAP User’s Information
The following steps explain how to edit an LDAP user’s
information.
1. In the Workarea, click Settings > Users.
2. In the Username column, click a user to edit.
3. The View User Information screen appears.
4. Click the Edit button (

).
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5. Change the information as needed. For more information on
the fields you can edit, see ”Fill out the fields according to the
table below.” on page 859.
6. Click Save (

).

Deleting Users
If a user is deleted in an LDAP server, Ektron CMS400.NET does
not automatically delete the user. However, the user’s login fails
because he cannot be authenticated.
In this case, you should delete the user from Ektron CMS400.NET
using the Delete User function. See Also: ”Deleting a User” on
page 722
NOTE

If you mistakenly delete all users with administrative privileges, you can still sign
in using the builtin user’s username and password. For more information, see
”BuiltIn User” on page 30.

LDAP Screen Descriptions
The LDAP feature uses the following screens:
•

”The Active Directory Setup Screen” on page 863

•

”The View Users Screen” on page 864

This section explains how to use each screen.

The Active Directory Setup Screen
The Active Directory Setup screen (illustrated below) lets you
enable and disable the Active Directory or LDAP features, as well
as determine other aspects of AD management, such as whether
users and groups are automatically updated. To access the screen,
click Configuration -> Active Directory -> Setup from the left
panel of the Workarea.
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For a description of the fields, see the Active Directory section
”The Active Directory Setup Screen” on page 818.

The View Users Screen
The View Users screen (illustrated below) lists all users in the
Ektron CMS400.NET database. To access the screen, click Users
from the left panel of the Workarea. To view more information for a
user, click that user to move to the View User Information screen.
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The View Users screen also provides a toolbar button ( ) that
lets you add LDAP users manually to the Ektron CMS400.NET
database. This is useful if you want to add a single user from an
Organization that is does not have the same Organizational Unit as
the rest of your users, and you do not want to add any other users
from that Organization.
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The View User Information Screen

The View User Information Screen displays the user’s
•

username

•

Path

•

first and last name

•

language

•

email address and whether the user receives email
notifications

•

whether the account is locked

•

which Forum Editor the user is using

•

user groups

•

user properties (if any)
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The screen also displays the following buttons.
Button

Description
Edit information on screen

Delete user
See Also: ”Deleting Users” on page 863
Return to previous screen

Launches a help screen

Disabling LDAP Authentication
If you decide to disable LDAP authentication or integration, edit the
Active Directory Setup screen and select Disable Active
Directory and LDAP Authentication.
See Also: ”The Active Directory Setup Screen” on page 863
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There are several aspects to translating within Ektron
CMS400.NET. They are listed below.
Type of Translation

Seen by

For more information, see

Content

Content contributors; visitors to
your site

”Working with Multi-Language
Content” on page 868

Spell check dictionary

Visitors to your site

”Set the Language of Spell
Checking” on page 906

Special Character Encoding

Visitors to your site

”Character Encoding” on
page 920

Workarea screen labels, alt text,
system messages

Content contributors

”Translating the Workarea” on
page 921

Working with Multi-Language Content
Ektron CMS400.NET supports the creation of content in any

language supported by the Unicode standard. This section
explains how to create and work with content in any language.

Overview
First, determine the languages in which your site’s content should
appear (see ”Determining Which Languages are Available” on
page 872). Then, for any content, you can provide editions in each
supported language.
To provide multi-language content, you can either create new
content or copy and edit existing content. For example, you can
begin the creation of German content by copying English content
into it, then translating that content into German and deleting the
English content.
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All editions of content have the same ID number but are
differentiated by the language attribute. As a result, your Web page
template can link to a single content item, but what is displayed is
determined by the selected language. There are two ways that
content’s language can be selected:

NOTE

•

a language cookie, which is created when a visitor enters your
site and selects a language

•

the link to another page includes the language (langType)
parameter. For example, mytemplate.aspx?LangType=1033.

For a list of the decimal values for each supported language, see Ektron
CMS400.NET Workarea > Settings > Configuration > Language Settings.

The View Contents of Folder screen’s View field lets you choose a
language then view and create content in that language. You can
also view all content in the folder, regardless of language. This field
makes to easy to find and work on content editions in a selected
language.
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The View Contents of Folder screen also displays the language of
each content item. This helps you distinguish them when viewing
all content.
Finally, you can set up a separate approval chain for each edition
of a content, and can assign collections and tasks in any supported
language.
This section describes how to work with a multiple language Web
site through the following topics.
•

”Enabling/Disabling Support for Multiple Language Content” on
page 870

•

”Viewing Your Site in Another Language” on page 870

•

”Determining Which Languages are Available” on page 872

•

”The Default Language” on page 874

•

”Creating New Content” on page 875

•

”Translating Content” on page 876

•

”Additional Multi-Language Topics” on page 895

•

”Setting Up a Multilingual Web Site” on page 897

•

”Using a Language Other than American English as the
Default” on page 901

•

”Resolving Conversion Issues” on page 902

Enabling/Disabling Support for Multiple Language Content
Support for multi-language content is enabled in the web.config
file. To enable or disable it, follow these steps.
1. Open the file webroot\yourwebsite\web.config.
2. To enable multi-language content, set the value of
ek_EnableMultilingual to 1. To disable it, set it to zero (0).
3. Save and close web.config.

Viewing Your Site in Another Language
It’s easy for your site visitors to view your site in any enabled
language. On any screen, your developer can display a language
drop-down list (circled in red below).
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(For more information about the LanguageSelect Server Control
which displays this drop-down list, see the Ektron CMS400.NET
Developer’s Manual.) On the sample site provided with Ektron
CMS400.NET, this drop-down list appears in the lower left corner of
the home page, but your developer can place it anywhere on any
page.
Another way to indicate which language-edition of content to
display is by adding the language parameter (langType) to the
Quicklink. For example, products.aspx?LangType=1033 displays the
English (US) edition of the products.aspx content. This syntax
automatically sets the language cookie.

NOTE

For a list of the decimal values for each supported language, see Ektron
CMS400.NET Workarea > Settings > Configuration > Language Settings.

See Also: ”What Happens if Chosen Language is Not Available” on
page 871

What Happens if Chosen Language is Not Available
A visitor to your site uses one of the methods listed above to select
a language. Ektron CMS400.NET uses the following criteria to
determine which language edition to display for content.
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1. If an edition of the content is available in the selected
language, display that.
2. If option 1 is not available, display an edition of the content in
the default language (defined in the
ek_DefaultContentLanguage variable in web.config).
NOTE

When Ektron CMS400.NET is installed, the default language is English.See
Also: ”The Default Language” on page 874

3. If neither edition is available, display nothing.

Determining Which Languages are Available
To determine which languages are available for creating content,
go to the Workarea and click Settings > Configuration >
Language Settings. The Language Settings screen lists all
languages in which content can be created on your site.
NOTE

Only members of the Administrator User Group can view, add, or edit language
settings.

To change the list, follow these steps.
1. Click the Edit button (

).

2. The Edit Language Setting screen appears.
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3. Each language has two check boxes. They are described
below.
•

To enable a language in the Workarea only, click (
). If this
column is checked, the language populates the language dropdown lists within Ektron CMS400.NET, as shown below.

•

To enable a language in the Workarea and let site visitors
).
select it when viewing the site, click (

So, you can enable languages in the
column when you are
translating the site but are not ready to make those content items
publicly available. When you complete the translation, check the
column.
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NOTE

NOTE

If you select
, the check box in the
column is checked automatically.
This is because, if you let users view the language on the site, it must be enabled
in the Workarea.
The default content language on a dropdown list is determined in the
ek_DefaultContentLanguage element of the web.config file.

If you choose only one language on the Language Settings screen,
fields that prompt the user to select a language do not appear in
Ektron CMS400.NET. Instead, all content is created in that
language.

The Default Language
The default language determines which edition of content to
display when a visitor to your site does not select a language.
It is also used if a visitor selects a language other than the default,
then navigates to page for which content does not exist in the
selected language. In that case, Ektron CMS400.NET displays that
content in the default language (if available).
Within Ektron CMS400.NET, the default language determines the
default value on the language drop-down lists that appear on every
page on which a user can select a language.
When you install Ektron CMS400.NET, the default language is
English.
Use the following procedure to change the default language for
your multi-language Web site.
1. Open webroot\yourwebsite\web.config.
2. Set the value of ek_DefaultContentLanguage to the locale id of the
default language. For example, 1031 for German.
NOTE

For a list of locale ids, see Ektron CMS400.NET Workarea > Settings >
Configuration > Language Settings.

3. Save and close web.config.
See Also: ”Using a Language Other than American English as the
Default” on page 901
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Disabling a Language
To disable any language, uncheck the accompanying checkbox on
the Edit Language Setting screen. (For more information, see
”Determining Which Languages are Available” on page 872.)
If you want to disable the default language, you must first assign a
new default language. See Also: ”The Default Language” on
page 874 explains what a default language is and how to assign
one.

What Happens to Content When You Disable Its Language
If you disable a language for which content exists, that content
remains in the database but no one can access it, either from
within Ektron CMS400.NET or when visiting your site.
If you later enable that language, the content is once again
available.

Creating New Content
To create content in a non-English language, follow these steps.
1. Navigate to the content folder in which you want to create the
content. (You must have permission to add content to the
folder.)
2. From the language drop-down list, select the language in which
you want to create the content.
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.

If the desired language is not available, see ”Determining
Which Languages are Available” on page 872.
3. Click the Add Content button (
you would any content.

) and create the content as

4. In order to add metadata to a content, metadata specifications
must have been created for the selected language.See Also:
”Metadata” on page 118

Translating Content
When translating content into a foreign language, you have three
options.
Option

For more information, see

Copy original content into a new content item in a
new language. Then, translate content manually.

”Translating Content Manually” on
page 877
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Option

For more information, see

Use the computer-based translation tool provided
with Ektron CMS400.NET.

”Using Machine Translation” on
page 879

Create an XLIFF or XHTML file from existing
content. The file is sent to a translation agency
and returns translated to the new language(s).
Then, import the translated files into Ek tr on
C MS 4 00 .NE T .

”Using the Language Export Feature” on
page 882

Translating Content Manually
Use this procedure when you want to initialize new foreign
language content with content from a source language, then
translate the content manually. This copying should facilitate the
translation.
For example, an editor is translating content from French to
German. The editor copies the French edition to new content
whose language is German. As the editor translates the French
edition into German, he deletes the French content. Any images in
the content would usually remain, and all formatting (tables,
bullets, etc.) is retained.
After signing in to Ektron CMS400.NET, you copy content into new
content of a different language by either
•

navigating the Web site, or

•

accessing the Workarea and navigating the folder structure

After copying the original content, translate it into the new
language then delete the original text. Both procedures are
described below.
Accessing Content via the Web Site
1. Navigate to a page on which you can select the site language.
See Also: ”Viewing Your Site in Another Language” on
page 870
2. Select the language into which you want to translate the
content.
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3. Navigate to content that you want to translate. You must have
privileges to add content to this folder. See Also: ”Setting
Permissions” on page 768
4. Right click within the content’s border and a small menu
appears.
5. Click the Add New Language option (

).

6. The original language content appears. Translate into the new
language then delete the original content.
NOTE

At this point, you can click the Translate Content button (
) to have the software
translate the content. You can then edit it as needed to perfect the translation.

7. In order to add metadata to content, metadata specifications
must have been created for the selected language. See Also:
”Metadata” on page 118
8. When you save the content, it is saved as the edition of that
content in the selected language.

Accessing Content via its Content Folder
To copy content into a new content of a different language, follow
these steps.
1. Go to the View Content screen for the content you want to
translate. Its status must allow editing (it cannot be submitted
or pending).
2. From the View drop-down list, select a original language.
3. Click the content you want to translate.
4. It appears on the View Content screen.
5. Use the Add drop down list in the upper right corner to select
the language into which you want to translate the content.
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6. The original language content appears. Translate into the new
language then delete the original content.
7. In order to add metadata to content, metadata specifications
must have been created for the selected language.See Also:
”Metadata” on page 118
8. When you save the content, it is saved as the edition of that
content in the selected language.

Using Machine Translation
Ektron CMS400.NET includes a machine translation feature, which

can automatically translate content from/to the following
languages.

NOTE

•

Chinese Simplified

•

Chinese Traditional

•

Dutch

•

English

•

French

•

German

•

Greek

•

Italian

•

Japanese

•

Korean

•

Portuguese (Brazilian)

•

Russian

•

Spanish

Currently, machine translation is not supported for all languages in the Language
Settings screen.

Like most software-based translation, someone fluent in the new
language should review the translated content to verify that the
translation is appropriate within the context of the page.
The machine translation feature lets you choose a glossary (that is,
a field, industry, or subject area). This helps the software find the
best translation for a term or phrase with different meanings in
different fields.
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To use the machine translation feature, follow these steps.
Accessing Content via the Web Site
1. Navigate to a page on which you select the site language. See
Also: ”Viewing Your Site in Another Language” on page 870
2. Select the language into which you want to translate. If you do
not see the language on the language selector dropdown, you
need to enable the language. See Also: ”Determining Which
Languages are Available” on page 872
3. Navigate to content you want to translate.
NOTE

You must have privileges to add content to the folder.See Also: ”Setting
Permissions for a Content Folder” on page 772

4. Right click within the content’s border. A menu appears.
5. Click the Add Content button (

).

6. The original language content appears.
7. If the screen uses a Smart Form, select the text that you want
to translate.
NOTE

You cannot use Machine Translation to translate field names in a Smart Form.
XLIFF files are a good way to translate XML field names.See Also: ”Using the
Language Export Feature” on page 882

8. Click the Translate Content button (

).

9. The Translation screen appears.

10. Select the source (old) and target (new) languages.
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11. If the content should refer to a specific glossary, select one
from the dropdown list.
12. Click the Translate button.
13. The translation appears. If it looks OK, press Paste Content.
14. The translated content replaces the original content in the
editor. Modify as needed.
15. In order to add metadata to content, metadata specifications
must have been created for the selected language.See Also:
”Metadata” on page 118
16. When you save the content, it is saved as the edition of that
content in the selected language.

Accessing Content via its Content Folder
To machine translate content by identifying its content folder, follow
these steps.
1. In the Workarea, navigate to the content folder that contains
the content you want to edit.
2. Click View > Language and select an original language (that
is, the language from which it will be translated).
3. Click the content you want to translate. Its status must allow
editing (that is, its status cannot be submitted or pending).
4. It appears on the View Content screen.
5. Use the Add dropdown list in the upper right corner to select a
new language for the content.
If you do not see the language on the dropdown, you need to
enable the language. See Also: ”Determining Which
Languages are Available” on page 872

6. The original language content appears. Edit the title if
appropriate.
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7. Click the Translate Content button (

).

8. The Translation screen appears.

9. Select the source (old) and target (new) languages.
10. If the content should refer to a specific glossary, select one
from the dropdown list.
11. Click the Translate button.
12. The translation appears. If it looks OK, press Paste Content.
13. The translated content replaces the original content in the
editor. Modify as needed.
14. In order to add metadata to content, metadata specifications
must have been created for the selected language.See Also:
”Metadata” on page 118
15. When you save the content, it is saved as the edition of that
content in the selected language.
NOTE

When the View Contents of Folders screen reappears, it is probably set to the
source language. In this case, you do not see the new content in the target
language. To see it, click View > Language and select All or the target language.

Using the Language Export Feature
The Language Export feature lets you copy content into XLIFF files
that can be submitted to a translation agency. The agency
translates the files and returns them. In the final stage, you import
the translated content back into Ektron CMS400.NET.
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The Language Export feature lets you translate the following kinds
of CMS information.
•

content, including summary, comments, and meta data

•

forms, including response message, comments, and meta data

•

all menus (you cannot choose individual menus)

•

file assets (files managed by the DMS, including Office
documents, Open Office documents, managed files, etc.)

•

taxonomies

The Language Export Feature is explained through the following
topics.
•

”What is XLIFF?” on page 883

•

”Overview of Exporting/Importing Translation Files” on
page 884

•

”Creating the .zip File” on page 885

•

”Importing Translated Files into Ektron CMS400.NET” on
page 889

•

”Applying Translated Metadata to Translated Content” on
page 892

What is XLIFF?
XLIFF (XML Localization Interchange File Format) is a format
that's used to exchange localization data between participants in a
translation project. This special format enables translators to
concentrate on the text to be translated, without worrying about
text layout. The XLIFF standard is supported by a large group of
localization service providers and localization tools providers.
To learn more about XLIFF, visit these Web sites:
•

http://www-106.ibm.com/developerworks/xml/library/x-localis/

•

http://www-106.ibm.com/developerworks/xml/library/x-localis2/

•

http://www.xliff.org/
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Supported Versions of XLIFF
Ektron CMS400.NET supports the following versions of the XLIFF

standard: 1.0, 1.1, and 1.2. You specify the version you are
exporting in the web.config file, using the ek_XliffVersion element.
Any version listed above can be imported.
SDL Trados Studio 2009

Trados is a commonly used translation tool.
SDL Trados Studio 2009 supports XLIFF 1.1 and 1.2, which are
the recommended versions for use with Ektron CMS.
If you are using Trados (an earlier version of the product), it only
supports XLIFF 1.0. Note that CMS 400 6.1.4 and older default to
XLIFF 1.1, you need to change the XLIFF version in the web.config
file as described in ”Supported Versions of XLIFF” on page 884.

Overview of Exporting/Importing Translation Files
1. You select content to translate. You can select:
•a content item
•a folder (all content in the selected folder is selected; all
subfolders of the selected folder may be included)
•all menus
•one or more taxonomies
2. Ektron CMS400.NET converts the selected content to XLIFF
files. You can prepare the files for translation into several
languages at once.
A separate .xlf file is created for each item. Then, all .xlf files for
a language are compressed into one .zip file. A separate .zip
file is created for each language.
3. Transmit the.zip files to a translation agency, which converts
them into the new language(s).
4. The translation agency returns the files.
5. Import them into Ektron CMS400.NET. If the editions of the
content do not exist in the target language, they are created.
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Creating the .zip File
To create one or more .zip files for translation, follow these steps.
Note

Only members of the Administrator User Group and those defined in the Manage
Members for Role: XLIFF-Admin screen can create or import XLIFF files. See
Also: ”Using the Roles Screens” on page 788.

1. To translate one content item, navigate to its folder then click it.
To translate all content in a folder (and, if desired, all of its
subfolders), navigate to its View Contents of Folder screen.
To translate a menu, go to Modules > Menus.
To translate a taxonomy, go to Modules > Taxonomy and
check the taxonomies to translate.
2. Click the Export for Translation button (
). (On the View
Contents of Folder Screen, click Action > Export for
Translation.)
3. The Export for Translation screen appears.

NOTE

The Include Subfolders field only appears if you click the Export for Translation
button from the View Contents of Folder screen.
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4. If you want to include content in all of the selected folder’s
subfolders, check Include Subfolders. To translate just the
selected folder, uncheck it.
5. The language of items being translated appears in the Source
Language pull-down. If this is not the correct source language,
click the down arrow and select the correct one.
6. All languages enabled in the Language Settings screen are
selected under Target Language(s). (See Also: ”Determining
Which Languages are Available” on page 872).
7. To translate the content into all languages, proceed to the next
step.
To translate the content into some languages, uncheck the
languages that you do not want. You can uncheck the box in
the header row (illustrated below) to uncheck all, then only
check the ones you want.

8. Click the Create XLIFF Files for Translation button (

).

9. Ektron CMS400.NET creates one .zip file for each language.
The .zip file includes an XLIFF file for each selected content
item.
NOTE

If any selected folder contains content in a target language whose edit date is
more recent than the source language edition, that content is excluded from the
.zip file. Ektron CMS400.NET assumes that, since a more recent target-language
edition exists, you do not want to translate the corresponding source language
edition.

The History section of the Export for Translation screen
displays the translated files.
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The history lists the .zip file created for each language. (.zip
files are indicated by the WinZip icon (
icon are

).) To the right of the

•the flag of the source language
•an arrow indicating the direction of the translation
•the flag and name of the destination language
•the size of the zip file
NOTE

The top of the history window displays the most recently exported/imported files.

10. If you want to review the items in a zip file, click the plus button
next to Extracted. When you do, each content item’s ID
number, title, and last edit date appear.
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11. Click the blue text of a .zip file. The File Download window
appears.

NOTE

If you want to review the XLIFF files within the .zip file, click Open.

12. Click the Save button. The Save As window appears. Navigate
to the folder where you want to place the zip file and click
Save.
13. Transmit the files to the translation agency.
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NOTE

When XLIFF files are returned by the translation agency, their extension must be
.xlf. Other than that, the file name is not important.

File Naming Patterns

File
Type

Pattern

XLIFF

item identifier[item ID]_[new language hexadecimal code][two letter new language code].xlf
•

item identifier options:
- content: cont
- form: form
- menu: s
- menu item: s
- taxonomy: t

•

item ID varies, depending on whether the item is content, a form, a menu, or a menu item
- content: content ID number
- form: form ID number
- Menu: menu ID number
- Menu item: menu ID number

Zip

xlf[timestamp in format yyyymmddThhmmss]_u[user ID] _ [new language hexadecimal code][two letter language code].zip
The user ID indicates which user performed the export or import.

Importing Translated Files into Ektron CMS400.NET
To import translated files into Ektron CMS400.NET, follow these
steps.
Note

Only members of the Administrator User Group and those defined in the Manage
Members for Role: XLIFF-Admin screen can create or import XLIFF files. See
Also: ”Using the Roles Screens” on page 788.

1. Go to Workarea > Modules > Import XLIFF Files.
2. Click the Browse button and navigate to the folder that
contains the translated files.
3. Select the files to import.
4. Click the Upload and Import button (
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5. Ektron CMS400.NET creates new or updates existing foreignlanguage editions of the imported content/menu/taxonomy.
6. Information about the imported file appears in the history area
of the Import XLIFF Files screen. You can click plus signs (+) to
reveal increasing levels of information about the imported
content.

When you import the file, the comment Translated appears next to
it.
For each new edition:
•

If the content title is the same as the source edition, the next
available number is appended to the title to distinguish it from
the source. For example: Henry Williams(1).

•

its status matches the status of the source content. Typically, its
status is checked out. When imported, it can enter the approval
process just like other content.
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•

its history indicates it was checked in at the time the report was
run

•

for content, the following properties are inherited from the
original content:
- status
- Smart Form
- content searchable
- approval method

•

date created and last edit date are captured from when the
content is imported

•

the last user to edit is captured by user who imported the file

After you import the translation files, Ektron CMS400.NET removes
them from the file system.
NOTE

If an error exists in any of the files, the erroneous files are moved into a
subdirectory. The directory is created using a timestamp. For example:
uploadedFiles\localization\merged\xlf20060208T141841_u1\error\.

Viewing Foreign Language Content
1. Navigate to the folder that contains the content.
2. Click View > Language and select the desired language.
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3. Only content in that folder and the selected language appears.
You can perform the same activities with this content as any other
content.

Applying Translated Metadata to Translated Content
Unfortunately, translated metadata is ignored when importing
XLIFF files. This section describes how to have translated
metadata applied to the translated content.
Background Information

Although metadata exists in the XLIFF files, it does not appear in
the content's metadata even if metadata is defined for that
language. This is because metadata definitions have unique IDs
across languages.
NOTE

While a content ID is the same for a corresponding content block in other
languages, the same is not true for metadata.
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As a result, the ID for the source language (for example, English)
metadata is not automatically mapped to metadata for other
languages (for example, Spanish).
To solve this problem, create a mapping between the IDs of
metadata definitions of different languages that are synonymous.
For example, consider the following metadata definitions.

ID

Name

Language

102

Paper form number

en-US

104

Original page count

en-US

106

Número de papel de la forma

es-ES

108

Cuenta de la página original

es-ES

110

Estado de la minoría

es-ES

In this example, IDs 102 and 106 are synonymous as are 104 and
108. Definition 110, however, only exists in Spanish.
The mapping is stored in an XML file. The mapping informs the
XLIFF import process that metadata for ID 102 in English
corresponds to ID 106 in Spanish and likewise with 104 and 108.
Setting up the Process to Apply Translated Metadata to Content

1. Open the folder site root/workarea/xslt/ and look for the file
metadatadefinitions.xml. If it exists, go to step 2. If it does not,
download it from Ektron at http://dev.ektron.com/uploadedFiles/
DevCenter/Support/KB_Articles/XliffMetadata.zip.

The zip file includes modified XSLT files that access the XML
file.
2. Create metadata definitions in the other language(s). Be sure
to use the same data type.
To do this, log in, open the workarea, go to Settings >
Configuration > Metadata Definition.
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3. Make note of the definitions in the original language (for
example, English).
4. Switch to view another language (for example, Spanish) and
add a new definition. Assign it the same data type and other
properties as the original. Make note of the new ID numbers.
Create metadata definitions in all languages you wish to
support. You may add other languages and define more
metadata definitions at any time.
5. Edit workarea/xslt/metadataDefinitions.xml. For each Metadata
Definition, enter a <dd> element within the <dl> element. The
<dd> element has the following form.
<dd title="Name of the metadata definition">
<dfn id="ID" xml:lang="language-country code"/>
<dfn id="ID" xml:lang="language-country code"/>
:
</dd>

For example,
<dl>
<dd title="Paper form number">
<dfn id="102" xml:lang="en-US"/>
<dfn id="106" xml:lang="es-ES"/>
</dd>
<dd title="Original page count">
<dfn id="104" xml:lang="en-US"/>
<dfn id="108" xml:lang="es-ES"/>
</dd>
</dl>

The definition for ID 110 is not included because it applies to only
one language.
Now that you have set up the xml file, the XLIFF import process
accesses the metadataDefinitions.xml file to determine which
definitions in the target language (for example, Spanish)
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correspond to the definitions in the source language (for example,
English).

Additional Multi-Language Topics
•

”Multi-Language Approval Chains” on page 895

•

”Working with Tasks in a Multi-Language System” on page 896

•

”Working with Collections in a Multi-Language System” on
page 896

•

”Working with Calendars in a Multi-Language System” on
page 896

•

”Working with Menus in a Multi-Language System” on
page 896

•

”Creating an External Link to a Page of Foreign Content” on
page 897

Multi-Language Approval Chains
Just as you can create separate editions of content for each
enabled language, you can set up a language-specific approval
chain and method. When determining a folder’s approval chain,
first select a language then select users and groups with authority
to approve content in that folder and that language.
The screen below shows the language selection drop-down list on
the View Approvals screen.

Only users in the language-specific approval chain for a folder can
approve content in that language.
You can also set a language-specific approval method. See Also:
”The Approval Method” on page 784
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Working with Tasks in a Multi-Language System
If you create content then add a task to it, the task can be in any
enabled language. This would be helpful if, for example, you
review English content then want to assign the task of translating it
into another language in that language.
If you create a task then try to assign content to it, you can only
choose from content in the language of the task.

Working with Collections in a Multi-Language System
In a multi-language Ektron CMS400.NET system, you can create a
language-specific edition of each collection. For information about
doing this, see the Ektron CMS400.NET User Manual section
“Working with Collections.”

Working with Calendars in a Multi-Language System
Calendars can be created in any supported language. Once you
enter the calendar and event information in the foreign language,
the calendar display (that is, day and month names) automatically
appears in that language. Also, regional conventions for first-last
days of the week, and date and time formats are maintained.
For more information, see ”Creating a Foreign Language
Calendar” on page 552.

Working with Menus in a Multi-Language System
NOTE

If you are not familiar with the Ektron CMS400.NET’s menus feature, please read
“Menu Feature” on page 704 and the Ektron CMS400.NET User Manual section
“Working with Menus.”

You can create an edition of any menu in every supported
language. When a site visitor selects a language, navigates to a
page that has a menu and clicks the menu link, Ektron
CMS400.NET displays the menu in the selected language if it is
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available. If a menu in that language is not available, nothing
appears.
Before creating or translating a menu, it’s a good idea to create or
translate all content that will be on the menu. In this way, you can
link these content items to the new menu. However, after creating
a menu, you can always add new items to it.
For details about translating menus, see the Ektron CMS400.NET
User Manual section “Working with Menus”, “Managing Menus”,
“Working with Menus in a Multi-Language System.”

Working with Taxonomies in a Multi-Language System
See ”Multi-Language Support for Taxonomies” on page 679

Creating an External Link to a Page of Foreign Content
If another Web site links to a multilingual page on your site, the
URL must include the language ID parameter. For example:
www.ektron.com/web-content-management-solutions.aspx?LangType=1036

Setting Up a Multilingual Web Site
Ektron CMS400.NET supports multilingual content. This section lists

steps to follow when setting up such a site.
See Also: ”Creating Web Pages that Support Several Languages”
on page 899

Step

For details, see

1.

”Enabling/Disabling Support for Multiple Language
Content” on page 870

In web.config, make sure multilingual support is enabled.
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Step

For details, see

2.

”The Default Language” on page 874

Set a default content language, one
that will be used by the majority of
your site’s content.

If you had a previous version of E kt ro n
C MS 4 00 .NE T and selected a default
language on the Database Upgrade
Utility, be sure that default language
matches the one in web.config.
3.

Enable languages your site will
support.

”Determining Which Languages are Available” on
page 872

4.

Add language selection function to
templates.

”Viewing Your Site in Another Language” on page 870

5.

Create a metadata definition for
each supported language.

”Adding a Metadata Definition” on page 129

6.

Create or translate content.

•

”Creating New Content” on page 875

•

”Translating Content” on page 876

7.

Change the language of content not
in the default language.

”Resolving Conversion Issues” on page 902

Note: Only needed if Web site previously
had multilingual content.
8.

Set up approval chains for new
content.

”Multi-Language Approval Chains” on page 895

9.

Set up multilingual collections.

”Working with Collections in a Multi-Language System”
on page 896

10. Set up multilingual menus.

”Working with Menus in a Multi-Language System” on
page 896

11. Modify text on templates.

”Modifying Page Content Based on Language
Selection” on page 899

12. Translate graphics.

”Modifying Images Based on Language Selection” on
page 900
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Creating Web Pages that Support Several Languages
When thinking about setting up your Web site to support content in
multiple languages, consider these three actions.
Action

For more information, see

Create language-specific
content, menus, collections

•

”Translating Content” on page 876

•

”Working with Collections in a Multi-Language System” on page 896

•

”Working with Menus in a Multi-Language System”
on page 896

After you create these items, have the page invoke that
item dynamically. When Ek tron CMS4 00. NE T receives
a request to display an item that includes a language
and item id number, it returns the language-specific
edition. To learn about letting the user select a language
from a Web page, see ”Viewing Your Site in Another
Language” on page 870.
Adjust template content to user
language

”Modifying Page Content Based on Language
Selection” on page 899

Translate text in images

”Modifying Images Based on Language Selection” on
page 900

Modifying Page Content Based on Language Selection
If a template’s text should change according to a user’s language
selection, use a case statement to provide the language-specific
content. A good example of this is the template used on the RC
international sample site (Illustrated below).

Assume you want to create editions of the menu that runs across
the header (Home, Products, etc.) in three languages:
•

English
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•

French

•

German

To do so, follow these steps.
Note

This procedure uses the header.asp file delivered with the RC international
sample site as an example.

1. In the template file, declare each menu option a variable. For
example:
Dim t_search, t_products, t_support, t_news, t_careers, t_calendar, t_home, t_login,
t_site_lang, t_contact, t_copyright, calendar_id

2. Enter case statements that provide the value of each variable
in each language. (1031 is the decimal code for German, 1036
for French.) The following illustrates how to do this for the
search menu option.
Select Case ContentLanguage
Case "1031"
t_search = "Suche"
Case "1036"
t_search = “Recherche"
Case else
t_search = "Search"
End Select

Now, when a user visits a page controlled by this template and
selects French or German as the site language, the page is
refreshed and the translated values appear on the template.

Modifying Images Based on Language Selection
Many Web page templates also include images that require
translation. You can set up templates to invoke images in the userselected language by following these steps.
1. Add to the library each image that should change when the
language changes. For example, if your company’s tag line is
translated into three languages, upload the three images into
the library.
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It‘s a good idea to include the language in the title of the image.
For example, tagline_English, tagline_French.
2. Create a separate content block for each language-specific
image. Each content block must have a unique ID number.
3. Insert the appropriate image into a content block for each
language. For example, insert the tagline_English image into
the English content block.
4. Insert the content blocks into the appropriate templates. For
example, insert the English content block into the English
template.

Using a Language Other than American English as
the Default
Use this procedure if your site supports one language only, and it is
not American English (1033).
To set your site’s default language to something other than
American English, follow these steps.
1. Install a new site. Do not log in at this point.
2. Open your site’s web.config file (located in your site root
folder.) Set ek_EnableMultilingual to zero (0). Set
ek_DefaultContentLanguage to the four digit locale id for the
desired language.
3. Log in to Ektron CMS400.NET.
4. Go to Settings > Configuration > Language Settings.
5. Enable the desired language, and disable all other languages.
6. Go to Settings > Configuration > Setup.
7. Make sure the desired language is the Default Application
Language.
8. Go to Settings > Users > Edit User Information. Set the
User Language to the desired language. Do not leave App
Default as the value.
9. Repeat Step 7 for every Ektron CMS400.NET user.
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Resolving Conversion Issues
IMPORTANT!

This section is only relevant to Web sites that upgrade to Ektron CMS400.NET
Release 4.7 or higher and which, prior to the upgrade, had content in more than
one language. If your site does not meet both criteria, you can ignore this section.

When you upgrade to 4.7 or higher, the Database Upgrade utility
prompts you to select a language. All content in your site is then
assigned that language. (Prior to Release 4.7, content did not have
a language attribute.) If all content is not in the selected language,
you must resolve that discrepancy.
For example, assume for the sake of simplicity that your pre-4.7
Web site had four content items: three English and one French.
During the database upgrade, you select English. Three content
items are assigned the correct language, but the fourth content
item, which should be assigned French, is also assigned English.
You cannot simply change the content’s language assignment.
When resolving the discrepancy, there are two possible scenarios.

Scenario 1
Prior to 4.7, your site had unique content in French (id number 4).
To resolve this, copy the content to a new French edition with the
same id number. Then, delete the English edition.

Before Upgrade

Content id

Language
attribute

Actual
language

1

not available

English

2

not available

English

3

not available

English

4

not available

French
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After Upgrade

Content id

Language
attribute

Actual
language

1

English

English

2

English

English

3

English

English

4

English

French

Content id

Language
attribute

Actual
language

1

English

English

2

English

English

3

English

English

4 (deleted)

English

English

4

French

French

After Following Procedure Listed Below

Procedure for Scenario 1
To change a content item’s language, follow these steps.
NOTE

Before beginning this procedure, make sure
•

the correct language for the content is enabled. See ”Determining Which
Languages are Available” on page 872.

•

metadata has been defined for the new language. See ”Adding a Metadata
Definition” on page 129
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1. Within Ektron CMS400.NET, navigate to the View Content
screen on content item 4.
2. From the Add drop-down list, select French.

3. Ektron CMS400.NET creates a French edition of the content.
4. Check in that edition of the content.
5. Delete the English edition of the content.

Scenario 2
Prior to 4.7, your site had English and French content (id numbers
3 and 4) that presented the same content in each language. You
want to leave the English content alone, create a French edition of
that content with the same id number, then delete the French
content.
The advantage of this solution is that both editions of the content
have a single id number. So, when a site visitor selects a language
and navigates to that page, Ektron CMS400.NET displays the
edition of the content for the selected language.
To resolve this, create a French edition of the English content,
copy the French content, then delete the French content.

Before Upgrade

Content id

Language
attribute

Actual
language

1

not available

English
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2

not available

English

3

not available

English

4

not available

French

Content id

Language
attribute

Actual
language

1

English

English

2

English

English

3

English

English

4

English

French

Content id

Language
attribute

Actual
language

1

English

English

2

English

English

3

English

English

3

French

French

4 (deleted)

na

na

After Upgrade

After Following Procedure Listed Below
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Procedure for Scenario 2
To solve the language conversion issue explained in scenario 2,
follow these steps.
NOTE

Before beginning this procedure, make sure
•

the correct language for the content is enabled. See ”Determining Which
Languages are Available” on page 872.

•

metadata was defined for the new language. See ”Adding a Metadata
Definition” on page 129

1. Within Ektron CMS400.NET, navigate to the View Content
screen of content id 3.
2. From the Add drop-down list, select French.

3. Ektron CMS400.NET creates a French edition of content id 3.
4. Translate the title into French.
5. Delete the English elements of content id 3 (content, summary,
metadata, schedule, and comments).
6. Check in the French edition of content id 3.
7. Copy and paste all relevant elements of the French content (id
4) into the French edition of content id 3 (content, summary,
metadata, schedule, and comments).
8. Delete content id 4.

Set the Language of Spell Checking
Since Ektron CMS400.NET provides two editors, there are two
procedures for doing this.
•

”Setting the Spell Check Language for eWebEditPro+XML” on
page 907
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•

”Setting the Spell Check Language for eWebEdit400” on
page 907

Setting the Spell Check Language for eWebEditPro+XML
To specify which dictionary to reference when checking spelling,
specify a language in Microsoft Word, version 2000 or later. To do
this, open Word and select Tools > Language > Set Language.

Setting the Spell Check Language for eWebEdit400
NOTE

The Ektron CMS400.NET User Manual section “Introduction to eWebEdit400”
> “Checking Spelling” provides basic information about spell checking. Please
read that before reading this section.

eWebEdit400’s spell checker refers to a standard dictionary of the

content’s language. So, for example, if the content is U.S. English,
the U.S. English dictionary is referenced.
The spell checker also references a language-specific custom
dictionary. Words are added to this list when a user stops at a
misspelled word and chooses the Add to Dictionary option.
Both dictionaries reside on the server that hosts Ektron
CMS400.NET.
The spell checker compares each word against both sources. If a
word is in either one, the spell checker moves to the next word. If a
word is missing from both sources, the spell check options shown
below appear, and the user decides what to do.
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The following topics provide more information about eWebEdit400’s
spelling dictionaries and custom word lists.
•

”What Happens if No Dictionary Matches the Content
Language” on page 908

•

”List of Standard Dictionaries” on page 909

•

”Accessing the Spell Check Dictionary Update Screen” on
page 910

•

”Editing eWebEdit400’s Standard Spell Check Dictionaries” on
page 910

•

”Editing eWebEdit400’s Custom Dictionary” on page 919

What Happens if No Dictionary Matches the Content Language
If eWebEdit400 does not have a dictionary that matches the content
language, it proceeds through these steps in the order shown
below.
1. If the language begins with en (for example, en-AU), use the
en-GB dictionary.
If it begins with zh, use zh-CHS.
2. Each language has a default version, indicated by letters
before the dash matching the ones after the dash. For example
fr-FR. If the default version’s dictionary is available, use it.
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3. Use the first dictionary (alphabetically) that begins with the
content language. For example, the content language is es-AR,
but its dictionary does not exist. The first dictionary
alphabetically beginning with es that is available is es-CO, so
use that.
4. If none of the above is available, use en-US.

List of Standard Dictionaries
eWebEdit400 provides the following standard dictionaries.

Code

Language

uk-UA

Afrikaans

ar-AR

Arabic

bg-BG

Bulgarian

cs-CZ

Czech

da-DK

Danish

de-CH

German (Switzerland)]

de-DE

German

en-GB

English (Great Britain)

en-US

English (United States)

es-ES

Spanish

fr-FR

French

he-IL

Hebrew

it-IT

Italian

nl-NL

Dutch

nn-NO

Norwegian (Nynorsk)
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Code

Language

pl-PL

Polish

pt-PT

Portuguese

pt-BR

Portuguese (Brazil)

ru-RU

Russian

sl-SL

Slovenian

sv-SE

Swedish

uk-UA

Ukrainian

Editing eWebEdit400’s Standard Spell Check Dictionaries
The following topics explain how to access a screen for working
with standard dictionaries, and how to update, edit, replace, and
delete individual words as well as entire dictionaries.

NOTE

•

”Accessing the Spell Check Dictionary Update Screen” on
page 910

•

”Adding a Word” on page 911

•

”Deleting a Word” on page 913

There is no option for editing a word. Instead of editing, delete a word then add
the correct version.

•

”Adding a Word List” on page 915

•

”Importing a Dictionary” on page 917

•

”Deleting a Dictionary” on page 918

•

”Replacing a Dictionary” on page 919

Accessing the Spell Check Dictionary Update Screen
eWebEdit400 provides a special screen that allows you to create,
update, and delete the standard dictionaries. To access this
screen, use this URL:
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http://your server/site root folder/workarea/contentdesigner/
dictionaryconfigurator/dictionaryconfigurator.aspx

This screen looks like this.

NOTE

If you want to remove the red text from the top of the screen, open the .aspx file
and delete that text.

In order to use this screen. the ASP.NET user must be granted
read and write permission to the following folder: your server\site
root folder\Workarea\Foundation\RadControls\Spell\TDF.
TIP!

If ASP.NET user has full permission but you still cannot edit a dictionary, open the
folder listed above, right click the TDF file and verify it is not read-only.

Adding a Word
To add a word to any dictionary, follow these steps.
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1. Open the Dictionary Update screen. See ”Accessing the Spell
Check Dictionary Update Screen” on page 910.
2. Click Edit Dictionary.
3. At the Select Dictionary dropdown, choose the language of
the dictionary you want to update. (”List of Standard
Dictionaries” on page 909 describes the codes on the list.)

4. In the Add a word field in the lower right corner of the screen,
enter the word to add.
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5. Click the Add button.
TIP!

Enter the word you just added into the Find Word field and click Find to verify
that the word was successfully added.

Deleting a Word
To delete a word from any dictionary, follow these steps.
1. Open the Dictionary Update screen. See ”Accessing the Spell
Check Dictionary Update Screen” on page 910.
2. Click Edit Dictionary.
3. At the Select Dictionary dropdown, choose the language of
the dictionary you want to update. (The ”List of Standard
Dictionaries” on page 909 describes the codes on the list.)
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4. In the Find word field in the top left of the screen, enter the
word to delete.
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5. Click the Find button.
6. In the results box below, click the word.
7. Click the Delete Selected button.
TIP!

Enter the deleted word into the Find Word field and click Find to verify that the
word was successfully removed.

Adding a Word List
You may add a list of words to a standard dictionary. For example,
you work in a hospital and want to add medical terms. While you
can add words one at a time using ”Adding a Word” on page 911, it
is more efficient to place all words in a text file then import the file
into a dictionary.
To add a list of words, follow these steps.
1. On your server, create a .txt file.
2. Place all words into the .txt file, one on each line.
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3. Save the file using the language code of the dictionary you are
updating. For example, if you are adding to the French
dictionary, name the file fr-fr.txt. See Also: ”List of Standard
Dictionaries” on page 909
4. Open the Dictionary Configurator screen. See ”Accessing the
Spell Check Dictionary Update Screen” on page 910.
5. Click Edit Dictionary.
6. Next to Import Wordlist, click Browse.

7. Navigate to the text file you saved in Step 3.
8. Click the Import button.
9. All words on the list are added to the dictionary whose name
matches the .txt file. For example, words in the fr-fr.txt file are
added to the fr-FR.TDF dictionary file.
TIP!

While on the screen, enter one of the words in the word list into the Find word
field, then click Find to verify that the import succeeded.
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Importing a Dictionary
Typically, you want to import a dictionary because the language of
some Ektron CMS400.NET content is not on the ”List of Standard
Dictionaries” on page 909. For example, your content is Japanese.
You could also delete a standard dictionary then import one to
replace it if you have a word list that you consider superior to the
standard dictionary. See Also: ”Deleting a Dictionary” on
page 918.
To import a dictionary, follow these steps.
NOTE

The following procedure assumes the words do not yet exist in a .TDF file. If they
do, open the Dictionary Configurator screen, click the Browse button, select the
file, and click Import.

Part one: Create a Blank TDF File
1. On your server, use Notepad to create a blank .tdf file named
after the language code of the dictionary you are importing. For
example, if you are importing a French dictionary, name the file
fr-fr.tdf. See Also: ”List of Standard Dictionaries” on page 909
2. Open the Dictionary Configurator screen. See ”Accessing the
Spell Check Dictionary Update Screen” on page 910.
3. Next to the Pick a file to import field, click Browse.
4. Navigate to the .tdf file you created in Step 1.
5. Click the Import button. This action places the TDF file into the
correct folder.
Part two: Create and Import the Word List
1. Follow the procedure described in ”Adding a Word List” on
page 915 to insert all dictionary words into a .txt file.
2. Click Edit Dictionary.
3. Next to Import Wordlist, click Browse.
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4. Select the text file you created in Step 1.
5. Click the Import button.
6. All words in the list are added to the dictionary whose name
matches the .txt file name.
TIP!

Use the Edit dictionary screen to select the dictionary. Then, use the Find word
field to verify that the import succeeded.

Deleting a Dictionary
You would typically delete a standard dictionary in order to replace
it if you have a word list that you consider superior to the standard
dictionary.
To delete dictionary, follow these steps.
1. Open the Dictionary Configurator screen. See ”Accessing the
Spell Check Dictionary Update Screen” on page 910.
2. In the available dictionaries list, find the language whose
dictionary you want to import.
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3. To the right of the language, click Delete.

Replacing a Dictionary
You would typically want to replace a standard dictionary if you
have a word list that you consider superior to the one provided.
The procedure for replacing a dictionary is documented in
”Importing a Dictionary” on page 917.

Editing eWebEdit400’s Custom Dictionary
A language’s custom dictionary is created the first time a user uses
the Add to Dictionary option while spell checking content in that
language.
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From then on, the dictionary is updated when anyone using that
server edits content in that language and uses the Add to
Dictionary option.

How the Custom Dictionary is Named
The name of the custom dictionary is formed by stringing together
•

the language code of the content

•

a dash (-)

•

the word custom

•

the file extension .txt

So, if the content is French, the file’s name is fr-fr-custom.txt. The
file is saved to the root/Workarea/Foundation/RadControls/Spell/TDF
folder.

Editing the Custom Dictionary
Edit the custom dictionary using any application that updates .txt
files, such as Notepad.

Character Encoding
The following Ektron Knowledge Base articles describe issues
surrounding the display of special characters within Ektron
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CMS400.NET. Note that these articles refer to eWebEditPro,
Ektron’s WYSIWYG editor embedded within Ektron CMS400.NET.

Wherever these articles contain references to eWebEditPro’s
configuration data or file (config.xml), you should instead update
the web.config file, located in your site’s root folder.
•

HOWTO: produce UTF-8 (www.ektron.com/developers/
ewebeditpro_tutorials.cfm?id=403)

•

INFO: Character Encoding (www.ektron.com/developers/
ewebeditprokb.cfm?id=1807)

•

INFO: Encoding special characters (www.ektron.com/
developers/ewebeditprokb.cfm?id=384)

Translating the Workarea
When Ektron CMS400.NET is delivered, the Workarea is in English.
If you want to translate it to another language, read this section.
NOTE

Ektron provides American English strings in a text file. You must translate them.

Prerequisites
•

The alphabetical, four-character identifier of the country/
language into which you are translating. See CultureInfo Class
from the MSDN Web site (http://msdn2.microsoft.com/en-us/
library/system.globalization.cultureinfo(vs.71).aspx).

•

The server that hosts Ektron CMS400.NET must have Visual
Studio.NET

Procedure for Translating Workarea Strings
All Workarea text (that is, screen titles, Workarea menus,
messages, alt text for buttons, etc.) is stored in a resource file.
Resource files are installed to the siteroot\Workarea\resources
directory.
NOTE

Workarea images that include text are stored in the workarea/images/language
folder. For example, Workarea\images\french_standard.
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Ektron CMS400.NET provides a resource files for the following

languages. The English resource file is complete. The others are
partially complete.
•

German

•

English (United States)

•

Spanish

•

French

•

Italian

•

Dutch - Netherlands

•

Dutch - Belgium

Regardless of the list above, to translate your Workarea, translate
the English file into the desired language.

Procedure Overview
A resource file is not human-readable. To make it so, use
Microsoft’s resgen utility. Next, translate the human-readable, .txt
version of the file. Here is a portion of it.
add menu title=Add Menu
lbl ad serverip=Domain Controller IP
alt: remove collection items text=Click here to remove items from
this collection

Notice that, for each string in the file, an English description
appears first. The description includes information about where the
text appears. For example, btn text appears on a button. Next is an
equal sign (=), then English text.
Translate the text to the right of the equal sign. You can send the
file to an agency or do it yourself.
Then, run the resgen utility on the .txt file again, indicating the
translate-to language. This converts the file back to a machinereadable format. Finally, move that file to the appropriate language
folder under workarea/images, and enable the new language in the
Workarea.
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Step by Step Instructions
To perform this procedure, follow these steps.
1. The resgen.exe utility is located in C:\Program Files\Microsoft
Visual Studio 8\SDK\v2.0\Bin. Copy it to the your web
site\Workarea\resources folder.
2. Go to Windows Start button > Microsoft Visual Studio 2005
> Visual Studio Tools > Visual Studio 2005 Command
Prompt to open a command window.

3. Within the command window, change the directory to the your
web site\Workarea\resources folder. For example, cd
C:\Inetpub\wwwroot\CMS400Min\Workarea\resources.
4. Insert the following text: resgen

EKResource.en-US.resources

anyfilename.txt

NOTE

You can assign any name to the .txt file.

5. A .txt file of resource strings converted to a human-readable
format is created in the resources directory. (You assigned its
name in Step 4.) Open the file.
6. Replace any single backslash (\) with a double backslash (\\).
7. Translate the text following every equal sign (=). Be careful not
to change any occurrences of n surrounded by double
backslashes (\\n\\).
NOTE

You can send the file to a translation house or translate the strings yourself.

8. Save and close the .txt file.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

923

Multi-Language Support

9. Open the command window (as described in Step 2) and insert
the following: resgen anyfilename.txt EKResource.two-character
country code-two-character language code.resources

Replace anyfilename.txt with the file you named in Step 4. In
this example, the .txt file is named span_translation.txt.
For example, to indicate that the Workarea is being translated
into the Spanish/Spain, enter resgen.exe span_translation.txt
EKResource.es-ES.resources.

When the conversion is complete, Writing Resource File
...Done appears in the command window.
10. The Workarea\resources folder includes several resource files. If
one exists for the translate-to language, it is overwritten. If one
does not exist, it is created.
To follow our example, the EkResource.es-ES.resources file was
updated with changes you made in Step 7.
11. Move the updated resource file to the appropriate language
folder under Workarea/images. To continue our example, move
the file to the Workarea/images/spanish_traditional_Sort folder.
If a folder does not exist for the new language, create one
under Workarea/images.
12. Enable the new language in the Language Settings screen.
See ”Determining Which Languages are Available” on
page 872
13. Make the new language the default language in the
Configuration Setup screen. See ”Default Application
Language” on page 24.
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Mapping Feature

The Mapping feature displays a map that flags locations of interest
to your site visitors. Using Ektron’s GeoMapping functionality,
content can be tagged with longitude and latitude coordinates to
leverage Bing Maps for Enterprise and Google Maps.
Each location is a CMS content item to which map information was
added. For example, if your site hosts a school district, each map
location could represent one school in the district.
For information on installing and using the Mapping Feature, see
the Ektron CMS400.NET Developer Manual section “Introduction to
Ektron CMS400.NET Server Controls” > “Map Server Control.”
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Content Analytics Feature

The Content Analytics feature lets you track statistics about visits
to your Web site. You can use it to determine the following kinds of
information:
•

how often your content was viewed

•

how many site visitors viewed for first time, and how many
returned

•

the most popular referral pages (that is, the Web page from
which visitors clicked to arrive on your site)

Several options for selecting a date range let you compare activity
across different weeks, months, and years.
This section explains the Content Analytics feature through the
following subtopics.
•

”Enabling the Content Analytics Feature” on page 926

•

”Determining Which Templates are Tracked” on page 927

•

”Specifying the Frequency of Writing to the Database” on
page 929

•

”The Statistical Data” on page 929

•

”Writing to the IIS Log” on page 931

•

”Content Analytics Reporting” on page 931

•

”Changing the Date Range of the Statistical Data” on page 937

Enabling the Content Analytics Feature
By default, the Content Analytics feature is enabled in the
web.config file, under the <analyticsSettings> tag. To disable it, set
the value of the enableAnalytics property to false.
<analyticsSettings>
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<!-- globally enables or disabled all visitor tracking -->
<add key="enableAnalytics" value="true" />

If this property is set to true, and you later change it to false,
statistical data remains within Ektron CMS400.NET, but no
additional data is collected.

Determining Which Templates are Tracked
Analytic data is tracked for every template that has a Content
Analytics server control.
NOTE

Ektron CMS400.NET can only track template views if the viewer’s browser’s
cookies are enabled.

Inserting a Content Analytics Server Control
For details about dropping this server control onto a template, see
the Ektron CMS400.NET Developer Manual section “Content
Analytics Server Control.”
Best Practice
Drop the control onto an area that does not disrupt the template layout,
such as the bottom.

Tracking Templates vs. Individual Content Items
To track visitor activity to a template (for example,
customerservice.aspx), drop the server control onto it. To track
activity for a content item within that template, set the
DefaultContentID property to the ID of that content.
NOTE

You can only track one content item per template.

Display of Analytic Data on Template
If a user is logged in, each template that has a server control
displays statistics for that template. So, you can immediately see
how many times a template has been viewed, and by how many
visitors (as illustrated below).
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You can get a more detailed breakdown of activity for a template by
viewing the Top Templates statistics. See Also: ”Top Templates”
on page 936
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Specifying the Frequency of Writing to the
Database
Once you set up the Content Analytics feature, your database is
subject to a continuous barrage of write activity, generated by visits
to your site.
To mitigate the effect of this activity on your database’s
performance, you can hold visit activity in application server
memory until a predetermined amount of data is collected. When
that amount is collected, it is moved in one packet to the database.
So, the database is “hit” much less frequently.
You can specify the amount of data saved in memory prior to being
written to the database using these web.config file elements.
•

recordsBeforeWrite

•

timeBeforeWrite

- the number of unique template visits

- the number of seconds since the last time a
database write occurred

When either element reaches the value set in web.config, all
records stored in application server memory are written to the
database. That event also resets the value of both elements to
zero (0).

The Statistical Data
For every template view, the following statistical information is
captured:
•

url - the visited page

•

content_id - the ID of the visited content. Only captured if a
content block ID was entered in the server control’s
DefaultContentID property. See Also: ”Tracking Templates vs.
Individual Content Items” on page 927

•

visitor_id - a unique GUID that identifies a visitor

•

hit_date - date and time when a page view occurred

•

referring_url - the URL a user was viewing before jumping to
the visited page
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•

visit_type - zero (0) indicates new visitor, 1 indicates returning
visitor, 2 indicates all other views. See Also: ”Tracking Site
Visitors” on page 930
In a session, the first page hit tracks the visit as zero (0) (if the
user is new) or 1 (if the user previously visited the page). From
then on, 2 is logged.

Tracking Site Visitors
The Content Analytics feature provides information about visits
made by new versus returning visitors. To capture this data, the
feature asks this question whenever a page is visited: is the user
logged in as either a membership or regular user?
•

If yes, capture the user ID with the statistical data

•

If no, place a cookie on the visitor’s computer

So, the first time a user visits a page, either user information is
captured or a cookie is created.
The next time the user visits that page, the feature checks the visit
history for the user ID, or for a cookie. If either is found, the visit is
considered a return.

New Visitor Statistical Tracking
The same user visit may be considered new on one view but not
on another. For example, someone visits on January 30 (Monday)
then again February 2 (Thursday). On the monthly statistics, that
visitor is new, but on the weekly statistics, the February 2 hit would
be a return visit (his second this week).
Now consider a second visitor, who browses to your site on the first
and 20th of the month. These visits would appear on weekly
statistics as two new visits, but on the monthly statistics, only the
first visit would show up on that month's tally of new visitors. The
second visit would add to the return visitor statistics.
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Writing to the IIS Log
In addition to writing Site Analytic data to the database, you can
write it to the IIS log. To do this, enable the appendToIISLog element
in the web.config file.
Note that if you set appendToIISLog to true, Site Analytic data is
written to the IIS log, but does not appear in the Workarea. Only
data written to the database appears in the Workarea.

Content Analytics Reporting
The Content Analytics feature has extensive reporting features
which are based on drilling down from a top-level view of the entire
site, to individual templates, all the way down to individual content
items (if specified).
To access Content Analytics Reports, follow these steps.
Either
1. Browse to a content item for which analytic data is being
captured.
2. Right click the mouse.
3. Click View Template Activity to see analytic data for the
current content item (to learn more about data captured for one
content item, see ”Top Content” on page 935).
4. Click View Site Analytics to view analytic data for the entire
Web site.
or
1. Go to Modules > Site Analytics to view analytic data for the
entire Web site.
Five levels of reporting are available.
•

”Site Statistics” on page 932

•

”Site Activity” on page 933

•

”Top Content” on page 935

•

”Top Templates” on page 936

•

”Top Referrers” on page 937
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Summary of Statistical Data Available
The following table lists the kinds of analytic statistics that can be
viewed at each level of the site.

Type of Statistical Information

Site-wide

TemplateLevel

Content-Level

Views of Any Template

X

X

X

Visitors: New and Return

X

X

X

Pie Chart of New vs. Return Visitors

X

X

X

Pie Chart of Views/Visitors Ratio

X

X

X

Bar Graph of Views/Visitors Ratio

X

X

X

Visited Pages

X

Visited Content Blocks

X

URLs from which Site Visitors Accessed

X

X

Ek tr on CMS 40 0.NET

Site Statistics
The Site Statistics screen offers an overview of all tracked activity
within the selected date range. You see actual data for the
•

number of views

•

number of visitors

•

ratio of visitors per view

•

number of new and returning visitors

•

ratio of new to return visitors

Below this data are pie charts of the ratio of views to visitors and
new vs. return visitors.
NOTE

To understand how new and returning visitors are tracked, see ”Tracking Site
Visitors” on page 930.
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Site Activity
The Site Activity view shows relative activity during the selected
time period. The red bar indicates views, and the blue bar indicates
visitors.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

933

Content Analytics Feature

Site Activity Time Increments
The graph’s time increments are one level below the Quick View
selection. For example, in the screen above, Quick View is set to
Day. So, the statistics are broken down by hours of the day.
The following table lists the Site Activity time increments for each
Quick View selection.
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Quick view time
increment

Site Activity Graph display broken down by
these units

day

hourly

week

daily

month

weekly

year

monthly

Top Content
The Top Content View shows the most frequently-accessed
content items on your Web site.
See Also: ”Tracking Templates vs. Individual Content Items” on
page 927

You can click any content item to view
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NOTE

•

Content Statistics - statistics for that content item only (See
Also: ”Site Statistics” on page 932)

•

Content Activity - relative activity for that content item only
(See Also: ”Site Activity” on page 933)

•

Audit Content - all users who viewed the selected content
item; to the right of each user are the date and time when the
content was viewed

Only users who viewed the content after logging in appear on the list. Visitors to
your site who do not log in affect statistics but are not tracked on this report.

Top Templates
The Top Templates View shows all viewed templates on your Web
site, with the most frequently-accessed templates on top.
By default, the templates at the top of the list are those with the
highest number of unique visitors. You can change the sort by
clicking on any column header. For example, to sort the templates
by the number of views, click Views.

You can click any template to view
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•

Template Statistics - statistics for that template only (See
Also: ”Site Statistics” on page 932)

•

Template Activity - relative activity for that template only (See
Also: ”Site Activity” on page 933)

•

Content in Template - if a content items was specified for the
template in the Content Analytic server control, this view show
statistics for the template. You can click the template to view
Template Level activity. (See Also: ”Top Templates” on
page 936)

Top Referrers
The Top Referrers View shows the Web pages from which your
site was most frequently accessed.

Changing the Date Range of the Statistical Data
When you first view statistical data, the default date range is today
(one day).
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If you view statistics for different date ranges, when you return to
the screen, the last selected date range is the default selection.
You can change it if needed.

Using Quick View Options
Use Quick View options to view analytic statistics for any of the
following time periods.
•

one day

•

one week

•

one month

•

one year

When you click Quick View [week], [month] or [year], the current
end date is used as the last day of the range. Here are some
examples.

Quick
View
Option

If end date is today, begin date is

Week

one week earlier than today

Month

one month earlier than today

Year

one year earlier than today

Using Jump To Options
Use Jump To options to view analytic statistics for a time period
before and after the current date range. The time period is
determined by the Quick View increment. For example, if the Quick
View option is Day, you can jump to the previous day, the following
day, or today.
Regardless of the Quick View increment, you can always view
statistics for today.
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Quick
View
Option
Day

Week

Month

Year

“Jump to” options

•

previous day

•

next day

•

today

•

previous week

•

next week

•

today

•

previous month

•

next month

•

today

•

previous year

•

next year

•

today
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A community is a group of people who network with each other to
share information, ideas, likes and dislikes. Typically, people or
members in the community are connected by a relationship. For
example, they work for the same company, went to the same
school, share the same values, or have a friendship.
When a person visits a community site, he can look around to see
what type of information, people and groups are on the site. While
the person can see limited information on the site, he needs to
become a member of the site to see all information.
When a person signs up to be member, he defines information
about himself. This is known as his member profile. Once a person
becomes a member, he can
•

search for other members and add them to his friends list

•

invite non-members to join the community and become a friend

•

join or create a community group

•

add photos

•

add documents

•

leave messages on another member’s message board

•

write a private message to another member

•

keep a journal of his thoughts

•

have a list of favorite CMS400.NET content links

•

have a list of content he’s added

•

write content reviews

•

flag content

The Community Platform in CMS400.NET is a group of features
that allow users to network socially on the site. Access to the
community platform is available from the Web site or the
Workarea. Only CMS400.NET users and administrators can
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access their information via the Workarea. Membership Users,
CMS400.NET users, and administrators can access their profile
pages via a Web site.
As an Administrator, you can manage Community features from
the Workarea. These features are described in the following topics:
•

”Accessing a Profile” on page 941

•

”Message Board Comments Associated with Content in the
Workarea” on page 942

•

”Community Groups” on page 942

•

”Distributing Content to Another Ektron CMS400.NET Folder”
on page 952

•

”Flagging” on page 964

•

”Email Invites For Community Management” on page 979

•

”Tags” on page 981

•

Reviews - see ”Content Rating” on page 91

•

”Assigning Templates to Groups and Members” on page 994

Accessing a Profile
A Profile provides users with information about a user.
Administrators can access user profiles from the Workarea.
CMS400.NET users can access their profile from the Workarea or
the Web site. Membership users can access their profile page from
the Web site.
IMPORTANT!

For CMS400.NET users, some profile information in the Workarea’s View User
Information screen is not available on the Web site profile page. That information
involves Workarea settings.

Profiles in the Workarea
In the Workarea, profiles are located in the following areas:
•

For CMS400.NET Users - navigate to Settings > Users. See
”Managing Users” on page 713

•

For Membership Users - navigate to Modules > Community
Management > Memberships > Users. See the ”Working with
Membership Users” on page 729
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Message Board Comments Associated with
Content in the Workarea
Message Board comments can be associated with content. This
allows a user who views the content on the site to add comments
about the content.
NOTE

IMPORTANT!

Message Boards can also be associated with users and groups. See the User
Manual section My Workspace > Message Board and the Developer Manual
section “MessageBoard Server Control.”
Message Board comments are not the same as the Comments tab on the View
Content screen. See Also: The User Manual section “Working with Folders and
Content” > “Adding Content” > “Tabs on the Edit Content Screen”

You can view these comments in the Workarea. To do so, follow
these steps:
1. Click the Content folder button.
2. Navigate to the content block for which to view messages.
3. Click that content item. The View Content screen appears.
4. Click the View Content Reports button (

).

5. Click the Messages tab.
6. A list of comments associated with the content appears.

Community Groups
IMPORTANT!

Membership User Groups and Community Groups are two different concepts.
Membership User Groups allow an administrator to create a group of membership
users, thereby reducing the effort required to assign identical permissions to
many users. See ”Membership User Groups” on page 738. Community Groups
are explained below.

Community Groups are another aspect of a community sites.
Being a part of a group allows you to meet people with a similar
interest; for example, car racing.
Groups have features and functions similar to users. A Community
Group can have its own Message Board, Discussion Board, show
a list of members in the group, and keep a journal about the group.
Community Groups can be managed from the Web site or the
Workarea.
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Community Groups can also be assigned to a Taxonomy. This
allows users to browse and search for groups by category.
You can also assign Tags to a community group. This allows users
to find the group when searching via tag name. Tag information for
a group appears in the Group’s profile on the Web site. In the
Workarea, Tag information can be found on the View Community
Group’s > Tag tab. From this tab, you can add a Default Group Tag
or a new tag associated with the group.
See Also:
•

”Community Groups in the Workarea” on page 943

•

”Managing Community Groups” on page 943

•

”Distributing Content to Another Ektron CMS400.NET Folder”
on page 952

Community Groups in the Workarea
You can access community group information in the following
areas of the Workarea:
•

My Workspace > Community Groups - this area allows you
to see what groups you belong to and remove yourself from
them. See the User Manual section “My Workspace” >
“Community Groups” for additional information.

•

Modules > Community Management > Community Groups
- this area allows you to see all groups that exist. You can
define a group’s details or add and remove members from the
group when you are:
- a Group’s Leader (Group’s Administrator)
- a CMS400.NET Administrator
- a CMS400.NET user or Membership user with the
Community Group Admin or Community Group Create role

Managing Community Groups
To view a list of all community groups in the Workarea, click the
Modules folder > Community Management > Community
Groups > Groups.
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From this screen, the following actions and information are
available.
•

Information
- Group Name
- How many members are in the group
- The language of the group
- The ID of the group
- Whether the group is Public or Restricted
- The short description of the group
- The location of the group

•

Actions
- ”Adding a New Community Group” on page 944
- ”Viewing a Community Group’s Details” on page 946
- ”Editing a Community Group’s Information” on page 947
- ”Assigning Tags to a Community Group” on page 947
- ”Viewing Members of a Community Group” on page 948
- ”Adding Members to a Community Group” on page 949
- ”Accepting/Declining Requests to Join a Community Group”
on page 950
- ”Removing Members from a Community Group” on page 950
- ”Deleting a Community Group” on page 951
- ”Searching for a Community Group” on page 951

Adding a New Community Group
Administrators or CMS400.NET users with the Community Group
Administrator role can add a new community group in the
Workarea. After you create a group, you can add members to it.
See Also: ”Adding Members to a Community Group” on page 949
To add a new community group, follow these steps:
1. Click Modules > Community Management > Community
Groups > Groups.
2. Click the Add New Community Group button (

).

3. The Add Community Group screen appears.
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4. Use the table below to assist you with filling out this screen.
Field

Description

Properties Tab
Group Name

The name of the group.

Administrator

A group administrator has privileges to delete a group or
edit its properties.
Note: Members of the Administrators group and users
assigned to the Community Group Admin role also have
these privileges.
By default, the person who created the group is the group
administrator. Click the Browse button if you want to
select a different group administrator.

Membership

Select whether the group is open to the public, or if
members can only join when invited.

Image

Upload an image to use as an avatar for the group.

Location

The geographical location associated with the group.

Short Description

A brief description of the group.

Description

A fully detailed description of the group.

Enable Distribute

Check this box if you want the group and system
administrator to be able to distribute content to any
Ek tron CM S40 0.NET folder. See Also: ”Distributing
Content to Another Ektron CMS400.NET Folder” on
page 952

Allow member to
manage photo/
workspace folders

Checking this box allows members to add, remove and
control the sharing of folders in a community group’s
Photo Gallery or Document’s Workspace. See Also:
”Allowing Community Group members to Work with
Folders” on page 946.

Tags Tab
Group Tags

From this screen, you can either create a new tag or select
from a default list of community group tags. See Also:
”Assigning Tags to a Community Group” on page 947.
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Field

Description

Categories Tab
Category List

The categories tab lists all of the categories associated
with the community group.
Note: If you have not defined at least one taxonomy for
community groups, this tab does not appear. See Also:
”Creating a Taxonomy” on page 638.

5. Click the Save button (

).

6. The page refreshes, and the View All Community Groups
screen appears.
Allowing Community Group members to Work with Folders

When you associate the CommunityDocuments or PhotoGallery
server control with a community group, you can allow members of
the group to add, remove and control the sharing of folders in
these controls. To allow a member to work with Photo Gallery and
Workspace folders, follow these steps.
1. In the Workarea, navigate to Modules > Community
Management > Community Groups > Groups.
2. Click a community group.
3. Click the Edit button (

).

4. Place a check mark in the Allow member to manage photo/
workspace folders check box.
5. Click the Save button (

).

Viewing a Community Group’s Details
Any user with access to the Workarea can view a group’s details.
However, they cannot see the members of the group.
If a user is the Group Leader (Group’s Administrator), an
Administrator, or CMS400.NET User with the Community Group
Administrator role, he can edit the group’s information, add and
remove members, or delete the group.
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To view a group’s details, follow these steps.
1. Click Modules > Community Management > Community
Groups > Groups.
2. Click the Group Name link.
3. The group’s detailed information appears.

Editing a Community Group’s Information
Editing a group’s information allows you change certain details
about the group. Only the Group Leader (Group’s Administrator),
Administrators, CMS400.NET Users with the Community Group
Admin, or Community Group Create role can edit a group’s
information.
To edit a group’s details, follow these steps:
1. Click Modules > Community Management > Community
Groups > Groups.
2. Click the Group Name link.
3. Click the Edit button (

).

4. Change any fields as needed. These fields are described in
”Adding a New Community Group” on page 944.
5. Click the Save button (

).

Assigning Tags to a Community Group
You can either create a new tag for a community group or select
from a default list of group tags.
See Also: ”Tags” on page 981
Creating New Tags for a Community Group

To create a new tag for a community group, follow these steps.
1. In the Workarea, navigate to the Modules > Community
Group > Groups.
2. Click the community group for which to create a new tag.
3. Click the Edit button (

).
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4. Click the Tags tab.
5. Click the Click To Add A New Group Tag link.
6. Add a tag to the Name text box.
7. Select a Language.
8. Click Save.
9. Click the Save button (

).

Once the Tag is saved, it appears in the Group Tags area with a
check mark in the check box. Having a check mark in the check
box means the tag is active for the community group.
Adding a Default Tag to a Community Group

To add a default tag to a community group, follow these steps.
1. In the Workarea, navigate to the Modules > Community
Group > Groups.
2. Click the community group for which to create a new tag.
3. Click the Edit button (

).

4. Click the Tags tab.
5. Place a check mark in the tag’s check box that you want to use.
6. Click the Save button (

).

Viewing Members of a Community Group
Only the Group Leader (Group’s Administrator), Administrators or
CMS400.NET Users with the Community Group Administrator role
can view members of the group. In addition to viewing community
group members, you can see add and remove members. You can
also accept or decline members’ requests to join the group if the
group’s membership is set to Restricted.
See Also:
•

”Adding Members to a Community Group” on page 949

•

”Removing Members from a Community Group” on page 950

•

”Accepting/Declining Requests to Join a Community Group” on
page 950
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To view members of a community group, follow these steps:
1. Click Modules > Community Management > Community
Groups > Groups.
2. Click the Group Name link.
3. Click the View Community Group Members button (

).

4. A list of group members appears.

Adding Members to a Community Group
Only the Group Leader (Group’s Administrator), Administrators or
CMS400.NET Users with the Community Group Administrator role
can add members to a group.
To add members to a group, follow these steps:
1. Click Modules > Community Management > Community
Groups > Groups.
2. Click the Group Name link.
3. Click the View Community Group Members button (

).

4. The View Community Group Members for the group screen
appears.
5. Click the Add User(s) button (

).

6. The Add Members screen appears.
7. Using the drop down box, select the type of name for which to
search.
8. Enter a name in the text box.
9. Click the Search button.
TIP!

If you leave the text box blank and click the Search button, all results for the name
type are returned.

10. The results are returned.
11. Place a check mark in the box next to each member to add.
12. Click the Add button (

).

13. The View Community Group Members screen appears with
all members of the group.
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Accepting/Declining Requests to Join a Community Group
If a group’s membership is set to Restricted (on the Add or Edit
Community Group screen), users must request to join the group. If
membership is set to Open, on the other hand, users join a group
immediately.
Use the Pending tab on the View Community Group Members to
accept or decline a user’s request to join a group. Only a Group
Leader (Group’s Administrator), Administrators, or Ektron
CMS400.NET users with the Community Group Administrator role
can accept new members to a group.

To accept or decline members’ request to join a group, follow these
steps.
1. From the Ektron CMS400.NET Workarea, go to Modules >
Community Management > Community Groups > Groups.
2. Click the group for which you want to accept or decline
requests to join.
3. Click the View Community Group Members button (

).

4. Click the Pending tab.
5. Check the box next to each member whose request you want
to approve or decline.
6. To approve the selected members’ request to join, click the
approve button (

).

To decline the request, click the decline button (

).

Removing Members from a Community Group
Only the Group Leader (Group’s Administrator), Administrators, or
CMS400.NET Users with the Community Group Administrator role
can remove members from a group.
To remove members from a group, follow these steps.
1. Click Modules > Community Management > Community
Groups > Groups.
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2. Click the Group Name link.
3. Click the View Community Group Members button (

).

4. The View Community Group Members for the group screen
appears.
5. Place a check mark in the box next to members you want to
remove.
6. Click the Remove button (

).

7. A dialog box appears asking you to confirm you are removing
the selected members.
8. Click OK to remove the members.
9. The page refreshes, and the selected members are removed.

Deleting a Community Group
Only the Group Leader (Group’s Administrator), Administrators or
CMS400.NET Users with the Community Group Administrator role
can delete a group.
To remove a community group, follow these steps:
1. Click Modules > Community Management > Community
Groups > Groups.
2. Click the Group Name link.
3. Click the Delete button (

).

4. A dialog box appears asking you to confirm that the community
group will be deleted.
5. Click OK.
6. The page refreshes and the View All Community Groups
screen appear.
You could

Searching for a Community Group
You can search for a Community Group in the Workarea by using
the Search box located at the top of the View All Community
Groups page. To search for Community Groups, click Modules >
Community Management > Community Groups > Groups.
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Enter text in the search box and click the Search button. A list of
Community Groups that match the search term appears.

Distributing Content to Another Ektron
CMS400.NET Folder
Ektron CMS400.NET supports the distribution of Community

Documents to any CMS folder. (A community document is either
HTML content or an asset created via the Community Documents
server control.)
For example, your Marketing Department uses the Community
Documents server control to create and edit content. After
completing a press release, they use the Distribute menu option
to copy it from the private collaboration folder to a public content
folder. Once there, the document can pass through an approval
chain or be published immediately.
The Distribute option can insert new content or overwrite existing
content in any folder.

The Distribute Option is more fully explained through these topics.
•

”Enabling the Distribute Option” on page 953
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•

”Distributing a Community Document” on page 954

Enabling the Distribute Option
Only a member of the Ektron CMS400.NET Administrators group
can enable the Distribute option. Do this for every Community
Group that will use it. You can do so from the Workarea or after
logging in to the Web site.

From the Workarea
1. From the Ektron CMS400.NET Workarea, go to Modules >
Community Management > Community Groups > Groups.
2. Click the group for which you want to enable the Distribute
option.
3. Click the Edit button (

).

4. Check the Enable Distribute check box.
5. Click the Save button (

).

From the Web Site
1. Log into a site that uses the Community Management features
as a CMS administrator or a Group Administrator.
2. Navigate to a Web page that hosts a Group Profile page.
3. Click the Edit Group link (circled below).

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

953

Community Management

4. Check the Enable Distribute check box.
5. Click the Save button (

).

Distributing a Community Document
There are two procedures for distributing a community document
the first time. When doing so, ask yourself the following question.

What are you doing?

Read this procedures

Replacing an existing file in an E k tro n
C MS 4 00 .NE T folder. The file types must match.

”Distributing a New Community Document that
Overwrites an Existing One” on page 959

Placing a file in an E ktron CM S40 0. NET folder
for the first time

”Distributing a New Community Document” on
page 955

IMPORTANT!

After a community document is distributed the first time, the original document is
forever linked to the destination document. You cannot break the link.

If you want to later revise the document, you would typically edit it
in the collaboration folder and select the Distribute option again.
When you do, you are asked to confirm replacing the document in
the destination folder. You are not allowed to select another folder.
If you really must distribute it to another folder, delete the
document in the destination folder. This action breaks the link
between documents. Once the link is broken, you can distribute
the document to another folder.
”Distributing Content After the First Time” on page 963 explains
how subsequent edits are handled.

Prerequisites
•

You log in as one of the following
- Administrator of the group whose documents are being
distributed
- Ektron CMS400.NET user assigned Community Group
Administrator role for that group

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

954

Community Management

- CMS administrator
•

The content’s status is Approved.

•

You have permission to add, delete, and restore content to the
destination folder. (If you do not, the folder doesn’t appear on
the folder selection screen.) See Also: ”Setting Permissions” on
page 768

Distributing a New Community Document
When distributing a Community Document that does not exist in
Ektron CMS400.NET for the first time, you identify a destination
folder and, if required, metadata and taxonomy categories. This
information is collected through a series of screens that guide you
through the process.
NOTE

If you are using Ektron CMS400.NET with Microsoft Sharepoint Integration,
after selecting the folder (in Step 8), the document is copied to that folder even if
you later click the screen’s Close button. See Also: ”Ektron’s Microsoft Office
SharePoint Server Connector” on page 1075.

1. Log in to the Web site that contains content you want to
distribute.
2. Navigate to the Web page that contains content you want to
distribute.
3. Click the triangle to the right of the content or asset you want to
distribute.
4. Click Distribute from the dropdown menu.

5. The following screen appears.
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6. Click in the top box, which begins I want to distribute a copy
of this item.
7. The following screen appears
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8. Select the folder to which you want to distribute the content.
9. Click Next.
10. The following screen appears if metadata or a taxonomy
category is required for the folder.
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11. Enter any required metadata or taxonomy. See the Ektron
CMS400.NET User Manual section “Adding or Editing
Metadata,” ”Metadata” on page 118, and ”Taxonomy” on
page 634.
12. A confirmation screen appears. Click Done.
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13. Ektron CMS400.NET copies the selected document to the
selected folder.

Distributing a New Community Document that Overwrites an Existing
One
NOTE

This process only occurs the first time you overwrite a document. For a
description of subsequent updates, see ”Distributing Content After the First Time”
on page 963.

During this procedure, you identify a destination folder and content
to be replaced. Since the content’s type that you are distributing
must match the content being replaced, you only see content
whose types match.
Upon replacing, any metadata and taxonomy categories applied to
the existing content are applied to the new. Also, the content title
and ID number from the existing content are maintained -- they are
not replaced by the title and ID number of the new content. Finally,
the existing content’s summary is maintained and can be edited if
needed.
This information is collected through a series of screens that guide
you through the process.
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1. Log in to the Web site that contains the content you want to
distribute.
2. Navigate to the page that contains that content.
3. Click the triangle to the right of the document you want to
distribute.
4. Distribute appears on the dropdown menu.

5. Click Distribute.
6. The following screen appears.
NOTE

The following screen only appears the first time you overwrite a file. To overwrite
the file subsequently, see ”Distributing Content After the First Time” on page 963.
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7. Click the lower box, which begins I want to replace an
existing item.
8. The following screen appears.
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9. Navigate to and select the content you want to replace. Only
content whose type matches the document you selected in
Step 3 appears.
10. Press Next.
11. A confirmation screen appears. Click Done.
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12. Ektron CMS400.NET overwrites the selected document with the
one you selected in Step 3.

Distributing Content After the First Time
If you later try to Distribute the same document (whether you
added a new document or overwrote an existing one), a screen
like the following appears.
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You can copy the latest version of the document to the distribution
folder by clicking in the gray box whose text begins I want to
redistribute... However, you cannot distribute the document to
another folder. (If you want to do so, first delete the document from
the destination folder. Then, you can use either procedure to
distribute the document to any folder.)
When distributing content after the first time, its metadata and
taxonomy categories appear on the Metadata/Category screen by
default. You can change them if desired.
As with the replace option, existing content’s title and ID number
are maintained -- they are not replaced by the new content’s title
and ID number. And, the existing content’s summary is maintained
and can be edited if needed.

Flagging
Flagging Content enables a site visitor who views a piece of
content to flag content and provide feedback. It allows you to
define a list of flags and apply the choices to a folder. Lists can be
centered on content that is not appropriate for all viewers. For
example:
•

Sexually Explicit

•

Mature (over 18 only) content

•

Graphic Violence

•

Hate Speech

While some sites use flagging to allow notification of inappropriate
content, it can also be used to indicate if a content item is above
average. This would help an organization to create a
recommended content list. Below is an example list:
•

Loved This Content

•

Hated This Content

•

I Could Take It or Leave It

After you create a flag definition and assign it to a folder, all content
in that folder can be flagged. For a user to be able to flag content, a
developer must add a ContentFlagging server control to a Web
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page on the site and assign it the ID of the content to be flagged.
See the Developer’s Manual section “Introduction to Server
Controls” > “ContentFlagging Server Control” for additional
Information.
Having a way to flag content is a necessity for sites with a large
quantity of site visitor-generated content. Content flagging can
spread the moderation of your site to your site visitors Flagging
can also help site visitors feel vested in the site.
Flagged content appears in the following Workarea locations.
•

Content Flags list on the Smart Desktop

•

Modules > Community Management > Flagging > Flagged
Content

•

a content item’s View Content Reports > Flagging tab

This section contains the following topics.
•

”Flagging Definitions” on page 965

•

”Flagged Content” on page 969

Flagging Definitions
The Flagging Definitions screen is located in the Workarea >
Modules > Community Management > Flagging. From this screen
you can, view a list of existing flagging definitions, work with them,
or create new definitions. In addition, the list of Flagging definitions
can be filtered by language.
This screen contains the following information about a flagging
definition.

Field

Description

ID

The ID of the flagging definition.

Name

The name of the flagging definition.

Description

A description of the flagging definition.
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Field

Description

Language

An image of a national flag associated with the language.
For example, American English appears as

Items

.

The number of flags in a definition. For example, if you
have a flag definition for these movie ratings:
•

G

•

PG

•

PG-13

•

R

The items count for this flag definition would be four.

This section contains the following topics.
•

”Adding a Flagging Definition” on page 966

•

”Edit a Flagging Definition” on page 967

•

”Deleting a Flagging Definition” on page 967

•

”Assigning a Flagging Definition to a Folder” on page 967

•

”Seeing Which Flagging Definition is Assigned to a Content
Item” on page 969

Adding a Flagging Definition
To create a flagging definition, follow these steps.
1. In the Workarea, navigate to Modules > Community
Management > Flagging > Flagging Definitions.
2. Select a language with which the flagging definition will be
associated.
3. Click the Add button (

).

4. The Add Flagging Definition screen appears.
5. Enter a Name and Description for the flagging definition.
6. Click the Option button (
definition.

) to add a flag to this flagging

7. Continue to click the Option button to add additional flags.
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8. If necessary, change the order of the flags by clicking the
Sorting buttons (
). If you create a flag you want to
remove, click the Remove button ( ).
9. Click the Save button (

).

Edit a Flagging Definition
To edit a flagging definition, follow these steps.
1. In the Workarea, navigate to Modules > Community
Management > Flagging > Flagging Definition.
2. Click the flagging definition Name link or the ID link.
3. Edit the available fields.
4. Click the Save button (

).

Deleting a Flagging Definition
When you no longer want to use a flagging definition, delete it.
When a flagging definition is deleted, it is removed from all folders
with which it is associated.
To delete a flagging definition, follow these steps.
1. In the Workarea, navigate to Modules > Community
Management > Flagging > Flagging Definition.
2. Click the flagging definition Name link or the ID link.
3. Click the Delete button ( ).

Assigning a Flagging Definition to a Folder
Once you have created a flagging definition, you can assign it to
one or more folders. All content in the folders will have the selected
flagging definitions applied to it.
To assign a flagging definition to a folder, follow these steps.
1. Create a flagging definition, as explained in ”Adding a Flagging
Definition” on page 966.
2. Click the Content folder bar.
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3. Navigate to the folder where the content to be flagged is
located.
4. Select View > Folder Properties from the View menu.

5. The View Properties screen appears.
6. Click the Edit button (

).

7. Find the Flagging area.
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8. Make sure the Inherit Parent Flagging Configuration check
box is not checked.
9. Select an available flagging definition from the Flagging drop
down.
10. Click the Save button (

).

Seeing Which Flagging Definition is Assigned to a Content Item
To see which flagging definition is assigned to a content item,
follow these steps.
1. In the Workarea, navigate to the content item.
2. Click the content’s title.
3. Click the Edit Properties button (

).

4. The View Properties screen appears.
5. The name of the flagging definition appears next to the
Flagging Definitions title.

Flagged Content
The Flagged Content areas of the Workarea allow you to view and
manage content that’s been flagged and the flags themselves.
There are three places in the Workarea to work with flagged
content:
•

on the Smart Desktop. This area deals with the most recent
content flags associated with any content. See ”Content Flags
on the Smart Desktop” on page 970

•

in Modules > Community Management > Flagging >
Flagged Content. This screen is for all flagged content. See
”Flagged Content in Modules > Community Management” on
page 971.
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•

a tab on the Content Reports screen for a content item. This
tab displays a list of content flags for a specific content item See ”Viewing a Content Item’s Flags” on page 976.

Flagged content is more fully explained through the following
topics.
•

”Content Flags on the Smart Desktop” on page 970

•

”Flagged Content in Modules > Community Management” on
page 971

•

”Viewing a Content Item’s Flags” on page 976

•

”Viewing a Flag’s Details” on page 977

•

”Editing a Flag’s Details” on page 978

•

”Deleting a Flag” on page 979

Content Flags on the Smart Desktop
This area lists the ten most recent content flags that have been
added. From this area, you can view a flag by clicking on its Title
link. To view all recent flags, click the View recent flags link.
Clicking this link takes you to the Content Reports: Recent Flags
screen. See Also: ”Flagged Content in Modules > Community
Management” on page 971
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Flagged Content in Modules > Community Management
The Flagged Content area in Modules > Community
Management > Flagged Content allows you to display a list of
flags. By default, the list shows flags for the last ten days. You can
change this by entering a new number in the Show flags for the
last # days field.
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The information for each flag is explained in this table.

Field

Description

Title

The title of the content block being flagged. Clicking this
link brings you to a detailed description of the content’s
flag.

Display Name

The name of the user who flagged the content as it is
displayed on the Web site.

Date

The date the content was flagged.

Flag

The specific flag from the flagging definition for this
content.

Comment

Any comments added by the user who flagged the
content.

From this screen, you can perform the following actions:
•

View the details of a submitted content flag - see ”Viewing a
Flag’s Details” on page 977
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•

Generate a Flagged Content report - see ”Generating a
Flagged Content Report” on page 973

•

Print a list of flagged content - see ”Printing a List of Flagged
Content” on page 974

•

Email a list of flagged content - see ”Email a List of Flagged
Content” on page 974

•

Filter flagged content by folder - see ”Filtering Flagged Content
by Folder” on page 975

•

Filter flagged content by language - ”Filtering Flagged Content
by Language” on page 975

Generating a Flagged Content Report

By default the Content Reports: Recent Flags screen shows
content flagged within the last ten days. To generate a different
report, follow these steps.
1. In the Workarea, navigate to Modules > Community
Management > Flagging > Flagged Content.
2. In the Showing flags for the last # days field, enter a new
number of days for which to show Flagged Content.

3. Click the Report button (

).

4. The page refreshes, and the list contains the new report.
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Printing a List of Flagged Content

On the Content Reports: Recent Flags screen, you can output the
flagged content report to a printer by clicking the Print button ( ).
This creates an HTML version of the list that opens in a browser.
From the browser, you can print the list by using the browser print
functionality.
Email a List of Flagged Content

You can email the a list of flagged content to any other
CMS400.NET user. This does not include membership users. To
email a flagged content list, follow these steps.
1. In the Workarea, navigate to Modules > Community
Management > Flagging > Flagged Content.
2. Either create a new Flagged Content report or use the existing
one.
3. Click the Email button (

).

4. The Select user email report screen appears.

5. Place a check next to each user to whom you want to email the
report.
6. Click the Email button (

).

7. If necessary, enter your email address and click the Email
button (

) again.

8. The list of flagged content is sent.
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From the Content Reports: Recent Flag screen, you can filter
flagged content by folder. This allows you to see only flagged
content for a specific folder. To filter flagged content by folder,
follow these steps.
1. In the Workarea, navigate to Modules > Community
Management > Flagging > Flagged Content.
2. Click the Filter button (

)

3. The Select Folder screen appears.

4. Select a folder.
5. Click the Save button (

).

6. The page refreshes, and any flagged content in the folder is
shown.
NOTE

Only flagged content that falls within the time frame for the Showing flags for the
past # days field is shown. For example, if the field is set to five when you filter by
a folder, only content that’s been flagged in the last five days appears.

Filtering Flagged Content by Language

To see flagged content for a specific language, select the language
from the Language drop down box. When the page refreshes, only
flagged content associated with the language appears.
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Viewing a Content Item’s Flags
You can also view flags for a specific content item. This allows you
to see only flags associated with that content item. Flags for a
content item can be found on the Content Report screen >
Flagging tab. From this screen, you can filter the flags by a date
range or see all flags associated with the content. In addition, this
screen contains a purge button which allows you to remove all
flags associated with this content. This subsection contains the
following topics:
•

”Getting Flags for a Content Item” on page 976

•

”Purging Flags for a Content Item” on page 977

Getting Flags for a Content Item

Follow the steps below to get flags for a content item.
1. In the Workarea, find the content block for which to retrieve
content flags.
2. Click the title of the content block.
3. The View Content screen appears.
4. Click the Content Reports button (
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NOTE
NOTE

5. Click the Select Date button (
start date.

) next to Start Date to select a

6. Click the Select Date button (
end date.

) next to End Date to select an

To retrieve all flags for a content item, leave the Start Date and End Date blank.

To remove a Start Date or End Date, click the Delete Date button (

).

7. Click the Get Flags button.
8. A list of flags is displayed.
Purging Flags for a Content Item

If you need to delete flags for a content item, follow these steps.
1. In the Workarea, find the content block for which to purge
content flags.
2. Click the title of the content block.
3. The View Content screen appears.
4. Click the Content Reports button (

NOTE
NOTE

).

5. Click the Select Date button (
start date.

) next to Start Date to select a

6. Click the Select Date button (
end date.

) next to End Date to select an

To purge all flags for a content item, leave the Start Date and End Date blank.

To remove a Start Date or End Date, click the Delete Date button (

).

7. Click the Purge Flags button.
8. The flags are removed.

Viewing a Flag’s Details
Viewing a flag’s detail information allows you to read the entire
comment if it is truncated in one of the lists. You can also edit or
delete the flag from this screen.
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To view detailed flag and comment information, follow these steps.
1. Navigate to one of these area in the Workarea:
- Smart Desktop > Content Flags
- Modules > Community Management > Flagging > Flagged
Content
- Content Reports > Flagging tab for a content item
2. Click either a flag’s content title or the flag’s date.
3. The flag’s detail information appears.
See Also: ”Editing a Flag’s Details” on page 978; ”Deleting a Flag”
on page 979

Editing a Flag’s Details
Editing a flag allows you to change the flag’s selection or the
comments for a flagged content item. This can be useful if a user
selects the wrong flag by mistake or you want edit a particular
flag’s comments. For example, a user selects the “Offensive
Content” flag and he meant to click the “Copyright Violation” tag.
To edit a flag or its comment information, follow these steps.
1. Navigate to one of these area in the Workarea:
- Smart Desktop > Content Flags
- Modules > Community Management > Flagging > Flagged
Content
- Content Reports > Flagging tab for a content item
2. Click either a flag’s content title or the flag’s date.
3. The flag’s detail information appears.
4. Click the Edit button (

).

5. Change the flag or edit the comments.
6. Click the Save button (

).

7. The flag’s information is changed.
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Deleting a Flag
When you do not need a flag, you can delete it from the system.
When you do, the flag is permanently removed.
To delete a flag, follow these steps.
NOTE

To remove all flags associated with a specific content item, see ”Purging Flags for
a Content Item” on page 977.

1. Navigate to one of these area in the Workarea:
- Smart Desktop > Content Flags
- Modules > Community Management > Flagging > Flagged
Content
- Content Reports > Flagging tab for a content item
2. Click either a flag’s content title or the flag’s date.
3. The flag’s detail information appears.
4. Click the Delete button (

).

5. A dialog appears asking you to confirm the deletion.
6. Click OK.

Email Invites For Community Management
The Community Platform’s email notification feature enables
Ektron CMS400.NET to generate email that invites a user to join
the site, a community group or become a colleague of another
user.
For example, a message might be sent when someone in a
community group wants another user to join the group.

Creating the Email Message
You can create an email message to be sent when a user invites
another user to join a group, the site or invite them to be a friend. A
simple editor lets you apply some XHTML formatting the message.
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Including Variables in the Default Message
The messages can include variables that retrieve information
about the person who’s sending the invite or the link to join a group
and display it in the message text. The variables are surrounded
by at signs (@). For example:
@appSenderName@ is used to display the name of the user sending the
invite.

In the email, this text might read:
Alan Administrator has invited you to join the Marketing Community
Group.

You can use the following variables in the body of an email
notifications.

Variable

Displays this information in the email

@appOptionalText@

Text that the user types into the Optional Text box on the Invite server
control.

@appSenderName@

The name of the person sending the invitation

@appFriendDisplayName@

The name of the person to which the invite is being sent.

@appInvitedEmail@

The email address of the person being invited.

@appInviteId@

Used for appending the invite ID to the registration URL. For example:
Click <a href=http://www.example.com/
register.aspx&fInvId=@appInviteId@>here</a> to accept.

@appGroupName@

The name of the group a person is being invited to join.

To create a message, follow these steps.
1. In the Workarea, go to Modules > Community Management
> Messages.
2. Click the Add button (

).

3. Enter a title that describes the message.
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4. At the Type field, select either FriendInvitation, SiteInvitation
or GroupInvitation.
5. Select whether to make the email message a Default message.
6. In the Subject box, add a subject for the email.
7. In the editor, enter the message text. Use the variables listed in
the table above to retrieve information about the about the
invitation and display it in the message.
8. Click the Save button (

).

Tags
NOTE

This section discusses Tags for use with the Community Platform. Information on
tagging blog entries can be found in the User Manual section “Blogs” > “Blog
Post” > “Adding A Blog Post” > “Tags on the Summary Page.”

Tags are keywords that can be assigned to users, groups, content,
and library items.
On a Web site, tags for a user or group appear in a profile, helping
site visitors to learn about a user or group.

Tags also allows users to perform tag-based searching, as shown
below.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

981

Community Management

So, for example, you could tag all content related to a new product
release with the name “Widgets 2.0.” Anyone could enter that term
into the Search box, click Tags from the dropdown list (shown
above), then the Search button to find all related content.
In the Workarea, tags are used in the following locations.

Location

Image

User Information screen’s Tags
area, for users or membership
users
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Location

Image

The Community Group screen’s
Tags tab

A content item’s Metadata tab >
Tags area
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Location

Image

A library item’s Metadata tab >
Tags area

Modules > Community
Management > Tags

DEVELOPER ’S NOTE

The CommunityGroupBrowser, CommunityGroupProfile, and
CommunityGroupList Server Controls can display group tags and link them to a
list of all groups that share the tag. Also, the TagCloud server control displays a
weighted list of tags. For more information, see the Ektron CMS400.NET
Developer’s Manual.

The rest of this section explains tags through the following topics.
•

”Tag Types” on page 985
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•

”Creating Default Tags” on page 985

•

”Creating User-Created Tags” on page 990

•

”Managing Tags” on page 991

•

”Viewing a Tag’s Details” on page 992

•

”Deleting Tags” on page 992

Tag Types
There are basic two types of tags, and they are contrasted below.

Type

Description

For more information,
see

Default

•

created by system administrator in Modules >
Community Management > Tags area

”Creating Default Tags” on
page 985

•

appear as checkbox options wherever tags can be
applied

•

created by user as needed wherever tags can be
applied

Usercreated

”Creating User-Created
Tags” on page 990

Creating Default Tags
An Ektron CMS400.NET administrator can create default tags for
each object (user, user group, content or library item). For
example, you want to allow users to associate themselves with a
favorite race car driver. You create a default user tag for each
driver’s name.
When a user creates or edits an item for which you created the
default tags, they appear and the user clicks inside check boxes to
assign them.
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Ektron CMS400.NET provides separate screens for creating default

tags for user groups, users, content and library items. They are
available via Modules > Community Management > Tags
(shown below).

See Also:
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•

”Adding Default Group Tags” on page 987

•

”Adding Default User Tags” on page 988

•

”Adding Default Content Tags” on page 988

•

”Adding Default Library Tags” on page 989

Adding Default Group Tags
The Default Group Tags screen lets you add tags that may be
assigned to community groups.

To add a Default Group Tag, follow these steps.
1. In the Workarea, navigate to Modules > Community
Management > Tags > Default Group Tags.
2. Select a language for the tag.
3. Add the tag in the empty text box. If no empty box appears,
click the Add button ( ) then enter the tag.
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4. Click the Save button (

).

Adding Default User Tags
The Default User Tags screen allows you to add tags that may be
assigned to a user.

To add a Default User Tag, follow these steps.
1. In the Workarea, navigate to Modules > Community
Management > Tags > Default User Tags.
2. Select a language for the tag.
3. Add the tag in the available text box. If no text box is available,
click the Add button ( ) then enter the tag.
4. Click the Save button (

).

Adding Default Content Tags
The Default Content Tags screen allows you to add tags that may
be assigned to a content.
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To add a Default Content Tag, follow these steps.
1. In the Workarea, navigate to Modules > Community
Management > Tags > Default Content Tags.
2. Select a language for the tag.
3. Add the tag in the available text box. If no text box is available,
click the Add button ( ) then enter the tag.
4. Click the Save button (

).

Adding Default Library Tags
The Default Library Tags screen allows you to add tags that may
be assigned to a library.

To add a Default Library Tag, follow these steps.
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1. In the Workarea, navigate to Modules > Community
Management > Tags > Default Library Tags.
2. Select a language for the tag.
3. Add the tag in the available text box. If no text box is available,
click the Add button ( ) then enter the tag.
4. Click the Save button (

).

Creating User-Created Tags
In addition to applying default tags, users, community group
leaders, and content editors can create their own tags. This allows
for a more diverse and creative list of tags.
For example, a user is editing content. He reviews the default tags
but decides that none is correct. So, he creates and assigns a new
tag: Rosebud. That tag is now applied to that content.

The user-created tag also appears on the Modules> Community
Management > Tags screen, where you can see its ID number.
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If someone creates another tag with the same exact name, the
new tag will share the ID number with the previous one, and the
Times Used will increase from 1 to 2. However, the new tag will
not appear as a default on any screen.

Managing Tags
Administrators manage tags from the Modules > Community Management > Tags screen.
This screen displays all default and user-created tags. You can filter the list by language.
Click any tag’s name to see its details. See Also: ”Viewing a Tag’s Details” on page 992
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This screen displays the following information about each tag.
Field

Description

ID

Its integer ID

Name

Its title

Times Used

The number of times a tag has been assigned

Language

Its language. This appears as a national flag. For example,
American English appears as
.

Viewing a Tag’s Details
When you click a tag’s name, its details appear on the View Tag
screen.
Field

Description

ID

The integer ID of the tag.

Language

The language assigned to the tag.

Name

The title of the tag.

Tagged Type

Shows how the tag is assigned: to a community group,
user, content, or library item. See Also: ”Adding Default
Group Tags” on page 987 and ”Adding Default User Tags”
on page 988

Times Used

The number of times this tag is assigned to each Tagged
Type.

Deleting Tags
As mentioned above, there are two basic tag types: user-created
and default. (See Also: ”Tag Types” on page 985). The following
table contrasts how to delete tags.
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Tag Type

Result

Procedure

Usercreated

Delete a single tag

1.

Open the item’s Tags area. For example, for
content, edit the Metadata tab.

2.

Uncheck the checkbox next to the tag.

3.

Publish the content.

1.

Go to the Modules > Community Management > Tags screen.

2.

Click the tag.

3.

Click the delete button (

4.

A confirmation screen appears.

5.

Click OK.

Delete all occurrences of a tag
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Tag Type

Result

Procedure

Default

There are two methods for deleting default tags. Each has different results.
Deleting a Default Tag

1.

Go to Modules > Community Management
> Tags

2.

Select the screen for the kind of tag you want
to delete (group, user, content or library).

3.

Select the language.

4.

Click the red X to the right of the tag you want
to delete (see below).

5.

You are asked if you are sure. Click OK.

6.

Click the save button (

Deleting a Default Tag and All of its
Links

1.

Go to the Modules > Community Management > Tags screen.

•

No longer available for assignment
to users, content, etc.

2.

Click the tag.

•

Existing links to it are deleted

3.

Click the delete button (

4.

A confirmation screen appears.

5.

Click OK.

•
•

No longer available for assignment
to users, content, etc.
Existing links to it remain

)

).

Assigning Templates to Groups and Members
As mentioned in ”Community Management” on page 940, Ektron
CMS400.NET ‘s Community Management feature supports both
community and individual member pages. Like other Ektron
CMS400.NET content, Community Management content appears
on a dynamic Web page. Page templates determine each page’s
layout and location of elements (menus, content, blogs, etc.).
Below is a sample Community Management template. See Also:
”Creating/Updating Templates” on page 70
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Sample Group Template within Visual Studio.NET

Sample Group Template on a Web Page

The Community Management feature includes six templates:
•

Community Group
- documents
- photos
- journal

•

User
- documents
- photos
- journal

Ektron CMS400.NET provides a sample for each template. You can
use the sample or create your own. If you begin with a sample
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template and modify it, be sure to save it under a different name to
prevent it from being overwritten when you upgrade.

The Templates Screen
Use the Templates screen to assign templates to Community
Management pages.

The following table explains the fields on the Templates screen.

Field

Page that displays template

Group Templates
Community Document

Page hosts the CommunityDocuments Server Control;
ObjectType property is set to Group

Photo Gallery

Page hosts the PhotoGallery Server Control;
ObjectType property is set to Group

Journal

Page hosts the Blog Server Control, and the blog was
created for a group page
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Field

Page that displays template

User Templates
Community Document

Page hosts the CommunityDocuments Server Control;
ObjectType property is set to User

Photo Gallery

Page hosts the PhotoGallery Server Control;
ObjectType property is set to User

Journal

Page hosts the Blog Server Control, and the blog was
created for a user page
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Multi-Site Support

Ektron CMS400.NET’s multi-site support feature lets you set up and

manage several Web sites under one CMS. For example:
•

www.example.com

•

support.example.com

•

forums.example.com

All sites share a single database. The multi-site support feature
does not support multiple databases.
Multi-site support is explained through the following topics.
•

”Advantages of Multi-Site Configurations” on page 998

•

”Prerequisites” on page 998

•

”Using Multi-Site Configurations” on page 999

•

”Installing the Multi-Site Support Feature” on page 999

•

”Using eSync in a Multi-site Environment” on page 1360

Advantages of Multi-Site Configurations
•

The URL can indicate the nature of the site to visitors.

•

All sites can share
- common content, but appear within their own site and
templates
- the library of images and files. These files can be stored once,
yet authors can insert them into content from any site.

Prerequisites
•
NOTE

The server must run Windows Server 2003 or 2008

Windows XP supports only one Web site.
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•

All sites reside on the same server

Using Multi-Site Configurations
Within the Workarea, sites appear under Ektron CMS400.NET’s
folder structure but the icon is a globe (see illustration below). So,
an author can create and edit content in the additional site the
same way he works with content in the root site.

Authors log into a root site then begin editing content in the
additional site. Regardless of which site he is using, an author can
use the library to insert hyperlinks, images, files, and quicklinks.
When a folder has a production domain assigned to it, it is a
domain folder. Links to content in a domain folder are activated via
linkit.aspx, which redirects to the appropriate domain name and
uses the appropriate template for the folder or content.
WARNING!

You cannot create a quicklink within content, a collection, menu, etc. to a form that
resides in another site.

Installing the Multi-Site Support Feature
There are three major steps to setting up each new site.
•

”Step 1: Create New Folders in the File System” on page 1000

•

”Step 2: Create New Sites in IIS” on page 1001

•

”Step 3: Assign Multi-Site Capabilities in Ektron CMS400.NET”
on page 1010
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Step 1: Create New Folders in the File System
1. Using Windows Explorer, navigate to the C:\Inetpub\wwwroot
folder.
2. Create a new folder for each site.

3. Copy the following CMS files and folders from the original CMS
site to your new multi-site folder.
•

all individual files (not subdirectories)

•

all .config files in all directories under the site root

•

these subdirectories
- bin
- WorkArea
- App_Code
- AssetManagement

4. Within each new site folder, open the web.config file and
update the ek_sitePath and WSPath elements with your CMS site
path.
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If your CMS site is in the Web site root, enter slash (/). If it is in
a subdirectory of the Web site, enter the subdirectory name.
For example, if your web site root is C:\inetpub\wwwroot and it
has a subdirectory called CMS400Min, enter CMS400Min as the site
path.

Step 2: Create New Sites in IIS
Follow these steps to create each new site in IIS.
1. Go to Start > Programs > Administrative Tools > Internet
Services Manager.
2. Right click the Web Sites folder and click New > Web Site.
3. A wizard screen appears. Click Next.
4. Enter a name for the new site.
5. On the IP Address and Port Settings screen, enter the IP
address of your new Web site or the host header. Press Next.
6. On the Web Site Home Directory screen, browse to the new
site’s folder. You created it in ”Step 1: Create New Folders in
the File System” on page 1000.
7. On the Web Site Access Permission screen, make sure that
Read and Write are checked.
8. You are notified that you have completed the new site.
9. Make the new site an application. To do this, right click the site,
and select Properties. Then, click the Home Directory tab.
Under Application Settings area, click the Create button then
click OK.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1001

Multi-Site Support

10. Set Execute permissions to Scripts only.

Create Virtual Folders in IIS
In IIS, for each new Web site, create one new virtual folder for the
following shared folders:
•

assets

•

privateassets

•

uploadedfiles

•

uploadedimages

These folders are created when you install Ektron CMS400.NET. If
you did a normal installation, they reside under the site directory.
For example, C:\Inetpub\wwwroot\your site root\uploadedimages.
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To create virtual versions of these folders, follow these steps.
•

”Creating Virtual Folders in IIS6” on page 1003

•

”Creating Virtual Folders in IIS7” on page 1005

Creating Virtual Folders in IIS6

1. In IIS, select the new site folder you created in ”Step 2: Create
New Sites in IIS” on page 1001.
2. Right click the mouse and select New > Virtual Directory.

3. Identify the corresponding subfolder in the root folder.
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4. Assign Read and Write permissions to the virtual directory.

5. Follow this procedure for all four folders: assets, privateassets,
uploadedfiles, uploadedimages.
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Creating Virtual Folders in IIS7

1. In IIS, select the new site folder you created in ”Step 2: Create
New Sites in IIS” on page 1001.
2. Right click the mouse and select Add Virtual Directory.

3. Identify the corresponding subfolder in the root folder.
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4. Follow this procedure for all four folders: assets, privateassets,
uploadedfiles, uploadedimages.

Set File System Permissions on New Folders
To do this, follow these steps:
1. Using Windows Explorer, navigate to the new folder(s) you
created in ”Step 1: Create New Folders in the File System” on
page 1000.
2. Right click the folder and click Properties.
3. Click the Security tab.
4. Click the Advanced button.
5. Click the check box next to Allow Inheritable Permissions
from the Parent to Propagate…
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Install the aspnet_isapi.dll File
Follow this procedure to install the aspnet_isapi.dll file for every
new site.
1. Open IIS.
2. Navigate to an Ektron CMS400.NET Web site.
3. Right click the site and select Properties.
4. On the Properties screen’s Home Directory tab, click the
Configuration button.
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5. The Application Configuration screen appears.
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6. In the Wildcard application maps area, click Insert.
7. The Application Extension Mapping screen appears.

8. Browse to
C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_isapi.dll.

9. Uncheck the Verify that file exists check box.
10. Click OK.
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Step 3: Assign Multi-Site Capabilities in Ektron CMS400.NET
1. In the Ektron CMS400.NET Workarea, click Content. Each site
folder must reside within the site root folder.
2. Create a new top-level site folder for each site by clicking New
> Site.
3. Assign site folder properties as you did for the root folder.
4. The Multi-site Configuration fields appear on the lower section
of the screen (illustrated below).
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5. In the Production Domain field, insert your domain.
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6. If you want library links to refer to the staging server domain, as
opposed to the production server domain, enter the staging
server domain in the Staging Domain field. See Also: ”Setting
up Staging Multi-sites” on page 1364
7. Save the screen.
Within Ektron CMS400.NET, the new domains are indicated by
a globe icon.
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Web Alert Feature

The Web Alert feature enables Ektron CMS400.NET to generate
email for a list of registered users whenever new content appears
on your site, or existing content is updated.
For example, anyone may register to be notified when new
information about your product is published. As soon as a page is
published on your site, registered users receive an email
announcement with a link to the new/updated page. The recipient
clicks the link to immediately access the page.
As a result, a self-selected group of users can be instantly notified
of changes on your Web site relating to their interests. Once the
system is set up, you don’t need to do anything -- everything
happens in the background.
NOTE

Only members of the Administrator User Group and users identified on the
Manage Members for Role: Folder User Admin screen can work with Web Alerts.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1013

Web Alert Feature

Sample Web Alert email

This chapter explains the Web Alerts feature through the following
topics.
•

”How Web Alert Works” on page 1015

•

”Server Configuration” on page 1016

•

”Enabling the Web Alert Feature” on page 1018
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•

”Setting Up the Message Queue and Asynchronous Processor”
on page 1019

•

”Creating the email Message” on page 1028

•

”Defining Subscriptions” on page 1035

•

”Assigning Web Alert Information to Folders and Content” on
page 1038

•

”How Users Sign up for Subscriptions” on page 1045

See Also: ”Using eSync with Web Alerts” on page 1365

How Web Alert Works
The following explains how Web Alert email works.
1. Content is published.
2. Ektron CMS400.NET checks the This is a staging server
checkbox on the Settings > Configuration > Application Setup
screen. If it is unchecked, proceed to the next step. If the box is
checked, no Web alerts will be issued for this server.
3. Ektron CMS400.NET checks to see if any subscriptions are
assigned to the folder or content. (Subscriptions can be
assigned at the folder or content level.)
If no subscriptions are assigned, the Web Alerts tab does not
appear when editing content.
4. If any subscription is assigned, Ektron CMS400.NET checks to
see if an email should be created for this content. The settings
appear under Web Alerts tab.
For example, some content only triggers an email when it is
first published, while other items always generate an email.
5. If an email should be generated, Ektron CMS400.NET builds the
email content by retrieving information from fields on the Folder
Properties screen. These are identified under the Web Alert
Contents section of the Web Alerts tab.
6. Ektron CMS400.NET determines which subscription lists should
receive the email. These are identified on the Available Web
Alerts area of the Web Alerts tab. Each list contains the email
address of every subscribed user.
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Server Configuration
The following illustration depicts a typical Web server configuration
you would use with the Web Alerts feature.

•

Firewall - the Ektron CMS400.NET business tier must have
Web access to the asynchronous server. The business tier
maintains the CMS files. This configuration enables proper
communication between Ektron CMS400.NET and the
asynchronous processor.
- The asynchronous processor must have port 25 (SMTP)
access to a valid mail server to send emails
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- The mail server (omitted from the illustration) must be allowed
to send out port 25 (SMTP) traffic and can be on the Async
server
•

Queuing - Message queuing must be installed on the Async
server.
You must create a message queue on the Async machine and
record its name. The message queue is specified in the
exe.config file for the service, and in the web.config file for the
Web Service interface.

•

CMS - The web.config file includes a key for the location of the
asynchronous processor. This needs to be verified as working.

•

Other - IIS must be installed on the asynchronous processor.
IIS allows a Web service call to schedule a file download and
send commands.
Ektron recommends that the Async machine only allow HTTP
traffic from Ektron CMS400.NET servers. This provides
additional security on the Async processor.

Verifying Connections
•

You can verify the Web service > queue connection by
- leaving the Ektron asynchronous processor service off,
submitting content with notifications, and verifying that a
message arrived in the queue
- turning on journaling for the queue. Submit a message in the
queue. The Ektron asynchronous processor service picks it
up and places it in the journaled messages.
- turning on logging for the Ektron asynchronous processor
service

•

To verify the CMS > Web service connection, open the
asynchronous processor location inside a Web browser and
test the Web services.
To verify the writing of files, ensure that Ektron CMS400.NET
has write access to the [sitepath]subscriptions directory and
submit content that will trigger notifications. This action places
a file inside that directory.

•

To verify that the Ektron asynchronous processor service can
download a file, open a Web browser on the Async machine
and connect to the location of the notification command files.
Attempt to download one.
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Enabling the Web Alert Feature
Enabling the Web Alert feature involves the following steps.This
section explains each step in detail
Step

Description

For more information, see

1.

Set up message queue
and asynchronous processor.

”Setting Up the Message Queue
and Asynchronous Processor”
on page 1019

2.

Create messages.

Define components of the email to be
sent to subscribers.

”Creating the email Message”
on page 1028

3.

Define subscriptions.

Categories of information on your site.
Site visitors can subscribe to be notified
when content in a category is added or
updated.

”Defining Subscriptions” on
page 1035

4.

Assign Web Alert
information to folders
and content.

Assign Web Alert information to folders
and content items which, when
published, trigger emails.

”Assigning Web Alert
Information to Folders and
Content” on page 1038

For each folder or content item to which
you assign subscriptions, determine

5.

Create and publish site
visitor registration
page.

•

activities that trigger emails (for
example, only upon initial publication
of content)

•

the content of the email

•

the subscription list(s) to whom the
email is sent

Create a new Web form and drop the
membership server control onto it. Then,
publish that form on your Web site.
Note: This task is typically done by a
developer.

6.

Site visitors subscribe
to lists of interest.

7.

CMS users can also
subscribe.

Someone signs up to be notified when
changes in a selected subscription
(category) are published on your Web
site.
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Step

Description

8.

Web content is either first published or
updated. If at least one subscription is
assigned to the content or its folder, email
is sent according to pre-defined criteria
for the folder.

Subscribers are
automatically notified
when content is
updated.

For more information, see

Setting Up the Message Queue and Asynchronous
Processor
After installing Ektron CMS400.NET version 5.1 or higher, you need
to set up the Microsoft Message Queuing and the Ektron
Asynchronous Processor. It is assumed that the following
directories and files are installed on your server:

NOTE

•

C:\Program
Files\Ektron\CMS400versionnumber\EktronAsyncProcessor_Service\

•

C:\inetpub\wwwroot\your site
root\bin\EktronAsyncProcessorWS.dll

•

C:\inetpub\wwwroot\your site
root\Workarea\webservices\EktronAsyncProcessorWS.asmx

If you need to move Web services file, use the Asynchronous Processor
Location field in the Configuration > Setup screen to specify the new folder
location.

1. On the server that hosts Ektron CMS400.NET, go to Control
Panel > Add/Remove programs > Add/Remove Windows
Components.
2. If it is not checked, check Message Queuing Services.
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NOTE

On Windows 2003, it is within the Application Server Components group.

3. If Message Queuing Services was checked when you viewed
it, go to step 4.
If it was not checked, click Next. A wizard creates the
component.
NOTE

The rest of this procedure employs a wizard that saves you several manual steps.
If you have a problem using the wizard, or prefer to install Web Alerts manually so
you can track the files being installed to your server, see ”Manual Steps for
Setting up the Message Queue and Asynchronous Processor” on page 1025.

4. From the Windows Start Menu, click All Programs > Ektron >
CMS400 > Utilities > Web Alerts Setup.
5. The Web Alert Wizard setup screen appears.
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6. Press Next. The wizard begins installing the Web Alerts
feature.
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7. The following screen appears.
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8. Enter the username and password that will be used to send
and receive email.
9. At the Log File Name field, enter the name of the file that will
track Web Alert activities. If you enter nothing, the file is named
listener.log.
The file resides in the C:\Program
Files\Ektron\CMS400versionnumber\EktronAsyncProcessor_Service

folder. It is also available from the Workarea. See
”Asynchronous Log File Reporting” on page 1027.
10. If you want a very detailed log file, click Logfile Verbose.
11. Press Next. The following screen appears.
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12. Either insert or browse to the folder that contains your
web.config file. This is your site root folder. Then press Next.
13. If your Asynchronous Processor service is not running, the
following message appears.

14. If you see this message, press OK then click Finish.
15. Go to Control Panel > Administrative Tools > Computer
Management > Services and Applications > Services. Start
the Ektron Async Processor Service.
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Manual Steps for Setting up the Message Queue and Asynchronous
Processor
This section describes manual steps for setting up the Message
Queue and Asynchronous Processor. You can use this procedure
if you had a problem using the wizard, or you want to know which
files are being installed to your server.
1. Go to Control Panel > Administrative Tools > Computer
Management > Services and Applications > Message
Queuing.
2. Right click the Private Queues folder and select New > Private
Queue.

3. Create a private queue named msmq_web.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1025

Web Alert Feature

4. Right click msmq_web and select Properties.

5. Go to the Security tab. You can give the Everyone group Full
Control if you are in a testing environment. If you are on a
production server or want better security, give the local system
account (the account which the EktronAsyncProcessor Service
runs as) the following permissions:
•Delete
•Receive Message
•Peek Message
•Send Message
Give the ASP.NET account (the account that the Web services
interface runs as) Send Message permission.
6. Click OK.
7. Open the following file:
C:\Program
Files\Ektron\CMS400v52\EktronAsyncProcessor_Service\RegEktron.S
ervices.EktronAsyncProcessor.bat

8. Review and update as necessary the paths to the .NET
directory and Ektron.Services.EktronAsyncProcessor.exe file.
WARNING!

Update the paths to the .NET Directory and the .exe file if necessary.

9. Execute the .bat file.
Or, from a command line or Start Menu > Run, enter:
C:\Windows\Microsoft.NET\Framework\v2.0.50727\installutil

“C:\program
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Files\Ektron\CMS400v75\EktronAsyncProcessor_Service\Ektron.Serv
ices.EktronAsyncProcessor.exe”

10. Open the following file and enter your SMTP connection
settings: C:\Program
Files\Ektron\CMS400v75\EktronAsyncProcessor_Service\Ektron.Serv
ices.EktronAsyncProcessor.exe.config.

11. Go to Control Panel > Administrative Tools > Computer
Management > Services and Applications > Services. Start
the Ektron Async Processor Service.

Asynchronous Log File Reporting
Once the Message Queuing and Asynchronous Process are set up
and running, you can access a log report about the Asynchronous
process. This report shows any problems with the Asynchronous
Processor.
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In addition to viewing the report, you can email it to any
CMS400.NET user. See ”emailing Reports” on page 154.
To access the Asynchronous Process log, follow these steps.
1. In the Workarea’s Smart Desktop, click the Reports folder.
2. Click the Asynchronous Log File link.
3. Any problems appear on the screen.

Creating the email Message
This section has the following topics.
•

”Predefining Message Components” on page 1028

•

”Combining Message Components to Create the Message” on
page 1032

•

”Previewing the email Message” on page 1033

Predefining Message Components
Before you can create an email message, define the following
information.
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•

default message text

•

opt out message

•

unsubscribe message

•

“from” address

You can define as many as you want of each item. You must,
however, define at least one opt-out message, unsubscribe
message, and “from” address to use the Web Alert feature.
These message components are later inserted into an email
message that is sent to your subscribers. See Also: ”Creating the
email Message” on page 1028

Creating Default Message Text
You can create one or more default messages to contain the text of
the email. A simple editor lets you apply some XHTML formatting
the message.
Including Variables in the Default Message
The default message can include variables that retrieve
information about the content and display it in the message text.
The variables are surrounded by at signs (@). For example
The following content was recently updated: @AppContentLink@

In the email, this text might read:
The following content was recently updated: The Effect of Coumadin
on Cardiac Patients

You can use the following variables in the body of a Web Alert
message.

Variable

Displays this information in the email

@appContentTitle@

The title of the content block.

@appCRLF@

A carriage return. Moves the text down one line.
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Variable

Displays this information in the email

@appContentLink@

The link to the content block on the Web site.
Note: You must be logged in to see the changes.

@appContentURL@

The URL of the content, from the quicklink and domain.

@appSubscriptionNames@

Comma separated list of subscriptions that a user
selected.

@appComment@

The comments for the content block.

@appSubmitterFirstName@

The first name of the user who submitted the content
block.

@appSubmitterLastName@

The last name of the user who submitted the content
block.

To create default message text, follow these steps.
1. In the Workarea, go to Settings > Configuration > Web
Alerts > Messages.
2. Click the Add button (

).

3. Enter a title that describes the message.
4. At the Type field, select DefaultMessage.
5. In the editor, enter the message text.
6. Click the Save button (

).

Creating Opt Out Message Text
An Opt-Out message appears as the first line of every email. It
directs the reader to the Unsubscribe message at the bottom. Here
is an example:
You have subscribed to receive alerts from the Ektron CMS400.NET
email alert system. See below for removal instructions.

You can add variables to the Opt Out text. See Also: ”Including
Variables in the Default Message” on page 1029
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To create Opt-Out message text, follow these steps.
1. Go to Settings > Configuration > Web Alerts > Messages.
2. Click the Add button (

).

3. Enter a title that describes the Opt-Out message.
4. At the Type field, select OptOut.
5. In the editor, enter the message text.
6. Click the Save button (

).

Creating Unsubscribe Message Text
An Unsubscribe message lets the person receiving the email
remove himself from the subscription list.
You can add variables to the Unsubscribe text. See Also:
”Including Variables in the Default Message” on page 1029
To create Unsubscribe message text, follow these steps.
1. Go to Settings > Configuration > Web Alerts > Messages.
2. Click the Add email Message button (

).

3. Enter a title that describes the Unsubscribe message.
4. At the Type field, select Unsubscribe.
5. In the editor, enter the message text.
6. Click the Save button (

).

Creating “From” Addresses

Any email generated by the Web Alert feature must have a “from”
address. To create one or more “from” addresses, follow these
steps.
1. Go to Settings > Configuration > Web Alerts > Email From
List.
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2. Click the Add email From Address button (

).

3. Enter an email address that will be used in the From field of
messages generated by the Web Alert feature.
4. Click the Save button (

).

Combining Message Components to Create the Message
You create the content of an email message by configuring the
following components. Some are required. Then, when content is
published, Ektron CMS400.NET retrieves the field values to create
the email Web Alert.
NOTE

To set or modify this information, you must have permission to edit the folder.

Component

Comment

Required?

1.

Subject line

Plain text you enter on the Web Alerts tab of the Folder
Properties screen

No

2.

From address

See ”Creating “From” Addresses” on page 1031

Yes

3.

Opt out message

See ”Creating Opt Out Message Text” on page 1030

Yes

4.

Default message

See ”Creating Default Message Text” on page 1029

No

5.

Content Summary

The Summary of the content item whose creation or
change generates the email.

No

Note: The Summary can include variables that retrieve
information about the content item. See ”Including
Variables in the Default Message” on page 1029
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Component

Comment

Required?

6.

Identify CMS content to include within the email content.

No

Any CMS content
item

•

To identify an existing content item, click Select
next to the Use Content checkbox. Then, navigate
to the content item.

Note: If the content item is an Office document or a
managed file, a link to that item appears within the email
message, not the item itself.
•

To insert this content item (that is, the one whose
creation or change triggers this Web Alert), click
Use Current.

•

To create a new content block to insert into this
message, click Select next to the Use Content
checkbox. When the folder navigation window
appears, click the Add Content button (
see ”Adding HTML Content” on page 80.

7.

Unsubscribe
message

See ”Creating Unsubscribe Message Text” on
page 1031

). Then,

Yes

The elements appear within the email in the sequence shown
above.

Previewing the email Message
You can preview the email message at any time by clicking the
preview button, which appears to the right of the Web Alert
Contents: label on the Web Alerts tab (see below).
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The button appears on the Web Alerts tab for folders as well as
content.
When you click the preview button, a new window displays the
body of the email message. (The components used in an email
message are listed in ”Combining Message Components to Create
the Message” on page 1032.)
After previewing the message, you can change any message
components and click the button again to review the updated
message. You don’t need to save or check in the content to update
the preview.
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Defining Subscriptions
Create a subscription for each type of information site visitors
might want to be notified about. For example, if your site sells
electronics, you could set up one subscription for televisions,
another for computers, and a third for stereo equipment. Site
visitors can then subscribe to appropriate areas of interest.
CMS and membership users can also sign up for subscriptions.
To create one or more subscriptions, follow these steps.
1. Go to Settings > Configuration > Web Alerts >
Subscriptions.
2. Click the Add Subscription button (shown below).

3. Enter a name for the subscription. The name should indicate
the kind of information that it will cover.
4. Use the Enabled check box to indicate if the subscription is
currently active.
5. Press the Save button (

).

Effect on Custom User Properties
When you create the first subscription, a new entry is automatically
created in the Custom User Properties screen. By default, its name
is Subscriptions, and its type is Category. This occurs because
all custom user properties appear on the Site Visitor Registration
screen. In this way, users visiting that page can select areas of
interest about which to be notified when content is updated.
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The default name (Subscriptions) appears on the Site Visitor
Registration screen. You may want to change it to something more
helpful, such as Select Areas of Interest. To do this, select the
Subscriptions entry and edit the Label field in the Custom User
Properties screen.
The following graphic illustrates the relationship among the
Subscriptions, Custom Properties, and Site Visitor Registration
screens.
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If you add more subscriptions later, they have no effect on the
Subscriptions entry in the Custom User Properties screen -- that
single entry covers all subscriptions.

Using Subscriptions in a Multi-Language System
When you create a subscription, a version of it is created for every
enabled language in your system. You can edit the subscription
name and Enabled values for any language but the ID number
cannot be changed.

To translate any subscription, follow these steps.
1. Go to Settings > Configuration > Subscriptions.
2. From the View Languages dropdown list, select the language
into which you want to translate the subscription.
3. Click the subscription that you want to translate.
4. Click the Edit button (

).

5. Enter the translation for the subscription name. If desired, you
can check or uncheck the Enabled checkbox. Only enabled
subscriptions appear on the Site Visitor Registration screen.
6. Click the Save button (

).
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Assigning Web Alert Information to Folders and
Content
After creating predefined messages (as explained in ”Predefining
Message Components” on page 1028) and subscriptions (as
explained in ”Defining Subscriptions” on page 1035), you need to
identify which folders include content that, when updated, trigger a
Web Alert. For example, new product announcements are placed
in the Marketing folder.
NOTE

In order to set or modify Web Alert information, you must have permission to edit
the folder.

For each folder, you can assign the following kinds of message
information.
•

whether Web Alert information is inherited from a parent folder
or customized

•

whether a folder’s Web Alert information is inherited by all
content items in the folder

•

when email is sent: always, only on initial publication, or never

•

the content of the Web Alert email

•

the subscriptions assigned to the folder. These determine
which recipients receive email when content in this folder is
created or updated.

Customizing Web Alert Information for a Folder
Like other folder-level information in Ektron CMS400.NET, Web
Alert information is inherited from a parent folder. By default, all
folders inherit these settings from the root (Content) folder.
However, inheritance can be broken and customized at any folder
level or even the content level. Breaking inheritance means that
custom settings can be made at any folder level. Subsequent
changes to Web Alert settings at the parent level are ignored.
See Also: ”Assigning Web Alert Information to Content” on
page 1042
To view, enter, or modify folder-level Web Alert information, follow
these steps.
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1. Navigate to the folder whose Web Alert information you want to
edit.
2. Click View > Folder Properties.
3. Click the Web Alerts tab.
4. Scroll down to view the Web Alert options.
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5. To change any value, click the Edit Properties button (

).

6. The following table describes the fields.
Web Alert Fields

Field

Description

Group
Web Alert Settings:
Break Inheritance

To inherit Web Alert settings (described below) from this folder’s
parent folder, leave this box (Break Inheritance) empty.
To assign custom Web Alert settings for this folder, check this box
and use the fields below to customize the settings.

Web Alert Options

Check when Web Alert emails are sent as content in this folder is
published.
•

Notify Always - send email whenever any content is published.
It doesn’t matter if the content is being published for the first
time or being updated.

•

Notify only on Initial Publication - send email the first time
content is published. After that, email is not sent.

•

Notify Never - email is never sent for content in this folder.

Web Alert Subject

Enter the subject line of the email.

Web Alert email From Address

Select the address of the person from whom the email will be sent.
See Also: ”Creating “From” Addresses” on page 1031

Web Alert Contents

Check any or all of the following components to determine the text of
the email. See Also: ”Combining Message Components to Create
the Message” on page 1032
•

OptOut Message - see ”Creating Opt Out Message Text” on
page 1030

•

Use Default message - see ”Creating Default Message Text” on
page 1029

•

Use Summary - include the content summary in the email

•

Use Content - see ”Any CMS content item” on page 1033

•

Unsubscribe message - See ”Creating Unsubscribe Message
Text” on page 1031

The components appears within the email in the order listed above.
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Field

Description

Group
Available Web Alerts

All enabled subscriptions set up in the Subscriptions screen appear.
Check those to be notified when content in this folder is added or
updated.
See Also: ”Defining Subscriptions” on page 1035
Note: If you uncheck all subscriptions, you disable the Web Alert
feature for this folder and all of its content. This applies even if
unique subscription information has been assigned to content items
within the folder.

Assigning Web Alert Information to Content
You can customize Web Alert settings for any content item. If you
do, you break the inheritance from its folder. This means that any
subsequent changes to the folder settings do not affect the
content’s Web Alert settings. From then on, its settings are
independent of the folder’s settings.
See Also: ”Web Alert Feature” on page 1013
EXCEPTION!

If all subscriptions are unchecked for a folder, the Web Alert feature is disabled for
all content in the folder. This applies even if unique Web Alert information has
been assigned to content.

To customize the Web Alert settings for any content item, follow
these steps.
1. Navigate to the folder that contains the content.
2. Click the content. The View Content screen appears.
3. Click the Edit button (

).

4. Click the Web Alerts tab.
NOTE

The Web Alerts tab only appears if required messages, “from” email addresses,
and at least one subscription are assigned to the content’s folder.

5. The Web Alert settings for the content appear.
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The following table describes the settings.
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Field

Description

Group
Web Alert Options

Check when Web Alert emails are sent as this content is published.
•

Notify Always - send email whenever content is published. It
doesn’t matter if the content is being published for the first time
or being updated.

•

Suspend Next Notification (override) - Check this box if you
want to suspend the next email to be sent for this content. You
might use this feature is you notice a small error in the content
and don’t want to notify all subscribers that the page was
updated.
Important! - This setting only applies until the next time this
content is published. When that happens, this box is
automatically unchecked.

•

Notify only on Initial Publication - send email the first time
content is published. After that, email is not sent.

•

Send Next Notification (override) - Send an email to all subscribers the next time this content is published. Use this checkbox to send a one-time mailing to all subscribers about content
that has already been published.
Important! - This setting only applies until the next time this
content is published. When that happens, this box is
automatically unchecked.

•

Notify Never - email is never sent when content in this folder is
published.

Web Alert Subject

Same as for a content folder. See ”Web Alert Subject” on page 1041

Web Alert email From Address

Same as for a content folder. See ”Web Alert email From Address”
on page 1041

Web Alert Contents

Same as for a content folder. See ”Web Alert Contents” on
page 1041

Available Web Alerts

Only Web Alerts assigned to the folder appear. Check ones that you
want to assign to this content item. For more information, see
”Available Web Alerts” on page 1042.
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Inheriting Content-Level Web Alert Information from Its Folder
If you customized Web Alert information for content items and later
decide to standardize that information for all content in a folder, use
the Restore Web Alert Inheritance toolbar button (

).

This button copies folder-level Web Alert information to every
content item in the folder, replacing whatever content-level
information exists. In this way, all content in a folder will have the
same Web Alert information.

How Content that is Dragged and Dropped is Handled
Web Alert emails are not generated for files that are dragged and
dropped into Ektron CMS400.NET and immediately published. To
generate email for these files, you must manually publish them.
Like HTML content, these files must reside in a folder for which the
Web Alert feature is enabled.

How Users Sign up for Subscriptions
Once subscriptions are set up, you create a page on your Web site
to let site visitors subscribe to areas of interest. An example of that
page is below.
NOTE

The email address collected on the screen is used for the membership Username
field.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1045

Web Alert Feature

To place this form on a Web page, your developer inserts a
Membership Server Control. For more information, see the Ektron
CMS400.NET Developer Manual chapter “Introduction to Ektron
CMS400.NET Server Controls” > ”Membership Server Control.”
Any user who subscribes via the above screen becomes an Ektron
CMS400.NET membership user, and is automatically added to the
All Members user group. For more information, see ”Membership
Users and Groups” on page 727.
What happens next depends on the Enable Verify email check
box in the Application Setup screen (shown below).

•

”What Happens if Verification email is Not Used” on page 1047

•

”What Happens if Verification email is Used” on page 1047

•

”Setting up Other Web Pages for Site Visitor” on page 1049

•

”CMS User Subscription Sign Up” on page 1050

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1046

Web Alert Feature

What Happens if Verification email is Not Used
If the Enable Verify email checkbox is not checked, everyone who
signs up automatically becomes a membership user.

What Happens if Verification email is Used
WARNING!

When using the Checkout Server Control on an eCommerce site, the Enable
Verify Email setting must be unchecked. Otherwise, new users will receive an
error message when they sign-up using this control. For information on the
Checkout Server Control, see the “eCommerce” > “Checkout Server Control”
section in the CMS400.NET Developer Reference Manual

Typically, when managing a self-subscribe list, you want new users
to confirm their interest in being on the list. This prevents people
from being subscribed by someone else without their permission.
If the Enable Verify email checkbox is checked, everyone who
signs up is placed on the Users Not Verified list. (To see this list, go
to Workarea > Modules > Community Management >
Memberships > Users Not Verified.)
These people then receive an email. You define the content of this
email in Workarea > Modules > Community Management >
Messages. The email should direct the unverified user to a new
Web page that asks him to confirm his interest in signing up for the
subscription. (See ”The Verification Message” on page 1047.) New
users are activated when the subscriber confirms his interest.
To create such a page, your Web developer creates or updates a
Web Form using the Membership Server Control. For this purpose,
set the control’s DisplayMode property to AccountActivate.
NOTE

Users can also be manually activated or removed via the View Not Verified Users
screen. For more information, see ”The View Not Verified Users Screen” on
page 1048.

The Verification Message
By default, Ektron CMS400.NET supplies a generic message asking
the user to confirm his password and directing him to the
acitvatemyaccount.aspx page on your Web site. If you want to
customize that message, follow these steps.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1047

Web Alert Feature

1. Go to Workarea > Modules > Community Management >
Messages.
2. Click the Add button (

).

3. Assign a title to the message, such as Verification Message.
4. Click to place a check mark in the Default box.
5. Enter the text of the confirmation message you want the
subscriber to receive. Be sure to place the @appQueryLink@
variable in the message to create a link to the confirmation
page. For example:
Welcome to example.com. You have registered to be notified of
updates to our site.
Before we can do this, you need to activate your account. To do so,
please visit @appQueryLink@.

The @appQueryLink@ variable places a link in the message that
gets resolved as follows:
http://sitepath/workarea/activateuser.aspx?uid=[username]&acc=[accountID]

For example:
http://www.example.com/Workarea/activateuser.aspx?uid=john.edit@example.com&acc=ce5w84o936477

If you want the message to include the user’s name and email
address, use the following variables to retrieve that
information:
•name - @appEmail@
•email address - @appActivateId@
For example:
Your user name is @appEmail@.
Your account id is @appActivateId@

The View Not Verified Users Screen
All users who have signed up for a subscription but who have not
yet verified that subscription appear on the View Not Verified Users
Screen. This screen is available via Modules > Community
Management > Memberships > Users not Verified.
After viewing membership users on the screen, you can manually
activate their account. To do so, selecting one or more users then
click the Activate button (

). Alternatively, you can delete
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members by selecting one or more and clicking the Delete button
(
NOTE

).

The ek_PageSize setting in the web.config file determines the maximum number
of users that can appear on a page before it “breaks.” When a page breaks,
additional entries appear on another screen, and the following text appears near
the bottom of the list:
Page 1 of 2
[First Page] [Previous Page] [Next Page] [Last Page]

To select all members, click the check box in the header line, next
to Username (circled below).

You can also change the way membership users are sorted, or use
the Search button to find users that match your criteria (for
example, users whose username includes example.com.) These
features are explained in ”Sorting Membership Users” on page 734
and ”Searching for Membership Users” on page 734.

Setting up Other Web Pages for Site Visitor
You can set up other Web pages that let the subscriber perform the
following actions:
•

Activate their account

•

Reset their password

•

Unsubscribe

To create these pages on your web site, place the membership
server control on the page. Then use the control’s DisplayMode
property to determine the kind of screen you want to place. For
example, to create a screen that lets the user reset his password,
set the Membership server control’s DisplayMode property to
ResetPassword.
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For more information, see the documentation for the Membership
server control in the Ektron CMS400.NET Developer’s Manual.

CMS User Subscription Sign Up
CMS users can also subscribe to any subscription list. This would
be particularly useful on an intranet where, for example,
employees are notified when job-related information is updated.
Another example would be for your internet site. The manager of
the Marketing Department could sign up to be notified whenever
Marketing content is added or updated.
To do so, users go to Settings > User Profile > Edit User (see
illustration).
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Ektron CMS400.NET provides a Windows Service to handle
background processing functions. This section explains the
service, including

•

the CMS functions it performs

•

how it propagates updates to the connection string and site
path

•

where it resides in IIS and the file system

•

its activity log

Functions Performed by the Ektron Windows
Service
The Ektron Windows Service performs the following processes.
•

”XML Indexing” on page 203

•

”Load Balancing Assets” on page 1062

•

”PDF Generation” on page 319

•

”Bad Links Report” on page 172

•

Publication of content scheduled to go live at a future time,
and removal of content scheduled to expire. See Ektron
CMS400.NET User Manual section “Scheduling Content to
Begin and End”

•

When a new metadata definition is created, the Windows
service applies it to all content in the CMS database.
However, the metadata definition is only activated for the
content when it is enabled for the content’s folder. See Also:
”Metadata” on page 118

In addition, the Ektron Windows Service propagates updates
made to the database connection string or the site path in the
web.config file. The service copies the new value to the
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data.config and sitedb.config files (respectively). These are located
in C:\Program Files\Ektron\EktronWindowsservice30. Any CMS
components that reference these values can retrieve the current
information from these files.
IMPORTANT!

Do not edit the data.config and sitedb.config files. They are dynamically
generated by Ektron CMS400.NET. If these files have incorrect values, edit the
web.config file, which is used to generate them.

Changing the Update Time
The update of the data.config and sitedb.config files occurs once a
day at a time prescribed in the C:\Program
Files\Ektron\EktronWindowsservice30\Ektron.ASM.EktronServices.exe.c
onfig

file’s updateTime value. If desired, you can change this time.

Changing the Name of the data.config File
If your server already has a file named data.config, and you want
to change the name of the one in C:\Program
Files\Ektron\EktronWindowsservice30 to avoid confusion, follow these
steps.
1. Open Ektron.ASM.EktronServices.exe.config.
2. Find this line: <connectionStrings

configSource="data.config"/>.

3. Replace data.config with the new file name. For example:
<connectionStrings configSource="Ektron_data.config" />

4. Save Ektron.ASM.EktronServices.exe.config.

Changing the http Port
If your Web site is already using port 6060, follow these steps to
change the port number used by the Ektron Windows Web
Service.
1. Open Ektron.ASM.EktronServices.exe.config.
2. Find this line: <add

key="HttpServicePort" value="6060"/>.

3. Change the value to the port number you will use for the Ektron
Windows Service.
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Disabling PDF Generation
By default, PDF generation is enabled. If you want to disable it
within the Ektron Windows Services configuration file, follow these
steps.
1. On the server to which you installed Ektron CMS400.NET, open
C:\Program Files\Ektron\EktronWindowsservice30.
2. Open Ektron.ASM.EktronServices30.exe.config.
3. Find this line:
<add name="PdfFileRead"
type="Ektron.ASM.EktronServices.PdfFileManagerRead.PdfFileManagerReadService,
Ektron.ASM.EktronServices20" IntervalSeconds="101" Enabled="true" />

4. Set enabled to false.

Viewing the Ektron Windows Service
Viewing in IIS
The Windows Service starts automatically when Ektron
CMS400.NET is installed, and again whenever the server is
restarted.
1. To see the status of the service, go to Computer Management
> Services and Applications > Services.
2. Look for Ektron Windows Services. You can see its status in
the Status column.
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The Activity Log
The service has an Activity Log, which tracks all related events. To
see it, go to Computer Management > System Tools > Event
Viewer > Ektron Log.
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To view detail for any event, double click it.
A common source of errors is that the service cannot find Ektron
CMS400.NET sites, because they have not been created yet, as
shown in the sample below.
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Viewing in the File System
On your file system, the Ektron Windows Service is located in
C:\Program Files\Ektron\EktronWindowsservice30. Within that folder,
the Ektron.ASM.EktronServices.exe.config file runs the Ektron
Windows service.
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NOTE

This section explains how to move individual content items and assets
between staging and production servers. If you want to move an entire Web
site, use Ektron CMS400.NET’s eSync feature. It is documented in ”Using
eSync” on page 1295.

This section explains how to set up a virtual staging and
production server configuration. As you can see below, it
consists of two physical servers, with the production server
outside Ektron CMS400.NET’s Load Balancing feature moves
the content and assets from staging to production.

After you set this up, content contributors create, test, and
modify content on the staging server. Preview Mode lets
everyone view and modify proposed changes on the staging
server. No editing is done on the Production server, which is
typically located outside the firewall.
Ektron CMS400.NET lets you control the approval process.

Once content is approved, the Load Balancing software moves
it to the production server, where it is immediately available to
site visitors.
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NOTE

Load Balancing pushes a copy of every content item and asset to the production
server. However, content on production only becomes visible to site visitors after it
is approved.

The advantages of using a Virtual Staging configuration are
•

simplicity of maintaining content

•

ability to preview before content is published

•

instant publishing to production

•

approvals to community data

•

staging and production servers share one database

•

as library items and assets are updated on the staging server,
Load Balancing automatically pushes the changes to the
production server
At the same time, the following information collected on the
production server is updated on the staging server:
- new Blog and Discussion Forum comments
- Poll/survey results
- site analytic information
- assets
- content rating data

Setting up a Virtual Staging Configuration
Miscellaneous Considerations
•

Login Control - For Ektron CMS400.NET users, editors and
approvers, place a login control only on pages that reside on
the staging server. This prevents the creation or editing of
content on the production server.
Only membership users should be allowed to log in to the
production server.

•

Content Analytics – disable this feature in the staging server’s
web.config file. (See ”Enabling the Content Analytics Feature”
on page 926.) If you do not, your usage statistics may be
skewed.
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•

Configure Web Alerts on the production server only. When
member users receive Web alerts, the link should point to the
production server. See ”Setting Up the Message Queue and
Asynchronous Processor” on page 1019 .

•

If you haven’t already done so, set up workflow permissions
for folders on the staging server. See ”Setting Approval Chains”
on page 778 and ”Setting Permissions” on page 768.

Set Up Instructions
Prerequisite:Ektron CMS400.NET Version 7.5 or higher is installed
on both servers
1. Install a minimal site on the staging server. During installation,
create a database.
2. Install a minimal site on the production server. Do not create a
database on the production server.
3. Set up database security that will allow the two servers to read
and write to each other.
4. Open the web.config file for both sites.
- in the staging server’s web.config file, copy the section
beginning and ending with <connectionStrings>
<connectionStrings>
<!--FOR SQLSERVER-->
<add name="Ektron.DbConnection" providerName="System.Data.SqlClient"
connectionString="server=WS10080;database=virtual_test;Integrated Security=False;user=abc;pwd=xyz;" />

</connectionStrings>

- in the production server’s web.config file, replace the
<connectionStrings> tag with the information copied from the
staging server
As a result, both sites reference the same database.
5. Set up library load balancing. See ”Load Balancing Library
Images and Files” on page 1060. This will ensure that, as items
are added or changed in the library on the staging server, they
are also added to the production server’s library and vice
versa.
6. Set up load balancing for your assets. See ”Load Balancing
Assets” on page 1062. This will ensure that, as assets are
added or changed in Ektron CMS400.NET on the staging server,
they are also updated on the production server and vice versa.
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Load Balancing has two purposes:
•

Provides redundancy for your Web site - if one server fails,
a second can still handle requests

•

Balances requests - distributes requests across multiple
servers

To enable load balancing, set up several servers that include
the same files. Then, purchase load balancing equipment to
evenly distribute content requests among the servers.
Whenever an image or file gets uploaded to your Web site,
regardless of the Web server the user is working on, the asset
is replicated on both servers.
The client browser is unaware that more than one server is
involved. All URLs point to a single Web site. The load balance
software resolves them.
Ektron provides different strategies for load balancing library
images and files and DMS assets. See
•

”Load Balancing Library Images and Files” on page 1060

•

”Load Balancing Assets” on page 1062

See Also: ”eSync in a Load Balanced Environment” on
page 1351

Load Balancing Library Images and Files
Library load balancing is important when your configuration
consists of two or more Web sites that share a single database.
Library files are not saved in the database but in the site root
folders uploadedfiles and uploadedimages.
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To support load balancing, the library files on all servers must be
identical. To maintain this state, whenever a user uploads an item
to the library, it must be replicated on all other servers. After
following the setup instructions, any image or file added to the
library of one server will be copied to the corresponding folder on
the other servers in the configuration.

Setting up Library Load Balancing
Step 1. Update Assetmanagement.config
1. On the first server in the configuration, open the siteroot/
AssetManagement.config file.
2. Find the LoadBalanced property.
3. Set the value to 1.
4. Repeat this step for all other servers in the configuration.

Step 2. Update the Ektron Windows Service File
1. Open C:\Program

Files\Ektron\EktronWindowsService30.

2. Open Ektron.ASM.EktronServices30.exe.config.
3. Find the LoadBalanced property.
4. Set the value to 1.
5. Find the LibraryLoadBalanced property.
6. Set the value to 1.
7. Find the LoadBalServerCount property.
8. Set to the number of servers in your load balance cluster.
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Step 3. Restart the Ektron Windows Service

See Also: ”Ektron Windows Service” on page 1051

Load Balancing Assets
Ektron CMS400.NET lets you balance requests to view or work with

assets among two or more servers. To achieve this, each server
has its own copy of every asset.
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To accomplish this, Ektron CMS400.NET initially stores every new
asset in the database. An Ektron service constantly checks to see
if all database assets also exist on each server’s file system. To
learn about this service, see ”Ektron Windows Service” on
page 1051.
If an asset does not exist on any server in the cluster, it is copied
from the database to the server’s file system. Once there, the
asset is available for requests to work with it. After an asset is
copied to all servers, Ektron CMS400.NET removes it from the
database.
There is no limit to the number of servers or databases that can be
load balanced.
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Setting up Asset Load Balancing
To set up load balancing for assets, follow these steps on both the
staging and production server.
1. Within the site root folder, open the AssetManagement.config
file. Change the value of the LoadBalanced element to 1.
2. Open the following file using a word processor such as
Notepad
C:\Program Files\Ektron\EktronWindowsservice30\Ektron.ASM.EktronServices30.exe.config

3. Find the following tag: <add
Change the value to 1.

key="LoadBalanced" value="0" />.

4. Find the following tag <add key="LoadBalServerCount" value="2"/>.
Make sure the value is set to the number of servers in your
load balance cluster. This number must be the same for all
servers in the cluster.
5. After updating these files for each server in the load balance
cluster, sign on to Ektron CMS400.NET. This action sets up the
load balance software in the database.
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Web Services are reusable software components that can be
consumed over the Web by means of standard Internet
technologies. Mechanisms exist to publish and discover Web
Services on the Web, allowing users to locate and integrate
them into their applications.
A Web Service is comprised of one or more methods that
expose functionality. A Web Service can be thought of as an
Application Program(ming) Interface (API), the one big
difference being, consumers can access the service using
Simple Object Access Protocol (SOAP) over HTTP.
SOAP is an XML based lightweight protocol that defines the
message format for Web Services, which allows
heterogeneous systems to communicate with each other in a
standard way. Seeing Web Services are based on ubiquitous
technologies, they have been quickly accepted for the
interchange of data.
For information about implementing Ektron CMS400.NET’s
Web services support for your Web site, refer to Web Services
in the Ektron CMS400.NET Developer’s Reference Manual.
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Configuring SMTP Server
For information about configuring Microsoft’s SMTP service for
your Ektron CMS400.NET Web server, please refer to Configuring
Email Notifications, in the Ektron CMS400.NET Setup Manual.

Automatic eMail Notification
Ektron CMS400.NET has an automated email system that sends
emails to the proper users when an action has been, or needs to
be, performed. Emails are generated when any of the following
actions takes place.
email sent to

When content is

Next approver

Submitted to be published

Next approver

Submitted to be deleted

Author

Published to Web site

Author

Declined to be published or deleted

In order for users to be notified of these actions, the following
criteria must be met:
•

Valid system email address

•

Enabled email notification

•

User email address

•

User email notification enabled

These values are set in the Edit User screen. See Also: ”Managing
Users” on page 713
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The Tasks feature also has automatic email notification. For more
information, see ”Email Notification” on page 385.

Content of Automatic email
The automatic emails are stored in and received from the
database. Each email consists of one string for the subject and one
for the body. Ektron CMS400.NET does not currently support HTML
emails, but the messages are fully customizable. To learn about
customizing them, see Customizing Ektron CMS400.NET emails in
the Ektron CMS400.NET Setup Manual.

Instant eMail
In addition to automatic email, Ektron CMS400.NET lets you send
email instantly to a user or user group from many screens. Your
ability to send instant mail is indicated by either
•

a small mail icon next to a user or group name, as indicated in
red below

•

a small mail icon on the toolbar (see second image below)
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When you click such a user/group name or email icon, the email
screen appears, as shown below. Once you complete the screen
and click Send, an email is sent to designated users.

Conditions for Instant eMail
•

The user who is using Ektron CMS400.NET must have a valid
from email address set up in the user profile. If not, email icons
do not appear in Ektron CMS400.NET.
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•

The email software must be configured for your server. See
”Configuring SMTP Server” on page 1066

Where Instant email is Available
Instant email is available from several screens that display users
and user groups. Typically, you click a user name or the email icon
to launch an email. Screens in the following Ektron CMS400.NET
features support instant email.
•

Smart Desktop

•

Tasks

•

Approvals

•

Reports

•

User and user group setup

Wherever instant email is available, an email icon appears (circled
in the illustration below).
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Modifying Instant eMail
When the email screen appears, the following information is
copied from Ektron CMS400.NET into the email.
Field

Source of Default Information

Editable?

To

User you selected to receive the email. If the user does
not have valid email address, an error message
appears. If you then insert a valid email address, the
email is sent.

Yes.

If you specify a group to receive the message, as long
as one group member has a valid email address, all
group members with valid addresses receive the email.

If desired, you
can add
recipients by
typing them
into this field.

From

User who signed on to Ek tr on CMS 400 .NET .

No

Subject

If the email message is linked to content, its title
appears.

Yes

The screen section below provides an example of
content (Trinity In-Line Pipe) that is linked to a
message.

Body of
message

If the email message is linked to content, a link to the
content appears.
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As an administrator, you can add, edit, and delete fonts to and from
the Ektron CMS400.NET application. By adding fonts, you are
allowing the content contributors to use them when creating
content. Administrators can also edit the name of a font, and delete
a font from the system.
Minimizing the number of available fonts makes the Web site look
more uniform.
Below is the Font Manager screen.

NOTE

Only members of the Administrator User Group can view, add, or edit fonts.

Adding Fonts
To add a font to the application, follow these steps.
1. From the left frame of the Workarea, click Settings >
Configuration > Fonts.
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2. Click the Add Font button (

).

3. The add font screen is displayed.

4. Enter the font name or family into the text field provided.
5. Click the Save button (

.)

The new font is available to use when adding or editing content.

Viewing Fonts
When viewing fonts, you can also edit or delete them.
To view a font:
1. Access the font manager in your Workarea as described in
”Adding Fonts” on page 1071.
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2. Click the font you want to view.

3. The view font screen is displayed.

Edit Fonts
When you edit a font, the font or family name is changed. Editing
does not change any fonts in existing content.
To edit a font name, follow these steps.
1. Access the view font screen, as described in ”Viewing Fonts”
on page 1072.
2. Click the Edit button (

).

3. The Edit Font screen is displayed.

4. Edit the font name or family in the text field specified.
5. When finished, click the Update button (
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Delete Fonts
By deleting a font from the system, you are taking away the
content contributors’ use of that font in their content. To delete a
font, follow these steps.
1. Access the view font screen, as described in ”Viewing Fonts”
on page 1072.
2. Click the Delete button (

).

3. A message is displayed.

4. Click OK to delete the font.
5. The screen is refreshed, and the updated fonts table is
displayed.
NOTE

When you delete a font from Ektron CMS400.NET, you do not delete it from your
computer.
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Using this tool, Ektron’s customers can take full advantage of
SharePoint’s collaborative workspace to create documents.
These documents can then be delivered to a public facing Web
site, corporate intranet or extranet enabled with all the latest
search, navigation, Web 2.0 and social networking functionality
provided by Ektron CMS400.NET
Ektron CMS400.NET supports the distribution of SharePoint
content to any CMS400.NET folder. For example, your
Marketing Department uses Microsoft SharePoint to create and
edit content. After completing a press release, they use the
Publish to Ektron CMS menu option to copy it from
SharePoint to a content folder. Once there, the document can
pass through an approval chain or be published immediately.
See Also:
•

”Enabling Ektron's SharePoint Connector” on page 1075

•

”Distributing SharePoint Content to CMS400.NET” on
page 1076

Enabling Ektron's SharePoint Connector
To enable Ektron's SharePoint Connector in Microsoft
SharePoint, simply copy the SharePoint_To_CMS.exe file from
C:\Program Files\Ektron\CMS400v75\Utilities to your SharePoint
server and follow the on screen dialog.
If you successfully log in during Step 1of the Publish To
CMS400 process, then get a Please Login message in Step 2,
make sure your web browser is configured to accept cookies
from the Ektron CMS400.NET server. For example, if your
Sharepoint server is on sharepoint.company.com, and Ektron
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CMS400.NET is on cms.company.com, your web browser must allow

cookies from cms.company.com.
If cookies are being blocked, a stop sign symbol appears at the
bottom of Internet Explorer (shown below).

Distributing SharePoint Content to CMS400.NET
Once the SharePoint Connector is setup on a SharePoint server,
navigate to a content item and click the dropdown arrow next to the
content's title. A menu appears with the item Publish to Ektron
CMS. Clicking this item starts a simple wizard that publishes the
document into your CMS400.NET site's folder structure and
taxonomy-based information architecture. This information is
collected through a series of screens that guide you through the
process.
After SharePoint content is distributed to CMS400.NET the first
time, the original content is forever linked to the destination
content. You cannot break the link. However, deleting the
destination content in CMS400.NET allows you to select a new
folder when you republish the content from SharePoint.
NOTE

If you delete the destination content, you will not be able to access history
revisions of the content in CMS400.NET.

If you want to later revise the document, you would typically edit it
in SharePoint and select the Publish to Ektron CMS option again.
When you do, you are asked to confirm replacing the document in
the destination folder. You are not allowed to select another folder.

Prerequisites
When you click the Publish to Ektron CMS menu item, it will
check to see if you can log into CMS400.NET using Active
Directory. If so you will be logged in. If not, you will be prompted for
your username and password. You must have the following
permissions:
•

Add
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•

Delete

•

Restore Content.

If you do not have these permissions, the folder doesn't appear on
the folder selection screen.
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NOTE

The eCommerce feature requires special license from Ektron, Inc. If you do not
see this feature under Ektron CMS400.NET’s Modules area, it may be because
your license does not support eCommerce. For licensing information, contact
sales@ektron.com.

eCommerce documentation consists of the following top level
topics.
•

”Introduction” on page 1078

•

”Sample eCommerce Site” on page 1082

•

”Access to eCommerce” on page 1082

•

”Deploying eCommerce” on page 1082

•

”eCommerce Configuration Screens” on page 1089

•

”eCommerce Shipping Screens” on page 1134

•

”eCommerce Tax Screens” on page 1145

•

”eCommerce Products” on page 1156

•

”eCommerce Order Management” on page 1221
- ”Messages” on page 1129

•

”eCommerce Coupons” on page 1236

•

”Using eSync with eCommerce” on page 1249

•

”The eCommerce Audit Screen” on page 1250

Introduction
No matter what kind of sales you need to support, Ektron
eCommerce brings you all functionality you need, giving you an
entire toolset for building out the online marketplace you want. As
part of Ektron Ektron CMS400.NET, you’ll have a single application
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running both your Web site and online marketplace, letting you
manage both from the same interface.
Total integration means total control over your site via the authorfriendly Workarea, and you’ll open the doors to even more
possibilities for marketing and revenue!

Core eCommerce Features
eCommerce supports all product types, from single items, to
complex products (think movies available in DVD, Blu-ray or other
formats), bundles, and kits.
eCommerce takes advantage of key CMS400.NET technologies,
including Smart Forms and market-leading taxonomy and search.
Product entry Smart Forms standardize how product information is
entered; all information, attributes, and descriptive text is entered
in one place and goes into the database as structured XML data
(making it easy to repurpose this content wherever and whenever
you need it).
Enhance product SEO in the Smart Form by setting attributes,
adding metadata, and including photos and other media. Adding
images of products auto-generates thumbnails and gives you
complete control over sizes and number of images, as well as a
clickthrough image gallery. Images can also be defined for a
product type via the taxonomy.
Control over your product catalog extends to cross-sell and upsell
features, and Ektron’s taxonomy enables products to be classified
in multiple ways, providing more options for you to help customers
find what they are looking for.
CMS400.NET’s Web 2.0 content review tools find new uses here,
letting your customers post opinions and ratings on products. The
product search uses Ektron’s unparalleled taxonomy, and can be
filtered by price, ratings, reviews, and more.
Existing product data can be imported into eCommerce and the
CMS using Ektron’s flexible, scalable API.
When a customer is a member of your eCommerce site, they can
name and save shopping baskets for future purchases or as wish
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lists and registries. Your site administrators can always see which
baskets are open.
Checking out is a multi-step process: you can display all steps on a
single page or distribute them across multiple pages. While site
visitors are checking out, they can save as many shipping
addresses as they want, or simply check “same as billing.”
Shipping uses real-time rates by plugging into external providers,
or you can use your own rates by setting up an internal shipping
provider. Rates are quite customizable: they can be set up by
package size, product weight, and even product price ranges.
Payment options are flexible with eCommerce too: you can decide
if you want to accept credit cards, checks, and PayPal accounts.
Also, payment gateways (such as Payflow and Authorize.Net) are
supported out-of-the-box to authorize and capture transactions. Or,
create your own payment gateway (one that allows terms or any
other payment option).
Once the order is reviewed and submitted (and payment is
authorized), it can go through a simple or complex routing through
your own processing setup or plug-in to your existing CRM or ERP
to process the order. When the order is processed, the CRM/ERP
notifies CMS400.NET that it is complete. Online inventory is kept
up to date; you can set properties so that when items on hand drop
below a certain level, it triggers a sequence to notify your inventory
control.
Ektron eCommerce leverages the advanced core functionality of
CMS400.NET to give developers a complete toolset that works
out-of-the-box or can be completely customized (and everything in
between). Powerful Web 2.0 controls of CMS400.NET, including
memberships, ratings, forums and commenting, enabling you to
quickly implement an eCommerce site with the community-based
information they want to help them to make buying decisions.
As a .NET application, eCommerce uses the same database as
CMS400.NET to maximize efficiencies and takes advantage of
SQL cluster capabilities to be truly scalable. There is no need for
“glue code” to tie a third-party ecommerce application to your Web
site. Ektron eCommerce utilizes CMS400.NET’s existing
customizability to enable integration into any IT infrastructure.
Open architecture and a new ektron.cms.commerce API makes
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any commerce configuration possible, letting you tie it to your
backend systems.

Coupons, Taxes and Pricing
eCommerce supports a complete array of pricing schemes:
individual pricing, separate pricing within complex products, tiered
pricing to support volume discounts, and more. Online coupon
capability is also included, letting you set the type (dollar amount,
percentage) and at what level those coupons are applied (product
level, basket level and type of item).
For global business opportunities, all international currencies are
available. You are able to use conversion rates to determine prices
or set flat costs for each product. This goes hand in hand with the
tax options available. Set tax classes, including country, state, and
local (by postal code) as well as taxes for specific classes of
goods, and be able to sell to even more customers.

Developer Flexibility
Ektron eCommerce leverages the advanced core functionality of
Ektron CMS400.NET to give developers a complete toolset that
works out-of-the-box or can be completely customized (and
everything in between). Powerful Web 2.0 controls of
CMS400.NET, including memberships, ratings, forums and
commenting, enabling you to quickly implement an eCommerce
site with the community-based information they want to help them
to make buying decisions.
As a .NET application, eCommerce uses the same database as
Ektron CMS400.NET to maximize efficiencies and takes advantage
of SQL cluster capabilities to be truly scalable. There is no need for
“glue code” to tie a third-party eCommerce application to your Web
site. Ektron eCommerce utilizes Ektron CMS400.NET’s existing
customizability to enable integration into any IT infrastructure.
Open architecture and a new ektron.cms.commerce API makes
any commerce configuration possible, letting you tie it in to your
backend systems.
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Sample eCommerce Site
To see a sample eCommerce site, download the Developer
Sample Site. Within that site, you can try out a customer shopping
experience by going to http://site root/cms400developer/developer/
default.aspx then Commerce > Cart. The following shopping cart
screen appears.

You can add items to the cart then proceed through a sample
checkout process.

Access to eCommerce
Only members of the Administrators group or those assigned the
eCommerce Admin role can access the eCommerce screens
within the Ektron CMS400.NET Workarea. See Also: ”Defining
Roles” on page 787

Deploying eCommerce
Follow these steps to deploy Ektron CMS400.NET’s eCommerce
feature.
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1. ”Determine Units of Measure” on page 1083
2. ”Determine the Default Currency” on page 1083
3. ”Set Up eCommerce Configuration Screens” on page 1083
4. ”Set up eCommerce Catalog Entries” on page 1085
5. Set up your templates and eCommerce server controls. See
Also: The Ektron CMS400.NET Developer Manual section
“eCommerce Server Controls.”
See Also: ”Images in eCommerce” on page 1086

Determine Units of Measure
For each item sold on your Web site, you define a height, length,
depth, and weight. If English, the units are inches and pounds. If
Metric, the units are centimeters and kilograms. This information is
used to calculate shipping costs.
By default, this is set to English. To change to Metric, open the
siteroot/web.config file, and edit the value of the
ek_measurementsystem property.
<ektroncommerce>
ek_measurementsystem value = “english” or “metric”

WARNING!

After you make this decision and build your eCommerce system, you cannot
change the units of measure.

Determine the Default Currency
Decide on a default currency, the one on which all exchange rates
are based. See Also: ”The Default Currency” on page 1100
WARNING!

After your eCommerce feature goes live, do not change the
ek_ecom_DefaultCurrencyId value in web.config.

Set Up eCommerce Configuration Screens
The configuration screens collect critical information that is used
throughout the eCommerce feature.
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Set up eCommerce configuration screens in this order.

Order

Screen

1

Countries (enable
ones you will
support)

2

Regions

3

Tax classes

Dependent on

For more information, see
”Countries” on page 1089

Countries

”Regions” on page 1093
”The Tax Class Screens” on page 1147
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Order

Screen

Dependent on

For more information, see

4

•

Postal Code
Tax

•

•

”Postal Tax Tables” on page 1149,

•

”Regional Tax Tables” on page 1151

•

Regional Tax

•

”Country Tax Tables” on page 1153

•

Country Tax

Countries,
Regions, Tax
Class

•

Regions, Tax
Class

•

Countries,
Tax Class

5

Warehouse

Countries and
Regions

”Warehouse” on page 1134

6

Credit Card
Types, Payment
Options

”Credit Card Types” on page 1124, ”Payment
Options” on page 1105

7

Currencies
(enable ones you
will support)

”Currencies” on page 1097

8

Shipping Methods
and Packages

”Shipping Methods” on page 1139, ”Packages”
on page 1137

9

Messages

”Messages” on page 1129

Set up eCommerce Catalog Entries

Order

Screen

Dependent
on

For more information, see

1

Product Types

2

Catalog Folders

Product
Types

”Creating a Catalog Folder” on page 1182

3

Entries in Catalog Folders

•

Product
Types

”Creating a Catalog Entry” on page 1185

•

Catalog
folders

”Product Types” on page 1156
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Order

Screen

Dependent
on

For more information, see

4

Create Web Pages using
eCommerce Server
Controls

Catalog
entries

E ktron CM S40 0. NET Developer Manual

section “eCommerce Server Controls”
For samples of the server controls, install the
developer sample site. Then go to site root
folder/developer/default.aspx >
Commerce.
Note: To download the developer sample site,
go to http://www.ektron.com/solutions/
startersites/.

5

Coupons

Catalog
entries

”Creating a Coupon” on page 1236

Images in eCommerce
When using eCommerce, a site visitor sees images that represent
products or services for sale. The following table lists each image
that appears on an eCommerce Web site, and the source of each
one.
NOTE

You control your Web’s site’s display of catalog entries through eCommerce
Server Controls. They are documented in the Ektron CMS400.NET Developer
Manual section “Introduction to Ektron CMS400.NET Server Controls” >
“eCommerce Server Controls.”
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Where Image
Appears

Example

Product Server
Control, main
image

Image Location in
Workarea
On the catalog entry’s Content
tab
Note: The sample catalog
entries are based on Product
Types whose XML Smart Form
includes an Image field. As a
result, the product description,
(which appears at the top of the
Product Server control) includes
an image. This is not required,
merely a suggested
implementation.

Image on Product control
Product Server
Control, thumbnails

On the catalog entry’s Media
screen.
If an image’s Gallery Display
field is set to Yes, its smallest
thumbnail appears on the
Product server control, below
the content area. (This assumes
you are using the control’s
default xslt.)
When a site visitor clicks a
thumbnail, the corresponding
full image appears.

Thumbnails on lower portion of Product
control
Note: To control the thumbnail display, use the Xslt
files generated by the Product, Product List,
Product Search, and Recommendation server
controls.
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Where Image
Appears

Example

Product List,
Product Search,
and
Recommendation
server controls

Image Location in
Workarea
On the catalog entry’s Media
tab, the image designated as
Product Icon
See Also: ”Entering a Catalog
Entry’s Media” on page 1207

Image on Product List control
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Screens

•

”Countries” on page 1089

•

”Regions” on page 1093

•

”Currencies” on page 1097

•

”Credit Card Types” on page 1124

•

”Payment Options” on page 1105

•

”Messages” on page 1129

Countries
Use the Countries screen to modify existing country information or
add new countries to eCommerce.

How Countries are Used
•

to define country tax tables. For example, assume Canada
has a national tax of 5% that applies to the sale of certain
goods. National tax tables are defined in the Country Tax
Tables screen.

•

to determine shipping costs. In the Order checkout process,
the purchaser selects a shipping address, which includes
country. So, be sure to enable all countries from which site
visitors can enter orders.
Countries are also part of the location on the Warehouse
screen. An order’s shipping cost is determined by the distance
between the warehouse and the destination.

See Also:
•

”Default Countries” on page 1090

•

”Creating a Country” on page 1091

•

”Editing a Country” on page 1092

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1089

eCommerce Configuration Screens

•

”Deleting a Country” on page 1093

Default Countries
By default, Ektron CMS400.NET provides information for all
countries on the ISO list of English country names and code
elements (http://www.iso.org/iso/country_codes/
iso_3166_code_lists/english_country_names_and_code_elements.htm).

The following is provided for each country.
•

name

•

numeric ISO code

•

long alphabetical ISO code

•

short alphabetical ISO code

The countries screen lets you enter new countries, as well as edit
information for any provided countries.
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Creating a Country
Prerequisite: The new country’s ISO codes
To add a new country, follow these steps. See Also: ”Countries” on
page 1089
1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Configuration > Countries.
2. Click New > Country.
3. Use the following table to complete the screen.
Field

Description

Name

Enter the country’s name.

Numeric ISO

Enter the country’s ISO 3166-1 three digit numeric ISO code. See Also:
http://en.wikipedia.org/wiki/ISO_3166-1_numeric
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Field

Description

Enabled

Check this box if you want this country to be active. Only active countries
can be selected on the Edit Billing Information screen, which appears
during the Checkout procedure.

Long ISO

Enter the country’s ISO 3166-1 alpha-3, three letter country code. See
Also: http://en.wikipedia.org/wiki/ISO_3166-1_alpha-3

Short ISO

Enter the country’s ISO 3166-1 alpha-2, two letter country code. See
Also: http://en.wikipedia.org/wiki/ISO_3166-1_alpha-2

Editing a Country
Follow these steps to edit a country. See Also: ”Countries” on
page 1089
1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Configuration > Countries.
2. Click the name of the country that you want to edit.
3. Click the Edit button (

).
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4. Edit any of the fields, which are described in ”Use the following
table to complete the screen.” on page 1091

Deleting a Country
Follow these steps to delete a country. See Also: ”Countries” on
page 1089
1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Configuration > Countries.
2. Click the name of the country that you want to delete.
3. Click the Delete button (

).

4. A confirmation message appears. Click OK.
5. The country is deleted.

Regions
The Regions screen lets you define geographic regions within
countries that your eCommerce site services. For example, in the
United States of America, each state is a region.
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Regions are used in the same way that countries are used. See
Also: ”How Countries are Used” on page 1089

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1094

eCommerce Configuration Screens

Default Regions
By default, the Regions screen includes all 50 United States of
America, the District of Columbia, and 9 Canadian Provinces.
See Also:
•

”Creating a Region” on page 1095

•

”Editing a Region” on page 1097

•

”Deleting a Region” on page 1097

Creating a Region
Prerequisite: The region’s country is defined in the Countries
screen
To add a new region, follow these steps. See Also: ”Regions” on
page 1093
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1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Configuration > Regions.
2. Click New > Region.
3. Use the following table to complete the screen.
Field

Description

Name

Enter the region’s name.

Enabled

Check this box if you want this region to be active. Only active regions
can be selected on the Edit Billing Information screen, which appears
when site visitors enter billing information during the Checkout procedure.

Code

Enter an abbreviation for this region.

Country

Select this region’s country from the pull down list. If the country is not
there, exit this screen, and create the country using the Countries screen.
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Field

Description

Add another
region to this
country?

This field saves the effort of selecting a country when entering several
regions for one country.
To add more regions for this country, check this box and press the Save
button ( ). When you do, the screen refreshes, and the most recently
selected country appears as the default.

Editing a Region
Follow these steps to edit a region. See Also: ”Regions” on
page 1093
1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Configuration > Regions.
2. Click the name of the region that you want to edit.
3. Click the Edit button (

).

4. Edit any of the fields, which are described in ”Use the following
table to complete the screen.” on page 1096

Deleting a Region
Follow these steps to delete a region. See Also: ”Regions” on
page 1093
1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Configuration > Regions.
2. Click the name of the region that you want to delete.
3. Click the Delete button (

).

4. A confirmation message appears. Click OK.
5. The region is deleted.

Currencies
eCommerce supports all currencies. However, site visitors can
only choose enabled currencies. The Currency screen lets you
enable and edit information for all installed currencies.
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See Also:
•

”Installed Currencies” on page 1098

•

”The Default Currency” on page 1100

•

”How Currencies Are Used in the Currency Select Server
Control” on page 1101

•

”How Exchange Rate Affects an Item’s Price” on page 1102

•

”Updating the Exchange Rate” on page 1103

•

”Editing a Currency” on page 1103

•

”Deleting a Currency” on page 1104

Installed Currencies
By default, Ektron CMS400.NET provides all currencies on the ISO
4217 currency names and code elements list (http://www.iso.org/
iso/support/faqs/faqs_widely_used_standards/
widely_used_standards_other/currency_codes/
currency_codes_list-1.htm).
The following information is provided for each installed currency.
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•

name

•

enabled (yes or no)

•

numeric ISO code

•

alpha ISO code

•

exchange rate

Enabled Currencies
When users are setting prices in the Ektron CMS400.NET Workarea
or site visitors are shopping, they can only choose enabled
currencies. When you install Ektron CMS400.NET, the following
currencies are enabled.

TIP!

WARNING!

•

U.S. dollar (the default currency. See Also: ”The Default
Currency” on page 1100)

•

Euro

•

Australian dollar

To see which currencies (other than the default) are enabled, click Action > Edit
Exchange Rates from the Currencies screen. Only non-default, enabled
currencies appear.
The Euro and Australian dollar are shipped with a default exchange rate. If you
will support these currencies, you should update the rate to its current value
before going live. See Also: ”Updating the Exchange Rate” on page 1103

To enable any installed currency, follow these steps.
1. Click Ektron CMS400.NET Workarea > Modules > Commerce>
Configuration > Currencies.
2. Click the currency you want to enable.
TIP!

Use the Search box to quickly find a currency.

3. The Edit Currency screen appears.
4. Check the Enabled check box.
5. Click Save

.
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The Default Currency
The default currency is the reference currency when setting the
exchange rate on the Edit Currency screen. For example, if the
default is US dollars, USD appears on the left of the exchange rate
equation, as shown below.

The default currency is also used as the default choice in the
Currency Selector server control, and on the Pricing tab of the
View/Edit Catalog Entry screen.
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Viewing and Changing the Default Currency
When you install Ektron CMS400.NET, the default currency is the
Numeric ISO code for U.S. dollars (Id 840). At that time, you can
change this in the web.config file’s ek_ecom_DefaultCurrencyId tag.
However, once you set your default currency in web.config and
begin to deploy eCommerce, do not change it.
WARNING!

After your eCommerce feature goes live, do not change the
ek_ecom_DefaultCurrencyId value in web.config.

How Currencies Are Used in the Currency Select Server
Control
If your developer places a Currency Select server control on a
page, a site visitor can use it to select any enabled currency.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1101

eCommerce Configuration Screens

After a currency is selected, the prices on the page change to that
currency. See Also: ”How Exchange Rate Affects an Item’s Price”
on page 1102
From that point on, the cart and order use the selected currency.

How Exchange Rate Affects an Item’s Price
The Edit Currency screen lets you define an exchange rate
between the default and any other currency. See Also: ”The
Default Currency” on page 1100; ”Updating the Exchange Rate” on
page 1103

The exchange rate can dynamically adjust prices when the rate
changes. See Also: ”Alternate Currency Pricing” on page 1200
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Updating the Exchange Rate
Using the Ektron CMS400.NET API
The following Ektron API supports calling an exchange rate service
to update rates automatically: Ektron.Cms.Commerce.ExchangeRateApi.
For more information, see the Ektron CMS400.Net API
documentation.

Using the Update Exchange Rates Screen
The Edit Exchange Rates screen lets you update the exchange
rate for enabled currencies. See Also: ”How Exchange Rate
Affects an Item’s Price” on page 1102;”Currencies” on page 1097
TIP!

A good Web site for finding exchange rates is http://www.xe.com/ucc/.

To use the screen, follow these steps.
1. In the Ektron CMS400.NET Workarea, go to Modules >
Commerce > Configuration > Currencies.
2. Click Action > Edit Exchange Rates.
3. The Edit Exchange Rates screen appears, showing all enabled
currencies and their exchange rates.

4. Update rates as needed.
5. Click Action > Update.

Editing a Currency
Follow these steps to edit a currency. See Also: ”Currencies” on
page 1097
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1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Configuration > Currencies.
2. Click the currency you want to edit.
3. You can only edit the Name, Enabled, and Exchange Rate
fields. All fields are described below.
Field

Description

Name

Enter the currency’s name.

Numeric ISO
Code

The currency’s ISO 4217 three-digit numeric ISO code appears. See
Also: ”Installed Currencies” on page 1098

Alpha ISO
Code

The country’s ISO 4217 alphabetic, three-letter currency code appears.
See Also: ”Installed Currencies” on page 1098

Enabled

Check this box to enable this currency. See Also: ”Enabled Currencies”
on page 1099

Exchange
Rate

Enter the exchange rate between this currency and the default one. See
Also: ”How Exchange Rate Affects an Item’s Price” on page 1102; ”The
Default Currency” on page 1100

4. Click the Save button (

).

Deleting a Currency
Follow these steps to delete a currency. See Also: ”Currencies” on
page 1097
1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Configuration > Currencies.
2. Check the box next to the currency that you want to delete.
3. Click Action > Delete Selected.
4. A confirmation message appears. Click OK.
5. The currency is deleted.
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Payment Options
The Payment Options screen lets you determine which options are
available for your customers to pay for their purchases.
•

Paypal - See Also: ”PayPal Support” on page 1105

•

a Payment Gateway, such as AuthorizeNet - See Also:
”Payment Gateway” on page 1115

Both options can be enabled, but only one gateway can be
enabled at a time.

PayPal Support
“PayPal is an ecommerce business allowing payments and money
transfers to be made through the Internet. PayPal serves as an
electronic alternative to traditional paper methods such as checks
and money orders.
A PayPal account can be funded with an electronic debit from a
bank account or by a credit card. The recipient of a PayPal transfer
can either request a check from PayPal, establish their own
PayPal deposit account or request a transfer to their bank account.
PayPal is an example of a payment intermediary service that
facilitates worldwide e-commerce.” source: wikipedia
See Also:
•

”Using PayPal with Ektron CMS400.NET’s eCommerce” on
page 1105

•

”Paypal Documentation” on page 1107

•

”Enabling PayPal Support” on page 1108

•

”Customizing the PayPal Page” on page 1114

Using PayPal with Ektron CMS400.NET’s eCommerce
Your customers can use PayPal to pay for purchases from either of
two points in the checkout process
•

the shopping cart screen

•

the payment screen
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If a site visitor accesses PayPal via the shopping cart screen, he
follows these steps.

Here is the sequence illustrated above.
1. From the Cart screen, a site visitor clicks the PayPal button.
2. He logs into his PayPal account.
3. Information from that account is used to populate the default
shipping and billing addresses.
4. The site visitor can change addresses if needed.
NOTE

If the PayPal account address is used for the order, it is saved as part of the site
visitor’s Ektron CMS400.NET eCommerce account information.

5. Shipping costs are added.
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6. The order is confirmed.
7. Site visitor checks out via PayPal.
Alternatively, the site visitor can use the standard eCommerce
checkout process, select PayPal on the payment screen, and
complete his order using the PayPal payment screen. That
sequence is illustrated below.

Paypal Documentation
Use the following resources to familiarize yourself with integrating
PayPal into your eCommerce site.
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IMPORTANT!

•

PayPal Technical Documentation - https://cms.paypal.com/us/
cgi-bin/?cmd=_render-content&content_ID=developer/
library_documentation

•

PayPal Express Checkout Integration Guide - https://
cms.paypal.com/cms_content/en_US/files/developer/
PP_ExpressCheckout_IntegrationGuide.pdf

•

Payflow ACH Payment Service Guide - https://
cms.paypal.com/cms_content/US/en_US/files/developer/
PP_ACHPayment_Guide.pdf

PayPal requires you to place the Pay with PayPal option on both the shopping
cart and payment screens.

Enabling PayPal Support
To enable PayPal support in Ektron CMS400.NET, follow these
steps.
•

”Create a Sandbox Account” on page 1108. This step includes
updating Ektron CMS400.NET’s web.config file.

•

”Enable PayPal in the Ektron CMS400.NET Workarea” on
page 1113

Create a Sandbox Account

1. Sign on to http://www.sandbox.paypal.com.
2. Sign up for an account.
NOTE

If you plan to support the eCommerce recurring billing feature, make sure your
PayPal account supports this service. See Also: ”Creating a Subscription” on
page 1173

3. After a short while, you receive an email confirmation that
directs you to another page.
4. Log in using the information you provided in Step 2.
5. Under Test Accounts, click Create a preconfigured buyer or
seller account.
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6. Create a buyer account. You will use this to test the customer
experience.
TIP!

Change the password to one you can easily remember.

7. Click Home > Test Accounts > Create a preconfigured
buyer or seller account.
8. This time, click Account Type Seller.
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9. Create a seller account. You will use this to test the merchant
experience.
TIP!

Change the default password to one that you can easily remember.

10. In the upper left corner of the screen, click API Credentials.

11. Open your siteroot/web.config file.
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12. Copy the following values from the API Credentials screen into
the web config’s providers/paypal element. Save web.config.

PayPal Test Account Value

web.config Paypal
Element

API Username

PayPalUser

API Password

PayPalPwd

Signature

PayPalSignature

The following illustration shows the PayPal API Username
copied into the web.config file’s PayPalUser property.

If you want to encrypt these values, see ”Encrypting PayPal
Authentication Values” on page 1111.
Encrypting PayPal Authentication Values

Follow these steps to encrypt the following values in the
web.config file’s providers/paypal element.
Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1111

eCommerce Configuration Screens

•

PayPalUser

•

PayPalPwd (password)

•

PayPalSignature

1. Open the site

root/web.config

file.

2. Set the AuthValuesEncrypted element to true.

3. Save and close web.config.
4. Open C:\Program Files\Ektron\CMS400v7x\Utilities.
5. Run EncryptEmailPassword.exe.
6. The Encrypt Utility dialog appears.

7. Enter the PayPal user name into the Text field.
8. Click the Encrypt button.
9. The screen displays encrypted text in the Encrypted field.
10. Copy the encrypted text and paste it into the web.config file’s
PayPalUser element value.
11. Repeat Steps 7 through 10 for PayPalPwd and PayPalSignature.
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Test the Sandbox Account

After creating a sandbox account, you should test it.
1. Sign into the Developer Sample site > eCommerce > Cart.
2. Click the PayPal button.

3. Enter the buyer account user name and password that you
created in ”Create a Sandbox Account” on page 1108.
4. You proceed to the Ektron CMS400.NET Checkout screen.
After completing these steps, you have verified your PayPal buyer
experience.
Enable PayPal in the Ektron CMS400.NET Workarea

To enable PayPal in the Ektron CMS400.NET Workarea, follow
these steps.
1. Ektron CMS400.NET Workarea > Modules > Commerce >
Configuration > Payment Options.
2. Click Action > Edit Payment options.
3. Check PayPal.
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4. Click the Save button (

).

Customizing the PayPal Page
If you are using Ektron CMS400.NET’s sample site and PayPal is
enabled, the login screen contains an Ektron logo for
demonstration purposes.

You can replace the logo using the following property of the web
config’s providers/add name=”PayPal” element.
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To change the logo, change the referenced image.
To learn how to customize other aspects of the page, see PayPal’s
“Express Checkout Integration Guide” section “PayPal Page
Style.” (https://cms.paypal.com/cms_content/en_US/files/
developer/PP_ExpressCheckout_IntegrationGuide.pdf)
When setting values in the web.config’s providers/add name=”
element, prefix any variable with apiparam. For example, to
set the header background color, enter
apiparamHDRBACKCOLOR=”FFF666”.
PayPal”

Payment Gateway
A payment gateway is a “service that automates the payment
transaction between a shopper and merchant. It is usually a thirdparty service that processes, verifies, and accepts or declines
credit card transactions or checks on behalf of the merchant
through secure Internet connections.” (source: webopedia)
Ektron CMS400.NET provides two standard payment gateways

authorize.net and Payflow, along with manual. The manual
gateway accepts all credit cards. In this case, the merchant emails
the credit card information to the credit card company.
NOTE

Details on how to implement a custom Payment Gateway can be found in the
Ektron CMS400.NET Developer Manual section “Customizing eCommerce” >
“Payment Gateway Provider.”

Within Ektron CMS400.NET, a gateway can support credit cards,
checks, or both, depending on how you implement it.
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Ektron CMS400.NET lets you edit information on any provided

gateway as well as create a new one.
See Also:
•

”How a Payment Gateway Works” on page 1116

•

”The Default Gateway” on page 1118

•

”Adding a Payment Gateway” on page 1119

•

”Editing a Payment Gateway” on page 1120

•

”Deleting a Payment Gateway” on page 1120

•

”Check Support” on page 1121

•

”Credit Card Types” on page 1124

•

”PayPal Support” on page 1105

How a Payment Gateway Works
Processing Credit Card Transactions
The following sequence explains how credit card transactions are
typically processed. (source: www.authorize.net)
1. The payment gateway provider (PGP) receives secure
transaction information and passes it via secure connection to
the Merchant Bank’s Processor.
2. The Merchant Bank’s Processor submits the transaction to the
Credit Card Interchange (a network of financial entities that
manage credit card transactions).
3. The Credit Card Interchange sends the transaction to the
customer’s Credit Card Issuer.
4. The Credit Card Issuer approves or declines the transaction,
based on the customer’s available funds. It then passes the
transaction results and, if approved, the appropriate funds back
through the Credit Card Interchange.
5. The Credit Card Interchange relays the transaction results to
the Merchant Bank’s Processor.
6. The Merchant Bank’s Processor relays the transaction results
to PGP.
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7. The PGP stores transaction results and sends them to the
customer and/or the merchant. This communication process
averages three seconds or less.
8. The Credit Card Interchange passes the transaction’s funds
from the Credit Card Issuer to the merchant’s bank account.

Processing Check Transactions
The following sequence explains how a payment gateway
processes checks. (source: www.authorize.net)
1. Customer authorizes merchant to charge his bank account for
an amount.
2. Order and payment information is securely transmitted via the
Internet to the payment gateway.
3. The transaction is accepted or rejected based on initial data
validation and security criteria defined by the payment
gateway.
4. If accepted, the transaction is sent to the ACH Network for
settlement.
5. The ACH Network uses the transaction’s bank account
information to determine the bank that holds the customer’s
account (the RDFI).
6. The ACH Network instructs the RDFI to charge or refund the
customer’s account.
7. The RDFI transfers funds from the customer’s account to the
ACH Network. The RDFI also notifies the ACH Network of any
returns (if funds could not be collected from the customer’s
bank account) or chargebacks (if a customer disputes a
purchase).
8. The ACH Network transfers funds for the transaction to the
payment gateway’s bank.
9. After a holding period, the payment gateway provider initiates a
ACH transaction that deposits the funds into the merchant’s
bank account.

Establishing a Relationship with a Payment Gateway Provider
You need to set up an account with a third-party payment service
before using a payment provider. This includes payment providers
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such as Authorize.NET and PayFlow, which are included with
CMS400.NET’s eCommerce Module.
To do this with Authorize.Net, go to http://www.authorize.net/
solutions/merchantsolutions/onlinemerchantaccount/.
To set up an account with PayFlow, go to https://www.paypal.com/
cgi-bin/webscr?cmd=_payflow-gateway-overview-outside.
WARNING!

Make sure your payment gateway supports all currencies that you want to enable.

Each payment gateway provider accepts configuration parameters.
For example, Authorize.NET requires a username and password,
while PayFlow requires a Username, password, vendor, and
partner.
In addition, some payment gateways do not support subscription
payments. This is something to consider if your site relies on
subscriptions. See Also: ”Creating a Subscription” on page 1173

The Default Gateway
The eCommerce checkout process only uses the default gateway.
Additional gateways are unused unless one is changed to be the
default.
You cannot delete the default gateway. If you want to delete it, you
must first make another gateway the default.
To change the default gateway, follow these steps.
1. Go to Modules > Commerce > Configuration > Payment
Options.
2. The currently-defined default has a check in the Default
column.
3. Click the radio button to the left of the gateway you want to
make the default.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1118

eCommerce Configuration Screens

4. Click Action > Mark as Default.
5. A confirmation message appears. Click OK.

Adding a Payment Gateway
NOTE

To learn how to create a new payment gateway provider, see the Ektron
CMS400.NET Developer Manual section “Customizing eCommerce” >
“Payment Gateway Provider” > “Creating a Custom Payment Gateway Provider.”

To add a new payment gateway to Ektron CMS400.NET, follow
these steps. See Also: ”Payment Options” on page 1105
1. In Ektron CMS400.NET, go to Modules > Commerce >
Configuration > Payment Options.
2. Click New > Payment Gateway.
3. Use the following table to complete the screen.

Field

Description

Name

Enter the name of the gateway.

Default

Check this box if this is the default gateway. If you do, and another
gateway is currently the default, it is replaced by this one. See Also: ”The
Default Gateway” on page 1118

User ID

Enter your User ID. This ID will identify your account with this gateway
provider.

Password

Enter the password for your account with this gateway provider.
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Field

Description

Expand Custom
Values

If this gateway provider needs additional fields of information, enter those
values into the Custom 1 and Custom 2 fields.

Credit Cards

Check if this payment gateway accepts credit cards.

Checks

Check if this payment gateway accepts checks.

Editing a Payment Gateway
Follow these steps to edit a payment gateway. See Also: ”Payment
Options” on page 1105
1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Configuration > Payment Options.
2. Click the payment gateway that you want to edit.
3. Click the Edit button (

).

4. Edit any of the fields, which are described in ”Use the following
table to complete the screen.” on page 1119.
5. Click the Save button (

).

Deleting a Payment Gateway
Follow these steps to delete a payment gateway.
NOTE

The default gateway cannot be deleted. If you want to delete it, you must first
make another gateway the default.

See Also: ”Payment Options” on page 1105
1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Configuration > Payment Options.
2. Click the payment gateway that you want to delete.
3. Click the Delete button (

).

4. A confirmation message appears. Click OK.
5. The payment gateway is deleted.
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Check Support
Payment gateways generally offer two payment mechanisms:
credit cards and checks. You can enable or disable check support
for a gateway via the Modules > Commerce > Configuration >
Payment options > Edit Payment Gateway screen (shown
below).

When checks are enabled for the default payment gateway, a site
visitor can choose to pay by Check on the payment screen. If
check support is not enabled, the Payment Method field does not
appear.
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Check Support Integration Documentation
Use the following resources to familiarize yourself with integrating
checks into your eCommerce site.
•

Authorize.Net
http://www.authorize.net/files/echecknetuserguide.pdf

•

PayFlow

https://cms.paypal.com/cms_content/US/en_US/files/developer/PP_PayflowLink_Guide.pdf

See the chapter “Integrating TeleCheck Transactions.”

Effect of Check Payment on Order Processing
The following describes a typical sequence of events when
processing a check for eCommerce payment.
However, Ektron CMS400.NET is very flexible and does not enforce
this sequence. For example, you can enter a tracking number and
mark an order shipped even though its payment has not been
captured yet.
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1. eCommerce user accesses the View Payment screen’s
Capture option, which submits a payment request to the
customer’s bank.

2. A few days later, the funds are transferred to the merchant’s
account.
3. The eCommerce user accesses the View Payment screen’s
Mark as Settled option to confirm that the funds have been
received.

4. If the goods are tangible
The eCommerce user ships the merchandise, using the View
Payment screen’s Enter Tracking Number option to insert the
tracking number and confirm the shipment.
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If the goods are not tangible
The workflow sends the customer an email with details about
the purchase, such as how to download it.

Credit Card Types
Use this screen to enter all types of credit cards that your
eCommerce system may use. By default, Ektron CMS400.NET’s
developer sample site provides the following card types.

NOTE

•

American Express

•

Diners Club (not accepted by default)

•

Discover

•

MasterCard

•

Visa

•

Solo

•

Maestro

If Solo and Maestro are enabled, additional fields appear on the Checkout server
control to collect required information.
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You can edit the information provided for these types or enter a
new one.

See Also:
•

”Where Credit Card Types are Used” on page 1125

•

”Creating a Credit Card Type” on page 1126

•

”Editing a Credit Card Type” on page 1128

•

”Deleting a Credit Card Type” on page 1129

Where Credit Card Types are Used
During the checkout process (managed by the Checkout server
control), screen 5 (Submit Order) has a dropdown list of all
enabled credit cards. See below.
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Creating a Credit Card Type
To create a new credit card within Ektron CMS400.NET, follow
these steps.
1. In Ektron CMS400.NET, go to Modules > Commerce >
Configuration > Credit Card.
2. Click New > Credit Card.
3. Use the following table to complete the screen.
Field

Description

Name

Enter the credit card’s name.
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Field

Description

Accepted

Check this box if site visitors can use this card to make purchases on your Web site. Only
Accepted cards appears in the Check out procedure > Submit Order screen’s Credit Card
Type dropdown, as shown below.

Image

Use this field to specify an image for the credit card.
The image does not appear on the standard checkout screen. But it is a field in the XML,
so you can enable it using an XSLT.
Adding or Changing the Image
If you are entering a new credit card image or editing an existing one, follow these steps.
Prerequisite: The image resides on your computer.
1.

Click Change.

2.

The Library Upload screen appears.

3.

Click the Add button (

4.

Click Browse and navigate to the folder that contains the image.

5.

Choose the image.

6.

Assign a Title.

7.

Click the Add Library button (

8.

The image appears on the screen.

).

).
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Field

Description

Regex

A Regex expression is a simple way to validate a credit card account number. (See Also:
http://regexlib.com/.) Validation occurs when a site visitor completes the Checkout
procedure’s Submit Order screen, as shown below.

Regex prevents the submission of invalid account numbers to a payment gateway, which
may charge a fee for such failures.
Ek tron CM S40 0.NET provides as Regex expression for the credit cards supplied with

medical sample site. You can modify them as needed. If you enter a new credit card, you
can enter a Regex expression for it.

Editing a Credit Card Type
Follow these steps to edit a Credit Card Type. See Also: ”Credit
Card Types” on page 1124
1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Configuration > Credit Card.
2. Click the Credit Card Type that you want to edit.
3. Click the Edit button (

).

4. Edit any of the fields, which are described in ”Use the following
table to complete the screen.” on page 1126.
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5. Click the Save button (

).

Deleting a Credit Card Type
Follow these steps to delete a Credit Card Type. See Also: ”Credit
Card Types” on page 1124
1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Configuration > Credit Card.
2. Click the Credit Card Type that you want to delete.
3. Click the Delete button (

).

4. A confirmation message appears. Click OK.
5. The Credit Card Type is deleted.

Messages
Ektron’s eCommerce feature provides a messaging feature that
can notify a purchaser when these events occur:
•

Order is submitted

•

Order is cancelled

•

Order is shipped

Each message has a unique type that corresponds to an event.
The message types are
•

OrderReceived

•

OrderCancelled

•

Order Shipped

You can create any number of messages for each event, assigning
one as the default. Only the default message is sent when the
corresponding event occurs.
Here is a sample message as set up within Ektron CMS400.NET.
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Here is the same message as delivered to a recipient’s inbox.
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See Also:
•

”How Messages are Created and Generated” on page 1131

•

”Creating or Editing an eCommerce Message” on page 1132

How Messages are Created and Generated
Ektron CMS400.NET provides sample text for each type of
message. To view and edit a message, go to Ektron CMS400.NET
Workarea > Modules > Commerce > Configuration >
Messages.
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The Message Type determines the event that causes a message
to be sent. For example, the Orderreceived message is sent to a
purchaser when he submits an order.
If regular content notification emails are being generated, the site
visitor provided a valid email address, and a message has been
defined for the event, emails are sent as eCommerce events occur.
No additional set up is required.
NOTE

eCommerce messages are distributed in the same way that content notification
emails are. For information on setting this up, see the Ektron CMS400.NET Setup
manual > “Configuring E-Mail for Tasks and Content.”

Creating or Editing an eCommerce Message
1. Go to Workarea > Modules > Commerce > Configuration >
Messages.
2. If a message of the type you want to create already exists,
select it. Otherwise, click the Add Message button (

).

3. Assign a Title, Subject (for the email subject line), Message
Type, and message text.

Message Variables
eCommerce message text can use the following variables to
retrieve order information from the database into the message text.

Variable

Description

@CustomerFirstName@

Customer’s first name

@CustomerLastName@

Customer’s last name

@OrderId@

The order’s ID number

@OrderSubTotal@

The order’s subtotal, that is the amount of all ordered
items prior to shipping costs, taxes, and coupon
discounts
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Variable

Description

@OrderTotal@

The order’s final cost (which includes taxes, shipping,
and coupon discounts)

@OrderShippingTotal@

The order’s shipping cost

@OrderCouponTotal@

The order’s coupon discounts

@OrderTaxTotal@

The order’s tax amount

@OrderItemTitle@

The title of any item on the order

@OrderItemSalePrice@

The sale price of any item on the order

@OrderItemQuantity@

The quantity of any item on the order

@OrderItemTotal@

The total cost of one item. For example, if
orderItemSalePrice = $10 and orderItemQuantity =
2, orderItemTotal = $20.

@OrderItemStart@ and
@OrderItemEnd@

Use the start and end markers to show information for
all ordered items.
The markers show no information by themselves.
Instead, they repeat the variables between them for
every item on the order.
So, for example, assume an order has 10 items, and
your message looks like this:
@OrderItemStart@
@OrderItemTitle@
@OrderItemQuantity@
@OrderItemSalePrice@
@OrderItemTotal@
@OrderItemEnd@

The message prints the title, quantity, sale price, and
total for each item on the order.
@TrackingUrl@

The link to a Web page that tracks your package. It is
usually a combination of the shipper’s URL and the
tracking number.
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eCommerce Shipping Screens

•

”Warehouse” on page 1134

•

”Packages” on page 1137

•

”Shipping Methods” on page 1139

Warehouse
Use the Warehouses screen to enter information about
warehouses that stock your catalog entries. eCommerce uses this
location to determine the “from” address when calculating shipping
costs.

Only the default warehouse is used by the checkout process.
Additional warehouses are unused until they are made the default.
See Also: ”Changing the Default Warehouse” on page 1135
Prerequisite: Regions and countries must be set up. See Also:
”Regions” on page 1093
See Also:
•

”Creating a Warehouse” on page 1135

•

”Changing the Default Warehouse” on page 1135

•

”Editing a Warehouse” on page 1136

•

”Deleting a Warehouse” on page 1136
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Creating a Warehouse
To create a new warehouse within Ektron CMS400.NET, follow
these steps. See Also: ”Warehouse” on page 1134
1. In Ektron CMS400.NET, go to Modules > Commerce >
Shipping > Warehouses.
2. Click New > Warehouse.
3. Use the following table to complete the screen.
Field

Description

Name

Enter the warehouse’s name.

Street1, Street2

Enter the warehouse’s street address.

City

Enter the warehouse’s city.

Postal Code

Enter the warehouse’s postal code.

Country

Select the warehouse’s country from the pull-down list.

State/Province

Select the warehouse’s state or province from the pull-down list.

Default
Warehouse

This box indicates if this is the default warehouse. If you want to make
this warehouse the default, use the Mark as Default toolbar button (
Only the default warehouse is used by the checkout process. Additional
warehouses are unused until they are made the default.

4. Click the Save button (

).

Changing the Default Warehouse
To change the default warehouse, follow these steps.
1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Shipping > Warehouses.
2. Click the radio button next to the warehouse that you want to
make the default.
3. Click Action > Mark Default Warehouse.
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NOTE

You can also specify a warehouse as the default via the Edit Warehouse screen’s
Mark Default Warehouse toolbar button

.

4. A confirmation dialog appears. Click OK.

Editing a Warehouse
Follow these steps to edit a warehouse. See Also: ”Warehouse” on
page 1134
1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Shipping > Warehouses.
2. Click the warehouse that you want to edit.
3. Click the Edit button (

).

4. Edit any of the fields, which are described in ”Use the following
table to complete the screen.” on page 1135.
5. Click the Save button (

).

Deleting a Warehouse
Follow these steps to delete a warehouse. See Also: ”Warehouse”
on page 1134
NOTE

You cannot delete the default warehouse. However, you can designate another
warehouse as the default, then delete the one that was the default. See Also:
”Changing the Default Warehouse” on page 1135

1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Shipping > Warehouse.
2. Click the warehouse that you want to delete.
3. Click the Delete button (

).

4. A confirmation message appears. Click OK.
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5. The warehouse is deleted.

Packages
The Packages screen lets you define standard sizes of packaging.
Use it to define every package size that your shipping department
uses to ship your products.
If you use a provider such as UPS® or FedEx®, it is likely they
provide boxes.

How Packaging Information Is Used
Each item in an order has size and weight dimensions. The
shipping calculator uses this information to fit the order into the
smallest-sized and fewest packages. It then passes packaging
information (number, sizes and weight) to the shipping provider,
which returns the order’s shipping costs.
If a catalog entry’s dimensions exceed all box sizes, eCommerce
passes that product’s dimensions to the shipping provider.
NOTE

Some shipping providers, FedEx and UPS for example, have limits on the size &
weight of packages they are willing to ship. If the size or weight exceeds their
limits, shipping rates may not be returned when a site visitor is going through the
checkout process. If shipping rates are not returned during checkout, an
Application error is logged in the Event Viewer. This prevents a site visitor from
continuing the checkout process.

See Also:
•

”Size and Weight Units of Measure” on page 1138

•

”Creating a New Package” on page 1138

•

”Editing a Package” on page 1139
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•

”Deleting a Package” on page 1139

Size and Weight Units of Measure
Packages use size and weight measurements. By default, Ektron
CMS400.NET uses English units of measure (inches and pounds).
At the beginning of your eCommerce implementation, you can
change to metric units of measure by updating the web.config file’s
ek_measurementsystem tag value to metric.
WARNING!

After your eCommerce feature goes live, do not change the
ek_measurementsystem value in web.config.

Creating a New Package
To create a new package, follow these steps. See Also:
”Packages” on page 1137
1. Go to Modules > Commerce > Shipping > Packages.
2. Click New > Package.
3. Use the following table to complete the screen.

Field

Description

Name

Enter a text description of this package size.

Length

Enter the package’s length in the units of measure that appear to the right
(inches or centimeters). See Also: ”Size and Weight Units of Measure” on
page 1138

Height

Enter the package’s height in the units of measure that appear to the right
(inches or centimeters).

Width

Enter the package’s width in the units of measure that appear to the right
(inches or centimeters).

Max Weight

Enter the package’s weight in the units of measure that appear to the
right (pounds or kilograms).

4. Click the Save button (

).
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Editing a Package
Follow these steps to edit a package. See Also: ”Warehouse” on
page 1134
1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Shipping > Packages.
2. Click the package that you want to edit.
3. Click the Edit button (

).

4. Edit any of the fields, which are described in ”Use the following
table to complete the screen.” on page 1138.
5. Click the Save button (

).

Deleting a Package
Follow these steps to delete a package. See Also: ”Warehouse” on
page 1134
1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Shipping > Packages.
2. Click the package that you want to delete.
3. Click the Delete button (

).

4. A confirmation message appears. Click OK.
5. The package is deleted.

Shipping Methods
Use the Shipping Methods to define all choices your site visitors
will have for delivering their purchases.
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Prerequisites:
•

Default warehouse with an address

•

A default shipping provider is defined in the
siteroot\shipment.config file

See Also:
•

”Defining Shipping Providers” on page 1140

•

”Defining the Default Shipping Provider” on page 1141

•

”Adding a Shipping Method” on page 1142

•

”Editing a Shipping Method” on page 1143

•

”Deleting a Shipping Method” on page 1143

•

”Changing the Order of the Shipping Method” on page 1143

Defining Shipping Providers
When you install Ektron CMS400.NET, several providers exist in the
siteroot\shipment.config file:
•

FedExShipmentProvider

•

FlatRateShipmentProvider

•

UPSShipmentProvider

However, the FedEx and UPS information is for testing purposes
only. In order to use FedEx, UPS or another shipping provider,
obtain the following information from them.

NOTE

•

service URL

•

key

•

password

•

account number

•

meter number

•

transactionId

The above list can vary slightly for each provider.

Then, enter that information into shipment.config, following the
format of providers already in the file.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1140

eCommerce Shipping Screens

The shipment.config file also contains name and type properties for
each provider (shown in red below).
name="FedExShipmentProvider"
type="Ektron.Cms.Commerce.Shipment.Services.FedExShipmentProvider, Ektron.Cms.Commerce"

The red text that you insert (above) is not important, but the two
strings must match.

Defining the Default Shipping Provider
While you can define any number of shipping providers in the
shipment.config file, only one can be active. The active provider
appears on the Modules > Commerce > Shipping > Methods >
New > Shipping Method screen when you click View Options.

Specify the default (active) shipping provider via the
defaultprovider property (highlighted in red below) in
siteroot\shipment.config.
<?xml version="1.0" encoding="utf-8" ?>
<shipmentProvider defaultProvider="FedExShipmentProvider">
<providers>
<add name="FedExShipmentProvider" .
.
.</shipmentProvider>
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Adding a Shipping Method
Use the Add Shipping Method screens to select shipping methods
you will support. When a site visitor submits an order, these
shipping choices appear on the Shipping screen. See Also:
”Shipping Methods” on page 1139
To add shipping methods, follow these steps.
1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Shipping > Methods.
2. Click New > Shipping Method.
3. The Add Shipping Method screen appears.

4. Use the following table to complete the screen.
Field

Description

Name

Enter the name of the shipping method. Site visitors select a
shipping method for their order using this name (see example
below).

Tip! First click View Options and select a shipping method. Then
enter its name here.
Active

Check this box if you want site visitors to be able to select this
shipping method.
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Field

Description

Provider
Service

As explained in ”Defining the Default Shipping Provider” on
page 1141, a default shipping provider is defined in your site’s
shipment.config file. To view all methods offered by that provider,
click View Options. Then, select from the dropdown list that
appears.

Editing a Shipping Method
1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Shipping > Methods.
2. Click the Shipping Method that you want to edit.
3. The View Shipping Method screen appears.
4. Click the Edit button (

).

5. See ”Use the following table to complete the screen.” on
page 1142.

Deleting a Shipping Method
1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Shipping > Methods.
2. Click the Shipping Method that you want to edit.
3. The View Shipping Method screen appears.
4. Click the Delete button (

).

Changing the Order of the Shipping Method
Each shipping method you define has an Order field. This
determines the sequence in which shipping methods appear on
the Shipping Rates screen when a site visitor is submitting an
order.
The shipping method with 1 in the Order field appears at the top of
the list.
By default, every shipping method’s order is set to 1. To set a
sequence for shipping methods, follow these steps
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1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Shipping > Methods.
2. Click Action > Reorder.
3. Use the selection bar and arrows to arrange methods in the
desired sequence.

4. Click Action > Save.
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eCommerce Tax Screens

eCommerce provides a set of tax screens in the Ektron
CMS400.NET Workarea that lets you

•

set up tax classes (for example, goods, services, tobacco)

•

define tax rates for these geographic entities (from most to
least specific)
- postal code
- region
- country

See Also:
•

”How an Order’s Tax Amount is Calculated” on page 1145

•

”The Tax Class Screens” on page 1147

•

”Postal Tax Tables” on page 1149

•

”Regional Tax Tables” on page 1151

•

”Country Tax Tables” on page 1153

How an Order’s Tax Amount is Calculated
During checkout, Ektron CMS400.NET tries to find a tax rate for
each catalog entry’s Tax Class (shown below) and the shipping
address’s postal code.
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The following table describes what happens next.

checks for this tax

If it finds a tax rate for geographic
entity

If it does not find a tax rate for
geographic entity

1.

It adds that amount and stops.

It checks the customer’s address for
a regional tax code.

Ek tr on CM S40 0. NET

Postal code

For example

2.

Region

•

an item costs $100.00

•

the postal code tax rate = 5%

•

the adjusted cost is $105.00

It adds that amount and stops.
For example

3.

Country

•

an item costs $100.00

•

the regional tax rate = 7%

•

the adjusted cost is $107.00

It adds that amount.

It checks the customer’s address for
a country tax code.

No tax is added to the order.

For example
•

an item costs $100.00

•

the country tax rate = 10%

•

the adjusted cost is $110.00
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TIP!

If a postal zone has several taxes (for example, a local tax and a regional tax),
build the combined percentage into the postal code tax. So, assume New York
City has a 4% tax, and New York state has a 3% tax. In this case, enter a
combined total of 7% into all postal zones within New York City. See Also: ”The
Tax Class Screens” on page 1147

The Tax Class Screens
Use the Tax Class screen to define all classes of catalog entries
that can be taxed. When you install eCommerce, the following tax
classes are installed.
•

alcohol

•

goods

•

service

•

tobacco

You can modify or delete these, and add new classes at any time.
You assign a tax class to a catalog entry via its Properties tab’s
Tax Class field (shown below).

See Also:
•

”How an Order’s Tax Amount is Calculated” on page 1145

•

”eCommerce Tax Screens” on page 1145
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•

”Creating a New Tax Class” on page 1148

•

”Editing a Tax Class” on page 1148

•

”Deleting a Tax Class” on page 1149

Creating a New Tax Class
To create a new tax class, follow these steps. See Also: ”The Tax
Class Screens” on page 1147
1. Go to Modules > Commerce > Tax > Classes.

2. Click New > Tax Class.
3. Enter the name of the tax class.
4. Press the Save button (

).

Editing a Tax Class
To edit a tax class, follow these steps. See Also: ”The Tax Class
Screens” on page 1147
1. Go to Modules > Commerce > Tax > Classes.
2. Click the Tax Class that you want to edit.
3. Click the Edit button (

).

4. Edit the name of the tax class.
5. Press the Save button (

).
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Deleting a Tax Class
IMPORTANT!

If a tax class has been assigned to a catalog entry that appears on any order, the
Delete button does not appear.

To delete a tax class, follow these steps.
1. Go to Modules > Commerce > Tax > Classes.
2. Click the Tax Class that you want to delete.
3. Click the Delete button (

).

4. A confirmation message appears. Click OK.
5. The Tax Class is deleted.

Postal Tax Tables
Use postal code tax tables to identify local areas (cities, counties,
etc.) that apply taxes to eCommerce catalog entries. The areas are
identified by their postal code. For example, London, England
taxes alcohol delivered to addresses within it.
You only need to create a postal tax table if the area that applies
the tax is smaller than a country’s geographical regions (states,
provinces, etc.). If an entire region applies a tax, use a regional tax
table.
See Also:
•

”How an Order’s Tax Amount is Calculated” on page 1145

•

”eCommerce Tax Screens” on page 1145

•

”Creating a New Postal Code Tax Table” on page 1149

•

”Editing a Postal Code Tax Table” on page 1151

•

”Deleting a Postal Code Tax Table” on page 1151

Creating a New Postal Code Tax Table
Prerequisite: The postal code’s country and region are defined in
the Regions and Countries screens
To create a new postal code tax table, follow these steps. See
Also: ”Postal Tax Tables” on page 1149
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1. Go to Modules > Commerce > Tax > Postal Tax Tables.
2. Click New > Postal Code.

3. Use the following table to complete the screen.
Field

Description

Postal Code

Enter the postal code for which you want to enter a tax rate. If this is
for a US state, the code must consist of five or nine digits.

Country

Enter the country in which the postal code resides.

Region

Enter the geographic region (for example, state or province) in which
the postal code resides.

Tax Rates:

For any tax class, enter a tax rate as a whole number. For example, if
the tax is 7%, enter 7. See Also: ”The Tax Class Screens” on
page 1147

Alcohol
Goods
Services
Tobacco
Note: Your list
may vary.

4. Press the Save button (

).
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Editing a Postal Code Tax Table
To edit a postal code tax table, follow these steps. See Also:
”Postal Tax Tables” on page 1149
1. Go to Modules > Commerce > Tax > Postal Tax Tables.
2. Click the ID of the tax table that you want to edit.
3. Click the Edit button (

).

4. Edit the fields as needed. See ”Use the following table to
complete the screen.” on page 1150
5. Press the Save button (

).

Deleting a Postal Code Tax Table
To delete a postal code tax table, follow these steps.
1. Go to Modules > Commerce > Tax > Postal Tax Tables.
2. Click the ID of the tax table that you want to delete.
3. Click the Delete button (

).

4. A confirmation message appears. Click OK.
5. The postal code tax table is deleted.

Regional Tax Tables
Use regional tax tables to identify regions (states, provinces, etc.)
that apply taxes to eCommerce catalog entries. For example,
within the United States of America, the state of New Jersey
applies a 5% tax on goods purchased on the internet and shipped
to it.
You only need to define a regional tax table if the area that applies
the tax is smaller than a country. If an entire country applies a tax,
use a country tax table.
See Also:
•

”How an Order’s Tax Amount is Calculated” on page 1145

•

”eCommerce Tax Screens” on page 1145

•

”Editing a Regional Tax Table” on page 1152
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•

”Deleting a Regional Tax Table” on page 1153

Editing a Regional Tax Table
A regional tax table is automatically created for every existing
region. By default, all tax rates are zero (0). To change any tax
rate, follow these steps. See Also: ”Regional Tax Tables” on
page 1151
1. Go to Modules > Commerce > Tax > Regional Tax Tables.
2. Select the region for which you want to create a tax table.
3. The View Region Tax Rate screen appears.
4. Click the Edit button (

).

5. Use the following table to complete the screen.
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Field

Description

Name

Select the region for which you want to enter a tax rate.

Tax Rates:

For any tax class, enter a tax rate. See Also: ”The Tax Class
Screens” on page 1147

Alcohol
Goods
Services
Tobacco
Note: Your list
may vary.

6. Press the Save button (

).

Deleting a Regional Tax Table
To delete a regional tax table, follow these steps.
1. Go to Modules > Commerce > Tax > Regional Tax Tables.
2. Click the ID of the tax table that you want to delete.
3. Click the Delete button (

).

4. A confirmation message appears. Click OK.
5. The regional tax table is deleted.

Country Tax Tables
Use country tax tables to identify nations that apply taxes to
eCommerce catalog entries. For example, Ethiopia applies a 5%
tax on goods purchased on the internet and shipped to it.
See Also:
•

”How an Order’s Tax Amount is Calculated” on page 1145

•

”eCommerce Tax Screens” on page 1145

•

”Editing a Country Tax Table” on page 1154

•

”Deleting a Country Tax Table” on page 1155
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Editing a Country Tax Table
A country tax table is automatically created for every existing
country. By default, all tax rates are zero (0). To change any
country tax rate, follow these steps. See Also: ”Country Tax
Tables” on page 1153
1. Go to Modules > Commerce > Tax > Country Tax Tables.
2. Select the country for which you want to edit a tax table.
3. The View Country Tax Rate screen appears.
4. Click the Edit button (

).

5. Use the following table to complete the screen.
Field

Description

Name

Select the country for which you want to enter a tax rate.
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Field

Description

Tax Rates:

For any tax class, enter a tax rate. See Also: ”The Tax Class
Screens” on page 1147

Alcohol
Goods
Services
Tobacco
Note: Your list
may vary.

6. Press the Save button (

).

Deleting a Country Tax Table
To delete a country tax table, follow these steps.
1. Go to Modules > Commerce > Tax > Country Tax Tables.
2. Click the ID of the tax table that you want to delete.
3. Click the Delete button (

).

4. A confirmation message appears. Click OK.
5. The country tax table is deleted.
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As mentioned in ”Deploying eCommerce” on page 1082, you
typically set up configuration screens before you build eCommerce
products. Next, you build the products in the sequence listed below
1. ”Product Types” on page 1156
2. ”Creating a Catalog Folder” on page 1182
3. ”Creating a Catalog Entry” on page 1185
See Also:
•

”eCommerce Analytics” on page 1217

•

”eCommerce Recommendations” on page 1218

Product Types
Create a separate product type definition for each category of
catalog entries that you sell. For example, you might have a
product type for movies, another for books, a third for electronics,
etc.
When thinking about creating new product types, the most
significant differences are the Class field (described below) and
the content page, which defines the XML Smart Form for products
you will create of a Product Type.
See Also:
•

”Product Classes” on page 1157

•

”How Product Types Affect the Creation of Catalog Entries” on
page 1157

•

”Creating a Product Type Step 1: Properties, Attributes &
Media Defaults” on page 1159

•

”Creating a Product Type Step 2: Creating the Content Page”
on page 1180
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•

”Deleting a Product Type” on page 1181

Product Classes
A catalog entry’s product class affects site visitors’ purchasing
options. Classes are explained below.

Class

Description

Example

Kit

Let a site visitor select from any number
of free-text options. Options can increase
or decrease the overall price. See Also:
”Creating a Kit” on page 1165

A computer whose price changes as a site
visitor selects RAM, hard drive, monitor, etc.

Bundle

A catalog entry consisting of several
other catalog entries bundled together. Its
pricing, shipping, images, etc. are
independent of the individual items. See
Also: ”Creating a Bundle” on page 1168

A living room set: couch, end tables and
lamps. Instead of buying each item
separately, the site visitor buys all for a
“package” price.

Product

Simple or complex catalog entries.

A movie in three formats and prices:

A complex product is a “wrapper” that
provides links to related simple products.
Each simple product has its own SKU,
price, inventory data, etc. See Also:
”Creating a Complex Product” on
page 1170

•

VHS ($12.95)

•

DVD ($14.95)

•

Blu-ray ($17.95)

A catalog entry which can provide access
to designated site pages, and may billed
on a recurring basis. See Also: ”Creating
a Subscription” on page 1173

Web site content that is only available to
subscribed members

Subscription

How Product Types Affect the Creation of Catalog Entries
Catalog folders generally contain the same kind of catalog entries,
such as DVDs or digital cameras. Some information applied to a
catalog folder is inherited by all entries in the folder.
After you create product types, apply appropriate ones to catalog
folders using the Catalog Properties screen’s Product Types tab
(shown below).
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Then, when creating a new catalog entry, you first navigate to a
catalog folder. Next, click New and choose a product type
assigned to the folder (shown below).

A product type determines the following aspects of the catalog
entries based on it.

Catalog entry property

For more information, see

Product class

”Product Classes” on page 1157

Content page

”Creating a Product Type Step 2: Creating the Content
Page” on page 1180

Attributes

”Attributes Tab” on page 1161
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Catalog entry property

For more information, see

Media defaults (that is, size of thumbnail
images added to a catalog entry)

”Media Defaults Tab” on page 1164

There are two steps to creating a product type.
•

”Creating a Product Type Step 1: Properties, Attributes &
Media Defaults” on page 1159

•

”Creating a Product Type Step 2: Creating the Content Page”
on page 1180

See Also: ”Deleting a Product Type” on page 1181

Creating a Product Type Step 1: Properties, Attributes & Media
Defaults
To create a product type, go Workarea > Modules > Commerce >
Catalog > Product Types > New > Product Type. Use the
following table to complete the Add Product Type screens.

Tab/Field

Description

Properties Tab
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Tab/Field

Description

Title

Give the product type a unique title. The title identifies this entry on the View Product Types
screen.

Also, when creating a new catalog entry, users must pick a product type from the catalog’s
New menu (shown below).

Description

Enter a description for the product type.

Class

Enter a class for the product type. See Also: ”Product Classes” on page 1157
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Tab/Field

Description

Attributes
Tab

Define additional information about catalog entries based on this product type. By default,
Attributes appear on the Product server control (illustrated below).

As another example, if the Product Type is for movies, attributes might be Actors, Running
Time, Rating, Year Released, etc.
Follow these steps to define a Product Type’s attributes.
1.

Click the Product Type Attributes tab.

2.

Click the Add Attribute button.

3.

Assign a name to the attribute, such as color.

4.

Choose from these data types.
•text
•date
•number
•boolean (yes or no)

5.

Click OK.

(continued on next page)

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1161

eCommerce Products

Tab/Field

Description

Attributes
Tab
(continued)

For example, you want an attribute that describes a chair’s dimensions. You create a textbased attribute for the Product Type you will use to add chairs to a catalog.

Then, whenever you add a new chair to the catalog, you enter its dimensions into the
Attributes tab’s Dimensions field.
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Tab/Field

Description

Attributes
Tab
(continued)

When a site visitor views the chair’s product page, he sees the attribute text below the
thumbnails.

Attribute Statuses
Note: You can delete an attribute only if it is not applied to a catalog entry. If you try to delete
an attribute applied to a catalog entry, it is marked “Inactive.” Inactive attributes can no
longer be assigned.
•

Active - Attribute can be assigned to catalog entries

•

Inactive - Attribute already assigned to one or more catalog entries, but can no longer
be assigned. To make an attribute inactive, click the corresponding Mark for Delete button (

).

•

Not Published - Attribute has been created but Product Type not saved yet

•

Active - Marked for delete. Attribute will be deleted when Product Type is saved.
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Tab/Field

Description

Media
Defaults Tab

If desired, enter sizes of thumbnail images. If you do, thumbnails are automatically
generated for images (added on the Media tab) applied to catalog entries based on this
product type.
To add a new thumbnail size, click Add Thumbnail. To remove one, click the corresponding
Remove button (

).

To edit a thumbnail, click the corresponding Edit button (
the Save button (

). After making the edit, click

).

Viewing a Catalog Entry’s Thumbnails
You can see a catalog entry’s thumbnails by clicking its Media tab, then View Thumbnails.

See Also: ”Product Server Control, thumbnails” on page 1087
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Creating a Kit
A kit is a type of catalog entry that allows a site visitor to select
from free-text options, which can affect the item’s price. The
options can also be placed into logical groups.
For example, if a catalog entry is a laptop computer, one group
may let you enter options for RAM, another for operating system
version, and a third could present hard drive options. This is
illustrated below.

There is no limit to the number of groups you can add, nor the
number of options in a group. All groups and options are simple
text, created on a kit’s Items tab as needed, and can
accommodate a price modifier. The example below shows how to
set up chair color combinations.
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In this example, the options do not affect the price. Here is how the
options appear on a product page.

Consider another example in which the price does change. In this
case, use the Item screen’s Price Modifier field to adjust price
based on the chair frame. As shown below, if the chair frame is
teak, the sale price increases by $25.00.
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Other chair materials might adjust the price as shown below.

Frame material

Price Modifier

Wrought Iron

$0.00

Aluminum

+$15.00

Steel

-$10.00

Note how the Price Modifier can either increase or decrease the
sale price. Here are these options on the product page.
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The chair’s base price is $79.99, and the teak frame increases it to
$104.99.

Creating a Bundle
A bundle consists of several simple products. You would use it to
combine several existing products into one “umbrella” catalog
entry. That entry captures pricing, SKU number, shipping, and
inventory information for the bundle. The information for the
individual entries that make up the bundle are not affected when
one is ordered.
As an example of a bundle using furniture, assume your
eCommerce site sells a chair, a table, and an ottoman separately.
You also sell them together as a set.
Use a bundle to define the set, add pictures, pricing, etc. On the
bundle’s Items tab, you select the individual catalog entries that
make up the bundle, as shown below.
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Here is how this bundle looks on a product page.
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Creating a Complex Product
A Complex Product is similar to a bundle in that one catalog entry
serves as an “umbrella” for other entries. However, unlike a
bundle, a site visitor must select one of the catalog entries. So, the
price is that of the selected entry, not the umbrella item.
The advantage of a Complex Product is its ability to consolidate
several related items under one title, yet allow site visitors to
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choose the item they want. Because each item under the umbrella
is its own catalog entry, it is priced and tracked separately.
For example, a site sells movies in three formats: VHS, DVD, and
Blu-ray. Each is priced differently. To accommodate this, create
catalog entries for the movie in each format, assigning images,
SKU number, pricing, dimensions, etc. Then, create a Complex
Product, make its title the title of the movie, and use the Items tab
to select the catalog entries of the individual formats.
The Product List or Product Search control displays the Complex
Product, which is the movie title. When a site visitor selects that, he
sees the product page, which lists the format and price of each
assigned catalog entry. He can only choose one. See example
below.
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Steps in Creating a Complex Product

Unlike the Kit or Bundle, a complex product does not have its own
product class. Instead, you create a catalog entry whose product
class is product, then assign other catalog entries to it via the
Items tab. As soon as you assign one catalog entry via the Items
tab, the original catalog entry is converted to a Complex Product.
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Note that the price of the “umbrella” product appears on the
Product List and Product Search server controls. This can be
misleading, since the price of individual items within the complex
product can vary.
NOTE

You cannot apply tier pricing to a complex product. See Also: ”Tier Pricing” on
page 1201

Creating a Subscription
A subscription is a good or service which
•

can be billed on a one-time or a recurring basis

•

places users who purchase it into a designated membership
group, letting you grant them access to private content

Examples include
•

content only available to members who purchase a
subscription

•

a gym membership
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•

a book club, in which a customer makes the same payment
and receives a different book each month

•

anti-virus software that expires after 12 months

•

a 3-year maintenance contract on a digital television, payable
yearly

If you use the recurring billing feature, the bill can be generated for
any number of months or years, but no other time increments.
Each payment must be the same for the subscription’s term. The
term begins when a customer submits the order.
Below is an example of a subscription-based product.

NOTE

Site visitors cannot apply a cart-level coupon to a subscription-based catalog
entry. See Also: ”Creating a Coupon” on page 1236

Creating a Subscription Based Catalog Entry

Creating a subscription is the similar to creating a regular catalog
entry. The table below lists everything you need to do, highlighting
tasks that are unique to subscriptions.
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Step

For more information, see

1.

”Product Types” on page 1156

Create a subscription-based Product Type.

On the Product Type screen’s Product Class
dropdown, select Subscription (illustrated below).

2.

Assign the Product Type to a catalog folder.

•

”How Product Types Affect the Creation of Catalog Entries” on page 1157

•

”Creating a Catalog Folder” on page 1182

3.

In that folder, create a catalog entry for each
subscription.

”Creating a Catalog Entry” on page 1185

4.

On the Pricing tab, enter the cost. If using
recurring billing, enter the term of the
subscription.

•

If this product does not use recurring billing, click
No at the Use Recurring Billing dropdown.

Note: Subscription-based products do not support tier
pricing. See Also: ”Tier Pricing” on page 1201
•

5.

On the Items tab, assign membership and
CMS user groups.

To learn about the Unit Pricing fields, see ”Entering a Catalog Entry’s Price Information” on
page 1198

To learn about Recurring Billing fields, see
”Entering Recurring Billing Information” on
page 1176

”Assigning Membership and User Group to a
Subscription-Based Catalog Entry” on page 1178
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Step

For more information, see

6.

”Subscriptions that Involve Ektron CMS400.NET
Content” on page 1179

If a subscription provides access to E k t r o n
C MS 4 00 .NE T content, use its folder
Permission Table to grant permission to the
membership and CMS user groups you
defined in Step 5.

Entering Recurring Billing Information

IMPORTANT!

Due to differences in the way payment gateways work, Ektron recommends
testing recurring payments with your gateway before processing live transactions.

The Pricing tab’s Recurring Billing area of a subscription-based
catalog entry (highlighted below) lets you determine if a
subscription is billed on a one-time or a recurring basis. If
recurring, it helps you define the terms.

To set up recurring billing (that is, a series of scheduled payments),
click Yes at the Use Recurring Billing dropdown. The recurring
billing term begins when a customer submits an order, and is
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based on a number of months or years. You use the Billing Cycle
dropdown to choose a time interval.
Next, enter a number of Billing Intervals for which a customer is
charged. For example, if a customer should be charged once a
month for 12 months, complete the screen as shown above. If a
customer purchases the item on June 1, 2008, his credit card will
be billed on these dates.
•

June 1, 2008 (purchase date)

•

July 1, 2008

•

August 1, 2008

•

September 1, 2008

•

October 1, 2008

•

November 1, 2008

•

December 1, 2008

•

January 1, 2009

•

February 1, 2009

•

March 1, 2009

•

April 1, 2009

•

May 1, 2009

As another example, if a customer should be charged once a year
for 3 years, complete the screen as shown below.

If a customer purchases the item on June 1, 2008, his credit card
will be charged on the following dates.
•

June 1, 2008 (purchase date)

•

June 1, 2009
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•

June 1, 2010

Assigning Membership and User Group to a Subscription-Based Catalog Entry

You must assign a membership user group to a subscription-based
catalog entry. Optionally, you can assign an Ektron CMS400.NET
user group. You assign groups via the subscription’s Items tab.
See Also: ”Membership User Groups” on page 738; ”Managing
User Groups” on page 723
So, as part of setting up a subscription, you must either create new
membership and (possibly user) groups, or use existing groups.

All users (identified by their email address) who purchase the
product are automatically added to one of the groups.
•

Ektron CMS400.NET users are added to the group defined in

the CMS Author Group field
•

NOTE

Non-Ektron CMS400.NET users are added to the membership
group defined at the Member Group field

Ektron CMS400.NET checks a user’s email address to determine if he is a
CMS or a membership user.

Subscriptions that do not Involve Ektron CMS400.NET Content

If a subscription does not involve access to Ektron CMS400.NET
content, the membership group provides a list of customers who
purchased the subscription. You can use the list to manage the
accounts, notify them when the subscription is about to expire, etc.
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If a subscription involves access to Ektron CMS400.NET content,
create a folder and enable one or more subscription-based product
types on its Product Type screen (illustrated below).

Place the subscription products in that folder. Site visitors shop for
and purchase this content on your Web site as they do all
products, via eCommerce server controls.
Then, create a regular content folder in which to create the
confidential content. Next, use the content folder’s permission
table to grant the subscription user groups access to that folder
(illustrated below).

See Also: ”Setting Permissions” on page 768 and ”Assigning
Permissions for Memberships” on page 742
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Creating a Product Type Step 2: Creating the Content Page
After you complete and save the Add Product Type screen, a new
screen allows you to enter XML Smart Form information. On this
screen, you set up fields to collect information for the content page
of catalog entries based on this product type. See example below.

The content page appears on the Product server control,
describing this catalog entry to site visitors. See example below.
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The process of creating a product type content page is the same
as creating an XML Smart Form, described in ”Before You Manage
Smart Forms” on page 183.

Editing a Product Type
1. In the Ektron CMS400.NET Workarea, go to Modules >
Commerce > Catalog > Product Types.
2. Click the product type that you want to edit.
3. See ”A product type determines the following aspects of the
catalog entries based on it.” on page 1158.
NOTE

You cannot edit a Product Type’s Class.

Deleting a Product Type
Prerequisite: The product type is not assigned to any catalog
entries
1. In the Ektron CMS400.NET Workarea, go to Modules >
Commerce > Catalog > Product Types.
2. Click a product type you want to delete.
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3. Click the Delete button (

).

4. A confirmation message appears.
5. Click OK.
TIP!

Although you cannot delete a product type that is being used, you can prevent
users from creating new catalog entries based on it. To do this, go to each
applicable folder’s Catalog Properties > Product Types screen and remove that
product type.

Creating a Catalog Folder
Prerequisite: One or more product types (See Also: ”Product
Types” on page 1156)
A catalog folder is a special kind of Ektron CMS400.NET folder
designed to hold eCommerce entries. Its unique icon ( )
distinguishes it from other folder types. If you are familiar with
content folders, much of that information applies to catalog folders.
See Also: ”Managing Content Folders” on page 34
Catalog folders have several tabs/screens, as shown below.
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These screens are the same as regular content folders.
•

Properties - see ”Fields on the Folder Properties Screen” on
page 43

•

Web Alerts - see ”Web Alert Feature” on page 1013

•

Metadata - see ”Assigning Metadata to a Folder” on page 141

•

Breadcrumb - see ”Breadcrumbs” on page 59

The unique screen is Product Types. See Also: ”Assigning a
Catalog Folder’s Product Type” on page 1183
Like content folders, the following catalog folder information can be
inherited from its parent or uniquely set for each catalog. You can
only make changes after creating the catalog.
•

Permissions - see ”Setting Permissions for a Content Folder”
on page 772

•

Approvals - ”Creating an Approval Chain for a Content Folder”
on page 780

•

Purge History - ”Purge History” on page 56

•

Restore Web Alert Inheritance - ”Inheriting Content-Level Web
Alert Information from Its Folder” on page 1045

See Also: ”Deleting a Catalog Folder” on page 1184

Assigning a Catalog Folder’s Product Type
A catalog folder’s Product Types screen lets you identify product
types upon which catalog entries can be based. See Also: ”Product
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Types” on page 1156 and ”How Product Types Affect the Creation
of Catalog Entries” on page 1157
For example, you created a lawn mower Product Type, and want
only lawn mowers to be entered in a catalog folder. In this case,
open a catalog folder’s Product Types tab, break inheritance if
necessary, and select Lawn Mower as the catalog’s only product
type.

Then, when a Ektron CMS400.NET user creates an entry in this
catalog, he must use the Lawn Mower product type.

Deleting a Catalog Folder
Prerequisite: No catalog entries in the folder have been placed on
an order
To delete a catalog folder, follow these steps.
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1. Navigate to the folder that you want to delete.
2. Click Delete > This Catalog.
3. A confirmation message appears.
4. Click OK.

Creating a Catalog Entry
Prerequisite: One or more catalog folders (See Also: ”Creating a
Catalog Folder” on page 1182)
A Catalog entry is the eCommerce term that describes a product
sold on your Web site. It is similar to content in the rest of Ektron
CMS400.NET, so those concepts apply to catalog entries. You
should be familiar with ”Managing HTML Content” on page 69
before reading this section.
Catalog entries are built from Ektron CMS400.NET XML Smart
Forms, so use the same content and folder structure as other
Smart Forms. Catalog entries also share the following features
with regular content.
•

content status

•

approvals and permissions

•

metadata

•

schedule

•

history and the ability to restore previous versions

•

search

•

taxonomies to categorize products

Catalog entries also have unique information, such as
•

Tax Class - determines which taxes apply to item

•

Physical dimensions - used to calculate shipping costs

•

Inventory tracking

•

Pricing - can be fixed or variable for any currency
- tier pricing, that is, price adjusts when quantity reaches new
plateau. For example, 1-9 items cost $500 each. But if 10
are sold, the price drops to $450 each.
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•

Images (full sized and thumbnail) to display the product on your
Web Site

Because there is so much information to provide about managing
catalog entries, this section takes two approaches
•

”Catalog Entry Screens and Menu Options” on page 1186
describes all accessible options (tables, menus, etc.) from the
catalog entry screen

•

”Catalog Entry Tasks” on page 1186 describes how to do
things with catalog entries: create them, delete them, etc.

Catalog Entry Screens and Menu Options
•

”Tabs on the Catalog Entry Screen” on page 1190

•

”Menu Options on the Catalog Entry Screen” on page 1193

•

”Folder View Menu options” on page 1212

•

”Content View Menu Options” on page 1213

Catalog Entry Tasks
•

”Creating/Updating Content” on page 1187

•

”Deleting a Catalog Entry” on page 1188

•

”Adding Cross Sell and Upsell Recommendations to a Catalog
Entry” on page 1218

•

View and restore a previous version of a catalog entry Navigate to catalog folder > select catalog entry > View Menu
> Content History option. See Also: ”Content History” on
page 1214

•

Edit permissions for a catalog entry - To enable this, break
permission inheritance. Then, assign permissions to selected
users. See Also: ”Setting Permissions for Content” on
page 776

•

Edit inherited approval chain - First break permission
inheritance, and assign permission to users who need to be in
the approval chain. Then, update the catalog entry’s approval
chain. See Also: ”Editing an Approval Chain For Content” on
page 784

•

Make a catalog entry private, so that the Web site search does
not find it - See ”Private Content” on page 744
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•

Archive a catalog entry - See ”Archived” on page 1196

Creating/Updating Content
Follow these steps to create a new catalog entry or update an
existing one.
1. Navigate to a catalog folder in which you want to create or
update a catalog entry. See Also: ”Creating a Catalog Folder”
on page 1182
2. Click New then select a product type on which to base the
entry. See Also: ”Product Types” on page 1156

3. Complete the screens as needed. The required fields are:
- content Title
- Properties tab > SKU Number
- any fields on the content screen that your Ektron CMS400.NET
administrator has designated as required
For information on the catalog entry screens, see ”Tabs on the
Catalog Entry Screen” on page 1190
4. Check in or submit/publish the content. See ”Action Menu” on
page 1216.
NOTE

After signing in to your Web site, you can also update a catalog entry’s information
from there.
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See Also: ”Using the Web Site Interface” on page 20

Deleting a Catalog Entry
Prerequisites:

EKTRONBESTPRACTICE

•

Catalog entry is not on an order, or checked out.

•

You have delete permission for this catalog folder. See Also:
”Setting Permissions” on page 768

Do not delete catalog entries. For example, if you delete an entry from your
staging site, then run an eSync, that entry is removed from all active carts on your
live site.
Instead of deleting entries, Ektron recommends archiving them using the
Properties tab’s Archived checkbox (shown below).
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TIP!

If you want to prevent site visitors from purchasing an item, but you cannot delete
it because it has been placed on existing orders, you have two options.
* Uncheck its Buyable checkbox, located on the Properties screen (circled
below). If you do, the product still appears on your Web site, but the Add to Cart
button does not appear next to it.

* Archive it, using the Archived check box on the Properties screen (circled
above). In this case, the product does not appear on your Web site. See Also:
”Archived” on page 1196

Follow these steps to delete a catalog entry.
1. Navigate to the catalog folder that contains the entry.
2. Click the entry.
3. Click Action > Delete.

4. A warning message appears. Click OK.
5. The catalog entry is deleted.
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Tabs on the Catalog Entry Screen
Tab

Description

For more information, see

Content

The entry’s content page.

”Entering a Catalog Entry’s Content” on
page 1193

Summary

The content summary, by default the first 40
characters of the content text.

”Auto Generating Summaries” on
page 80 and “Adding a Content
Summary” in the E k t r o n C M S 4 0 0 . N E T
User Manual

Properties

eCommerce information about the catalog
entry:

”Entering a Catalog Entry’s Properties”
on page 1194

Pricing

•

SKU number

•

Number of Units

•

Tax Class

•

Archived

•

Buyable

•

Dimensions

•

Inventory

•

Lets you define list and sales price

•

For each enabled currency, you can set a
fixed price or have it float with exchange
rate

•

Allows tier pricing

•

For subscription products, you enter
recurring billing interval and term

”Entering a Catalog Entry’s Price
Information” on page 1198

Attributes

Additional information to help describe a
catalog entry

”Entering a Catalog Entry’s Attributes” on
page 1205

Media

Lets you add images that appear on several
eCommerce server controls

”Entering a Catalog Entry’s Media” on
page 1207
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Tab

Description

For more information, see

Items

Catalog entries that you are adding to this
“umbrella” item.

”Entering a Catalog Entry’s Items” on
page 1211

•

If you add catalog entries to a simple
product, it becomes a complex product.

”Creating a Complex Product” on
page 1170

•

For bundles, add catalog entries that
make up a bundle.

”Creating a Bundle” on page 1168

•

For kits, enter groups and their options.

”Creating a Subscription” on page 1173

•

For subscription products, define membership and E ktron CM S40 0. NET user
groups to which users are assigned when
they purchase the subscription.

Metadata

Enter meta tags, title tags, etc.

”Creating a Kit” on page 1165

”Metadata” on page 118

Note: When viewing the metadata screen in
view mode only, you see the catalog entry’s
Product Icon. The product icon is set on the
media tab. See Also: ”Product List, Product
Search, and Recommendation server
controls” on page 1088
Alias

Note: This tab only appears if Aliasing is
enabled.

”Adding a Manual Alias via the Alias Tab”
on page 596
”URL Aliasing” on page 559

Schedule

•

View and edit the catalog entry’s primary
manual alias

•

View all automatic aliases assigned to
this catalog entry

Lets you control when a version of a catalog
entry becomes visible on the Web site.
Similarly, you can remove a catalog entry on a
predetermined date and time.

Ek tron CM S40 0.NET User Manual >

“Working with Folders and Content” >
“Scheduling Content to Begin and End”

Note: The Archive and remain on the site
option is not available with catalog entries.
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Tab

Description

Comment

View comments on changes made when
editing a catalog entry.

For more information, see

Note: To view and edit catalog entry
comments, open the editor and choose
Change > Comment.

The comment also appears on the View
Content and Content History screens. Use it
to help distinguish one version from another.
Tasks

View tasks assigned to this catalog entry.
Note: To add a task from the View Entry
screen, click Action > Add Task.

Category

Add a taxonomy category to the catalog entry.
A list of available taxonomies and whether
one is required are defined on the Catalog
properties screen.
Note: This tab only appears if at least one
taxonomy is assigned to the catalog folder.

; E k t r o n C M S 4 0 0. NE T User Manual >
“Managing Tasks”

”Taxonomy” on page 634; ”Assigning a
Taxonomy or Category to Content via the
Edit Content Screen” on page 654
”Fields on the Folder Properties Screen”
on page 43
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Menu Options on the Catalog Entry Screen

Menu Option

Description

Action Menu
Save

Saves the catalog entry without leaving the editor. It is a good idea to
save your work frequently.

Checkin

Save and check-in the document. This action returns the changed
content to the database and exits the editor. It does not submit the
content into the approval chain. Rather, it allows you and other users to
continue changing it.

Submit/Publish

Submit the content into the approval chain. This action also returns the
new or updated content to the database and exits the editor.
Publish the content to the Web site.
Note: Only the last approver in the approval chain sees this button. If no
approval chain is assigned to the content’s folder, every authorized user
sees this button. See Also: ”Setting Approval Chains” on page 778
This action also returns the changed content to the database and exits
the editor.

Undo checkout

Exit screen and do not save changes made since you began editing this
catalog entry.

Change Menu
Comment

Enter comments on changes made when editing a catalog entry.
The comment also appears on the View Content and Content History
screens. Use it to help distinguish one version from another.

Template

A folder’s default template is automatically applied to all content in the
folder. However, you can change a content item’s template to any of
those assigned to the folder. See Also: ”Assigning Templates to Content”
on page 77

Entering a Catalog Entry’s Content
The Content tab displays the content page of this catalog entry’s
product type. See Also: ”Creating a Product Type Step 2: Creating
the Content Page” on page 1180
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Because the format is customized for your system, this
documentation cannot explain how to respond to the fields.
To learn about working with the editor, seethe Ektron CMS400.NET
User Manual section “Introduction to Ektron CMS400.NET Editors.”

Entering a Catalog Entry’s Summary
See ”Auto Generating Summaries” on page 80 and “Adding a
Content Summary” in the Ektron CMS400.NET User Manual

Entering a Catalog Entry’s Properties
The Properties screen collects eCommerce-specific information
about your catalog entries.
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Use the following table to complete the Properties screen.
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Property

Description

SKU

Enter a unique SKU code for this catalog entry. This is a required field that
does not accept a value of zero (0) or a space character.

Number of Units

If this item has a quantity other than one (1) for internal record-keeping
purposes only, enter that number.
For example, a 12 pack of soda. Set Quantity is 12 to represent the number
of units. But a site visitor still orders 1 of the item.
The quantity is not used when this item is ordered, nor does it affect inventory
levels. It is used for clerical purposes only.

Tax Class

Select the catalog entry’s Tax Class. See Also: ”The Tax Class Screens” on
page 1147

Archived

Check this box if you want to archive this catalog entry. Once archived, site
visitors can no longer see nor order it.
Also, E k t r o n C M S 4 0 0 . N E T users cannot view an archived catalog entry in
its catalog folder via the View Folders screen. To view it, open its catalog
folder then select View > Archive.

To make the entry available again on your Web site, open its archive folder,
edit the entry by unchecking the Archived check box, and publish it.
Note: A catalog entry can also be set to Archived status if it reaches its
expiration date and its Schedule tab > Action on End Date field is set to
Archive and remove from site (expire). See Also: Ek tr on CMS 40 0.NET
User Manual > “Working with Folders and Content“ > “Scheduling Content to
Begin and End” > “Setting Archive Options.”
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Property

Description

Buyable

To let site visitors add this catalog entry to a shopping cart, check this box.
Otherwise, uncheck it.
If a product is not buyable, it can still be seen by site visitors, but its product
page does not display an Add to Cart button.
Tip! To remove a catalog entry from your site, use the Archive field.

Dimensions - Used to calculate packaging containers and shipping costs. See Also: ”Packages” on
page 1137
Tangible Item

Check this box if the item is tangible, that is, it has dimensions, weight, and
will be shipped to a customer. Examples of non-tangible items are services,
warranties, and downloadable software.
If a catalog entry is tangible, you must enter its height, width, length, and
weight.

Height

Enter the catalog entry’s height. The units of measure are specified in the
web.config file’s ek_measurementsystem property.
Required if Tangible Item is checked.

Width

Enter the catalog entry’s width. Required if Tangible Item is checked.

Length

Enter the catalog entry’s length. Required if Tangible Item is checked.

Weight

Enter the catalog entry’s weight. Required if Tangible Item is checked.

Inventory - eCommerce’s inventory system is a provider model, allowing you to connect with thirdparty inventory systems.
Disable Inventory

Check this box if you do not want to track inventory activity for this catalog
entry. As examples, it is a service contract or a subscription to confidential
content on your site.

In Stock

Enter the number of items on hand for this catalog entry.
This number is automatically adjusted when an order containing this entry is
submitted. For example, there are 100 items in stock. When an order for 10 is
submitted, the In Stock value changes to 90.
If the amount placed on an order exceeds the In Stock amount, the site visitor
see this message “The item ... is not available for purchase. Please remove
from cart before submitting order.”

On Order

The number of items that have been ordered but not yet delivered appears.
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Property

Description

Reorder

Enter the In Stock quantity at which you need to reorder this item. When the
In Stock quantity reaches this level, an event is triggered which can be used
by an external inventory system to generate a new order.

Entering a Catalog Entry’s Price Information
Use the Pricing screen to enter price information for catalog
entries.

Use the following table to complete the Pricing screen.
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Field

Description

Currency selector

Use this dropdown to select a currency for the prices. See Also: ”Alternate
Currency Pricing” on page 1200

Only enabled currencies appear. See Also: ”Enabled Currencies” on
page 1099
List price

Enter the catalog entry’s list, or manufacturer’s suggested retail, price.
The list price appears on most eCommerce controls (see examples below) but
is not used in any calculations.
Cart server control

Product Search server control

Our Sales Price

Enter the catalog entry’s sale price. This price is used to calculate line item
totals, coupon discounts, shipping costs, etc.
The sales price appears on most eCommerce controls. See examples above.
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Field

Description

Add Pricing Tier
button

”Tier Pricing” on page 1201

Recurring Billing
(appears only for
subscriptionbased products)

”Creating a Subscription” on page 1173

Alternate Currency Pricing

By default, the Pricing screen converts prices to every enabled
currency (see screen below), using the exchange rate. Site visitors
who select a non-default currency see these prices. See Also:
”Updating the Exchange Rate” on page 1103

The Float checkbox (checked by default) indicates that prices
change as the exchange rate changes.
If you do not want to float a catalog entry’s price, but instead fix it
for a currency, select the currency, uncheck Float, edit the price,
and publish. From then on, if a site visitor selects that currency and
catalog entry, the price set on this screen is used. The exchange
rate is ignored.
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For example, a television costs 700 Euros, regardless of its cost in
US dollars or the exchange rate. To incorporate this, do not check
the Float checkbox.
When you first select EUR on the Pricing screen, the default
currency’s prices are converted using the exchange rate. For
example, the television’s sale price is $1000 US dollars, and
today’s exchange rate is .7811. When you select Eur from the
Pricing screen’s currency selector, the television’s cost is set at
781.10 Euros. You change the price to 700.00 Euros.
From that point on, the Euro price only changes if an authorized
user accesses this screen and changes it manually.
Tier Pricing

eCommerce supports tier pricing, that is, a pricing schedule that
adjusts according to order quantity. Typically, the price is reduced
as more items are ordered. For example, if a visitor orders 1-5,
items are $10.00 each; 6-10, $9.00 each; 11 or more, $8.50 each.
NOTE

Tier pricing is not supported for subscription products, nor for complex products.
See Also: ”Creating a Subscription” on page 1173, ”Creating a Complex Product”
on page 1170

To set up tier pricing, follow these steps.
1. In the Workarea, open the catalog folder containing the entry to
which you want to apply tier pricing.
2. Edit the catalog entry.
3. Click the Pricing tab
4. Click the Add Pricing Tier button (shown below).
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5. The following screen section appears.

6. In the left column, enter the quantity of items above which the
tier price is used.
7. In the right column, enter the price to be used when an order
quantity exceeds the number in the left column.
8. Enter as many tiers as necessary.
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NOTE

To remove a tier, check the box to its left, then click the Remove Pricing Tier
button.

Tier Pricing and Non-Default Currencies: When Floated

If a non-default currency is floated, then that currency’s pricing
tiers mirror the default currency’s pricing tier values. The amounts
are adjusted by the exchange rate.
These values appear on pricing screen in view-only mode and
cannot be changed. This is illustrated below.
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If pricing tiers are set up for the default currency and the user
unchecks the Float box, he is notified that the pricing tiers can now
be edited. Next, Tier Pricing fields are loaded with the existing
values but the user can change values, remove existing tiers, and
add new ones.
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Tier Pricing and Non-Default Currencies: When Not Floated

If a non-default currency is not floated, its pricing tiers are
independent of the default currency’s. That is, they do not exist
initially regardless of whether they exist for the default currency. If
the user clicks Add Pricing Tier, Tier Pricing fields appear and let
the user enter number of units and corresponding tier price per
unit.
If pricing tiers are set up for a non-default currency and the user
checks the Float box, the pricing tiers are changed to mirror those
of the default currency. If the default currency has no pricing tiers,
then that currency has none. You cannot independently edit a nondefault currency’s pricing tiers if Float is checked.

Entering a Catalog Entry’s Attributes
Attributes are additional pieces of information that help describe a
catalog entry. To illustrate the concept, the following attributes are
applied to furniture in Ektron CMS400.NET’s sample site.

In the Workarea, you select a catalog entry then click the
Attributes tab to enter or modify attribute values. In the above
example, you could change model year to 2009, or style to
Woodland. You cannot however change fields, field names, or
data types.
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NOTE

If no attributes are assigned to the product type on which a catalog entry is based,
you will not see an Attributes tab when working with that catalog entry.

On your Web site, a catalog entry’s Attribute field names and
values appear by default on the Product server control, as shown
below.
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Origin of Attributes

Attribute fields, data types, and default values are created as part
of a Product Type. See Also: ”Attributes Tab” on page 1161
When you create a catalog entry, you base it on a product type.
The product type’s Attribute information is imported to the catalog
entry.

What Happens to a Catalog Entry’s Attributes When Moved

Like metadata that follows Ektron CMS400.NET content, if a catalog
entry is moved to another folder, its attributes stay with it.

Entering a Catalog Entry’s Media
Use the Media tab to add product images that appear on the
following server controls.
•

Product (the smallest thumbnail may appear)

•

Product List

•

Product Search

•

Recommendation

See Also: ”Images in eCommerce” on page 1086
Adding a New Image

Follow these steps to add a new image. See Also: http://
www.w3schools.com/tags/tag_IMG.asp
1. Click the Media tab.
2. Click Add Image (circled below).
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3. Enter an image Title. This is a required field.
4. Enter the image’s Alt text. This is a required field.
5. Click the Browse button and navigate to the image you want to
add.
6. Click the Upload button.
7. The image is uploaded to the siteroot/uploadedimages folder.
NOTE

When an image is uploaded to the Media tab, the original image and any
thumbnails associated with it are added to the Library. For example, if you add an
image named “TestImage” (actual file name: “case.jpg”) with a 150px and 50px
thumbnails, you see the following entries in your library (File Name - Path):
TestImage - /~siteroot~/uploadedImages/case.jpg
case[filename]150 - /~siteroot~/uploadedImages/case[filename]150.jpg
case[filename]50 - /~siteroot~/uploadedImages/case[filename]50.jpg

8. The image appears on the screen, below any existing images.
9. Determine if you want the image’s smallest thumbnail to
appear on the product server control by selecting Yes or No
next to Gallery Display. (See example below). See Also:
”Product Server Control, thumbnails” on page 1087
10. If you want to designate the image as the product icon, click
Set as Product Icon. See Also: ”Product List, Product Search,
and Recommendation server controls” on page 1088
To learn about the image thumbnails, see ”Determining Thumbnail
Size” on page 1209.
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Editing an Existing Image

NOTE

You cannot change an existing image. If you need to do this, delete the image you
do not want, then add the correct one. You can only edit the Title and Alt Text.

1. Click the Media tab.
2. Move the cursor to the field that you want to edit.
3. Click the pencil icon to the right of the field (shown below).

4. Update the text as needed.
5. Click the OK button (

).

Determining Thumbnail Size

When you create a catalog entry, you base it on a Product Type.
The selected product type’s Media Defaults information
determines the sizes of thumbnails created for each image
assigned to the Media tab. See Also: ”Media Defaults Tab” on
page 1164
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•

If the image is less than both thumbnail dimensions (height and
width), it appears full size.

•

If the image is greater than the thumbnail’s dimensions, the
image is reduced proportionately, scaling its dimensions to the
thumbnail size.

The Default Image

If you do not assign an image to a catalog entry, but one is
assigned to appear on a server control, the following default image
is used.

If you want to change the default image, edit the following file:
site root/WorkArea/images/application/Commerce/productImageBackground.gif

Entering a Catalog Entry’s Items
Use the Items tab to add additional information to the current entry.
It is used in these situations.
•

to select the catalog entries that make a product into a complex
product. See Also: ”Creating a Complex Product” on
page 1170

•

to select the catalog entries that make up a bundle. See Also:
”Creating a Bundle” on page 1168

See Also: ”Product Classes” on page 1157
•

NOTE

to select the groups and their options that make up kits. See
Also: ”Creating a Kit” on page 1165

You can only choose a catalog entry whose language matches the language of
the original item.

•

to select a subscription-based catalog entry’s user groups. See
Also: ”Assigning Membership and User Group to a
Subscription-Based Catalog Entry” on page 1178
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Folder View Menu options
The following menu options are available when you open a catalog
folder.

Menu option

Description

New Menu
Catalog

Create a new catalog folder underneath the current one. See Also:
”Creating a Catalog Folder” on page 1182

product types
assigned to folder

Create a new catalog entry based on one of the displayed product
types. Your product types may not match the ones shown below.

Product types are assigned to a catalog’s via the Product Types
screen. See Also: ”Product Types” on page 1156
View Menu
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Menu option

Description

All types,
products, kits,
bundles

Lets you change the display of catalog entries. You can see all
entries in folder, or only those of a selected product class. See Also:
”Product Classes” on page 1157

Language

Limits display of catalog entries to one language.
Also determines the language of any new catalog entries you create
in this folder.

Archive

Displays archived catalog entries. See Also: ”Archived” on
page 1196

Catalog
Properties

Lets you view and edit catalog folder information. See Also:
”Creating a Catalog Folder” on page 1182

Delete Menu - SeeEk tr on CMS 40 0.NET User Manual > “Working with Folders and
Content” > “Delete Menu”
Note - You cannot delete a catalog entry that has been placed on any order. The order’s
status is irrelevant.
Catalog

”Deleting Folders” on page 50

Entries

See
•

”Deleting a Catalog Entry” on page 1188

•

Ek tron CM S40 0.NET User Manual > “Working with Folders

and Content” > “Deleting Content” > “Deleting Several Content
Items in a Folder”
Action Menu
Move entry

”Moving or Copying Content” on page 84
Note: You can only move catalog entries -- you cannot copy them.

Search

See E ktron CM S40 0. NET User Manual > “Working with Folders
and Content” > “Searching the Workarea“ > “The Search Published
Tab”

Content View Menu Options
The following menu options are available when you are viewing a
catalog entry.
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Menu option

Description

Action Menu
Edit

Edit the catalog entry. See Also: ”Tabs on the Catalog Entry Screen”
on page 1190

Delete

See
•

”Deleting a Catalog Entry” on page 1188

•

Ek tron CM S40 0.NET User Manual > “Working with Folders

and Content” > “Deleting Content”
Link Search

Locates all content that includes a Quicklink to the displayed catalog
entry.
This feature is useful before deleting a catalog entry, because it
informs you of every entry that will include a “dead” link if you delete
that entry. You should then edit those catalog entries and remove or
change the obsolete Quicklinks.

Add Task

•

”Managing Tasks” on page 360

•

Ek tron CM S40 0.NET User Manual > “Managing Tasks”

View Menu
Content History

Lists every version of the content available in E k t r o n C M S 4 0 0. NE T .
After viewing the View Content History window, you can click any
version to see its detail.
See Also: Ek tr on CMS 400 .NET User Manual > “Working with
Folders and Content“> “Viewing and Restoring Previous Content” >
“The Content History Window”

View Approvals

Access the catalog folder’s approval chain. See Also: ”Setting
Approval Chains” on page 778
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Menu option

Description

View Permissions

Access the catalog folder’s permissions table. See Also: ”Setting
Permissions” on page 768

Cross Sell

Lets you assign cross sell items to this catalog entry. See Also:
”Adding Cross Sell and Upsell Recommendations to a Catalog
Entry” on page 1218

Up Sell

Lets you assign up sell items to this catalog entry. See Also: ”Adding
Cross Sell and Upsell Recommendations to a Catalog Entry” on
page 1218

View Properties

Lets you
•

view the
- catalog entry’s product type See Also: ”Product Types” on
page 1156
- Flagging Definitions assigned to the catalog entry’s folder See
Also: ”Flagging” on page 964

•

view and edit the Content Searchable setting - The search only
considers content if this field is checked. By default, this field is
checked when an entry is created.

Reports Menu
Content Statistics

”Viewing the Content Rating Report” on page 92

Analytics

Provides a visual display of order information for a selected catalog
entry. See Also: ”eCommerce Analytics” on page 1217

Editor View Menu Options
The following options are available when you are editing a catalog
entry’s content.
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Menu
Option

Description

Action Menu
Save

Save the content without leaving the editor. It is a good idea to save your
work frequently.

Check in

Save and check-in the document. This action returns the changed
content to the database and exits the editor. It does not submit the
content into the approval chain. Rather, it allows you and other users to
continue changing it.

Submit or
Publish

Submit the content into the approval chain. This action also returns the
new or updated content to the database and exits the editor.
Publish the content to the Web site.
Note: Only the last approver in the approval chain sees this button. If no
approval chain is assigned to the content’s folder, every authorized user
sees this button. See Also: ”Setting Approval Chains” on page 778
This action also returns the changed content to the database and exits
the editor.

Undo
Checkout

Close the editor without saving changes.

Change Menu
Comment

Briefly describe the content, or comment on changes made when editing
content. The history comment appears on the View Content and Content
History screens.
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Menu
Option

Description

Template

Lets you specify one or more templates for catalog entries in this folder.
These entries use the specified template when appearing on your Web
site. See Also: ”Assigning Templates to Content” on page 77

eCommerce Analytics
The eCommerce Analytics screen provides a visual display of
order information for a selected catalog entry.

•

The top left section graphs the quantity of this catalog entry
ordered over the past seven days

•

The top right charts the number of orders that used a coupon
versus the number that did not

•

Below that pie chart is another that shows the number of
returning customers versus the number of new ones
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•

The lower part of the screen shows the following order
information
- order number
- date/time when order was entered
- site from which order was entered
- order status
- customer information: new or returning, name, number of
orders entered, value of all orders entered, average order
monetary value
- order monetary value
- whether or not a coupon was used

eCommerce Recommendations
Adding Cross Sell and Upsell Recommendations to a Catalog
Entry
Cross sell and upsell tactics are designed to increase the amount
of cart sales.
Cross sell offers items related to a catalog entry. So, for example, if
someone is purchasing a digital camera, cross sell items might be
a carrying bag, digital photo printer, larger memory cards,
additional warranty, etc.
Up Sell refers to similar but more expensive items. So, for
example, if someone is viewing a 7 megapixel digital camera,
upsell items might be a 10 megapixel camera, or a digital SLR
camera.
The following sections explain how to assign cross sell and up sell
items to any catalog entry, and how to display those options on
your Web site.
See Also:
•

”Assigning Cross Sell and Upsell Items to a Catalog Entry” on
page 1219
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•

”Displaying Cross Sell and Upsell Items on Your Web Site” on
page 1219

Assigning Cross Sell and Upsell Items to a Catalog Entry
1. Open the catalog folder containing the catalog entry to which
you want to assign cross sell items.
2. Click that entry.
3. Click View > Cross Sell or View Upsell.

4. Click the Add button (

).

5. A screen displays all catalog folders.
6. Open the folder that contains the cross sell or upsell catalog
entry.
7. Click that catalog entry.
8. Press OK.
9. Enter additional cross sell entries as needed.
10. Click Action > Save.

Displaying Cross Sell and Upsell Items on Your Web Site
Use the Recommendation server control to place cross sell or
upsell items anywhere on a Web page. A single control can only
show either cross sell or upsell items.
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See Also: Ektron CMS400.NET Developer Manual > “Introduction to
Ektron CMS400.NET Server Controls” > “eCommerce Server
Controls” > “Recommendation Server Control”
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The fulfillment aspect of eCommerce involves
•

tracking submitted orders, including
- order status
- charge capture
- shipping
- cumulative sales information on customers
For more information, see ”Orders” on page 1221.

•

customer information, such as
- orders submitted
- addresses
- current shopping carts
For more information, see ”Customer Information” on
page 1232.

Orders
The orders screen provides information about all orders in your
eCommerce system. To access it, go to Ektron CMS400.NET
Workarea > Modules > Commerce > Fulfillment > Orders.
IMPORTANT!

In order to process orders, the Distributed Transaction Coordinator (DTC)
Windows service must be running. It is started by default when you install Ektron
CMS400.NET.
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Initially, orders are sorted by submission date and time, with the
most recent at the top.
See Also:
•

”Selecting Orders by Criteria” on page 1222

•

”Order Statuses” on page 1223

•

”The View Order Screen” on page 1224

•

”Capturing the Order” on page 1226

•

”Cancelling the Order” on page 1229

•

”Entering a Tracking Number” on page 1229

•

”Marking the Order as Fraud” on page 1230

Selecting Orders by Criteria
You can select orders by any of the following criteria.
•

entry date range

•

customer

•

catalog entry
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To use any filter, click Reporting (see below) then the appropriate
filter option.

NOTE

The Most Recent menu option is the default select and sort order: all orders with
the most recent on top.

See Also: ”Orders” on page 1221

Order Statuses
NOTE

The following table assumes you use the default workflow installed with
eCommerce. If you customize the workflow, the following table may be
inaccurate. See Also: Ektron CMS400.NET Developer Reference Manual section
“Customizing Workflows.”

Status

Description

How Set

Received

Order has been submitted.

Site visitor submits order

Fraud

Your organization has determined that the order is
fraudulent.

View Order Screen > Action
Menu > Mark as Fraud

Shipped

Order has been shipped

View Order Screen > Action
Menu > Ship Order

Note: This status can be the workflow’s end point. You
do not need to use the Completed status.

or
View Order Screen > Action
Menu > Enter/Edit Tracking
Number > Check Mark as
Shipped checkbox and save
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Status

Description

How Set

Completed

All order activities are finalized. No events can occur to
a Completed order.

View Order Screen > Action
Menu > Process Order

Cancelled

Order has been cancelled.

View Order Screen > Action
Menu > Cancel Order

InProcess

Automatically assigned when order is submitted.

Order placed but not yet
captured

The View Order Screen
To view the details of any order, click it. When you do, the View
Order screen appears.
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NOTE

If the View Workflow option does not display a flowchart, verify that the server’s
Distributed Transaction Coordinator (DTC) Windows service is running. It is
started by default when you install Ektron CMS400.NET, but if it stops for some
reason, the Workflow does not appear on this screen.

The View Order screen’s Action menu has the following options.
•

Capture - See ”Capturing the Order” on page 1226

•

Mark as Fraud - ”Marking the Order as Fraud” on page 1230

•

Enter Tracking Number - ”Entering a Tracking Number” on
page 1229

•

Cancel Order - ”Cancelling the Order” on page 1229

You can also edit the order’s billing and shipping addresses. See
”Editing an Order’s Billing and Shipping Addresses” on page 1231.
These options are explained below.

Capturing the Order
Authorization versus Capture
Authorization occurs while a customer is using the Checkout
server controls. It submits a customer’s payment information to a
payment gateway, bank, or PayPal, and returns either an approval
with an authorization number (transaction ID) or a decline along
with an explanation.
Capture is the process of submitting encrypted order information
(including the transaction ID) to a payment gateway account, bank,
or PayPal. At this time, the account is charged for the order
amount.
NOTES

* In many states, you must ship an item before you can charge a customer’s credit
card for it.
* Items that are not tangible are automatically captured if paid by PayPal or a
credit card. See Also: ”Tangible Item” on page 1197

Next, you receive confirmation from the paying agency that the
money has been deposited to your account and is available. At this
time, you use the Mark as Settled option to inform the
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eCommerce feature that payment has been received. This
changes the order status to Complete.

Payment
Method

Tangible item

Intangible Item

PayPal or credit
card

When goods are shipped

When customer submits order

Check

When check clears

When check clears

See Also: ”Payment Options” on page 1105

The Capture
To capture an order, follow these steps.
1. Workarea > Modules > Commerce > Fulfillment > Orders.
2. Click the order that you want to capture.
3. Click the Payment link (see illustration below).
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4. The View Payment screen appears, showing information about
the transaction captured when the site visitor submitted his
payment information.

5. Click Action > Capture.
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6. You are asked to confirm the action.
7. Click OK.

Cancelling the Order
Click Action > Cancel Order to stop all processing on the order. If
you do, the order’s status changes to Cancelled.

Entering a Tracking Number
When an order is shipped, the shipping provider typically provides
a tracking number to help locate the shipment within the delivery
chain. Use the Enter Tracking Number option to enter this part of
the order information.

After entering the tracking number, you can indicate whether the
order has shipped.

Viewing the Tracking Number
You can see an order’s tracking number on the View Order screen,
under the Shipping Address (as illustrated below).
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Marking the Order as Fraud
Use this option if your organization determines that the order is
fraudulent. These orders cannot be processed any further.

Marking the Order as Shipped
To denote that an order has shipped, follow these steps.
NOTE

If that order has not yet been captured, it will be captured as part of the shipping
of the order.

1. Go to Modules > Commerce > Fulfillment > Orders.
2. Click the order that is being shipped.
3. Click Action > Ship Order.
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Alternatively, you can mark the order as shipped while entering its
tracking number. See Also: ”Entering a Tracking Number” on
page 1229

Editing an Order’s Billing and Shipping Addresses
To edit an order’s billing or shipping address, click Edit as circled
below.

Order Workflow
Ektron CMS400.NET uses Microsoft’s Windows Workflow

Foundation to create and implement order process workflows to
handle the ordering process. The workflow can be as simple or
complex as your business requires.
For example, you could have a simple workflow that sends one
email to the customer when an order is received, and another to
your shipping department. Or, you could have a more complex
workflow that:
•

sends an email to the customer when the order is received
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•

checks to see whether the item is a tangible product or a virtual
product. Then, continues down the workflow path that’s
appropriate for the item.

•

handles shipping notifications and updates the account
throughout the

•

shipping process

•

handles the order if it is canceled

•

handles the order if it is determined to be fraudulent

•

marks the order as complete once all activities are finished

For more information on workflows, see the Ektron CMS400.NET
Developer Manual section “Customizing Workflows.”

Customer Information
Customers create an account the first time they complete the
checkout procedure. The Customers screen provides information
about all customers who order from your Web site. The first screen
presents the
•

customer ID number

•

user name

•

number of orders

•

amount of all orders

•

average order amount

You can click any customer’s ID number or name to see more
details about his order history. The View Customer screen (shown
below) provides information about the customer’s
•

summary information (name, number of orders, total of all
orders, average order amount)

•

orders (see ”Orders” on page 1221)

•

addresses
- You can edit any address or enter a new one (see ”Entering a
New Customer Address” on page 1233)
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- Whenever a user creates a new order and enters a new or
selects an existing billing/shipping address, that becomes
the new default
•

shopping carts (see ”Viewing a Customer’s Shopping Cart” on
page 1234)

Entering a New Customer Address
Use this screen to enter a new address for a customer or edit an
existing one. It may be used as the default billing address, shipping
address, or both.
Use the following table to complete the screen.

Field

Description

Name

Enter the customer’s name.

Company

If available, enter the name of the customer’s company.

Street Address

Enter the customer’s street address.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1233

eCommerce Order Management

Field

Description

City

Enter the customer’s city.

Postal Code

Enter the customer’s postal code.

Country

Select the customer’s country from the pull-down list.
See Also: ”Countries” on page 1089

State/Province

Select the customer’s state or province from the pulldown list. See Also: ”Regions” on page 1093

Phone

Enter the customer’s phone number.
You can add characters or spaces between groupings if
you wish. For example: 603-594-0249.

Default Billing

If you want this address to appear by default as the
billing address whenever this customer makes a
purchase, check this box.

Default Shipping

If you want this address to appear by default as the
shipping address whenever this customer makes a
purchase, check this box.

Viewing a Customer’s Shopping Cart
To view active shopping carts for a customer, follow these steps.
After viewing the carts, you can delete any of them.
1. Modules > Commerce > Customers.
2. Click a customer ID number.
3. Click the Baskets tab.
4. Click the ID number of the shopping cart that you want to view.
5. A View Cart screen shows information for items in the cart.
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Deleting a Shopping Cart from the Workarea
Follow these steps to delete a shopping cart from the Ektron
CMS400.NET Workarea.
1. Access the View Cart screen by following the steps in ”Viewing
a Customer’s Shopping Cart” on page 1234.
2. Click the delete button (

).

3. A confirmation message appears. Click OK.
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Most eCommerce sites periodically offer coupons to provide
discounts to customers, either to attract new business or reward
loyalty. Ektron CMS400.NET’s eCommerce feature provides a
coupon generation capability with the following features.
•

discount can be an amount or percentage
- if percentage, you can set a maximum coupon value
regardless of the amount calculated by percentage

•

restrict coupon to catalog entries that you approve

•

restrict coupon to most or least expensive entry

•

limit to one use per customer

•

prevent coupon from being used with other coupons

•

specify a maximum number of redemptions

•

specify a minimum order amount required to activate coupon

•

designate a date range when coupon is active

Creating a Coupon
Create coupons in the Ektron CMS400.NET Workarea by going to
Modules > Commerce > Catalog > Coupons. To make it easy to
complete the information, the screens are arranged in numbered
steps. Subsequent screens are context-sensitive, so that you only
see fields that are a logical result of previous decisions.
The following table summarizes the information collected on each
screen.
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Screen

Information collected

For more information, see

1.

•

code (that is, unique identifier)

•

description

”Completing the First Coupon
Screen (Type)” on page 1238

•

whether discount is based on amount or percentage

•

currency (applicable to amount-based coupons only)

•

enabled or disabled

•

If amount, dollar amount

•

If percentage, percentage and maximum coupon value

•

applies to entire cart, approved items only,
most/least expensive item only

•

limit to one per customer?

•

allow combination with other coupons?

•

maximum number of redemptions

•

minimum cart value

•

start and end dates

2.

3.

4.

Type

Discount

Scope

Items

If coupon is restricted to certain items, designate
the items

”Completing the Second Coupon
Screen (Discount)” on page 1240

”Completing the Third Coupon
Screen (Scope)” on page 1242

”Completing the Fourth Coupon
Screen (Items)” on page 1244

See Also:
•

”Disabling a Coupon” on page 1247

•

”Deleting a Coupon” on page 1248
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Completing the First Coupon Screen (Type)

Use the following table to complete the first coupon screen.

Field

Description

Type

Select the type of coupon you are creating/editing.
•

Amount - discount is a dollar amount.

If you select this type, choose a currency at the Currency field (below).
Then, enter the dollar amount on the Discount screen. See Also:
”Amount Based Coupon” on page 1240
•

Percentage - discount is a percentage.

If you select this type, enter the percentage on the Discount screen. That
screen also lets you enter a maximum amount. See Also: ”Percentage
Based Coupon” on page 1241
Also, if the coupon type is percentage, the Currency field is disabled.
Percentage-based coupons are currency neutral.
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Field

Description

Code

Enter the coupon code. The code cannot contain
•

spaces

•

angle brackets ( <, >)

•

single (‘) or double quotes (“)

•

ampersand (&)

•

slash (/) or back slash (\)

•

plus sign (+)

When done, click the Validate Code button. When you do, E k t r o n
C M S 4 0 0 . N E T verifies that the code contains the correct characters and
is not already in use.
Tip! The following page gives suggestions about eCommerce coupons,
including coupon-naming strategies: http://www.ecommerce-guide.com/
solutions/advertising/article.php/3667331
Site visitors enter this code to redeem the coupon on a page that hosts
the Cart server control (see image below).

Description

Enter a free text description of the coupon. This helps describe it on the
initial Coupons screen in the E ktron CM S40 0. NET Workarea.

Currency

Select the currency to which this coupon applies. A dropdown list of all
enabled currencies is available. See Also: ”Currencies” on page 1097
If the coupon type is percentage, this field is disabled.
Important! The coupon is only valid if a site visitor selects this currency.
So, for example, if you create a coupon for a USD amount, and a site
visitor selects Euros when shopping on your site, the coupon is not
accepted. To work around this restriction, create a coupon for every
applicable currency.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1239

eCommerce Coupons

Field

Description

Status

Set to enabled to let site visitors uses this coupon (providing all other
conditions are met).
Or, set to disabled to keep the coupon in the eCommerce feature but
prevent it from being used.

Completing the Second Coupon Screen (Discount)
•

”Amount Based Coupon” on page 1240

•

”Percentage Based Coupon” on page 1241

Amount Based Coupon
See Screen Sample

Use the following table to complete the second coupon screen if
the coupon is based on amount.

Field

Description

Amount

Enter the coupon’s discount amount.
Note: If the coupon amount exceeds the sum of all items to which it is
applied, it is reduced to the sum of the items. For example, a coupon
amount is $10.00 and applies to the least expensive item. If that item is
$3.00, the amount changes to $3.00.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1240

eCommerce Coupons

Percentage Based Coupon

Use the following table to complete the second coupon screen if
the coupon is based on percentage.

Field

Description

Percentage

Enter the percentage of the discount.

Maximum Amount

Enter the maximum value of this coupon.
For example, if you set a discount of 10% and a Maximum Amount of
$20.00, the discount will never exceed $2.00 (that is, 10% of the
Maximum Amount) regardless of the amount of the goods ordered.
Typically, you would include a Maximum Amount in the email or
announcement that describes the coupon.
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Completing the Third Coupon Screen (Scope)

Use the following table to complete the coupon Scope screen.
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Field

Description

Apply Coupon to

•

Entire cart - coupon applies to all items in cart

•

All approved items - coupon applies all approved items in cart.
Items are approved on the Items screen.

•

Most expensive approved item - coupon applies to most expensive
approved item in the cart. Items are approved on the Items screen.

•

Least expensive approved item - coupon applies to least expensive approved item in the cart. Items are approved on the Items
screen.

Important: If you select All approved items, Most expensive approved
item, or Least expensive approved item, you must identify approved
items on the Items tab. If you do not, the coupon is effectively inactive.
Note: You cannot apply a cart-level coupon to a subscription product.
However, you can apply an item-level coupon to a subscription product.
(An an item-level coupon is one that applies to all approved items, or the
most or least expensive item.) See Also: ”Creating a Subscription” on
page 1173
One Per Customer

Check this box if you want to limit each customer to one use of the
coupon. If you do and a site visitor completes an order with the coupon
then tries to use it a second time, he is notified that the coupon is not
valid.

Can be combined with
other coupons

Check this box if this coupon can be combined with other coupons in the
same order.
If you do not check this box and a site visitor tries to add this coupon to
an order to which a coupon is already applied, he is notified that the
coupon is not valid.

Maximum
Redemptions

If desired, enter a maximum number of times this coupon can be used. It
does not matter which site visitors use the coupon.
If you set a maximum, and the coupon is applied that number of times,
the next time someone tries to use the coupon, he is informed it is not
valid.

Minimum Required
Cart Value

If desired, enter the minimum order amount required to activate this
coupon. The order amount does not include tax or shipping charges.
For example, enter $50.00. If a shopping cart total is $40.00, and a site
visitor adds this coupon to an order, he is informed the coupon is not
valid.
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Field

Description

Start Date/End Date

Enter the date range within which this coupon is valid.
For example, you enter a Start Date of January 1, 2008 and an End Date
of December 31, 2008. If a site visitor inserts this coupon on February 9,
2009, he is informed the coupon is not valid.

Completing the Fourth Coupon Screen (Items)

Use the following table to complete the Items coupon screen.
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Field

Description

Include/ Exclude

Use this screen to identify items to which this coupon applies if the
Coupon Scope screen’s Apply Coupon to field is set to
•

All Approved Items

•

Most Expensive Approved Item

•

Least Expensive Approved Item

Important! - Item-level coupon types apply only to items selected on this
screen. If a site visitor orders a catalog entry that’s not defined on this
screen, an item-level coupon does not apply to the item.
For example, you create a coupon worth 10% off any digital camera. The
coupon is only applicable if a digital camera is in the shopping cart.
Typically, the email or announcement that describes the coupon includes
item restrictions.
The discount is applied to each approved item in the cart. For example, a
coupon provides a 10% savings on items 1, 3, and 5 but not 2 and 4
because 2 and 4 are not on the approved items list.
See Also: ”Selecting a Coupon’s Approved Items” on page 1245;
”Include vs. Exclude” on page 1247

Selecting a Coupon’s Approved Items
There are three ways to select items to add to the Include or
Exclude list. You can select
•

individual items - click the Include Product button and
navigate through the Ektron CMS400.NET folder system to that
content. You can only select items in a category folder (which
are blue to distinguish them from regular folders).
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•

all items in a catalog folder - click the Include Catalog button
and navigate through the Ektron CMS400.NET folder system to
that folder. You can only select items in a category folder
(which are blue to distinguish them from regular folders).

•

all items in a taxonomy or category - click the Include
Category button and navigate through the Ektron CMS400.NET
taxonomies to the desired taxonomy or category. All content
applied to the category will be eligible for the coupon.
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Include vs. Exclude
You can both include and exclude using any of the criteria listed
above. If any product appears on both lists, it is excluded from
coupon eligibility.
So for example, one of your folders contains 500 digital cameras
that your site offers. You want the coupon to apply all but a few
cameras.
On the Include tab, select the cameras folder. Then, use the
Exclude tab to select the few cameras to which the coupon does
not apply. In this way, you can easily select the majority of items
but exclude a few.

Disabling a Coupon
When the coupon’s status is Disabled, site visitors can no longer
apply it to an order.
Coupons can be disabled automatically (according to a schedule)
or manually.

Using an Expiration Date to Disable a Coupon
When you create a coupon, a default end date is set for 10 years
from the end of the current year. At that time or at any time the
coupon is active, you can change its end date.
When the coupon’s end date is reached, its status changes to
Disabled.

Manually Disabling a Coupon
To disable an active coupon, follow these steps.
1. Go to Ektron CMS400.NET Workarea > Modules > Commerce >
Coupons.
2. Locate the coupon that you want to delete.
3. Go to its Type screen.
4. Change its Status field to Disabled (see below).
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Deleting a Coupon
IMPORTANT!

You cannot delete a coupon that is applied to any order within Ektron
CMS400.NET.

Follow these steps to delete a coupon that is not applied to an
order. If a coupon is applied to an order, you cannot delete it but
you can disable it. See ”Disabling a Coupon” on page 1247.
1. Go to Ektron CMS400.NET Workarea > Modules > Commerce
> Coupons.
2. Locate the coupon that you want to delete.
3. Click the delete button on the far right of the coupon
information (circled below).

4. A strike through line appears over all coupon text, and a
Restore button (

) replaces the delete button.
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NOTE

If you change your mind and do not want to delete the coupon, click the Restore
button.

5. Click the Save button (

).

If the coupon cannot be deleted (because it is applied to an order),
it remains on the main Coupons screen and No appears in the
Enabled field. This coupon can no longer be used.

Using eSync with eCommerce
When using eSync with an eCommerce site, you will want to
prevent orders from being processed on your staging server. This
is to prevent orders from being processed twice.
For example, a customer on your production site purchases a
product. If the staging server and production server are synced
before the credit card is processed, the potential exists for the
customer’s credit card to be charged twice; once from the
production server and again from the staging server.
To prevent orders from being processed on your staging server,
edit your staging site’s web.config file. Next, set the following
property to true.
<add key="ek_ecom_OrderProcessingDisabled" value="true" />

Once the property is set to true, you cannot process or edit orders
from the Workarea’s View Order screen on the staging server.
Also, if you try to create an order from the staging server’s Web
site, you receive the following message.
“We're sorry, an error occurred while processing your
request. Please try again later...”
It is important to note that all other eSync functions still work
properly. For example, when you create catalog entries on a
staging server and perform a sync, the entries will be moved to the
production server. This key only affects the processing of orders.
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The eCommerce Audit Screen
As an Administrator, you should regularly review the eCommerce
Audit log. This is vital to keeping your site secure and will help you
determine the source when data is compromised.
While it is important that CMS400.NET captures this information, it
is even more important that you review, analyze and use it. For
example, while reviewing eCommerce event logs in CMS400.NET,
you might find that one of your eCommerce administrators has an
unusually large amount of login failures. This could be a sign
someone is trying to break into your system.
You can view a log of your CMS400.NET Web site's eCommerce
activity in the Workarea > Modules > Commerce > Audit screen.

To turn eCommerce Logging on, open the Web site’s web.config
file and change the following key to true.
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<add key="ek_ecom_ComplianceMode" value="false"/>

When compliance mode is turned on, Ektron CMS400.NET logs
and displays the following events.
•

Actions affecting administrators (Administrator Group member,
Commerce Admin Role, Builtin Account).
- An Administrator logs in or out
- An Administrator's login attempt fails
- An Administrator password is changed

•

Actions affecting an Ektron CMS400.NET user’s rights to
eCommerce.
- Adding a user to the Commerce Admin Role
- Removing a user from the Commerce Admin Role
- Adding a user to the Admin group
- Removing a user from the Admin group

•

Actions affecting order information.
- Updates to an order's address
- The transaction ID and response from the payment gateway
- Any action conducted with the payment gateway. For
example, when capturing a previously authorized
transaction.
- Workflow activities. For example, sending an email.
- Whenever the default gateway or payment options are
changed in the Workarea.
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Introduction to
eSync

Ektron’s eSync revolutionizes the way that Web sites are built,
deployed and maintained and is the only synchronization solution
that can keep Web sites up-to-date efficiently, giving you a level of
control over your site that was impossible before. From single
sites, to global multi-sites, to server farms, eSync gives you
scalable, geo-synchronization capabilities that allow you to easily
update exactly what you want, when you want to.
The following videos introduce eSync.
•

http://media.ektron.com/flash/esync/800x600/esync.html

•

http://media.ektron.com/webinars/esync/esyncwebinar.html
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eSync moves only the changes you want to move, from single
pieces of content to entire sites, making updates efficient and
eliminating site downtime. With its intelligent synchronization
technology, eSync is able to securely move selected content
bidirectionally: Web 2.0 sites have a wealth of user-generated
content and membership information. That data can now be
synchronized back to the development side of the firewall.
By employing certificate-based authentication to secure your Web
site, Ektron’s eSync lets CMS users update content anywhere
safely, whether it is on a production server or within the
development environment. Alternatively, all of your updates can
take place on the safe side of your firewall before they are moved
to the live site.
If conflicting versions of content exist, eSync’s configurable conflict
resolution engine ensures that you won’t lose your most up-to-date
content. The version that isn’t posted is saved in a history, along
with other previous versions, enabling you to track changes or
restore content if the need arises.
Within complex IT infrastructures, eSync can synchronize content,
assets, HTML pages and other components of your Web site,
whether it is managed by CMS400.NET or not.
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Synchronization can be scheduled to take place at strategic times
that assure optimal performance while facilitating site updates.
Global multi-site setups can take advantage of this to coordinate
synchronizations with servers around the world, taking advantage
of low traffic periods. Or, use eSync’s scheduling feature to set up
time-sensitive events. Synchronization can take place with single
or multiple servers, whatever your needs are.
eSync’s ability to move and copy data is unparalleled, and it offers
a host of options for managing multiple servers. If there is a need
for multiple development servers, eSync can create another copy
of the live site for you to work with. As your developers build out
changes to the site, their updates can by synchronized to the
staging and production servers. eSync can also support advanced
infrastructures, including load balancing and failover server
configurations.
Ektron’s eSync is the only solution in the marketplace today that
gives you the level of control you need to keep your Web sites
completely up-to-date. Whatever your Web site structure is,
Ektron’s synchronization technology lets updates happen
efficiently and quickly, and provides the tools to deal with today and
tomorrow’s information-hungry world.
eSync is more fully explained through these topics.
•

”Setting Up eSync” on page 1255

•

”eSync Requirements” on page 1295

•

”Characteristics of eSync” on page 1296

•

”Managing eSync Security Certificates” on page 1305

•

”Using eSync to Initialize a New Site” on page 1316

•

”Running a Sync” on page 1332

•

”Content and Folder Sync Options” on page 1345

•

”eSync in a Load Balanced Environment” on page 1351

•

”Using eSync in a Multi-site Environment” on page 1360

•

”Using eSync with eCommerce” on page 1366

•

”eSync Troubleshooting” on page 1367
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This chapter helps you install and start using Ektron CMS400.NET’s
eSync. For full details about the feature, see ”Using eSync” on
page 1295.

For this configuration

See this section

Two sites on same server

”Scenario 1: Synching Two Sites on the Same Server”
on page 1255

One Local to one Remote
server

”Scenario 2: Synching an Ektron CMS400.NET Server
with Another Server” on page 1256

Development to Staging to
Production servers

”Scenario 3: Setting up a Development > Staging >
Production Environment” on page 1268

Scenario 1: Synching Two Sites on the Same
Server
Although it is unlikely that you will use this configuration in “reallife” situations, it the simplest way to begin testing and learning
how eSync works.
1. Install the first site.
See Also: Ektron CMS400.NET Setup Manual sections
“Installing Ektron CMS400.NET” and “Installing the Minimum
and Starter Sites.”
2. Near the end of the installation, the following dialog appears.
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3. Click Yes.
4. Install a second site on the same server.
5. Near the end of the installation, the same dialog appears.
6. Click Yes.
7. Both sites’ security certificates have been set up and
configured. Continue from ”Part Three: Connect the Local and
Remote Servers” on page 1261.

Scenario 2: Synching an Ektron CMS400.NET
Server with Another Server

This scenario assumes you have Ektron CMS400.NET on one
server (call it local), and want to sync it with another (call it
remote). To accomplish this, you install a minimal Ektron
CMS400.NET site to the new, remote server. Next, use eSync to
upload your Ektron CMS400.NET site from the local to the remote
server.
After the you complete the initial and template syncs explained in
this chapter, the two sites are a mirror image of each other.
Follow these steps to configure two servers to sync with each
other.
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Prerequisites - See ”eSync Requirements” on page 1295
•

”Part One: Set up a Min Site on the Remote Server” on
page 1257

•

”Part Two: Generate and Copy Security Certificates” on
page 1257

•

”Part Three: Connect the Local and Remote Servers” on
page 1261

•

”Part Four: Upload the Local Server’s Database to the Remote
Server” on page 1264

•

”Part Five: Upload the Local Server’s Templates to Remote” on
page 1266

Part One: Set up a Min Site on the Remote Server
1. Upgrade the local server to the latest version of Ektron
CMS400.NET if necessary.
2. On the remote server, install a minimum site whose Ektron
CMS400.NET version matches the version on the local server.
To do this, run the Ektron CMS400.NET base installation file
(CMS400Base7x.exe). For more information, see the Ektron
CMS400.NET Setup manual.
3. If the current site with which you will sync is precompiled, you
must also precompile the min site.

Part Two: Generate and Copy Security Certificates
Security certificates authorize the synchronization of files between
servers. In this part, you generate security certificates on the local
server, then copy them to the remote.
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Follow these steps to complete this procedure.
1. Sign on to the local server.
2. Click the Windows Start Button> All programs > Ektron >
CMS400 v7x > Utilities > Security Configurator.
3. The following screen appears.

4. At the Web Site Description field, select the Web site on the
local server.
5. Press Generate.
6. The certificates are created on the local server.
7. Close the Security Configurator dialog.
8. Open two Windows Explorer windows side-by-side: one
showing the local server’s file system, and the other showing
the remote server’s file system.
9. In the remote server window, create a folder underneath the
root folder. Name the folder local security certificates.
WARNING!

Do not create the new folder under the web root, C:\inetpub\wwwroot.
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10. In the local server window, open the following folder:
C:\ProgramFiles\Ektron\CMS400V7x\Utilities\Software\SecurityCon
figurator.

11. From that folder, copy these files.
•servername_SyncClient.pfx
•servername_SyncClient.pvk
•servername_SyncClient.cer
•servername_SyncServer.pfx
•servername_SyncServer.pvk
•servername_SyncServer.cer
12. Paste the files into the folder you created in Step 9. Make sure
there are no other security files in the folder.
13. Close both windows you opened in Step 8.
NOTE

After copying security certificates to the remote folder, you need to register and
move them to the correct folders. The Security Configurator screen does this.

14. Sign on to the remote server.
15. Open the security configurator screen using this path:
Windows Start Button > All programs > Ektron > CMS400
v7x > Utilities > Security Configurator.
16. The security configurator screen appears.
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17. Click the Apply Remote Server Certificates button (circled
above).
18. Click the Browse button next to that field.
19. Browse to the folder to which you pasted the security
certificates in Step 12.
20. Click the Apply button.
21. The security configurator copies the certificates you pasted in
Step 12 to the correct folder, and configures them for the
remote server.
Next, you need to generate security certificates on the remote
server, then copy them to the local.
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To accomplish this, follow all steps in ”Part Two: Generate and
Copy Security Certificates” on page 1257, but this time, consider
the remote server to be the local server and vice versa.
Now that you have generated and copied security certificates
between servers, you can set up eSync.

Part Three: Connect the Local and Remote Servers

WARNING!

Back up your database before beginning this procedure!

1. On the local server, sign on to Ektron CMS400.NET.
2. In the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Synchronization.
3. The View All Synchronization Configurations screen appears.
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4. Click the Add button (

).

5. The Create Synchronization Server Relationship screen
appears.

6. At the Remote Server field, enter the name of the remote
server.
7. At the Choose Certificate field, the name of the remote server
appears.
8. Click the Connect button. This action connects the local with
the remote server.
9. After you connect to the remote server, a new screen appears
showing its database.
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10. Click Next.
11. A new screen appears, showing both servers.

12. Click the Switch Synchronization Direction button.
13. Now the screen indicates that the database will be uploaded
from your local server (which contains the CMS400 Developer
site) to the new, remote server. See below.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1263

Setting Up eSync

14. Click Create. This action connects the local and remote
servers.

Part Four: Upload the Local Server’s Database to the Remote Server

1. From the View All Synchronization Configurations screen, click
the Start Initial Sync button.
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2. The initial sync uploads the local server’s database to the
remote server.
3. A screen tracks the progress.

4. When the sync is finished, Synchronization is Complete
appears.
The initial sync also creates a default database profile. The profile
remembers information about the sync, such as source and
destination databases, sync direction, and the fact that it syncs the
database and resource files (see example below). You can reuse
this profile to sync your database/resource files any time in the
future.
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Part Five: Upload the Local Server’s Templates to Remote

1. From the View All Synchronization Configurations screen, click
the Add Sync Profile button.
2. The Add Synchronization Profile screen appears.
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3. At the Synchronization name field, give this profile a name,
such as Local - Remote Template Sync.
4. At the Items to Synchronize field, select Templates.
5. For Direction, choose Upload.
6. For Schedule, choose None. (See example below.)

7. Save the profile.
8. Click the Run button to the right of the template sync (circled
below).
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9. A screen tracks the sync’s progress.
10. When the sync is complete, Synchronization is Complete
appears.
You can reuse the template sync profile to sync templates any time
in the future.

Scenario 3: Setting up a Development > Staging >
Production Environment
Before
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After

In this scenario, a version of Ektron CMS400.NET resides on one
server. You will consider that your production server and use it to
initialize the staging and development servers.
Here’s a preview of the steps you will follow.
•

”Part One: Set up a Min Site on the Staging and Development
Servers” on page 1270

•

”Part Two: Generate and Copy Security Certificates” on
page 1270

•

”Part Three: Connect Staging and Production Servers” on
page 1280

•

”Part Four: Download the Production Server’s Database to the
Staging Server” on page 1282

•

”Part Five: Download the Production Server’s Templates to
Staging” on page 1285

•

”Part Six: Connect the Development and Staging Servers” on
page 1287

•

”Part Seven: Download the Staging Server’s Database to the
Development Server” on page 1290

•

”Part Eight: Download the Staging Server’s Templates to
Development” on page 1292

Prerequisites - See ”eSync Requirements” on page 1295
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Part One: Set up a Min Site on the Staging and Development Servers
1. Upgrade your existing server to the current version of Ektron
CMS400.NET if necessary.
2. Install a minimum site on the staging and development servers.
To do this, run the Ektron CMS400.NET base installation file
(CMS400Base7x.exe) version 7.6 or higher. (For more
information, see the Ektron CMS400.NET Setup manual.)

Part Two: Generate and Copy Security Certificates
Security certificates authorize synchronization between servers. In
an eSync configuration, every server needs a security certificate
from every other server, as shown below.

To generate and copy these certificates, follow these steps.
•

”A. Generate Security Certificates on Production and Copy
Them to Staging and Development” on page 1271

•

”B. Generate Security Certificates on Staging and Copy Them
to Development and Production” on page 1274
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•

”C. Generate Security Certificates on Development and Copy
them to Staging and Production” on page 1277

A. Generate Security Certificates on Production and Copy Them to Staging and
Development

Follow these steps to complete this procedure.
1. Sign on to the production server.
2. Click the Windows Start Button> All programs > Ektron >
CMS400 v7x > Utilities > Security Configurator.
3. The following screen appears.
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4. At the Web Site Description field, select the Web site on the
production server.
5. Press Generate.
6. The certificates are created on the production server.
7. Open two Windows Explorer windows: one showing the
production server’s file system, and the other showing the
staging server’s file system.
8. In the staging server window, create a folder underneath the
root folder. Name the folder Prod security certificates.
WARNING!

Do not create the new folder under the web root, C:\inetpub\wwwroot.

9. In the production server window, open the following folder:
C:\ProgramFiles\Ektron\CMS400V7x\Utilities\Software\SecurityCon
figurator.

10. From that folder, copy these files.
•servername_SyncClient.pfx
•servername_SyncClient.pvk
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•servername_SyncClient.cer
•servername_SyncServer.pfx
•servername_SyncServer.pvk
•servername_SyncServer.cer
11. Paste the files into the folder you created in Step 9. Make sure
there are no other security files in the folder.
12. Close both windows you opened in Step 8.
After copying the security certificate files to the staging folder,
you need to register and move them to the correct folders. The
Security Configurator screen does this.
13. Sign on to the staging server.
14. Open the security configurator screen using this path:
Windows Start Button > All programs > Ektron > CMS400
v7x > Utilities > Security Configurator.
15. The security configurator screen appears.
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16. Click the Apply Remote Server Certificates button (circled
above).
17. Click the browse button next to that field.
18. Browse to the folder to which you pasted the security
certificates in Step 12.
19. Click the Apply button.
20. The security configurator copies the certificates you pasted in
Step 12 to the correct folder, and configures them for the
staging server.
21. Follow the same procedure to move production certificates to
the development server. To do this, begin at Step 8 and follow
all steps. Wherever the instructions mention a staging server,
substitute the development server.
B. Generate Security Certificates on Staging and Copy Them to Development and
Production

Follow these steps to complete this procedure.
1. Sign on to the staging server.
2. Click the Windows Start Button> All programs > Ektron >
CMS400 v7x > Utilities > Security Configurator.
3. The following screen appears.
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4. At the Web Site Description field, select the Web site on the
staging server.
5. Press Generate.
6. The certificates are created on the staging server.
7. Open two Windows Explorer windows: one showing the
staging server’s file system, and the other showing the
production server’s file system.
8. In the production server window, create a folder underneath the
root folder. Name the folder staging security certificates.
WARNING!

Do not create the new folder under the web root, C:\inetpub\wwwroot.

9. In the staging server window, open the following folder:
C:\ProgramFiles\Ektron\CMS400V7x\Utilities\Software\SecurityCon
figurator.

10. From that folder, copy these files.
•servername_SyncClient.pfx
•servername_SyncClient.pvk
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•servername_SyncClient.cer
•servername_SyncServer.pfx
•servername_SyncServer.pvk
•servername_SyncServer.cer
11. Paste the files into the folder you created in Step 9. Make sure
there are no other security files in the folder.
12. Close both windows you opened in Step 8.
After copying the security certificate files to the production
folder, you need to register and move them to the correct
folders. The Security Configurator screen does this.
13. Sign on to the production server.
14. Open the security configurator screen using this path:
Windows Start Button > All programs > Ektron > CMS400
v7x > Utilities > Security Configurator.
15. The security configurator screen appears.
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16. Click the Apply Remote Server Certificates button (circled
above).
17. Click the browse button next to that field.
18. Browse to the folder to which you pasted the security
certificates in Step 12.
19. Click the Apply button.
20. The security configurator copies the certificates you pasted in
Step 12 to the correct folder, and configures them for the
production server.
21. Follow the same procedure to move staging certificates to the
development server. To do this, begin at Step 8 and follow all
steps. Wherever the instructions mention a production server,
substitute the development server.
C. Generate Security Certificates on Development and Copy them to Staging and
Production

1. Sign on to the development server.
2. Click the Windows Start Button> All programs > Ektron >
CMS400 v7x > Utilities > Security Configurator.
3. The following screen appears.
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4. At the Web Site Description field, select the Web site on the
development server.
5. Press Generate.
6. The certificates are created on the development server.
7. Open two Windows Explorer windows: one showing the
development server’s file system, and the other showing the
staging server’s file system.
8. In the staging server window, create a folder underneath the
root folder. Name the folder Dev security certificates.
WARNING!

Do not create the new folder under the web root, C:\inetpub\wwwroot.

9. In the development server window, open the following folder:
C:\ProgramFiles\Ektron\CMS400V7x\Utilities\Software\SecurityCon
figurator.

10. From that folder, copy these files.
•servername_SyncClient.pfx
•servername_SyncClient.pvk
•servername_SyncClient.cer
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•servername_SyncServer.pfx
•servername_SyncServer.pvk
•servername_SyncServer.cer
11. Paste the files into the staging server folder you created in Step
9. Make sure there are no other security files in the folder.
12. Close both windows you opened in Step 8.
After copying the security certificate files to the staging folder,
you need to register and move them to the correct folders. The
Security Configurator screen does this.
13. Sign on to the staging server.
14. Open the security configurator screen using this path:
Windows Start Button > All programs > Ektron > CMS400
v7x > Utilities > Security Configurator.
15. The security configurator screen appears.

16. Click the Apply Remote Server Certificates button (circled
above).
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17. Click the browse button next to that field.
18. Browse to the folder you created in Step 9.
19. Click the Apply button.
20. The security configurator copies the certificates you pasted in
Step 12 to the correct folder, and configures them for the
staging server.
21. Follow the same procedure to move development certificates
to the production server. To do this, begin at Step 8 and follow
all steps. Wherever the instructions mention a staging server,
substitute the production server.

Part Three: Connect Staging and Production Servers

WARNING!

Back up your database before beginning this procedure!

1. On the staging server, sign on to Ektron CMS400.NET.
2. In the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Synchronization.
3. The View All Synchronization Configurations screen appears.

4. Click the Add button (

).

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1280

Setting Up eSync

5. The Create Synchronization Server Relationship screen
appears.

6. At the Remote Server field, enter the name of the production
server.
7. At the Choose Certificate field, the name of the production
server appears.
8. Click the Connect button. This action connects the staging with
the production server.
9. After you connect to the production server, a new screen
appears showing its database.

10. Click Next.
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11. A new screen appears, showing both servers.

12. Click Create. This action connects the staging and production
servers.

Part Four: Download the Production Server’s Database to the Staging
Server

1. From the View All Synchronization Configurations screen, click
the Start Initial Sync button.
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2. The initial sync downloads the production server’s database to
the staging server.
3. A screen tracks the sync’s progress.

4. When the sync is complete, Synchronization is Complete
appears.
The initial sync also creates a default database profile. The profile
remembers information about the sync, such as the source and
destination databases, sync direction, and the fact that it syncs the
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database and resource files (see example below). You can reuse
this profile to run database/resource syncs any time in the future.
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Part Five: Download the Production Server’s Templates to Staging

1. From the View All Synchronization Configurations screen, click
the Add Sync Profile button.
2. The Add Synchronization Profile screen appears.
3. At the Synchronization name field, give this profile a name,
such as Prod - Staging Template Sync.
4. At the Items to Synchronize field, select Templates.
5. For Direction, choose Download.
6. For Schedule, choose None. (See example below.)
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7. Save the profile.
8. Click the Run button to the right of the template sync (circled
below).
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9. A screen tracks the sync’s progress.
10. When the sync is complete, Synchronization is Complete
appears.
You can reuse the template sync profile to sync templates any time
in the future.

Part Six: Connect the Development and Staging Servers

1. Sign on to Ektron CMS400.NET development server.
2. In the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Synchronization.
3. The View All Synchronization Configurations screen appears.
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4. Click the Add button (

).

5. The Create Synchronization Server Relationship screen
appears.

6. At the Remote Server field, enter the name of the staging
server.
7. At the Choose Certificate field, the name of the staging server
appears.
8. Click the Connect button. This action connects the
development with the staging server.
9. After you connect to the staging server, a new screen appears
showing its database.
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10. Click Next.
11. A new screen appears, showing both servers.
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12. Click Create. This action connects the development and
staging servers.

Part Seven: Download the Staging Server’s Database to the
Development Server

1. From the View All Synchronization Configurations screen, click
the Start Initial Sync button.

2. The initial sync downloads the staging server’s database to the
development server.
3. A screen tracks the sync’s progress.
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4. When the sync is complete, Synchronization is Complete
appears.
The initial sync also creates a default database profile. The profile
remembers information about the sync, such as the source and
destination databases, sync direction, and the fact that it syncs the
database and resource files (see example below). You can reuse
this profile to sync the database/resources between these two
servers at any time in the future.
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Part Eight: Download the Staging Server’s Templates to Development
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1. From the View All Synchronization Configurations screen, click
the Add Sync Profile button.
2. The Add Synchronization Profile screen appears.
3. At the Synchronization name field, give this profile a name,
such as Staging-Dev Template Sync.
4. At the Items to Synchronize field, select Templates.
5. For Direction, choose Download.
6. For Schedule, choose None. (See example below.)

7. Save the screen.
8. Click the Run button to the right of the template sync (circled
below).
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9. A screen tracks the sync’s progress.
10. When the sync is complete, Synchronization is Complete
appears.
You can reuse the template sync profile to sync templates any time
in the future.
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This section explains the following eSync topics.
•

”eSync Requirements” on page 1295

•

”Characteristics of eSync” on page 1296

•

”Managing eSync Security Certificates” on page 1305

•

”Using eSync to Initialize a New Site” on page 1316

•

”Setting up eSync Profiles” on page 1317

•

”Optional Steps before Running a Sync” on page 1331

•

”Previewing a Sync” on page 1331

•

”Running a Sync” on page 1332

•

”Backing up the Destination Server During an eSync” on
page 1336

•

”Synching Custom Database Tables” on page 1344

•

”Reviewing Resolved Collisions” on page 1341

•

”Content and Folder Sync Options” on page 1345

•

”eSync in a Load Balanced Environment” on page 1351

•

”Using eSync in a Multi-site Environment” on page 1360

•

”Using eSync with Web Alerts” on page 1365

•

”eSync and Integrated Search Folders” on page 1365

•

”Using eSync with eCommerce” on page 1366

•

”eSync Troubleshooting” on page 1367

eSync Requirements
Ektron Software and Files
•

Ektron CMS400.NET version 7.6 or higher
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WARNING!

The version of Ektron CMS400.NET on every server in the sync configuration
must match. You cannot upgrade nor downgrade Ektron CMS400.NET using
eSync.

•

An Ektron CMS400.NET base installation file (for example,
cms400Base7x.exe). Use this file to install a second site with
which you will sync your current site.

•

Ektron CMS400.NET licenses that support Enterprise or

Professional with eSync on every server being synched.
•

Matching security certificates on every server being synched.
See Also: ”Managing eSync Security Certificates” on
page 1305

Microsoft Software
•

Windows Server 2003 or higher; Vista Ultimate or Business

•

Microsoft .NET Framework 3.5
Ektron CMS400.NET’s installation checks for this version of the

framework during installation/upgrade. If it’s not on your server,
you are asked for permission to install it.
NOTE

It is not a problem if your templates were created using the 2.0 Framework.

•

Microsoft SQL 2005 SP2 or higher

User Permissions
•

You are a member of the Administrators group or assigned the
Synchronization Admin role. See Also: ”Defining Roles” on
page 787

•

The user performing the sync has either a db_ddladmin or
dbowner role for the SQL database

Server
The GMT time on each server’s clock must be within 5 minutes of
each other.

Characteristics of eSync
•

”Easy and Flexible Setup and Usage” on page 1297

•

”Sync Configurations” on page 1298
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•

”Unique ID Numbering” on page 1303

•

”eSync Moves Changes Only” on page 1304

Easy and Flexible Setup and Usage
You administer eSync through Ektron CMS400.NET’s Workarea >
Settings > Configuration > Synchronization screens. The
screens let you establish a sync configuration between two
databases, then specify any number of sync profiles for each
configuration.

Each profile lets you specify data to sync, a direction, and a
schedule. You can always sync immediately by clicking the sync
( ) button.
You create profiles to sync these kinds of data.
•

all content, assets, and library assets

•

all Workarea folder files

•

the remaining site files (with a few exceptions)

•

a selection of Windows files in your site root folder and its
subfolders

See Also: ”Setting up eSync Profiles” on page 1317
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Individual file types can be included or excluded from the sync. In
addition, you can sync Ektron CMS400.NET content or folders. See
Also: ”Content and Folder Sync Options” on page 1345

Sync Configurations
Several eSync configurations are shown below. You can
synchronize any server to or from any other server with one
important exception: you cannot initiate a sync from a server
outside the firewall. You can only initiate a sync from a server
inside the firewall and copy to a server outside the firewall. This is
because the outside server does not know the address of servers
inside the firewall. However, you can use a staging server to push
and pull updated information to and from a production server.
IMPORTANT!

All eSync transmissions use port 8732. This is not configurable.

Configuration 1: One Staging Server, One Production Server
This is the most basic eSync configuration, showing one staging
and one production server. Each server has a database and one
site.

The eSync feature can automatically create a production server
from your staging server. See Also: ”Using eSync to Initialize a
New Site” on page 1316
For installation instructions for this configuration, see ”Scenario 2:
Synching an Ektron CMS400.NET Server with Another Server” on
page 1256.
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Configuration 2: One Development Server, One Staging Server, One
Production Server
This configuration includes a development server. Developers can
use it to create new features and modify existing ones. When they
are done, they can sync the changes to the staging server, where
the changes can be verified before being moved to production.

For installation instructions for this configuration, see ”Scenario 3:
Setting up a Development > Staging > Production Environment” on
page 1268.

Configuration 2a: Multi-site Staging Server, Multi-site Production Server
The following configuration illustrates synching several sites on a
staging server with those sites on production.
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Configuration 3: Several Development Servers, One Staging Server, One
Production Server
As shown in the illustration, any number of development servers
can sync to each other and to your staging servers.

Configuration 4: One Development Server, One Staging Server, One
Production Site Server, One Production Database Server
In this configuration supported by eSync, the production site has
two servers: one for site files, and another for the database.
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To synchronize these servers, set up several eSync profiles. One
syncs the database, assets, and templates to the production
database server. Use additional profiles to sync the staging
server’s workarea files with the production site server.
NOTE

When using separate site and database servers, assets are stored on the site
server.

Configuration 5: Configuration 4 Plus Pre-Production Server
This eSync configuration adds an extra server between staging
and production. The preproduction server can be used for review
and testing of changes before they are moved to production.

Configuration 6: Multi-site Configurations, Each Site and Database on its
own Production Server
In this configuration, each production server has its own database
plus the site files. As an alternative, you could have a separate
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server for each production database, with all sites on one
production server.

NOTE

The above configuration also supports separate site and database servers.

To synchronize this type of configuration, set up several eSync
profiles, one for each site.
•

Three database and template profiles

•

Three Workarea profiles

The Server Number
Every server in a sync configuration is assigned a unique number.
The originating server is numbered 1, the first server with which it
establishes a relationship is numbered 2, etc.
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The server number is in the serverinfo.xml file, located in the
c:\sync\inetpub\wwwroot\siteroot folder, as shown below.
<SyncServerInfoList>
<SyncServerInfo IsSyncRunning="true" MaxId="2" ServerNumber="1" IsMulti-SiteStaged="false">
<ServerId>b0cccb5a-1d45-4262-8857-79f1333696dc</ServerId>
<ServerUrl>http://localhost:8732/Ektron.Sync.Communication/
SyncCommunicationScheduleService.svc</ServerUrl>
<ConnectionInfo>server=WS10080\SQLExpress;database=CMS400Developer;Integrated
Security=TRUE;user=;pwd=;</ConnectionInfo>
</SyncServerInfo>
</SyncServerInfoList>

Unique ID Numbering
All Ektron CMS400.NET data is assigned a unique ID number to
distinguish it from similar objects. Examples are content (see
illustration below), folders, menus, users, etc.

When you create a sync relationship, Ektron CMS400.NET applies
to each server a new ID numbering range to ensure that, from then
on, objects created on either server have a unique ID. This
prevents collisions when synching between servers. For example,
since membership users created on a production server have a
different ID number range from those created on the staging
server, eSync does not overwrite them.
To view a server’s ID number range, open its serverinfo.xml file,
located in the c:\sync\inetpub\wwwroot\siteroot folder, and check
the MaxId value (highlighted in red below).
<SyncServerInfoList>
<SyncServerInfo IsSyncRunning="true" MaxId="1" ServerNumber="1" IsMulti-SiteStaged="false">
<ServerId>b0cccb5a-1d45-4262-8857-79f1333696dc</ServerId>
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<ServerUrl>http://localhost:8732/Ektron.Sync.Communication/
SyncCommunicationScheduleService.svc</ServerUrl>
<ConnectionInfo>server=WS10080\SQLExpress;database=CMS400Developer;Integrated
Security=TRUE;user=;pwd=;</ConnectionInfo>
</SyncServerInfo>
</SyncServerInfoList>

Multiply that number by 1 trillion to get the largest ID number which
that server can assign. So for example, if MaxId = 3, possible ID
numbers range from 2,000,000,000,001 to 3,000,000,000,000.

eSync Moves Changes Only
eSync only copies data that changed since the last sync. So, for
example, if your site has 100 menus but only 3 changed since the
last sync, it only copies three. As a result, eSync is very quick.
To track changes to Ektron CMS400.NET data between syncs,
eSync sets up a c:\sync folder structure that mirrors your site’s
Windows folder structure. This structure is created on each server
when sync relationships are first established.
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No Ektron CMS400.NET files reside in the \sync folders. Instead,
each folder has four .sync files that monitor changes to the Ektron
CMS400.NET files in the corresponding folder.

Managing eSync Security Certificates
Ektron CMS400.NET’s eSync feature uses security certificates to

ensure secure communication between servers. That is, all servers
in an eSync configuration must have matching, encrypted security
certificates in order to establish an eSync relationship.
NOTE

If your configuration features separate database servers, you do not need to
install security certificates on them. You only need to install certificates on servers
that host Ektron CMS400.Net.

This section explains how to create and replace security
certificates on a server through the following topics.
•

”The Client and Server Certificates” on page 1305

•

”Installing Security Certificates” on page 1307

•

”Regenerating Security Certificates” on page 1313

•

”Troubleshooting Security Certificates” on page 1314

See Also: ”Create eSync Security Certificates for a Load Balanced
Cluster” on page 1355

The Client and Server Certificates
Before you can establish an eSync relationship between servers,
each server must have its own (local) security certificate and one
from every other server in the configuration, as shown below.
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As another example, if an eSync configuration consists of five
servers, each server would require five security certificates: one
local and four remote certificates.
Each server creates two sets of certificates: a server and a client
set. Then, you copy the certificates to the other server. The local
machine’s server certificate must match a client certificate on the
remote server, and vice versa.
Certificates are typically copied only when you first establish an
eSync relationship between servers. After that, any eSync activity
triggers a background check, and the user can proceed only if the
certificates match.
Each certificate consists of the following files.
•

Server certificate
- servername_SyncServer.pfx
- servername_SyncServer.pvk
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- servername_SyncServer.cer
•

Client certificate
- servername_SyncClient.pfx
- servername_SyncClient.pvk
- servername_SyncClient.cer

The security certificates can apply to one site or all sites on a
server. You determine this when installing them.
See Also: ”Installing Security Certificates” on page 1307

Installing Security Certificates
Prerequisite: Permission to copy and paste files between local
and remote servers
To create and place eSync security certificates in the correct
locations, follow these steps.
•

”Step 1: Create Security Certificates on Your Local Server” on
page 1307

•

”Step 2: Create Security Certificates on the Remote Server” on
page 1309

•

”Step 3: Copy Local Client Certificate to Remote Server” on
page 1310

•

”Step 4: Copy Remote Client Certificate to Local Server” on
page 1312

•

”Step 5: Test the Security Certificates” on page 1313

Step 1: Create Security Certificates on Your Local Server
1. At the end of the Ektron CMS400.NET installation, you are
asked if you want to install eSync security certificates. If you
agree, the following screen prompts you to enter information
needed to create the certificates.
NOTE

You can access this screen at any time screen by opening Windows Start
Button> All programs > Ektron > CMS400 v7x > Utilities > Security
Configurator.
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Use the following table to complete this screen.

Field

Description

Generate Certificates - Use this screen area to create security certificates that must be copied to a
remote server with which you want to sync.
Web Site Description

If more than one site is set up on this server, use the pull-down list to
select the Web site for which you are installing security certificates. Or,
click All to apply the certificates to all sites on this server.

Apply Remote Server Certificates - Use this screen area to apply eSync security certificates that
were copied from a remote server to your local server. See Also: ”Step 3: Copy Local Client
Certificate to Remote Server” on page 1310

2. Click Generate.
3. Local security certificates are created and configured
(illustrated below).
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See Illustration

NOTE

Only click OK once. The status field at the bottom of the screen updates the
status as it progresses. If you click OK more than once, you delay the certificates’
creation.

Step 2: Create Security Certificates on the Remote Server
1. Sign on to remote server.
2. Generate security certificates for the remote server, following
instructions in ”Step 1: Create Security Certificates on Your
Local Server” on page 1307.
3. When you complete this procedure, remote client and server
security certificates are created and configured (illustrated
below).
See Illustration
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Step 3: Copy Local Client Certificate to Remote Server

1. On the local server, open two Windows Explorer windows: one
showing the local server’s file system, and the other showing
the remote server’s file system.
2. In the remote server window, create a folder underneath the
root folder. The folder name is not important.
WARNING!

Do not place it under the web root folder, C:\inetpub\wwwroot.

3. In the local server window, open the following folder:
C:\ProgramFiles\Ektron\CMS400V7x\Utilities\Software\SecurityCon
figurator.

4. Copy the following files.
•servername_SyncClient.pfx
•servername_SyncClient.pvk
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•servername_SyncClient.cer
•servername_SyncServer.pfx
•servername_SyncServer.pvk
•servername_SyncServer.cer
NOTE

These files were created when you completed the eSync Security Configurator
Screen in Step 1.

5. Paste the files into the remote server folder that you created in
Step 2. Make sure there are no other security files in the folder.
After the local server’s security certificates are copied to the
remote server, you need to register and move them to the correct
folders. The Security Configurator screen does this.
6. On the remote server, open the security configurator screen
using this path: Windows Start Button > All programs >
Ektron > CMS400 v7x > Utilities > Security Configurator.
7. The security configurator screen appears.
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8. Click the Apply Remote Server Certificates button (circled
above).
9. Click the browse button next to that field.
10. Browse to the folder to which you pasted the security
certificates in Step 5.
11. Click the Apply button.
12. The utility copies the security certificates you pasted in Step 5
to the correct folder, and configures them for the remote server.

Step 4: Copy Remote Client Certificate to Local Server

1. Sign on to the remote server.
2. Follow the steps described in ”Step 3: Copy Local Client
Certificate to Remote Server” on page 1310, except substitute
remote for local.
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Step 5: Test the Security Certificates
1. From the local server, sign on to Ektron CMS400.NET.
2. In the Workarea, go to Settings > Configuration >
Synchronization.
3. Click the plus sign (

).

4. Insert the name of the Remote Server.
5. Select the security certificate you are testing.
6. Click Connect.
7. If the next screen appears, the security certificates are working
properly.

Regenerating Security Certificates
Follow these steps to regenerate security certificates. You may
need to do this if they stop working, or you are concerned about a
security breach.
1. Access the eSync Security Configurator screen via Windows
Start Button > All programs > Ektron > CMS400 v7x >
Utilities > Security Configurator.
2. Use the Web Site pulldown field to select a site on your server,
or choose All sites.
3. Click the Discard Existing Keys checkbox (circled below).

4. Click Generate.
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5. The existing security certificates are removed from your local
server.
6. Reopen the Security Configurator screen.
7. Choose the correct Web Site, verify the other settings, and
click Generate. See Also: ”Step 1: Create Security Certificates
on Your Local Server” on page 1307
8. This action generates new security certificates on your server.
9. Copy the new certificates to all other servers in the eSync
configuration. This is explained in ”Step 3: Copy Local Client
Certificate to Remote Server” on page 1310.

Troubleshooting Security Certificates
•

”Could Not Connect Error” on page 1314

•

”No Endpoint Error” on page 1316

Could Not Connect Error
When trying to connect to a remote server, after selecting a
security certificate, you may see the following message.
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Here are some steps to resolve the problem.
•

Check the Windows Event Viewer > EktronL2 log for the error.
If the service is hosted but already exists, stop then start the
service (do not restart).

•

The certificates may be corrupted. To resolve this, see
”Regenerating Security Certificates” on page 1313.
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No Endpoint Error

The above error indicates that
•

the remote site may not be on the same Ektron CMS400.NET
version as the local site, or

•

the Ektron Windows Service is not started

Using eSync to Initialize a New Site
Typically, before you begin using eSync, one server hosts an
Ektron CMS400.NET Web site, and you want to bring other servers
into the configuration. After the servers are synchronized, one will
be the staging server (the one on which content is created or
updated, then approved). Another server, production, hosts your
live Web site.
IMPORTANT!

The names of the site and all folders must match on both servers. This is because
paths to images, xslt files, etc. refer to a site and its folders. If the servers’ site and
folder names do not match, the links break.

First, use eSync to initialize the new servers from the existing one.
This process is described in ”Setting Up eSync” on page 1255.
Afterwards, use eSync to periodically sync updated content,
folders, users, menus, etc.
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Setting up eSync Profiles
To minimize data entry, eSync saves your specifications about an
individual eSync job in a sync profile. So, after you enter
specifications the first time, just select the profile every subsequent
time you want to sync. A profile contains information about the
•

source and destination databases

•

type of data being synched

•

files to include/exclude

•

direction

•

schedule

Use the Add Synchronization Profile screen to create and update
eSync profiles.
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While following the steps in ”Setting Up eSync” on page 1255, you
created a default database and a template profile. This section
explains how to modify those profiles and create new ones.
To eSync an entire Web site, you need a minimum of two profiles:
one for your web site root/Workarea folder, and another for all other
site files.
To create a profile for
•

your Workarea folder, click Workarea Files under Items to
Synchronize.

•

all other site files, click Database/Resources, Templates and
Bin under Items to Synchronize.
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The following table explains the kinds of files synched by each
category.

Items to
Synchronize

Type of data synched

Exceptions

For setup
instructions,
see

Database/
Resources

The database plus the
following site root folders

See ”Global File Type Exceptions”
on page 1320

”Setting up a
Profile to Sync a
Database and
Assets” on
page 1321

Files in these folders:

”Setting up a
Profile to Sync
Workarea Files”
on page 1323

Workarea Files

•

assets

•

Privateassets

•

uploadedimages

•

uploadedfiles

All files in the site’s
Workarea folder other than
the exceptions

•

ewebeditpro

•

help

•

explorer

•

ewebdiff

•

documents

•

foundation

•

resources

•

sync

See Also: ”Global File Type
Exceptions” on page 1320
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Items to
Synchronize

Type of data synched

Exceptions

For setup
instructions,
see

Templates

All files in your site root
folder other than the
exceptions

Files in these folders:
•

workarea (covered by Workarea
Files sync)

Note: If you perform an
initial sync of a recentlyinstalled min site with your
staging site, the min site’s
templates could overwrite
templates on your staging
site. This is because,
when two templates have
the same name, the most
recently modified one
overwrites the other.

•

assets, privateassets, uploadedfiles, uploadedimages (covered by Database/Resources
sync)

”Setting up a
Profile to Sync
Template and Bin
Files” on
page 1325

•

bin (covered by Bin checkbox,
below)

•

app_webreferences

•

latestchanges

•

app_globalresources

WARNING!
If you run a
template sync
and Bin is
checked, and
one server is
running is 32bit mode while
the other is
running in 64bit mode, users
will not be able
to drag and
drop DMS files
on the staging
server.

To avoid this, rename the
only template installed
with the min site
(login.aspx) before
performing the initial
template sync. You should
also rename login.aspx’s
supporting files, such as
login.aspx.vb.
Note: If you create a new
Windows folder within the
site root folder, sync it,
then later delete the new
folder and sync again, the
new folder will not be
deleted from the
destination server.

Bin

These files:
•

assetManagement.config

•

web.config

See Also: ”Global File Type
Exceptions” on page 1320
Note: If you create a folder within
your site root and name any folders
under that folder assets,
privateassets, uploadedfiles, or
uploadedimages, those folders are
not synched.

The bin folder

You can also set up a profile that syncs Windows folders. See
Also: ”Synchronizing Windows Files” on page 1329

Global File Type Exceptions
The following file types are not synched by default.
•

.config files
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NOTE

•

.txt files

•

.sln files

Ektron CMS400.NET creates a large number of .txt files to support the search
functionality.

However, you can add these file types to a sync profile via the
Include/Exclude Files field. See Also: ”At the Include/Exclude
files field, include files not normally synched, or exclude files that
are synched by default.” on page 1323

Setting up a Profile to Sync a Database and Assets
To set up a profile to sync an Ektron CMS400.NET database and its
assets, follow these steps.
Prerequisite
•

You created a Sync configuration and ran an initial sync. See
Also: ”Setting Up eSync” on page 1255

1. Go to the Settings > Configuration > Synchronization
screen.
If you are eligible to add a profile to a configuration, the Add
Sync Profile button appears, circled below.

2. Click the Add Sync Profile button. The Add Synchronization
Profile screen appears.
3. At the Synchronization name field, enter a name for this
profile.
4. At the Items to Synchronize field, select database and
assets.
5. At the Synchronization Direction field, select the direction of
the data copy that will occur. Your choices are:
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•

NOTE

Bidirectional (that is, both directions). Changed data on either
server is updated on the other. If the same data (for example, a
membership user profile) is updated on both servers, the
conflict resolution policy determines the outcome. See Also:
”Bidirectional Sync” on page 1328; ”Conflict Resolution Policy”
on page 1328

If you are using bidirectional sync and only one version was updated since the last
sync, the updated version overwrites the unchanged version.

•

Upload - the database and assets are copied from the local
server (the one to which you signed on) to the remote server
(specified at the Remote Site field above). Items on the remote
server are overwritten.

•

Download - the database and assets are copied from the
remote server to the local server. Items on the local server are
overwritten.

6. At the Conflict Resolution Policy field, decide what to do if
Synchronization Direction is Bidirectional, and the data has
changed on both servers since the last sync. Your choices are.
•Version on Remote Site Wins - the remote version
overwrites the local version
•Version on Local Site Wins - the local version overwrites the
remote version
7. If desired, select a schedule for when the sync will run
automatically. The choices are
•None - Don’t set up a schedule. Run this sync profile as
needed via the Sync Profile screen‘s Start Now button.
•One Time - you specify a start time and date
•Hourly - you specify a start date and time. eSync begins on
the start date and time, then runs every hour at that time.
•Daily - you specify a start time and date; this sync profile will
run every day at this time
•Weekly - you specify a start time, date, and day. After the start
date, this sync profile will run this day every week at this time.
•Monthly - you specify a start time and date (numbers 1
through 31). After the start date, this sync profile will run this
day every month at this time.
IMPORTANT!

You cannot schedule more than one sync to begin at the same time.
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NOTE

While the following options let you schedule a sync profile, you can sync at any
time by accessing the Sync Profile and clicking the Sync button (
”Running a Sync” on page 1332

NOTE

). See Also:

If you enter a date greater than 28, the sync will not run in a month that does not
include that date. For example, if you enter 31, the sync will not run in February,
April, June, September, and November.

Setting up a Profile to Sync Workarea Files
Prerequisite
•

You created a Sync configuration and ran an initial sync. See
Also: ”Setting Up eSync” on page 1255

1. Go to the Settings > Configuration > Synchronization
screen.
2. If you are eligible to add a profile to a configuration, the Add
Sync Profile button appears on the right side, as circled below.

3. Click the Add Sync Profile button. The Add Synchronization
Profile screen appears.
4. At the Synchronization name field, enter a name for this profile.
5. At the Items to Synchronize field, select Workarea files.
6. At the Include/Exclude files field, include files not normally
synched, or exclude files that are synched by default.
For example, .txt files are not normally included in a sync, but
you want to copy several on your staging server to the
production server. In this case, check Include and enter *.txt
into the adjacent field (illustrated below). If you do, only files
with that extension are synched.
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As an example of the Exclude option, assume you do not want
to sync Flash (.swf) files. If you check the Exclude button, and
enter .swf into the text field, eSync ignores them.
NOTE

By default, eSync ignores .config and .txt files.

7. At the Synchronization Direction field, select the direction of
the data copy that will occur. Your choices are:
•

NOTE

Bidirectional (that is, both directions). Changed data on either
server is updated on the other. If the same data (for example, a
membership user profile) is updated on both servers, the
conflict resolution policy determines the outcome. See Also:
”Bidirectional Sync” on page 1328; ”Conflict Resolution Policy”
on page 1328

If you are using bidirectional sync and only one version was updated since the last
sync, the updated version overwrites the unchanged version.

•

Upload - if the file on the local server was modified more
recently than the one on the remote server, the local file
replaces the remote. Otherwise, nothing happens.

•

Download - if the file on the remote server was modified more
recently than the one on the local server, the remote file
replaces the local. Otherwise, nothing happens.

8. At the Conflict Resolution Policy field, decide what to do if
Synchronization Direction is Bidirectional, and the data has
changed on both servers since the last sync. Your choices are.
•Version on Remote Site Wins - the remote version
overwrites the local version
•Version on Local Site Wins - the local version overwrites the
remote version
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9. If desired, select a schedule for when the sync will run
automatically. The choices are
•None - Don’t set up a schedule. Run this sync profile as
needed via the Sync Profile screen‘s Start Now button.
•One Time - you specify a start time and date
•Hourly - you specify a start date and time. eSync begins on
the start date and time, then runs every hour at that time.
•Daily - you specify a start time and date; this sync profile will
run every day at this time
•Weekly - you specify a start time, date, and day. After the start
date, this sync profile will run this day every week at this time.
•Monthly - you specify a start time and date (numbers 1
through 31). After the start date, this sync profile will run this
day every month at this time.
IMPORTANT!
NOTE

You cannot schedule more than one sync to begin at the same time.
While the following options let you schedule a sync profile, you can sync at any
time by accessing the Sync Profile and clicking the Sync button (
”Running a Sync” on page 1332

NOTE

). See Also:

If you enter a date greater than 28, the sync will not run in a month that does not
include that date. For example, if you enter 31, the sync will not run in February,
April, June, September, and November.

Setting up a Profile to Sync Template and Bin Files
Prerequisite
•

You created an eSync configuration and ran an initial sync.
See Also: ”Setting Up eSync” on page 1255

1. Go to the Settings > Configuration > Synchronization
screen.
2. If you are eligible to add a profile to a configuration, the Add
Sync Profile button appears, as shown below.
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3. Click the Add Sync Profile button. The Add Synchronization
Profile screen appears.
4. At the Synchronization name field, enter a name for this
profile.
5. At the Items to Synchronize field, select Templates and Bin.
6. At the Include/Exclude Files field, include files not normally
synched, or exclude files that are synched by default. For
example, .txt files are not normally included in a sync, but you
want to copy several on your staging server to the production
server. In this case, check Include and enter *.txt into the
adjacent field (illustrated below). If you do, only files with that
extension are synched.

As an example of the Exclude option, assume you do not want
to sync Flash (.swf) files. If you check the Exclude button, and
enter .swf into the text field, eSync ignores them.
NOTE

By default, eSync ignores .config and .txt files.

7. At the Synchronization Direction field, select the direction of
the data copy that will occur. Your choices are:
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•Bidirectional (that is, both directions). Changed data on
either server is updated on the other. If the same data (for
example, a membership user profile) is updated on both
servers, the conflict resolution policy determines the outcome.
See Also: ”Bidirectional Sync” on page 1328; ”Conflict
Resolution Policy” on page 1328
NOTE

If you are using bidirectional sync and only one version was updated since the last
sync, the updated version overwrites the unchanged version.

•Upload - if the file on the local server was modified more
recently than the one on the remote server, the local file
replaces the remote. Otherwise, nothing happens.
•Download - if the file on the remote server was modified more
recently than the one on the local server, the remote file
replaces the local. Otherwise, nothing happens.
8. At the Conflict Resolution Policy field, decide what to do if
Synchronization Direction is Bidirectional, and the data has
changed on both servers since the last sync. Your choices are.
•Version on Remote Site Wins - the remote version
overwrites the local version
•Version on Local Site Wins - the local version overwrites the
remote version
9. If desired, select a schedule for when the sync will run
automatically. The choices are
•None - Don’t set up a schedule. Run this sync profile as
needed via the Sync Profile screen‘s Start Now button.
•One Time - you specify a start time and date
•Hourly - you specify a start date and time. eSync begins on
the start date and time, then runs every hour at that time.
•Daily - you specify a start time and date; this sync profile will
run every day at this time
•Weekly - you specify a start time, date, and day. After the start
date, this sync profile will run this day every week at this time.
•Monthly - you specify a start time and date (numbers 1
through 31). After the start date, this sync profile will run this
day every month at this time.
IMPORTANT!

You cannot schedule more than one sync to begin at the same time.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1327

Using eSync

NOTE

While the following options let you schedule a sync profile, you can sync at any
time by accessing the Sync Profile and clicking the Sync button (
”Running a Sync” on page 1332

NOTE

). See Also:

If you enter a date greater than 28, the sync will not run in a month that does not
include that date. For example, if you enter 31, the sync will not run in February,
April, June, September, and November.

Bidirectional Sync
Although most CMS data is created and updated on the staging
server, certain types of data are collected on the production server.
This information can be viewed and edited on the staging server.
Here are some examples:
•

membership users

•

content ratings data

•

forum and blog posts

•

community folders

When you set up a sync profile to copy this kind of data
(maintained in the database), you typically would choose
Bidirectional as the direction. In this case, if a membership user
creates or updates his profile on the production server, those
changes are transmitted to staging. On the other hand, if your
administrator needs to change that membership user’s
information, the next eSync transfers that from staging to
production.
If changes are made to the same file on both servers since the last
sync, your conflict resolution policy determines which data is
saved. See Also: ”Conflict Resolution Policy” on page 1328
NOTE

The first time you run a sync for templates or Workarea files, the sync is
bidirectional, regardless of the direction you specify on the Synchronization
Direction screen.

Conflict Resolution Policy
If you are using bidirectional synchronization (See Also:
”Bidirectional Sync” on page 1328), and the same item changed on
both servers since the last sync, eSync must decide which version
should be kept, and which version overwritten.
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NOTE

If you are using bidirectional sync and only one version was updated since the last
sync, the updated version overwrites the unchanged version.

Use the Conflict Resolution Policy field to determine which
version ends up on both servers after synchronization. The
following choices are available.
•

Version on Remote Site Wins - the remote version overwrites
the local version

•

Version on Local Site Wins - the local version overwrites the
remote version

Synchronizing Windows Files
As an alternative to selecting a type of data to sync (using the File
types radio button), you can sync individual Windows files. For
example, you updated a few template files and their related .css
files on the staging server, and now want to update the production
server without moving everything else.
NOTE

If you create new HTML content and insert a Library image into it, then sync just
that content, the image is not inserted into the destination library nor is it
searchable from the destination site. To remedy this problem, perform a database/
resources sync.

Unlike the full sync, you cannot schedule a Windows file sync.
Instead, you select files then sync immediately.
Like the profile sync, the local file replaces the corresponding
remote one only if the local file was modified more recently than
the one on the remote server. Otherwise, nothing happens.
To synchronize Windows files, follow these steps.
1. Create a sync configuration between the two servers whose
files you want to sync. See ”Setting Up eSync” on page 1255.
2. From the View All Synchronization Configurations screen, click
the Add Sync Profile button (circled below).
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3. Complete the fields on the screen except for Schedule, which
the file sync ignores. See ”Setting up a Profile to Sync
Workarea Files” on page 1323.
4. Save the profile.
5. From the View All Synchronization Configurations screen, click
the profile then the Synchronize files button (

).

6. All folders in your Ektron CMS400.NET site root folder appear.
Open folders as needed, and check all files to be synched.
NOTE

If you create a new folder within the site root folder, sync it, then later delete the
new folder and sync again, the new folder will not be deleted from the destination
server.

7. Click the Sync now button (

).

8. A dialog tracks the sync’s progress, and notifies you when it is
completed.
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Optional Steps before Running a Sync
You may want to adjust the web.config and db.config settings
before running a Sync. The following topics explain eSync features
that you control via the .config files.
•

”Content and Folder Sync Options” on page 1345

•

”Using eSync with Web Alerts” on page 1365

•

”Using eSync with eCommerce” on page 1366

•

”Force Initial Sync” on page 1334

•

”Backing up the Destination Server During an eSync” on
page 1336

•

”Previewing a Sync” on page 1331

Previewing a Sync
After creating a profile based on a database sync (as explained in
”Setting up eSync Profiles” on page 1317), you can preview the
content that the sync will copy before launching it. Use this list to
verify that the sync’s results will match your expectations before
beginning to sync.
To preview a sync profile, go to the View All Synchronization
Configurations screen, find the profile, and click the preview button
(

) (circled below).
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The preview screen lists information about local (upload) and
remote (download) changes that will occur the next time you sync
that profile.

Running a Sync
IMPORTANT!

WARNING!

The names of the site and all folders must match on both servers. This is because
paths to images, xslt files, etc. refer to a site and its folders. If the servers’ site and
folder names do not match, the links break.
You cannot run two eSyncs simultaneously.

Prerequisites
•

”eSync Requirements” on page 1295

•

You created an eSync configuration and profile. See ”Setting
Up eSync” on page 1255.

•

You are not signed on to a production server that is outside the
firewall. This is because you cannot sync from a production
server outside the firewall to other servers - you can only sync
to this production server.

As mentioned in ”Setting up eSync Profiles” on page 1317, you
can set up eSync to run on a schedule. However, you can also
sync at any time. Follow these steps to sync a profile immediately.
1. Go to the Settings > Configuration > Synchronization
screen.
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2. If a profile is ready for you to sync, a sync button appears in the
right column, as circled below.

3. Click the sync button (
NOTE

).

If another sync is running, you are notified. You cannot begin a new sync until the
current one finishes.

4. A screen monitors the sync’s progress.

5. The screen indicates when the sync is complete.
NOTE

You can close the window and reopen it at any time by clicking the sync button
(

WARNING!

). If you do, the sync’s current status appears.

If you performed a database sync and the site being synched uses URL aliasing,
you must go to its URL Aliasing Configuration screen and click the Refresh button
(

) to update its aliasing information.
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Force Initial Sync
Use the Force Initial Sync button (circled in red below) to
reinitialize a server that was previously initialized.

Here’s a scenario in which you would want to use Force Initial
Sync.
1. You initialized a test server from your current Ektron
CMS400.NET server.
2. You experimented on the test server by adding new content,
deleting content, etc.
3. You no longer want the test server’s database. Instead, you
want to reinitialize the test server from the Ektron CMS400.NET
server.
To accomplish step 3, use the Force Initial Sync button. The button
only appears when all prerequisites are present. See Also: ”Force
Initial Sync Prerequisites” on page 1334
TECHNICAL NOTE

The Force Initial Sync procedure ignores the following checks that are normally
made prior to synching:
* the destination database is smaller than the source database
* the site has not been previously staged

Force Initial Sync Prerequisites
In order to use the Force Initial Sync feature, these conditions must
exist.
•

The server’s web.config file’s ek_ForceReInit property is set to
true.
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NOTE

If the ForceReInit property is set to false, and you click the Force Initial Sync
button, you are informed that you need to change the property to true if you want
to force an initial sync.

•

The site to which you are signed on is not part of a multi-site
configuration.

•

The server has only one sync server relationship.

•

The server is the destination in the sync server relationship. In
other words, the server is on the download side of the
relationship.

The following image illustrates the last two conditions.
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Backing up the Destination Server During an eSync
You can create a backup of the destination server’s database. If
you do and problems occur during the sync, the database is
automatically restored to its state prior to beginning the backup.
You can specify the backup to occur on the initial sync only, or
every time you sync.
NOTE

No backup is made when you sync a folder or content. See Also: ”Content and
Folder Sync Options” on page 1345

Setting up the Destination Database Backup
To set up the database backup, follow these steps.
1. Open
C:\Program Files\Ektron\EktronWindowsServcie30\dbsync.config.

2. Find the following line (near the top).
<DatabaseRuntime name="EktronDbSync" logPath="C:\Program
Files\Ektron\EktronWindowsService30\Database\">

3. Add the following properties to that tag
•

device - Following device, enter the path to the backup file.
Ektron recommends using C:\Program Files\Microsoft SQL
Server\MSSQL.1\MSSQL\Backup\.

•

backupOption -

possible values

- 1 - backup on initial sync only
- 2 - backup every time you run a sync
4. The line should now look something like this:
<DatabaseRuntime name="EktronDbSync" device="C:\Program Files\Microsoft SQL
Server\MSSQL.1\MSSQL\Backup\" backupOption="1" logPath="C:\Program
Files\Ektron\EktronWindowsService30\Database\">

5. Save the file.
6. Restart the Ektron Windows Service.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1336

Using eSync

Once this is set up, a backup file is created either after the initial
sync (if backupOption="1") or after every sync (if backupOption="2").
Here is the file’s format:
[dbname][yyyy][mm][dd][hh][mm][ss][mmm].[product].bak

For example:

cms400min20090216075946765.esync.bak.

- See logs of previous sync activity See Also: ”Sync Logs” on
page 1337

Sync Logs
eSync provides the following logs of previous sync activity.
•

the most recent sync for any profile - see ”Viewing a Log of a
Profile’s Most Recent Sync” on page 1338

•

the most recent sync for any sync server relationship - see
”Viewing a Log of a Sync Server Relationship’s Most Recent
Sync” on page 1339
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•

all syncs for a sync server relationship - see ”Viewing a Log of
all Syncs for a Sync Server Relationship” on page 1340

Viewing a Log of a Profile’s Most Recent Sync
You can view a log of any profile’s most recent sync by clicking the
log icon ( ) next to that profile (circled below).

The Last Sync Status icon appears only for profiles that have been
previously synched.
The sync log (shown below) has the same appearance as the log
that appears upon completion of a sync.
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Viewing a Log of a Sync Server Relationship’s Most Recent Sync
You can view a log of a Sync Server Relationship’s most recent
sync by clicking the log icon ( ) (circled below) in the header
section of the screen.

The sync log (shown above) has the same appearance as the log
that appears upon completion of a sync.
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Viewing a Log of all Syncs for a Sync Server Relationship
The View All Synchronization Configurations screen provides a
toolbar button ( ) (circled below) that displays a chronological log
of all syncs on your server, with the most recent one at the top.

You can click the icon in the Status column to view details about
the sync.
If the column contains a green check mark, the sync was
successful.
If the column contains a warning ( ), the sync failed for some
items. If you click the icon, a new screen appears listing causes for
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the failure, as shown below. Ektron support staff can use this log to
troubleshoot the problem.

Reviewing Resolved Collisions
To verify the accuracy of the data being synchronized, eSync
checks for and resolves the following matching items
•

user names
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•

folder names

•

metadata definitions

•

messages

For example, on the staging server, a user creates a folder directly
under the root folder called Marketing, and a user on the production
server does the same.
NOTES

* In order for folders to match, they must have the same name and folder path.
* Both CMS and membership users are included.

This problem only occurs if the matching items were both entered
since the last synchronization.
Although matching items have different ID numbers, users cannot
tell them apart. So, eSync appends the ID number to the more
recently-created one to distinguish it from the other. For example,
Marketing becomes Marketing11329.

The Review Resolved Collisions Button
To help track these changes, the View All Synchronization
Configurations screen has a button (
such a collision is resolved.

) that appears only after

.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1342

Using eSync

The server on which the button appears is explained below.
eSync Direction

Collision Resolution Information
Appears on this Server

download

local

upload

remote

When you click this button, the Review Synchronization Collisions
screen appears, showing the original and changed items.

The Review Synchronization Collisions Screen
This screen shows how collisions between matching items were
resolved. See Also: ”Reviewing Resolved Collisions” on page 1341
Each type of resolved collision appears on its own tab.

After noting these changes, you can click the box to the left of each
change, then click the Mark Reviewed button to remove it from the
screen. Alternatively, you can click the box in the header row to
select all.
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The Users tab has an additional button, Mark Reviewed and
Email. Use it to remove the user from the screen and send an
email to him/her (using the address from the Add/Edit User
screen’s E-Mail Address field). The email text is below.
lbl sync collision email subject = Your username has been changed
lbl sync collision email body = For security purposes, your username
has been changed. Your new username is {0}. You will need to use
this new username the next time you login. Thank you.

NOTE

You can change the text in the resource file. To learn about editing it, see
”Procedure for Translating Workarea Strings” on page 921.

Synching Custom Database Tables
You can use eSync to synchronize a custom SQL database table.
To do so, follow these steps.
1. Add a new, empty table to the target SQL database.
The table must have a primary key and cannot use identity
columns.
Here is an example of a valid table.
Create table foo3(Id int not null primary key clustered, Id2 int not null, company nvarchar(50)
null)

Here are two examples of invalid tables. The identity columns are
highlighted in red.
create table foo1(Id int not null identity(1,1) primary key clustered,company nvarchar(50)
null)
create table foo2(Id int not null primary key clustered,Id2 bigint not null identity(1,1)
,comapny nvarchar(50) null

2. On the server that hosts the source database, navigate to
C:\Program Files\Ektron\EktronWindowsService30.
3. Open the DbSync.config file.
4. Find the section that begins <Release

version="7.6.6.

5. Within the 7.6.<Groups> tag, you see these names:
<add
<add
<add
<add

name="default" scope="ektron"
name="folder" scope="ektron"
name="content" scope="ektron"
name="folderrecursive" scope="ektron"
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<add name="workflow" scope="workflow"
<add name="custom" scope="custom" schema=""/>

6. Enter your custom table schema within the last line’s schema=""
tag.
NOTE

Follow the pattern of the existing schemata when adding yours.

7. Save DbSync.config.
8. Sign on the source server.
9. Follow steps 1 through 7 on that server.
10. Restart the Ektron Windows Service on both servers.
11. Run a DB sync from local to remote (local win).

Content and Folder Sync Options
Members of the Administrators group or those assigned to the
Synchronization Admin role can sync individual content items and
Ektron CMS400.NET folders using context menu options, as shown
below.
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See Also:
•

”Prerequisites for Content/Folder Sync” on page 1346

•

”Enabling the Content and Folder Level Sync” on page 1347

•

”Using Content and Folder Level Sync” on page 1348

•

”Synching a Content Item” on page 1348

•

”Synching a Folder” on page 1350

Prerequisites for Content/Folder Sync
See Also: ”eSync Requirements” on page 1295
•

You are a member of the Administrators group or assigned to
the Synchronization Admin role

•

Content/folder sync is enabled in web.config. See ”Enabling
the Content and Folder Level Sync” on page 1347.

•

The server has a sync configuration whose initial sync has
been run

•

Existing folders: folder information has not been updated since
the last database sync using the selected profile.
If any folder property is changed (for example, a new metadata
value is assigned), a database sync must be run before you
can synchronize content in that folder and the folder itself.
Furthermore, any child folder (and its content) that inherits that
property from the parent folder can only be synchronized after
the next database sync.

•

New folders: a database sync must be run before you can
synchronize content in the new folder and the folder itself

•

Content: No new tags or taxonomy categories have been
added since the last time the selected profile was synched. If
either event has occurred, a database sync must be run before
you can synchronize that content. You must also run a
database sync for all other profiles that use those tags or
taxonomy.

The following graphic illustrates adding new tags and a taxonomy
category to content.
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•

For a folder sync, the content is not a blog or forum post. For a
content sync, the content is not a forum post.

Enabling the Content and Folder Level Sync
To set up the content and folder Synchronize options, follow these
steps.
1. Log on to the server on which content editors will sync content
and folders.
2. Open Windows Explorer > your site root folder > the web.config
file.
3. Go to the following area.
<eSyncSettings>
<!-- enables or disables eSync feature -->
<add key="eSyncEnabled" value="false"/>
</eSyncSettings>

4. Set the value of eSyncEnabled to true.
5. Save web.config.

Ektron CMS40 0.NET Admini strator Manua l, Version 7 .6 Re v 13

1347

Using eSync

Using Content and Folder Level Sync
You would typically use eSync in the following manner.
1. Create, update, and get content approved on a staging server.
2. Synchronize content blocks or an Ektron CMS400.NET folder
with the production server.
The eSync feature is available if you see Synchronize menu
options (shown below) on Approved content or a folder.

Synching a Content Item
Content sync copies a selected content item to another computer.
The sync also copies library resources within that content, such as
images and quicklinks.
Only Approved content can be synchronized. See Also:
”Prerequisites for Content/Folder Sync” on page 1346
To sync a content item, follow these steps.
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1. Navigate to the content. You can
•go to the Web page that displays it
•sign into the Ektron CMS400.NET Workarea and
- navigate to its folder, or
- use the Search to find it (see below)

2. Click the arrow to the right of the content to see its dropdown
menu.
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NOTE

A Synchronize button (shown below) is also available from the View Content
screen.

3. Click Synchronize.
4. All relationships with at least one Database profile whose
direction is Upload or Bidirectional appear. Select the
appropriate one. See Also: ”Setting up eSync Profiles” on
page 1317

5. Click Sync Now.
6. The content is synchronized with the selected database.

Synching a Folder
The folder sync updates all content in a folder with another
computer. It does not affect content in folders underneath the
selected folder. See Also: ”Prerequisites for Content/Folder Sync”
on page 1346
To sync a folder, follow these steps.
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1. Navigate to the folder.
2. Click Action > Synchronize Folder.

3. A screen asks you to select a sync relationship.

4. Click the Start Sync button.
5. All content in the folder is synched with the selected database.

eSync in a Load Balanced Environment
Ektron CMS400.NET supports a load-balanced environment, in

which several servers share your Web site’s processing load. This
feature is explained in ”Load Balancing Support” on page 1060.
If your site uses load balancing, you can set up eSync such that,
after one server in a load balance cluster is synchronized, the other
servers will be automatically synchronized. Note that if a separate
database server is outside the load balance cluster (as shown
below), eSync only synchronizes documents and files used by the
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search among the clustered servers. It does not touch the
database.
A typical load balanced cluster is below.

WARNING!

Ektron’s eSync feature does not synchronize all databases in a SQL database
cluster. If you have such a configuration, it is your responsibility to ensure that
eSync updates all the databases.

WARNING!

In a load balanced environment, only update templates on the staging server. Do
not update them on the production server and assume they will be synchronized
with the staging server.

Prerequisites
•

The connection string on all servers in the cluster match

•

You must initiate eSync relationships, and the actual
synchronization, from a staging server

•

If your staging servers are clustered, you must remove one
from the cluster before you can sync

Follow these steps to set up this capability.
•

”Install a Min Site on Every Server in the Cluster” on page 1353
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•

”Update the Assetmanagement.config File” on page 1353

•

”Update the Ektron Windows Service Config File” on
page 1353

•

”Create eSync Security Certificates for a Load Balanced
Cluster” on page 1355

Install a Min Site on Every Server in the Cluster
1. Upgrade each server to the same 7.6 version of Ektron
CMS400.NET. If Ektron CMS400.NET is already installed to one
server, you can install a minimum site on the other servers.
To do this, run the Ektron CMS400.NET base installation file
(CMS400Base7x.exe). For more information, see the Ektron
CMS400.NET Setup manual.
2. If the current site with which you will sync is precompiled, you
must also precompile all min sites.

Update the Assetmanagement.config File
1. Sign on to the first server in your load balanced cluster.
2. In the site root folder, open site

root\assetmanagement.config.

3. Change the value of LoadBalanced to 1 and save.
4. Do this on every server in the cluster.

Update the Ektron Windows Service Config File
1. Sign on to the first server in your load balanced cluster.
2. Open
C:\ProgramFiles\Ektron\EktronWindowsService30\Ektron.ASM.Ektron
Services30.exe.Config.

3. Change the value of LoadBalanced to 1 and save.
4. Do this on every server in the cluster.
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5. Stop and then Start the Ektron Windows Service on every
server in the cluster.
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Create eSync Security Certificates for a Load Balanced
Cluster
You should be familiar with eSync security certificates before
beginning this procedure. If you are not, read the following section:
”Managing eSync Security Certificates” on page 1305.
Assume the load balance cluster has three servers: mach1,
and mach3.

mach2,

This procedure has two major parts.
•

Generating Security Certificates on mach1.

•

Applying Security Certificates to mach2 and mach3

Generate Security Certificates on mach1
In the first nine steps, you copy mach1’s security certificate files,
then paste them into the same folder, and rename them beginning
with mach2 and mach3.
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1. Sign on to mach1 and generate security certificates. To do this,
click the Windows Start Button> All programs > Ektron >
CMS400 v7x > Utilities > Security Configurator.
2. The security configurator screen appears.
3. See ”Use the following table to complete this screen.” on
page 1308.
4. Click Generate Certificates then click OK. This action creates
security certificates on mach1.
5. On mach1, open the following folder:
C:\ProgramFiles\Ektron\CMS400V7x\Utilities\Software\SecurityCon
figurator.

6. Copy the following files.
•mach1_SyncClient.pfx
•mach1_SyncClient.pvk
•mach1_SyncClient.cer
•mach1_SyncServer.pfx
•mach1_SyncServer.pvk
•mach1_SyncServer.cer
7. Paste them into the same folder.
8. Rename each file according to the following pattern: mach2_file
name. (This assumes the second server in your load balance
cluster is mach2.)
9. Repeat steps 7 and 8 for every server in your load balance
cluster. So the number of certificate files in the folder is 6 x the
number of servers.
10. Copy all security certificate files to the following mach1 folder:
C:\Program Files\Ektron\EktronWindowsService30.
11. Stop and start the Ektron Windows Service.
In the second part of this procedure, you
•

open the Ektron.ASM.EktronServices30.exe.config file

•

copy mach1’s certificate’s key value

•

create new keys, and apply mach1’s encoded value to them

So, when you finish, the affected part of the file looks like this:
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<add key="mach1_SyncClient.cer" encodedValue="MIIB7TCCAVag....
<add key="mach2_SyncClient.cer" encodedValue="MIIB7TCCAVag....
<add key="mach3_SyncClient.cer" encodedValue="MIIB7TCCAVag....

NOTE

The encodedvalue above is abbreviated to fit the page.

12. Open the following file:
C:\Program
Files\Ektron\CMS400v7x\Utilities\EWSUpdates\3.0\Ektron.ASM.EktronServices30.exe.config

13. Find the <publickCertKeys> element.
14. Following that line is the encoded certificate value for mach1,
which looks something like this.
<add key="mach1_SyncClient.cer" encodedValue="MIIB7TCCAVag....

NOTE

The encodedvalue above is abbreviated to fit the page.

15. Copy the entire <add
Notepad file.

key>

element, including the value, into the

16. Open a text processing application like Notepad.
17. Into the Notepad file, paste the text you copied in Step 13 three
times.
18. Change the second line’s add
19. Change the third line’s add

key

key

value to mach2_SyncClient.cer.

value to mach3_SyncClient.cer.

20. Copy the second and third lines of the Notepad file (the lines
you just changed).
21. Return to the Ektron.ASM.EktronServices30.exe.config file.
22. Locate the

<add key>

element.

23. Place the cursor directly below that line.
24. Paste the text you copied in Step 18.
25. Save the Ektron.ASM.EktronServices30.exe.config file.

Apply Security Certificates to mach2 and mach3
1. On the local server, open two Windows Explorer windows: one
showing the mach1’s file system, and the other showing the
mach2’s file system.
2. In the mach1 window, open C:\Program
Files\Ektron\EktronWindowsService30.
3. Copy all security certificate files in that folder.
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4. In the mach2 window, open the following folder: C:\Program
Files\Ektron\EktronWindowsService30.

5. Paste all security certificate files you copied in Step 3 to that
folder.
6. Stop and start the Ektron Windows Service.
7. In the mach2 window, create a folder underneath the root folder.
Name it Ektron Security Certificates.
WARNING!

Do not place it under the web root folder, C:\inetpub\wwwroot.

8. Return to the mach1 window, which is still open to the following
folder: C:\Program Files\Ektron\EktronWindowsService30.
9. Copy the following files.
WARNING!

Copy - do not move - the files from the mach1 folder.

•mach2_SyncClient.pfx
•mach2_SyncClient.pvk
•mach2_SyncClient.cer
•mach2_SyncServer.pfx
•mach2_SyncServer.pvk
•mach2_SyncServer.cer
10. Paste the files into the mach2 folder you created in Step 6. Make
sure there are no other security files in the folder.
Next, you need to register and move the files to the correct folders.
The Security Configurator screen does this.
11. On mach2, open the security configurator screen using this path:
Windows Start Button > All programs > Ektron > CMS400
v7x > Utilities > Security Configurator.
12. The security configurator screen appears.
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13. Click the Apply Remote Server Certificates button (circled
above).
14. Click the browse button next to that field.
15. Browse to the folder to which you pasted the security
certificates in Step 9.
16. Click the OK button.
17. The utility copies the security certificates you pasted in Step 9
to the correct folder, and configures them for the remote server.
18. Repeat the above steps for every server in the load balance
cluster. Note that the files to be copied will start with the server
name you’re currently setting up.

Setting Up and Running eSync
You set up and run eSync in a load balanced environment the
same way you run it normally. See these sections for details.
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NOTE

•

”Using eSync to Initialize a New Site” on page 1316

•

”Setting up eSync Profiles” on page 1317

•

”Optional Steps before Running a Sync” on page 1331

•

”Running a Sync” on page 1332

If your first load balanced sync fails, you must run the Search Config Utility on the
load balanced server in order for search to work. See Also: ”Automatically
Recreating a Catalog” on page 396

Using eSync in a Multi-site Environment
If you want to use eSync in a multi-site environment, you must do
so before the initial synchronization of a configuration. That is, you
cannot set up a eSync configuration in a single-site environment
and then later change to multi-site. You can set up a new
configuration at any time.
See Also:
•

”Limitations on using eSync in a Multi-site Environment” on
page 1360

•

”Setting up eSync in a Multi-Site Environment” on page 1361

Limitations on using eSync in a Multi-site Environment
•

In a multi-site environment, you cannot create a staging site
from a production site (as described in ”Using eSync to
Initialize a New Site” on page 1316). You must first create all
sites on the staging server, then set up production sites with
which they will sync.

•

If you want to sync templates between sites in a multi-site
configuration, you must sign on to the site that has the
templates that need to be synched. For example, your
configuration consists of a main site and two multi-sites (A & B)
on staging and production. If you want to sync site A’s
templates, you must sign on to site A on the staging server,
then use its Workarea screens to sync its templates to site A on
the production server.

•

When using eSync, each site in a multi-site configuration must
be created separately in IIS. In other words, you cannot set up
several sites under one IIS site and successfully use eSync.
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Setting up eSync in a Multi-Site Environment
To set up eSync in a multi-site environment, follow these steps.
WARNING!

Back up your database before beginning this procedure!

1. Set up all sites on the staging server, following the instructions
in the Ektron CMS400.NET Administrator Manual section “MultiSite Support”.
2. Install an Ektron CMS400.NET min site on each production
server that will host a site. To do this, run the Ektron
CMS400.NET base installation file, version 7.6 or higher. (For
more information, see the Ektron CMS400.NET Setup manual.)
3. Install security certificates between the staging server and all
production servers. This procedure is described in ”Managing
eSync Security Certificates” on page 1305.
4. Sign on to the staging server.
5. In the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Synchronization.
6. The View All Synchronization Configurations screen appears.
7. Click the Add button (

).

8. The Create Synchronization Server Relationship screen
appears.
NOTE

If you see the following error, The system cannot find the file specified, you
must set up security certificates. See Also: ”Managing eSync Security
Certificates” on page 1305

Because the staging server is multi-site, the screen’s staging
server area has a Site pulldown field (circled below), which lets
you select a site.
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9. Use the following table to complete the screen.
WARNING!

The first time you sync an Ektron CMS400.NET Web site, all of its data is
overwritten. Make sure that no important information resides on the production
server before beginning the first sync.

Field

Description

Remote Server

Select a production server by choosing the path to the site’s physical
location on the remote server.
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Field

Description

Port Number

Use this field to indicate to the local service the port on which the
remote service runs. By default, port 8732 appears.
If you want to change the service port, you must
•

change it in this field

•

open the C:\Program
Files\Ektron\EktronWindowsService30\Ektron.ASM.Ektro
nServices30.exe.config file, and replace every occurrence of
localhost:8732 with localhost: followed by the new port

number.
Choose Certificate

If you selected a single server above, its name appears here.
Proceed to the next step.
If you selected a domain or IP address above, click the dropdown
arrow to view all servers whose client security certificates reside on
this server. Then, select the server with which you want to set up an
eSync relationship.

10. Click the Connect button.
After you connect to the production server, all eligible
databases on it appear. The top one has a green check mark,
indicating it is selected by default.
11. Click the database with which you want to sync. When you do,
a green check mark appears on it, and its background color
changes.
12. Click Next.
13. A new screen appears, showing both servers and allowing you
to change the direction of the initial database copy. Make sure
you are copying from staging to production.
14. When you are satisfied, click Create. This sets up the server
configuration but does not launch the initial sync.
15. The View All Synchronization Configurations screen appears
with the new configuration.
If you are ready to overwrite the production database with the
staging one, click Start Initial Sync.
16. A confirmation screen appears.
17. A screen monitors the sync’s progress.
18. The initial sync creates a default profile, which appears on the
View All Synchronization Configurations screen.
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19. Set up and launch sync profiles to sync workarea files and
templates on the staging server with those on the production
server. (This is described in ”Setting up eSync Profiles” on
page 1317 and ”Running a Sync” on page 1332.) For
synchronization direction, choose Upload.

Setting up Staging Multi-sites
By default, if you sign on to a staging server then insert library
items (images, quicklinks, etc.) into content, the path to those
items includes the production server.
For example, your server setup includes two multi-sites:
sales.ektron.com and support.ektron.com.
NOTE

The multi-site names are defined in the site’s folder properties screen’s
Production Domain field, as described in ”Step 3: Assign Multi-Site Capabilities
in Ektron CMS400.NET” on page 1010.

So, any library links in the sales.ektron.com site’s content look like
this: http://sales.ektron.com/template?id=id number.
However, you may wish to change library links so they refer to the
staging server. This would help you verify that the linked items
exist on the staging server.
To change library links so they refer to your staging server, follow
these steps.
1. In the Ektron CMS400.NET Workarea, go to Settings >
Configuration > Setup.
2. Click the Edit button (

).

3. Check the This is a Staging Server check box.
4. Save the screen.
5. Go to Content > the staging site folder.
6. Click View > Folder Properties.
7. Click the Edit button (

).

8. Scroll down to the section labeled Multi-Site Domain
Configuration:.
9. In the Staging Domain field, enter the URL of your staging
server.
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10. Save the screen.
From now on, when a user signs on to the staging server and
works with library links, the links include the staging server instead
of the production server.

Using eSync with Web Alerts
The Web Alert feature enables Ektron CMS400.NET to generate
email for a list of registered users whenever new content appears
on your site, or existing content is updated. For more information,
see ”Web Alert Feature” on page 1013.
In an eSync environment, you need to determine which servers
send Web Alerts. For example, Web Alerts should probably not be
generated when content is published on a staging server, but you
would want them when content is published on a production
server.
To determine if a server generates Web alerts, use the following
property of each Web site’s web.config file.
<add key="ek_DisableWebAlerts" ..... />

Set the property’s value to true to suppress Web Alerts on a
server.
Set the property’s value to false to generate Web Alerts to on a
server.
Also, the server clock on the download side of the eSync
relationship must be exactly the same time as or slightly ahead of
the clock on the sending server.

eSync and Integrated Search Folders
In a multi-site environment, Integrated Search folders on the
source server are not synched with the destination server. See
Also: ”Using the Integrated Search” on page 434; ”Setting Up
eSync” on page 1255
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Using eSync with eCommerce
When using eSync with an eCommerce site, you will want to
prevent orders from being processed on your staging server. This
is to prevent orders from being processed twice.
For example, a customer on your production site purchases a
product. If the staging server and production server are synced
before the credit card is processed, the potential exists for the
customer’s credit card to be charged twice; once from the
production server and again from the staging server.
To prevent orders from being processed on your staging server,
edit your staging site’s web.config file. Next, set the following
property to true.
<add key="ek_ecom_OrderProcessingDisabled" value="true" />

Once the property is set to true, you cannot process or edit orders
from the Workarea’s View Order screen on the staging server.
Also, if you try to create an order from the staging server’s Web
site, you receive the following message.
“We're sorry, an error occurred while processing your
request. Please try again later...”
It is important to note that all other eSync functions still work
properly. For example, when you create catalog entries on a
staging server and perform a sync, the entries will be moved to the
production server. This key only affects the processing of orders.
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eSync Troubleshooting
Symptom

Cause

Possible Solutions

Synchronization has failed

One server in the configuration
cannot resolve the address of
the other server. This may be
due to security restrictions or
because the Ektron Windows
service is off.

•

Modify the hostname of the
other server so that it can
be found.

•

Restart the Windows service

•

Reconfigure security

Local site can't communicate
with service

1.

Load the security configuration utility: C:\Program

There was no endpoint listening at
http://alphatest:8732/
Ektron.Sync.Communication/
SyncCommunicationScheduleServic
e.svc that could accept the
message.
This is often caused by an incorrect
address or SOAP action. See
InnerException, if present, for more
details.
The identity check failed for the
outgoing message. The expected
identity is xxx for the xxx target
endpoint.

Files\Ektron\CMS400V7x
\utilities\software\se
curityconfigurator\sec
urityconfigurator.exe.

2.

Select the web site that is
failing.

3.

Click OK.

This recopies client certificates
to the site and updates
web.config to use them.
No viable CMS sites were found on
the remote server specified. Please
check the remote server and try
again.

No E ktron CM S40 0. NET site
exists on the remote server.
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Appendix A: Unicode
Support

Ektron CMS400.NET supports Unicode characters in

•

the editor
- source view, from the editor

•

dialog boxes

Unicode Support in the Ektron CMS400.NET
Editor
Ektron CMS400.NET is practically 100% compliant with the
Unicode standard. It is only lacking in the following areas.

NOTE

•

Dialog box title bars - If the client does not support
Unicode characters, the title bar displays English.

•

The toolbar - If the client does not support Unicode
characters, drop-down lists on the toolbar display question
marks (?).

A client fully supports Unicode characters if the Unicode language is the
same as the Windows default language.

•

Toolbar dropdown lists on Korean systems - Korean
characters in a drop-down list may appear as question
marks (?) unless one of the following conditions is true:
- The Arial Unicode MS font is installed. Since this is
installed with MS Office, most clients have it.
or
- The default system language is Korean.
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Unicode Support in Source View
Ektron CMS400.NET also supports Unicode characters in while

viewing HTML source code, as illustrated below.

For more information about working with HTML source code, see
the Ektron CMS400.NET User Manual chapter “Working with
HTML.”

Unicode Support in Dialog Boxes
Ektron CMS400.NET supports Unicode in text boxes within dialogs

even if the Operating System (OS) language does not match the
Unicode language. For example, a content contributor author
wants to edit in Korean and Japanese without switching the OS
language.
Here is an example of such a dialog.
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What’s New in the 7.6 Release

W h a t ’s N e w i n t h e 7 . 6
Release

The following new 7.6 features are documented in the Ektron
CMS400.NET Administrators Manual.

• The Community Platform’s Tags feature now includes content
and library items. See ”Tags” on page 981

• The URL Aliasing feature has been totally revamped and
improved. See ”URL Aliasing” on page 559.

- 7.6.1- Aliasing now supports rules to handle an alias’s query
string parameters. Also, you can now control which folders/
taxonomy levels appear in the automatic alias pattern.

• A new eSync feature automates the process of copying a web
site from a staging server to a production server. See ”eSync”
on page 1025.

• The license keys have been restructured to accommodate
Ektron CMS400.NET’s new price structure. See ”License Keys”

on page 6.

• eWebEdit400’s spell checking now supports multiple
languages. See ”Setting the Spell Check Language for
eWebEdit400” on page 907.

• Users can now add video to a forum post. See ”Adding Video
to a Post” on page 525

• A new Widgets feature has been added to the Workarea and
the eIntranet site. It allows users to add custom miniapplications to personalize their page. See ”” on page 702

• 7.6.1 - Users with Moderate permission for Discussion Boards
can delete topics from the Web site. See ”Moderate
Comments” on page 484

• 7.6.1 - Users can delete their own topic in a Discussion Board
from the Web site. See ”Deleting a Topic” on page 520
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• 7.6.1 - A beta version of the eCommerce feature was added.
See ”eCommerce” on page 1078

• 7.6.1 - The buttons and methodology used to validate
eWebEdit400 content have changed. See ”Validating with
eWebEdit400” on page 113

• 7.6.5 - You can lock a specific Topic in a Discussion Board.
See ”Locking a Topic” on page 494.

• 7.6.5 - A completed version of the eCommerce feature was
released. See ”eCommerce” on page 1078.

• 7.6.5 - The screen used to create and maintain eCommerce
coupons were improved. See ”eCommerce Coupons” on
page 1236.

• 7.6.5 - Much improved multi-language support was added to
the Taxonomy feature. See ”Multi-Language Support for
Taxonomies” on page 679

• 7.6.6 - Support for checks and PayPal was added to
eCommerce. See ”PayPal Support” on page 1105 and ”Check
Support” on page 1121

• 7.6.6 - The Setting up eSync chapter has a new section. See
”Scenario 1: Synching Two Sites on the Same Server” on
page 1255.

• 7.6.6 - Logs have been added to eSync to provide a record of
all syncs. For each sync, you can view the user ID, and the
number of applied, skipped, and total changes. See ”Sync
Logs” on page 1337.

• 7.6.6 SP1 - You can change library links so they refer to the
staging server, as opposed to the production server. This would
help you verify that the linked items exist on the staging server.
See ”Setting up Staging Multi-sites” on page 1364
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Additional Information

Supporting Documents
You can find more detailed information about Ektron CMS400.NET
in the following manuals:
•

Ektron CMS400.NET Developer’s Reference Manual

•

Ektron CMS400.NET User Manual

•

Ektron CMS400.NET Setup Manual

Support
If you are experiencing trouble with any aspect of Ektron
CMS400.NET, please contact the Ektron Support Team via our
Web Site: http://dev.ektron.com/support.aspx.

Sales
For questions and answers about purchasing Ektron CMS400.NET
from Ektron, contact the sales department at sales@ektron.com.

Information
For general information about Ektron and its products, send an
email to info@ektron.com.
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